Contents

Chapter 1  Introduction  1
   About AutoCAD Land Development Desktop 2
   Getting Started 2

Chapter 2  Starting a Drawing Session  3
   Starting a Drawing Session from the Start Up Dialog Box 4
      Opening a Recently Used Drawing 4
      Using the Start Up Dialog Box to Open Drawings, Create New Drawings,
      and Access the Project Management Dialog Box 5
      Turning Off the Display of the Start Up Dialog Box 5
   Starting a New Drawing 6
      Basing a Drawing on a Drawing Template 7
      Selecting an Existing Project from the New Drawing: Project Based
      Dialog Box 7
      Creating a New Project from the New Drawing: Project Based Dialog Box 8
      Using Filters to Find a Project 10
   Opening an Existing Drawing 11
   Using Menu Palettes 12
      Selecting a Menu Palette 13
      Creating a Menu Palette 15
      Changing the Name or Description of a Menu Palette 16
      Saving a Menu Palette 17
      Deleting a Menu Palette 18
   Unloading Applications 18
      Unloading Civil Design 18
      Unloading Survey 18

Chapter 3  Projects and Prototypes  19
   AutoCAD Land Development Desktop Projects 20
   Managing Projects 21
      Adding a Project Path by Using the Project Management Dialog Box 21
      Removing a Project Path by Using the Project Management Dialog Box 22
Contents

iv

Selecting a Project When Using the Project Management Dialog Box 22
Finding a Project Using Filters 23
Creating a Project Using the Project Management Dialog Box 23
Changing the Project Detail Settings When Using the Project Management Dialog Box 24
Copying a Project 25
Deleting a Project 26
Renaming a Project 27

Project Locks 28
Managing Locked Files in a Project 29

Associating the Current Drawing with a Different Project 31
Selecting or Creating a Project 31
Attaching a Drawing to an Existing Project 32
Associating a Drawing with a New Project 32
Displaying Project Details for an Existing Project 33

Prototypes 34
Managing Prototypes 34
Copying a Prototype 34
Renaming a Prototype 36
Deleting a Prototype 36
Changing the Prototype Settings 37

Chapter 4 Setting Up Drawings 39

Setting Up Drawings 40
Setting Up a Drawing Using the Drawing Setup Wizard 40
Setting Up a Drawing by Automatically Loading a Pre-Existing Drawing Setup File 41
Setting Up a Drawing Using the Drawing Setup Command 41
Loading Drawing Setup Profiles 41
Saving Drawing Setup Profiles 43
Changing the Unit Settings for a Drawing 44
Changing the Precision Values for a Drawing 45
Changing the Scale Settings for a Drawing 46
Determining the Scale at Which to Draw Objects 47
Changing the Sheet Size for a Drawing 48
Changing the Current Zone for a Drawing 48
Changing the Base Point for a Drawing 50
Changing the North Rotation for a Drawing 52
Loading Pre-defined Text Styles and Changing the Current Text Style 54
Changing the Border Style for a Drawing 55
Defining a Line Border 56
Defining an Unscaled Block as a Border 57
Defining a Scaled Block as a Border 57
Chapter 5  Changing the AutoCAD Land Development Desktop Settings  59
Changing the AutoCAD Land Development Desktop Settings 60
Changing the AutoCAD Options 60
Changing the User Preferences 61
  Changing the Program Paths Settings 61
  Showing the Start Up Dialog Box 63
  Changing the Open Command Preference 63
  Changing the New Command Preference 64
  Selecting How to Set Up New Drawings 64
Editing Data Files 65
Changing the AutoCAD Land Development Desktop Drawing Settings 66
  Saving Drawing Settings to a Prototype 66
  Loading Drawing Settings from a Prototype 67
Changing the Geodetic Zone Transformation Settings 68
  Selecting a Point from the Drawing to Define the Transformation Reference Point 71
  Typing Point Coordinate Values to Define the Transformation Reference Point 71
  Typing a COGO Point Number to Define the Transformation Reference Point 72
  Selecting a Point from the Drawing to Define the Transformation Rotation Point 72
  Typing a COGO Point Number to Define the Transformation Rotation Point 72
  Type Point Coordinate Values to Define the Transformation Rotation Point 73
  Typing a Rotation to Grid North to Define the Transformation Rotation Angle 73
Changing the Output Settings 73

Chapter 6  Getting Started with Points  77
COGO Points 78
Creating the Point Database 78
Point Names 79
Changing the Point Creation Settings 80
  Adding Points to the Drawing as Points Are Created 80
  Changing the Numbering Convention for Points 81
  Changing the Point Elevation Settings 82
  Changing the Point Description Settings 83
Changing the Point Insertion Settings 84
Changing the Point Update Settings 86
Changing the Coordinate Display Settings 88
Changing the Description Key Settings 89
Differences Between Point Markers and Point Labels 91
Chapter 7  Point Groups and Lists  97

Point Groups 98
  The Point Group Manager 99
Creating a Point Group 100
  Creating a Point List Using Advanced Point Selection Options 102
  Using Advanced Point Source Options To Build a Point List 102
  Filtering a Point List 104
  Filter Option: Ranging in Numbers From 106
  Filter Option: Ranging in Elevations From 106
  Filter Option: With Name Matching 106
  Filter Option: With Description Matching 106
  Filter Option: With XDRef Matching 107
  Viewing a Point List 108
Point Group Overrides 109
  Setting Up Point Group Overrides 110
  Example: Creating a Point Group with an XDRef Override 112
Removing Points from a Point Group 114
  Using Existing Overrides for Points in a Point Group When Selecting the Group 114
Creating a Point Group that has Overrides Applied to It 115
  Deleting a Point Group 116
Changing the Properties of a Point Group 116
Creating Point Lists 117
  Creating a Point List 118

Chapter 8  Description Keys  121

Using Description Keys 122
  Description Keys and Point Markers and Point Labels 123
  Description Key Symbols 124
Using the Description Key Manager 124
  Creating a Description Key 125
  Scaling and Rotating a Description Key Symbol 127
  Parameters for Scaling and Rotating a Description Key Symbol 128
  Creating a Description Key File 130
  Deleting a Description Key 131
  Deleting a Description Key File 131
  Changing the Properties of a Description Key 132
  Importing a Previous Version of a Description Key File 132
Using Description Parameters in Description Keys 133
Using Description Parameters to Scale and Rotate Description Keys 134
Dollar Sign, Asterisk ($*) Description Format Substitution Code 135
Using Wildcard Characters in Description Keys 136
Example: Creating a Utility Pole Description Key 139
Example: Formatting a Point Label Style to Use Description Key Substitution 141
Saving a Description Key File to a Prototype 142
Loading a Description Key File from a Prototype 143

Chapter 9  External Data References (XDRefs) 145
Using External Point References (XDRefs) 146
External Data Reference Requirements 146
New Features in the XDRef Manager for Release 2 of AutoCAD Land Development Desktop 147
Creating an External Point Database with Microsoft Access 147
Creating an External Data Reference (XDRef) 149
Changing the Properties of an External Data Reference (XDRef) 150
Deleting an External Data Reference (XDRef) 151
Example: Creating a Point Label Style that Labels Points with XDRef Information 151
Example: Using an External Database File and Point Groups to Substitute Point Information 153

Chapter 10  Managing Points 155
Selecting Points to Edit 156
Changing the Point Database Setup Settings 157
Displaying Information About Points in the Project 159
Printing Point Lists 160
Printing a Point List 160
Printing a Point List to a File 160
Setting Up the Printer for Printing a Point List 161
Previewing a Point List Before Printing 161
Locking and Unlocking Points 161
Displaying the Locked Point Numbers in a Project 162
Locking Points in a Project 162
Unlocking Points in a Project 162
Checking for Points in Projects and Drawings 163
Updating the Project Point Database with Drawing Point Information 163
Duplicate Point Numbers 165
Updating the Drawing with Project Point Information 165
Inserting Points into a Drawing 166
Removing Points from the Drawing 167
Chapter 11  Creating Points  169

Creating Points 170
  The Effect of Point Settings on Point Prompts 170
  Selecting Points and Locations 170
  Selecting Lines, Curves, and Spirals by Selecting Points 171
  Creating Points at Selected Coordinates 172
  Creating Points at Northing/Easting Coordinates 172
  Creating Points by Specifying Directions 173
  Creating Points by Turned or Deflection Angle 174
  Creating Points by Azimuths and Geodesic Distances 175
  Creating Points by Resection 176
  Creating Points by Station and Offset from an Object 177
  Creating Points at Object Vertices 178
  Creating Points Along a Line, Curve or Spiral 178
  Creating Points on Lines, Curves, or Spirals 179
  Creating a Specific Number of Points Along an Object 180
  Creating Points Equal Distances Along an Object 181
  Creating Points on Polylines and Contours by Using the Elevation of the
  Current Polyline 182
  Creating Points on Polylines or Contours by Using a Default Elevation 182

Creating Points at Intersections 183
  Creating Points at the Intersections of Directions 183
  Creating Points at the Intersections of Radial Distances 184
  Creating Points at the Intersections of Directions and Distances 185
  Creating Points that Are Perpendicular to Points and Directions 186
  Creating Points that Are Radial to Arcs and Points 187
  Creating Points at the Intersections of Objects and Directions 188
  Creating Points at the Intersections of Objects and Radial Distances 189
  Creating Points at Intersections of Objects 190
  Creating Points on Objects that Are Perpendicular or Radial to Points 191

Creating Points at Alignment Intersections 192
  Creating Points at the Intersections of Direction Lines and Alignments 192
  Creating Points at the Intersections of Distances and Alignments 194
  Creating Points at the Intersections of Objects and Alignments 195
  Creating Points at the Intersections of Alignments 196

Creating Points Based on Horizontal Alignments 197
  Creating Points that are Offset from Alignment Stations 197
  Creating Points on an Alignment Based on a Segment Length 198
  Creating Points on an Alignment Based on Station Intervals 199
  Creating Points on the Intersection Points of Alignments 200
  Creating Points on Alignments that are Radial or Perpendicular to
  Selected Points 201
  Creating Points on an Alignment by Importing ASCII Files 202

Creating Points Based on a Surface 204
  Creating a Point that Obtains Its Elevation from the Current Surface 204
  Creating a Grid of Points that Obtain Their Elevations from the
  Current Surface 204
Creating Points Along a Polyline or Contour that Obtain Their Elevations from the Current Surface 205
Creating Points at Polyline or Contour Vertices by Using the Elevations of the Surface 206
Creating Points Based on Slopes 206
Creating Points Where Two Grades or Slopes Intersect 206
Creating Points at a Given Slope or Grade for a Specified Distance 208
Create Points at a Given Slope or Grade Based on an Ending Elevation 209
Interpolating Points 211
Interpolating Points Along a Line 211
Creating Points Along a Specified Distance by Interpolation 212
Defining a 2D or 3D Polyline as an Interpolation Region 213
Defining an Arc as an Interpolation Region 214
Defining a Line as an Interpolation Region 214
Creating a Point at an Elevation by Interpolating Between Two Points or Contours 215
Creating a Number of Points Along a Specified Distance by Interpolation 216
Interpolating Points that are Perpendicular to the Control Points 217
Interpolating Points Using Distance Increments 217
Interpolating Points by Using Elevation Increments 218
Interpolating Points at Intersections of Entities 219

Chapter 12 Importing and Exporting Points 221
Importing and Exporting Points 222
Changing the COGO Database Import Options 223
Example: What to Do When the Point Number Already Exists in the Point Database 224
Creating a Point Import/Export Format 225
Creating a User Point File Import/Export Format 226
Creating a User Point Database Import/Export Format 229
Column Headings 231
<unused> 231
User Defined 231
Z+ 232
Z- 232
Thickness 233
XDRef 233
Easting 234
Northing 234
Elevation 234
Longitude 234
Latitude 235
Number 235
Name 235
Description 235
Grid Northing 235
Grid Easting 235
Degrees Longitude 236
Minutes Longitude 236
Seconds Longitude 236
Degrees Latitude 236
Minutes Latitude 236
Seconds Latitude 236
Hemisphere Longitude 237
Hemisphere Latitude 237
Copying an Existing Import/Export Format 237
Viewing an Existing Import/Export Format 237
Modifying an Existing Import/Export Format 238
Removing a Point Import/Export Format 238
Importing Point Data 239
Importing Points into the COGO Point Database 239
Exporting Point Data 241
Exporting Points from the COGO Point Database 242
Transferring Points 244
Converting Points in the COGO Database to a Different Coordinate Zone 246
Merging a Point Database into the Current Point Database 246

Chapter 13 Editing Points  249
Editing Points 250
Changing the Display Properties for Points in the Drawing 250
Editing Point Data in a Dialog Box 254
Changing the Elevations of Points 255
Example: Changing the Datum Elevation of Points 255
Renumbering Points 256
Moving Points 256
Rotating Points 257
Copying Points 257
Erasing Points 258
Restoring Erased Point Information 259
Changing the Coordinates of All Project Points 259
Changing the Rotation of All Project Points 261

Chapter 14  Creating Point Stakeout Reports  263
Creating Point Stakeout Reports 264
Changing the Stakeout Angle Type 264
Changing the Settings for Outputting Stakeout Files 265
Creating a Radial Stakeout Report 266
Creating a Curve Stakeout Report by Direction 267
Creating a Curve Stakeout Report of Offsets from Tangent 268
Chapter 15  Point Utilities  273
Point Utilities 274
Displaying Which Point Numbers Are Available to Use 274
Displaying the Locations of Points in the Project 274
Zooming to a Point Number 274
Zooming to the Point Extents 275
Drawing the Point Extents 275
Replacing Softdesk Point Blocks 275
Converting AutoCAD Points to COGO Point Objects 277
Packing the Point Database 277
Using the Geodetic Calculator 278

Chapter 16  Drawing Lines  281
Drawing Lines, Curves, and Spirals 282
Drawing Lines 282
Drawing a Line by Selecting Start and End Points 282
Drawing a Line Using a Range of COGO Points 283
Drawing a Line Using Individual Point Numbers 283
Drawing a Line Using Individual Point Numbers and a Range of
Point Numbers 284
Drawing a Curve with a Fixed Radius and Start Point 284
Drawing a Curve with Two Fixed Endpoints and a Variable Radius 285
Drawing a Line by Defining a Direction 285
Defining a Line by Bearing 286
Defining a Line by Azimuth 286
Defining a Line by Point Selection 287
Drawing a Line by Turned or Deflection Angle 287
Drawing a Line by Station and Offset 288
Extending or Shortening a Line by a Specified Distance 290
Drawing Lines from the Ends of Objects 290
Drawing a Best Fit Line Through Selected Points 291
Removing Points from the List for the Best Fit Line 292
Changing the Assigned Error of the Best Fit Line 293
Adding Points to the Best Fit Line 293
Drawing the Best Fitting Line 294
Drawing a Line Tangent to a Line or Curve 294
Drawing Lines Radial or Perpendicular to an Object 295
Chapter 17  Drawing Curves  297

Working with Curves 298
  Drawing a Curve Between Two Lines 298
  Defining a Curve by Length 299
  Defining a Curve by Tangent Length 299
  Defining a Curve by External Secant 299
  Defining a Curve by Degree of Curve 299
  Defining a Curve by Chord Length 300
  Defining a Curve by Middle Ordinate Distance 300
  Defining a Curve by Minimum Distance 300
  Defining a Curve by Radius 300
  Drawing a Curve on Two Lines 301
  Drawing a Curve Through a Point 301
  Drawing Multiple Curves 302
  Drawing a Curve From the End of an Existing Object 303
  Drawing a Curve Based on Radius 303
  Drawing a Reverse or Compound Curve 304
  Drawing a Best Fitting Curve Through Points 304
  Removing Points from the List for the Best Fit Curve 305
  Changing the Assigned Error for the Best Fit Curve 306
  Adding Points to the Best Fit Curve 306
  Drawing a Best Fitting Curve 307

Chapter 18  Drawing Spirals  309

Working with Spirals 310
  Selecting the Current Spiral Type 311
  Drawing Spirals Between Two Lines 312
    Drawing Two Spirals and an Intermediate Curve Between Two Tangents 312
    Drawing Two Spirals Between Two Tangents Without an Intermediate Curve 313
  Drawing Spirals Between Tangents and Curves 314
    Drawing a Spiral Between a Tangent and a Curve 314
    Drawing a Spiral, Curve, Compound Spiral, and a Reverse Spiral Between a Tangent and a Circular Curve 316
  Drawing Spirals Between Two Curves 317
    Drawing a Tangent and Two Spirals Between Two Curves, Using the Spiral Lengths as the Control Factors 317
    Drawing a Tangent and Two Spirals Between Two Curves, Using the Tangent Length as the Control Factor 319
    Drawing a Tangent and Two Spirals Between a Curve and a Reverse Curve, Using the Spiral Lengths as the Control Factors 321
    Drawing a Tangent and Two Spirals Between a Curve and a Reverse Curve, Using the Tangent Length as the Control Factor 322
    Drawing a Compound Spiral Between Two Curves 323
  Drawing a Curve and Two Compound Spirals Between Two Curves 325
Chapter 19  Drawing Special Lines and Curves  349

Special Lines and Curves 350
  Drawing a Stone Wall 350
  Drawing a Tree Line 351
  Drawing a Shore Line 352
  Drawing a Ledge 352
  Drawing a Guard Rail 353
  Drawing a Railroad Track 354
  Drawing a Retaining Wall 354
  Drawing a Line With Text on It 355
  Drawing a Line With a Symbol 356
  Drawing a Barbed Wire Fence 357
  Drawing a Stockade Fence 358
  Drawing a Chain Link Fence 358

Chapter 20  Alignments  361

Horizontal Alignments 362
  The Horizontal Alignment Database 362
    Sharing Access to Alignments Over a Network 363
Alignment File Locking 364
Alignment Locking when Working in More than One Session of
 AutoCAD Land Development Desktop 366
Access to Profile and Cross Section Data 366
Backwards Compatibility of Alignment Data 366
Drawing an Alignment 367
Making an Alignment Current 367
Defining Alignments 369
Defining an Alignment from Objects 369
Defining an Alignment from a Polyline 371
Creating Offsets for an Alignment 372
Using Station Equations to Change the Stationing of an Alignment 375
Clearing Station Equations 376
Adding Station Equations 376
Modifying Station Equations 377
Deleting Station Equations 377
Exiting the Equations Command 377
Editing Horizontal Alignments 378
Inserting, Deleting, or Editing an Alignment Point of Intersection 379
Editing a Horizontal Alignment Curve 381
Editing a Horizontal Alignment Spiral 382
Reporting Data About a Horizontal Alignment 386
Reporting Alignment Data by Station 387
Reporting Alignment Data by Curve 387
Reporting Alignment Data by Station and Curve 387
Reporting Alignment Data By Increments 387
Displaying Which Alignment is Current 388
Listing the Alignments Defined in the Current Project 388
Importing and Deleting Alignments 388
Importing a Horizontal Alignment 389
Deleting a Horizontal Alignment 389
Importing Multiple Horizontal Alignments 390
Deleting Multiple Horizontal Alignments 391
Changing the Properties of Alignments 392
Moving an Alignment to a Different Layer 393
Changing the Color of an Alignment 393
Changing the Linetype of an Alignment 394
Changing the Description of an Alignment 394
Merging Alignments from Different Projects 395
Saving the Alignment Database as an .adb File 398
Closing the Horizontal Alignment Database 399
Changing the Station Display Format 399
Changing the Alignment Label Settings 400
Stationing Alignments 402
Changing the Alignment Station Label Settings 402
Creating Station Labels on an Alignment 404
Contents

Labeling and Reporting the Station and Offset Values of Points in Relation to the Current Alignment 405
Labeling the Station and Offset of a Location in Relation to the Current Alignment 405
Reporting the Station and Offset of COGO Points in Relation to the Current Alignment 406

Staking Out an Alignment 408
Changing the Alignment Stakeout Settings 408
Changing the Output Settings for Stakeout Reports 409
Creating an Alignment Stakeout Report 410

Overview of Outputting Horizontal Alignment Data to ASCII Files 411
Changing the Settings for Outputting ASCII Files 411
Outputting Horizontal Alignment Data to an ASCII File 412

Chapter 21 Working with Parcels 415

Using the Parcels Commands 416
Drawing Parcels 416
Selecting a Curved Parcel Line 416
Changing the Parcel Settings 417
Managing Parcels 419
Reporting Parcel Area, Inverse, or Map Check Data 420
Importing Parcel Lines and Labels 422
Deleting Parcels 423
Renaming Parcels 424
Merging Parcel Data into the Current Project from Other Projects 424
Defining Parcels 426
Defining a Parcel from Lines and Curves 426
Defining a Parcel from a Polyline 427
Defining a Parcel from Points 427
Sizing Parcels So They Are Specific Areas 428
Sizing a Parcel Using a Sliding Bearing Line 428
Sizing a Parcel Using a Radial Line 430
Sizing a Parcel by Swinging a Bearing to a Line 432
Sizing a Parcel by Swinging a Bearing to a Curve 433
Breaking Parcel Lines and Curves 434

Chapter 22 Getting Started with Labels 435

Using the Labels Commands 436
Creating a Selection Set for Labeling 436
Changing the Label Settings 437
Specifying Which Folder Contains the Label Styles 437
Specifying How Labels are Updated 439
Updating Labels Manually 440
Changing the Settings for Labeling Lines 441
The Effects of Label Alignment 442
Chapter 23  Label Styles  447
Label Styles 448
Selecting the Current Label Style 448
   Making a Selected Label Style the Current Label Style 449
   Selecting the Current Label Style from the Style Properties Dialog Bar 449
   Selecting the Current Label Style from the Labels Settings Dialog Box 450
Style Properties Dialog Bar 450
   Changing the Label Alignment Setting from the Style Properties Dialog Bar 451
   Accessing the Edit Label Styles Dialog Box from the Style Properties Dialog Bar 451
   Accessing the Label Settings Dialog Box from the Style Properties Dialog Bar 451
   Switching Between Label Styles and Tag Label Styles in the Style Properties Dialog Bar 451
Editing Line Label Styles 452
Editing Curve Label Styles 458
Editing Spiral Label Styles 462
Editing Point Label Styles 467
Using a Formula Within a Label Style to Convert Values 473
   Example: Converting Feet to Meters 475
   Example: Labeling the Magnetic Direction 476
   Example: Using the TRUNC Function 476

Chapter 24  Labeling Objects  477
Dynamic Labels 478
   Creating Dynamic Labels 478
   Updating Selected Dynamic Labels 479
   Updating All Dynamic Labels in the Drawing 479
   Swapping Label Text 480
   Changing the Angular Direction of a Label 480
   Deleting Labels 481
   Disassociating Labels to Prevent Auto-Updating 481
   Grip Editing Label Text 482
   Changing the Properties of Labels 482
Static Labels 484
   Creating Static Labels 484
   Labeling Line and Curve Segments 485
   Labeling Line Segments By Selecting Points to Define the Line Segments 486
Labeling Curve Segments by Selecting Points to Define the Curve Segments 487
Labeling Polylines 488
Labeling Points with Northing and Easting Coordinates 489
Labeling Points with Geodetic Information 489
  Changing the Geodetic Point Label Settings 490
  Changing the Geodetic Line Label Settings 491
Labeling a Point with Geodetic Data 492
Labeling a Line with Geodetic Data 492
Creating a Building Offset Label 493

Chapter 25 Creating Object Tables 495
Tag Labels and Object Tables 496
Tag Label Styles 496
  Editing Line Tag Label Styles 496
  Editing Curve Tag Label Styles 499
  Editing Spiral Tag Label Styles 501
Creating Tag Labels 503
Creating Object Tables 503
  Creating a Line Table 503
  Creating a Curve Table 509
  Creating a Spiral Table 513
  Changing the Column Definitions of a Spiral Table 514
Editing Object Tables 516
Updating Object Tables 517
Deleting Object Tables 518

Chapter 26 Creating Surface Models 519
Using the Terrain Commands 520
Creating Surfaces 520
The Terrain Model Explorer 522
Creating a New Surface 523
Building a Surface 524
  Minimizing Flat Triangles Resulting from Contour Data 527
Creating Surface Data and Adding It to the Surface Folders 527
  Deleting Data from the Terrain Model Explorer Folders 528
Adding Point Groups to the Surface Folder to Use in Surface Generation 528
Adding Point Files to the Surface Folder to Use in Surface Generation 529
  Creating a Surface Point File Manually 530
Creating Surface Point Data from Objects 531
  Adding to the Surface Point File by Selecting AutoCAD Point Nodes 531
  Adding to the Surface Point File by Selecting Lines 532
  Adding to the Surface Point File by Selecting Blocks 533
  Adding to the Surface Point File by Selecting Text 534
  Adding to the Surface Point File by Selecting 3D Faces 534

Contents xvii
Adding to the Surface Point File by Selecting Polyfaces 535
Creating Contour Data to Use in Surface Generation 536
  Creating Contour Data to Use in Surface Generation 537
Deleting Contour Data from a Surface Folder 539
Contour Data and Surface Triangulation 539
  Missing Contour Information 539
Creating Breakline Data to Use in Surface Generation 540
  Creating Breaklines from Points 541
  Creating Breaklines from Point Numbers 542
  Creating Breaklines from 2D or 3D Polylines or Lines 543
  Creating Breaklines from 3D Lines 544
  Importing Breakline Definitions from a Text File 545
  Creating a Breakline File Manually 546
  Proximity Breaklines 547
  Defining Proximity Breaklines by Selecting Points 548
  Defining Proximity Breaklines by Selecting Polylines 548
  Defining Walls or Curbs as Breaklines 550
Identifying Breaklines in a Drawing 552
Listing the Breaklines in the Project 553
Importing Breaklines into a Drawing 554
Editing Breaklines 555
  Changing the Description of a Breakline 556
  Updating Edited Breaklines 556
  Deleting Breaklines 557
  Exporting Breakline Data to a Text File 558
Creating Boundary Data to Use in Surface Generation 559
  Adding a Boundary to the Surface Folder to Use in Surface Generation 559
  Importing a Surface Boundary 562
Using Roadway Cross Sections as Surface Data 563

Chapter 27  **Surface Statistics  565**
Statistics for Terrain Surfaces 566
Overall Statistics for a Surface 566
  Description of the Surface 566
  Surface Data 567
  Surface Statistics 567
  Extended Surface Statistics 568
Statistics for Surface Data Folders 568
  TIN Data Statistics 568
  Edit History Information 569
  Watershed Information 569
  Point Group Information 570
  Point File Information 570
  Contour Information 570
  Breakline Information 571
  Boundary Information 571
Chapter 28  Managing Surfaces  573
Managing Surfaces 574
Making a Surface Current 574
Opening an Existing Surface and Making It Current 575
Saving a Surface 575
Saving a Surface with a Different Name 576
 Saving the Current Surface 576
Closing a Surface 576
Copying a Surface 577
Deleting a Surface 577
Renaming a Surface 577
Calculating Extended Statistics for a Surface 578
Surface Locking 578
Changing Surface Properties 578
Managing Volume Surfaces 579
Opening a Volume Surface and Make it Current 579
Closing a Volume Surface 580
Saving a Volume Surface 580
Renaming a Volume Surface 580
Copying a Volume Surface 581
Deleting a Volume Surface 581
Changing the Volume Surface Properties 582

Chapter 29  Creating Watershed Models  583
Creating Watershed Models 584
Changing the Watershed Settings 584
Changing Watershed Properties 586
Creating a Watershed Model When Building a Surface 588
Creating a Watershed Model After Building the Surface 589
Importing the Watershed Boundaries into the Drawing 590
Importing Individual Watershed Boundaries Into a Drawing 591
Watershed Types 593

Chapter 30  Editing Surfaces  599
Editing Surfaces 600
  Importing the Surface as 3D Lines 600
The Edit History of Surfaces 600
    Deleting Edits from a Surface's Edit History 601
Adding TIN Lines to a Surface 601
Deleting TIN Lines from a Surface 602
Flipping TIN Faces on a Surface 602
Adding Points to a Surface 603
Deleting Points from a Surface 603
Changing the Elevations of Surface Points 603
Adding Non-Destructive Breaklines to a Surface 604
Minimizing Flat Faces on a Surface That is Generated from Contours 606
Changing the Elevations of the Current Surface or Copying a Surface with a Relative E elevational Change 606
Pasting Two Surfaces Together 607
Editing a Surface to Define or Remove Surface Boundaries 608
Defining Surface Boundaries After Building a Surface 609
Removing Surface Boundaries After Building a Surface 610
Creating Surface Borders 610
Creating a 2D Line Surface Border 611
Creating a 3D Line Surface Border 611
Creating a 2D Polyline Surface Border 611
Creating a 3D Polyline Surface Border 612

Chapter 31 Displaying Surfaces 613

Using the Surface Display Commands 614
Changing the Surface Display Settings 614
Viewing the Surface TIN Lines as Temporary Vectors 615
Viewing the Surface TIN Lines as 3D Faces 615
Viewing the Surface TIN Lines as a Polyface Mesh 616
Changing the Surface Display Based on Elevation Ranges 617
Changing the Surface Elevation Shading Settings 617
Defining the Auto-Range Elevation 619
Defining the User-Range Elevation 620
Creating 2D Solids Using the Average Method that Show the Elevations of a Surface 621
Creating Legends that Explain Surface Views 622
Creating 3D Faces Using the Average Method that Show the Elevations of a Surface 623
Creating a Polyface Using the Average Method that Shows Surface Elevations 624
Creating 2D Solids Using the Banding Method that Show the Elevations of a Surface 625
Creating 3D Faces Using the Banding Method that Show the Elevations of a Surface 626
Changing the Surface Display Based on Slope Settings 627
Changing the Surface Slope Shading Settings 627
Defining the Auto-Range Slope 629
Defining the User-Range Slope 629
Creating 2D Solids that Show the Slopes of a Surface 630
Creating 3D Faces that Show the Slopes of a Surface 631
Creating a Polyface Mesh that Shows the Slopes of a Surface 632
Drawing Arrows on a Surface that Show Surface Slopes 633
Creating a Surface Grid of 3D Faces 634
 Changing the Surface 3D Grid Generator Settings 636
Creating a Surface Grid of 3D Polylines 639
 Changing the Surface 3D Polyline Grid Settings 641
Using Surface Utilities 643
 Drawing Water Drop Paths on the Current Surface 643
 Projecting Lines, Curves, or Polylines onto a 3D Grid Surface 644
 Labeling the Elevation of a Surface Point 645
 Viewing the Surface from a Specified Point 646
 Viewing the Surface Along a Polyline Path 648

Chapter 32 Creating and Managing Contours 651

Creating and Managing Contours 652
 Advantages of Using the Contour Object 652
Using the Contour Style Manager 653
 Changing the Contour Appearance Settings 653
 Changing the Contour Text Style Settings 655
 Changing the Contour Label Position Settings 656
Managing Contour Styles 657
 Creating a New Contour Style 658
 Selecting the Current Contour Style 658
 Deleting a Contour Style from the Current Drawing 659
 Saving Contour Styles to the Contour Style Folder 659
 Deleting Contour Styles from the Contour Style Folder 659
 Renaming Contour Styles in the Contour Style Directory 660
 Loading Contour Styles into a Drawing 660
 Changing the Contour Styles Path 661
 Creating Contours From a Built Surface 661
 Creating Contours From a Surface 661
 Changing Contour Properties 664
 Showing or Hiding Contour Grips 664
 Editing Contours Using Grips 665
Labeling Contours 665
 Labeling the End of a Contour 666
 Labeling the Ends of Multiple Contours 666
 Labeling a Contour at a Selected Location 668
 Labeling Multiple Contours at a Selected Location 668
 Deleting Contour Labels 670
 Deleting All Contour Labels from Selected Contours 670
 Showing or Hiding Contour Labels 671
 Showing or Hiding Contour Label Grips 671
 Editing Contour Labels Using Grips 671
Using Contour Utilities to Create and Edit Contours 672
 Converting Polylines to Contours 672
 Exploding Contours to Polylines 672
Digitizing Contours 673
Digitized Contours 674
Changing Contour Elevations 675
Changing the Elevations of Selected Contours 675
Changing the Elevation of Each Contour on a Layer 676
Changing Contour Elevation Datum by Adding or Subtracting a Value 676
Assigning Elevations to Contours or Polylines 677
Finding and Changing Contours with Zero Elevations 678
Weeding Contours to Remove and Add Points 678
Creating Contours by Copying and Offsetting 679
Copying Finished Ground Contours to Another Layer 679
Copying and Offsetting the Contours Using a Slope and an Elevation Increment 680
Copying and Offsetting Contours by Using a Grade and an Elevation Increment 681
Creating Multiple Offsets of a Contour Within a Specified Distance 682
Creating Multiple Offsets of a Contour Until the Elevation you Specify is Obtained 683

Chapter 33 Working with 3D Polylines 685
Creating 3D Polylines 686
Creating 3D Polylines by Referencing the Elevations of Points 686
Creating 3D Polylines by Referencing Points and Slopes 688
Creating a Curb by Offsetting a 3D Polyline and Applying a Single Elevation Change 690
Creating a Step by Offsetting a 3D Polyline and Applying the Elevation Changes to Each Vertex 692
Converting 3D Polylines to 2D Polylines 693
Converting 2D Polylines to 3D Polylines 694
Editing a 3D Polyline 695
Filleting 3D Polyline Vertices 696
Displaying 3D Polyline Grade Breaks 697
Adding Vertices to a Polyline 697
Joining 3D Polylines 699
Weeding 3D Polyline Vertices 699

Chapter 34 Creating and Managing Surface Sections 701
Creating Surface Sections 702
Creating Surface Sections that You Can Import and Query 702
Turning Multiple Surfaces On or Off for Creating Surface Sections 702
Creating Surface Sections from Multiple Surfaces 702
Defining Surface Sections 703
Processing Surface Sections 704
Importing Surface Sections into the Drawing 705
Placing a Grid Over Surface Sections 706
## Chapter 35 Calculating Volumes

Using Volume Calculation Methods 716

Volume Calculation Methods 716
  - Using the Grid Method 716
  - Using the Composite Method 717
  - Using the Section Method 718

Using a Stratum for Volume Calculations 720
  - Defining a Stratum 721
  - Selecting the Current Stratum 721
  - Deleting a Stratum 722

Using Sites for Volume Calculations 722
  - Changing the Volume Site Settings 722
  - Defining a Site for Volume Calculations 724

Managing Site Definitions 727
  - Reporting Site Information 727
  - Importing Sites into the Drawing 728
  - Deleting Sites from the Project 729

Calculating Grid Volumes 729
  - Changing the Grid Volume Settings 729
  - Calculating Total Site Volumes Using the Grid Method 731
  - Calculating Parcel Volumes Using the Grid Method 732
  - Creating a Grid of Ticks That Shows Cut and Fill Areas on Volume Surfaces 733

Calculating Composite Volumes 735
  - Changing the Composite Volume Settings 735
  - Calculating Total Site Volumes Using the Composite Method 736
  - Calculating Parcel Volumes Using the Composite Method 737

Calculating Section Volumes 739
  - Changing the Section Volume Settings 739
  - Using the Prismoidal Volume Calculation Method 740
Using the Average End Area Volume Calculation Method 740
Sampling Section Data for Volume Calculations 741
Editing Sampled Section Data for Volume Calculations 742
Calculating Total Site Volumes Using the Section Method 743
Reporting Section Volume Data 745
Plotting Volume Sections 745
  Changing the Section Volumes Plotting Settings 745
  Changing the Section Layout Settings for Plotting Section Volumes 747
  Changing the Page Layout Settings for Plotting Section Volumes 748
Selecting the Text Size to Use for Plotted Volume Sections 750
Plotting a Single Volume Section 750
Plotting All Volume Sections for a Site 751
Plotting a Page of Volume Sections 752
Importing Volume Sections into the Current Drawing 753
Importing Volume Sections into Another Drawing 754
Outputting Volume Data 754
  Reporting Total Volume Data for a Site 754
  Creating a Total Volume Table for a Site 755
  Creating an ASCII File of Total Volume Data for a Site 757
Reporting Parcel Volume Data 758
  Creating a Parcel Volume Table 758
  Creating an ASCII File of Parcel Volume Data 759

Chapter 36  Managing Terrain Layers 761
Using the Layer Commands 762
  Managing the Surface Layer 762
  Managing the Border Layer 762
  Managing the Range Layers 763
  Managing the Contour Layers 763
  Managing the 3D Grid Layer 763
  Managing the Polyline Grid Layer 764
  Managing the 3D Projection Layer 764
  Managing the Water Drop Layer 765
  Managing the Site Grid Layer 765
  Managing the Volume Ticks Layers 766

Chapter 37  Performing Inquiries on Drawing Features 767
Using the Inquiry Commands 768
  Listing the Northing and Easting of a Location 768
  Listing the Latitude and Longitude of a Location 768
  Listing the Geodesic Information of a Line 769
  Listing the Station and Offset of a Location in Relation to an Object 769
  Listing the Station and Offset of a Location in Relation to the Current Alignment 770
Identifying Object Geometry 771
Introduction

AutoCAD Land Development Desktop is the AutoCAD for land development professionals such as surveyors, civil engineers, and land planners.
About AutoCAD Land Development Desktop

AutoCAD Land Development Desktop Release 2 is part of the Land Development Solutions II suite of applications for professionals in the land planning and development industries. The Land Development Solutions II suite includes:

■ **AutoCAD® Land Development Desktop Release 2**: This is the AutoCAD for Land Development professionals. It provides a base level of functionality that meets the needs of everyone in the land development process, including land planners, surveyors, civil engineers, drafters, and anyone who creates supporting documents. AutoCAD Land Development Desktop provides an Application Programming Interface (API), so that other add-on products can be designed to work with AutoCAD Land Development Desktop.

■ **Autodesk® Survey Release 2**: An add-on to AutoCAD Land Development Desktop that provides a streamlined ability to communicate survey data to and from the field.

■ **Autodesk® Civil Design Release 2**: An add-on to AutoCAD Land Development Desktop that provides transportation and site engineering tools, and hydrology and hydraulics design and analysis.

For more information about Autodesk Survey and Autodesk Civil Design, see the *Autodesk Survey User’s Guide* and the *Autodesk Civil Design User’s Guide*.

Getting Started

Much of the basic information on how to get started with AutoCAD Land Development Desktop is located in the *AutoCAD Land Development Desktop Getting Started Guide*. The *Getting Started Guide* describes the AutoCAD Land Development Desktop documentation set and tells you where to look for the information you need.

The *Getting Started Guide* also describes how to start the program and how to switch menu palettes so you can access all of the AutoCAD Land Development Desktop commands.
Starting a Drawing Session

When you first start AutoCAD Land Development Desktop, you are prompted to create a new drawing or open an existing drawing. To use the AutoCAD Land Development Desktop commands, you must be working in a named drawing, and the drawing must be associated with a project. In addition, you must load the Land Desktop menu palette to access all of the program’s commands.
Starting a Drawing Session from the Start Up Dialog Box

When you initialize AutoCAD Land Development Desktop, the Start Up dialog box is displayed. Use this dialog box to open an existing drawing, start a new drawing, or access the Project Management dialog box.

Opening a Recently Used Drawing

You can open a drawing from the Most Recently Used list in the Start Up dialog box. This list displays the four most recently used drawings. If you move, rename, or delete any of the four drawings you most recently worked on, then they are not displayed in this list.

To select a drawing that you recently worked on

1. Start AutoCAD Land Development Desktop.
   The Start Up dialog box is displayed.
2. From the Most Recently Used list, double-click the file name. You can also click the file name you want to open and click OK.
Using the Start Up Dialog Box to Open Drawings, Create New Drawings, and Access the Project Management Dialog Box

You can use the options in the Start Up dialog box to do the following:

- **Open drawings.** For more information on how to open a drawing, see “Opening an Existing Drawing” in this chapter.
- **Create new drawings and projects.** For more information on how to start a new drawing, see “Starting a New Drawing” in this chapter.
- **Manage projects.** For more information on how to manage projects, see “Managing Projects” in Chapter 3, “Projects and Prototypes.”

Turning Off the Display of the Start Up Dialog Box

You can turn off the Start Up dialog box so it does not display when you start AutoCAD Land Development Desktop.

**To turn off the display of the Start Up dialog box**

1. Start AutoCAD Land Development Desktop.
   The Start Up dialog box is displayed.
2. Clear the Show this dialog at start up check box.
3. The next time you start up AutoCAD Land Development Desktop, the Start Up dialog box is not displayed. You can redisplay it if needed, by selecting the Use Land Development Startup check box in the User Preferences dialog box, which you can access by choosing User Preferences from the Projects menu.

![User Preferences Dialog Box](image)

Starting a Drawing Session from the Start Up Dialog Box
Starting a New Drawing

AutoCAD Land Development Desktop uses an enhanced, project-based, New command for creating new drawings. By selecting a project to associate the drawing with, the drawing is created in the correct folder for the project automatically.

AutoCAD Land Development Desktop requires that a drawing be named to be associated with a project. The unnamed “drawing.dwg” cannot be associated with a project.

NOTE This topic describes how to use the AutoCAD Land Development Desktop New command. If you chose to use the AutoCAD New command in the User Preferences, then see the AutoCAD User’s Guide for more information.

To start a new drawing

1 From the File menu, choose New to display the New Drawing: Project Based dialog box, or type New at the command line.

2 Under Drawing Name, type the name of the drawing you want to create.
   The drawing name can be up to 255 characters, including path and file extension, and it must be unique. You cannot create two drawings with the same name in the same drawing folder. It is not necessary to add .dwg to the end of the name; the drawing file extension is created automatically.
3 Under Project and Drawing Location, do one of the following:
  ■ Select an existing project. For more information, see the following section, “Selecting an Existing Project from the New Drawing: Project Based Dialog Box.”
  ■ Create a new project. For more information, see the following section, “Creating a New Project from the New Drawing: Project Based Dialog Box.”

NOTE For detailed information about projects, see Chapter 3, “Projects and Prototypes.”

4 Under Select Drawing Template, select a drawing template. The Preview window shows a preview of the drawing template.
If the template you want to use is not visible in the list, then click Browse to locate it. You can select the Show sub-folders check box to view the files inside any sub-folders that may exist in the template folder. For more information about drawing templates, see the following topic “Basing a Drawing on a Drawing Template.”

5 Click OK.

Basing a Drawing on a Drawing Template
When you create a new drawing, you can base it on a drawing template. A drawing template is a drawing file with pre-established settings for new drawings and has the extension .dwt. For example, you can set up all your standard layers in a drawing and save the drawing as a .dwt file. If you base a new drawing on this template, then the new drawing is created with all your standard layers. Templates also store text styles, line types, dimension styles, and AutoCAD variables like Aperture. They can also store blocks, such as a border or a company logo.
A template also stores drawing setup values. For example, if you use the Drawing Setup Wizard or the Drawing Setup command to set up a drawing, and then you save that drawing as a .dwt file, then the next time you create a new drawing based on the drawing template, all of the drawing setup values will be loaded.

Selecting an Existing Project from the New Drawing: Project Based Dialog Box
To select an existing project from the New Drawing: Project Based dialog box

1 Complete steps 1–2 the previous section, “Starting a New Drawing.”
2 Under Project and Drawing Location, select a Project Path from the list. Select the folder in which the project you want to select is stored. By default, the project path is c:\Land Projects R2.
If the list does not show a project path, then you can browse for one by clicking the Browse button to display the Browse for Folder dialog box:

3. Locate the path and click OK to return to the New Drawing: Project Based dialog box.

4. Under Project Name, select the name of the project you want to associate the new drawing with. This list shows all projects stored in the Project Path that you selected in step 2.

If this list does not show the project name that you want to select, then verify that you selected the correct Project Path in step 2.

TIP: Click Filter Project List to filter the project list by keyword or creator. For more information, see “Using Filters to Find a Project” in this chapter.

5. The Drawing Path shows where the drawing is created. If the drawing path has any sub-folders, then you can choose a sub-folder. Otherwise, this path is fixed. This path is based on the drawing location that you specify when you create a new project. For example, the recommended storage location for drawings is in the <project name>\dwg folder. If you create a sub-folder in the drawing storage location, such as <project name>\dwg\plotting, then it is also listed in the Drawing Path list for you to choose.

Creating a New Project from the New Drawing: Project Based Dialog Box

To create a new project from the New Drawing: Project Based dialog box

1. Complete steps 1–2 in “Starting a New Drawing” in this chapter.
2 Under Project and Drawing Location, click Create Project to display the Project Details dialog box.

3 Under Initial Settings for New Drawings, select the prototype to base the project on. A prototype contains default settings for new drawings associated with the project.

4 Under Project Information, type a Name for the project. This name can be up to 64 characters.

5 Type a Description for the project. This description can be up to 255 characters.

6 You can type keywords for the project. Type a comma or press SPACEBAR to separate each keyword. Keywords can help you identify a project when you are searching for a project. For example, you could use a keyword called “county” to help you locate all your county projects.

7 Under Drawing Path for this Project, select one of the following options to determine where drawings that you create in this project are stored:
   - Select Project “DWG” Folder if you want to store the drawings in the DWG folder in the project folder, \Land Projects R2\<project name>\dwg. This is the recommended location for storing drawings, because it keeps all the project files together.
   - Select Fixed Path, and type or browse for a path for the drawings.

8 Click OK to create the project and return to the New Drawing: Project Based dialog box.

NOTE For detailed information about projects and prototypes, see Chapter 3, “Projects and Prototypes.”
Using Filters to Find a Project

When you click Filter Project List from the New Drawing: Project Based dialog box, the Project Filter Criteria dialog box is displayed. For more information about the New Drawing: Project Based dialog box see “Starting a New Drawing” in this chapter.

To use filters to find a project

1. From the Keywords list, select the keyword you want to search for. If you do not want to search by keyword, then select Unfiltered by keyword.

2. From the Created By list, select the AutoCAD login name of the person who created the project. If you do not want to search by the person who created the project, then select Unfiltered by created by.

   The filtered list of projects is displayed in the Filtered Projects List.

   **TIP**
   
   If you want to save the filtered project list, then select the Save filter criteria check box.

3. Click OK to return to the previous dialog box.

   The Name list now contains only the list of projects that you filtered on.

4. Select the project that you want to use from the Name list.
Opening an Existing Drawing

AutoCAD Land Development Desktop uses an enhanced, project-based, Open command for opening drawings. First select the project to work with, and then select the drawing to open from a list of available drawings. If you need to search for a drawing outside of the project folder, then use the Browse button to open the drawing.

**NOTE** Only one drawing can be open at a time with AutoCAD Land Development Desktop Release 2.

**NOTE** This topic describes how to use the AutoCAD Land Development Desktop Open command. If you selected the User Preference for using the AutoCAD Open command, then see the AutoCAD User’s Guide.

To open an existing drawing

1. From the File menu, choose Open to display the Open Drawing: Project Based dialog box, or type Open at the command line.

2. Under Project and Drawing Location, select a Project Path from the list. Select the folder in which the project you want to select is stored. By default, the project path is c:\Land Projects R2.
   
   You can click Browse to locate a project path if it is not shown in the list.

3. Under Project Name, select the name of the project that contains the drawing you want to open. This list shows all the projects stored in the Project Path you selected in step 2.
If this list does not show the project name that you want to select, then verify that you selected the correct Project Path in step 2.

**TIP**
Click Filter Project List to filter the project list by keyword or creator.

4 The Drawing Path shows where the drawing is stored. If the drawing path has any sub-folders, then you can choose a sub-folder. Otherwise, this path is fixed. This path is based on the drawing location that you specify when you create a new project. For example, the recommended storage location for drawings is in the `<project name>\dwg` folder. If you create a sub-folder in the drawing storage location, such as `<project name>\dwg\plotting`, then it is also listed in the Drawing Path list for you to choose.

5 Under Select Project Drawing, select the drawing you want to open. The preview window displays a preview of a drawing.

If the drawing is located in a sub-folder of the Drawing Path, then you can select the Show Sub-folders check box to display the contents of any sub-folders that exist in the Drawing Path.

**NOTE**
If the drawing you want to open is not located in a project drawing path, then use the Browse button to search for the drawing.

6 Click OK.

**NOTE**
If the drawing is associated with a project name that is different than the project selected, then you are prompted to choose a project.

### Using Menu Palettes

AutoCAD Land Development Desktop menus are arranged in palettes. A menu palette defines which pull-down menus appear on screen. The default menu palettes that are installed with AutoCAD Land Development Desktop include the following:

- **Land Desktop R2**: A menu palette that contains all the AutoCAD Land Development Desktop menus (Projects, Points, Lines/Curves, Alignments, Parcels, Labels, Terrain, Inquiry, Utilities, Help), the Map menu, and the AutoCAD File, Edit, and View menus. This menu palette is loaded by default when you start AutoCAD Land Development Desktop for the first time.

- **Land Desktop R2 Complete**: A menu palette that contains all the AutoCAD Land Development Desktop menus, the Map menu, and the AutoCAD File, Edit, View, Insert, Format, Tools, Draw, Dimension, and Modify menus.
■ **AutoCAD Map 2000**: A menu palette that contains the standard AutoCAD Map 2000 menu, the AutoCAD Land Development Desktop Projects menu, and the AutoCAD File, Edit, Insert, Format, Tools, Draw, Dimension, and Modify menus.

■ **Civil Design R2** (If installed): A menu palette that contains the Civil Design menus (Grading, Layout, Profiles, Cross Sections, Hydrology, Pipes, Sheet Manager), the AutoCAD Land Development Desktop Projects, Points, Terrain, Alignments, Inquiry, Utilities, and Help menus, the Map menu, and the AutoCAD File, Edit, and View menus.

■ **Survey R2** (If installed): A menu palette that contains the Survey menus (Data Collection/Input, Analysis/figures), the AutoCAD Land Development Desktop Projects, Points, Lines/Curves, Labels, Terrain, Inquiry, Utilities, and Help menus, the Map menu, and the AutoCAD File, Edit, and View menus.

**NOTE** Menu palettes with toolbars are not supported in AutoCAD Land Development Desktop Release 2.

To create a custom menu palette, you can use the `MENULOAD` command to set up the AutoCAD, AutoCAD Map, and AutoCAD Land Development Desktop menus the way you want them, and then save this configuration as a palette.

Menu palettes are saved in the `c:\Land Desktop R2\data\Menu Palettes` folder. Release 2 menu palettes have the file extension `.apm2`, whereas Release 1 menu palettes have the file extension `.apm`.

**Restoring Original Palettes**

If you customize the default menu palettes and you want to return to the original palettes, backups are stored in the `\data\Menu Palettes\Original` folder. You can copy these palettes up one level to the `\data\Menu Palettes` folder to restore the original palettes.

**Selecting a Menu Palette**

By default, the Land Desktop R2 menu palette is displayed the first time that you run AutoCAD Land Development Desktop. You can select a different menu palette, such as the Land Desktop R2 Complete menu palette, if you want to access different menus.

There are three different ways to select a menu palette. You can select a menu palette from the Menu Palette Manager dialog box, you can use a macro, or you can use a command-line command.
To select a menu palette from the Menu Palette Manager dialog box

1. From the Projects menu, choose Menu Palettes to display the Menu Palette Manager dialog box. Or type MP at the command line.

2. Select the menu palette that you want to load.
   - To use AutoCAD Land Development Desktop commands, select the Land Desktop R2 palette.
   - To use AutoCAD Land Development Desktop and commands in the AutoCAD Insert, Format, Tools, Dimension, and Modify menus, select the Land Desktop R2 Complete palette.
   - If you have Autodesk Civil Design installed and want to use Civil Design commands, then select the Civil Design R2 menu palette.
   - If you have Autodesk Survey installed and want to use Survey commands, then select the Survey R2 menu palette.
   - To use the AutoCAD Map 2000 menu palette, select the AutoCAD Map 2000 palette.

3. Click Load.

Selecting a Menu Palette by Using a Macro

To select a menu palette by using a macro

Type one of the following macros at the command line to quickly load a menu palette:

- MLD: AutoCAD Land Development Desktop
- MLC: AutoCAD Land Development Desktop with additional AutoCAD menus
- MCD: Autodesk Civil Design
- MSV: Autodesk Survey
- MMP: AutoCAD Map 2000
Selecting a Menu Palette by Using a Command at the Command Line

To load a menu palette at the command line

- Type `(AeccLoadMenuPalette "MenuPaletteName")` at the command line.
  For example, to load the Land Desktop R2 menu palette, type the following:
  
  `(AeccLoadMenuPalette "Land Desktop R2.apm2")`

Creating a Menu Palette

You can create a new menu palette that contains the menus that you use frequently. Configure the AutoCAD, Map, and AutoCAD Land Development Desktop menus the way you want them, and then save the configuration as a menu palette. Menu palettes make it easy to switch between different menus when you focus on different aspects of a project.

Menu palettes are saved in the c:\Land Desktop R2\data\Menu Palettes folder. Release 2 menu palettes have the file extension, .apm2.

**NOTE**
If Autodesk Survey and Civil Design are installed, then you can also create menu palettes that include the menus from these programs.

**NOTE**
Menu palettes with toolbars are not supported in AutoCAD Land Development Desktop Release 2.

To create a menu palette

1. Use the MENULOAD command to select which pull-down menus you want to include in the menu palette.
2. Click the Menu Bar tab.

![](image)
3 From the Menu Group, choose a program to display the menus for that program.
4 Use the Insert, Remove, or Remove All buttons to add or delete menus to the Menu Bar.
5 Click Close.
6 From the Projects menu, choose Menu Palettes to display the Menu Palette Manager dialog box.
7 Click Save to display the Save Menu Palette dialog box.

![Save Menu Palette dialog box](image)

8 In the Name box, type the name for the new palette.
9 In the Description box, type the description of the new palette. You may want to include the names of the menus in this description.
10 Click OK to return to the Menu Palette Manager dialog box.
11 Click Close.

The menu palette is saved to the \c:\Land Desktop R2\data\Menu Palettes folder with an .apm2 file extension.

### Changing the Name or Description of a Menu Palette

You can change the name or description of a menu palette. For example, if you copy a menu palette and make changes to the copy, you may want to alter the description of that palette.

**To change the name or description of a menu palette**

1 From the Projects menu, choose Menu Palettes to display the Menu Palette Manager dialog box.
2 Select the menu palette that you want to rename.
3 Click Rename to display the Rename Menu Palette dialog box.

![Rename Menu Palette dialog box]

4 Do one or both of the following:
   ■ In the Name box, type a new name.
   ■ In the Description box, type a new description.

5 Click OK to return to the Menu Palette Manager dialog box.

6 Click Close.

**Saving a Menu Palette**

You can create a new menu palette that contains the menus that you use frequently. Configure the AutoCAD, Map, and AutoCAD Land Development Desktop menus the way you want them, and then save the configuration as a menu palette. Menu palettes make it easy to switch between different menus when you focus on different aspects of a project.

Menu palettes are saved in the c:\Land Desktop R2\data\Menu Palettes folder. Release 2 menu palettes have the file extension .apm2.

**NOTE** If Autodesk Survey and Civil Design are installed, then you can also create menu palettes that include the menus from these programs.

**NOTE** Menu palettes with toolbars are not supported in AutoCAD Land Development Desktop Release 2.

**To save a menu palette**

1 From the Projects menu, choose Menu Palettes to display the Menu Palette Manager dialog box.
2 Click Save to display the Save Menu Palette dialog box.
3 In the Name box, type the name for the new palette.
4 In the Description box, type the description of the new palette.
5 Click OK to save the menu palette and return to the Menu Palette Manager dialog box.
6 Click Close.

The menu palette is saved to the c:\Land Desktop R2\data\Menu Palettes folder with an .apm2 file extension.
Deleting a Menu Palette

To delete a menu palette

1. From the Projects menu, choose Menu Palettes to display the Menu Palette Manager dialog box.
2. Select the name of the menu palette that you want to delete.
3. Click Delete to display a warning dialog box.
4. Click Yes if you want to delete the menu palette, or No to cancel the command.
5. Click Close.

Unloading Applications

To unload Autodesk Civil Design or Autodesk Survey floating licenses without exiting AutoCAD Land Development Desktop, you can use the Unload Applications command.

Unloading Civil Design

You can use the Unload Applications ➤ Autodesk Civil Design command to unload Civil Design and free up a floating license for someone else to use.

To unload Civil Design

- From the Projects menu, click Unload Applications ➤ Autodesk Civil Design.

Unloading Survey

You can use the Unload Applications ➤ Autodesk Survey command to unload Survey and free up a floating license for someone else to use.

To unload Survey

- From the Projects menu, click Unload Applications ➤ Autodesk Survey.
When you install AutoCAD Land Development Desktop, a projects folder is created. Projects act as a central location for shared files. Use the Project Manager command to create, copy, delete, and rename projects.

Projects are based on prototypes. You can assign drawing settings to prototypes, and then when you create a new drawing in a project, the default drawing settings for the new drawing are copied from the prototype.
AutoCAD Land Development Desktop Projects

AutoCAD Land Development Desktop uses projects to manage and organize all the data for a job that you are working on. This data includes the project point file, alignment database, parcel database, surface database, drawing files, and more.

- You can assign a drawing to only one project, but you can change the project association if necessary. The project association is stored in the drawing file.
- Projects can contain many drawings.
- All the drawings in a project share the same data files.
- You are prompted to select a project if you open an existing drawing that is not assigned to a project, or if the project is not found. This assignment is saved when you save the drawing.

When you install AutoCAD Land Development Desktop, a project folder (c:\Land Projects R2 by default) is created. When you create a project, a subfolder named <project name> is created within the project folder. For example, if you create a project named 97201, then Land Development creates a c:\Land Projects R2\97201 folder.

**NOTE**
You can change the Project Path or add new paths by using the Project Management dialog box.

You must assign every drawing to a project. When you start a new drawing, you are prompted to select a project for the drawing. You can either create a new project or assign the drawing to an existing project. The drawing stays associated to that project as long as the project exists in the current Project Path. If you delete the project or if you change the project path, then you are prompted to select the project the next time you open the drawing. You can also associate an existing drawing (already assigned to a project) with a different project by using the Reassociate Drawing command.

**NOTE** AutoCAD Land Development Desktop requires drawings to be associated with projects so that it has a location in which to store its external files. If you open a drawing, or create a new drawing, without using the AutoCAD Land Development Desktop versions of the New and Open commands, you will be prompted to select a project with which to associate the drawing. If you decline to select a project, then AutoCAD Land Development Desktop automatically creates a project called "_scratch" and attaches the drawing to it so that AutoCAD Land Development Desktop can function.

When you create a new project, you must specify a prototype (default settings for new drawings that are associated with the project) and a name for the project. You can also add a description of the project and any keywords that help you identify the project; these can be very helpful if you have many projects. You can filter the list of projects based on the keywords to find a particular project, and then check the description to make sure it is the project you are looking for.

Although it is not required, we suggest that you save your drawings in the \dwg subfolder that is created in your project folder. This keeps the drawing and the project files together for easier archiving.
Creating Projects Outside of AutoCAD Land Development Desktop

The recommended method for creating projects is by using the AutoCAD Land Development Desktop interface. If you manually create a project folder outside of AutoCAD Land Development Desktop with an external program such as Windows Explorer, the Project Manager command should be used to create a "project.dfm" file within the project folder.

You can do this by selecting the new folder from the Name list in the Project Management dialog box, and then clicking the Project Details button. In the Project Details box, you select a project prototype for the drawing settings, enter the project description and keywords, and set the project's drawing path.

Managing Projects

From the Project Management dialog box, you can locate a project, create or remove a project path, search for a project, create a project, and much more.

Adding a Project Path by Using the Project Management Dialog Box

Projects are stored in a folder called the project path. By default, the project path is c:\Land Projects R2. You can change the project path and store multiple paths as needed.

To add a new project path

1. From the Projects menu, choose Project Manager to display the Project Management dialog box.
Under Project Location, click the Browse button.
Select the folder for the project path and click OK.

This creates a new project path in which you can create projects.

**Removing a Project Path by Using the Project Management Dialog Box**

**To remove a project path**
1. From the Projects menu, choose Project Manager to display the Project Management dialog box.
2. Under Project Location, select the path you want to remove from the Path list.
3. Click Remove.

**NOTE**
This just removes the path from the list. It does not delete folders or files.

**Selecting a Project When Using the Project Management Dialog Box**

To use the Project Management dialog box to rename, copy, or delete projects, you must first select the project that you want to work with.

**To select a project**
1. From the Projects menu, choose Project Manager to display the Project Management dialog box.
2. Under Project Location, select a project path from the Path list. Select the folder in which the project you want to select is stored. By default, the project path is `c:\Land Projects R2`.

   You can click Browse to look for a project path if it is not shown in the list, you can click Remove to remove a project path if it is no longer valid, and you can create a new project path.
3. Under Project, do one of the following:
   - Select a project from the Name list.
   - Click Filter Project List to filter the project list by keyword or creator. For More information, see “Finding a Project Using Filters” in this chapter.
   - Create a new project. For More information, see “Creating a Project Using the Project Management Dialog Box” in this chapter.
Finding a Project Using Filters

When you click Filter Project List, the Project Filter Criteria dialog box is displayed. You can filter on keywords that you assigned to projects, or you can filter on the login name of the person who created the project.

To find a project using filters

1. From the Keywords list, select the keyword you want to search for. If you do not want to search by keyword, then select Unfiltered by keyword.
2. From the Created By list, select the AutoCAD login name of the person who created the project. If you do not want to search by the person who created the project, then select Unfiltered by created by.

The filtered list of projects is displayed in the Filtered Project List.

3. Click OK.

   TIP If you want to save the filter settings, then select the Save filter criteria check box.

4. Select the project you want to use.

Creating a Project Using the Project Management Dialog Box

To create a new project using the Project Management dialog box

1. From the Projects menu, choose Project Manager to display the Project Management dialog box.
2. Click Create New Project to display the Project Details dialog box.

![Project Details dialog box](image)
3 Under Initial Settings for New Drawings, select the prototype to base the project on. A prototype contains default settings for new drawings associated with the project.

4 Under Project Information, type a name for the project in the Name box. This name can be up to 64 characters.

5 In the Description box, type a description for the project. This description can be up to 255 characters.

6 In the Keywords box, you can type keywords for the project. Type a comma or press SPACEBAR to separate each keyword. Keywords can help you identify a project when you are searching for a project. For example, you could use a keyword called “county” to help you locate all your county projects.

7 Under Drawing Path for this Project, select one of the following options to determine where drawings that you create in this project are stored:
   - Select Project “DWG” Folder if you want to store the drawings in the DWG folder in the project folder (c:\Land Projects R2\<project name>\dwg). This is the recommended location for storing drawings, because it keeps all the drawing and project files together.
   - Select Fixed Path and then browse for a path for the drawings.

8 Click OK to create the project and return to the Project Management dialog box.

Changing the Project Detail Settings When Using the Project Management Dialog Box

For each project, you can assign a project description and project keywords. You can also choose a location in which the drawing files associated with the project are stored. These settings are called the project detail settings.

To change the project detail settings

1 From the Projects menu, choose Project Manager to display the Project Management dialog box.

2 Click Project Details to display the Project Details dialog box.

3 You can do any of the following:
   - Change the project description. The description can be up to 255 characters.
   - Change the project keywords.
   - Change the drawing path for the project. Select Project “DWG” Folder if you want to store the drawings in the DWG folder in the project folder (c:\Land Projects R2\<project name>\dwg). This is the recommended location for storing drawings, because it keeps all the project files together. Or, you can select Fixed Path and then type or browse for a path.

   NOTE Changing the drawing path for the project does not move any existing drawings.

4 Click OK to return to the Project Management dialog box.
**Copying a Project**

You can use an automated command to copy a project. The Copy option in the Project Management dialog box copies everything that is in the `c:\Land Projects R2\<project name>` folder.

When you copy the project, you are asked if you want to change the association of the drawings in that project. This means that the drawings will point to the new, copied project.

**NOTE**  
Do not use Windows Explorer to copy a project.

**To copy a project**

1. From the Projects menu, choose Project Manager to display the Project Management dialog box.
2. Select the project that you want to copy.

**NOTE**  
You cannot copy the current project.

3. Click Copy to display the Copy dialog box.
4. The details of the project you are copying are listed under Copy Project From.

5. Under Copy Project To, select a path for the copied project.

**NOTE**  
You can select only defined project paths from this list. If you want to copy the project to a folder other than what is listed in the Path list, then click Cancel to return to the Project Management dialog box and create a new project path.

6. In the Name box, type a name for the new project. This name can be up to 64 characters.
7. In the Description box, type a description for the project. This description can be up to 255 characters.
8 In the Keywords box, you can type keywords for the project. Type a comma or press SPACEBAR to separate each keyword.

9 Click OK.

If there are drawings in the project you are copying, then a message dialog box is displayed, asking if you want to change the association of drawings so they will point to the new, copied project.

**NOTE** The Copy command copies only the drawing files that are stored in the project folder structure.

10 Click Yes to associate the copied drawings with the copied project, or click No if you want the copied project drawings to retain their original project association.

### Deleting a Project

You can use an automated command to delete a project. The Delete option in the Project Management dialog box deletes everything in the `<project name>` folder, including the drawing files if they are located in the project folder.

**NOTE** You can also use Windows Explorer to delete a project. Just delete everything in the `<project name>` folder.

#### To delete a project

1 From the Projects menu, choose Project Manager to display the Project Management dialog box.

2 Select the project you want to delete.

**NOTE** You cannot delete the current project.

3 Click Delete.

A warning dialog box is displayed to inform you that the Delete command permanently deletes the files and folders within the project folder. This command deletes the project drawings if they are stored within the `<project name>` folder.

4 Click Yes to delete the project.
Renaming a Project

You can use an automated command to rename a project. The Rename option in the Project Management dialog box renames the c:\Land Projects R2\<project name> folder to the new name. If drawings are located in the project folder you want to rename, then you are asked if you want to associate the drawings with the new project name.

**NOTE**
Do not use Windows Explorer to rename a project.

**To rename a project**

1. From the Projects menu, choose Project Manager to display the Project Management dialog box.
2. Select the project you want to rename.

**NOTE**
You cannot rename the current project.

3. Click Rename to display the Rename dialog box.

4. Under Rename Project To, type a new name for the project in the Name box.
5. If needed, you can type a new description in the Description box and type new keywords in the Keywords box. Type a comma or press SPACEBAR to separate each keyword.
6. Click OK.
If there are drawings in the project you are renaming, then a message dialog box is displayed, asking if you want to change the project associations for all drawings found in the project.

Click Yes to associate the drawings with the renamed project, or click No if you want the project drawings to retain their original project association.

**Project Locks**

To support the multi-user environment, AutoCAD Land Development Desktop places locks on specific project data files when they are accessed during a drawing session. Project locks prevent multiple people from changing the same project data simultaneously.

- Some locks protect access to individual files, others protect entire data folders.
- Some data files can be accessed by one person at a time. After someone locks the data file, everyone else is denied access.
- Other data files let the first person access the data file with read/write capabilities; anyone else who accesses the file has read-only status and cannot edit the data.
- The point database allows several people to access the file with read/write capabilities so that more than one person can modify the data file. These locks are created to prevent other people from changing the point database Open Mode to single-user when multiple people are working with the database.

Lock files are created and removed automatically by AutoCAD Land Development Desktop. The locks are created in the project folders and have the file extension .lk#. These locks contain information about the data files that have been locked, the owner of the lock, and when the lock was created. The locks are automatically removed from project data files when someone completes a procedure that releases the file, or ends the drawing session.

**NOTE**

AutoCAD login names are used to identify the owners of project locks. Each person working on a project must have a unique AutoCAD login name in order for locks to work correctly.

If a drawing session ends unexpectedly, through an event such as a power failure or system error, then the lock files may remain in the project folders even though the drawing session has ended. In a single-user setting, the lock files are removed automatically the next time the project data is accessed. In a multi-user setting, you can use the Project Management dialog box to manually delete the locks.
Managing Locked Files in a Project

Use the Project Management dialog box to view which files in a project are locked, and who currently owns the locks. The lock owner is the person who opens the file first, locking the project files so that other people cannot make changes to them.

You can also delete project locks. While you never want to delete a project lock for someone currently working on a project, you may need to delete project locks in the event of a power failure or system error.

**WARNING!** Clicking Cancel does not restore project locks if you have already clicked the Delete or Delete All buttons.

To manage the lock files for the current project

1. From the Projects menu, choose Project Manager to display the Project Management dialog box.
2. Select the project from which you want to view and/or remove locks.
3. Click File Locks to display the Project File Locks dialog box.

Under Lock Files, the lock files for the selected project are displayed, with the following information for each lock:

- **File**: Displays the location and name of the lock file.
- **Label**: Displays the name of the data file that is locked.

**NOTE** If a project contains no lock files, then a message dialog box is displayed informing you that there are no lock files.
■ **Type**: Displays the current access rights of the locked file. The letter r indicates that the file owner has the file in a read-only state; w indicates the file is in a read/write state; and s indicates that the file is shared. Shared means that the lock owner has read-write access to the alignment but another user can obtain read-only access to it.

■ **Owner**: Displays the AutoCAD login name of the person who created the lock file.

■ **Date/Time**: Displays the date and time when the lock file was created.

4 Select a method of displaying the locks:

■ Click **Display All** to display all the locks for the current project.

■ Click **By Owner** to display the locks for one person at a time.

The Project Owners dialog box is displayed:

Under Lock Owners, select the owner whose locks you want to display.

**NOTE** Select the Display All Locks check box if you want to display all the locks in the project.

5 If you need to manually delete a lock, such as in the event of a power failure, then do one of the following:

■ Select the lock that you want to delete and click **Delete**. You can select the lock by clicking any of the four lines that contain the lock information.

■ Click **Delete All** to delete all project locks currently displayed in the Lock Files list. To delete the locks for one person, click **By Owner** to display only the lock files for that person, then click **Delete All**. The lock files that are not displayed in the Lock Files list are not affected.

**WARNING!** Never delete the lock files for anyone else who currently has access to the project. This may result in data corruption or loss of data.

6 Click **OK** to return to the Project Management dialog box.

For more information about Alignment Database locking, see “Alignment File Locking” in Chapter 20, “Alignments.”
Associating the Current Drawing with a Different Project

You can change which project the current drawing is associated with. For example, you may need to re-associate a drawing if you create a new drawing but accidentally select the wrong project.

**To associate a drawing with a different project**

1. From the Projects menu, choose Reassociate Drawing.
   
   A message box is displayed, informing you that you must save and reopen the drawing if you change the project association for the current drawing. Until you close the drawing it remains associated with the original project.

2. Click Yes to display the Select or Create a Project dialog box.

   ![Select or Create a Project dialog box]

   **NOTE** Re-associating a drawing does not change the drawing folder location. After closing the drawing, use Windows® Explorer if you want to move the drawing to a new location.

For more information on using the Select or Create a Project dialog box, see the topics that follow.

**Selecting or Creating a Project**

If you open a drawing that is not associated with a project, or if you select the Reassociate Drawing command, then you are prompted to attach the drawing to an existing project or create a new project for the drawing. All drawings must be associated with a project if you want to use the AutoCAD Land Development Desktop commands. AutoCAD and Map commands do not require drawings to be associated with a project.
You may be prompted to select or create a project if the drawing was originally created in AutoCAD or AutoCAD Map, if you deleted a project but saved the project drawing, if you moved the drawing out of the drawing folder of the project, or if you are using the Reassociate Drawing command.

**Attaching a Drawing to an Existing Project**

In some instances, such as when you run the Reassociate Drawing command, you are prompted to select a project or create a new project to associate a drawing with.

*To attach a drawing to an existing project*

1. Display the Select or Create a Project dialog box. The Select or Create a Project dialog box is displayed whenever you open a drawing that is not associated with a project. In addition, it is displayed when you select Reassociate Drawing from the Projects menu.
2. Under Project Information, select a project path from the Path list. By default, the project path is `c:\Land Projects R2`.
   You can click Browse to look for a project path if it is not shown in the list.
3. Do one of the following:
   - From the Name list, select the project you want to associate the drawing with.
   - Click Filter Project List to filter the project list by keyword or creator, and then select the project you want to associate the drawing with.
4. Click OK.

**NOTE**

Attaching a drawing to a project does not move the drawing to the project’s drawing folder. To move the drawing, use Windows® Explorer.

**Associating a Drawing with a New Project**

In some instances, such as when you run the Reassociate Drawing command, you are prompted to select a project or create a new project to associate a drawing with.

*To associate a drawing with a new project*

1. Display the Select or Create a Project dialog box.
   The Select or Create a Project dialog box is displayed whenever you open a drawing that is not associated with a project. In addition, it is displayed when you select Reassociate Drawing from the Projects menu.
   Under Project Information, click Create Project to display the Project Details dialog box.
2. Under Initial Settings for New Drawings, select the prototype to base the project on.
3. Under Project Information, type a name for the project in the Name box. This name can be up to 64 characters.
4 In the Description box, type a description for the project. This description can be up to 255 characters.
5 In the Keywords box, you can type keywords for the project. Type a comma or press SPACEBAR to separate each keyword.
6 Under Drawing Path for this Project, select one of the following options to determine where drawings that you create in this project are stored:
   - Select Project “DWG” Folder if you want to store the drawings in the DWG folder in the project folder (c:\Land Projects R2\<project name>\dwg). This is the recommended location for storing drawings, because it keeps all the project files together.
   - Select Fixed Path and either type a path or click Browse to select a path.
7 Click OK to create the project and return to the Select or Create a Project dialog box.
8 In the Name box, verify that the new project name is listed.
9 Click OK.

**Displaying Project Details for an Existing Project**

For each project, you can assign a project description and project keywords. You can also choose a location in which the drawing files associated with the project are stored. These settings are called the project detail settings.

**To display the project details for an existing project**

1 Display the Select or Create a Project dialog box.
   The Select or Create a Project dialog box is displayed whenever you open a drawing that is not associated with a project. In addition, it is displayed when you select Reassociate Drawing from the Projects menu.
2 Click Project Details to display the Project Details dialog box.
3 You can change any of the following:
   - The project description.
   - The project keywords.
   - The drawing location for the project. Select Project “DWG” Folder if you want to store the drawings in the DWG folder in the project folder (c:\Land Projects R2\<project name>\dwg). This is the recommended location for storing drawings, because it keeps all the project files together. Or, you can select Fixed Path and either type a path, or click Browse to select a path.
4 Click OK to return to the Select or Create a Project dialog box.
Prototypes

AutoCAD Land Development Desktop uses prototypes as a convenient way for you to maintain standard settings for your drawings. After you set up the drawing settings by using the Drawing Settings command on the Projects menu, you may want to save them back to a prototype and use them whenever you create a new drawing. When you create a new project, you can select a prototype to use for the default settings for new drawing creation.

For more information about changing drawing settings and saving them to prototypes, see “Changing the AutoCAD Land Development Desktop Drawing Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”

When you install AutoCAD Land Development Desktop, a root prototype folder (c:\Program Files\Land Desktop R2\data\prototypes) is created. Each prototype is represented by a subfolder of this root prototype folder. For example, if you create a prototype named MYPROTO, then AutoCAD Land Development Desktop creates a c:\Program Files\Land Desktop R2\data\prototypes\myproto folder. AutoCAD Land Development Desktop always maintains default prototypes, one for feet and the other for meters. If you delete these prototypes, then they are recreated, using the default system settings, the next time you start AutoCAD Land Development Desktop.

Whenever a new drawing is attached to a project, its default settings are copied from this prototype. The settings are copied to each drawing so that after a drawing is created, its settings can be modified independently of any of the other drawings in the project.

Managing Prototypes

From the Prototype Management dialog box, you can copy, rename, and delete prototypes.

Copying a Prototype

You can create a new prototype by copying an existing prototype. By default, there is always at least one prototype you can copy. After you copy the prototype you can change the prototype settings to customize it.
To copy a prototype

1 From the Projects menu, choose Prototype Manager to display the Prototype Management dialog box.

2 From the Prototype list, select the prototype you want to copy.

3 Click the Copy button to display the Copy Prototype dialog box.

4 In the Name box, type a name for the copy.

5 In the Description box, type an optional description for the copy.

6 Click OK to return to the Prototype Management dialog box.
Renaming a Prototype

Use the Rename command in the Prototype Manager to rename a prototype. If you rename a prototype that you have already associated with a project, then you must update the prototype name in the Project Details.

To rename a prototype
1. From the Projects menu, choose Prototype Manager to display the Prototype Management dialog box.
2. From the Prototype list, select the prototype you want to rename.
3. Click the Rename button to display the Rename Prototype dialog box.

   ![Renaming Prototype Dialog Box](image)

4. Type a new name for the prototype.
5. Click OK to return to the Prototype Management dialog box.

Deleting a Prototype

Use the Delete command in the Prototype Manager to delete a prototype that you no longer use.

To delete a prototype
1. From the Projects menu, choose Prototype Manager to display the Prototype Management dialog box.
2. From the Prototype list, select the prototype you want to delete.
3. Click the Delete button.

   A warning dialog box is displayed, informing you that all files and folders within the prototype folder are deleted.

4. Click Yes to continue.
Changing the Prototype Settings

You can use the Prototype Settings command to edit the settings for a project prototype. Whenever a new drawing is created in a project, the customized settings in the prototype are copied to the new drawing.

**NOTE**
Settings changed in a prototype have no affect on the current drawing.

To change the prototype settings

1. From the Projects menu, choose Prototype Settings to display the Select Prototype dialog box.
2. Select the prototype that you want to edit.
3. Click OK to display the Edit Prototype Settings dialog box.

4. Edit the prototype settings as necessary, and then click OK to save the prototype with the new settings. For more information about changing the settings, see “Changing the AutoCAD Land Development Desktop Drawing Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
Setting Up Drawings

After you create a new drawing, you are prompted to set up the drawing. Drawing setup includes establishing units, zones, text styles, and several other settings. Depending on your preference, you can use a wizard to set up drawings, you can automatically load a setup profile, or you can use the Drawing Setup dialog box.
Setting Up Drawings

Every time you create a new drawing, you must set it up. Drawing setup involves several drawing parameters. You can set the units to feet or meters, the angle type to bearing or azimuth, the horizontal and vertical scale, and define the display precision for linear, angular, coordinate and elevation units. You can control the sheet size and import a drawing border, load text styles to use, and save the current settings to a setup profile or load settings from a previously created setup profile.

You have three options for drawing setup: use the Drawing Setup Wizard, use the Drawing Setup command, or load a pre-existing setup file.

NOTE You may not need to set up a drawing if you based the drawing on a drawing template. For more information about using drawing templates, see “Basing a Drawing on a Drawing Template” in Chapter 2, “Starting a Drawing Session.”

Setting Up a Drawing Using the Drawing Setup Wizard

You can use a wizard to set up a new drawing.

To use the New Drawing Wizard

1. From the Projects menu, choose User Preferences to display the User Preferences dialog box.

2. Under First Time Drawing Setup, select the Use the Drawing Setup Wizard option.

3. Click OK.
The next time you create a new drawing, the Drawing Setup wizard is displayed automatically. The wizard has tips and context-sensitive help that describe each option on each page of the wizard. For more information about each setting in the wizard, see “Setting Up a Drawing Using the Drawing Setup Command” in this chapter.

**Setting Up a Drawing by Automatically Loading a Pre-Existing Drawing Setup File**

To automatically load a pre-existing drawing setup file

1. From the Projects menu, choose User Preferences to display the User Preferences dialog box.
2. Under First Time Drawing Setup, select the AutoLoad Setup File option.
3. From the list, select the setup file that you want to use.
4. Click OK.

The next time you create a new drawing, the setup file is loaded automatically.

**NOTE**

You can create drawing setup files when you use the Drawing Setup dialog box. For more information, see “Saving Drawing Setup Files” in this chapter.

**Setting Up a Drawing Using the Drawing Setup Command**

One option you can use to set up your drawing is the Drawing Setup command. You can use this command to set units, scale, current zone, base point and north rotation, and more.

**NOTE**

You can set a User Preference so that the Drawing Setup dialog box is always displayed after you create a new drawing. For more information, see “Selecting How to Set Up New Drawings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”

**Loading Drawing Setup Profiles**

If a drawing setup profile exists, then you can load it when setting up a drawing. The setup profile contains all the drawing settings necessary for setting up a drawing, like units, text style, current zone, and so on.
To load a drawing setup profile

1. From the Projects menu, choose Drawing Setup to display the Drawing Setup dialog box.

2. Click the Load/Save Settings tab.
   All the available drawing setup profiles that are stored in the current path are displayed under Load a Drawing Setup Profile in the Profile Name list.
   
   **NOTE** If you want to load a drawing setup profile from a different path, then click Browse and select a new path. The setup profiles are called <Name>.set.

3. From the Profile Name list, select the drawing setup profile that you want to use.
4. Click Load to load the setup profile.
   
   **TIP** You can click View to display the setup profile details, such as the units, drawing orientation, and so on, before loading the profile.

After you load a drawing setup profile, you can click any other tab on the Drawing Setup dialog box to change any of the individual settings. If you want to make these changes permanent (within the setup profile), then save the setup profile.
Saving Drawing Setup Profiles

You can save all your custom drawing setup settings as a setup profile. When you want to set up another drawing using the same settings, you can load this setup profile.

To save the current drawing setup to a profile

1. From the Projects menu, choose Drawing Setup to display the Drawing Setup dialog box.
2. Click the Load/Save Settings tab.
3. Verify that the Path box displays the correct path. If you want to save the drawing setup profile to a different folder, then click Browse and select a new path.
4. Under Save a Drawing Setup Profile, type the name of the file that you want to save in the Profile Name box. This name can be up to 64 characters, including path and file extension. This file is saved with an .set file extension.
5. Click Save to save the setup profile.
6. Click OK.
Changing the Unit Settings for a Drawing

You can specify whether you want to use feet or meters in your drawing. You can specify which type of angle measurement you want to use (azimuths, south azimuths, or bearings), as well as the angle unit type (degrees, grads, or radians).

To change the units and angle settings for a drawing
1. From the Projects menu, choose Drawing Setup to display the Drawing Setup dialog box.
2. Click the Units tab.

![Drawing Setup dialog box](image)

**NOTE** Whenever you change the settings on the Units tab, the Samples change to reflect the new settings.

3. Under Linear Units, select either Feet or Meters.
4. Under Angle Units, select one of the following options on which to base angular output:
   - Degrees
   - Grads

**NOTE** When you type degrees at AutoCAD Land Development Desktop command prompts, type them in the decimal format indicated (DD.MMSS). Use a period (.) between the degree value and the minutes and seconds. For example, to enter 67°45′15″ type the value as 67.4515. If you use bearings, then type the bearing quadrant first, and then the angle in degrees.
5 Under Angle Display Type, select one of the following options on which to base angular output:

- Bearings
- North Azimuths
- South Azimuths

6 Click OK or set the precision settings.

**NOTE** The linear units that you select must be the same for all drawings in a project. You cannot mix foot-based drawings with meter-based drawings in the same project.

### Changing the Precision Values for a Drawing

You can set the angular, linear, coordinate, and elevation precision for the drawing. The precision settings are used only for labeling and listing values, not actual computations. AutoCAD Land Development Desktop commands always calculate all numbers up to the highest internal precision.

The following illustration is a line that is labeled with different precisions:

![Different precisions](image)

#### To change the display precision values

1. From the Projects menu, choose Drawing Setup to display the Drawing Setup dialog box.
2. Click the Units tab.
3. Under Display Precision, you can change the values for the following types of measurements by either typing values in the boxes or clicking the up or down arrows:
   - **Linear**: Sets the linear precision for the drawing. This is used for all distances.
   - **Elevation**: Sets the elevation precision for the drawing.
   - **Coordinate**: Sets the coordinate precision for the drawing. This is used to display all northing/easting coordinate information.
   - **Angular**: Sets the angular precision for the drawing. This is used to display minutes and seconds.
4. Click OK.
Changing the Scale Settings for a Drawing

You can control how the horizontal and vertical scales of the drawing are displayed.

**NOTE** If you change the horizontal scale, then you may need to change the Text Style as well. Text style is controlled by the horizontal scale. For more information, see “Loading Pre-defined Text Styles and Changing the Current Text Style” in this chapter.

To change the drawing scale

1. From the Projects menu, choose Drawing Setup to display the Drawing Setup dialog box.
2. Click the Scale tab.

3. Under Drawing Scale, select a Horizontal scale from the list. If you do not see the scale you want to use, then select Custom and type the scale in the Horizontal box. For example, for a 1:200 scale, type 200.

4. Select a Vertical scale from the list. If you do not see the scale you want to use, then select Custom and type the scale in the Vertical box. For example, for a 1:200 scale, type 200.

   For more information about choosing a scale for your drawings, see “Determining the Scale at Which to Draw Objects” in this chapter.

5. Click OK or set the sheet size.
Determining the Scale at Which to Draw Objects

The horizontal scale controls how objects are drawn in plan view. The vertical scale controls how objects are drawn in profile and sectional views.

**Information for Users of Autodesk Civil Design**

The Profile and Section commands in Autodesk Civil Design automatically take into account the vertical scale.

However, if you want to use the POLYLINE or LINE command instead of the Profile commands to draw an object in a profile that reflects the vertical exaggeration, then you can compensate for the vertical exaggeration.

To compensate for vertical exaggeration, divide the horizontal scale by the vertical scale, and then use this factor to draw objects. For example, a horizontal scale of 50 (1'=50'), and a vertical scale of 5 (1'=5'), results in a ratio of 50/5. To draw a 1'-long vertical line in the profile, you factor it by a ratio 50/5, meaning you actually draw a 10-foot line.

The following is an illustration of a profile with a vertical scale of 10:

![Profile with vertical scale of 10](image1)

For more exaggeration, you can specify a smaller vertical scale. The following is an illustration of a profile with a vertical scale of five (5):

![Profile with vertical scale of 5](image2)
Changing the Sheet Size for a Drawing

You can modify the limits of the drawing by selecting a sheet size. The sheet size and the horizontal scale determine the effective area on the drawing in relation to the plotted drawing.

For example, if you set the horizontal scale of a drawing to 100 (or 1” = 100' in English units) and the sheet size to 22" x 34", then the limits of the drawing are set from (0,0) to (2200, 3400) feet.

To change the sheet size

1. From the Projects menu, choose Drawing Setup to display the Drawing Setup dialog box.
2. Click the Scale tab.
3. Under Sheet Size, select one of the pre-defined sheet sizes. If you do not see the sheet size you want to use, then select Custom and type the sheet dimensions in the Height and Width boxes.
   
   This sets the AutoCAD drawing limits based on your horizontal scale. For example, the drawing limits are set to 960' x 1440' for a 24" x 36" sheet at 1” = 40’.
4. Click OK.

Changing the Current Zone for a Drawing

Drawings in a project can have the same or different coordinate zones assigned to them. To work in real-world coordinates, you must establish a current zone for the drawing.

To change the current zone for a drawing

1. From the Projects menu, choose Drawing Setup to display the Drawing Setup dialog box.
2. Click the Zone tab.

3. From the Categories list, select a zone category. Categories include Lat/Longs, US states, and so on. When you select a category, the Available Coordinate Systems list displays all the defined zones in that category.

4. Select the zone you want to use. To select no zone, leave the CS Code box blank. The CS Code box lists the code for that coordinate system.

   **TIP**
   
   If you know the coordinate system code for a zone, you can just type it in the CS Code box and click OK to select the zone.

   The other information in the dialog box includes a description, the projection type, and the datum that was used for the zone.

5. Click OK.
Changing the Base Point for a Drawing

AutoCAD Land Development Desktop uses two coordinate systems for locating points: X,Y and northing/easting. When you start a new project, these values all default to 0 so that the Y coordinate is the same as the northing and the X coordinate is the same as the easting.

The following illustration is the default coordinate system, where X,Y is 0,0 and the northing/easting is 0,0:

![Default coordinate system](image)

You can change the base point so that a different X,Y coordinate equals a different northing/easting coordinate. For example, if the points in your drawing begin at northing and easting coordinates of 5000,5000, then you can set a new base point to translate these coordinates so they fit onto your drawing screen.

You can set the base point by assigning a northing and easting value to a fixed X,Y location. For example, you can assign X,Y coordinates 100,100 the northing and easting values of 5000,5000.

The following is an illustration of the coordinate system after the base point and northing/easting values are adjusted:

![Base point and northing/easting adjustment](image)

**NOTE** Setting a different base point affects only the view of the points in the current drawing and does not alter the point database coordinates. The point commands take only the base point into account and translate the information. All points are stored in the point database using their northing and easting coordinates. Setting a different base point does not move any objects such as lines, polylines, or figures. We recommend that you set the base point before creating such figures in your drawing.
To set a new base point for northing and easting coordinates

1. From the Projects menu, choose Drawing Setup to display the Drawing Setup dialog box.
2. Click the Orientation tab.

3. Under Base Point, do one of the following:
   - In the X and Y boxes, type the X, Y coordinates that you want to translate the northing/easting coordinates to.
   - Click Pick and select an X,Y point in your drawing.

4. Under Northing and Easting, type the northing and easting coordinates that you want to associate with the X,Y base point.
   - The northing value corresponds to the Y coordinate.
   - The easting value corresponds to the X coordinate.

   **NOTE** If you change the base point in an existing drawing, then you must move any objects in the drawing to match the new coordinate system. Use the Inquiry commands to verify the coordinates in the drawing.

5. Click OK or set the north rotation.
Changing the North Rotation for a Drawing

By default, north is always represented in a drawing as the top of the screen. But you can define a different orientation of north if your drawing layout requires it. Changing the north rotation affects only the commands that use a northing/easting coordinate system; it does not rotate the X,Y angular base or affect any CAD commands.

You should typically set the north rotation when you create a new drawing, but you can change it at any time.

There are two parts to defining a north direction. The first is to identify a direction in the drawing, and the second is to define what the direction represents.

To change the north rotation

1. From the Projects menu, choose Drawing Setup to display the Drawing Setup dialog box.
2. Click the Orientation tab.
3. Under North Rotation, do one of the following:
   - Select the Angle option and then type the rotation angle in the format indicated. This number is a clockwise angle from the vertical. The default value of 0 sets north to the top of the screen.

TIP Different drawings that are associated with the same project can have different north rotations. This provides different views of the project point data relative to the X,Y coordinates.
Select the Define by Points option. Click Pick Points and select the points that represent an angle. This angle can represent north, a known bearing or azimuth, or the angle between two known points.

To specify what the angle between the two points represents, select one of the following under Points Represent:

- Select North if the angle represents the North direction.
- Select Bearing and enter the bearing value for the rotation angle in the format DD.MMSS, and then specify the quadrant. For example, if you have a line in the drawing that is drawn at a known angle, then you can use this reference angle as a method of defining the north rotation.
- Select Azimuth and enter the azimuth value for the rotation angle in the format DD.MMSS.
- Select Coordinate and enter two sets of northing/easting coordinates that define the direction of the rotation angle. For example, if you know the start and end coordinates of a line in the drawing, then you can use these coordinates to define a reference angle.

**TIP** Select the Use First Point as New Base Point check box if you want the Coordinate 1 point to become the new base point.

**NOTE** If you change the north rotation in an existing drawing, then you must move any objects in the drawing to match the new coordinate system. Use the Inquiry commands to verify the coordinates in the drawing.

4 Click OK.
Loading Pre-defined Text Styles and Changing the Current Text Style

You can load predefined text styles and set the current text style to use in the drawing.

The height of a text style is converted to values based on the drawing’s horizontal scale. For example, a L100 style in a 50 scale drawing is created with a height of \(5\)’. Therefore, when plotted at 1 = 50 scale, all text defined as L100 is plotted 0.1” high.

For more information on text styles, look up “Working with Text Styles” in the AutoCAD User’s Guide or online Help.

To change the text style

1. From the Projects menu, choose Drawing Setup to display the Drawing Setup dialog box.
2. Click the Text Style tab.
3. Verify that the Path for the text style sets is correct. If it is incorrect, then click Browse and locate the folder where the text style sets are stored. By default, text style sets are stored in the \(c:\)\Program Files\Land Desktop R2\data\setup folder. A style set is a group of styles that are related. Style sets have the file extension *.stp."
4 Under Style Set Name, select the style set you want to load into the current drawing. When you select a style set, all the text styles in the style set are shown in the Styles in This Set list.

- If you use feet as your units in the drawing, then select a Point, Leroy, or Fraction style set. Point is based on point standards, Leroy is based on standard Leroy sizes, and Fraction is based on font sizes in fractions.

  NOTE  Point and Fraction style sets have style names that start with C and S. S stands for Simplex, meaning that the fonts uses only one stroke. Whereas C stands for Complex, meaning that the font uses two strokes to delineate the characters in the font set.

- If you use Metric units, select a Metric Leroy (mleroy) or Millimeter (milli) type.

5 Click Load to load the selected style set and update the Select Current Style list.

6 Under Select Current Style, select the name of the style that you want to use. This list shows all existing styles in the current drawing. You can change the current style at any time.

  NOTE  To change the current text style, you can also use the STYLE command or you can select the Set Text Style command from the Utilities menu.

7 Click OK.

  NOTE  Many of the AutoCAD Land Development Desktop commands that create text require styles with fixed (non-zero) heights. The included style sets all contain fixed-height styles. Standard is the default zero-height text style that exists in a drawing.

### Changing the Border Style for a Drawing

You can insert a border in a drawing that is either a polyline or a block with attributes. Several default border blocks are included with AutoCAD Land Development Desktop.

To place a border in your drawing

1 From the Projects menu, choose Drawing Setup to display the Drawing Setup dialog box.
2 Click the Border tab.

![Drawing Setup dialog box](image)

3 Under Border Selection, select one of the following options:

- **Line**: Inserts a polyline with a line width at specified margins. For more information, see “Defining a Line Border” in the following section.
- **Unscaled Block**: Inserts a block at 1:1 scale. For more information, see “Defining an Unscaled Block as a Border” later in this chapter.
- **Scaled Block**: Inserts a block using the horizontal scale of the drawing. For more information, see “Defining a Scaled Block as a Border” later in this chapter.
- **None**: Inserts no border into the drawing.

**Defining a Line Border**

If you select the Line option in the Drawing Setup dialog box, then define the following width and margin settings.

**NOTE** The following values are all based on the current units for the drawing.

1 In the Line Width box, type a line width for the border. This is the plotted width of the polyline that is used to draw the border.
2 In the Left Margin box, type a left margin for the border.
   The margins are the offsets in plotted units from the edge of the sheet to the border. The size of the border is based on the sheet size and the horizontal scale, less the margins.
3 In the Right Margin box, type a right margin for the border.
4 In the Top Margin box, type a top margin for the border.
5 In the Bottom Margin box, type a bottom margin for the border.
6 Click OK.

**Defining an Unscaled Block as a Border**

If you select the unscaled block option, then the block that you select is inserted at a 1:1 scale.

1 In the Drawing Setup dialog box, under Custom Block, do one of the following:
   ■ Click Browse and locate the name of the folder in which the border you want to insert is located. By default, this location is the following:
   `c:\Program Files\Land Desktop R2\data\borders\lng`.
   ■ In the Path box, type the name of the block path.
2 Under Block Name, select the name of the block that you want to insert:
   
   **NOTE** Several sample borders are included with AutoCAD Land Development Desktop. However, they should be inserted using the Scaled Block option.
3 Click OK.

**Defining a Scaled Block as a Border**

If you select the scaled block option, then the block you select is inserted using the current horizontal scale.

1 In the Drawing Setup dialog box, under Custom Block, do one of the following:
   ■ Click Browse and locate the name of the folder in which the block you want to insert is located. By default, this location is the following:
   `c:\Program Files\Land Desktop R2\data\borders\lng`.
   ■ In the Path box, type the name of the block path.
2 Under Block Name, select the name of the block that you want to insert. The block names comply with the following naming conventions:
   ■ `pf_` are plan borders for drawings that use feet as units
   ■ `pm_` are plan borders for drawings that use meters as units
   ■ `df_` are detail borders for drawings that use feet as units
   ■ `dm_` are detail borders for drawings that use meters as units
3 Click OK.
There are several settings you can configure to control how AutoCAD Land Development Desktop functions. These include path settings, New and Open command preferences, and zone transformation settings, among others. In addition, you can access and change label styles, import/export formats, contour styles, and drawing settings from a central location.
Changing the AutoCAD Land Development Desktop Settings

AutoCAD Land Development Desktop provides system variables that you can use to control various features of the program. These settings include AutoCAD Options, User Preferences, Data Files settings, Drawing Settings, and Prototype Settings.

Changing the AutoCAD Options

The AutoCAD options control saving, colors, paths, printers, and much more.

To change AutoCAD options

- Type OPTIONS at the command line to display the Options dialog box.

For more information, see “Modifying the AutoCAD Environment” in the AutoCAD User’s Guide, or click the Help button in the Options dialog box.
Changing the User Preferences

The User Preferences control program-wide preferences such as the project paths for various files, the AutoCAD overrides, and the drawing setup method.

The file paths include paths for storing prototypes, speed tables, and drawing setup profiles. The AutoCAD overrides include options you can select to use the non-project based version of AutoCAD New and Open commands. If you have turned off the AutoCAD Land Development Desktop Startup dialog box, then you can redisplay it. For drawing setup, you can select among three options. You can choose to use the drawing wizard, the Drawing Setup command, or automatically load a drawing setup profile when you start a new drawing.

The preference settings are stored in the following folder:

c:\Program Files\Land Desktop R2\data\pref

The file name is <AutoCAD login name>.dfm. The preference path settings are stored in the sdsk.dfm file in the program folder.

Changing the Program Paths Settings

AutoCAD Land Development Desktop uses paths to find installed components. The installation program defines these path settings. If you want to move components of the installed software, such as the prototypes, the temporary folder, or the data folder, then you must update the paths to the files.

If you change a path setting, it won’t take effect until you shut down AutoCAD Land Development Desktop and restart it.

To change the file locations paths

1. From the Projects menu, choose User Preferences to display the User Preferences dialog box.

![User Preferences dialog box](image)
2 Under File Locations, select the path that you want to change from the Type list:

- **Contour Styles**: The location of the Contour Style files.
- **Drawing Setup Borders**: The location of the border .dwg files used by drawing setup. By default this path is the following:
  c:\Program Files\Land Desktop R2\data\borders\.
- **Drawing Setup Files**: The location of the drawing setup profiles. By default this path is c:\Program Files\Land Desktop R2\data\setup\.
- **Import/Export Formats**: The location of the point import and export formats.
- **Label Styles**: The location of the line, curve, spiral, and point label style files.
- **Project Prototypes**: The location of the project prototypes. By default this path is c:\Program Files\Land Desktop R2\data\prototypes\.
- **Speed Tables**: The location of speed tables used to calculate spiral geometry. By default this path is c:\Program Files\Land Desktop R2\data\Speed Tables\.
- **Symbol Manager Files**: The location of symbol sets that are used in the Symbol Manager. By default this path is the following:
  c:\Program Files\Land Desktop R2\data\Symbol Manager\.
- **Temporary Files**: The location of any temporary files generated by AutoCAD Land Development Desktop. By default this path is c:\temp.

  ![NOTE](image)

  The Cross Section and Sheet Manager template paths are only used if Autodesk Civil Design is installed.

- **Cross Section Templates**: The location of the Civil Design cross section templates. By default this path is the following:
  c:\Program Files\Land Desktop R2\data\tplates\.
- **Sheet Manager Templates**: The location of the Autodesk Civil Design Sheet Manager files.

  ![NOTE](image)

  The Survey Data Files path is only used if Autodesk Survey is installed.

- **Survey Data Files**: The location of the Survey equipment, synonyms, and the figure prefix files.

3 Click Browse to locate the new folder for the file location type.

  ![NOTE](image)

  Changing a path for a folder location type does not move that component’s files. It just tells AutoCAD Land Development Desktop where to look for the files. You must move the files using Windows® Explorer.

4 Click OK.

  ![NOTE](image)

  Paths are saved in the sdsk.dfm file in the program folder. This file also contains many program paths that should not be modified.
Changing the User Preferences

Showing the Start Up Dialog Box

You have the option of showing the Start Up dialog box whenever you start AutoCAD Land Development Desktop. By default, this dialog box is always displayed. However, if you cleared the Show this dialog box at Start Up check box in the Start Up dialog box, then the Start Up dialog box is not displayed unless you change the Start Up preference.

To show the Start Up dialog box when you start AutoCAD Land Development Desktop

1. From the Projects menu, choose User Preferences to display the User Preferences dialog box.
2. Under AutoCAD Overrides, do one of the following:
   - Select the Use Land Development Startup check box to display the AutoCAD Land Development Desktop Start Up dialog box when you initialize the program.
   - Clear the Use Land Development Startup check box to use the AutoCAD option that controls the display of the basic AutoCAD startup dialog box. Use the Tools ➤ Options command (or type OPTIONS) to change the AutoCAD startup dialog box setting. Click the System tab and select the Show Startup dialog check box under the General Options section of the dialog box.
3. Click OK.

   NOTE: The "Open" drawing dialog check box and the "New" drawing dialog check box must be selected in order to use the AutoCAD Land Development Desktop Startup dialog box. For more information, see “Changing the Open Command Preference” and “Changing the New Command Preference” in the following sections.

Changing the Open Command Preference

If you want to use the basic AutoCAD Open command dialog box instead of the AutoCAD Land Development Desktop Open Drawing: Project Based dialog box, then you can change the Open command preference.

To change the Open command preference

1. From the Projects menu, choose User Preferences to display the User Preferences dialog box.
2. Under AutoCAD Overrides, do one of the following:
   - Select the "Open" drawing dialog check box to use the AutoCAD Land Development Desktop Open command, a project-based command.
   - Clear the "Open" drawing dialog check box to use the AutoCAD Open command.

   NOTE: You must first clear the Use Land Development Startup check box if you want to clear the "Open" drawing dialog check box.
Click OK.

NOTE If you clear the “Open” drawing dialog check box (and use the AutoCAD Open command to open a drawing), then you are automatically prompted to select a project if the drawing isn’t associated with a project or if the drawing’s project is not found.

Changing the New Command Preference

If you want to use the basic AutoCAD New command dialog box instead of the AutoCAD Land Development Desktop New Drawing: Project Based dialog box, then you can change the New command preference.

To change the New command preference:

1. From the Projects menu, choose User Preferences to display the User Preferences dialog box.
2. Under AutoCAD Overrides, do one of the following:
   ■ Select the “New” drawing dialog check box to use the AutoCAD Land Development Desktop New command, a project-based command.
   ■ Clear the “New” drawing dialog check box to use the AutoCAD New command.

   NOTE You must first clear the Use Land Development Startup check box if you want to clear the “New” drawing dialog check box.

3. Click OK.

NOTE If you clear the “New” drawing dialog check box and use the AutoCAD New command to create a new drawing, then you must save the new drawing to name it. Only named drawings can be associated with a project.

Selecting How to Set Up New Drawings

You must assign drawing setup values for every new drawing that you create and for any existing drawing that hasn’t been used with AutoCAD Land Development Desktop. To set up the drawing, you can use a wizard or the Drawing Setup command, or a setup file can be loaded automatically for the drawing.

NOTE Even if you select to use the wizard by default, you can still make changes to the drawing setup after running the wizard by using the Drawing Setup command or by loading a drawing setup file.
To select how to set up new drawings

1. From the Projects menu, choose User Preferences to display the User Preferences dialog box.
2. Under First Time Drawing Setup, select one of the following:
   - Use the Drawing Setup Wizard: Select this option if you want to use the wizard each time you create a new drawing.
   - Use the Drawing Setup Command: Select this option if you want to use the Drawing Setup command to change the drawing settings for a new drawing.
   - Autoload Setup File: Select this option to load a setup file automatically when you start a new drawing. Then select the setup file that will be loaded.

   **NOTE** You can create custom setup files using either the Drawing Setup command or the Drawing Setup Wizard.
3. Click OK.

**Editing Data Files**

The Edit Data Files dialog box is a central location from which you can edit data files. These data files include import/export formats, speed tables, label styles, tag styles, and contour styles.

To edit data files

1. From the Projects menu, choose Data Files to display the Edit Data Files dialog box.

   ![Edit Data Files](image)

   2. Under Program, select Land Development Desktop.

   **NOTE** If Autodesk Survey or Autodesk Civil Design is installed, then you can also edit data files for those programs.
Select one of the following data files and then click Edit Data:

- **Import/Export Formats.** For more information, see “Creating a Point Import/Export Format” in Chapter 12, “Importing and Exporting Points.”
- **Speed Tables.** For more information, see “Editing a Speed Table” in Chapter 18, “Drawing Spirals.”
- **Label Styles.** For more information, see “Selecting the Current Label Style” in Chapter 23, “Label Styles.”
- **Tag Styles.** For more information, see “Tag Label Styles” in Chapter 25, “Creating Object Tables.”
- **Contour Style Manager.** For more information, see “Managing Contour Styles” in Chapter 32, “Creating and Managing Contours.”

### Changing the AutoCAD Land Development Desktop Drawing Settings

Drawing settings control many different parameters in AutoCAD Land Development Desktop. When you create a new drawing in a project, the drawing is assigned default drawing settings based on the prototype.

Drawing settings are divided by program so they are easy to locate. If you have Autodesk Civil Design or Autodesk Survey, then you can change the drawing settings for those programs as well.

After you change the drawing settings, you can save the settings to a prototype so the settings can be used by other drawings. When you create a new drawing in a project that is based on that prototype, then the drawing settings that you saved to the prototype are used for the drawing. If you changed settings and you want to restore them to the original drawing settings, then you can reload the prototype settings.

The drawing settings file is stored in the project’s \dwg folder. The current drawing name is used as the file name with the extension .dfm.

**NOTE** Each of the drawing settings available in the Edit Settings dialog box is documented in this manual in the applicable section. For example, Alignment settings are documented in Chapter 20, “Alignments.”

### Saving Drawing Settings to a Prototype

Each new drawing that you create in a project is assigned the drawing settings that are saved to the prototype that the project is associated with. You can save drawing settings to a prototype so that each drawing you create in a project associated with the prototype are assigned the same drawing settings by default.
To save drawing settings to a prototype

1 From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box.

2 Change the settings as needed.

3 Do one of the following:
   ■ From the Settings list, select the setting you want to save to the prototype and then click Save to Prototype under Selected Item.
   ■ Under All Settings, click Save to Prototype.

The Select Prototype dialog box is displayed.

4 Select the prototype you want to save the setting(s) to.

5 Click OK.

Loading Drawing Settings from a Prototype

You can assign drawing settings to a drawing by loading the settings from a prototype.

To load drawing settings from a prototype

1 From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box.

2 Do one of the following:
   ■ From the Settings list, select the setting that you want to load from the prototype and then click Load from Prototype under Selected Item.
   ■ Under All Settings, click Load from Prototype.

The Select Prototype dialog box is displayed.

3 Select the prototype that you want to load the setting(s) from.
Changing the Geodetic Zone Transformation Settings

Before using any geodetic-related commands, like the geodetic labeling commands, you must set the zone transformation settings. The transformation settings relate the local northing and local easting coordinates of your survey with the current zone’s grid northing and grid easting coordinates.

The zone transformation settings do the following:

- Relate local coordinates to grid coordinates by transforming distances measured on the Earth (or geoid) to distances on an ellipsoid.
- Relate distances on the ellipsoid to the flat plane (projection) of the current zone’s grid coordinate system.

These transformations are accomplished through the use of scaling factors. First, a sea level scale factor is applied to the local values measured on the geoid, and then a grid scale factor is applied in order to relate the ellipsoid values to the grid projection. The scaling factors can be defined in two ways:

- The sea level scale factor relates the distances on the geoid to the distances on the ellipsoid.
- The grid scale factor relates the distances on the ellipsoid to the distances on the grid projection.

In addition to setting scale factors, you must also specify reference points. These reference points are the two points that tie the local and grid coordinates together. The reference points can be defined in two ways:

- By the grid and local coordinates of two known reference points in your drawing.
- By the grid and local coordinates of one known point and a known rotation to grid north.

To change the transformation settings

1. Select the current zone for the drawing. For more information, see “Changing the Current Zone for a Drawing” in Chapter 4, “Setting Up Drawings.”
2 From the Projects menu, choose Transformation Settings to display the Transformation Settings dialog box.

![Transformation Settings dialog box](image)

The description of the current zone is displayed at the top of the dialog box.

3 Select the Apply Transform Settings check box. When this box is selected, the other settings in the dialog box become active.

4 Select the Apply Sea Level Scale Factor check box.

**TIP** If you know the combined scale factor, then you can clear the Apply Sea Level Scale Factor check box, select User Specified as the Grid Scale Factor, and type a combined scale factor in the Grid Scale Factor box. The combined scale factor is the combination of the scale factor for converting local to sea level and the scale factor for converting sea level to grid.

5 Type a Default Elevation, such as the average elevation of your project site from sea level.

6 You can change the Spheroid Radius. The Spheroid Radius is the radius of a mathematical figure close to the shape of the Earth at sea level, approximately 6,370 km. The value shown in this box is initially derived from the current zone’s ellipsoid and can be changed if local observations differ. In most cases, the default value shown is the accepted value.

7 Select one of the following Grid Scale Factor options:

- **Unity**: To set the grid scale factor to 1.00 for all points within the zone.
- **User Specified**: To activate the Grid Scale Factor box, where you can type the grid scale factor value. For example, you can type the average scale factor of the points in your survey. This value is used for all points or locations within the zone and is constant.
■ Reference Point: To use the scale factor of the specified reference point (see the following equation) as the grid scale factor for all points or locations within the zone.

■ Prismoidal Formula: To use the prismoidal formula to calculate the grid scale factor. This is the recommended method because it accounts for the fact that every point has a different scale factor.

IMPORTANT When you use the Attach drawings feature of AutoCAD Map and you bring a source drawing that is set up in a different zone into the Map project, the source drawing is converted to the zone of the Map project. The Prismoidal Formula option sets a different value for each point within the zone. However, when you bring a source drawing that uses the Prismoidal Formula option into a Map project, a fixed scale factor is used. Therefore, the points that are brought into the Map project from the source drawing would not line up exactly with the points in the actual source drawing (when looked at independently of the Map project drawing).

The following equation is used to calculate prismoidal scale:

$$K_{eff} = \frac{K_{ref} + K_{pt} + K_{mid} \times 4}{6}$$

Where $K_{eff}$ is the grid scale factor, $K_{ref}$ is the scale factor of the reference point, $K_{pt}$ is the scale factor of the current point, and $K_{mid}$ is the scale factor of the midpoint between the reference point and the current point. A different value is used for each point or locations within the zone.

8 Specifying the Reference Point values. The reference point could be a benchmark that was used in a survey. It can be any point for which you know both the local coordinates and the grid coordinates. To specify the Reference Point values, do one of the following:

■ Select a COGO point from the drawing. For more information, see the following section, “Selecting a Point from the Drawing to Define the Transformation Reference Point.”

■ Type a COGO point number. For more information, see “Typing a COGO Point Number to Define the Transformation Reference Point” later in this chapter.

■ Type coordinate values in the boxes. For more information, see “Typing Point Coordinate Values to Define the Transformation Reference Point” later in this chapter.

9 To define the rotation angle for the transformation, do one of the following:

■ Select a COGO point from the drawing. For more information, see “Selecting a Point from the Drawing to Define the Transformation Rotation Point” later in this chapter.
Changing the Geodetic Zone Transformation Settings

- **Type a COGO point number.** For more information, see “Typing a COGO Point Number to Define the Transformation Rotation Point” later in this chapter.

- **Type coordinate values in the boxes.** For more information, see “Typing Point Coordinate Values to Define the Transformation Rotation Point” later in this chapter.

- **Type the rotation to grid north.** For more information, see “Typing a Rotation to Grid North to Define the Transformation Rotation Angle” later in this chapter.

The Grid Azimuth is calculated automatically when you define the rotation angle.

10 Click OK.

**IMPORTANT** Always save the drawing after you change the Transformation Settings if you are going to use the drawing in a Map project and perform queries on it. The changes you make to the Transformation Settings are not recognized in a Map query if you do not save the drawing first.

---

**Selecting a Point from the Drawing to Define the Transformation Reference Point**

1 Complete steps 1–7 in the section, “Changing the Geodetic Zone Transformation Settings” earlier in this chapter.

2 Click the Reference Point button.

3 Select a COGO point from the drawing.
   - The local northing and easting values are retrieved from the point database and are displayed in the dialog box.

4 Type the reference point’s Grid Northing and Grid Easting values.

---

**Typing Point Coordinate Values to Define the Transformation Reference Point**

1 Complete steps 1–7 in the section, “Changing the Geodetic Zone Transformation Settings” earlier in this chapter.

2 Under the Reference Point button, type local northing and easting values in the Local Northing and Local Easting boxes.

   **NOTE** The local northing and easting coordinates are automatically displayed if you select a point from the drawing or if you type a point number.

3 Type the reference point’s Grid Northing and Grid Easting values.
**Typing a COGO Point Number to Define the Transformation Reference Point**

1. Complete steps 1–7 in the section, “Changing the Geodetic Zone Transformation Settings” earlier in this chapter.
2. Under the Reference Point button, type the point number in the Point Number box.
   The Local Northing and the Local Easting coordinates are obtained from the point database and entered into the dialog box.
3. Type the reference point’s Grid Northing and Grid Easting values.

**Selecting a Point from the Drawing to Define the Transformation Rotation Point**

1. Complete steps 1–8 in the section, “Changing the Geodetic Zone Transformation Settings” earlier in this chapter.
2. Click the Rotation Point button.
3. Select a COGO point from the drawing.
   The local northing and easting values are retrieved from the point database and displayed in the dialog box.
4. Type the rotation point’s Grid Northing and Grid Easting values.

**Typing a COGO Point Number to Define the Transformation Rotation Point**

1. Complete steps 1–8 in the section, “Changing the Geodetic Zone Transformation Settings” earlier in this chapter.
2. Under the Rotation Point button, type the point number in the Point Number box.
   The Local Northing and the Local Easting coordinates are obtained from the point database and entered into the dialog box.
3. Type the rotation point’s Grid Northing and Grid Easting values.
**Type Point Coordinate Values to Define the Transformation Rotation Point**

1. Complete steps 1–8 in the section, “Changing the Geodetic Zone Transformation Settings” earlier in this chapter.
2. Under the Rotation Point button, type local northing and easting values in the Local Northing and Local Easting boxes.

   **NOTE** The local northing and easting coordinates are automatically displayed if you select a point from the drawing or if you type a point number.

3. Type the rotation point’s Grid Northing and Grid Easting values.

**Typing a Rotation to Grid North to Define the Transformation Rotation Angle**

1. Complete steps 1–8 in the section, “Changing the Geodetic Zone Transformation Settings” earlier in this chapter.
2. In the Rotation to Grid North box, type the grid north rotation.
   
   The rotation to grid north is the difference between the local coordinate system’s north meridian and the grid north meridian (of the current zone).
   
   If you are using True North, then this value may equal the convergence angle. If you are using magnetic north, then this value would be derived from the declination angle and the convergence angle.

**Changing the Output Settings**

There are several different commands that you can use to display the Output Settings dialog box. The following task describes how to access the dialog box from the Edit Settings dialog box.

1. From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box.
2. Under Programs, select Land Development Desktop.
3. From the Settings list, select Output Settings.
4 Click the Edit Settings button to display the Output Settings dialog box.

![Output Settings Dialog Box]

5 Under Output Options, select how you want to output the file.
   - Select the File check box to output the information to a text file.
   - Select the Screen check box to output the information to the screen.

   **NOTE** Some commands write output information specifically to the screen or to a file and ignore these two options.

6 Under Output Format, select or clear the following check boxes:
   - **Date**: Select this check box to place the date on the report. For example:
     
   
   - **Title**: Select this check box to place a title on the report. For example:
     
     Horizontal Alignment PI Station Report.
     Alignment: Road1  Desc: Subdivision access road
   
   - **Page Breaks**: Select this check box to place page breaks in the report. When you select this check box, and create a Screen report, the text window displays only the first page of the information and then prompts you to press a key to continue. When you select this check box, and create a File report, the report is created with page breaks instead of having all the information displayed in one long list.
If you select the Sub Headers and Page Breaks check boxes, then sub headers are placed at the beginning of each page break as shown in the following example.

Page Numbers: Select this check box to place page numbers on a report. This setting applies to File output only.
Sub Headers: Select this check box to place sub headers at the beginning of each new page of a report. This setting applies to File output only. You must also select the Page Breaks check box if you want sub headers to appear. The sub headers are placed at the beginning of each page break.
Overwrite File: Select this check box to overwrite a file if it already exists. Clear this check box to append new information to the end of an existing file. Be sure to also specify the correct Output File Name for the report.

NOTE
If you select the Overwrite File option, then each time you create a new report, be aware that if you do not assign a unique name to the report, the existing output report is overwritten.

7 Under Output Format, specify the following information:
Page Length: In this box, type the number of rows of type you want to have on each page. The spacing is measured in characters. This setting only applies if the Page Breaks check box is selected and if File is selected as an output option.
Page Width: In this box, type the number of characters you want to have across each page. This setting applies only to File output. It also affects the output of the Stakeout file. If the page width is too narrow, the lines wrap.
Left Margin: In this box, type the number of characters you want to have as a left margin. This setting applies only to File output.
Right Margin: In this box, type the number of characters you want to have as a right margin. This setting applies only to File output.
Top Margin: In this box, type the number of characters you want to have as a top margin. The margin is inserted between the page number (if you select the Page Numbers option) and the report title. This setting applies only to File output.
Bottom Margin: In this box, type the number of characters you want to have as a bottom margin. This setting applies only to File output.
8  Enter the Output File Name.

   NOTE  Each time you create a new report, be sure to change the default output file
name so you do not overwrite the previous report if you select the Overwrite
file check box.

9  If needed, you can click Output File Name to specify a folder for the output file. If
you do not specify an output folder, then the file that is created is placed in the
C:\Program Files\Land Desktop R2 folder by default.

10 Click OK when you have finished changing the settings.
Getting Started with Points

When you start a new project, you are prompted to set up the project point database. At this time you can enable the use of point names and establish character limits for each point data type.

Before you start working with points you should configure the point settings. The point settings control how points are created, inserted, displayed, and updated. They control whether point labels are used, and therefore whether description key substitution can occur when points are created or inserted into a drawing.
COGO Points

COGO points are the foundation for any civil engineering or surveying project. AutoCAD Land Development Desktop stores COGO points in an external database called points.mdb. Because points are stored outside of the drawing, the drawing file size is kept down and multiple people can access the database over a network.

You may work with a point database that contains thousands of points. To make point management easier, you can create point groups, which allow you to logically group points for surface creation, point editing, and point exporting. You can also use description keys to place points in the drawing with symbols on specific layers. In addition, you can create links with external, user-defined point databases for labeling points with extended information or for parameter substitution.

Creating the Point Database

When you create a new project, the Create Point Database dialog box is displayed. This dialog box lists the project and the point file name and contains options you can use to control how long point descriptions can be and whether to use point names or not.

**NOTE** After you set these options for a project, they are not editable.

To create the point database:

1. Create a new project. For more information, see the section “Creating a Project Using the Project Management Dialog Box” in Chapter 3, “Projects and Prototypes.”

The Create Point Database dialog box is displayed:

2. In the Point Description Field Size, type the number of characters you want to use for point descriptions. You can enter any number between 2 and 254.

3. To use alpha-numeric strings to identify points, select the Use Point Names check box. Point names are used in addition to the point numbers; they are not a replacement for point numbers. For more information about point names, see “Point Names” in this chapter.
If you selected the Use Point Names check box, then type the number of characters you want to use for point names. You can enter any number between 2 and 254.

Click OK to create the point database.

Point Names

To associate alpha-numeric text strings with points, you can enable the use of point names when you create a project. Point numbers are always required for points, but if you require more descriptive, alpha-numeric names, then use point names in addition to point numbers.

To use point names, you must set up the point database at the start of a project so that it uses point names.

To assign point names to points you create manually, you must turn off sequential (automatic) point numbering in the point settings. With this setting off, you see the following prompt when you create points:

Point name or number:

The character string that you enter at this prompt determines whether the string is used as the point's name or the point's number. To assign a name to the point, the name must start with an alphabetic character (a-z, A-Z) or an underscore (_ ) in order to be recognized as a name. After that you can use any number, alphabetic character, or underscore.

Valid Point Names

- abc123
- a1234_5678_xyz
- _1234

The last example is a valid point name because it begins with an underscore character. However, you cannot name a point “1234”, because “1234” would just be accepted as the point's number.

Invalid Point Names

- 3abc (starts with a number)
- abc-def (illegal character)

If you type an invalid point name, the command line reports that it is an “invalid entry”. If you enter a point name at the “point name or number” prompt, then the point is automatically assigned a point number, starting with the next available point number. If you enter a point number at the “point name or number” prompt, then no point name is assigned to the point.

For identification purposes, the point name is treated as an “alias” for the point number, but the point number is always considered the point’s primary identifier.

Point names are never shown in point marker text; you must label points to see point names in the drawing. To label points with point names, you can create a point label style that has “Point Name” as a data element.
Changing the Point Creation Settings

Depending on how you set up options in the point settings, each time you set a point, you may be prompted for descriptions, elevations, and point numbers, or these features can be automatically created.

Adding Points to the Drawing as Points Are Created

When you create or import points, the points are always added to the point database. However, you can control whether points are inserted into the drawing when you create or import them. For example, if you import a large number of points, you can choose to insert them into the project point database only. You can then use the Insert Points to Drawing command to insert a subset of the points into the drawing for viewing and editing purposes.

To add points to the drawing as the points are created

1. Do one of the following to display the Point Settings dialog box:
   - From the Points menu, choose Point Settings.
   - From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Point Settings and click the Edit Settings button.
2. Click the Create tab.
3. Select the Insert To Drawing As Created check box to place the points into the drawing and into the point database as you are creating or importing points. If you clear this check box, then the points are placed into the point database only.

**NOTE** Points are always inserted into the point database when you create or import points.

4. Click OK.

**Changing the Numbering Convention for Points**

Use the point numbering settings to control whether points are numbered sequentially or manually (which in turn controls whether point names are prompted for), whether points are inserted into the drawing as they are created, and what the current point number is.

**To change the numbering convention for points**

1. From the Points menu, choose Point Settings to display the Point Settings dialog box.
2. Click the Create tab.
3. Under Numbering, select or clear the Insert To Drawing As Created check box:
   - Select the Insert To Drawing As Created check box to place the points into the drawing and into the point database as you are creating or importing points.
   - Clear the Insert To Drawing As Created check box to place the points into the point database only.
4. Under Numbering, select or clear the Sequential Numbering check box:
   - Select the Sequential Numbering check box to sequentially number the points from the current point number as they are created.
     **NOTE** If you select this check box, then you are not prompted for a point name even if point names are enabled.
   - Clear the Sequential Numbering check box to be prompted to enter a point name or number each time that you create a point.
     **NOTE** If you clear this check box, and point names are enabled, then you are prompted to enter a point name or number at point creation prompts. The program recognizes any string that starts with an alphabetic character (a-z, A-Z) or an underscore character ( _ ) as a point name. If you type a numeric-only string, then the program recognizes it as a point number. If you type a point name, then the point is automatically assigned the next available point number. Point numbers are required for points.
Under Numbering, you can type an integer in the Current number box to change the start number for the points. The default number when you begin a project is 1. All sequential points use available point numbers starting with the current point number.

**NOTE** If you type an already-used number into the Current number box, then a message box is displayed, informing you that the point number is already in use or is invalid.

The current point number can differ by drawing and user, as described in the following topics:

**Current Point Number for a Drawing**

Each drawing can have a unique starting point number because this value is saved with the drawing. Every time you set a point in the project, it increments to the next available number. If that point number has been used already, or is locked, then the program continues to scan upward to the next available, unused and unlocked point.

**Current Point Number for a User**

In a networked environment where more than one person is adding new points, we recommend that each person set a different current point number to avoid confusion. For example, if you set points in a project at the same time as someone else starts with the same current point number, then your numbering sequence has gaps.

You may end up setting point numbers 1,2,4,7,8,10 while the other person sets point numbers 3,5,6,9. If the other person sets their current point number to 100, then you would have ended up with point numbers 1,2,3,4,5,6 while the other person set points 100,101,102,103. It may also be convenient to pre-assign ranges of points to each person, to minimize the need for frequent coordination.

**Changing the Point Elevation Settings**

You can create points with a pre-set elevation, create points without elevations, or be prompted for point elevations when you create points.

**To change the point elevation settings**

1. From the Points menu, choose Point Settings to display the Point Settings dialog box.
2. Click the Create tab.
3. Under Elevations, select one of the following options:
   - Select Automatic to automatically assign elevations to points, and then type the elevation to use in the Default Elevation box.
   - The default elevation defaults to the last elevation you enter when creating points.

   **NOTE**

   - Select Manual to manually assign elevations to points as they are created.
   - Select None to not assign elevations to points.
When points are created without elevations, a period (.) is displayed as the elevation value, as shown in the following illustration:

```
  122 122
+ 78.32 + .
benchmark benchmark
```

When you are importing points, the elevations from the file that you are importing are used regardless of the option you select here.

4. Click OK.

Changing the Point Description Settings

You can create points with a pre-set description, create points without descriptions, or be prompted for point descriptions when you create points.

To change the point description settings

1. From the Points menu, choose Point Settings to display the Point Settings dialog box.
2. Click the Create tab.
3. Under Descriptions, select one of the following options:
   - Select Automatic to automatically assign descriptions to points, and then type the description in the Default Description box. Descriptions can be between 2 and 254 characters, depending on the character limit you assigned to point descriptions when you created the project.
     
     **NOTE** The default description defaults to the last description you enter when creating points.
   - Select Manual to manually assign descriptions to points as they are created.
   - Select None to not assign descriptions to points.
When points are created without descriptions, a period (.) is displayed as the description value, as shown in the following illustration:

<table>
<thead>
<tr>
<th>122</th>
<th>122</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ 78.34</td>
<td>+ 78.34</td>
</tr>
<tr>
<td>benchmark</td>
<td>.</td>
</tr>
</tbody>
</table>

Points created without descriptions

**NOTE** When you are importing points, the descriptions from the file that you are importing are used regardless of the option you select here.

4 Click OK.

**Changing the Point Insertion Settings**

Use the point insertion settings to control what the search path is for symbols inserted with point labels or description keys. The point insertion settings control whether to insert points at actual or fixed elevations, and whether to use the current label style when inserting or creating points.

**NOTE** In order to label points that already exist in the drawing, the Use the Current Point Label Style When Inserting Points check box must be selected in the Point Settings dialog box. If this check box is selected when you are creating or inserting points, then the current point label style is automatically applied to the points—you do not have to label the points after they are inserted or created.

**To change the point insertion settings**

1 From the Points menu, choose Point Settings to display the Point Settings dialog box.
2 Click the Insert tab.

3 Under Search Path for Symbol Block drawing files, type a path for the symbols or click Browse and locate a path. This is the path for symbols inserted with point labels and description keys.

4 Under Insertion Elevation, select one of the following options:
   ■ Select Actual Elevation to insert the points in 3D, using the actual elevations of the points stored in the point database (or the elevations from the XRef if an XRef was used for elevations). If you select this option, then specify an elevation to assign to points that do not have elevational data assigned to them in the If No Elevation, Use box.
   ■ Select Fixed Elevation to insert the points using a fixed elevation for all points, and then type an elevation in the Fixed Elevation box.

   **NOTE** The Insertion Elevation settings do no affect the elevations in the point database, or the elevations that exist in an external database that are assigned by an XRef. These settings just control how the point’s elevation is represented in the 3D AutoCAD drawing.

   **IMPORTANT** In Autodesk S8 Civil/Survey, the points were always inserted into the drawing at an elevational value of 0, regardless of their actual elevations. Because of this, the DISTANCE command always reported the correct X,Y 2D distance between points. If you select the Actual Elevation check box, then the DISTANCE command (and any other command that reports distances) reports 3D distances.
5 Under Point Labeling, select or clear the Use The Current Point Label Style When Inserting Points check box:

- Select the Use The Current Point Label Style When Inserting Points check box to label points with the current point label style. When this option is selected, points that you create or insert are automatically labeled with the current point style, and you can label points that already exist in your drawing. When you select this option, the current label style is displayed beneath it.

  **NOTE** To insert points with description keys, you must select this option and set the current point label style to a label style that is set up to use description keys.

- Clear the Use The Current Point Label Style When Inserting Points check box to create or insert points with their default marker text only.

  **NOTE** The Use The Current Point Label Style When Inserting Points check box must be selected to label points that already exist in the drawing.

6 Click OK.

**Changing the Point Update Settings**

Use the point update settings to control whether points can be edited with the AutoCAD MOVE command, whether the point database is updated when the AutoCAD MOVE command is used, and whether the drawing is checked against the point database when the drawing is opened.

**To change the point update settings**

1 From the Points menu, choose Point Settings to display the Point Settings dialog box.
2 Click the Update tab.

3 Under AutoCAD MOVE Command, select or clear the Allow Points To Be MOVE’d In Drawing check box:
   - Select the Allow Points To Be MOVE’d In Drawing check box to use the AutoCAD MOVE, ROTATE, or ALIGN command to move points. Using these AutoCAD commands to move points in the drawing does not update the point database unless you select the Update Point Database After MOVE Command check box.
   - Clear the Allow Points To Be MOVE’d In Drawing check box if you do not want to use AutoCAD MOVE, ROTATE, or ALIGN to move points. When this check box is cleared, you can use the MOVE command to move point marker text, but leaders are created, pointing back to the unmoved point node.

   **NOTE** Unlike AutoCAD MOVE, the AutoCAD Land Development Desktop Move command automatically moves the points in the drawing and updates the point database.

4 Under AutoCAD MOVE Command, select or clear the Update Point Database After MOVE Command check box:
   - Select the Update Point Database After MOVE Command check box to update the COGO point database with the point coordinates when you use the MOVE command. The update does not happen automatically; you are prompted to confirm the update.
   - Clear the Update Point Database After MOVE Command check box if you do not want to update the COGO point database with the point coordinates when you use the MOVE command.
5 Under Point Checking, select or clear the Check Drawing Points Against Point Database On Open check box:

■ Select the Check Drawing Points Against Point Database On Open check box to check the drawing against the point database whenever you open the drawing. The drawing is then updated with any changes that were made to the point database. This option is very useful if you are working on the same project with other people.

■ Clear the Check Drawing Points Against Point Database On Open check box if you do not want to check the drawing against the point database when you open the drawing. Any differences between the drawing and the point database can be reconciled by using the Check Points commands.

6 Under Point Checking, do one of the following to specify how symbols react when you use the Check Points commands:

■ Select the Reunite Symbol With Description During Check Points check box to return point symbols to the exact insertion points of the points if the symbols are not already there. Symbols that are affected are the symbols that are inserted by using description keys or that are inserted with point labels. When a command such as Modify Drawing updates the point or symbol location, then the symbol returns exactly to the insertion point of the point.

■ Clear the Reunite Symbol With Description During Check Points check box to have symbols maintain their relative locations to the points so that if a point is moved, the symbol moves with it while staying the same distance away from the point.

7 Click OK.

### Changing the Coordinate Display Settings

Use the coordinate display settings to control whether point coordinates are displayed in Northing - Easting, Easting - Northing, X - Y, or Y - X format, and whether the point coordinates are echoed at the command line.

**To change the coordinate display settings**

1 From the Points menu, choose Point Settings to display the Point Settings dialog box.
2 Click the Coords tab.

3 Under Coordinate Display, select one of the following options:
   - **Northing - Easting**: Displays point coordinates in northing/easting format.
   - **Easting - Northing**: Displays point coordinates in easting/northing format.
   - **X - Y**: Displays point coordinates in X/Y format.
   - **Y - X**: Displays point coordinates in Y/X format.

   **NOTE** These options only affect point coordinates. Other objects in a drawing are not affected by this setting. These options control what you are prompted for at the command line as well as listing operations.

4 Select the Echo Coordinates on the Command Line check box to display the coordinates of the points that you create in the AutoCAD Text Window.

5 Click OK.

### Changing the Description Key Settings

You can use description keys any time you are prompted to enter a description for a point, or when you are importing points that use description keys.

The description key settings control the matching capabilities of description keys. You can control other description key settings when editing point label styles.

**To change the description key settings**

1 From the Points menu, choose Point Settings to display the Point Settings dialog box.
2 Click the Description Keys tab.

3 Under Description Key Search Order, select one of the following options:
   - Select Ascending to search the description key file from top to bottom. The ascending option searches the file from A to Z. In the ASCII character sequence, A is the lowest number of the alphabet, and Z is the highest number in the alphabet, which is why a search of this type is called ascending. For example, if you select Ascending, the description key ST* is used before the description key STA*, and every description starting with ST would use the ST* description key.
   - Select Descending to search the description key file from bottom to top. If you select Descending, then the STA* description key would be used before ST*, so that every description starting with STA would use the STA* description key. Then, if there are other descriptions that start with ST (but not STA), they would use the ST* description key.

4 Under Matching Options, select or clear the Match on Description Parameters ($1, $2, etc.) check box:
   - Select the Match on Description Parameters ($1, $2, etc.) check box to use description parameters in the description format, and for scaling and rotating the description key symbols.
   - Clear the Match on Description Parameters ($1, $2, etc.) check box if you do not want to use description parameters in the description format and for scaling and rotating the description key symbols.

For more information, see “Using Description Parameters in Description Keys” in Chapter 8, “Description Keys.”
5 Under Matching Options, select or clear the Perform Extended Default Search for Description Keys in DEFAULT.MDB check box:

- Select the Perform Extended Default Search for Description Keys in DEFAULT.MDB check box to search the default description key file for matching description keys, after the current description key file is searched and a match is not found.
- Clear the Perform Extended Default Search for Description Keys in DEFAULT.MDB check box to limit the search to the current description key file.

NOTE You set the current description key file in the Edit Label Styles dialog box.

6 Click OK.

Differences Between Point Markers and Point Labels

There are two different modes you can use to view point information on screen:

- Point markers
- Point labels

You can use point markers as a “working mode” and then you can label the points to place additional data on the point node.

Point markers have the following benefits

- You can set their size relative to the screen, so when you zoom in or out, they stay the same size.
- You can drag the marker text away from the point node, creating a leader with an arrow.
- They can show point number, elevation, and description. If description keys are in use, the full description of the point can be substituted for the raw description.

Point labels have the following benefits

- You can label points with XDRef information. (For more information about XDRefs, see “Using External Point Data References” in Chapter 9, “External Data References (XDRefs).”)
- You can label points with any amount of data: you are not limited to point number, elevation, or description. You can keep the marker text visible, showing point number, elevation, and description, and use the point labels to label the points with different information.
- You can observe the full affect of description key substitution when points are labeled. The full description is substituted for the raw description and the symbol is placed in the drawing.
- You can turn off point markers when labels are created.
Both labels and markers can exist at the same time, making a point appear like it has duplicate information. You can turn markers or labels off so that only one of the two is displayed.

**NOTE** In order to label points, the Use the Current Point Label Style When Inserting Points check box must be selected in the Point Settings dialog box. If this check box is selected when you are creating or inserting points, then the current point label style is automatically applied to the points—you do not have to label the points after they are inserted or created.

### Changing the Point Marker Symbol Settings

The point marker settings control the appearance of the point markers, such as the marker symbol and text. For more information about the differences between point markers and point labels, see “Differences Between Point Markers and Point Labels” in this chapter.

**To change the point marker symbol settings**

1. From the Points menu, choose Point Settings to display the Point Settings dialog box.
2. Click the Marker tab.
3. Select one of the following options:
   - Select Use Custom Marker to customize the marker settings. When you select this option, the other options in the dialog box become available for you to use.
   - Select Use AutoCAD POINT for Marker to use an AutoCAD point type as the point marker. If you select this option, then the other options in the dialog box are grayed out. To change the AutoCAD point type you can use the DDPTYPE, PDMODE, and PDSIZE commands.
4 Under Custom Marker Style select one of the five options for displaying the marker. You can use an X, a dot, and so on. The blank icon inserts no point marker.

5 Under Superimposed, you can choose to have a square and/or a circle superimposed around the point marker in the drawing by selecting the square or circle check boxes.

6 Under Custom Marker Size, select one of the following options:
   ■ Select Size Relative to Screen to scale the point marker size to a fixed percentage of the AutoCAD graphics screen. This option maintains the relative size of the point marker to the screen regardless of the zoom level. If you select this option, then type the percentage in the Size box.
   ■ Select Size in Absolute Units to make the point markers a fixed size in the drawing. If you select this option, then type the fixed size in units in the Size box.

7 Select the Align Marker With Text Rotation box to rotate the point marker at the same angle specified for the marker text rotation.

   **NOTE** To change the default rotation angle for the point marker text, type a rotation angle in the Text Rotation box on the Text tab of the Point Settings dialog box.

8 Click OK.

---

**Changing the Point Marker Text Settings**

Use the point marker text settings to control the following:

■ The visibility of point marker leaders
■ The color and visibility of the point marker text
■ Whether point markers show full descriptions instead of raw descriptions
■ Whether point marker size remains constant relative to the screen after zooming, or whether it is a fixed size in the drawing
■ The rotation of the point marker text

   **NOTE** To change the point marker settings for points already in the drawing, see “Changing the Point Display Properties for Points Already in the Drawing” in Chapter 13, “Editing Points.”

**To change the point text settings**

1 From the Points menu, choose Point Settings to display the Point Settings dialog box.
2 Click the Text tab.

3 Under Color and Visibility, choose which point marker components you want to be visible in the drawing and what color they are.
   - Select the Visible check boxes next to the marker component to view the feature in the drawing.
   - Click the color boxes next to the marker features to change the color of the component, or type a color number in the text box.

4 Select one of the following options:
   - Select Show Raw Descriptions to show the point descriptions that were originally assigned to the points, before description key matching is applied.
   - Select Show Full Descriptions to show the descriptions after description key matching is applied. The description key settings of the point label style that is current at the time the point object is inserted in the drawing are used to match the description.

   **NOTE** To show the full descriptions, the Use the Current Point Label Style When Inserting Points check box must be selected on the Insert Tab of the Point Settings dialog box.

5 Under Style and Size, select a text style to use for the point markers from the Text Style list.

6 Do one of the following to control the display size of the point markers:
   - Select Size Relative To Screen to scale the point marker text to a fixed percentage of the AutoCAD graphics screen. This option maintains the relative size of the point marker text to the screen regardless of the zoom level. If you select this option, then type the percentage in the Size box.
   - Select Size In Absolute Units to make the point marker text a fixed size in the drawing. If you select this option, then type the fixed size in units in the Size box.
Changing the Point Preferences

To change the point preferences

1. From the Points menu, choose Point Settings to display the Point Settings dialog box.

2. Click the Preferences tab.

Use the point preference settings to control whether to display dialog boxes instead of command line prompts for certain commands, and whether to regenerate the point marker display when zooming.

Changing the Point Preferences
3 Under Command Line Input, select or clear the Allow Command Line Input of Point Lists check box:

- Select the Allow Command Line Input of Point Lists check box to use command line options to define the list of points to use for point commands. When this check box is selected, a prompt similar to the following is displayed when you select point editing/inserting/removing commands:

  Points to lock (All/Numbers/Group/Selection/Dialog) ? <Dialog>:

- Clear the Allow Command Line Input of Point Lists check box to define point lists from the Point List dialog box.

4 Under Command Line Input, select or clear the Allow Command Line Input of Point Group Names check box:

- Select the Allow Command Line Input of Point Group Names check box to type point group names at the command line to select the groups.

- Clear the Allow Command Line Input of Point Group Names check box to select point groups from a dialog box only.

5 Under Point List Dialog, select one or more of the following:

- Select the Sort Point List After Remove Duplicates is Pressed check box to sort the point list when you click the Remove Duplicates button in the Point List dialog box.

- Select the Sort Point List After Remove is Pressed check box to sort the point list when you click the Remove button in the Point List dialog box.

**WARNING** Clear these check boxes when you are creating order-dependent point lists. For example, when you are creating a point list to use for a Best Fit Line, the order of the points in the list is imperative.

6 Under Point Display, select or clear the Always Regenerate Point Display After Zoom check box:

- Select the Always Regenerate Point Display After Zoom check box to regenerate the point display when you change the zoom level. Point markers only resize if the point display is regenerated. Therefore, if you set the point marker display size as Size Relative to Screen, and you select the Always Regenerate Point Display After Zoom check box, then when you zoom, the point marker display is updated.

**NOTE** This setting does not perform a REGEN on the drawing. Only the points are regenerated, not the entire drawing.

- Clear the Always Regenerate Point Display After Zoom check box if you do not want to regenerate the point display when you change the zoom level. If you set the point marker display size as Size Relative to Screen, and you clear the Always Regenerate Point Display After Zoom check box, then when you zoom, the point marker size is not updated.

7 Click OK.
To make it easier to organize and access points in the project point database, you can create point groups. To create a point group, you must select the points to be in the group by building a point list. If desired, you can apply overrides to point groups to substitute point data in the project point database.
Point Groups

You may work with a point database that contains thousands of points. To make point management easier, you can create point groups, which allow you logically group points for surface creation, point editing, and point exporting.

Point groups are a collection of point numbers that you can use to simplify point selection for several different functions. For example, to build a surface out of points, you can create an EG point group that contains all the points you want to use to build an existing ground surface. After you set up the EG point group, you can reuse it every time you want to rebuild the surface. You can also add points to the group later.

You can add the points that exist in the point database file to point groups. A point number can be in more than one point group at a time. If you insert a point group into a drawing, and then insert another point group into the drawing that contains some of the same points that was in the first group, then those duplicate points take on the attributes of the second group (such as labeling settings and so on).

To create a point group, you must first create a point list. This list contains the point numbers that you want to add to the group. You can select all the points in the project, specific points in the drawing, or filter points based on elevation range, description, and so on. Point lists are also used for selecting points to edit or insert.

NOTE After you create the COGO point groups database file using Release 2 of AutoCAD Land Development Desktop, the point groups database file may not be used with any prior version of AutoCAD Land Development Desktop.
The Point Group Manager

To create, modify, or delete point groups, you can use the Point Group Manager. Point groups are a collection of point numbers in the project point database that you can use to simplify point selection for several different functions, such as inserting points, importing points, and for including points from the point database in a surface.

The Point Group Manager has the following new features for Release 2 of AutoCAD Land Development Desktop:

- Printing commands available through shortcut menu and Manager menu
- Drag-and-drop column ordering
- Columns retain widths after sizing

In addition, you can right-click on a column heading to hide and restore column visibility.
Creating a Point Group

To create a point group, you must first build a point list. You can build a point list from all or selected points in the project, from existing point groups, or you can use advanced options to filter points. You can use overrides to establish a single fixed value for a point, or to reference a column of data in a custom Microsoft Access database. These overrides include the Point Label Style, the description, the elevation, and the point name.

To create a point group

1. From the Points menu, choose Point Management ➤ Point Group Manager to display the Point Group Manager dialog box.
2. Do one of the following to display the Create Point Group dialog box:
   - Click
   - Right-click in the left-hand pane of the Point Group Manager and select Create Point Group.
   - From the Manager menu in the Point Group Manager, choose Create Point Group.
3. In the Group Name box type a name for the group.

Point group names are limited to the following characters: alphanumeric (A–Z, a–z, 0–9), dash (-), underscore (_), and space ( ). There is no restriction on the first character, so point group names can begin with any of these characters. The total length of a point group name must not exceed 32 characters.
4. Click Build List to display the Point List dialog box.

5. Select the points to add to the list.
   - Select All Points to add all the points from the project point database to the list.
   - Select Drawing Selection Set and then click the Select button to select points from the drawing. You can use the 'Zoom and Pan' commands transparently to help you locate the points to select.
   - Select Point Group and then select a group name to create the list from a pre-existing group.

   **TIP**
   Click the Advanced button to use advanced point selection options. For more information, see “Creating a Point List Using Advanced Point Selection Options” in this chapter.

6. To remove duplicate points from the list, click Remove Duplicates.

   **NOTE**
   If you selected the Sort Point List after Remove Duplicates is pressed check box in the Point Settings dialog box, then the Remove Duplicates button also sorts the list.
7 You can set up point group overrides. For more information, see “Setting Up Point Group Overrides” in this chapter.
8 Click OK to return to the Point Group Manager. The point group you created is displayed in the left-hand pane of the dialog box, and the points in the point group are listed in the right-hand pane.

Creating a Point List Using Advanced Point Selection Options
You can click the Advanced button in the Point List dialog box to display options that you can use to select points, filter points, and view point data.

Using Advanced Point Source Options To Build a Point List
When you click the Advanced button in the Point List dialog box, three tabs appear: Source, Filter, and List.

To use the Source tab options to select points
1 Do one of the following to display the Point List dialog box:
   ■ From the Points menu, choose Point Management ➤ Point Group Manager. From the Manager menu, choose Create Point Group to display the Create Point Group dialog box. Click the Edit List button.
   ■ From the Points menu, choose List Points.
   ■ From the Points menu, choose Edit Points ➤ Edit Points.

   NOTE The dialog box can also be displayed when you type Dialog at the following prompt, which is displayed when you select several different point editing commands, such as Lock Points.

   Points to Lock (All/Numbers/Group/Selection/Dialog) ? <Dialog>:

   2 Click the Advanced button.
3 Click the Source tab.

4 Do one or more of the following to create the point list:
   - Select All Points to add all the points from the project point database to the list.
   - Select Drawing Selection Set and then click the Select button to select points from the drawing. You can use the 'Zoom and 'Pan commands transparently to help you locate the points to select.
   - Select Drawing Selection Set and then click the All Project Points in Window button to select points from the drawing and the project database. When you select this option, all the project points that are inside the window that you draw are selected, regardless of whether they are in the drawing or not.
   - Select Group Points and then select a group name from the Group list to create the list from a pre-existing group.
   - Select Group Points with Overrides and then select a group name from the Group list to add a group to the list and to use the overrides that you have already set up for that group.

When you select the points, the source points are listed in the Source Point List box.
5 Click one of the following options:
- Click Add to add the points in the Source Point List box to the Current List, which is displayed at the top of the dialog box.
- Click Remove to remove the points in the Source Point List box from the Current List.

**NOTE** If you selected the Sort Point List after Remove is pressed check box in the Point Settings dialog box, then the Remove button also sorts the list.

6 Click Remove Duplicates to remove duplicate points from the list.

**NOTE** If you selected the Sort Point List after Remove Duplicates is Pressed check box in the Point Settings dialog box, then the Remove Duplicates button also sorts the list.

7 Click Create Group to create a point group from the list.

**NOTE** This button is not enabled when you access the Point List dialog box from the Create Point Group dialog box.

8 Click OK.

**Filtering a Point List**

When you click the Advanced button in the Point List dialog box, three tabs appear: Source, Filter, and List. You can use the filtering options to create a point list of specific ranges of point numbers, elevations, descriptions, and names, among other options.

**To use the Filter tab options to filter a point list**

1 Do one of the following to display the Point List dialog box:
- From the Points menu, choose Point Management ➤ Point Group Manager.
  From the Manager menu, choose Create Point Group to display the Create Point Group dialog box. Click the Edit List button.
- From the Points menu, choose List Points.
- From the Points menu, choose Edit Points ➤ Edit Points.

**NOTE** The dialog box can also be displayed when you type Dialog at the following prompt, which is displayed when you select several different point editing commands, such as Lock Points.

Points to Lock (All/Numbers/Group/Selection/Dialog) ? <Dialog>:

2 Click the Advanced button.
3 Click the Filter tab.

The Source label shows which option you used to select the points and lists which points are in the list.

4 Set up the filter by selecting any of the following options:
- Ranging In Numbers From (see the following section).
- Ranging In Elevations From (see the following section).
- With Name Matching (see the following section).
- With Description Matching (see the following section).
- With XRef Matching (see the following section).

5 Select one of the following options to specify whether you want to include the matching (filtered) points in the resulting point list or exclude the matching points from the Resulting Point list.
- Include Matching Points: Select this option to add the matching points to the Resulting Point List. For example, if the source list is 1–45, and you include points 1–10 by filtering them, then the list 1–10 is displayed in the Resulting Point list.
- Exclude Matching Points: Select this option to exclude the matching points from the Resulting Point List. For example, if the source list is 1–45, and you excluded points 1–3 by filtering them out, then the list 4–45 is displayed in the Resulting Point list.

6 Click the Filter button to filter the list. The resulting list is displayed in the Resulting Point List box.
7 Click one of the following buttons:
   ■ **Add**: Click this button to add the Resulting Point list to the Current List, which is displayed at the top of the dialog box.
   ■ **Remove**: Click this button to remove the Resulting Point list from the Current List.

8 Click Remove Duplicates to remove duplicate points from the Current List.

   **NOTE** If you selected the Sort Point List after Remove Duplicates is pressed check box in the Point Settings dialog box, then the Remove Duplicates button also sorts the Current List.

9 Click Create Group to create a point group from the Current List.

   **NOTE** This option is not enabled when you access this dialog box from the Create Point Group dialog box.

**Filter Option: Ranging in Numbers From**

1 Select the Ranging In Numbers From check box to filter points based on a number range.
2 Type the beginning of the range (the lowest point number you want to use).
3 Type the ending of the range (the highest point number you want to use).

**Filter Option: Ranging in Elevations From**

1 Select the Ranging In Elevations From check box to filter the points based on an elevation range.
2 Type the beginning of the elevation range (the lowest elevation you want to use).
3 Type the ending of the elevation range (the highest elevation you want to use).

**Filter Option: With Name Matching**

1 Select the With Name Matching check box to filter the points based on a point name.
2 Type the string that you want to use as a filter.

   **TIP** You can use wildcard characters to filter point names. For example, you can type **STA*** to filter on all point names that start with STA. For an introduction to wildcard characters, see “Using Wildcard Characters in Description Keys” in Chapter 8, “Description Keys.”

**Filter Option: With Description Matching**

1 Select the With Description Matching check box to filter the points based on a point description.
2 Select one of the following options:

- Select the Raw Desc option to filter the points based on the original, raw, point descriptions.
- Select the Full Desc option to filter the points based on the point descriptions that were substituted by description keys.

3 Type the string that you want to use as a filter.

**TIP**
You can use wildcard characters to filter descriptions. For example, you can type STA* to filter on all point descriptions that start with STA. For an introduction to wildcard characters, see “Using Wildcard Characters in Description Keys” in Chapter 8, “Description Keys.”

### Filter Option: With XDRef Matching

**NOTE** Before using this option, you must set up XDRefs. For more information on how to set up XDRefs, see “Creating an External Data Reference (XDRef)” in Chapter 9, “External Data References (XDRefs).”

1 Select the With XDRef Matching check box to filter points based on values in an external database.

2 Select the XDRef to use from the XDRef to Search list.

3 Enter the string that you want to use as a filter. The actual XDRef values in the external database are filtered for a match. This string is case sensitive. TOPO is not the same as topo.

**TIP**
You can use wildcard characters to filter XDRefs. For example, you can type STA* to filter on all XDRef values that start with STA. For an introduction to wildcard characters, see “Using Wildcard Characters in Description Keys” in Chapter 8, “Description Keys.”

For example, say you have an external database that contains a column of point description data. You can set up an XDRef for the column, and create a point group that uses the XDRef as the description override. However, you only want to include in the point group the points whose descriptions start with T. To do this, click the Advanced button in the Point List dialog box and then click the Filter tab. Select the With XDRef matching box, select the XDRef, and then type T* as the string you want to filter on. Click Filter to filter the points in the external database that have descriptions that start with T. You can click Add to add these points to the current point list.

**NOTE**
You can also use this filtering mechanism when inserting points into the drawing, selecting points to edit, and so on. For example, you could set up a point group that uses an XDRef override to use all of the point descriptions in the external database. Then when using the Insert Points to Drawing command, select the Dialog option to select the points to insert from the Point List dialog box. Click the Advanced button, click the Filter tab, and then specify the XDRef and the string to filter on.
Using Wildcard Characters
You can use any of the following wildcard characters to search for descriptions, point names, and XDRefs.

### Wildcard Characters

<table>
<thead>
<tr>
<th>Character</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td># (pound)</td>
<td>Matches any single numeric digit</td>
</tr>
<tr>
<td>@ (at)</td>
<td>Matches any alphabetic character</td>
</tr>
<tr>
<td>. (period)</td>
<td>Matches any nonalphabetic character</td>
</tr>
<tr>
<td>* (asterisk)</td>
<td>Matches any string and can be used anywhere in the search string</td>
</tr>
<tr>
<td>? (question mark)</td>
<td>Matches any single character, for example, ?BC matches ABC, 3BC, and so on</td>
</tr>
<tr>
<td>~ (tilde)</td>
<td>Matches anything but the pattern, for example, ~<em>AB</em> matches all strings that don’t contain AB</td>
</tr>
<tr>
<td>[ ]</td>
<td>Matches any one of the characters enclosed, for example, [AB]C matches AC and BC</td>
</tr>
<tr>
<td>[~ ]</td>
<td>Matches any character not enclosed, for example, [~AB]C matches XC but not AC</td>
</tr>
<tr>
<td>- (hyphen)</td>
<td>Inside brackets, specifies a range for a single character, for example [A-G]C matches AC, BC, and so on to GC, but not HC</td>
</tr>
<tr>
<td>' (reverse quote)</td>
<td>Reads the next character literally, for example, '*AB matches *AB</td>
</tr>
</tbody>
</table>

Viewing a Point List
When you click the Advanced button in the Point List dialog box, three tabs appear: Source, Filter, and List.

To use the List tab options to view and sort the Current Point list

1. Do one of the following to display the Point List dialog box:
   - From the Points menu, choose Point Management ➤ Point Group Manager. From the Manager menu, choose Create Point Group to display the Create Point Group dialog box. Click the Edit List button.
   - From the Points menu, choose List Points.
   - From the Points menu, choose Edit Points ➤ Edit Points.

   **NOTE** The dialog box can also be displayed when you type Dialog at the following prompt, which is displayed when you select several different point editing commands, such as Lock Points.

   Points to Lock (All/Numbers/Group/Selection/Dialog) ? <Dialog>:
2 Click the Advanced button.
3 Click the Edit tab.

The Edit tab shows the point number, name, elevation, description, easting, northing, latitude, longitude of the points in the list.

4 You can click on a column heading to sort the point list.

**NOTE** If you access this dialog box by selecting the List Points command, the tab is named List instead of Edit.

**Point Group Overrides**

When you create a point group, by default the points in that group retrieve all of their information from the COGO point database. For example, in the COGO point database, point 1 has a description of Benchmark and an elevation of 100. If you create a group that includes point 1, then the point retrieves its data from the COGO point database and have the description Benchmark and the elevation 100.

However, you can also set up overrides for the points in a point group. Overrides can substitute Point Label Style, description, elevation, and name. For example, you could set up an override for the group that replaces point 1’s description, Benchmark, with a description of TOPO. The data in the point database remains unchanged, but when the point is referenced in a group, the point has an override, TOPO, as its description.
There are two ways to override point data in point groups:

- You can override the point label style, description, elevation, or name with a single fixed value that is used for all points in the group.
- You can specify an XDRef name to substitute data that is in a Microsoft Access database on a point-by-point basis. Use this option to override each point with a different value.

### Setting Up Point Group Overrides

To override the existing properties of the points in a point group, you can apply point overrides. You can either establish a fixed value to use as an override, or reference an XDRef. By referencing an XDRef, you can substitute point properties from an external database, such as point elevations, for the current properties of the points.

The following dialog box shows a point group that has overrides assigned to it:

![Point Group Properties](image)

**To set up point group overrides**

1. From the Points menu, choose Point Management ➤ Point Group Manager to display the Point Group Manager dialog box.
2. Select the point group for which you want to set up overrides.
   
   **NOTE** You can set up point group overrides while you create a point group, or you can use the Properties command to set up point group overrides for an existing group.

3. From the Manager menu in the Point Group Manager, choose Properties, or click to display the Point Group Properties dialog box.
4. Under Point Overrides select the point Property check boxes for properties that you want to override:
   
   - **Point Label Style**: Substitutes a fixed label style or label styles set up in an XDRef.
   - **Description**: Substitutes a fixed description or descriptions set up in an XDRef. Description overrides are always applied to the point’s raw description.
   - **Elevation**: Substitutes a fixed elevation or elevations set up in an XDRef.
   - **Name**: Available only if the point database is set up to use point names. This check box substitutes a fixed name or names set up in an XDRef.
In the Override column, assign an override:

To assign a fixed override, click in a box (see the following example) and type the override that you want to use.

<table>
<thead>
<tr>
<th>Property</th>
<th>Override</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Name</td>
<td>✍️ &lt;click here&gt;</td>
</tr>
</tbody>
</table>

The ✍️ icon indicates that the override is fixed. For example, to override the names of all of the points in the group with TOPO, select the Name check box, click in the override box, and then type the name that you want to use as an override in the adjacent box.

<table>
<thead>
<tr>
<th>Property</th>
<th>Override</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Name</td>
<td>✍️ TOPO</td>
</tr>
</tbody>
</table>

Fixed overrides are limited to 32 characters. Point names and descriptions are also limited by the character limit you assigned when you first created the project.

To assign an XDRef override, click the ✂️ icon to display the ✂️ icon. The ✂️ icon indicates that the override is an XDRef override.

Then click in the box next to the ✂️ icon (see the following example) to display the Select External Data Reference dialog box, where you can select the XDRef to use.

<table>
<thead>
<tr>
<th>Property</th>
<th>Override</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Name</td>
<td>✂️ &lt;click here&gt;</td>
</tr>
</tbody>
</table>

When you select the XDRef, its name is displayed in the Override box. The following illustration shows that the point names in the point group are overridden by the point names in the external database defined by the XDRef called “PT Name XDRef”.

<table>
<thead>
<tr>
<th>Property</th>
<th>Override</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Name</td>
<td>✂️ PT Name XDRef</td>
</tr>
</tbody>
</table>

For more information about creating XDRefs, see “Creating an External Data Reference (XDRef)” in chapter 9, “External Data References (XDRFs).”

You can determine whether overrides are in use by looking at the point group in the Point Group Manager. In the following illustration, the Elevation column shows that an XDRef override is applied to the data:

| ✓ ✂️ | Elevation |

In the following illustration, the Raw Description column shows that a fixed override is applied to the data:

| ✓ ✍️ | Raw Desc |
Example: Creating a Point Group with an XDRef Override

The following example describes how to use a sample user database to set up an XDRef and to use the XDRef to override point descriptions in a point group.

To create a point group with an XDRef override

1. Create a new project and a new drawing.
2. Place some points in the drawing, starting with point number 1.
3. From the Points menu, choose Point Management ➤ XDRef Manager to display the XDRef Manager dialog box.
4. From the Manager menu, choose Create XDRef to display the Create External Data Reference dialog box.

5. Click to display the Find User Database dialog box.
6. Select the sample user database, SampleUserDb.mdb, from the following folder:
   c:\Land Projects R2\<project name>\cogo\UserDb
7. Click Open to return to the Create External Data Reference dialog box.
   When you select the database, the table and column name lists become active.
8. From the Table Name list, select SampleTable1.
9. From the Column Name list, select DESC1.
10. In the Name box, type XDREF Name.
    The Create External Data Reference dialog box should appear as shown in the following illustration:

11. Click OK.
12. Close the XDRef Manager.
13. From the Points menu, choose Point Management ➤ Point Group Manager to display the Point Group Manager dialog box.
14. From the Manager menu, choose Create Point Group to display the Create Point Group dialog box.
15 In the Name box, type a name for the point group.
16 Click Build List to build the point list. For more information, see “Creating a
Point Group” in this chapter.
17 Click OK to return to the Create Point Group dialog box.
18 Under Point Overrides, select the Description check box.
19 Click the icon to change it to the icon.
20 Click in the box next to the icon to display the Select External Data Reference
dialog box.

![Select External Data References dialog box]

21 Select XDREF Name.
22 Click OK to return to the Create Point Group dialog box. The Point Overrides
section of the dialog box should appear as shown in the following illustration:

![Point Overrides]

23 Click OK to return to the Point Group Manager.

The point descriptions substituted for the values in the COGO database appear in
the Description column as shown in the following illustration:

![Desired Input]

Now when you insert the points as a group, the descriptions substituted from the
XDRef are used instead of the raw descriptions in the COGO point database.
### Removing Points from a Point Group

To remove points from a point group you can use the Filter options in the Advanced section of the Point List dialog box. You can specify the points to remove by filtering on a range of point numbers, a set of points that fall within an elevation range, point names, descriptions, and XRef information.

**To remove points from a point group**

1. From the Points menu, choose Point Management ➤ Point Manager Group to display the Point Group Manager dialog box.
2. In the right-hand pane, right-click the point group you want to edit to display the shortcut menu.
3. Select Properties to display the Point Group Properties dialog box.
4. Click Edit List to display the Point List dialog box.
5. Click the Advanced button.
6. Click the Filter tab.
7. Use the Filter options to select the point or points you want to remove from the point group.
   - For example, to remove point numbers 5-10, select the Ranging in Numbers From check box, and then type 5 in the first edit box and 10 in the second edit box.
8. Select the Include Matching Points option. This option adds the specified points to a selection set that you can later remove from the point group.
9. Click Filter to filter the points.
   - The resulting point list is displayed in the Resulting Point List box. For example, if you specified point numbers 5–10 and click Filter, then points 5-10 are listed in the Resulting Point List box.
10. Click OK to continue.
11. Click Remove to remove the points from the point group.
   - AutoCAD displays a message box informing you that the removal is complete.
12. Click OK to continue.

### Using Existing Overrides for Points in a Point Group When Selecting the Group

Overrides work for point groups only if you reference the group as a group. For example, say you create a point group that contains all the points in your project and you name the group EVERY POINT. You assign a description override of TOPO to the group, and then you insert the points into the drawing by selecting the EVERY POINT group. For example, when you select the Insert Points to Drawing command, the following prompt is displayed:

```
Points to insert (All/Numbers/Group/Window/Dialog) ? <Dialog>:
```

When you use the Group option to insert the points, the override is applied to the group and the points are inserted into the drawing with the description TOPO.
However, if you do not reference the group as a group, overrides are not applied. For example, if you select the All option as displayed in the previous prompt, all the points would be inserted into the drawing, but because they were not referenced as a group, the overrides are not applied.

**Description Key Matching and Point Group Overrides**

When you assign an override for the points' descriptions, the points' raw descriptions are overridden. If the raw description is a description key and the raw description is overridden, then the description key is not used. However, if the description you assign as an override contains a description key code, then description key substitution is applied to the points.

For more information on how description keys are applied to points, see “Description Keys and Point Markers and Point Labels” in Chapter 8, “Description Keys.”

**Creating a Point List from a Point Group that has Overrides Applied to It**

Unless you turned off the option to allow command line input of point groups, a prompt similar to the following is displayed when you select a command that requires a point selection set, such as Insert Points to Drawing:

Points to insert (All/Numbers/Group/Window/Dialog) ? <Dialog>:

At this prompt you have several options for selecting points. To select point groups that have overrides applied to them, you can do one of the following:

- You can use the Group option to select a group name from the current list of groups or to type the point group name at the command line. When you select a group this way, all the overrides that are set up for that group are applied to the group.
- You can use the Dialog option to display the Point List dialog box. Click the Advanced button and then click the Source tab. Select the Group Points with Overrides option and then select the group from the list.

**NOTE** If you select the Group Points option, or if you select the point group from the Simple point group dialog box, then overrides are not applied. By using Group Points with Overrides option, all overrides are used.

You can see the actual override values displayed for each point in the right-hand pane of the Point Group Manager. If there is a check box in the column header, then the column has an override. If there is a icon in the column header, then an XDRef controls the override, for example:
Deleting a Point Group
You can delete a point group if you no longer need to use it. Deleting a point group does not delete the points in the point group; the points remain intact in the COGO point database.

To delete a point group
1. From the Points menu, choose Point Management ➤ Point Group Manager to display the Point Group Manager dialog box.
2. Select the point group that you want to delete.
3. Do one of the following to delete the point group:
   - Click \( \times \).
   - Right-click to display the shortcut menu and select Delete.
   - From the Manager menu, choose Delete.

The following message is displayed:

4. Click Yes to delete the point group.

Changing the Properties of a Point Group
You can change point group overrides, point group name, and which points are in the point group by changing the point group properties.

To change point group properties
1. From the Points menu, choose Point Management ➤ Point Group Manager to display the Point Group Manager dialog box.
2. Select the point group you want to edit.
3 Do one of the following to display the Point Group Properties dialog box:

- Click  
- Right-click to display the shortcut menu and select Properties.
- From the Manager menu, choose Properties.

4 In the Group Name box, you can type a different name to rename the point group.

5 In the Point List box, you can type a different range of point numbers to change the points in the point group, or you can click the Edit List button to access the Point List dialog box, where you can use advanced point selection and filtering methods.

6 Under Point Overrides, you can set up point group overrides. For more information, see “Point Group Overrides” in this chapter.

Creating Point Lists

You can create lists of points to add to a point group, to edit, to insert, or to list information about. Point groups are always based on a point list. The point list can contain all the points in the project, selected points from the graphics screen, or filtered points that match a specific criteria, such as points that are located at elevations between 100 and 200.

You can use the point list selection method for point editing, inserting, and removing points as well. When you select a point editing command, the following prompt is displayed:

`Points to lock (All/Numbers/Group/Selection (Window)/Dialog) ? <Dialog>:`

You can type `Dialog` at this prompt to build a list of points to select.

If you clear the Allow Command Line Input of Point Lists check box in the Point Settings, then the prompt is not displayed. Instead, the Point List dialog box is automatically displayed.
Creating a Point List

You can create lists of points to add to a point group, to edit, or to view.

The Point List dialog box has the following new features for Release 2 of AutoCAD Land Development Desktop:

- Printing commands available through shortcut menu and Printing menu
- Drag-and-drop column ordering
- Columns retain widths after sizing

In addition, you can right-click on a column heading to hide and restore column visibility.

To create a point list

1. Do one of the following to display a dialog box you can use to create a point list:
   - From the Points menu, choose Point Management ➤ Point Group Manager. From the Manager menu, choose Create Point Group to display the Create Point Group dialog box. Click the Build List button.
   - From the Points menu, choose List Points.
   - From the Points menu, choose Edit Points ➤ Edit Points.
Do one or more of the following to create the point list:

- Select All Points to add all the points from the project point database to the list.
- Select Drawing Selection Set and then click the Select button to select points from the drawing. You can use the ‘Zoom’ and ‘Pan’ commands transparently to help you locate the points to select.
- Select Point Group and then select a group name to create the list from a pre-existing group.

**TIP** Click the Advanced button to use advanced point selection options. For more information, see “Creating a Point List Using Advanced Point Selection Options” in this chapter.

3 Click Remove Duplicates to remove duplicate points from the list.

**NOTE** If you selected the Sort Point List after Remove Duplicates is Pressed check box in the Point Settings dialog box, then the Remove Duplicates button also sorts the list.

4 Click the Create Group button to create a group from the point list.

**NOTE** This button is not enabled when you access the Point List dialog box from the Create Point Group dialog box.

5 Click OK to build the list.
Description Keys

You can use description keys to replace a point’s raw description with a full description, to insert a symbol along with the point information, and to place symbols and point nodes on specified layers. Use the Description Key Manager to create and manage description keys. Use point label styles to apply description key substitution to points.

In this chapter

- Using Description Keys
- Using the Description Key Manager
- Using Description Parameters in Description Keys
- Using Wildcard Characters in Description Keys
- Saving a Description Key File to a Prototype
- Loading a Description Key File from a Prototype
Using Description Keys

Use description keys to associate symbols with COGO points, to place points on specific layers, and to substitute full descriptions for raw descriptions. The effect of description keys depends on whether you are using point markers or point labels.

When you create COGO points, you can enter a description key at the Description prompt. The program searches for the description key in the description key file. If the key is found, then the full description, point layer, and symbol information are retrieved from the description key file. If the key is not found, then the entered key is used as the description for the point.

Description keys are also used when you insert existing points into the drawing from the point database file, or when you import points into the drawing from an external file or user database. When the point is inserted into the drawing, the point layer and symbol associations of the description key file are applied to the points.

To use a description key when creating, inserting, or importing points

1. Change the search path for symbol blocks so it points to the location of the symbols you want to use. For more information, see “Changing the Point Insertion Settings” in Chapter 6, “Getting Started with Points.”

2. Turn on the option to use the current point label style when inserting points. For more information, see “Changing the Point Insertion Settings” in Chapter 6, “Getting Started with Points.”

3. Set up the Description Key settings. For more information, see “Changing the Description Key Settings” in Chapter 6, “Getting Started With Points.”

4. Format a label style to use description keys. (For more information, see “Description Keys and Point Markers and Point Labels” in this chapter.) Or, if you just want to use point markers, select the option to insert the points’ full descriptions on the Text tab of the Point Settings dialog box and make a point label style that is set up to use description key substitution the current point label style.

5. Create description keys. For more information, see “Creating a Description Key” in this chapter.

6. Use a description key as a point’s raw description. The description key is interpreted and the point’s raw description is replaced by a full description (optional); a symbol is inserted, and the symbol and point are placed on separate layers.

All drawings within a project can use the description keys that you set up, so multiple people working across a network all have access to the same description keys. Description keys are stored in description key files. You can have multiple description key files per project. Description key files are saved externally, in the project directory. The files are named <name>.mdb, and are located in the c:\Land Projects R2\<project name>\cogo\DescKey folder.

You can use wildcard characters when you create description keys. Wildcards expand the flexibility of description keys. For example, if you create a description key named T*, then any point whose description starts with T (such as Topo, T-1, T2) is assigned the description key symbol.
For examples of situations in which you can use description keys, see the following scenarios:

**Description Key Scenario 1: Importing Points**

When recording point data out in the field, use a description convention. This convention makes it easier to implement description key substitution. For example, use BM as a prefix for all benchmark points. You can set up a description key so that when you download the points and import the ASCII file into AutoCAD Land Development Desktop, all points that begin with a prefix of BM are assigned a symbol, layer, and full description.

**Description Key Scenario 2: Creating Points**

When creating points, decide on a point naming convention and set up description keys based on this convention. You can then create points and assign descriptions to them that are based on the description keys. For example, if you use TOPO as a prefix for all topographic points, then create a description key called TOPO*. When you create points and are prompted to enter the description for a point, use TOPO as the description prefix. For example, you can create TOPO-1, TOPO-2, and so on. By doing this, each point with the TOPO prefix is assigned the symbol, layer, and optional description that was established for the TOPO* description key.

**NOTE**

After you create the COGO description key database file using Release 2 of AutoCAD Land Development Desktop, the description key database file may not be used with any prior version of AutoCAD Land Development Desktop.

**Description Keys and Point Markers and Point Labels**

To fully implement description key substitution, you must set up and use a Point Label Style that is formatted to use description keys. The description key settings in the Point Label Style dialog box include the following:

![Description Keys](image)

These settings must be selected if description key substitution is to be performed on points when they are labeled.

To insert the point’s full description into a point marker, you must select the option to use the current point label style when inserting points on the Insert tab of the Point Settings dialog box. The current point label style must be set up to use description keys. Then select the full description option on the Text tab of the Point Settings dialog box.
Description Key Symbols

The symbols that you can use for description keys are located in the symbol path that you set on the Insert tab in the Point Settings dialog box. For more information, see “Changing the Point Insertion Settings” in Chapter 6, “Getting Started with Points.”

Symbols that are inserted with the points by description keys are linked with the point object. They exist in the drawing as separate objects; however, any point command that modifies the point also affects the symbol, such as MOVE or ERASE.

Using the Description Key Manager

All of the description key management commands are located in the Description Key Manager dialog box. You can use the Description Key Manager to create, delete, and change the properties of description keys and description key files.

The Description Key Manager has the following new features for Release 2 of AutoCAD Land Development Desktop:

- Printing commands available through shortcut menu and Manager menu
- Drag-and-drop column ordering
- Columns retain widths after sizing

In addition, you can right-click on a column heading to hide and restore column visibility. You can also import a project.dsc file, a previous version of a description key file from Softdesk 7 or Softdesk 8.
Creating a Description Key

Use the Description Key Manager to create a description key.

To create a description key

1. From the Points menu, choose Point Management ➤ Description Key Manager to display the Description Key Manager dialog box.

2. In the left-hand column of the dialog box, click the name of the description key file that you want to add a description key to. There is always a DEFAULT description key file.

   **NOTE** By default, the description key file for a project is named default.mdb and is located in the c:\Land Projects R2\<project name>\cogo\DescKey folder.
3 Do one of the following to display the Create Description Key dialog box:
   ■ From the Manager menu, choose Create Description Key.
   ■ Click 
   ■ In the Manager, select the description key file that you want to add the description key to, right-click to display the shortcut menu, and then select Create Description Key.

4 In the DescKey Code box, type the description key code. This code is limited to 32 characters, including any wildcard characters. You can use the description key code as a description for any point that you import or create. Description keys are case sensitive. TOPO is not the same key as topo.

5 Click the General tab if it is not already active.

6 Type a Description Format. This code is limited to 255 characters. The Description Format is the text that replaces the points' raw description. For example, you can set up a description key called Oak, and assign a Description Format of Oak Tree to the key. If you create a point and use a description key named Oak as the description, then Oak Tree becomes the full description of that point.

   **NOTE** You can use the dollar and asterisk ($*) description parameter code or other description parameters as the Description Format. For more information, see “Using Description Parameters to Scale and Rotate Description Keys” in this chapter.

7 In the Point Layer box, type the layer name for the point. If the layer does not exist, then AutoCAD Land Development Desktop creates it. This is the layer on which a point that you create with the description key is placed. Layer names are limited to 255 characters.

8 Under Symbol Insertion, select the symbol that you want to use for the description key from the Symbol Block Name list. This is the symbol that is inserted at the point’s insertion point when you create a point with the description key.
The symbols shown in this list are located in the symbol block path set up on the Insert tab on the Point Settings dialog box. To use symbols stored elsewhere, change this path. You can also create a custom symbol to use in your drawing and then use the WBLOCK command to save the block to the symbol directory.

9 Under Symbol Insertion, type the layer name for the symbol in the Symbol Layer box. This is the layer on which the description key symbol is placed. Layer names are limited to 255 characters.

10 Click the Scale/Rotate Symbol tab and set up scale and rotation factors for the symbol. For more information, see "Scaling and Rotating a Description Key Symbol" in this chapter.

**Scaling and Rotating a Description Key Symbol**

*To set up scale and rotation factors*

1 Complete steps 1–9 in “Creating a Description Key” in this chapter.

2 Click the Scale/Rotate Symbol tab.

3 Under Scale Symbol By, select one or more of the following. For more information about these choices, see “Parameters for Scaling and Rotating a Description Key Symbol” in this chapter.

- Description Parameter
- Fixed Scale Factor
- Current Dwg Scale

**NOTE** You can apply more than one scale factor to the symbol. The resulting scale is the combination of all the scale factors.

4 Under Apply Scale To, select one or more of the following options:

- **X-Y Dimensions**: Select this check box to apply the scale to the X-Y dimensions. This option scales the symbol in 2D view.
- **Z Dimension**: Select this check box to apply the scale to the Z dimension. This option scales the symbol in 3D view.
NOTE

If the X,Y, and Z dimensions of a symbol are not the same, then you cannot explode the symbol.

5 Under Rotate Symbol By, select one or more of the following. For more information about these choices, see the section “Parameters for Scaling and Rotating a Description Key Symbol” in this chapter.

■ Description Parameter
■ Fixed Rotation

NOTE

You can apply more than one rotation factor to the symbol. The resulting rotation angle is the combination of all the rotation factors.

NOTE

The units of rotation are the same as those set in the drawing.

6 Under Direction, select Clockwise or Counter-Clockwise:

■ Select Clockwise to insert the description key symbol at a clockwise rotation angle in relation to north.
■ Select Counter-Clockwise to insert the description key symbol at a counter-clockwise rotation angle in relation to north.

7 Click Save to save the description key.

8 Click OK.

Parameters for Scaling and Rotating a Description Key Symbol

Description Parameter (Scaling)

You can use a description parameter to apply a scale to a symbol. For example, say you create points with a description of Oak 18 and Oak 24. These points represent oak trees with 18” and 24” diameters. You can use the 18 and 24 parameters to scale the symbol on insertion.

To set the parameters for scaling and rotating a description key symbol

1 Complete steps 1 and 2 in “Scaling and Rotating a Description Key Symbol” in this chapter.

2 Under Scale Symbol By, select the Description Parameter check box.

3 In the Description parameter $ box, type the description parameter substitution code that you want to use for the scale factor.

These numbers use the naming convention $n, where n is the number of the description parameter in the entry. Description parameters to scale by must be in the range 1–9.

For example:

■ In the description Oak 18, Oak is the $0 field and 18 is the $1 field.
■ In the description Oak Tree 18, Oak is the $0 field, Tree is the $1 field, and 18 is the $2 field.
If the description is Oak 18, then in the Description parameter $ box, type 1 to apply a scale of 18 units to the symbol.

4 If you must apply an additional scale to the symbol, then select the Fixed Scale Factor check box and type the scale factor in the box. For example, if you created the symbol so that it was 1 unit in a drawing that was set up to use feet as the units, then you need to scale it by .083 to scale the symbol down to inches.

**Fixed Scale Factor**

1 Complete step 1 and 2 in “Scaling and Rotating a Description Key Symbol” in this chapter.

2 Under Scale Symbol By, select the Fixed Scale Factor check box.

3 In the box, type the scale factor to apply to the symbol.

4 Under Apply Scale To, select whether you want the scale to be applied to X-Y Dimensions and/or the Z Dimension. By applying the scale to the X-Y dimensions, the symbol is scaled in 2D view. By applying the scale to the Z dimension, the symbol is scaled in 3D view.

**NOTE** If the X, Y, and Z dimensions of a symbol are not the same, then you cannot explode the symbol.

**Current Drawing Scale**

1 Complete step 1 and 2 in “Scaling and Rotating a Description Key Symbol” in this chapter.

2 Under Scale Symbol By select the Current Dwg Scale check box to apply the scale factor of the drawing to the symbol. For example, if your horizontal scale is 1:40, then the symbol is inserted using that scale.

3 Under Apply Scale To, select whether you want the scale to be applied to X-Y Dimensions and/or the Z Dimension. By applying the scale to the X-Y dimensions, the symbol is scaled in 2D view. By applying the scale to the Z dimension, the symbol is scaled in 3D view.

**NOTE** If the X, Y, and Z dimensions of a symbol are not the same, then you cannot explode the symbol.

**Description Parameter (Rotation)**

You can use a description parameter for applying a rotation to a symbol.

1 Complete step 1 through 4 in “Scaling and Rotating a Description Key Symbol” in this chapter.

2 Under Rotate Symbol By, select the Description Parameter check box.

3 In the Description Parameter $ box, type the description parameter substitution code that you want to use for the rotation factor.

These numbers use the naming convention $n, where n is the number of the description parameter in the entry. Description parameters to rotate by must be in the range 1–9.
For example:

- In the description Oak 18, Oak is the $0 field and 18 is the $1 field.
- In the description Oak Tree 18, Oak is the $0 field, Tree is the $1 field, and 18 is the $2 field.

4. If you must apply an additional rotation to the symbol, then select the Fixed Rotation check box and type the rotation factor in the box.

5. Specify whether the rotation angle is clockwise from north, or counter-clockwise from north, by selecting either the Clockwise or the Counter-Clockwise option.

**Fixed Rotation**

1. Complete steps 1–4 in “Scaling and Rotating a Description Key Symbol” in this chapter.

2. Under Rotate Symbol By, select the Fixed Rotation check box.

3. In the box, type the rotation angle. Type this rotation angle in DD.MMSS format.

4. Specify whether the rotation angle is clockwise from north, or counter-clockwise from north, by selecting either the Clockwise or the Counter-Clockwise option.

**Creating a Description Key File**

By default, the description key file for a project is named default.mdb and is located in the `c:\Land Projects R2\<project name>\cogo\DescKey` folder. You can create a new description key file.

---

**NOTE**

All description key files for a project must reside in the following folder: `c:\Land Projects R2\<project name>\cogo\DescKey`.

---

**To create a description key file**

1. From the Points menu, choose Point Management ➤ Description Key Manager to display the Description Key Manager dialog box.

2. Do one of the following to display the Create Description Key File dialog box:

   - From the Manager menu in the Description Key Manager dialog box, choose Create DescKey File.
   - Click .
   - In the left pane of the Manager, right-click to display the shortcut menu, and then select Create DescKey File.

3. In the DescKey File Name box, type the name of the new file.

4. Click OK to create the new file and return to the Description Key Manager dialog box.

The new file is listed in the left-hand pane of the manager.
Deleting a Description Key
You can remove a description key and its associated information from a
description key file.

To delete a description key
1 From the Points menu, choose Point Management ➤ Description Key Manager to
display the Description Key Manager dialog box.
2 In the right-hand pane of the dialog box, select the description key that you want
to delete by clicking any box that contains the description key data (except for
the Code box).
3 Do one of the following:
   ■ Click .
   ■ Right-click and select Delete.
   ■ From the Manager menu, choose Delete.

The following message is displayed:

4 Click Yes to delete the description key.

Deleting a Description Key File
A description key file stores description keys. If you no longer need the
description keys in the file, you can delete it.

To delete a description key file
1 From the Points menu, choose Point Management ➤ Description Key Manager to
display the Description Key Manager dialog box.
2 In the left-hand pane of the manager, select the description key file that you
want to delete.
3 Do one of the following:
   ■ Click .
   ■ Right-click and select Delete.
   ■ From the Manager menu, choose Delete.
The following message is displayed:

4 Click Yes to delete the description key file.

## Changing the Properties of a Description Key

You can edit an existing description key by changing the description key properties.

**To change the properties of a description key**

1. From the Points menu, choose Point Management ➤ Description Key Manager to display the Description Key Manager dialog box.
2. Do one of the following:
   - In the right-hand pane of the dialog box, move your cursor so that it is over the description key code that you want to edit. The properties icon is displayed. Click to display the Description Key Properties dialog box.
   - In the right-hand pane of the dialog box, click the line that contains the description key anywhere but over the code column, then select Manager ➤ Properties or click .

For more information about changing the description key properties, see “Creating a Description Key” in this chapter.

**NOTE** If you change the symbol to be used for a description key, and have already placed points in the drawing with the description key, then use the Modify Drawing command to replace the old symbols with the new symbols. For more information, see the section “Updating the Drawing with Project Point Information” in Chapter 10, “Managing Points.”

## Importing a Previous Version of a Description Key File

Using the Import .DSC command, you can import a Softdesk 7.X or Softdesk 8.X version of a description key file into a selected AutoCAD Land Development Desktop description key file. Previous versions of description key files have the extension .dsc.

**To import a previous version of a description key file**

1. From the Points menu, choose Point Management ➤ Description Key Manager to display the Description Key Manager dialog box.
2. From the left pane of the Description Key Manager, click on the description key file that you want to add the description keys to.
Do one of the following:

- From the Manager menu in the Description Key Manager dialog box, select Import .DSC.
- Click  

The Select .DSC File to Import dialog box is displayed:

4 Select the .dsc file you want to import and click Open.

The description keys from the .dsc file are added to the selected description key file.

**Using Description Parameters in Description Keys**

When surveyors are entering data in the field, they can use description parameters. Description parameters are entries, separated by a space, that expand the description of a point. For example, TREE OAK 7 is a description that has three parameters.

By formatting a description key to use description parameters, you can use one description key that maintains but reorders the point’s description information. When you create a point, a description (termed the point’s raw description) is saved with the point. When the point is created or inserted, and Description Key matching is turned on, this raw description string is inspected for a matching description key at the beginning of the string. If one is found, then any parameters that follow the description key can be inserted as the full description (and they can also be used to scale and rotate the description key symbol).
The following dialog box shows an example of how you can use description parameters to set up a description key that converts a point description such as TREE OAK 7 to 7 inch Oak tree.

- **DescKey Code**: TREE is used as the description key code because it is at the beginning of the description string (for example, TREE OAK 7). The description key code must match the first description parameter (TREE, in TREE OAK 7) to make the description key parameter substitution work.
- **Description Format**: $2 inch $1 Tree is used because in the string TREE OAK 7, TREE = the zero character, OAK = the first character, and 7 = the second character. You can type any additional text here as well, for example, inch and tree. This format produces the final description of 7 inch Oak tree.

**Using Description Parameters to Scale and Rotate Description Keys**

You can also use description parameters to scale and rotate description key symbols as they are inserted into the drawing. For example, if you create a point that represents a 7 inch oak tree, then you can use the 7 (the second character that follows the description key in the TREE OAK 7 string) to scale the symbol. The following dialog box shows how you can use the description parameter to scale the symbol:
**Description Parameter:** This value is $2, because in the string TREE OAK 7, the value 7 corresponds to the second character after the description key, TREE.

**Apply Scale To:** The scale factor can be applied to both the X-Y dimensions and the Z dimension. If you ever want to explode a symbol, the symbol must be the same size in all dimensions.

### Description parameter substitution codes

<table>
<thead>
<tr>
<th>Use this code…</th>
<th>To…</th>
<th>Such as…</th>
</tr>
</thead>
<tbody>
<tr>
<td>$0</td>
<td>match the description key itself</td>
<td>TREE Oak 7</td>
</tr>
<tr>
<td>$1</td>
<td>match the first parameter after the description key</td>
<td>TREE Oak 7</td>
</tr>
<tr>
<td>$2</td>
<td>match the second parameter after the description key</td>
<td>TREE Oak 7</td>
</tr>
<tr>
<td>$3</td>
<td>match the third parameter after the description key</td>
<td>TREE Oak 7 24</td>
</tr>
<tr>
<td>$4 - $9</td>
<td>match the fourth parameter after the description key (and so on up until $9)</td>
<td></td>
</tr>
<tr>
<td>$+</td>
<td>match all the parameters after the description key</td>
<td>TREE Oak 7</td>
</tr>
<tr>
<td>$*</td>
<td>match all the parameters including the description key</td>
<td>TREE Oak 7</td>
</tr>
<tr>
<td>$$</td>
<td>insert a single $ into the description</td>
<td>If you used $$200.00 as part of the Description Format for a description key, then the actual description placed with the point would be $200.00.</td>
</tr>
</tbody>
</table>

### Dollar Sign, Asterisk ($*) Description Format Substitution Code

The $* (dollar sign, asterisk) wildcard can be used in Description Formats.

### Dollar sign, asterisk ($*) description format substitution code

<table>
<thead>
<tr>
<th>Use this description key format…</th>
<th>To…</th>
<th>Such as…</th>
</tr>
</thead>
<tbody>
<tr>
<td>$*</td>
<td>use the point’s raw description instead of substituting a description.</td>
<td>If you used the descriptions, UP-1, UP-2, and UP-3, and you want to maintain these descriptions, then use the $* as the Description Key Format.</td>
</tr>
</tbody>
</table>
Using Wildcard Characters in Description Keys

You can use wildcard characters to expand the matching capabilities of description keys. For example, say you have a point description prefix that you use repeatedly to describe benchmarks, such as BM. You may want to create points with descriptions of BM-1, BM-2, and so on.

Instead of having to create different description keys for each point, you can create a description key that contains an asterisk wildcard (BM*) that searches for just the prefix of a point description, BM. That way, the same symbol is applied to all points that you create whose descriptions start with BM.

The following dialog box shows how you can set up this description key:

- **DescKey Code**: The description key code BM* matches point descriptions of BM-1, BM-2, BM-A, BM-Oak Tree. This means that if you create a point and give it the description of BM-5, this description key is used.

- **Description Format**: By using the dollar sign, asterisk ($*) description format substitution code as the Description Format, the description key does not substitute a description for the raw description entered in the field. For example, if you create a point and give it the description of BM-1, and the $* is used as the description format, then the point still has the description of BM-1 even after description key matching has occurred. To contrast, if you enter Benchmark in this box, then all the points that you create with descriptions that start with BM are changed so that Benchmark is their description. You can also use other description parameters in the Description Format box.

- **Point Layer**: Any point inserted with a description that begins with BM is placed on the BENCHMARK_POINTS layer.

- **Symbol Block Name**: Any point inserted with a description that begins with BM uses the symbol block named Benchmark as the point symbol. This symbol is placed at the insertion point of the point object.

- **Symbol Layer**: The symbol, benchmark, is placed on the layer BENCHMARK_SYMBOLS.
Description key and point list filter wildcard characters

<table>
<thead>
<tr>
<th>Character</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td># (pound)</td>
<td>Matches any single numeric digit</td>
</tr>
<tr>
<td>@ (at)</td>
<td>Matches any alphabetic character</td>
</tr>
<tr>
<td>. (period)</td>
<td>Matches any nonalphanumeric character</td>
</tr>
<tr>
<td>* (asterisk)</td>
<td>Matches any string and can be used anywhere in the search string</td>
</tr>
<tr>
<td>? (question mark)</td>
<td>Matches any single character, for example, ?BC matches ABC, 3BC, and so on</td>
</tr>
<tr>
<td>~ (tilde)</td>
<td>Matches anything but the pattern, for example, ~<em>AB</em> matches all strings that don't contain AB</td>
</tr>
<tr>
<td>[...]</td>
<td>Matches any one of the characters enclosed, for example, [AB]C matches AC and BC</td>
</tr>
<tr>
<td>[~...]</td>
<td>Matches any character not enclosed, for example, [~AB]C matches XC but not AC</td>
</tr>
<tr>
<td>- (hyphen)</td>
<td>Inside brackets, specifies a range for a single character, for example [A-G]C matches AC, BC, and so on to GC, but not HC</td>
</tr>
<tr>
<td>′ (reverse quote)</td>
<td>Reads the next character literally, for example, ′*AB matches *AB</td>
</tr>
</tbody>
</table>

Using the pound (#) character in description keys

<table>
<thead>
<tr>
<th>This description key code…</th>
<th>Does…</th>
</tr>
</thead>
<tbody>
<tr>
<td>T#</td>
<td>Work for T1, T2…T9. For example, if you type T1 as the description for a point, then this description key is used.</td>
</tr>
<tr>
<td>STA#</td>
<td>Work for STA1 or STA2. It does NOT work for a point with the description STA, since STA is not followed by a number.</td>
</tr>
</tbody>
</table>

Using the at (@) character in description keys

<table>
<thead>
<tr>
<th>This description key code…</th>
<th>Does…</th>
</tr>
</thead>
<tbody>
<tr>
<td>1@</td>
<td>Work for 1A, 1B, 1C. It does NOT work for a point with the description 1, since 1 is not followed by an alphabetic character. For example, if you type 1A as the description for a point, then this description key is used.</td>
</tr>
</tbody>
</table>
### Using the period (.) in description keys

<table>
<thead>
<tr>
<th>This description key code…</th>
<th>Does…</th>
</tr>
</thead>
<tbody>
<tr>
<td>T.</td>
<td>Work for T-, T+</td>
</tr>
<tr>
<td></td>
<td>For example, if you type T+ as the description for a point, then this description key is used.</td>
</tr>
</tbody>
</table>

### Using the asterisk (*) in description keys

<table>
<thead>
<tr>
<th>This description key code…</th>
<th>Does…</th>
</tr>
</thead>
<tbody>
<tr>
<td>T*</td>
<td>Work for T1, TOPO, T-2.</td>
</tr>
<tr>
<td></td>
<td>For example, if you type TREE as a description, then this description key is used.</td>
</tr>
</tbody>
</table>

**NOTE** Unlike previous releases of Softdesk Civil/Survey software, you cannot use the asterisk character in the Description Format field. Instead, use the $* (dollar sign, asterisk) combination.

### Using the question mark (?) in description keys

<table>
<thead>
<tr>
<th>This description key code…</th>
<th>Does…</th>
</tr>
</thead>
<tbody>
<tr>
<td>T?</td>
<td>Work for TA, TZ, T1, T9.</td>
</tr>
<tr>
<td></td>
<td>It does NOT work for T itself, since T is not followed by an alpha-numeric character.</td>
</tr>
<tr>
<td></td>
<td>For example, if you type TB as the description for a point, then this description key is used.</td>
</tr>
</tbody>
</table>

### Using the tilde (~) in description keys

<table>
<thead>
<tr>
<th>This description key code…</th>
<th>Does…</th>
</tr>
</thead>
<tbody>
<tr>
<td>~TOPO</td>
<td>Work for all point descriptions except those that contain TOPO as part of the description.</td>
</tr>
<tr>
<td></td>
<td>For example, if you type TREE as the description for a point, then this description key is used. If you type TOPO-1, however, this description key is not used.</td>
</tr>
</tbody>
</table>
Using the [ ] in description keys

<table>
<thead>
<tr>
<th>This description key code…</th>
<th>Does…</th>
</tr>
</thead>
<tbody>
<tr>
<td>STA[123]</td>
<td>Work for STA1, STA2, STA3. It does NOT work for STA4, STA5, STA6, STA7, STA8, or STA9. For example, if you type STA1 as the description for a point, then this description key is used.</td>
</tr>
</tbody>
</table>

Using the [-] in description keys

<table>
<thead>
<tr>
<th>This description key code…</th>
<th>Does…</th>
</tr>
</thead>
<tbody>
<tr>
<td>STA[-04-9]</td>
<td>Work for STA1, STA2, STA3. It does NOT work for STA4, STA5, STA6, STA7, STA8, or STA9. For example, if you type STA1 as the description for a point, then this description key is used.</td>
</tr>
</tbody>
</table>

Using the hyphen (-) in description keys

<table>
<thead>
<tr>
<th>This description key code…</th>
<th>Does…</th>
</tr>
</thead>
</table>

Using the reverse quote (’) in description keys

<table>
<thead>
<tr>
<th>This description key code…</th>
<th>Does…</th>
</tr>
</thead>
<tbody>
<tr>
<td>*AB</td>
<td>Work for a description like *AB, where the asterisk is used as part of the description (and is not intended to be used as a wildcard).</td>
</tr>
</tbody>
</table>

Example: Creating a Utility Pole Description Key

The following example describes how you can set up a description key and then use it to place a point in the drawing.

The scenario is that you are creating points that represent utility poles. You want to use a prefix of UP for all these points, for example, UPS5A, UP4B, and so on.
If you create a description key code that translates these descriptions, then you can do the following:

- Assign a symbol to the points
- Place all the points on a layer
- Place all the symbols on a different layer
- Assign a new point description automatically, or maintain the raw description you enter initially

By using wildcard characters, you do not need to create a description key for each different point description—you can just create a description key that references the UP prefix.

To create and use a utility pole description key

1. From the Points menu, choose Point Settings to display the Point Settings dialog box.
2. Click the Create tab.
3. Verify that the Insert To Drawing As Created check box is selected.
4. Verify that under Descriptions, the Manual option is selected.
5. Click the Insert tab.
6. Verify that the Search Path for Symbol Block drawing files path points to the location of the symbols you want to use. In this example, the path must point to the following:
   c:\Program Files\Land Desktop R2\data\Symbol Manager\cogo

   For more information, see “Changing the Point Insertion Settings” in Chapter 6, “Getting Started with Points.”
7. Verify that the option to use the current label style when inserting points option is selected on the Insert tab in the Point Settings dialog box.
8. Click the Update tab.
9. You can select the Reunite Symbol With Description During Check Points check box. By selecting this option, the description key symbol is moved back to the point if you move the point and then run the Check Points ➤ Modify Drawing command.
10. Click the DescKeys tab. The options on this tab control advanced description key matching and searching functions. You do not need to set up any of these options for this example. For more information, see “Changing the Description Key Settings” in Chapter 6, “Getting Started with Points.”
11. Click OK.
12. From the Points menu, choose Point Management ➤ Description Key Manager to display the Description Key Manager dialog box.
13. From the left-hand pane of the Description Key Manager, right-click on [DEFAULT] to display the shortcut menu.
14. Select Create Description Key to display the Create Description Key dialog box.
15. In the DescKey Code box, type UP*. The asterisk (*) matches any point description that starts with UP. For example, UPSA, UPSB.
16. In the Description Format box, type $*.
The dollar sign asterisk ($*) description format substitution code preserves the points' raw descriptions, such as UPSA and UP4B. However, you can assign a new, full description—just remember that this description is used for all points that start with UP.

17 In the Point Layer box, type PTS_UP as the layer. This places the COGO points on the PTS_UP layer.

18 From the Symbol Block Name list, select U_POLE.

19 Type SYMBOLS in the Symbol Layer box. This places the U_POLE symbols on the SYMBOLS layer.

The dialog box should appear as shown in the following illustration:

![Description Key Manager dialog box](image)

20 Click OK.

21 Close the Description Key Manager dialog box.

22 Format a label style named Desckey to use description keys. For more information, see the following example, “Formatting a Point Label Style to Use Description Key Substitution.”

23 Choose the Desckey point style as the current point label style.

24 From the Points menu, choose Create Points ➤ Manual.

25 Pick the location for a new point.

26 When you are prompted for the description, type UP1A.

The description UP1A and the utility pole symbol are placed with the point.

Example: Formatting a Point Label Style to Use Description Key Substitution

To fully implement description key substitution, you must set up and use a point label style that uses description keys.

To format a point label style for description key substitution

1 From the Labels menu, choose Edit Label Styles to display the Edit Label Styles dialog box.

2 Click the Point Label Styles tab.

3 In the Name box, type Desckey.
4 From the Data list, select Point Number and click the Text button. {Point Number} appears in the Text box.

5 In the Text box, place your cursor after {Point Number} and press ENTER.

6 Repeat steps 4 and 5 to insert the Description and Elevation data elements into the Text box.

7 Select the Turn Off Marker Text check box. This option turns off the display of point markers when you label the points.

8 Under Description Keys, select the DescKey Matching On check box.

9 From the DescKey File list, select the description key file in which your description keys are stored, for example, Default.

   NOTE If you followed the example to create a utility pole description key, then select the Default file from this list.

10 Select the Substitute DescKey Description check box.

11 Select the Insert DescKey Symbol check box.

12 Click Save to save the label style.

13 Click OK to close the dialog box.

## Saving a Description Key File to a Prototype

After you set up a description key file, you can save it to a prototype. When you save a description key file to a prototype, the next project you create that is based on that prototype contains the description key file and the description keys defined in that file.

When you save a description key file to a prototype, the file is saved to the c:\Land Desktop R2\data\prototypes\<prototype name>\cogo\DescKey folder.

### To save a description key file to a prototype

1 From the Points menu, choose Point Management ➤ Description Key Manager to display the Description Key Manager dialog box.

2 In the right pane of the Description Key Manager, right-click the description key file that you want to save to a prototype.

3 Select Save File to Prototype from the shortcut menu. The Select Prototype dialog box is displayed.

4 Select the prototype to which you want to save the description key file.

5 Click OK.

   If a description key file with the same name already exists in the prototype, a warning dialog box is displayed, asking whether you want to overwrite the existing file.

6 Click Yes to overwrite the existing file, or click No to cancel.
Loading a Description Key File from a Prototype

To access description keys that you saved to a prototype with the Save File to Prototype command, you can use the Load File from Prototype command.

NOTE The description keys you save to a prototype with the Save File to Prototype command are automatically available in a new project if the new project is based on that prototype. You only need to load description keys from a prototype to access a description key file that you saved to a prototype that is different than the prototype that the current project is based on.

To load description keys from a prototype
1 From the Points menu, choose Point Management ➤ Description Key Manager to display the Description Key Manager dialog box.
2 From the Manager menu, choose Load File from Prototype to display the Select Prototype dialog box.
3 Select the prototype from which you want to load the description key file.
4 Click OK to display the Find DescKey Files dialog box. By default this dialog box displays the description key .mdb files that are located in the following folder: c:\Land Desktop R2\data\prototypes\<prototype name>\cogo\DescKey
5 Select the description key file that you want to load.
6 Click Open to load the description key file into the Description Key Manager.
   If a description key file with the same name is already loaded in the Description Key Manager dialog box, then a warning dialog box is displayed, asking whether you want to overwrite the existing file.
7 Click Yes to overwrite the existing file, or click No to cancel.
External Data References (XDRefs)

External Data References, or XDRefs, allow you to substitute point data in a custom database for point data in the project point database. You can use XDRefs as point group overrides and you can label points with XDRef information.
Using External Point References (XDRefs)

AutoCAD Land Development Desktop creates and maintains a point database file that contains all the point information in the project. The COGO point database stores point number, name (optional), northing, easting, elevation, and description.

You can also create your own customized point databases and use them to do the following:

■ Substitute point data, like elevation or description, when points are accessed through a point group
■ Label points with data that is substituted from the custom database, or label points with data that supplements COGO point database information

These custom point databases are linked to AutoCAD Land Development Desktop by External Data References (XDRefs). An XDRef is a pointer to an entire column of data in a custom Microsoft® Access database. All of the database entries must have a point number. Then, when you use an XDRef to get a value for a point, the point number is looked up in the custom database, and the value from the specified column is used instead of the point’s original value that is stored in the COGO database.

NOTE
XDRefs do not overwrite or alter the COGO database.

External Data Reference Requirements

The custom databases that you can use for XDRefs must have the following features:

■ They must be Microsoft® Access database files.
■ There must be a Long Integer field named PNO, which contains the point numbers.
■ PNO must be an indexed field, and the index must be named PNOIDX.
■ Currently only Integer, Long Integer, Single, Double and Text type fields are supported.
■ Any number of Tables can be defined in this database, but any that are referenced by XDRefs must have the PNOIDX index and the PNO column defined.
■ Any number of additional Text or Number columns may also be defined in this database table. There are no restrictions on the names and order of the columns after PNO.
■ XDRefs can be placed anywhere on your system; they do not need to exist in a specific location in order for AutoCAD Land Development Desktop to read them.

For more information about setting up a Microsoft® Access database, see the next section, “Creating an External Point Database with Microsoft Access.”
New Features in the XDRef Manager for Release 2 of AutoCAD Land Development Desktop

The XDRef Manager has the following new features for Release 2 of AutoCAD Land Development Desktop:

- Printing commands available through shortcut menu and Manager menu
- Drag-and-drop column ordering
- Columns retain widths after sizing

In addition, you can right-click on a column heading to hide and restore column visibility.

Creating an External Point Database with Microsoft Access

You can use Microsoft Access to create custom point databases, and you can link these databases to AutoCAD Land Development Desktop by using external data references (XDRefs).

TIP

If you do not want to set up a database from scratch, you can copy the following sample user database file:

```
c:\Land Projects R2\<project name>\cogo\UserDB\SampleUserDb.mdb
```

Then edit that file. By default this sample is created in the following directory when a new project is created:

```
c:\Land Projects R2\<project name>\Cogo\UserDB
```

To set up an external point database

1. Start Microsoft Access.
   - The startup dialog box is displayed.
2. Select Blank Database and click OK to display the File New Database dialog box.
3. Use the Save In list to locate the following directory:
   - `c:\Land Projects R2\<project name>\cogo\UserDb`
4. In the File Name box, type a name for the database.
5. Click Create to display the Database dialog box.
6. On the Table tab, click New to display the New Table dialog box.
7. Select Design View.
8. Click OK to display the design view of the table.
9. In the first table cell in the Field Name column, type **PNO**.
   - **NOTE** The PNO field is required; you must name this field PNO.
10. In the first table cell in the Data Type column, select Number.
11 In the lower part of the dialog box, verify the following information:
   ■ Long Integer is the Field Size
   ■ Auto is the Decimal Places
12 In the Required field, select Yes.
13 In the Indexed field, select Yes (No Duplicates).
14 Add any additional field names below PNO as needed for your point information, such as DESC 1, DESC 2, ELEV 1, ELEV 2. There are no restrictions on the names and order of the columns after PNO.
15 From the View menu, choose Indexes to display the Indexes dialog box.
16 In the first table cell in the Index Name column, type PNOIDX.

   NOTE The PNOIDX is required. You must name this index PNOIDX.

17 In the first table cell in the Field Name column, type PNO.
18 In the first table cell in the Sort Order column, select either Ascending or Descending.
19 In the lower part of the dialog box, change the following settings:
   ■ The Primary field must be Yes.
   ■ The Unique field must be Yes.
   ■ The Ignore Nulls field must be No.
20 From the View menu, choose Datasheet.
   You are prompted to save the table.
21 Click Yes to display the Save As dialog box.
22 Type a name for the table and click OK.
   The Table dialog box is displayed.
23 Type the point information, such as point numbers, elevations, and descriptions, into the table.
24 From the File menu, choose Save to save the table.
25 Close Microsoft Access.

Now you can create XDRefs to the table columns.

You can use either the Map ➤ Database commands or Microsoft Access to manually edit the data in the database. You can also change the layout of a database at any time—as long as the referenced column is still in the database, the XDRef finds the data.
Creating an External Data Reference (XDRef)

To substitute or supplement data in a Microsoft Access database file for COGO point information, you must create an external data reference (XDRef) to the column of data in the Microsoft Access table.

**To create an external data reference**

1. From the Points menu, choose Point Management ➤ XDRef Manager to display the XDRef Manager dialog box.

![XDRef Manager dialog box](image)

2. Do one of the following to display the Create External Data Reference dialog box:

   - Click ![button icon]
   - Right-click on one of the external data references and then select Create XDRef.
   - From the Manager menu, choose Create XDRef.

![Create External Data Reference dialog box](image)

3. In the Name box, type a name for the XDRef.
XDRef names are limited to the following characters: alphanumeric (A–Z, a–z, 0–9), dash (-), underscore (_), and space ( ). There is no restriction on the first character, so XDRef names can begin with any of these characters. The total length of an XDRef name must not exceed 32 characters.

4 Click to locate the database file. By default, a sample database file is copied to the project directory of each project you create. This file is named SampleUserDB.mdb, and is located in the following:
   \Land Projects R2\<project name>\cogo\UserDb

5 Click Open to return to the Create External Data Reference dialog box.

6 From the Table Name list, select the table name that you want to use. These are the available tables that exist in the database file.

7 From the Column Name list, select the column name that you want to use. These are the names of the columns that exist in the table. For example, you can choose Elevation if the table has a column named Elevation.

8 Click OK to create the XDRef and to return to the XDRef Manager dialog box.

Changing the Properties of an External Data Reference (XDRef)

You can edit an existing XDRef by changing its properties, such as which table and column in the Microsoft Access database the XDRef points to.

To change the properties of an external data reference

1 From the Points menu, choose Point Management ➤ XDRef Manager to display the XDRef Manager dialog box.

2 Do one of the following to display the External Data Reference Properties dialog box:
   ■ Click the XDRef that you want to edit (anywhere but the Name column) and click your pointing device.
   ■ In the Name column of the XDRef Manager, move your cursor so that it is over the XDRef that you want to edit. The properties icon is displayed. Click your pointing device.
   ■ Right-click the XDRef that you want to edit, and then select Properties.

   ![External Data Reference Properties](image)

   The Name box displays the name of the XDRef (this box cannot be edited).
To change the properties of the XDRef, you can use any of the following options:

■ Click to locate a different database file.
■ From the Table Name list select a different table name. These are the available tables that exist in the database file.
■ From the Column Name list select a different column name. These are the names of the columns that exist in the table.

4 Click OK to return to the XDRef Manager dialog box.

Deleting an External Data Reference (XDRef)

You can delete an XDRef that you no longer require.

To delete an external data reference

1 From the Points menu, choose Point Management ➤ XDRef Manager to display the XDRef Manager dialog box.
2 Do one of the following:
   ■ Select the XDRef that you want to delete by clicking on any cell except the Name cell, and click .
   ■ Click the XDRef that you want to delete and then select Manager ➤ Delete.
   ■ Right-click on the XDRef that you want to remove, and select Delete.

The following message is displayed:

3 Click Yes to delete the XDRef.

Example: Creating a Point Label Style that Labels Points with XDRef Information

You can use external data references (XDRefs) to label points with point data that is not in the COGO point database. This data may be a substitute for point values that are already in the COGO point database, such as point elevation, or it may be new data, such as multiple elevations.

To create a point label style that labels points with information from a custom database

1 Start a new drawing in a new project.
Create an XDRef for each value you want to use in the point labels. For example, say you have a Microsoft® Access database called SURFACE.MDB that contains the following information:

<table>
<thead>
<tr>
<th>PNO</th>
<th>SURF_ELEV</th>
<th>SURF_DESC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>125.3</td>
<td>EG</td>
</tr>
<tr>
<td>2</td>
<td>126.5</td>
<td>EG</td>
</tr>
<tr>
<td>3</td>
<td>127.5</td>
<td>EP</td>
</tr>
<tr>
<td>4</td>
<td>125.2</td>
<td>EP</td>
</tr>
</tbody>
</table>

To create a point label style that labels points with the elevation and description data of the surface points, you must set up two XDRefs. One XDRef must point to the SURF_ELEV column in the database, and the other must point to the SURF_DESC column in the database. For this example, assume that the XDRef for the SURF_ELEV column is named Surface Elevation and the XDRef for the SURF_DESC column is called Surface Description.

For more information about creating a Microsoft® Access database, see “Creating an External Point Database with Microsoft Access” in this chapter.

From the Labels menu, choose Edit Label Styles to display the Edit Label Styles dialog box.

1. Click the Point Label Styles tab.
2. Type XDRef Style in the Name box.
3. From the Data list, select Point Number and then click the Text button. {Point Number} appears in the Text box.
4. In the Text box, place your cursor after {Point Number} and press ENTER.
5. From the XDRef list, select Surface Elevation (one of the two XDRefs that are defined) and click the Text button. {XDRef=Surface Elevation} appears in the Text box.
6. In the Text box, place your cursor after {XDRef=Surface Elevation} and press ENTER.
7. From the XDRef list, select Surface Description and click the Text button.

The text box should appear as shown in the following illustration:

![Text box illustration]

8. Click Save to save the XDRef Style.
9. Set the XDRef Style as the current point label style and turn on the option to use the current point label style on the Insert tab of the Point Settings dialog box.
On the Create tab of the Point Settings dialog box, select Insert To Drawing As Created, Sequential Numbering, and None for both Elevations and Descriptions.

Use the Manual command to create four points.

The points are labeled with the data from the Microsoft® Access database.

Example: Using an External Database File and Point Groups to Substitute Point Information

The following example describes how you can substitute point information from an external database file for point information in the point database. In this case, borehole information (elevation and description) is substituted for the points' original elevations and descriptions by creating XDRefs to an external database. Suppose the point database has these points in it:

<table>
<thead>
<tr>
<th>PNO</th>
<th>NORTHING</th>
<th>EASTING</th>
<th>ELEVATION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1254125.3</td>
<td>142543.5</td>
<td>130.2</td>
<td>PAD</td>
</tr>
<tr>
<td>2</td>
<td>1254126.5</td>
<td>142551.4</td>
<td>130.3</td>
<td>PAD</td>
</tr>
<tr>
<td>3</td>
<td>1255127.5</td>
<td>142520.8</td>
<td>130.1</td>
<td>PAD</td>
</tr>
<tr>
<td>4</td>
<td>1255125.2</td>
<td>142520.9</td>
<td>130.5</td>
<td>PAD</td>
</tr>
</tbody>
</table>

And suppose there is an external database called TBORING.MDB that contains the following information:

<table>
<thead>
<tr>
<th>PNO</th>
<th>SURF_ELEV</th>
<th>SURF_DESC</th>
<th>SUB1_ELEV</th>
<th>SUB1_DESC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>125.3</td>
<td>EG</td>
<td>120.5</td>
<td>SG</td>
</tr>
<tr>
<td>2</td>
<td>126.5</td>
<td>EG</td>
<td>121.0</td>
<td>SG</td>
</tr>
<tr>
<td>3</td>
<td>127.5</td>
<td>EP</td>
<td>119.8</td>
<td>LG</td>
</tr>
<tr>
<td>4</td>
<td>125.2</td>
<td>EP</td>
<td>119.1</td>
<td>SG</td>
</tr>
</tbody>
</table>

To substitute the elevation and description information in the TBORING.mdb file for the information in the point database, you must define the following two XDRefs:

<table>
<thead>
<tr>
<th>XDRef</th>
<th>DATABASE</th>
<th>COLUMN</th>
</tr>
</thead>
<tbody>
<tr>
<td>EL1</td>
<td>TBORING.MDB</td>
<td>SURF_ELEV</td>
</tr>
<tr>
<td>DS1</td>
<td>TBORING.MDB</td>
<td>SURF_DESC</td>
</tr>
</tbody>
</table>
These XDRefs point to the SURF_ELEV and SURF_DESC columns in the TBORING external database.

To access this new information, you must create a point group with overrides. For example, you use the EL1 external reference to access the point's elevation, and the DS1 external reference to access the point's description.

Instead of getting the original elevation and description stored in the point database, the XDRefs now point to the TBORING.MDB database. This is where the elevation stored under column SURF_ELEV is retrieved, and the description stored under column SURF_DESC is retrieved. So the points, when accessed through this group, appear like the following:

<table>
<thead>
<tr>
<th>PNO</th>
<th>NORTHING</th>
<th>EASTING</th>
<th>ELEVATION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1254125.3</td>
<td>142543.5</td>
<td>125.3</td>
<td>EG</td>
</tr>
<tr>
<td>2</td>
<td>1254126.5</td>
<td>142551.4</td>
<td>126.5</td>
<td>EG</td>
</tr>
<tr>
<td>3</td>
<td>1255127.5</td>
<td>142520.8</td>
<td>127.5</td>
<td>EP</td>
</tr>
<tr>
<td>4</td>
<td>1255125.2</td>
<td>142520.9</td>
<td>125.2</td>
<td>EP</td>
</tr>
</tbody>
</table>

To use these points, you must set up a point group with XDRef overrides and then access the points through a group as a group.

**NOTE** When these points are inserted with overrides applied, you do not need to set up point label styles to view the elevation and description obtained by the XDRef. The descriptions and elevations that are inserted from the XDRef are considered the points' elevations and descriptions. However, to add a new category for points, such as a second elevation, a point label is necessary to display this information in the drawing.
10

Managing Points

When working with points you have the option to limit write access to the project point database to yourself, or you can open it so everyone working on the project has read-write access. If you are concerned about points getting inadvertently changed or deleted, then you can lock the points.

If multiple people are working on a project over a network, then you may need to use the Check Points commands, which reconcile the differences between points in the project point database and the points in the drawing.
Selecting Points to Edit

Several topics in this manual contain a reference to the following prompt, and the options in this prompt. This prompt is displayed whenever you select a command that requires a selection set of points:

Points to Lock (All/Numbers/Group/Selection/Dialog) ? <All>:

The following are descriptions of the options:

- Type All to select all the points in the project.
- Type Numbers to specify point numbers or names.
- Type Group to specify a point group.
- Type Selection and then select the points from the drawing. This option only selects points that are visible in the drawing.
- Type Dialog to use filtering and advanced selection methods.

Specifying Point Numbers

When you type Numbers, you can type point numbers individually, separate each number with a comma (,), or type them in a range by using a hyphen (for example, type 1–5).

If point names are enabled for the project, then the following prompt is displayed:

Point Name or Numbers <>:

Type the point name you want to select, or type point numbers.

Specifying a Point Group

When you type Group, the following prompt is displayed:

Group (Name/Dialog) ? <Dialog>:

Type one of the following options:

- Type Name and then type the name of the group.
- Type Dialog to display the Select a Point Group dialog box. Select the group and then click OK.

NOTE You can click the Manage button to access the Point Group Manager dialog box to create a point group.

Using Filtering and Advanced Selection Methods

When you type Dialog, a dialog box is displayed. You can use this dialog box to create a list of points. For more information, see “Creating a Point List” in Chapter 7, “Point Groups and Lists.”
Changing the Point Database Setup Settings

By changing the point database setup settings, you can control whether the point database file is accessible by a single user or multiple users. You can also close the point database to give another person access to it.

If the Open Mode is set to multiple users and more than one person has the point database open, then you cannot switch the Open Mode from multi-user mode to single-user mode. If the database is open in single-user mode and another person tries to access the project, he or she can only open the project with the point database closed.

To change the point database setup settings

1. From the Points menu, choose Point Management ➤ Point Database Setup to display the Point Database Setup dialog box.

   ![Point Database Setup Dialog Box]

   The current project name, point file, and the character limits that were established for descriptions and point names are displayed.

   **NOTE** If point names are not enabled for the project, then Not Used is displayed next to Point Names.

2. Under Open Mode, select one of the following options:
   - **Close**: Select Close to close the point data file and disable all commands that require the point database. You can select Close if you:
     - Have the database set to Open As Single-User and want to give someone else access to the file.
     - Are working on a project with a very large point database and you don’t need to use the point information. Closing the point database in this situation can speed up performance.
     - Are working in a multi-user environment and need to run one of the commands that require the point database to be open in Single-User mode (Translate Points, Rotate Points, Pack Point Database). In this case, each person must close the point database so that one person can set it to Single-User mode and run the command.
■ **Open as Single-User**: Select Open as Single-User to prevent other people from accessing the point database while you are working on it. If you are the first person to open the point database and single-user is selected as the Open Mode, then no one else has read/write access to the point database until you close the point database file.

If another person has the point database open, then you cannot switch to the single-user setting until the other person closes the point database.

■ **Open as Multi-User**: Select Open as Multi-User to give multiple people access to the point database while you are working on it. Use this option if you work on a network and want several people to have read/write access to the data simultaneously.

3 To see which people currently have the point database open, click the Other Users button to display the Other Users dialog box.

Under Other Logins Using Point Database, the AutoCAD login names of each person who has the point database open are listed.

Unless points are locked, all users have read-write access to the point database. To restrict the point database to a single user, each person listed in the Other Users dialog box must close the point database.

**NOTE**

The Others Users button is unavailable when no other users have the current point database open or when Open as Single-User is selected.

4 Click OK.

**NOTE**

You cannot use three point commands in multi-user mode: Translate Points, Rotate Points, and Pack Point Database. These commands impact the point database and can be used only when the point database is open in Single-User mode.
Displaying Information About Points in the Project

You can display and print information about the points in the project. The information that is displayed includes point number, northing, easting, elevation, point name, raw description, and full description. An L next to a point number indicates that the point is locked.

To display information about points

1. From the Points menu, choose List Points to display the List Points dialog box.

2. Create a selection set of the points about which you want to display information. For more information, see “Creating a Point List” in Chapter 7, “Point Groups and Lists.”

   **NOTE** When you create a selection set, point information for each point you selected is displayed in the List Points dialog box. If you click the Advanced button in the Point List dialog box to used advanced point selection methods, then you can also view the points on the List tab, or you can click the Simple button and view the points in the list.

The dialog box shows each point’s name, elevation, description, coordinates, latitude, and longitude. You can drag and drop column headings to change the display of data in the dialog box.

   **NOTE** How the point coordinates are displayed is based on the Point Coordinate Display settings.
Printing Point Lists

From the Point List dialog box, you can print point information by using the options in the Printing menu. You can send the point list to a printer, or you can print the list to an ASCII text file.

Printing a Point List

You can print a point list from the Point List dialog box. You use this dialog box when you create a point list for the purpose of listing point information, or for creating or editing a point group.

To print a point list

1. Display the Point List dialog box by using one of the following methods:
   - From the Points menu, choose Point Management ➤ Point Group Manager.
   - From the Manager menu, choose Create Point Group to display the Create Point Group dialog box. Click the Build List button.
   - From the Points menu, choose List Points.
   - From the Points menu, choose Edit Points ➤ Edit Points.
2. From the Printing menu, choose Print to display the Print dialog box.
3. From the Name list, select the printer you want to use.
4. Under Copies, specify how many copies of the point list you want to print.
5. Click OK to print the point list.

Printing a Point List to a File

You can print a point list to a an ASCII text file from the Point List dialog box. You use this dialog box when you create a point list for the purpose of listing point information, or for creating or editing a point group.

To print a point list to a file

1. Display the Point List dialog box by using one of the following methods:
   - From the Points menu, choose Point Management ➤ Point Group Manager.
   - From the Manager menu, choose Create Point Group to display the Create Point Group dialog box. Click the Build List button.
   - From the Points menu, choose List Points.
   - From the Points menu, choose Edit Points ➤ Edit Points.
2. From the Printing menu, choose Print to File to display the Select Output file dialog box.
3. Specify the folder and file name for the point file.
4. Click Save to create the file. The file is saved with a .txt file extension in the folder you specified.
Setting Up the Printer for Printing a Point List

To set up the printer for printing a point list

1 Display the Point List dialog box by using one of the following methods:
   - From the Points menu, choose Point Management ➤ Point Group Manager.
   - From the Manager menu, choose Create Point Group to display the Create Point Group dialog box. Click the Build List button.
   - From the Points menu, choose List Points.
   - From the Points menu, choose Edit Points ➤ Edit Points.

2 From the Printing menu, choose Printer Setup to display the Print Setup dialog box.

3 From the Name list, select the default printer you want to use when printing point lists. You can click Properties to view and change printer properties.

4 Under Paper, select the paper size and source.

5 Under Orientation, select whether you want to orient the page in Portrait or Landscape layout mode.

6 Click OK to save the print setup changes.

Previewing a Point List Before Printing

To preview a point list before printing

1 Display the Point List dialog box by using one of the following methods:
   - From the Points menu, choose Point Management ➤ Point Group Manager.
   - From the Manager menu, choose Create Point Group to display the Create Point Group dialog box. Click the Build List button.
   - From the Points menu, choose List Points.
   - From the Points menu, choose Edit Points ➤ Edit Points.

2 From the Printing menu, choose Print Preview to display a preview of how the point list will print.

3 Click Print to print the point list, or click Close to return to the Point List dialog box.

Locking and Unlocking Points

When you work with a team on the same project over a network, you may want to lock some points to prevent them from being edited. By default, each person who accesses the project files has read/write access to the point database. To prevent unwanted changes from occurring, you can lock the points in a project so that people have read access to the points, but they cannot edit them.

Locking points does not prevent you from inserting them into a drawing, from creating point groups from them, or exporting them to an external file.
Displaying the Locked Point Numbers in a Project

To display which points are locked in the project
- From the Points menu, choose Lock/Unlock Points ➤ Locked #’s.
The locked point numbers in the project are displayed. If the drawing has no locked points, a message is displayed stating there are no locked points.

Locking Points in a Project

You can lock points in a project so that they cannot be edited.

To lock points
1. From the Points menu, choose Lock/Unlock Points ➤ Lock Points.
The following prompt is displayed:

   Points to Lock (All/Numbers/Group/Selection/Dialog) ? <All>:

2. Do one of the following to select the points to lock:
   - Type All to select all the points in the project.
   - Type Numbers to specify point numbers or names.
   - Type Group to specify a point group.
   - Type Selection and then select the points from the drawing. This option only selects points that are visible in the drawing.
   - Type Dialog to use filtering and advanced selection methods.

For more information about selection methods, see “Selecting Points to Edit” in this chapter.

Unlocking Points in a Project

To unlock points in a project
1. From the Points menu, choose Lock/Unlock Points ➤ Unlock Points.
The following prompt is displayed:

   Points to Unlock (All/Numbers/Group/Selection/Dialog) ? <All>:

2. Do one of the following to select the points to unlock:
   - Type All to select all the points in the project.
   - Type Numbers to specify point numbers or names.
   - Type Group to specify a point group.
   - Type Selection and then select the points from the drawing. This option only selects points that are visible in the drawing.
   - Type Dialog to use filtering and advanced selection methods.

For more information about selection methods, see “Selecting Points to Edit” in this chapter.
Checking for Points in Projects and Drawings

There are several situations where the project points may not match the drawing points. For example, the project database won’t match the drawing points if you:

- Use commands such as ERASE or COPY to modify the points.
- Edit points in the drawing and database, and then quit the drawing without saving it.
- Restore an old version of a drawing.
- Edit points in one drawing and then open another drawing that contains the same points.

Whenever you want to change the drawing so that it matches the project point database, or change project points to match the drawing, you can use the Check Points commands.

Updating the Project Point Database with Drawing Point Information

You can check the project point database against the drawing points, and update the project point database to match the drawing point information. You can change, add, or delete points in the project file based on the points in the drawing. Adding points to the project file is useful if you create a new project from an existing drawing that already has points in it. You can also search for Softdesk point blocks and replace them with COGO point objects.

To modify the point database with drawing point information

1. From the Points menu, choose Check Points ➤ Modify Project to display the Modify Project Database Points from Drawing dialog box.

   ![Modify Project Database Points from Drawing dialog box](image)

   **NOTE** If any points in your drawing are locked, a warning dialog box is displayed, alerting you that you can not alter any locked points. Click OK to continue.
2 Under Scan Drawing for, select one of the following options:

- Select COGO Point Objects to search for point objects that are in the drawing and update the point database.
- Select Softdesk Point Blocks to search for point blocks that were created in Softdesk Civil/Survey programs. This option searches for blocks named POINT and replaces the blocks with point objects.

3 Under Modify Project Database, select one or more of the following options:

- **Change Points in Project Database**: This option changes the northing/easting, elevation, or description of any point in the project point database that does not match the drawing points.
  
  This option affects only points that are in both the drawing and the project point database. If any of the point information differs, then the project point database is updated to reflect the points within the drawing. If a duplicate point number is found, then you are prompted to select the correct point number.

- **Add Unregistered Points to Project Database**: This option adds point information to the point database from the drawing. If any of the points in the current drawing are not present in the point database, then the information is added, creating new point information.

  **NOTE**
  
  If you create a new project from an existing drawing with points already placed in it, use the Add unregistered points to project database option to create the new point database information.

4 Select one of the Delete Points From Project Database options.

- **Off**: Points are not deleted from the project point database or the drawing.
- **Points Erased by AutoCAD ERASE Command**: Points that you erased from the drawing with the AutoCAD ERASE command during the current session are removed from the project.
- **All Points Not in the Current Drawing**: Points not in the current drawing are removed from the project. Because all drawings in the project are linked to the same point database, and not all points have to be in a drawing, the command prompts you for confirmation.

5 Select the Echo status to screen check box to echo the status of the point database modification to the screen.

6 Click OK to exit the dialog box and update the database.

The command then searches the drawing and updates the database according to the options you selected.

Duplicate point numbers may be found.
Duplicate Point Numbers

If a duplicate point number is found in the project, then the command displays prompts similar to the ones shown in the following example:

```
Duplicate point found: 10
Location Point Northing Easting Elevation Description
1) Project 10 71064.4340 82721.5547 2750 ip
2) Drawing 10 71473.6822 81891.1564 3250 og
```

Choose which is correct (1 or 2):

1 Type the correct number.

The following prompt is displayed:

```
Edit operation (Renumber/<Delete>):
```

2 Type Delete or Renumber:

- Type Delete to delete the duplicate.
- Type Renumber to renumber the duplicate with the next available point number.

The following prompt is displayed:

```
Perform above process for all subsequent duplicates (Yes/<No>):
```

3 Type Yes or No:

- Type Yes to automatically repeat the process for all other duplicates that are found.
- Type No to be prompted each time a duplicate point is found.

Updating the Drawing with Project Point Information

You can check the drawing points against the project point database and change points in the drawing to match the database information.

To update the drawing points with project point information

1 From the Points menu, choose Check Points ➤ Modify Drawing to display the Modify Drawing Points from Project Database dialog box.
2 Under Modify Drawing Points, select one or more of the following check boxes. These options can update the existing points in the drawing, but do not add new points or delete existing points.

- **Change Points in Drawing**: This option changes points in the current drawing so that they match the point database information. This option changes the northing/easting, elevation, or description of the points. Only points that exist both in the project and in the drawing are checked.

- **Change Description Key Symbols**: This option verifies that symbols associated with the points through description keys are correct. If you have changed the description key file, then this option updates any symbols as required.

- **Reunite Key Symbol with Point**: This option returns the description key symbol exactly to the insertion point of the point, if it is not already there. If this box is cleared and the point is moved when you update the drawing with the Modify Drawing command, then the symbol moves with the point, but maintains its relative location to the point.

3 Under Add/Remove Points, select one or both of the following options:

- Select the Add All Points To Drawing check box to add to the drawing the points in the project point database that are not present in the current drawing.

- Select the Remove Points From Drawing check box to remove any points in the current drawing that are not in the project point database. A warning dialog box is displayed when you select this option, prompting you to confirm the remove option.

4 Select the Echo Status To Screen check box to display the status of the point update at the command line.

5 Click OK.

Duplicate point numbers may be found. For more information, see “Duplicate Point Numbers” in this chapter.

### Inserting Points into a Drawing

You can insert points into a drawing from the project database, based on several different selection methods. You can insert all points in the project, or you can insert them by group, range, window, description, or elevation, or by creating a selection set from the Point List dialog box.

**To insert the points into a drawing**

1 From the Points menu, choose Insert Points to Drawing.

The following prompt is displayed:

Points to Insert (All/Numbers/Group/Window/Dialog) ? <All>:

2 To select the points, type one of the following options:

- **Type All** to select all the points in the project.
- **Type Numbers** to specify point numbers or names.
- **Type Group** to specify a point group.
Removing Points from the Drawing

You can remove points from the drawing without deleting the point database information.

To remove points from the drawing

1. From the Points menu, choose Remove from Drawing.
   The following prompt is displayed:
   
   Also remove description key symbols (Yes/No) <No>: 

   3 Click one of the following options:
   - Click Skip to leave the existing point in the drawing.
   - Click Replace to replace the existing point in the drawing with the selected point in the point database.
   - Click Skip All to leave all existing points in the drawing.
   - Click Replace All to replace the existing points in the drawing with the selected points in the point database.
   - Click Cancel to cancel the command.

   If you use the UNDO command after using the point insertion command and then reinsert the points, duplicate points will be created in the drawing, and you will not be prompted to skip or replace the points. A solution to this is to run the UNDO command twice, first to eliminate the duplicate point objects, then again to remove the first points (the points that the previous UNDO restored). This will remove the points from the drawing so you can reinsert them without creating duplicates.

   **Removing Points from the Drawing**

   You can remove points from the drawing without deleting the point database information.

   **To remove points from the drawing**

   1. From the Points menu, choose Remove from Drawing.
      The following prompt is displayed:
      
      Also remove description key symbols (Yes/No) <No>: 

   **NOTE**

   Removing Points from the Drawing
2 Type Yes or No:
- Type No to keep the description key symbols in the drawing.
- Type Yes to remove the description key symbols from the drawing. If you do not remove symbols when you remove points, then the symbols become detached from the point. Subsequent changes to the location of the point do not affect the symbol.

The following prompt is displayed:
Points to Remove {All/Numbers/Group/Selection/Dialog} ? <All>:

3 Do one of the following to select the points:
- Type All to select all the points in the project.
- Type Numbers to specify point numbers or names.
- Type Group to specify a point group.
- Type Selection and then select the points from the drawing. This option only selects points that are visible in the drawing.
- Type Dialog to use filtering and advanced selection methods.

For more information about selection methods, see “Selecting Points to Edit” in this chapter.
Creating Points

AutoCAD Land Development Desktop has several commands you can use to create COGO points in your project. You can create points at intersections, in relation to an alignment, and in relation to a surface. All point data that you create is stored in the project database which can be set up so that multiple people working over a network can create points simultaneously.
Creating Points

You can use many different methods to create points in a drawing. You can create points based on

- Station and offset, turned angles, objects, northing/easting, and AutoCAD objects
- Intersections of directions and distances, as well as at the intersections of alignments
- Horizontal alignment geometry and station offsets
- Surface elevations and grid points
- Slopes
- Interpolations

The sequence of point creation prompts depends on how you establish the point creation settings. For example, to enter an elevation for each point that you create, you must select the Manual option in the point creation settings.

To use description key substitution for points that you create and import, you must modify the point creation settings and set up description keys.

The Effect of Point Settings on Point Prompts

Depending on how you change the point creation settings, the command sequence of the Points commands differ. For example:

- If you choose Sequential numbering, then the points are numbered using the next available point number. However, if you clear the Sequential numbering check box, then you are prompted to enter a point number each time that you create a point. In addition, if point names are enabled for the project, you can enter point names at this prompt.
- If you select the Manual options under the Elevations and Descriptions sections of the Create tab in the Point Settings dialog box, then you are prompted to enter descriptions and elevations for the points that you create.
- If you select the Automatic options under the Elevations and Descriptions sections of the Create tab in the Point Settings dialog box, then you are not prompted to enter descriptions or elevations. They are automatically created using the defaults you specify in the Default Description and Default Elevation boxes.

In the documentation, the descriptions of the Points commands assume that the Sequential Numbering check box is selected, and the Manual options are selected.

Selecting Points and Locations

You can select points using several different methods. Some commands do not require you to select COGO points that are in the drawing. You can just use your pointer to select locations in the drawing, or type X,Y coordinates.
To select points

- Type X,Y coordinates at the command line, separated by a comma.
- Click a location in your drawing with your pointing device. You can use AutoCAD Object Snaps to select a point accurately.
- Use point filters to select COGO points by number, graphically, or by specifying northing/easting coordinates.

You can use the following point filters to select points at most Select Points prompt:

- Type .P to select a point by point number. The point does not have to be in the drawing to select a point with this filter (however, it must be in the point database).
- Type .N to select a point by northing/easting coordinates.
- Type .G to select points. Using this filter, you can select any part of the point object. The point must be in the drawing to select a point with this filter.

NOTE To turn off a point filter, type .P, .N, or .G at the command line again. For example, if you use the .P option to type point numbers, type .P again to exit the point number mode. Each time you activate one of the point selection filters, it remains in effect until you turn it off.

Selecting Lines, Curves, and Spirals by Selecting Points

Some commands prompt you to select the objects to work with. When you select one of these commands, a prompt, similar to the following example, is displayed:

Select entity (or POints):

At this prompt, you can select the object with your pointing device. However, you can also select the object by selecting points.

To select an object by selecting points

1 Type PO.
2 Select the start point of the object.
   The following prompt is displayed:
   Second point (end, center, spi):
3 Select the remainder of the points using one of the following methods:
   - If the object is a line: Select the endpoint of the line and press ENTER. You can use the AutoCAD ENDpoint Object Snap to make it easier to select the endpoint of the line.
   - If the object is a spiral: Select the spiral point of intersection (spi), and the endpoint.
   - If the object is an arc: Select the center point of the arc, and then select the endpoint of the arc.
When you select the center point, the command determines the arc’s radius point. Because you can draw two different arcs from the same start point, endpoint, and radius point, the following prompt may be displayed:

Is the included angle less than 180, No/<Yes>:

Your response determines which of the two possible arcs you want to select. If the arc you want to select has an included angle of less than 180 degrees, then press ENTER. Type No if the angle of the arc is greater than 180 degrees.

You may also be prompted for the arc’s direction:

Direction (Cw/<CCw>):

This is the direction of the arc from the start point to the endpoint. Type C if the direction is clockwise, or CC if the direction is counterclockwise.

**Creating Points at Selected Coordinates**

**To create points at selected locations**

1. Change the Point Settings. (For more information, see Chapter 6, “Getting Started with Points.”)
2. From the Points menu, choose Create Points ➤ Manual.
3. Select a location at which to place the point.
4. Type the description for the point, or type a period to skip the description.
5. Type the elevation for the point, or type a period to skip the elevation.

   The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.

6. Select another location at which to place a point, or press ENTER to end the command.

**Creating Points at Northing/Easting Coordinates**

You can create points by specifying northing and easting coordinates. The base point and north rotation settings determine the actual location where the point is created in the drawing.

**To place a point at northing/easting coordinates**

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. From the Points menu, choose Create Points ➤ Northing/Easting.
3. Type the northing.
4. Type the easting.
5. Type the description for the point, or type a period to skip the description.
6 Type the elevation for the point, or type a period to skip the elevation.
   The command inserts the point in the drawing if the Insert to drawing as created
   option is selected in the Point Settings. The point is placed on the current layer
   unless you are using description keys.

7 Type additional northing and easting coordinates to set another point, or press
   ENTER to end the command.

**Creating Points by Specifying Directions**

You can create a point by specifying a direction, or by selecting two points and
then entering a distance.

**To create a point by direction**

1 Change the Point Settings. For more information, see Chapter 6, “Getting Started
   with Points.”

2 From the Points menu, choose Create Points ➤ Direction.

3 Select the starting point.

   The following prompt is displayed:
   Azimuth (Bearing/Points):

4 Do one of the following to define the direction:
   - Type **Azimuth**, and then type the azimuth of the direction line in
     DD.MMSS format.
   - Type **B**, and then type a quadrant number and a bearing in DD.MMSS format.

![Diagram of point created by direction using a bearing](image)
■ Type PO, and select two points to define the direction. The direction is calculated from the first point that you select to the second point that you select.

![Diagram of point created by direction by using points]

5 Type the distance at which to place the point. This is the distance from the point you selected at step 3.
6 Type the description for the point, or type a period to skip the description.
7 Type the elevation for the point, or type a period to skip the elevation.
   The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.
8 Do one of the following:
   ■ Specify another direction to set another point using the same starting point.
   ■ Press ENTER and select a new starting point.
   ■ Press ENTER twice to end the command.

**Creating Points by Turned or Deflection Angle**

You create points by specifying a turned angle or a deflection angle and distance.

**To set a point by turned or deflection angle**
1 Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2 From the Points menu, choose Create Points ➤ Turned Angle.
   The following prompt is displayed:
   
   Select line (or Points):

3 Do one of the following to select the reference line from which the angle is turned or deflected:
   ■ Select the reference line near the end you want to draw the new line from.
   This end point acts as the reference point for the new point.
   ■ Type PO and then select the starting and ending points of the reference line.
   The starting point acts as the reference point for the new point.
4 Specify the type of angle measurement to use, Deflection or Turned.
5 Type the angle in DD.MMSS format.
   If you specify a positive value at the Angle prompt, then the command places the point clockwise from the reference line. A negative angle value places the point counterclockwise from the reference line.

6 Define the distance between the point that is drawn and the reference point.

7 Type the description for the point, or type a period to skip the description.

8 Type the elevation for the point, or type a period to skip the elevation.
   The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.

9 Do one of the following:
   - Type another angle to set another point. This angle is based on the original reference line you selected.
   - Press ENTER and select a new reference line.
   - Press ENTER twice to end the command.

The following illustration shows points created by deflected or turned angle:

![Points created by turned or deflected angle](image)

Creating Points by Azimuths and Geodesic Distances

To create a point by an azimuth and a geodesic distance

1 Set the current zone. For more information, see “Changing the Current Zone for a Drawing” in Chapter 4, “Setting Up Drawings.”

2 Set the Transformation Settings. For more information, see “Changing the Geodetic Zone Transformation Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”

3 Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”

4 From the Points menu, choose Create Points ➤ Geodetic Direction.

5 Select the start point, which is the point the angle measurement starts from.
   The northing, easting, latitude, and longitude of the point are displayed at the command line.
6 Type the geodetic azimuth, which is the geodetic azimuth from the existing point to the new point.
7 Type the geodesic distance, which is the distance as measured on the coordinate zone grid from the existing point to the new point.
8 Do one of the following:
   ■ Press ENTER to end the command.
   ■ Select a new starting point.

**Creating Points by Resection**

You can create a point at a position that is calculated from the measured angles between three known points. You can do this when you need to set up an instrument at an unreferenced point.

**To create a point by resection**
1 Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2 From the Points menu, choose Create Points ➤ Resection.
   The following prompt is displayed:
   ```
   First point is assumed backsight (reference).
   Enter first point:
   ```
3 Select the first point, which is assumed to be the backsight or reference point.
4 Select the second point. The second and third points are the points that are sighted on.
5 Select the third point.
6 Type the angle between the first point to the second point.
7 Type the angle between the first and third point.
   These two angles are used to calculate the location of the point to be placed.

8 Type the description for the point, or type a period to skip the description.
9 Type the elevation for the point, or type a period to skip the elevation.
   The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.
Creating Points by Station and Offset from an Object

You can create a point at a specified station and offset distance from an arc, line, or spiral.

To create a point at a station and offset from an object

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. From the Points menu, choose Create Points ➤ Station/Offset Object.
3. Select the object.
4. Type the starting station.
   The ending station is automatically calculated.
5. Type the station at which you want to place the point.
6. Define the offset distance.
7. Type the elevation for the point, or type a period to skip the elevation.
8. Type the description for the point, or type a period to skip the description.
   The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.
9. Do one of the following:
   ■ Type another offset to place another point at a different offset from the same station.
   ■ Press ENTER and specify a new station.
   ■ Press ENTER twice to end the command.

The following illustration shows a point created that is offset from a station:
Creating Points at Object Vertices

You can automatically create points at the end points of lines, at the end points and center point of arcs, and at the end points and spiral points of intersection.

To create points at object vertices
1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. From the Points menu, choose Create Points ➤ Automatic.
3. Select the objects you want to place points on.
4. Press ENTER to complete the selection set.

The command inserts the points in the drawing if the Insert to drawing as created option is selected in the Point Settings. The points are placed on the current layer unless you are using description keys.

The Automatic command does not create points where lines cross each other unless one of these points is an end point. To create a point where lines cross each other, use the Manual command.

Creating Points Along a Line, Curve, or Spiral

You can create points along a selected line, curve, or spiral, at a given distance from the nearest end point.

To create points along a line, arc, or spiral
1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. From the Points menu, choose Create Points ➤ Along Line/Curve/Spiral.
3. Select the line, curve, or spiral.

The end point nearest to the point you selected is marked with an ✗.
4. Do one of the following:
   ■ Type the distance from the end point that you want to set the point. If you type a positive distance, then the point is placed along the object selected. If you type a negative distance, then the point is placed at a projected point away from the object.
   ■ Select two points to define a distance.
Creating Points

5 Type the description for the point, or type a period to skip the description.
6 Type the elevation for the point, or type a period to skip the elevation.

The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.

7 Do one of the following:
   - Specify another distance, to create a point at a different distance from the end point.
   - Press ENTER and select a different object.
   - Press ENTER twice to end the command.

**NOTE** All distances are measured from the end point of the selected object, not from the last point placed on the object.

The following illustration shows a point created at a positive distance along a curve:

![Diagram showing a point created along a curve]

**Creating Points on Lines, Curves, or Spirals**

You can create a point at the endpoints of a selected line, curve, or spiral, as well as on points of intersections (PIs) for spirals and radius points for curves.

**To create points on the vertices of lines, curves, or spirals**

1 Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2 From the Points menu, choose Create Points ➤ On Line/Curve/Spiral.
   The following prompt is displayed:
   
   Select entity (or Points):

3 Select the object.
4 Type the elevation for the point, or type a period to skip the elevation.
5 Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.

6 To continue placing points at each location, type elevations and descriptions for the points. The command ends after it has processed each point on the object, or you can press ENTER to end the command.
If an arc is selected the command places points at the endpoints and radius points of the arc. For a spiral, the command places points at the endpoints and PI of the spiral.

Creating a Specific Number of Points Along an Object

You can set a specific number of points, equal distances apart, along a selected line, curve, or spiral, or at an offset distance from the object.

To create a specific number of points along an object

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. From the Points menu, choose Create Points ➤ Divide Object.
3. Select the object.
   The end point nearest to the point you selected is marked with an X. This is considered the start point of the object when calculating offset values.
4. Type the number of segments to divide the object by. A point is placed at each segment vertex.
5. Define the offset distance.
6. Type the elevation for the point, or type a period to skip the elevation.
7. Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.
8 Repeat steps 6–7 for each point on the object.

Creating Points Equal Distances Along an Object

You can create points at equal distances along a selected line, arc, or spiral, or at an offset distance from the object.

To create points along an object

1 Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2 From the Points menu, choose Create Point ➤ Measure Object.
3 Select the object.
4 Type the starting station of the object.
5 Press ENTER to accept the starting station, or type a new value.
6 Press ENTER to accept the default ending station, or type a new value.
7 Define the offset distance.
8 Type the station interval. Points are placed along the object at this interval.
9 Type the elevation for the point, or type a period to skip the elevation.
10 Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.

11 Repeat steps 9–10 for each point on the object.
The following illustration shows points set by the Measure Object command:

![Points set by Measure Object command](image)

Creating Points on Polylines and Contours by Using the Elevation of the Current Polyline

You can use the Polyline/Contour Vertices – Automatic command to create points on a polyline or a contour object that are the same elevation as the polyline or contour vertices. For example, you can use the 3D Polylines commands in the Terrain menu to draw 3D polylines with elevations, and then use this command to place points along the polylines you create.

To create points on polylines or contours by using the elevation of the current polyline

1. From the Points menu, choose Create Points ➤ Polyline/Contour Vertices - Automatic.
   The following prompt is displayed:
   
   Select polyline/contour:

2. Select a polyline or contour.
   Points are created at the vertices of the polyline or contour.

   NOTE Depending on the Point Settings, you may be prompted for point descriptions.

   The following prompt is displayed:
   
   Select polyline/contour:

3. Select another polyline or contour, or press ENTER to end the command.

Creating Points on Polylines or Contours by Using a Default Elevation

You can use the Polyline/Contour Vertices – Manual command to create points on a polyline or contour at a specified elevation.
To create points at polyline or contour vertices with given elevations

   The following prompt is displayed:
   Default elevation <0.000>:

2. Type the default elevation to use for all of the points.
   The following prompt is displayed:
   Select polyline/contour:

3. Select a polyline or contour from your drawing.
   Points are created at the vertices of the polyline or contour.

4. Select another polyline or contour, or press ENTER to end the command.

NOTE Depending on the Point Settings, you may be prompted for point descriptions.

Creating Points at Intersections

Using the point intersection commands, you can create points at a variety of “virtual” intersections. Instead of working with real lines, for example, you can define virtual lines by defining directions. You can then place a point at the intersection of these two directions. Virtual arcs are used to calculate radial distances, which can intersect with each other, with directions, and with objects.

Creating Points at the Intersections of Directions

You can create a point at the intersection of two directions that are defined by two points, a bearing, or an azimuth.

To create a point at the intersection of two directions

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”

2. From the Points menu, choose Create Points-Intersections ➤ Direction/Direction.

3. Select a point. This point, along with the direction you define in step 4, defines the first direction line.
   The following prompt is displayed:
   Azimuth (Bearing/Points):

4. Define the direction.

5. Define the offset distance.

6. Repeat to steps 3–5 to define the second direction line.

7. Type the elevation for the point, or type a period to skip the elevation.

8. Type the description for the point, or type a period to skip the description.
The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.

The following illustration shows a point created at the intersection of two directions, using an offset distance from each direction line:

```
Point created at the intersection of directions
```

**Creating Points at the Intersections of Radial Distances**

You can create a point at the intersection of two distances that are defined by radius lengths.

**TIP** When you are defining the radial points and distances, keep in mind that you are essentially designing two circles that intersect each other. The locations where the circles intersect are where the points are created. Think of the radial point as the equivalent of the center point of a circle, and think of the radial distance as the radius of a circle.

To create a point at the intersection of two radial distances

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. From the Points menu, choose Create Points-Intersections ➤ Distance/Distance.
3. Select the first radial point.
4. Define the radius by typing either a value or selecting a point.
5. Select the second radial point.
6. Define the second radius by typing a value or by selecting a point.

The command displays Xs that mark the intersection points. If only one intersection is located, then the command automatically places the point at that intersection.

7. If two intersections are located, then do one of the following:
   - Click near the X you want to create a point on.
   - Type A to place points at both intersections.
Creating Points at Intersections of Directions and Distances

You can create a point at the intersection of a direction (line) and distance (circle).

**TIP**
When you define the radial point and radial distance, keep in mind that you are essentially designing a circle that intersects with a direction line. The locations where the circle intersects the direction line are where the points are created. Think of the radial point as the equivalent of the center point of a circle, and think of the radial distance as the radius of a circle.

**To create a point at the intersection of a direction and a distance**
1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. From the Points menu, choose Create Points-Intersections ➤ Direction/Distance.
3. Select the radial point.
4. Define the radius by either typing a value or selecting a point.
5. Select the start point for the direction line. This point, with the angle you define in step 6, defines the direction line.
6. Define the direction.
7 Define the offset distance.
   The command displays Xs that mark the intersection points. If only one
   intersection is located, then the command automatically places the point at
   that intersection.

8 If two intersections are located, then do one of the following:
   ■ Click near the X you want to create a point on.
   ■ Type A to place points at both intersections.

9 Type the elevation for the point, or type a period to skip the elevation.

10 Type the description for the point, or type a period to skip the description.
   The command inserts the point in the drawing if the Insert to drawing as created
   option is selected in the Point Settings. The point is placed on the current layer
   unless you are using description keys.

11 Repeat steps 9–10 for the second point if you chose to place both points.
   The following illustration shows a point created at the intersection of a direction
   and distance:

![Point created at direction/distance intersection](image)

**Creating Points that Are Perpendicular to Points and Directions**

You can create a point that is perpendicular to a direction line and a
selected point.

**To create a point that is perpendicular to a point and a direction line**

1 Change the Point Settings. For more information, see Chapter 6, “Getting Started
with Points.”

2 From the Points menu, choose Create Points-Intersections ➤ Direction/Perpendicular.

3 Select a point. This point, with the direction you define in step 4, defines the
direction line.
   The following prompt is displayed:

   Azimuth (Bearing/Points):

4 Define the direction.
5 Select the perpendicular point. The command then calculates a perpendicular intersection between this point and the direction line.

6 Type the elevation for the point, or type a period to skip the elevation.

7 Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.

The command displays the ahead and offset distance of each selected point as the point is being placed. The ahead distance is the distance along the direction line from the beginning point selected in step 3. The offset distance is the offset distance from the direction line of the perpendicular point selected in step 5.

The following illustration shows a point created perpendicularly to a direction:

---

**Creating Points that Are Radial to Arcs and Points**

You can create a point that is radial to both a circle and a selected point.

---

**TIP** When you define the radial point and radial distance, keep in mind that you are essentially designing a circle. Think of the radial point as the equivalent of the center point of a circle, and the radial distance as the radius of a circle.

---

**To set a point at the radial intersection**

1 Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”

2 From the Points menu, choose Create Points-Intersections ➤ Distance/Perpendicular.

3 Select the radial point.

4 Define the radius by either typing a value or by selecting a point.

5 Select a point. The command then calculates how this point intersects radially with the circle you defined in steps 3–4.

6 Type the elevation for the point, or type a period to skip the elevation.

7 Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.
Creating Points at the Intersections of Objects and Directions

You can create a point at the intersection of a line, curve, or spiral object and a direction line.

**To set a point at the intersection of an object and direction line**

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. From the Points menu, choose Create Points-Intersections ➤ Direction/Object.
3. Select the object.
4. Define the offset distance.
5. Select a point. This point, with the angle you define at step 6, defines the direction line.
   The following prompt is displayed:
   
   **Azimuth (Bearing/Points):**

6. Define the direction.
7. Define an offset from the direction line.
8. Type the elevation for the point, or type a period to skip the elevation.
9. Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.
Creating Points at the Intersections of Objects and Radial Distances

You can set a point at the intersection of an object and a radial distance.

**TIP** When you define the radial point and radial distance, keep in mind that you are essentially designing a circle. Think of the radial point as the equivalent of the center point of a circle, of the radial distance as the radius of a circle.

**To create a point at the intersection of an object and a radial distance**

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. From the Points menu, choose Create Points-Intersections ➤ Distance/Object.
3. Select the object.
4. Define the offset distance.
5. Select the radial point.
6. Define the radius by either typing a value or by selecting a point.

   The command displays Xs that mark the intersection points. If only one intersection is located, then the command automatically places the point at that intersection.

7. If two intersections are located, then do one of the following:
   - Click near the X you want to create a point on.
   - Type A to place points at both intersections.

8. Type the elevation for the point, or type a period to skip the elevation.
9. Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.
Repeat steps 8–9 for the second point if you chose to place both points.

The following illustration shows points created that are offset from the intersections of an object and a radial distance:

![Illustration of points created at distance/object intersection](image)

Points created at distance/object intersection

**Creating Points at Intersections of Objects**

You can create a point at the intersection of two lines, arcs, or spirals in your drawing.

**NOTE** The two objects that you select do not have to physically intersect in the drawing. The program calculates the intersection by temporarily extending either or both of the objects until they meet, and then the program places the point at that intersection. The objects cannot be parallel.

To create a point at the intersection of two objects

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. From the Points menu, choose Create Points-Intersections ➤ Object/Object.
3. Select the first object.
4. Define the offset distance.
5. Select the second object.
6. Type an offset from the second object.
7. Type the elevation for the point, or type a period to skip the elevation.
8. Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.
Creating Points at Intersections

The following illustration shows a point created that is offset from the intersection of two objects:

Point created at object/object intersection

Creating Points on Objects that Are Perpendicular or Radial to Points

On an object, you can create a point that is perpendicular or radial to a selected point. If you create the point on a line, then the point is placed on the line perpendicular to the point that you select. If you create the point on an arc or spiral, then the point is placed on the object radial to the selected point.

To create a point perpendicular or radial on an object

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. From the Points menu, choose Create Points-Intersections ➤ Perpendicular.
3. Select the object.
4. Select the point. The command then calculates the perpendicular or radial intersection between the object and this point.
5. Type the elevation for the point, or type a period to skip the elevation.
6. Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.

7. Do one of the following:
   - Select another radial or perpendicular point.
   - Press ENTER to end the command.
Creating Points at Alignment Intersections

Using the alignment intersections commands, you can create points at the intersections of alignments with directions, distances, objects, and other alignments. An alignment must be present in the project in order to use the alignment intersection commands.

Creating Points at the Intersections of Direction Lines and Alignments

You can create points at the intersection of a direction line and the current alignment, or a point that is offset from this intersection.

**NOTE** The direction line is not an object; it is only for calculating direction. For more information on how to create a point at the intersection of an object and an alignment, see “Creating Points at the Intersections of Objects and Alignments” in this chapter.

To create a point at the intersection of a direction line and an alignment

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. Select the current alignment.
3. From the Points menu, choose Create Points-Intersections ➤ Direction and Alignment.
4. Define the offset distance between the alignment and the point to create. The offset value is the perpendicular or radial distance between the current alignment and the point that you want to create.
5. Select the starting point for the direction line.

The following prompt is displayed:

Quadrant (1-4) (Azimuth/Points):
To define the direction, type one of the following options:

- Type a quadrant number and then type the bearing of the direction line in DD.MMSS format.
- Type Azimuth and then type the azimuth of the direction line in DD.MMSS format.
- Type PO, and then select two points to define the angle of the direction line.
- Type .P, and then type two point numbers to define the angle of the direction line.

Define the offset distance between the direction line and the point to create. This is the perpendicular offset distance from the direction line to the point.

- Type a positive offset distance to place the point to the right of the object, direction line, or location. Right and left are determined by station progression or the direction in which the object was drawn.
- Type a negative offset distance to place the point to the left of the object, direction line, or location.
- Type 0 as the offset distance to place the point directly on the object, direction line, or location.
- Select two points in the drawing to define the offset distance.

The offset distance is based on the current drawing units.
The command then determines the intersection between the current alignment and the line defined by direction.

Type the elevation for the point, or type a period to skip the elevation.

Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.
The following illustration shows a point created that is offset from the intersection of a direction and an alignment:

![Point created at direction/alignment intersection](image-url)
Creating Points at the Intersections of Distances and Alignments

You can create points at the intersections of a distance line and the current alignment. The distance is defined radially; you define a radius for a swing arc, and then the intersections are located where the radius crosses the alignment.

**TIP**
When you are defining the radial point and radial distance, keep in mind that you are essentially designing a circle. Think of the radial point as the equivalent of the center point of a circle, and the radial distance as the radius of a circle.

You can set points either on the alignment where the distance line crosses it, or at an offset distance from the alignment. The arc does not have to physically intersect the alignment.

**NOTE**
The arc is not an object. It is only for calculating direction. For more information about how to create a point at the intersection of an object and an alignment, see “Creating Points at the Intersections of Objects and Alignments” in this chapter.

To create points at distance/alignment intersections

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. Select the current alignment.
3. From the Points menu, choose Create Points-Intersections ➤ Distance and Alignment.
4. Define the offset distance. The offset value is the perpendicular or radial distance between the current alignment and the point that you want to create.
5. Select the radial point.
6. Define the radius by either typing a value or by selecting a point.
   The command displays Xs that mark the intersection points. If only one intersection is located, then the command automatically places the point at that intersection.
7. If two intersections are located, then do one of the following:
   - Click near the X you want to create a point on.
   - Type A to place points at both intersections.
8. Type the elevation for the point, or type a period to skip the elevation.
9. Type the description for the point, or type a period to skip the description.
   The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.
The following illustration shows points created that are offset from the intersections of a radial distance and an alignment:

Points created at alignment/distance intersection

Creating Points at the Intersections of Objects and Alignments

You can create points at the intersections of any object and the current alignment, or you can set the point at offsets from this intersection. The object can be a line, arc, or spiral. The object does not have to physically intersect the alignment; this command automatically extends either object to determine an intersection point.

To create points at the intersection of an object and an alignment

1 Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2 Select the current alignment.
3 From the Points menu, choose Create Points-Intersections ➤ Object and Alignment.
4 Define the offset distance from the alignment. The offset value is the perpendicular or radial distance between the current alignment and the point that you want to create.
5 Do one of the following to select the object:
   ■ Click the object.
   ■ Type PO and then select points to select the object.
6 Define the offset distance from the selected object. This is the distance between the selected object and the point that you are creating.
   The command displays Xs that mark the intersection points. If only one intersection is located, then the command automatically places the point at that intersection.
7 If two intersections are located, then do one of the following:
   ■ Click near the X you want to create a point on.
   ■ Type A to place points at both intersections.
8 Type the elevation for the point, or type a period to skip the elevation.
9 Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.

The following illustration shows points created that are offset from the intersection of an alignment and an object:

![Diagram showing points created at object/alignment intersections]

**Creating Points at the Intersections of Alignments**

You can create points at the intersections of the two alignments, or at an offset distance from either or both of the alignments. The intersection of the alignments must be present in the drawing; this command does not extend the alignments in order to calculate an intersection point.

**To create points at the intersections of two alignments**

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. Select the current alignment. The current alignment can be either one of the two alignments that intersect.
3. From the Points menu, choose Create Points-Intersections ➤ Two Alignments.
4. Define the offset distance from the current alignment. The offset value is the perpendicular or radial distance between the current alignment and the point that you want to create.
5. Select the second alignment.
6. Define the offset distance from the second alignment.
   
   The command displays Xs that mark the intersection points. If only one intersection is located, then the command automatically places the point at that intersection.
7. If two intersections are located, then do one of the following:
   - Click near the X you want to create a point on.
   - Type A to place points at both intersections.
8. Type the elevation for the point, or type a period to skip the elevation.
9. Type the description for the point, or type a period to skip the description.
Creating Points Based on Horizontal Alignments

When you need to create points either on an alignment or offset from an alignment, then you can use the Create Points - Alignments commands. An alignment must be present in the project in order to use these commands.

Creating Points that are Offset from Alignment Stations

By creating points that are offset from stations on an alignment, you can create points along the alignment offsets, such as the ROW, shoulder, passing lanes, and so on.

To create points that are offset from a station on the current alignment

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. Select the current alignment.
3. From the Points menu, choose Create Points-Alignments ➤ Station and Offset.
   The command line displays the current point number.
4. Press ENTER to create points starting with the current point number, or type a new point number.
5. Type the station number that you want to offset a point from. Do not type the station plus (+) sign when typing this number.
6. Define the offset distance.
7. Type the elevation for the point, or type a period to skip the elevation.
8. Type the description for the point, or type a period to skip the description.
   After you are prompted for elevation and description information, you are prompted to type another offset value.
9 Do one of the following:
   ■ Type another offset value to offset another point from the current station.
   ■ Press ENTER and then select a new station to offset a point from.
   ■ Press ENTER twice to end the command.

The command inserts the point in the drawing if the Insert to drawing as created option is selected in the Point Settings. The point is placed on the current layer unless you are using description keys.

The following illustration shows a point created that is offset from an alignment station:

Point created by station and offset

Creating Points on an Alignment Based on a Segment Length

To set a specific number of point objects equal distances along the current alignment

1 Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2 Select the current alignment.
3 From the Points menu, choose Create Points-Alignments ➤ Divide Alignment.
4 Type the number of segments you want to divide the current alignment into.
5 The command calculates the distances between points by dividing the total length of the alignment by the number of segments specified.
6 Define the offset distance.
7 The command line displays the current point number.
8 Press ENTER to create points starting with the current point number, or type a new point number.
9 Type the elevation for the point, or type a period to skip the elevation.
10 Type the description for the point, or type a period to skip the description.
11 Continue to type the elevations and descriptions of the points until the command is completed.

The command inserts the points in the drawing if the Insert to drawing as created option is selected in the Point Settings. The points are placed on the current layer unless you are using description keys.
The following illustration shows points created that are both on the alignment and offset from the alignment. The distance between the points is determined by a specified number of segments:

Creating Points on an Alignment Based on Station Intervals

You can create points a specified distance apart either on the current alignment or at an offset distance from the alignment. The command divides the total length of the alignment by the specified distance (station interval) to determine the number of points to create.

**To create points along an alignment at intervals**

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. Select the current alignment.
3. From the Points menu, choose Create Points-Alignments ➤ Measure Alignment. The command line displays the starting station of the current alignment.
4. Press ENTER to start placing points from the starting station of the alignment, or type a different station at which to start creating points. The command line displays the ending station of the current alignment.
5. Press ENTER to end the points at the ending station of the current alignment, or type a different station at which to end the points.
6. Define the offset distance.
7. Type the station interval.
   For example, specifying a station interval of 5 places a point at every fifth station along the alignment.
   The command line displays the current point number.
8. Press ENTER to accept the current point number, or type a different number at which to start numbering the points.
9. Type the elevation for the point, or type a period to skip the elevation.
10. Type the description for the point, or type a period to skip the description.
Continue to type the elevations and descriptions of the points until the command is completed.

The command inserts the points in the drawing if the Insert to drawing as created option is selected in the Point Settings. The points are placed on the current layer unless you are using description keys.

**Creating Points on the Intersection Points of Alignments**

You can create points at every intersection point on an alignment, as well as at the curve and spiral points of intersections (PIs).

**To create points at the vertices of an alignment**

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. Select the current alignment.
3. From the Points menu, choose Create Points-Alignments ➤ At PC, PT, SC, etc.
   The command line displays the starting station of the current alignment.
4. Press ENTER to create points starting at the starting station of the alignment, or type a different station at which to start creating points.
   The command line displays the ending station of the current alignment.
5. Press ENTER to end the points at the ending station of the current alignment, or type a different station at which to end the points.
   The command line displays the current point number.
6. Press ENTER to accept the current point number, or type a different number at which to start numbering the points.
7. Type the elevation of each point.

**NOTE** The point objects are automatically labeled with labels that indicate the type of vertex.

The following illustration shows points created at alignment intersection points, such as the point where a curve meets a spiral, and at the curve and spiral PIs:

![Points created at alignment intersection points](image-url)
Alignment vertex labels and descriptions

<table>
<thead>
<tr>
<th>Label</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI</td>
<td>Point of intersection</td>
</tr>
<tr>
<td>CPI</td>
<td>Curve point of intersection</td>
</tr>
<tr>
<td>PT</td>
<td>Point of tangency</td>
</tr>
<tr>
<td>PC</td>
<td>Point of curvature</td>
</tr>
<tr>
<td>SPI</td>
<td>Spiral point of intersection</td>
</tr>
<tr>
<td>TS</td>
<td>Tangent-Spiral intersection</td>
</tr>
<tr>
<td>CS</td>
<td>Curve-Spiral intersection</td>
</tr>
<tr>
<td>ST</td>
<td>Spiral-Tangent intersection</td>
</tr>
<tr>
<td>CC</td>
<td>Curve center or radius point</td>
</tr>
</tbody>
</table>

Creating Points on Alignments that are Radial or Perpendicular to Selected Points

You can create points on an alignment that are radial or perpendicular to a selected point.

To create a point on an alignment radial or perpendicular to a selected point

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. Select the current alignment.
3. From the Points menu, choose Create Points-Alignments ➤ Radial or Perpendicular.
4. Select a point that is radial or perpendicular to the current alignment.
   The command creates the point on the alignment. The command also lists the ahead distance (the distance from the beginning of the alignment) and offset of the point that you selected. The command does not create the point if the point that you selected is not radial or perpendicular to the alignment.
The following illustration shows a point created on an alignment that is perpendicular to a selected point, and a point created that is radial to a selected point:

Points created radially or perpendicularly to selected points

Creating Points on an Alignment by Importing ASCII Files

You can create an ASCII text file with point information, and then import it into your drawing to place the points along the alignment at offsets from stations. This file can also contain the descriptions and/or the elevations of points. The elevation can either be a value or a rod reading and height of instrument. The command can calculate rod readings and can create the point at the appropriate elevation.

To create points along an alignment from an ASCII text file

1. Create and save an ASCII text file of point information that uses one of the following formats:
   - Station, Offset
   - Station, Offset, Elevation
   - Station, Offset, Rod, Hi
   - Station, Offset, Description
   - Station, Offset, Elevation, Description
   - Station, Offset, Rod, Hi, Description

   Use commas or spaces as delimiters. You can insert comments if you place a leading semi-colon (;) or pound sign (#) in front of the comment line.

   The following is an example of a text file that is formatted using the Station, Offset, Elevation format.

   #station, offset, elevation: subdivision 1
   0 20.0 112.00
   10 23.5 114.64
   20 22.5 116.56
   30 23.0 116.32
   40 22.0 115.83
Save the file to the \align subdirectory of the current project.

2. From the Points menu, choose Create Points-Alignments ➤ Import From File to display the File to Import dialog box.

3. Select the ASCII file that you created.

4. Click OK to exit the dialog box.

The following prompt is displayed:

1. Station, Offset
2. Station, Offset, Elevation
3. Station, Offset, Rod, hi
4. Station, Offset, Description
5. Station, Offset, Elevation, Description
6. Station, Offset, Rod, hi, Description

Enter file format (1/2/3/4/5/6): 

5. Specify the file format that you used when creating the text file by typing its number at the command line.

6. Specify the type of file delimiter that you used: spaces or commas.

7. If you selected a file format other than file format 4, then do one of the following:
   - If you selected file format 2 or 5, then type an Invalid elevation. You can use an invalid value to mark any point that should not be imported.
   - If you selected file format 3 or 6, then type an Invalid rod/hi and an Invalid station/offset. Use an invalid value to mark any point that should not be imported.

The command inserts the points in the drawing if the Insert to drawing as created option is selected in the Point Settings. The points are placed on the current layer unless you are using description keys.
Creating Points Based on a Surface

You can use the commands in the Create Points - Surface menu to create points based on elevations in the current surface.

Creating a Point that Obtains Its Elevation from the Current Surface

To create a point that obtains its elevation from the surface
1 Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2 Select the current surface.
3 From the Points menu, choose Create Points-Surface ➤ Random Points.
4 Select a location within the surface boundary for the point.

Creating a Grid of Points that Obtain Their Elevations from the Current Surface

You can generate a grid of points that are automatically assigned the elevations of the current surface.

To create a grid of points
1 Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2 From the Points menu, choose Create Points-Surface ➤ On Grid.
3 Type the rotation angle for the grid as a numeric value, or define it by selecting two points on the screen.
4 Select the Grid base point. This is the lower-left corner of the grid. Type the AutoCAD X,Y coordinates or select a point from the screen.
5 Specify the Grid X Spacing and Grid Y Spacing by typing numeric values or by selecting two points on the screen.
   These values describe the density of points for the grid. For example, if the specified X and Y values are X=50 and Y=50, then the grid is made entirely of 50 by 50 unit squares with a point at each corner.
6 Select the upper-right corner of the grid. The AutoCAD SNAP is set to the size of a grid square for the selection of the upper-right corner.
   One grid square, and the extents of the entire grid, is drawn on the screen.
7 Do one of the following:
   ■ To create the points based on this grid, press ENTER.
   ■ To change the size or rotation of the grid or grid squares, type Yes and change the grid base point, rotation angle, grid X spacing, grid Y spacing, and/or upper-right corner.
Creating Points Based on a Surface

The command calculates the coordinates of each corner of each grid square, and then extracts the elevation of each calculated point from the specified surface to create the grid of points.

The following illustration shows the parameters for using the On Grid command:

Creating Points Along a Polyline or Contour that Obtain Their Elevations from the Current Surface

You can place points along a polyline or contour object that are automatically assigned the elevations of the current surface.

To create points along a polyline or contour at a specified increment
1 Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2 From the Points menu, choose Create Points-Surface ➤ Along Polyline/Contour.
3 Specify the distance between the points by typing a numeric value or by selecting two points on the screen to define the distance.
4 Select the polyline or contour.

The points are placed along the polyline or contour at the specified interval.

NOTE Depending on the Point Settings, you may be prompted to define point descriptions.

5 Select another polyline or contour, or press ENTER to end the command.

The following illustration shows points created along a polyline at a specified distance:
Creating Points at Polyline or Contour Vertices by Using the Elevations of the Surface

You can place points based on the elevations of the current surface at the vertices of polylines or contours.

**To create points on polyline or contour vertices by using the elevations of the surface**

1. From the Points menu, choose Create Points – Surface ➤ Polyline/Contour Vertices. If no surface has been set current, the Select Surface dialog box is displayed.
2. Select a surface and click OK.
   
   The following prompt is displayed:
   
   `Select polyline/contour:`
3. Select a polyline or contour.
   
   The points are created and added to the polyline vertices.

**NOTE** Depending on the Point Settings, you may be prompted to define point descriptions.

4. Select another polyline or contour, or press ENTER to end the command.

If a vertex of the selected polyline or contour falls outside the current surface, then the command displays the following message:

`No surface elevation found at x: {#}, y: {#}`

The command does not place points at vertices that fall outside the surface.

Creating Points Based on Slopes

You can use the Create Points – Slope commands to create finished ground points where two grades or slopes intersect, at a specified slope and distance, and at a given slope or grade based on an ending elevation.

Creating Points Where Two Grades or Slopes Intersect

Using the High/Low Point command on the Create Points – Slope menu, you can place a point where two grades or slopes intersect in order to create finished ground data.

**To create points where two grades or slopes intersect**

1. From the Points menu, choose Create Points - Slope ➤ High/Low Point.
2. Select the two points to locate the high/low point in between.
   
   The first point you select is marked with an X and an arrow, pointing in the direction of the second point.
The following prompt is displayed:

First Slope (or Grade) <Infinite>:

3 At this prompt, do one of the following:

■ Type a slope value.
■ Select two points to define a slope.
   The distance between the two selected points are entered as the slope.
■ Type G and a grade, or select two points to define the grade.
   The distance between the two selected points are entered as the grade.

4 Define the slope or grade between the second point and the high/low point in
   the same manner as the first point.

The command calculates the location where the slope or grade would intersect,
and places a temporary X in the drawing where the new point would be located.
When the slope/grade intersection point is not between the points, it places an X
outside of the two points. This may not be apparent if the solution is outside of
your current view.

The following prompt is displayed:

Add point (Yes/No) <Yes>:

5 At this prompt, press ENTER to place the point in the drawing. Type No to not
   place the point.

6 Continue to select points, or press ENTER to exit the command.

The following illustration shows points created at the intersection of slopes
and grades:

High/low points created where slopes and grades intersect
Creating Points at a Given Slope or Grade for a Specified Distance

You can create points at a specified slope and a specified distance using the Create Points – Slope ➤ Slope/Grade – Distance command.

To create points at a given slope or grade for a specified distance

1 From the Points menu, choose Create Points - Slope ➤ Slope/Grade - Distance. The following prompt is displayed:
   
   Beginning point:

2 Select the first point. The following prompt is displayed:
   
   Direction:

3 Select a point to define the direction in which the points are placed. An × is drawn at each point as a temporary vector. The following prompt is displayed:
   
   Slope (or Grade) <Infinite>:

4 At this prompt, do one of the following to define the grade or slope:
   
   ■ Type a slope value.
   ■ Select two points to define a slope.
     The distance between the two selected points is entered as the slope.
   ■ Type G and a grade value, or select two points to define the grade.
     The distance between the two selected points is entered as the grade.

   The following prompt is displayed:
   
   Distance <#>:

   The number displayed in the brackets is the distance between the beginning point and the point you selected to define the direction.

5 Press ENTER to accept this distance, or type a new distance.

6 Specify the number of intermediate points to insert.

7 You can specify an offset distance. The following prompt is displayed:
   
   Add ending point (Yes/No) <Yes>:

   At this prompt press ENTER to add an ending point. Type No to place only the intermediate points you specified in step 6.

   The following prompt is displayed:
   
   Direction:
At this prompt, do one of the following:
- Select another direction in which to place points.
- Press ENTER and select another beginning point.
- Press ENTER twice to exit the command.

The following illustration shows points created at a given slope or grade based on distance:

Create Points at a Given Slope or Grade Based on an Ending Elevation

You can set points at a given slope/grade based on an ending elevation in order to create finished ground data. For example, you can specify a grade and an ending elevation, and then place points along the distance it takes to achieve the final elevation.

To create points at a given slope or grade based on an ending elevation

1. From the Points menu, choose Create Points - Slope ➤ Slope/Grade - Elevation. The following prompt is displayed:
   
   Beginning point:

2. Select the first point.
   
   The following prompt is displayed:
   
   Direction:

3. Select a point from your drawing to define the direction in which the points will be placed.
   
   An ✗ is drawn at each point as a temporary vector.

   The following prompt is displayed:
   
   Slope (or Grade) <Infinite>:

4. At this prompt, do one of the following to define the grade or slope:
   
   - Type a slope value.
   - Select two points to define a slope.
     
     The distance between the two selected points is entered as the slope.
   - Type G and a grade value, or select two points to define the grade.
     
     The distance between the two select points is entered as the grade.
5 Specify the elevation at the end point of the slope or grade.
   This is measured in current drawing units.
   The command determines the horizontal distance it would take to achieve the
   elevational difference at the specified slope or grade, and displays this
   information, along with the slope, grade, and elevational information.

6 Specify the number of intermediate points to insert.

7 You can specify an offset distance.
   A positive number offsets the points to the right, and a negative number offsets
   the points to the left by that distance.
   The following prompt is displayed:
   Add ending point (Yes/No) <Yes>:

8 At this prompt, do one of the following to determine whether to place an
   ending point:
   ■ Press ENTER to add an ending point.
   ■ Type No to place only the intermediate points you specified in step 6.

   The following prompt is displayed:
   Direction:

9 At this prompt, do one of the following:
   ■ Select another direction.
   ■ Press ENTER and select another beginning point.
   ■ Press ENTER twice to exit the command.

   The following illustration shows points created along the reference line at a
   horizontal distance between the beginning point and the point specified by the
   elevation override:

Points created by Slope/Grade – Elevation command
Interpolating Points

You can use the Points – Interpolate commands to create points for additional grading data. Whenever you use a point interpolation command, you need to define the interpolation region by selecting either two points to place the new points between, or an object on which to place the new points.

The following illustration shows the general interpolation parameters when selecting two points to define the interpolation region:

General interpolation parameters

Interpolating Points Along a Line

You can place a specified number of interpolated points between two selected points.

**NOTE** At least two points with elevations must exist in the drawing for this command to work properly.

**To interpolate points along a line**

1. Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2. From the Points menu, choose Create Points - Interpolate ➤ Interpolate.
3. Specify the elevational precision for the new points.
4. Select the two points that you want to interpolate points between.
   These points must be COGO point objects that have elevational values. If the point that you select does not have an elevation, then the command assigns an elevational value of zero (0).
5. Type the number of points to create.
6. Type the description for the point. If no description was previously entered, then the default value is INTERP.
The command inserts the points in the drawing if the Insert to drawing as created option is selected in the Point Settings. The points are placed on the current layer unless you are using description keys.

The following illustration shows interpolated points:

![Interpolated Points](image)

**Creating Points Along a Specified Distance by Interpolation**

You can interpolate points between two selected points, based on a distance.

**To set points by relative location**

1. From the Points menu, choose Create Points - Interpolate ➤ By Relative Location.

   The following prompt is displayed:

   **First point (or Entity)**

2. Specify the interpolation region using one of the following methods:
   - Select two points by picking a point on the screen, snapping to an entity, selecting a point object (.g), typing a point number (.p), or specifying northing/easting (.n). Next, specify the elevations of the points.
   - Select a 2D or 3D polyline. For more information, see “Defining a 2D or 3D Polyline as an Interpolation Region” in this chapter.
   - Select an arc. For more information, see “Defining an Arc as an Interpolation Region” in this chapter.
   - Select a line. For more information, see “Defining a Line as an Interpolation Region” in this chapter.

   **NOTE** The interpolation is calculated along the length of the entity selected. On 2D or 3D polylines, the first and second point can be at any vertex on the entity. The elevation of the second point can be as selected, or a function of a slope or elevation distance from the first point.
The following illustration shows the By Relative Location command parameters:

![By Relative Location command parameters](image)

**Defining a 2D or 3D Polyline as an Interpolation Region**

You can define the interpolation region by selecting a 2D or 3D polyline as the entity using any of the Create Points - Interpolate commands on the Points menu. The points are placed along or offset from the entity as specified.

**To define the interpolation region by selecting a 2D or 3D polyline as the entity**

1. From the Points menu, choose any Create Points - Interpolate command.
   
   The following prompt is displayed:
   
   `First point (or Entity):`

   2. Select the polyline by selecting points, or type `E` and select the polyline by clicking on it.
      
      The beginning and ending points of the polyline are initially set as the first and second control points.

      The following prompt is displayed:

      `eXit/Current/Prev/Next <Current>:`

   3. At this prompt, type one of the following options:

   - Type `P` to move to the previous vertex on the entity.
   - Type `N` to move to the next vertex on the entity.
   - Type `C` when you are ready to select the current vertex for the first or second point.

   4. Accept or type the elevation for the first point.
   
   5. Select the next vertex to use as the second point, using the methods in step 4.

   A temporary arrow is displayed, showing the direction from the first control point to the second. This arrow is useful when determining the general offset from the entity, because it points from the first control point to the second, and the program determines all offsets along that direction.

   The following prompt is displayed:

   `Elevation (eXit/Difference/Slope) <0.00>:`
At this prompt, define the second point using one of the following methods:

■ Type the elevation for the second point.
■ Type D and the difference in elevation between the first and second points.
■ Type S and a slope between the first and second points, or G and a grade.

The specified slope extends the length of the entity between the points. The command then prompts for a distance and defaults to the length between the two points along the entity.

Press ENTER to end the command.

**Defining an Arc as an Interpolation Region**

You can define an arc as an interpolation region using any of the Create Points - Interpolate commands.

To define an arc as an interpolation region

1. From the Points menu, choose any Create Points - Interpolate command.
   The following prompt is displayed:
   First Point (or Entity):

2. Select the arc by selecting points, or type E and select the arc by clicking on it.
   The control points are automatically set at the arc endpoints.

3. Type the elevation for the first point, and press ENTER.
   The following prompt is displayed:
   Elevation (exit/Difference/Slope) <0.00>:

4. At this prompt, define the second point using one of the following methods:
   ■ Type the elevation for the second point.
   ■ Type D and the difference in elevation between the first and second points.
   ■ Type S and a slope between the first and second points, or G and a grade.
   The specified slope extends along the length of the arc between the points. The command then prompts for a distance, and defaults to the length between the two points along the arc.

5. Press ENTER to end the command.

**Defining a Line as an Interpolation Region**

You can define a line as an interpolation region using any of the Create Points - Interpolate commands.

To define a line as an interpolation region

1. From the Points menu, choose any Create Points - Interpolate command.
   The following prompt is displayed:
   First Point (or Entity):

2. Select the line by selecting points, or type E and select the line by clicking on it.
The command locates the vertex to use that is closest to the selection point.
3 Type the elevation for the vertex and press ENTER.
   The following prompt is displayed:
   Elevation (eXit/Difference/Slope) <0.00>:
4 At this prompt, define the second point using one of the following methods:
   ■ Type the elevation for the second point.
   ■ Type D and the difference in elevation between the first and second points.
   ■ Type S and a slope between the first and second points, or type G and a grade.
      The specified slope extends along the length of the arc between the points.
      The command then prompts for a distance, and defaults to the length between the two points along the arc.
5 Press ENTER to end the command.

Creating a Point at an Elevation by Interpolating Between Two Points or Contours

You can create a point at an elevation by interpolating between two points or contours using the Create Points - Interpolate ➤ By Relative Elevation command.

To create a point at an elevation by interpolating between two points or contours
1 From the Points menu, choose Create Points - Interpolate ➤ By Relative Elevation.
   The following prompt is displayed:
   First point (or Entity):
2 Select the interpolation region using one of the following methods:
   ■ Select two points.
   ■ Select a 2D or 3D Polyline. For more information, see “Defining a 2D or 3D Polyline as an Interpolation Region” in this chapter.
   ■ Select an arc. For more information, see “Defining an Arc as an Interpolation Region” in this chapter.
   ■ Select a line. For more information, see “Defining a Line as an Interpolation Region” in this chapter.
Creating a Number of Points Along a Specified Distance by Interpolation

You can create a number of interpolated points using the Create Points - Interpolate ➤ Number By Distance command.

To place a number of interpolated points

1 From the Points menu, choose Create Points - Interpolate ➤ Number By Distance. The following prompt is displayed:

   
   First point (or Entity):

2 Select the interpolation region using one of the following methods:

   - Select two points.
   - Select a 2D or 3D Polyline. For more information, see “Defining a 2D or 3D Polyline as an Interpolation Region” in this chapter.
   - Select an arc. For more information, see “Defining an Arc as an Interpolation Region” in this chapter.
   - Select a line. For more information, see “Defining a Line as an Interpolation Region” in this chapter.

The following illustration shows the Number By Distance command parameters:
Interpolating Points that are Perpendicular to the Control Points

You can set points perpendicularly along a line based on the location of adjacent points.

To set points perpendicularly from selected points

1 From the Points menu, choose Create Points - Interpolate ➤ Perpendicular.
   The following prompt is displayed:
   First point (or Entity):

2 Select the interpolation region using one of the following methods:
   - Select two points.
   - Select a 2D or 3D Polyline. For more information, see “Defining a 2D or 3D Polyline as an Interpolation Region” in this chapter.
   - Select an arc. For more information, see “Defining an Arc as an Interpolation Region” in this chapter.
   - Select a line. For more information, see “Defining a Line as an Interpolation Region” in this chapter.

   The following illustration shows the Perpendicular command parameters:

   ![Perpendicular command parameters](image)

Interpolating Points Using Distance Increments

With the Create Points - Interpolate ➤ Incremental Distance command, you can interpolate points using distance increments.

To interpolate points using distance increments

1 From the Points menu, choose Create Points - Interpolate ➤ Incremental Distance.
   The following prompt is displayed:
   First point (or Entity):
2 Select the interpolation region using one of the following methods:

- Select two points.
- Select a 2D or 3D Polyline. For more information, see “Defining a 2D or 3D Polyline as an Interpolation Region” in this chapter.
- Select an arc. For more information, see “Defining an Arc as an Interpolation Region” in this chapter.
- Select a line. For more information, see “Defining a Line as an Interpolation Region” in this chapter.

The following illustration shows the Incremental Distance command parameters:

```
Incremental Distance command parameters
```

**Interpolating Points by Using Elevation Increments**

You can place a series of points at an even elevation increment along a straight line. Points or contours must exist in the drawing for this command to work properly.

**To place points using an incremental elevation**

1 From the Points menu, choose Create Points - Interpolate ➤ Incremental Elevation.

The following prompt is displayed:

```
First point (or Entity):
```

2 Select the interpolation region using one of the following methods:

- Select two points.
- Select a 2D or 3D Polyline. For more information, see “Defining a 2D or 3D Polyline as an Interpolation Region” in this chapter.
- Select an arc. For more information, see “Defining an Arc as an Interpolation Region” in this chapter.
- Select a line. For more information, see “Defining a Line as an Interpolation Region” in this chapter.
The following illustration shows the Incremental Elevation command parameters:

![Incremental Elevation command parameters](image)

**Interpolating Points at Intersections of Entities**

You can set points where one entity intersects another, or where it intersects another if its lines are extended.

**To set points at figure intersections**

1. From the Points menu, choose Create Points - Interpolate ➤ Intersection.

   The following prompt is displayed:

   ```plaintext
   First point (or Entity):
   ```

2. Select two points to place the new points between and define their elevational difference, or select an entity to place the new points on and define the elevational difference between vertices.

3. After selecting the second control point, define an offset from that position.

4. Select another entity for locating an intersection point.

   If one intersection point is found, then a point is created at that point. If more than one intersection point is found, then temporary Xs are placed at the intersection points.

   The following prompt is displayed:

   ```plaintext
   Select intersection - eXit/All/<point>:
   ```
At the command prompt, type one of the following options:

- Type **All** to set a point at all intersection points.
- Type **Point** to set specific intersections as points in the project or drawing; you can select individual locations when more than one intersection is found. Using the pointing device, select near the highlighted intersections to designate the area in which the points are to be placed.
- Type **X** (Exit) to display the Select POints/Entity prompt.

Press ENTER to exit the command.

The following illustration shows the Intersection command parameters:
If you have point data that is saved as an ASCII text file or in a Microsoft® Access database file, then you can import it into the project. Likewise, point data from the project point database can be exported to ASCII® text files, and point data can be transferred from a database or text file to a text file. All import, export, and transfer operations require import/export formats. Use the Format Manager to create and manage import/export formats.
Importing and Exporting Points

Use the import and export commands to import points into the COGO point database, to export points to ASCII text files, and to transfer point data between files.

Importing and Exporting Point Files into or out of the COGO point database
You can import points into the COGO point database from external sources, such as ASCII text files and Microsoft® Access database files. You can also export points from the COGO point database to ASCII text files.

Merging Point Databases
You can merge points from a COGO point database into the current COGO point database. The point database that you want to merge must be an .mdb file. Older versions of COGO point databases, project.pdf, cannot be merged into the current database.

Transferring Points Between Files
You can transfer points from ASCII or Microsoft® Access .mdb files to ASCII files. For example, you can transfer points from one point file to another, using different import/export formats for both the source and destination files.

NOTE Points that are transferred from a source to a destination are not deleted from the source file.

Importing Point Files into the Terrain Model Explorer
To include external point files in a surface model, you can import ASCII text files or Microsoft® Access .mdb files into the surface folder. When you import points into the surface folder, the points are not added to the COGO point database.

Import/Export Formats
To import, export, or transfer point files, import/export formats are required. The formats define what information is being imported, exported, or transferred. For example, to import a point file that lists point number, northing, easting, and elevation, you must define an import/export format that references the number, northing, easting, and elevation.
Changing the COGO Database Import Options

The COGO database import options control how the COGO point database handles points that are imported into it. For example, you can choose to overwrite existing points in the database when you import, or you can choose to merge the points. You can also specify how to number the points.

To change the COGO database import options

1. From the Points menu, choose Import/Export Points ➤ Import Options. The COGO Database Import Options dialog box is displayed:

2. Under What to do if the point numbers are supplied by the source, select one of the following options:
   - Select the Use option to use the point numbers from the source. For example, if the point file you want to import has point numbers defined in it, and you want to use these numbers, then select this option.
   - Select the Ignore option if you do not want to use the point numbers that are defined in the point profile. When you select this option, the points are numbered based on the option you select in the What to do when point numbers need to be assigned to the points section.
   - Select the Add an offset option and type a value in the box to add an amount to each point number in the point file. For example, if you type 200 in the box, then points 1, 2, and 3 in the point file are numbered 201, 202, and 203, when imported.

3. Under What to do when point numbers need to be assigned to the points, select one of the following options:
   - Select the Use next point number option to number the new point starting with the next available point number.
   - Select the Sequence from option and type a value in the box to number the new point starting at a fixed number, such as 100.
Under What to do when the point number already exists in the point database, select one of the following options:

- Select the Renumber option to assign new numbers to any points in the source file that have point numbers that already exist in the point database. The assignment of the new numbers is based on the What to do when point numbers need to be assigned to the points option.
- Select the Merge option to overwrite point data that exists in the COGO points database with data that exists in the source file; and to preserve data in the COGO database that is not supplied by the source file. For more information, see the section “Example: What to Do When the Point Number Already Exists in the Point Database” in this chapter.
- Select the Overwrite option to overwrite any existing points in the COGO point database that have the same numbers as the points in the file you are importing. For more information, see the section “Example: What to Do When the Point Number Already Exists in the Point Database” in this chapter.

Click OK.

**Example: What to Do When the Point Number Already Exists in the Point Database**

The following scenarios provide examples of what happens when you select the Merge or Overwrite options in the “What to do when the point number already exists in the point database” section of the COGO Database Import Options dialog box.

For example, if there is a point in the project point database with the following information:

```
Number: 23  
Northing: 500  
Easting: 500  
Elevation: 70.5  
Description: IP
```

And you import a file that contains just number, northing, easting as follows:

```
Number: 23  
Northing: 502.18  
Easting: 498.65
```

With the Overwrite option selected, the point in the project database would become:

```
Number: 23  
Northing: 502.18  
Easting: 498.65  
Elevation: (blank field)  
Description: (blank field)
```

All fields are overwritten, even elevation and description.
Creating a Point Import/Export Format

There are two different types of import/export formats that you can create:

- **User Point File**: For importing ASCII text files into the COGO point database, for exporting COGO point database information to an ASCII text file, and for transferring data from and to ASCII text files.

- **User Point Database**: For importing Microsoft® Access user database files into the COGO point database and for transferring data from a user point database to an ASCII text file.

**To create an import/export format for points**

1. From the Points menu, choose Import/Export Points ➤ Format Manager.

   The Format Manager dialog box is displayed:

   ![Format Manager dialog box](image)

2. Click Add to display the Format Manager - Select Format Type dialog box.

   ![Format Manager - Select Format Type dialog box](image)

With the Merge option selected, the point in the project database would become:

- Number: 23
- Northing: 502.18
- Easting: 498.65
- Elevation: 70.5
- Description: IP

The number, northing, and elevation are overwritten, but the elevation and description in the point database are preserved.
Select one of the following format types and click OK:

- **User Point File**: Select this option to create a format for an ASCII text file. For more information, see “Creating a User Point Database Import/Export Format” in this chapter.
- **User Point Database**: Select this option to create a format for a Microsoft Access point database file. For more information, see “Creating a User Point Database Import/Export Format” in this chapter.

### Creating a User Point File Import/Export Format

**To create a User Point File Import/Export format**

1. From the Points menu, choose Import/Export Points ➤ Format Manager.
2. Click Add.
3. Select User Point File and click OK to display the Point File Format dialog box.

4. Click Load to load the text file you want to import. This step is optional, but by loading the file, you can see the contents of the file.

   **NOTE** At any time you can click the Parse button to format your loaded file according to how the format is set up. When you click Parse, the loaded file is placed in the top frame and formatted. If you subsequently edit the format, the parsed text disappears and the Parse button becomes available to use.

5. In the Format Name box, type a name for the format.
From the Default Ext. list, select a file extension for the point file you are importing or exporting:

- .txt: Delimited ASCII text file.
- .csv: Comma Separated Value file; ASCII text file delimited by commas.
- .prn: Formatted text, space delimited.
- .xyz: Coordinates X, Y, and Z.
- .auf: Autodesk Uploadable File, comma delimited. Values in such a file are limited to Number, Easting, Northing, Elevation, Description (in that order).
- .nez: Northing, Easting, and Elevation data.

If the file extension you want to use is not in the list, then you can type one in the box.

In the Comment Tag box, type the symbol that you used when writing comments in the file. For example, if a point file contains a line like #Autodesk Point File, you would type # in the Comment Tag box. The Comment Tag indicates where the comment starts. A comment always ends at the end of the line.

Select one of the following options:

- Select Columnated if the entries in the point file are separated by tabs (or, for exporting or transferring, to determine how the resulting text file appears). For example:
  
  number  northing  easting  elevation

- Select Delimited if the entries in the point file are separated by a delimiter like a comma (or, for exporting or transferring, to determine how the resulting text file appears). For example:
  
  number,description,northing,easting,elevation

  If you select Delimited, then type the delimiter, such as a comma (,) in the box. Tabs and spaces are always used as delimiters so it is unnecessary to specify them. There is no restriction on which characters you can use as file delimiters.

Select the Read no more than check box to limit the import or export to a specific number of points, starting from the top of the file. If you select this check box, then type a limit in the box. This option does not include comment lines or errors in the text file; if you type 100 as the limit, then 100 points are imported.

Select the Sample every check box and type a value in the box to take a sample of point data at a specified interval. For example, if you type 100 in the box, then AutoCAD Land Development Desktop imports, exports, or transfers only every 100th point.
If you are working with point data from defined coordinate zones, then select the Coordinate Zone Transform check box and click to display the Select Coordinate Zone dialog box.

This option can transform points from one zone into another. For example, to import an ASCII text file that was created in an NAD27 zone, and the zone of the current drawing is an NAD83 zone, specify the NAD27 zone in the Point File Format dialog box. When you import the points, they are converted to NAD83.

12 Select a coordinate zone you want to convert the file to and then click OK.
13 Set up the columns of the point file format by clicking the column headings, such as [unused]. When you click on a heading, the Format Manager - Select Column Name dialog box is displayed.

From the drop-down list, select what the column contains (based on the setup of your text file). For more information, see "Column Headings" in this chapter.
15 If you loaded the text file by clicking the Load button, then when you have finished setting up the columns, click Parse.
Depending on the option you selected in step 8, Columnated or Delimited, the appearance of the lower part of the dialog box changes. If you selected Columnated and click Parse, then the top and bottom panes of the lower part of the dialog box appear as follows:

### Columnated points

<table>
<thead>
<tr>
<th>Number</th>
<th>North</th>
<th>Easting</th>
<th>Elevation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5000</td>
<td>5000</td>
<td>100</td>
</tr>
<tr>
<td>2</td>
<td>5001</td>
<td>5001</td>
<td>100</td>
</tr>
<tr>
<td>3</td>
<td>5002</td>
<td>5002</td>
<td>100</td>
</tr>
</tbody>
</table>

The editable column headers are in the bottom pane, and the results of parsing appear in the top pane.

If you select Delimited and click Parse, then the top and bottom panes of the lower part of the dialog box appear as follows:

### Delimited points

<table>
<thead>
<tr>
<th>Number</th>
<th>North</th>
<th>Easting</th>
<th>Elevation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5000</td>
<td>5000</td>
<td>100</td>
</tr>
<tr>
<td>2</td>
<td>5001</td>
<td>5001</td>
<td>100</td>
</tr>
<tr>
<td>3</td>
<td>5002</td>
<td>5002</td>
<td>100</td>
</tr>
</tbody>
</table>

The editable column headers are in the top pane, and the results of parsing appear in the top pane as well. The bottom pane is used only for displaying the contents of the file that you loaded.

You can resize the columns by positioning your cursor over a heading divider and dragging the divider back and forth. The resulting width defines a column in the file. You can rearrange the column headers by dragging one onto another.

16 Click OK to return to the Format Manager dialog box.

### Creating a User Point Database Import/Export Format

1 From the Points menu, choose Import/Export Points ➤ Format Manager.
2 Click Add.
3. Select User Point Database and click OK to display the User Point Database Format dialog box.

4. Click Load to load the Microsoft® Access file you want to import. This step is optional, but by loading the file, you can see the contents of the file and which tables are defined in the file.

5. In the Format Name box, type a name for the format.

6. From the Table Name list, select the table in the Microsoft® Access file that you want to use. If you do not see any table names listed, then click the Load button to load the .mdb file, or type the name of the table you want to use.

   **NOTE** Microsoft® Access databases can have multiple tables per .mdb file.

7. If you are working with point data from defined coordinate zones, then select the Coordinate Zone Transform check box and click to display the Select Coordinate Zone dialog box.

   This option can transform points from one zone into another. For example, to import data that was created in an NAD27 zone, and the zone of the current drawing is an NAD83 zone, specify the NAD27 zone in the User Point Database Format dialog box. When you import the points, they are converted to NAD83.

8. Select a coordinate zone you want to convert the file to and then click OK.

9. Set up the columns of the user point database format by clicking the column headings, such as . When you click on a heading, the Format Manager - Select Column Name dialog box is displayed.

10. From the drop-down list, select what the column contains (based on the setup of your Microsoft® Access file). For more information, see “Column Headings” in this chapter.

    You can resize the columns by positioning your cursor over a heading divider and dragging the divider back and forth. You can rearrange the column headers by dragging one onto another.

11. Click OK to return to the Format Manager dialog box.
Column Headings

The following are possible headings in the Format Manager – Select Column Name dialog box. Which headings appear depends on the setup of your Microsoft® Access file or ASCII text file.

Select the <unused> option to skip the column. For example, if your text file contains a column of information that you do not want to import, set the column heading to <unused>.

User Defined

Select the User Defined option to customize columns. If you select User Defined, then specify the following:

1. In the User Defined Column Name, type the name of the column.
2. Under Data Type, select one of the following options:
   - **Double**: (double-precision floating-point), 8 bytes, -1.79769313486232E308 to -4.94065645841247E-324 for negative values; 4.94065645841247E-324 to 1.79769313486232E308 for positive values. Use Double for northings, eastings, grid northings, grid eastings, and latitudes and longitudes, among others. Use Double for any numbers that contain decimal points, including elevations.
   - **Long**: (long integer) 4 bytes, -2,147,483,648 to 2,147,483,647. Use Long for point numbers.
   - **String**: (variable length) 10 bytes + string length, 0 to approximately 2 billion. Use String for descriptions and point names.
3 Type a value in the Invalid Indicator box. On import, for example, the program looks for the invalid indicator in the text file and marks that value as invalid.

4 In the Precision box, type the precision value to be used.

5 Click OK to return to the Point File Format dialog box.

**Z+**

Select the Z+ option to define a column for data that was taken at a height above the datum elevation. For example, if a point was measured at 10 ft. above the surface, then you can use the Z+ option.

The Z+ option performs calculations on the elevation. Any data that is in a Z+ column is added to the data in the Elevation column as the points are imported or transferred. For example, say a point at datum elevation is 100 ft., and say a point was measured at 10 ft. above the datum elevation at the same northing and easting coordinates. By setting up a format that includes a column for elevation and a column for Z+, the point is assigned an elevation of 110 ft. when it is imported or transferred.

If you select Z+, then specify the following:

1 Type a value in the Invalid Indicator box. On import, for example, the program looks for the invalid indicator in the text file and marks that value as invalid.

2 Click OK to return to the Point File Format dialog box.

**Z-**

Select the Z- option to define a column for data that was taken at a height below the datum elevation, such as borehole data. For example, if a point was measured at 10 ft. below the surface, then you can use the Z- option.

The Z- option performs calculations on the elevation. Any data that is in a Z- column is subtracted from the data in the Elevation column as the points are imported or transferred. For example, say a point at datum elevation is 100 ft., and say a point was measured at 10 ft. below the datum elevation at the same northing and easting coordinates. By setting up a format that includes a column for elevation and a column for Z-, the point is assigned an elevation of 90 ft. when it is imported or transferred.

If you select Z-, then specify the following:

1 Type a value in the Invalid Indicator box. On import, for example, the program looks for the invalid indicator in the text file and marks that value as invalid.

2 Click OK to return to the Point File Format dialog box.
Thicknes

Select the Thickness option if your data includes surface thickness values, such as the thickness of a layer of topsoil or clay.

The Thickness option performs calculations on the elevation. Any data that is in a Thickness column is subtracted from the data in the Elevation column when the points are imported or transferred. For example, say a point at datum elevation is 100 ft., and say the topsoil thickness is 5 ft. By setting up a format that includes a column for elevation and a column for Thickness, the point is assigned an elevation of 95 ft. when it is imported or transferred.

If you select Thickness, then specify the following:

1 Type a value in the Invalid Indicator box. On import, for example, the program looks for the invalid indicator in the text file and marks that value as invalid.

2 Click OK to return to the Point File Format dialog box.

XDRef

If you have a point file that you want to import into a project but the point file contains more information than what can be stored in the COGO point database, then set up columns in an import/export format to use XDRefs.

The COGO database can only store point number, name, elevation, description, northing, and easting. If you have a text file that contains additional information, such as engineer name and time and date, then you can send this data to a Microsoft® Access .mdb file for storage. The text file’s point number, name, description, elevation, northing, and easting coordinates are imported into the COGO database, and the engineer’s name and time and date are imported into an .mdb file.

This Microsoft Access .mdb file must already exist, and must contain column definitions that have XDRefs defined for them.

You can also use the XDRef column definition on exporting points. Say you imported your text file that contains PNEZ data and engineer's name and date into the project. On export of the same data, the PNEZ values are exported from the COGO point database to a text file, and the engineer’s name and time and date are exported from the Microsoft Access .mdb file to the same text file as the data from the COGO database.

To import point data into the COGO point database and into an .mdb file

1 Create a text file of point information.

2 Create a Microsoft Access .mdb file that is set up with the column headings. For example, if the text file of points contains PNEZ and engineer's name and time and date, then set up columns for point number, engineer’s name, and time and date. For more information about creating Microsoft Access .mdb files, see “Creating an External Point Database with Microsoft Access” in Chapter 9, “External Data References (XDRefs).”

3 Create XDRefs to the columns in the .mdb file that you want to import the data to. For example, engineer's name and time and date. For more information about creating XDRefs, see “Creating an External Data Reference (XDRef)” in Chapter 9, “External Data References (XDRefs).”
4 Create a point file format that has columns for PNEZ and two XDRef columns
(one for engineer’s name and one for time and date).
5 Import the text file.
The PNEZ values are imported into the COGO point database and the engineer’s
name and time and date are imported into the Microsoft Access .mdb file.

**To set up a column to use an XDRef**

If you select XDRef, then specify the following:

1 In the XDRef name list, select the XDRef that you want to store point
   information in on import or export of points.
2 Type a value in the Invalid Indicator box. On import, for example, the program
   looks for the invalid indicator in the text file and marks that value as invalid.
3 In the Precision box, type the precision value to be used.

**Easting**

Select the Easting option to define a column for easting coordinates.
If you select Easting, then do the following:

Type a value in the Invalid Indicator box. On import, for example, the program
looks for the invalid indicator in the text file and marks that value as invalid.

**Northing**

Select the Northing option to define a column for northing coordinates.
If you select Northing, then do the following:

Type a value in the Invalid Indicator box. On import, for example, the program
looks for the invalid indicator in the text file and marks that value as invalid.

**Elevation**

Select the Elevation option to define a column for elevations.
If you select Elevation, then do the following:

Type a value in the Invalid Indicator box. On import, for example, the program
looks for the invalid indicator in the text file and marks that value as invalid.

**Longitude**

Select the Longitude option to define a column for longitudes.
If you select Longitude, then do the following:

Type a value in the Invalid Indicator box. On import, for example, the program
looks for the invalid indicator in the text file and marks that value as invalid.
**Latitude**
Select the Latitude option to define a column for latitudes.
If you select Latitude, then do the following:
Type a value in the Invalid Indicator box. On import, for example, the program looks for the invalid indicator in the text file and marks that value as invalid.

**Number**
Select the Number option to define a column for point numbers.
If you select Number, then do the following:
Type a value in the Invalid Indicator box. On import, for example, the program looks for the invalid indicator in the text file and marks that value as invalid.

**Name**
Select the Name option to define a column for point names.
If you select Name, then do the following:
Type a value in the Invalid Indicator box. On import, for example, the program looks for the invalid indicator in the text file and marks that value as invalid.

**Description**
Select the Description option to define a column for point descriptions.
If you select Description, then do the following:
Type a value in the Invalid Indicator box. On import, for example, the program looks for the invalid indicator in the text file and marks that value as invalid.

**Grid Northing**
Select the Grid Northing option to define a column for grid northings.
If you select Grid Northing, then do the following:
Type a value in the Invalid Indicator box. On import, for example, the program looks for the invalid indicator in the text file and marks that value as invalid.

**Grid Easting**
Select the Grid Easting option to define a column for grid eastings.
If you select Grid Easting, then do the following:
Type a value in the Invalid Indicator box. On import, for example, the program looks for the invalid indicator in the text file and marks that value as invalid.
Degrees Longitude
Select the Degrees Longitude option to define a column for degrees longitude.
If you select Degrees Longitude, then do the following:
Type a value in the Invalid Indicator box. On import, for example, the program
looks for the invalid indicator in the text file and marks that value as invalid.

Minutes Longitude
Select the Minutes Longitude option to define a column for minutes longitude.
If you select Minutes Longitude, then do the following:
Type a value in the Invalid Indicator box. On import, for example, the program
looks for the invalid indicator in the text file and marks that value as invalid.

Seconds Longitude
Select the Seconds Longitude option to define a column for seconds longitude.
If you select Seconds Longitude, then do the following:
Type a value in the Invalid Indicator box. On import, for example, the program
looks for the invalid indicator in the text file and marks that value as invalid.

Degrees Latitude
Select the Degrees Latitude option to define a column for degrees latitude.
If you select Degrees Latitude, then do the following:
Type a value in the Invalid Indicator box. On import, for example, the program
looks for the invalid indicator in the text file and marks that value as invalid.

Minutes Latitude
Select the Minutes Latitude option to define a column for minutes latitude.
If you select Minutes Latitude, then do the following:
Type a value in the Invalid Indicator box. On import, for example, the program
looks for the invalid indicator in the text file and marks that value as invalid.

Seconds Latitude
Select the Seconds Latitude option to define a column for seconds latitude.
If you select Seconds Latitude, then do the following:
Type a value in the Invalid Indicator box. On import, for example, the program
looks for the invalid indicator in the text file and marks that value as invalid.
Hemisphere Longitude
Select the Hemisphere Longitude option to define a column for hemisphere longitude.
If you select Hemisphere Longitude, then do the following:
Type a value in the Invalid Indicator box. On import, for example, the program looks for the invalid indicator in the text file and marks that value as invalid.

Hemisphere Latitude
Select the Hemisphere Latitude option to define a column for hemisphere latitude.
If you select Hemisphere Latitude, then do the following:
Type a value in the Invalid Indicator box. On import, for example, the program looks for the invalid indicator in the text file and marks that value as invalid.

Copying an Existing Import/Export Format
If you want to make variations to an existing import/export format, but you want to preserve the original format, you can copy the format and modify it.

To copy an existing point import/export format
1 From the Points menu, choose Import/Export Points ➤ Format Manager.
2 From the list of defined formats, select the format that you want to copy.
3 Click Copy to display the format in either the Point File Format or the User Point Database Format dialog boxes, depending on the type of format it is.
4 Modify/rename the copy as needed.

Viewing an Existing Import/Export Format
If a format is not editable (for example, the formats included with Land Development Desktop), then you cannot modify the format. However, you can view the format to see how it is set up.

To view an existing point import/export format
1 From the Points menu, choose Import/Export Points ➤ Format Manager.
2 From the list of defined formats, select the format that you want to view.
3 Click View to display the format in either the Point File Format or the User Point Database Format dialog boxes, depending on the type of format it is.
Modifying an Existing Import/Export Format

You can modify an existing point import/export format if it is a format that you created yourself.

**NOTE**
Default import/export formats cannot be modified.

To modify an existing point import/export format
1. From the Points menu, choose Import/Export Points ➤ Format Manager.
2. From the list of defined formats, select the format that you want to modify.
3. Click Modify. For more information, see “Creating a Point Import/Export Format” in this chapter.

Removing a Point Import/Export Format

You can remove point import/export formats that you created and no longer need.

**NOTE**
Default import/export formats cannot be removed.

To remove an existing point import/export format
1. From the Points menu, choose Import/Export Point ➤ Format Manager.
2. From the list of defined formats, select the format that you want to remove.
3. Click Remove.

The following message is displayed:

4. Click Yes to remove the format.
Importing Point Data

You can import ASCII text files and custom Microsoft® Access .mdb files into the COGO point database of the current project or into a surface folder in the Terrain Model Explorer to use in surface generation.

For example, a surveyor can enter point data into a data collector, and then create an ASCII file of that information when downloading the collector. To import these points into your drawing and project, you must create an import format for the points.

If the point data you want to import was created in a coordinate zone that is different from the zone of the current drawing, then you can select an option that performs a coordinate transformation of the point data as it is imported.

You can also specify a point group so all points are added to the group as they are imported.

Importing Points into the COGO Point Database

You can import points into the COGO point database from ASCII text files or Microsoft® Access .mdb files.

NOTE
On the Coords tab in the Point Settings dialog box there is an option to echo the points to the command line as they are created. This option does not apply when importing points from a file using the Import Points command.

To import points into the COGO point database

1 Change the COGO database import options. For more information, see “Changing the COGO Database Import Options” in this chapter.
2 Create an import/export format for the file you want to import. For example, to import points from a Microsoft® Access database file, set up a User Point Database format.
3 From the Points menu, choose Import/Export Points ➤ Import Points to display the Format Manager - Import Points dialog box.

![Format Manager - Import Points]

4 From the Format list, select the format of the file you want to import.

TIP
Click to access the Format Manager, where you can create new formats.
5 Click next to the Source File list to display the Select Source File dialog box.

6 Select the source file to import.

7 Click Open to return to the Format Manager - Import Points dialog box.

8 Select the Add Points to Point Group check box to add the points that you import to a point group. If you select this check box, then do one of the following:

   - From the list, select an existing group to which you want to add the points.
   - Click to create a new group for the points. The Format Manager - Create Group dialog box is displayed. Type the name for the group and click OK.

9 Click the Advanced button to display advanced options.
10 Select the Do Elevation Adjustment If Possible check box if Z+, Z-, or Thickness columns are set up in the import/export format, and you want elevational adjustments to occur. When this check box is selected, and Z+, Z-, or Thickness columns are defined in the format, then elevational calculations are performed on the file. For more information, see “Column Headings” in this chapter.

11 Select the Do Coordinate Transformation If Possible check box if you want coordinate transformations to occur. In order for coordinate transformations to occur, the import/export format must have a coordinate zone assigned to it. For example, if you are importing a point file into the COGO point database, then the coordinates of the point file are transformed to match the zone of the current drawing.

12 Select the Do Coordinate Data Expansion If Possible check box if you are importing a file that contains pieces of information, such as degrees, minutes, seconds, and hemisphere for latitude and longitude values, and you want to calculate missing pieces of data based on these known pieces, such as grid northing and easting.

13 Click OK to import the points.

NOTE You can use the Import Points command to import XDRef data from a Microsoft Access database. However, not all Microsoft Access field data types can be imported. All types of Number and Text fields can be imported, but Yes/No, Date/Time, and Currency fields cannot be imported. When exporting, there is no restriction. All five data types can be exported, or used as point group overrides, or used in point label styles.

Exporting Point Data

When you export point data from the COGO point database, the points are exported to an ASCII text file. To export these points, you must create an export format for the points.

For example, the COGO point database stores point number, name, description, northing, easting, and elevation. To export only point number and elevation, you must create an export format that has columns for point number and elevation.

In addition to exporting COGO point database information, you can also export grid northing, grid easting, latitude, and longitude if a coordinate zone and transformation settings are defined for the drawing.

You can also perform a coordinate transformation for the points as you export them. To export the point data so that it uses a different coordinate zone than the current drawing, you can select an option that performs a coordinate transformation of the point data as it is exported.

You can also export data to a pre-existing Microsoft® Access database file. For more information, see “XDRef” in this chapter.
Exporting Points from the COGO Point Database

You can export points from the COGO point database to ASCII text files.

To export points from the COGO point database to ASCII text files

1. Create an import/export format for the file you want to export to. For example, to export only point number, northing, and easting values, set up a User Point File format with point number, northing, and easting columns.

2. From the Points menu, choose Import/Export Points ➤ Export Points to display the Format Manager - Export Points dialog box.

3. From the Format list, select the format of the file you want to export the points to.

   **TIP** Click to access the Format Manager, where you can create new formats.

4. Click next to the Destination File list to display the Select Destination File dialog box.

5. Locate the drive/folder in which you want to save the exported text file.

6. In the File Name box, type a name for the text file you want to export the points to.

7. Click Save to return to the Format Manager - Export Points dialog box.
8 Select or clear the Limit to Points in Point Group check box:

- Select the Limit to Points in Point Group check box to export only the points that are in a point group instead of the entire COGO point database.
- Clear the Limit to Points in Point Group check box to export all the points in the COGO point database.

9 If you selected the Limit to Points in Point Group box, then select the point group from which you want to export points from the drop-down list.

10 Click the Advanced button to display additional options.

11 Select the Do Elevation Adjustment If Possible check box if Z+, Z-, or Thickness columns are set up in the import/export format, and you want elevational adjustments to occur. When this check box is selected, and Z+, Z-, or Thickness columns are defined in the format, then elevational calculations are performed on the file. For more information, see “Column Headings” in this chapter.

12 Select the Do Coordinate Transformation If Possible check box to coordinate transformations to occur. In order for coordinate transformations to occur, the import/export format must have a coordinate zone assigned to it. For example, if you are exporting points to a point file, then the coordinates of the COGO points in the resulting ASCII file are transformed to match the zone assigned to the import/export format.

13 Select the Do Coordinate Data Expansion If Possible check box if you are exporting a file that contains pieces of information, such as degrees, minutes, seconds, and hemisphere for latitude and longitude values, and you want to calculate missing pieces of data based on these known pieces, such as grid northing and easting.

14 Click OK to export the points.
Transferring Points

You can transfer points between two different ASCII text files, or from a Microsoft® Access database file to an ASCII text file.

You can also transfer data to a pre-existing Microsoft® Access database file. For more information, see “XDRef” in this chapter.

**NOTE** Points that are transferred are not deleted from the source file.

**To transfer points**

1. Create import/export formats for the files you want to transfer points between. For example, to transfer points from a Microsoft® Access database file to an ASCII text file, set up a User Point Database format and a User Point File format.

2. From the Points menu, choose Import/Export Points ➤ Transfer Points to display the Format Manager - Import/Export dialog box.

3. From the Format list under Source, select the format of the file from which you want to transfer points.

   **TIP** Click the Manage button to access the Format Manager, where you can create new formats.

4. Click next to the Source File list to display the Select Source File dialog box.

5. Select the source file to use and click Open to return to the Format Manager - Import/Export dialog box.

6. Under Destination, select the format of the file you want to transfer points to.
7 Click next to the Destination File box to display the Select Destination File dialog box.

8 Select the destination file to transfer the points to, or type a new file name, and click Save to return to the Format Manager - Import/Export dialog box.

9 Click the Advanced button to display additional options.

10 Select the Do Elevation Adjustment If Possible check box if Z+, Z-, or Thickness columns are set up in the import/export format, and you want elevational adjustments to occur. When this check box is selected, and Z+, Z-, or Thickness columns are defined in the format, then elevational calculations are performed on the file. For more information, see “Column Headings” in this chapter.

11 Select the Do Coordinate Transformation If Possible check box to coordinate transformations to occur. In order for coordinate transformations to occur, the import/export format must have a coordinate zone assigned to it. For example, if you are transferring a point file from one ASCII file to another, then the coordinates of the point file are transformed to match the zone of the format to which you are transferring points.

12 Select the Do Coordinate Data Expansion If Possible check box if you are transferring a file that contains pieces of information, such as degrees, minutes, seconds, and hemisphere for latitude and longitude values, and you want to calculate missing pieces of data based on these known pieces, such as grid northing and easting.

13 Click OK to transfer the points.
Converting Points in the COGO Database to a Different Coordinate Zone

You can convert the points in the COGO point database to a different zone by exporting the points to a file, switching the current zone of the drawing, and then importing the file back into the drawing.

**To convert points in the COGO database to a different coordinate zone**

1. Set up an export format for the points. This format must be an User Point File format and its columns must match the values in the COGO point database. You must select the Coordinate Zone Transform check box and specify the coordinate zone for the format. This zone must be the zone you want to convert the points from. For example, if the points were created in an NAD27 zone and you want to convert them to an NAD83 zone, then specify the NAD27 zone as the coordinate zone for the format.

2. Export the points from the COGO point database.

3. Change the COGO database import options. You should set the “What to do when a point is already in the point database” option to Overwrite.

4. Change the current zone of the drawing to the new zone you want to use. For more information, see “Changing the Current Zone for a Drawing” in Chapter 4, “Setting Up Drawings.”

5. Import the points into the COGO point database.

Merging a Point Database into the Current Point Database

You can merge points from a point database into the current point database. The point database that you want to merge must be a Microsoft Access .mdb file.

**NOTE**
Older versions of COGO point databases—named project.pdf—that were created in Autodesk S8 Civil/Survey programs, cannot be merged into the current database. However, you can open the older project in AutoCAD Land Development Desktop to convert the project.pdf file to a points.mdb file, a file which can be merged with the current project.

**To merge a point database into the current point database**

1. Change the COGO database import options. For more information, see “Changing the COGO Database Import Options” in this chapter.

2. From the Points menu, choose Import/Export Points ➤ Import Points to display the Format Manager - Import Points dialog box.

3. From the Format list, select the External Project Point Database format.

4. Click next to the Source File list to display the Select Source Database dialog box.
5 Select the points.mdb file that you want to merge into the current project point database.

6 Click Open to return to the Format Manager - Import Points dialog box.

7 Select the Add Points to Point Group check box to add merged points to a point group. If you select this check box, then do one of the following:
   ■ From the list, select an existing group to which you want to add the points.
   ■ Click to create a new group for the points. The Format Manager - Create Group dialog box is displayed. Type the name for the group and click OK.

8 Click OK to merge the points into the project point database of the current project.
13

Editing Points

The AutoCAD Land Development Desktop point editing commands change the point data in both the drawing and in the project point database. You can move, copy, rotate, erase, and renumber points, as well as change their elevations and descriptions.

In this chapter

- Editing Points
- Changing the Display Properties for Points in the Drawing
- Editing Point Data in a Dialog Box
- Changing the Elevations of Points
- Renumbering, Moving, Rotating, Copying, and Erasing Points
- Restoring Erased Point Information
- Changing the Coordinates of All Project Points
- Changing the Rotation of All Project Points
Editing Points

Use the point editing commands to change point numbers, elevations, descriptions, names, and other data. There are commands you can use to move, erase, rotate, and copy points in both the drawing and in the point database. All of the point editing commands in the Points ➤ Edit Points menu update both the drawing and the point database with the changes that you make.

**WARNING!** If you use the AutoCAD commands like ERASE to edit drawing points, then the point database is not updated. Use the Modify Project command to update the point database to reflect the changes in the drawing.

Changing the Display Properties for Points in the Drawing

You can change the point marker display properties for a selection set of points that already exist in the drawing. For example, you can rotate the points, adjust the point marker colors, display raw descriptions instead of full descriptions, and reset the point marker elevations in the drawing. You can also turn off the display of leaders, which are created when you drag point marker text away from the point.

**To change the point display properties**

1. From the Points menu, choose Edit Points ➤ Display Properties.
   
   The following prompt is displayed:
   
   Points to Modify (All/Numbers/Group/Selection/Dialog) ? <Selection>:

2. Do one of the following to select the points:
   
   - Type **All** to select all the points in the drawing.
   - Type **Numbers** to specify point numbers or names.
   - Type **Group** to specify a point group.
   - Type **Selection** and then select the points from the drawing. This option only selects points that are visible in the drawing.
   - Type **Dialog** to use filtering and advanced selection methods.

   For more information about selection methods, see “Selecting Points to Edit” in Chapter 10, “Managing Points.”
When you have created the selection set, the Point Display Properties dialog box is displayed:

![Point Display Properties dialog box](image)

**NOTE** You can also create the selection set before using this command. Just select the points you want to change, right-click, and select Display Properties. If you select objects other than points when creating the selection set, the Display Properties command is not available from the shortcut menu.

3 Click the Marker tab to change the appearance of the point markers. For more information, see “Changing the Point Marker Symbol Settings” in Chapter 6, “Getting Started with Points.”
4 Click the Text tab to change the appearance of point text. For more information, see “Changing the Point Text Settings” in Chapter 6, “Getting Started with Points.”

5 Click the Reset tab to specify whether to move marker text back to the marker location or to reset point elevations. The Point Display Properties Dialog box is displayed:
6 Under Text Location, select or clear the Move Marker Text Back to Marker Location check box:
   - Select the Move Marker Text Back to Marker Location check box to reset the marker text back to its original location if you have moved it away from the point.
   - Clear the Move Marker Text Back to Marker Location check box to preserve any changes you have made to marker text location.

7 To restore the display elevations of points in the drawing that you have changed, under Point Elevation, select the Reset Point Elevation In Drawing check box. Select one of the following options:
   - Select Actual Elevation to insert the points in 3D, using the actual elevations of the points stored in the point database (or the elevations from the XDRef if an XDRef was used for elevations). If you select this option, then specify an elevation to assign to points that do not have elevational data assigned to them in the If No Elevation, Use box.
   - Select Fixed Elevation to insert the points using a fixed elevation for all points, and then type an elevation in the Fixed Elevation box.

   **NOTE** The Point Elevation settings do not affect the elevations in the point database, or the elevations that exist in an external database that are assigned by an XDRef. These settings just control how the point’s elevation is represented in the 3D AutoCAD drawing.

8 Click OK.

**IMPORTANT** In Autodesk S8 Civil/Survey, the points were always inserted into the drawing at an elevational value of 0, regardless of their actual elevations. Because of this, the DISTANCE command always reported the correct X,Y 2D distance between points. If you select the Actual Elevation check box, then the DISTANCE command (and any other command that reports distances) reports 3D distances.
## Editing Point Data in a Dialog Box

You can edit point names, elevations, descriptions, northing, easting, latitude, and longitude from within a dialog box.

**To edit points**

1. From the Points menu, choose **Edit Points ➤ Edit Points** to display the Edit Points dialog box.

   ![Edit Points Dialog Box](image)

2. Create a selection set of the points that you want to edit. For more information, see “Creating a Point List” in Chapter 10, “Managing Points.”

   **NOTE** When you create a selection set, point information for each point you selected is displayed in the Edit Points dialog box. If you click the **Advanced** button to use advanced point selection methods, then you can also edit the points on the **Edit** tab, or you can click the **Simple** button and edit the points in the list.

3. Click your pointing device in a cell to edit a point’s name, elevation, description, coordinates, latitude, longitude, grid northing and grid easting.

   **NOTE** The coordinates that are displayed for points are based on the Point Coordinate Display settings.
Changing the Elevations of Points

You can change the elevations of a group of points. This is useful when you have set points according to an assumed elevation datum, and then you transfer a benchmark elevation in at a later time.

To change the elevations of a group of points

1. From the Points menu, choose Edit Points ➤ Datum.

   The following prompt is displayed:

   Change in elevation (or Reference):

2. Type one of the following options:

   ■ Type a change in elevation. To specify a lower elevation, type a minus sign (-) in front of the value.

   ■ Type Reference and then type the old and new datum elevations. The points are modified by the difference between the two values.

   The following prompt is displayed:

   Points (All/Numbers/Group/Selection/Dialog) ? <All>:

3. Type one of the following options to select the points:

   ■ Type All to select all the points in the project.

   ■ Type Numbers to specify point numbers or names.

   ■ Type Group to specify a point group.

   ■ Type Selection and then select the points from the drawing. This option only selects points that are visible in the drawing.

   ■ Type Dialog to use filtering and advanced selection methods.

   For more information about selection methods, see “Selecting Points to Edit” in Chapter 10, “Managing Points.”

   **NOTE** If there is a period (.) placemarker in the elevation for one of the points selected, the elevation for that point is not adjusted.

Example: Changing the Datum Elevation of Points

You commonly change the datum elevation to adjust the points based on the actual elevation of a benchmark that was assumed in the field. For example, to adjust for the 1045.67 benchmark elevation that was assumed to be 100 in the field, use the Reference option, as shown in the following prompts:

Change in elevation<or Reference>: R
Old datum elevation: 100
New datum elevation: 1045.67

The following example shows how you can also achieve the same result by calculating the change in elevation and entering it directly.

Change in elevation<or Reference>: 945.67
Renumbering Points

To renumber points

1. From the Points menu, choose Edit Points ➤ Renumber.
2. Type the point number additive factor. The additive factor increases each point in the selection set.

   The following prompt is displayed:
   
   Points (All/Numbers/Group/Selection/Dialog) ? <All>:

3. Do one of the following to select the points:
   ■ Type All to select all the points in the project.
   ■ Type Numbers to specify point numbers or names.
   ■ Type Group to specify a point group.
   ■ Type Selection and then select the points from the drawing. This option only selects points that are visible in the drawing.
   ■ Type Dialog to use filtering and advanced selection methods.

   For more information about selection methods, see “Selecting Points to Edit” in Chapter 10, “Managing Points.”

   The Renumber command then checks for any duplication. If it finds a duplicate, then the command displays the following prompts:
   
   Point number <$#> is already used.
   Option (Overwrite/<Next>):

4. If duplicate points are located, do one of the following:
   ■ Press ENTER to give the point the next available point number in the database.
   ■ Type Overwrite to overwrite the point.

Moving Points

You can move points in the drawing and automatically update the coordinates for any point object in both the drawing and point database.

To move points

1. From the Points menu, choose Edit Points ➤ Move.

   The following prompt is displayed:
   
   Points to Move (All/Numbers/Group/Selection/Dialog) ? <All>:

2. Do one of the following to select the points:
   ■ Type All to select all the points in the project.
   ■ Type Numbers to specify point numbers or names.
   ■ Type Group to specify a point group.
   ■ Type Selection and then select the points from the drawing. This option only selects points that are visible in the drawing.
   ■ Type Dialog to use filtering and advanced selection methods.
For more information about selection methods, see “Selecting Points to Edit” in Chapter 10, “Managing Points.”

3 Select a base point. This point acts as the reference point for the move.

4 Select the second point of displacement.

All points you selected are moved according to the displacement, and the point database is updated with the new coordinates.

Rotating Points

You can rotate points based on a rotation angle or reference angle for both drawing and project points.

To rotate points

1 From the Points menu, choose Edit Points ➤ Rotate.

The following prompt is displayed:

Points to Rotate (All/Numbers/Group/Selection/Dialog) ? <All>:

2 Do one of the following to select the points:
   ■ Type All to select all the points in the project.
   ■ Type Numbers to specify point numbers or names.
   ■ Type Group to specify a point group.
   ■ Type Selection and then select the points from the drawing. This option only selects points that are visible in the drawing.
   ■ Type Dialog to use filtering and advanced selection methods.

For more information about selection methods, see “Selecting Points to Edit” in Chapter 10, “Managing Points.”

3 Select a base point for rotation.

4 Type the rotation angle in DD.MMSS format.

NOTE To rotate the coordinate system, you can change the North Rotation.

Copying Points

You can copy points from one location to another, and change the point elevations and layer while doing so.

To copy points

1 From the Points menu, choose Edit Points ➤ Copy.

The following prompt is displayed:

Points to Rotate (All/Numbers/Group/Selection/Dialog) ? <All>:
2 Do one of the following to select the points:
  ■ Type **All** to select all the points in the project.
  ■ Type **Numbers** to specify point numbers or names.
  ■ Type **Group** to specify a point group.
  ■ Type **Selection** and then select the points from the drawing. This option only selects points that are visible in the drawing.
  ■ Type **Dialog** to use filtering and advanced selection methods.

For more information about selection methods, see “Selecting Points to Edit” in Chapter 10, “Managing Points.”

3 Select a base point to copy from.

4 Select the point of displacement.

The following prompt is displayed:

```
Change in elevation (or Reference):
```

5 Do one of the following to change the elevations of the selected points:
  ■ Type a change in elevation. To specify a lower elevation, type a minus sign (-) before the value.
  ■ Type **Reference**, and then type the old and new datum elevations. The points are modified by the difference between the two values.

6 Type the name of the new layer, if necessary.

The command then copies the points to their new locations, layer, and/or elevations. Each point is numbered with the next available point number.

### Erasing Points

You can erase points, which removes point information from the drawing and marks the point in the database as having been deleted.

**NOTE** Unless you create new points using the erased point numbers, or pack the point database, you can restore erased points by using the Unerase command.

**To erase points**

1 From the Points menu, choose Edit Points ➤ Erase.

   The following prompt is displayed:

```
Points to Erase (All/Numbers/Group/Selection/Dialog) ? <All>:
```

2 Do one of the following to select the points:
  ■ Type **All** to select all the points in the project.
  ■ Type **Numbers** to specify point numbers or names.
  ■ Type **Group** to specify a point group.
  ■ Type **Selection** and then select the points from the drawing. This option only selects points that are visible in the drawing.
  ■ Type **Dialog** to use filtering and advanced selection methods.
For more information about selection methods, see “Selecting Points to Edit” in Chapter 10, “Managing Points.”

The points are removed from the drawing, and are marked in the point database file as deleted. However, you can use the Unerase command to recover the information if you haven’t created new points using the same point numbers, or packed the point database.

To remove just the points from the drawing while keeping the point database intact, you can also use the Remove from DWG command.

Restoring Erased Point Information

You can restore erased points to the drawing and point database. If you haven’t created new points with the same numbers, or packed the point database, you can recover the erased point information even if you erased it in a previous drawing session.

To restore erased points

1. From the Points menu, choose Edit Points ➤ Unerase.
   The following prompt is displayed:
   Points to Unerase (All/Numbers/Group/Window) ? <Window>:

2. Type one of the following options:
   - Type All to select all the points in the project.
   - Type Numbers to specify point numbers or names.
   - Type Group to specify a point group.
   - Type Window and then draw a selection window around the area of the drawing where you erased the points. This selection method selects erased points in the point database and restores them to the drawing.

For more information about selection methods, see “Selecting Points to Edit” in Chapter 10, “Managing Points.”

The command restores the erased points to the project.

Changing the Coordinates of All Project Points

You can change the coordinates of all project points by selecting a point in the drawing and then giving it a new location. This command moves all the other points in the project relative to this change in the base point.

To translate the project points

1. Open the point database in single-user mode. You cannot translate the project points if other people have the point database open.

2. From the Points menu, choose Edit Points ➤ Translate Points.
   The following prompt is displayed:
   Base point for translation:
3 Select a reference point for the translation of coordinates.

The following prompt is displayed:

Destination point for translation:

4 Select a destination point for the translation. The distance and angle between the base point and the destination point controls how the points are moved.

A warning box is displayed to warn you that this command modifies the entire project point database file.

5 Click OK to continue the command.

The following prompt is displayed:

Modify Setup Orientation North/East setting of current drawing (No/Yes) <Yes>:

6 Type Yes or No:

- Type Yes to change the base point setting of the drawing by the translation values. If you do this, then the points do not actually move in the drawing when the translation values are applied.

  For more information, see “Changing the Base Point for a Drawing” in Chapter 4, “Setting Up Drawings.”

- Type No if you do not want to change the base point setting of the drawing.

  **NOTE**

  If you do not change the base point setting, then the drawing coordinates of the points no longer match the project coordinates. You can use the Modify Drawing command later to reposition the drawing points to the new project coordinates.

The following prompt is displayed:

Modify Setup Orientation North/East setting of all drawings within project (Yes/No) <No>:

7 Type Yes or No:

- Type Yes to modify the base point of all the other drawings in the project the next time the drawings are opened.

- Type No if you do not want to modify the base point of all the other drawings in the project.

  **NOTE**

  When you type Yes to modify the base point of the other drawings in the project, a <drawing name>.cor file is created for each drawing in the project. These files are used to update the other drawing files in the project with the changes you made to the base point in the current drawing. When you open another drawing in the project, the <drawing name>.cor file is used by the program to automatically update that drawing with the changes to the base point. When you open the drawing, the changes are applied and the <drawing name>.cor file is deleted. If you manually delete the <drawing name>.cor file before opening the drawing, then the changes you made to the base point are not carried over to that drawing when you open it.
Changing the Rotation of All Project Points

You can modify the coordinates of all project points by rotating them about a base point.

To rotate the project points

1 Open the point database in single-user mode. You cannot rotate the project points if other people have the point database open.
2 From the Points menu, choose Edit Points ➤ Rotate Points. The following prompt is displayed:
   Base point for rotation:
3 Select a base point for the rotation.
4 Type the rotation angle in DD.MMSS format. This number is a clockwise angle from the vertical.
   A warning box is displayed to warn you that this command modifies the entire project point database file.
5 Click OK to continue the command. The following prompt is displayed:
   Modify Setup Orientation North Rotation setting of current drawing (No/Yes) <Yes>:
6 Type Yes or No:
   ■ Type Yes to change the north rotation of the drawing so that the points do not move in the drawing when the rotation angle is applied.
   ■ Type No if you do not want to change the north rotation of the drawing.
   
   **NOTE** If you do not change the north rotation, then the drawing coordinates of the points no longer agree with the project coordinates. You can use the Modify Drawing command later to reposition the drawing points to the new project coordinates.

The following prompt is displayed:
   Modify Setup Orientation North Rotation setting of all drawings within project (Yes/No) <No>:
7 Type Yes or No:

- Type Yes to change the north rotation of all the drawings in the project the next time the drawings are opened.
- Type No if you do not want to change the north rotation of the drawings in the project.

**NOTE** When you type Yes to modify the north rotation of the other drawings in the project, a <drawing name>.cor file is created for each drawing in the project. These files are used to update the other drawing files in the project with the changes you made to the north rotation in the current drawing. When you open another drawing in the project, the <drawing name>.cor file is used by the program to automatically update that drawing with the changes to the north rotation. When you open the drawing, the changes are applied and the <drawing name>.cor file is deleted. If you manually delete the <drawing name>.cor file before opening the drawing, then the changes you made to the north rotation are not carried over to that drawing when you open it.
You can generate stakeout reports based on turned or deflected angles, or you can generate reports by direction. Stakeout reports list stake points, direction or angle, distance, northing/easting coordinates, description, and elevation of points.
Creating Point Stakeout Reports

You can create several different types of stakeout reports that display the following information about each point:

- Stake number
- Direction or angle
- Distance
- Northing/easting coordinates
- Description and/or elevation

You can create the reports using different stakeout angle types: direction, turned angle right (+), turned angle left (-), deflected angle right (+), and deflected angle left (-).

Changing the Stakeout Angle Type

You can change the type of angle to use for creating stakeout reports.

To change the stakeout angle type

1. Do one of the following to display the Stakeout Settings dialog box:
   - From the Points menu, choose Stakeout ➤ Stakeout Settings.
   - From the Alignments menu, choose Stakeout Alignment ➤ Settings.
   - From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, click Land Development Desktop. From the Settings list, select Point/Alignment Stakeout and click the Edit Settings button.

2. Select one of the following stakeout angle types:
   - Turned +: turned angle right
   - Turned -: turned angle left
   - Deflect +: deflection angle right
   - Deflect -: deflection angle left
   - Direction: an angle that uses azimuths or bearings
The following illustration shows the different turned and deflected stakeout angle types:

<table>
<thead>
<tr>
<th>Turned Angle Right</th>
<th>Turned Angle Left</th>
</tr>
</thead>
<tbody>
<tr>
<td>BACKSIGHT POINT</td>
<td>OCCUPIED POINT</td>
</tr>
<tr>
<td>OCCUPIED POINT</td>
<td>BACKSIGHT POINT</td>
</tr>
<tr>
<td>BACKSIGHT POINT</td>
<td>OCCUPIED POINT</td>
</tr>
<tr>
<td>DEFLECTED ANGLE RIGHT</td>
<td>DEFLECTED ANGLE LEFT</td>
</tr>
</tbody>
</table>

Stakeout angle types

3. Click OK to select the stakeout angle or Cancel to exit the command.

Changing the Settings for Outputting Stakeout Files

To change the ASCII file output settings

1. From the Points menu, choose Stakeout Points ➤ Output Settings. The Output Settings dialog box is displayed:

```
Output Settings

- Output Options
  - File
  - Screen

- Output Format
  - Data
  - Page number
  - File
  - Sub header
  - Page breaks
  - Header file

- Page length: 8.5
- Page width: 11
- Left margin: 0
- Right margin: 0
- Top margin: 0
- Bottom margin: 0

Output File Name: stakeout.txt

OK Cancel Help
```

For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
Creating a Radial Stakeout Report

You can report stakeout data for points within a given distance of the occupied point.

To report radial stakeout data by range of points

1 Change the Output Settings. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
2 Change the stakeout angle type. For more information, see “Changing the Stakeout Angle Type” in this chapter.

**NOTE** If you select the Direction stakeout angle, then the Stakeout commands do not prompt you for a backsight point.

3 From the Points menu, choose Stakeout ➤ Radial Point Stakeout.
4 Type the number of the occupied point.
5 Type the number of the backsight point.
6 The following prompt is displayed:

   Points to Stakeout (All/Numbers/Group/Selection/Dialog) ? <All>:

7 Do one of the following to select the points:
   - Type **All** to select all the points in the project.
   - Type **Numbers** to specify point numbers or names.
   - Type **Group** to specify a point group.
   - Type **Selection** and then select the points from the drawing. This option only selects points that are visible in the drawing.
   - Type **Dialog** to build a list of points by using filtering and advanced selection methods.

For more information about selection methods, see “Selecting Points to Edit” in Chapter 10, “Managing Points.”

The following prompt is displayed:

   Stakeout distance (or RETURN for MAXIMUM) :

8 Do one of the following to define the stakeout distance:
   - Type a distance (in decimal format). All points within this distance from the occupied point are included in the stakeout report.
   - Pick two points to define the distance.
   - Press ENTER to include all points at any distance from the occupied point.

The text window displays the stakeout information if you selected the Screen option from the Output Settings, or the data is saved to a file if you selected the File option.
Creating a Curve Stakeout Report by Direction

You can report stakeout data of a curve, with directions or angles as output.

To report curve stakeout data by direction

1. Change the Output Settings. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”

2. Change the stakeout angle type. For more information, see “Changing the Stakeout Angle Type” in this chapter.

   NOTE: If you select the Direction stakeout angle, then the Stakeout commands do not prompt you for a backsight point.

3. From the Points menu, choose Stakeout ➤ Curve By Direction.

4. Select the curve. For more information, look up object selection methods in the AutoCAD User’s Guide.

   The command draws an X at the point of curvature. If the X is drawn at the wrong end of the curve, then cancel the command and select the curve closer to the point of curvature.

5. Type the starting station for the curve, in decimal units.

6. Type the station increment. A stake location is calculated for each station that falls at the specified station increment.

   TIP: You can type additional stations at step 10 to add odd stations that are not covered by this increment.

7. Type the number of the occupied point.

8. Type the number of the backsight point.

   The text window displays the stakeout information if you selected the Screen option from the Output Settings, or the data is saved to a file if you selected the File option.

9. Page down through the stakeout report if you selected the Page Breaks setting in the Output Settings.

   The following prompt is displayed:

   Additional station:

10. Type the number of a station not covered by the station increment.

11. Press ENTER to end the command.

   The text window displays the stakeout information if you selected the Screen option from the Output Settings, or the data is saved to a file if you selected the File option.
Creating a Curve Stakeout Report of Offsets from Tangent

You can create a curve stakeout report that reports the perpendicular offset distances from the curve's tangent.

To report curve stakeout offset data

1. Change the Output Settings. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”

2. Change the stakeout angle type. For more information, see “Changing the Stakeout Angle Type” in this chapter.

3. From the Points menu, choose Stakeout ➤ Curve By Offsets.

4. Select the curve. For more information, look up object selection methods in the AutoCAD User's Guide.

   The command draws an ✗ at the point of curvature. If the ✗ is drawn at the wrong tangent's end of the curve, then cancel the command and select the curve closer to the point of curvature.

5. Type the starting station for the curve, in decimal units.

6. Type the station increment. A stake location is calculated for each station that falls at the specified station increment.

   TIP You can type additional stations at step 9 to add odd stations that are not covered by this increment.

7. Press ENTER to generate the report.

   The text window displays the stakeout information if you selected the Screen option from the Output Settings, or the data is saved to a file if you selected the File option.

8. Page down through the stakeout report if you selected the Page Breaks setting in the Output Settings.

   The following prompt is displayed:
   Additional station:

9. Type the number of an additional stations not covered by the station increment.

Creating a Spiral Stakeout Report by Direction

You can report spiral stakeout data, with directions or angles as output.

To report spiral stakeout data by direction

1. Change the Output Settings. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
2 Change the stakeout angle type. For more information, see “Changing the Stakeout Angle Type” in this chapter.

**NOTE** If you select the Direction stakeout angle, then the Stakeout commands do not prompt you for a backsight point.

3 From the Points menu, choose Stakeout ➤ Spiral By Directions.
4 Select the spiral. For more information, look up object selection methods in the AutoCAD User’s Guide.
5 Type the starting station for the spiral, in decimal units.
6 Type the station increment. A stake location is calculated for each station that falls at the specified station increment.

**TIP** You can type additional stations at step 9 to add odd stations that are not covered by this increment.

7 Type the number of the occupied point.
8 Type the number of the backsight point.
   The text window displays the stakeout information if you selected the Screen option from the Output Settings, or the data is saved to a file if you selected the File option.
9 Page down through the stakeout report if you selected the Page Breaks setting in the Output Settings. For more information, see “Changing the Settings for Outputting Stakeout Files” in this chapter.
   The following prompt is displayed:
   `Additional station:`
10 Type the number of a station not covered by the station increment.
11 Press ENTER to end the command.

### Creating a Spiral Stakeout Report of Offsets from Tangent

You can create a spiral stakeout report that reports the perpendicular offset distances from the spiral’s tangents.

**To report spiral stakeout offset data**

1 Change the Output Settings. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
2 Change the stakeout angle type. For more information, see “Changing the Stakeout Angle Type” in this chapter.
3 From the Points menu, choose Stakeout ➤ Spiral By Offsets.
4 Select the spiral. For more information, look up object selection methods in the AutoCAD User’s Guide.
5 Type the starting station for the spiral, in decimal units.
6 Type the station increment. A stake location is calculated for each station that falls at the specified station increment.

**TIP** You can type additional stations at step 8 to add odd stations that are not covered by this increment.

The text window displays the stakeout information if you selected the Screen option from the Output Settings, or the data is saved to a file if you selected the File option.

7 Page down through the stakeout report if you selected the Page Breaks setting in the Output Settings.
   The following prompt is displayed:
   Additional station:

8 Type the number of a station not covered by the station increment.
9 Press ENTER to end the command.

### Creating a Stakeout Report for Consecutive Points

You can report stakeout data between consecutive points. A consecutive stakeout differs from a radial stakeout in that each point in the range becomes the occupied point.

**To report consecutive stakeout data**

1 Change the Output Settings. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
2 Change the stakeout angle type. For more information, see “Changing the Stakeout Angle Type” in this chapter.

**NOTE** If you select the Direction stakeout angle, then the Stakeout commands do not prompt you for a backsight point.

3 From the Points menu, choose Stakeout ➤ Consecutive Stakeout.
4 Type the number of the occupied point.
5 Type the number of the backsight point.
   The following prompt is displayed:
   Points to Stakeout (All/Numbers/Group/Selection/Dialog) ? <All>: 
6  Do one of the following to select the points:
   ■ Type All to select all the points in the project.
   ■ Type Numbers to specify point numbers or names.
   ■ Type Group to specify a point group.
   ■ Type Selection and then select the points from the drawing. This option only selects points that are visible in the drawing.
   ■ Type Dialog to build a list of points by using filtering and advanced selection methods.

The text window displays the stakeout information if you selected the Screen option from the Output Settings, or the data is saved to a file if you selected the File option.
15

Point Utilities

When you want to find out which point numbers are available to use, where points are located in a drawing, what the grid northing and easting or latitude and longitude of a point is, use the point utilities. If you are upgrading from Autodesk S8 Civil/Survey, then you can replace Softdesk point blocks with COGO point objects. You can convert AutoCAD point nodes to COGO points, and pack the point database to remove unused point records.

In this chapter

- Point Utilities
- Displaying Which Point Numbers are Available to Use
- Displaying the Locations of Points in the Project
- Zooming to a Point Number
- Zooming to the Point Extents
- Drawing the Point Extents
- Replacing Softdesk Point Blocks
- Converting AutoCAD Points to COGO Point Objects
- Packing the Point Database
- Using the Geodetic Calculator
Point Utilities

Use the point utilities to remove unused and deleted points from the point database, to replace old Softdesk point blocks with new COGO point objects, to zoom to points, to calculate geodetic values, and more.

Displaying Which Point Numbers Are Available to Use

You can display the point numbers that are available to use in the current project.

To display the available point numbers

■ From the Points menu, choose Point Utilities ➤ List Available Point #.

The command line lists the point numbers that have not yet been used. If point numbers are available above the highest point number, then the command displays a plus sign (+). For example, if the command line displays 49, 54+, then it means that point number 49 has not been used, nor have point numbers 54 and above.

Displaying the Locations of Points in the Project

You can easily view the locations in your drawing that correspond to the points in the project point database.

To display the locations of project points

■ From the Points menu, choose Point Utilities ➤ Quick View.

The program places Xs in the drawing for each point in the project point database, based on the coordinates of each point.

To redraw the display and erase the Xs, use the AutoCAD REDRAW command.

Zooming to a Point Number

You can change the view of a drawing so that the coordinates of a selected point number are located in the center of the screen.

To zoom to a drawing point

1 From the Points menu, choose Point Utilities ➤ Zoom to Point.
2 Type the point number to zoom to.

NOTE The actual point does not have to be inserted in the current drawing; however it must exist in the project point database.

The following prompt is displayed:

Zoom height <10>: 
This height defaults to the current zoom level of the drawing and represents the size in drawing units.

Do one of the following to specify the zoom height:

- Press ENTER to accept the current zoom level.
- Type a larger number to zoom out.
- Type a smaller number to zoom in.

### Zooming to the Point Extents

You can zoom to the extents of the points in the project point database. This command is useful for quickly returning to the extents of the project. It also makes it easy to quickly establish the extents of the current project when starting a new drawing. This command ignores AutoCAD objects that are in the drawing.

**To zoom to the extents of the points**

- From the Points menu, choose Point Utilities ➤ Zoom to Extents.

### Drawing the Point Extents

You can draw a polyline boundary that is based on the minimum and maximum point database coordinates, indicating the extents of the points in the project point database. You can use this as an option to see the extents of the points, without importing them.

**To draw the point extents**

- From the Points menu, choose Point Utilities ➤ Draw Extents.

  The command draws a polyline around the extents of the points in the project point database.

  **TIP** You can use the AutoCAD ZOOM command to zoom to the extents of the drawing and to see the limits of all objects in the drawing.

### Replacing Softdesk Point Blocks

If you are upgrading from Autodesk S8 Civil/Survey programs, or earlier versions of Softdesk Civil/Survey programs, then you can use the Replace Softdesk Point Blocks command to replace old point blocks with COGO point objects. This command searches the drawing for old point blocks (named POINT), reads the point numbers out of them, and then deletes the old blocks and any associated description key symbols. The command inserts new COGO points.

If the old point block is out of position, then you need to run the Check Points command to rectify this before you run the Replace Softdesk Point Blocks command.
To replace Softdesk point blocks

1. Select the current point label style. For more information, see “Selecting the Current Label Style” in Chapter 23, “Label Styles.”

2. Select the Use the Current Point Label Style When Inserting Points check box on the Insert tab of the Point Settings dialog box. For more information, see “Changing the Point Insertion Settings” in Chapter 6, “Getting Started with Points.”

   **NOTE** The previous two steps are optional if you select the Replace Directly option in step 4.

3. From the Points menu, choose Point Utilities ➤ Replace Softdesk Point Blocks. The POINT Block Replacement dialog box is displayed:

4. Click one of the following options:
   - Click Replace Directly to replace the point blocks with COGO point objects that contain only the information in the current point block. If you select this option, then the points are not labeled as they are replaced, nor does description key substitution occur. Points are inserted with the current point marker settings.
   - Click Delete and Reinsert to replace the point blocks with COGO point objects using the current label style and description key settings.
   - Click Cancel to cancel the command.

5. Select the Softdesk point blocks you want to replace and press ENTER. The command replaces the blocks with point marker text or with a point label, depending on which option you chose.

   If the point blocks you select do not match the data in the point database, for example, if they have been moved, then a message dialog box is displayed that contains one of the following messages:
   - Some Drawing Point Blocks selected are not in the database. Run Check Points to add them before replacing.
   - Some Drawing Point Blocks selected disagree with the database. Run Check Points to correct before replacing them.

   Use the Check Points commands to reconcile the differences between the drawing and the point database, and then run the Replace Softdesk Point Blocks command again.
Converting AutoCAD Points to COGO Point Objects

If you have AutoCAD point nodes in a drawing, then you can convert those points to COGO point objects. By converting AutoCAD point nodes to COGO point objects, the points can have information associated with them, such as elevation, point number, and description. This information is also stored in an external point database that can be accessed by multiple people working over a network. An additional benefit is that after the points are converted to COGO points, you do not need to keep the points in your drawing. Instead, you can insert the project points into the drawing as required.

NOTE
All points that you create by using the Points menu (and all other AutoCAD Land Development Desktop commands that create points) are automatically COGO point objects.

To convert AutoCAD points to COGO point objects
1 Change the Point Settings. For more information, see Chapter 6, “Getting Started with Points.”
2 From the Points menu, choose Point Utilities ➤ Convert from AutoCAD Points.
3 Select the AutoCAD point node(s) that you want to convert.
4 Type the description for the point, or type a period to skip the description.

The point is converted to a COGO point object, and the elevation of the AutoCAD point node automatically becomes the elevation of the COGO point. The points are added to the point database, points.mdb.

Packing the Point Database

To remove the records of unused and erased points from the project point database, you can pack the point database.

WARNING!
Erased points can be recovered by using the Unerase command, but packing the point database removes all deleted points from the point database so they can no longer be recovered.

To pack the point database
1 Verify that the point database is in single-user mode. For more information, see “Changing the Point Database Setup Settings” in Chapter 10, "Managing Points."
2 From the Points menu, choose Point Utilities ➤ Pack Point Database.
3 A prompt similar to the following is displayed:
   Point File has 2 unusable (deleted or empty) points.
   Remove all unusable points from Point File (Yes/No) <No>:
4 Type Yes to delete the point records.
If you type Yes to delete the points, then a warning dialog box is displayed, informing you that all deleted and empty points from the point database are about to be deleted.

4 Click OK to continue.

### Using the Geodetic Calculator

You can use the geodetic calculator to calculate the latitude and longitude or grid northing and grid easting of a point by specifying local northing and local easting coordinates. You can also calculate the local northing and easting coordinates by specifying latitude and longitude or grid northing and easting coordinates. You can create a point in your drawing based on the coordinate values you calculate using the geodetic calculator.

**To use the geodetic calculator**

1 Set the current zone. For more information, see “Changing the Current Zone for a Drawing” in Chapter 4, “Setting Up Drawings.”

2 Define the Transformation Settings. For more information, see “Changing the Geodetic Zone Transformation Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”

**NOTE** The transformation settings do not have to be applied to the drawing in order to use the geodetic calculator. However, if they are not set then you can only view grid northing and easting and latitude and longitude values in the calculator.

3 From the Points menu, choose Point Utilities ➤ Geodetic Calculator.

The Geodetic Calculator dialog box is displayed:
The Zone Description is listed at the top of the dialog box. The Scale Factor and Convergence angle are listed at the bottom of the dialog box, and are calculated based on the point location within the current zone.

Two notes are displayed above the dialog box buttons. These notes can vary depending on what settings you specify in the Transformation Settings dialog box. For example, if you select the option to apply a sea level scaling factor in the Transformation Settings, then the first note says Sea level corrections WILL be applied to Local Coordinates. If you clear the option, then the note says Sea level corrections WILL NOT be applied to Local Coordinates and the text is grayed out. When Transformation Settings are active for the drawing, the second note says Grid scale factor WILL be applied to local coordinates. If you turn off the Transformation Settings, then the note says Grid scale factor WILL NOT be applied to local coordinates and the text is grayed out.

4 Do one of the following to calculate values:

- Type a COGO point number in the Point # box to obtain the local coordinates from the point database and to calculate the grid northing and easting and the latitude and longitude.
- Click the Select button and select a COGO point number in the drawing. This option has the same effect as typing a point number.
- Type a known Latitude and/or Longitude to calculate the grid and local northings and eastings.
- Type a known Grid Northing and/or Grid Easting to calculate the latitude and longitude and the local northing and easting.
- Type a known Local Northing, Local Easting, or Local Elevation to calculate the latitude and longitude and the grid northing and easting coordinates.

NOTE If you clear the Apply Sea Level Scale Factor check box in the Transformation Settings dialog box, then the Local Elevation box is grayed out.

5 Click the Set Point button to create a new point in your drawing based on the local coordinates that you calculated.

6 Click OK to exit the dialog box.
16

Drawing Lines

You can use the Line commands to draw and manipulate lines in the drawing. These commands draw lines in a variety of methods: by point numbers, in a specific direction, and by best fitting the line between points. You can also extend a line using the Line commands.
Drawing Lines, Curves, and Spirals

To draw lines, curves, spirals, and special lines use the Lines/Curves commands. You can use these commands to draw basic geometry that you can later define as alignments, parcels, or breaklines. When using these commands to draw objects off of existing objects, tangency is guaranteed.

Although you can use the AutoCAD LINE or ARC commands to draw simple lines and curves, these commands provide more complex routines such as Line By Definition which is good for traversing. A set of Special Line symbols is included that you can use to draw lines and curves that use symbol linetypes.

Drawing Lines

You can use the Line commands to draw lines between points or locations determined by direction or angle.

Drawing a Line by Selecting Start and End Points

You can draw a line by selecting locations, entering COGO point numbers, or entering coordinates.

To draw a line by selecting start and end points

1. From the Lines/Curves menu, choose Line.
2. Select the first point of the line.
3. Continue to select points to draw the line.

**NOTE** Type *Undo* to undo the last segment of the line.

4. When you are ready to finish the line, do one of the following:
   - Press ENTER to end the line at the last selected point.
   - Type *C* to unite the end of the last line segment drawn to the start point, which is called closing the line.

The following illustration shows a line drawn by point selection:
Drawing a Line Using a Range of COGO Points

You can draw a line or curve—or a combination of both—between several COGO point numbers.

To draw a line by entering a range of COGO point numbers
1. From the Lines/Curves menu, choose By Point # Range.
2. Type the number of the point at which you want to start the line.
3. Type a hyphen (-).
4. Type the number of the point at which you want to end the line segment. For example:
   Point numbers: 12-15

   **NOTE** You can also draw curves using this command. For more information, see “Drawing a Curve with a Fixed Radius and Start Point” and “Drawing a Curve with Two Fixed Endpoints and a Variable Radius” in this chapter.

5. Press ENTER to end the line at the last selected point.

The following illustration features a line and curve drawn by entering a range of point numbers:

![Line and curve drawn through a range of point numbers](image)

Drawing a Line Using Individual Point Numbers

To draw a line by entering individual point numbers
1. From the Lines/Curves menu, choose By Point # Range.
2. Type the number of the point at which you want to start the line.
3. Type each point number to use in the range, and separate each number with a comma. For example:
   Point numbers: 10,12,13,15,17,20

4. Press ENTER to end the line at the last selected point.

   **NOTE** You can use any combination of these methods to draw the lines and curves. At any time you can press ENTER to end the line/curve.
Drawing a Line Using Individual Point Numbers and a Range of Point Numbers

To draw a line by entering a combination of both individual and a range of point numbers

1. From the Lines/Curves menu, choose By Point # Range.
2. Type the number of the point at which you want to start the line.
3. Do one of the following:
   - To draw part of the line through a discontinuous sequence of points, type each point number to use in the range, and separate each number with a comma. For example:
     
     Point numbers: 1, 3, 10, 12
   - To draw part of the line through a continuous sequence of points, type the beginning and end point numbers for the sequence, separated with a hyphen. For example:

     Point numbers: 1,3,10,12,6-7,26-36

   NOTE: You can also draw curves using this command. For more information, see “Drawing a Curve with a Fixed Radius and Start Point” and “Drawing a Curve with Two Fixed Endpoints and a Variable Radius” in this chapter.

4. Press ENTER to end the line at the last selected point.

Drawing a Curve with a Fixed Radius and Start Point

To draw a curve with a fixed radius and start point

1. From the Lines and Curves menu, choose By Point # Range.
2. At the command prompt, type C.
3. Type the point number that you want to use as the fixed radius point.
4. Type R or L:
   - Type R to specify a right or clockwise curve.
   - Type L to designate a left or counterclockwise curve.

   For example, for a clockwise curve, type:

   Point numbers: 12,13,C14R,15,16

   In this example, the command draws a line from point 12 to 13. Next, it draws a curve from point 13 to point 15 (to the right) using point 14 as the radius point. The command then draws a line to point 16.
   
   For a counter-clockwise curve, type:

   Point numbers: 1-3,C4L,7
Drawing a Curve with Two Fixed Endpoints and a Variable Radius

To draw a curve with two fixed endpoints and a variable radius
1. From the Lines and Curves menu, choose By Point # Range.
2. At the command prompt, type F.
3. Type the point number that you want to use as the variable radius point.
4. Type R or L:
   - Type R to specify a right or clockwise curve.
   - Type L to designate a left or counterclockwise curve.

For example, for a curve to the left, type:
Point numbers: 1-3,F4L,7

For a curve to the right, type:
Point numbers: 12-13,F14R,15,16

In the second example, the command draws a curve from point 13 to point 15, using point 14 as the radius point. However, because points 13 and 15 are fixed, the radius point varies if it is not geometrically correct.

Drawing a Line by Defining a Direction

You can draw a line from a start point to another point in a direction determined by either azimuth, bearing, point numbers, or screen picks and distance.

To draw a line by direction
1. From the Lines/Curves menu, choose By Direction.
2. Select a start point for the line.
3. The following prompt is displayed:
   Quadrant (1-4) (or Azimuth/Points):

   To define the direction, do one of the following:
   - To use a bearing, type a quadrant number. For more information, see “Defining a Line by Bearing” in this chapter.
   - To use an azimuth, type azimuth. For more information, see “Defining a Line by Azimuth” in this chapter.
   - To use point selection, see “Defining a Line by Point Selection” in this chapter.
The following illustration depicts using screen picks to define the direction and distance of the line:

### Defining a Line by Bearing

**To define a line by bearing**

1. Complete steps 1–3 in the previous section, “Drawing a Line by Defining a Direction.”
2. Type the bearing.
3. Type the distance for the line.

The following illustration shows a line drawn by bearing to define the direction and distance:

### Defining a Line by Azimuth

**To define a line by azimuth**

1. Complete steps 1–3 in the previous section, “Drawing a Line by Defining a Direction.”
2. Type the azimuth.
3. Type the distance for the line.
The following illustration shows a line drawn using an azimuth to define the direction:

![Diagram of line drawn using azimuth](image1)

**Defining a Line by Point Selection**

To define a line by point selection
1. Complete steps 1–3 in the previous section, “Drawing a Line by Defining a Direction.”
2. To define the direction of the line, do one of the following:
   - Type two COGO point numbers to define the direction of the line.
   - Click locations in the drawing to define the direction of the line. These can be either COGO points or any random location in your drawing.
3. Type the distance for the line.

The following illustration shows a line drawn by point numbers:

![Diagram of line drawn by point numbers](image2)

**Drawing a Line by Turned or Deflection Angle**

You can draw a line at a turned or deflection angle from a reference line that exists in your drawing.

To draw a line by specifying a turned or deflection angle
1. From the Lines/Curves menu, choose By Turned Angle.

The following prompt is displayed:

Select line (or Points):
2 To select the reference line (or baseline) from which the angle is turned or deflected, do one of the following:
   - Click the reference line near the end you want to draw the new line from. The end nearest to the point you clicked on is marked with a cross (×). This is the point from which the new line is drawn.
   - Type Points and then select the start and end point of the reference line. The first point you select is marked with a cross (×). This is the point from which the new line is drawn.

3 Select the type of angle measurement to use, Deflection or Turned.

4 Type the angle in decimal form in degrees, minutes, and seconds (DDMMSS). If you are working in grads, then enter the angle as a decimal.
   - Type a positive angle to draw the line segment clockwise from the reference line.
   - Type a negative angle to draw the line segment counterclockwise from the reference line.

5 Enter the distance of the line by either typing a distance or selecting two points or locations.

6 Do one of the following:
   - Continue drawing another line from the end of the line you just drew.
   - Press ENTER to start a new line.
   - Press ENTER repeatedly to exit the command.

The following illustration shows a line drawn by turned or deflection angle:

![Line drawn by turned or deflection angle](image)

**Drawing a Line by Station and Offset**

You can draw lines using station and offset information for a defined alignment. You can either draw a line that runs along the alignment (by specifying one offset value for a succession of stations), or draw a line perpendicular to the alignment (by specifying multiple offsets per station).

**To draw a line by station and offset**

1 Draw and define an alignment. For more information about alignments, see Chapter 20, “Alignments.”
2 From the Lines/Curves menu, choose By Station/Offset.
   The following prompt is displayed:
   Enter station:

3 Type the number of the station where you want to begin the line.
   The following prompt is displayed:
   Enter offset:

4 Type the offset value:
   ■ Type a positive offset value to set the point to the right of the alignment based on station progression.
   ■ Type a negative offset value to set the point to the left of the alignment based on station progression.

   The following prompt is displayed:
   Enter offset:

5 Do one of the following:
   ■ Press ENTER to return to the Enter Station prompt, and then type the next station and offset to draw the line along the alignment.
   ■ Type another offset value to draw the line perpendicular (or radial) to the alignment.

   The following illustration shows lines drawn by station and offset that run along the alignment:

   ![Illustration of lines drawn by station and offset from an alignment]

   Line drawn by station and offset from an alignment
Extending or Shortening a Line by a Specified Distance

You can lengthen or shorten a line by a specified distance.

To extend or shorten a line

1. From the Lines/Curves menu, choose Line Extension.
2. Select the line that you want to extend or shorten near the end you want to adjust.

The following prompt is displayed:

`Distance to change (or Total):`

3. To define the length of the line, do one of the following:
   - Select two locations to specify the length that you want to add to the line.
   - Type a positive distance to extend the line.
   - Type a negative distance to shorten the line.
   - Type `T` and then enter the total length of the segment. You can either type the new total length, or select two locations to define the total length. This total length can be greater than (to lengthen the line), or smaller than (to shorten the line), the current length of the line.

The following illustration shows how to extend the length of a line:

```
  EXTENDED SEGMENT
  ENDPOINT OF ORIGINAL LINE
  LINE SELECTION POINT
  LENGTH OF EXTENDED SEGMENT
  LENGTH OF ORIGINAL LINE
```

Drawing Lines from the Ends of Objects

You can draw a line off the end of a curve, spiral, or another line. However, you cannot draw lines from blocks or inserts. The new line is drawn as a separate object on the current layer using the orientation of the selected object.

To draw a line from the end of an object

1. From the Lines/Curves menu, choose From End Of Object.

The following prompt is displayed:

`Select entity (or Points):`

2. Do one of the following:
   - Select the object.
   - Type `PO` and select points to define the object.

The following prompt is displayed:

`Enter length:`
3 Do one of the following:

- Type the length of the line you want to draw.
- Select the end point of the line.
- Type `P` and a COGO point number at which to end the line.

**NOTE** You can press F2 to see the information about the line in the text window.

The following illustration shows a line drawn from the end of a curve:

![Line drawn from the end of a curve](image)

**Drawing a Best Fit Line Through Selected Points**

You can draw a line that passes between a range of points using the method of Least Squares Adjustment. Least squares adjustment averages out the error between the point numbers. For example, you can draw a property line through points that were surveyed as edges of the property line. The Best Fit line averages out the error between the points to create the most accurate line possible.

**To draw a best fitting line**

1. From the Lines/Curves menu, choose Best Fit Line.
   The following prompt is displayed:
   
   _Fit line by (Number/<Selection>):_

2. To select the points, do one of the following:

   - Type `Selection` and then select the COGO point objects. You can use a window or crossing selection to help you select the points. These must be COGO points that exist in the drawing.
   - Type `Number` and then type the COGO point numbers to draw the line between.

   To draw part of the line or curve through a discontinuous sequence of points, type each point number to use in the range, and separate each number with a comma. For example:
   
   **Point numbers:** 1, 3, 10, 12
   
   To draw part of the line or curve through a continuous sequence of points, type the beginning and end point numbers for the sequence, separated with a hyphen.
   
   **Point numbers:** 1, 3, 10, 12, 6-7, 26-36
3 After you complete the selection set, press ENTER.

After you select all the COGO points, the text window displays the point number, assigned error, perpendicular offset to line, and northing/easting coordinates of the points on the line for each point.

The following prompt is displayed:

1-Exclude pt   2-Change error   3-Enter more   4-Draw line   ESC-exit

Press a key (1 2 3 4 or ESC):

4 Do one of the following:

■ Type 1 to remove points from the list. For more information, see “Removing Points from the List for the Best Fit Line” in this chapter.
■ Type 2 to change the assigned error. For more information, see “Changing the Assigned Error of the Best Fit Line” in this chapter.
■ Type 3 to add points to the line. For more information, see “Adding Points to the Best Fit Line” in this chapter.
■ Type 4 to draw the line. For more information, see “Drawing the Best Fitting Line” in this chapter.
■ Press ESC to exit the command.

The following illustration shows a best fit line:

![Best fit line](image)

**Removing Points from the List for the Best Fit Line**

**To remove points from the list for the best fit line**

1 Complete steps 1–3 of the previous section, “Drawing a Best Fit Line Through Selected Points” in this chapter.
2 Type 1 to remove points.
3 Type the number of the COGO point to remove from the list.

The command displays an updated list and then displays the Press a key prompt again.
Changing the Assigned Error of the Best Fit Line

You can change the error value assigned to each point in a best fitting line by assigning either all points an equal error value (which gives each point equal weight when calculating the line) or different error values. Points with smaller errors are weighted more than points with larger errors.

The program assigns all points you selected for the best fit line an error of 1. However, you can assign an error value between 0 and 1000 units to any point. You can hold a point (the line is drawn through that point) by assigning it an error of zero (0).

To change the assigned error of the best fit line

1. Complete steps 1–3 of the previous section, “Drawing a Best Fit Line Through Selected Points” this chapter.
2. Type 2 to change the assigned error.
   
   The following prompt is displayed:
   
   Error option (All/<Individual>):

3. To determine which points to adjust, type Individual or All:
   - Type Individual and then at the following prompts, type the COGO point number and the new error:
     
     Enter the point number to change the error of:
     Enter error for point { # } <1.0000>:

   - Type All to enter new errors for all the points, and then at the following prompts, type the new error or press ENTER to accept the default error value:
     
     Error option (All/<Individual>): A
     Enter error for point 4 <1.000000>; (press ENTER)
     Enter error for point 3 <1.000000>; (press ENTER)
     Enter error for point 2 <1.000000>; .1
     Enter error for point 1 <1.000000>; 0

This example shows that points 3 and 4 are accurate to one unit. Point 2 is accurate to one tenth of a unit. Entering a zero (0) error for point 1 holds this point.

The command displays an updated list and then the Press a key prompt again.

Adding Points to the Best Fit Line

You can add more COGO points to your selection set for calculating the best fitting line.

To add points to the best fit line

1. Complete steps 1–3 of the previous section, “Drawing a Best Fit Line Through Selected Points” in this chapter.
2. Type 3 to add points to the line.
3. Enter the points.

   The command displays an updated list and then the Press a key prompt again.
**Drawing the Best Fitting Line**

**To draw the best fitting line**
1. Complete steps 1–3 of the previous section, “Drawing a Best Fit Line Through Selected Points” in this chapter.
2. Type 4 to draw the line.
3. Press ENTER or SPACEBAR to continue.
   The command displays the text window and the Press a key prompt again.
4. Do one of the following:
   - Continue to edit the point list or the weighting factors.
   - Press ESC to exit the command.

**Drawing a Line Tangent to a Line or Curve**

You can draw a line tangent to a line, curve, or spiral. If you draw a line tangent to a line, then the command draws the line as an extension of the first line segment. You can achieve similar results using the Line Extension command.

**To draw a line tangent to a line or curve**
1. From the Lines/Curves menu, choose Tangent.
2. Select the line or curve.
   When you select the line or curve object, the program marks it with an X at the end closest to the point where you selected it.
3. Select a location from which the line will be drawn.
   This location does not have to be on the object itself, but must be adjacent to it. If this location is not on the object, then the command draws the line from the perpendicular or radial point on the object.
4. Select the second location.
   The distance between the first location and this location defines the tangent length. The command automatically calculates tangency to the curve.
   The following illustration shows a line drawn tangent to a line or curve:

![Line drawn tangent to line or curve](image)
Drawing Lines Radial or Perpendicular to an Object

You can draw a line perpendicular to another line or radial to a curve or spiral section.

To draw a radial or perpendicular line

1. From the Lines/Curves menu, choose Perpendicular.
2. Select the object from which to draw the line.
   When you select the object, the program marks it with an X at the end closest to the point where you selected it.
3. Select a location on the object to specify the start point of the line.
   This location does not have to be on the object, but must be adjacent to the object. If this location is not on the object, then the command draws the line from the perpendicular or radial point on the object.
4. Select another location to define the endpoint of the line.
   The distance between the two locations defines the line length.

The following illustration shows radial and perpendicular lines:

Radial and perpendicular lines
17

Drawing Curves

The Curve commands are used to draw curves. You can draw a curve between two tangents, a curve off of a tangent, a reverse or compound curve, a concentric curve, or a best fit curve using the method of least squares.
Working with Curves

Using the Curve commands, you can draw many different types of curves, including curves between tangents, reverse or compound curves, and best fitting curves between points.

Drawing a Curve Between Two Lines

To draw a curve between two lines
1. From the Lines/Curves menu, choose Curve Between Two Lines.
2. Select the first tangent.
3. Select the second tangent.

The following prompt is displayed:

FACTOR (Length/Tangent/External/Degree/Chord/Mid/MDist/<Radius>):

4. Enter one of the following options to define the curve:
   - **Length**: For more information, see “Defining a Curve by Length” in this chapter.
   - **Tangent**: For more information, see the “Defining a Curve by Tangent Length” in this chapter.
   - **External (Secant)**: For more information, see “Defining a Curve by External Secant” in this chapter.
   - **Degree**: For more information, see “Defining a Curve by Degree of Curve” in this chapter.
   - **Chord**: For more information, see “Defining a Curve by Chord of Length” in this chapter.
   - **Mid (Middle Ordinate Distance)**: For more information, see “Defining a Curve by Middle Ordinate Distance” in this chapter.
   - **MDist (Minimum Distance)**: For more information, see “Defining a Curve by Minimum Distance” in this chapter.
   - **Radius**: For more information, see “Defining a Curve by Radius” in this chapter.

The following illustration shows a curve drawn between two lines, breaking the tangents:
Defining a Curve by Length

To define a curve by length
1 Complete steps 1–3 of “Drawing a Curve Between Two Lines” in this chapter.
2 Type Length to define the curve by length.
3 Specify the length of the curve by either typing a value or using your pointing device to select two points.

Defining a Curve by Tangent Length

To define a curve by tangent length
1 Complete steps 1–3 of “Drawing a Curve Between Two Lines” in this chapter.
2 Type Tangent to define the curve by tangent length.
3 Specify the tangent length by either typing a value or using your pointing device to select two points.

Defining a Curve by External Secant

To define a curve by external secant
1 Complete steps 1–3 of “Drawing a Curve Between Two Lines” in this chapter.
2 Type External to define the curve by external secant.
3 Specify the external secant by either typing a value or using your pointing device to select the secant.

Defining a Curve by Degree of Curve

To define a curve by degree of curve
1 Complete steps 1–3 of “Drawing a Curve Between Two Lines” in this chapter.
2 Type Degree to define the curve by degree of curve.
   The following prompt is displayed:
   DEFINITION (Chord/<Curve>):
3 To specify how the curve is defined, type Chord or Curve:
   ■ Type Chord if the curve is a railway curve. For a railway curve, the degree of curve is the angle at the center of a circular curve subtended by a chord of 100 units.
   ■ Type Curve if the curve is a roadway curve. For a roadway curve, the degree of curve is the central angle subtended by a circular curve of 100 units.
4 Type the degree of curve in DDMMSS format.
Defining a Curve by Chord Length

To define a curve by chord length
1. Complete steps 1–3 of “Drawing a Curve Between Two Lines” in this chapter.
2. Type Chord to define the curve by chord length.
3. Specify the chord length by typing a value or by selecting two points with your pointing device.

Defining a Curve by Middle Ordinate Distance

To define a curve by middle ordinate distance
1. Complete steps 1–3 of “Drawing a Curve Between Two Lines” in this chapter.
2. Type Mid to define the curve by the middle ordinate distance.
3. Specify the middle ordinate distance by either typing a value or using your pointing device to select two points.

Defining a Curve by Minimum Distance

You can draw a curve between two lines that are a minimum distance from an existing curve in your drawing.

To define a curve by minimum distance
1. Complete steps 1–3 of “Drawing a Curve Between Two Lines” in this chapter.
2. Type Mdist to define the curve by minimum distance.
3. Select the end of an existing curve.
   The command sets the Object Snap to END for this prompt. The point you select does not have to be on an existing curve; it can be any point along the adjacent tangent.
4. Enter the minimum distance between the end of the new curve and the point selected on the existing curve.
   For example, if you need a minimum distance of 200 feet from the end of a curve to an intersection, then select the intersection at step 3. At step 4, type 200. The command calculates a curve ending 200 units from the intersection.

Defining a Curve by Radius

To define a curve by radius
1. Complete steps 1–3 of “Drawing a Curve Between Two Lines” in this chapter.
2. Type Radius to define a curve by radius.
3. Specify the radius by either typing a value or using your pointing device to select two points.
Drawing a Curve on Two Lines

You can join two lines to create a curve and leave the lines intact.

**To draw a curve and leave the lines intact**

1. From the Lines/Curves menu, choose Curve On Two Lines.
2. Select the first line.
3. Select the second line.
4. Specify the radius by either typing a value or using your pointing device to select two points.

**NOTE** If the computed curve is too large for the selected lines an error message is displayed. Select the lines again and enter a smaller radius.

If you define this curve as part of an alignment, then you can station the alignment along the curves and not through the point of intersection. To station the alignment along the curves and not through the point of intersection, break the tangent before you define the alignment. To do this, use the BREAK command as follows:

```
Command: BREAK
Select object: (select line)
Enter second break point (or First point): F
Enter first break point: END
of (select curve near PC (BC) point)
Specify second break point: @
```

The at symbol (@) indicates that the second point is the same as the first. This breaks the line at that single point without removing any of the line.

The following illustration shows a curve drawn on two lines:

![Curve drawn between two lines without breaking lines](image)

Drawing a Curve Through a Point

You can draw a curve between two tangents that passes through a selected point.

**To draw a curve through a point**

1. From the Lines/Curves menu, choose Curve Through Point.
2. Select the two tangents from which the curve is drawn.
3. Select the point through which the curve is drawn.

The curve is drawn and information about the curve is listed at the command line.
The following illustration shows a curve drawn through a point:

![Curve drawn through point](image)

**Drawing Multiple Curves**

You can draw multiple curves between lines. You can use this command as an alternative to designing alignment curves with spiral sections. This command has a limit of ten curves.

**To draw multiple curves**

1. From the Lines/Curves menu, choose Multiple Curves.
2. Select the two lines from which the curves are drawn.
3. Type the number of curves to draw between the lines.
4. Specify which curve will have the floating length. One curve in the set must have a floating length. This is usually the middle curve.

The command prompts you to enter the radius and length of each curve.

```
Enter curve 1 Radius:
Length:
```

5. Enter the radius and length for each curve.

These prompts repeat for all but the floating curve. The command prompts only for the radius of the floating curve because the length is determined by the lengths and radii of the other curves.

The curve is then drawn from the specified parameters.

The following illustration shows multiple curves:

![Multiple curves](image)
Drawing a Curve From the End of an Existing Object

You can draw a curve that extends from the end point of an existing line, curve, or spiral.

To draw a curve from the end of an object

1. From the Lines/Curves menu, choose From End of Object.
2. Select the object near the end from which to draw the curve.

The command uses the ending angle of the original object for referencing the new curve.

The following prompt is displayed:

Select entry (Radius/Point) <Radius>:

3. Type **Radius** or **Point**:
   - Type **Radius** to draw the curve based on the radius. For more information, see “Drawing a Curve Based on Radius” in this chapter.
   - Type **Point** to draw the curve through a selected point.

4. Select the point for the curve to pass through.
5. Specify the length of the curve.

The following illustration shows a curve drawn from the end of an object:

![Curve drawn from an existing object](image)

---

Drawing a Curve Based on Radius

To draw a curve based on radius

1. Complete steps 1–2 of “Drawing a Curve From the End of an Existing Object” in this chapter.

2. Type **Radius** to draw the curve based on the radius.

The following prompt is displayed:

Enter Radius (or Degree):

3. Do one of the following:
   - Type a positive radius to draw the curve clockwise.
   - Type a negative radius value to draw the curve counter-clockwise.
   - Select two points to define the radius.
   - Type **Degree** to enter the degree of curvature.

The following prompt is displayed:

Select entry (Tan/Chord/Delta/Length/Ext/Mid) <Length>:
4 Do one of the following to define the curve:
   ■ Type Length and then the curve length.
   ■ Type Tan and then the tangent length.
   ■ Type Chord and then the chord length.
   ■ Type Delta and then the delta angle.
   ■ Type Ext and then the external secant.
   ■ Type Mid and then the Middle Ordinate Distance.

Drawing a Reverse or Compound Curve
The Reverse or Compound command draws a reverse or compound curve from
the endpoint of an existing curve.
A reverse curve is an S-shaped curve. A compound curve is a curve consisting of
two or more arcs of different radii curving in the same direction and having a
common tangent or transition curve at their point of junction.

NOTE There must be an existing curve in the drawing from which to draw the
      new curve.

To draw a reverse or compound curve
1 From the Lines and Curves menu, choose Reverse or Compound.
2 Select a curve.
3 Specify whether to draw a compound or reverse curve from the original endpoint
   of the curve.
4 Select a radius and another factor of the curve.
   The command calculates and draws the curve. The new curve is drawn on the
current layer.

Drawing a Best Fitting Curve Through Points
You can draw a curve between several COGO points, using the method of least
squares to calculate where to draw the curve.

To draw a best-fitting curve
1 From the Lines/Curves menu, choose Best Fit Curve.
   The following prompt is displayed:
   Fit curve by (Number/<Selection>):
2 To select the points, type Selection or Number:
   ■ Type Selection and then select the COGO points with your pointing device.
     You can use a window or crossing selection to help you select the points.
     These must be COGO points that exist in the drawing.
   ■ Type Number and then type the COGO point numbers.
After you select all the points, press ENTER.

After you select all the points, the text window displays the point number, assigned error, radial offset to curve, northing/easting coordinates of the points on the curve, and the following prompts:

- `1-Exclude pt`
- `2-Change error`
- `3-Enter more`
- `4-Draw curve`
- `ESC-exit`

Press a key (1 2 3 4 or ESC):

4 Do one of the following:

- Type 1 to remove points from the list. For more information, see “Removing Points from the List for the Best Fit Curve” in this chapter.
- Type 2 to change the assigned error. For more information, see “Changing the Assigned Error for the Best Fit Curve” in this chapter.
- Type 3 to add points to the curve. For more information, see “Adding Points to the Best Fit Curve” in this chapter.
- Type 4 to draw the curve. For more information, see “Drawing a Best Fitting Curve” in this chapter.
- Press ESC to exit the command.

The following illustration shows a best-fitting curve drawn between points that represent objects on the terrain such as surveyed points along an existing road centerline:

![Best fit curve illustration](image)

### Removing Points from the List for the Best Fit Curve

**To remove a point from the list**

1. Complete steps 1–3 of the previous section, “Drawing a Best Fitting Curve Through Points” of this chapter.
2. Type 1 to remove points from the list.
3. Type the number of the COGO point to remove from the list.

The command displays an updated list and then the Press a key prompt again.
Changing the Assigned Error for the Best Fit Curve

You can change the error value assigned to each COGO point in a best fitting curve by assigning either all points an equal error value (which gives each point equal weight when calculating the curve) or different error values. Points with smaller errors are weighted more than points with larger errors.

The program assigns all points you selected for the best fit curve an error of 1. However, you can assign an error value between 0 and 1000 units to any point. You can hold a point (the curve is drawn through that point) by assigning it an error of zero (0).

To change the error of a point

1. Complete steps 1–3 of the previous section, “Drawing a Best Fitting Curve Through Points” of this chapter.
2. Type 2 to change the assigned error.
   The following prompt is displayed:
   Error option (All/<Individual>):
   3. To determine which points to adjust, type Individual or All:
      ■ Type Individual and then at the following prompts, type the point number and the new error:
      Enter the point number to change the error of: 
      Enter error for point { # } <1.0000>: 
      ■ Type All to enter new errors for all the points, and then at the following prompts, type the new error or press ENTER to accept the default error value:
      Enter error for point 4 <1.000000>: (press ENTER) 
      Enter error for point 3 <1.000000>: (press ENTER) 
      Enter error for point 2 <1.000000>: .1
      Enter error for point 1 <1.000000>: 0

This example shows that points 3 and 4 are accurate to one unit. Point 2 is accurate to one tenth of a unit. Entering a zero (0) error for point 1 holds this point. The command displays an updated list and then the Press a key prompt again.

Adding Points to the Best Fit Curve

You can add more points to your selection set for calculating the best fitting curve.

To add points

1. Complete steps 1–3 of the previous section, “Drawing a Best Fitting Curve Through Points” in this chapter.
2. Type 3 to add points to the best fit curve.
3. Enter the points to add.
   The command displays an updated list and the Press a key prompt again.
Drawing a Best Fitting Curve

To draw a best fitting curve

1. Complete steps 1–3 of the previous section, “Drawing a Best Fitting Curve Through Points” in this chapter.
2. Type 4 to draw the best fit curve.
3. Press ENTER or SPACEBAR to continue.
   
   The command displays the text window and the Press a key prompt again.
4. Do one of the following:
   ■ Continue to edit the point list or the weighting factors.
   ■ Press ESC to exit the command.
18

Drawing Spirals

With the Spiral commands, you can draw a variety of spiral types, including cothoid, quadratic, cosinusoidal, and sinusoidal. You can draw spirals between two tangents, between tangents and curves, and between two curves. You can also attach spirals off the end of a tangent or curve, or between a tangent and a point.

There are commands provided to change the speed table storage path, edit a speed table, and create spiral curves using a speed table to calculate superelevation.
Working with Spirals

In modern transportation design, vehicle dynamics, as well as safety and comfort considerations, dictate the need to avoid abrupt changes in horizontal curvature. Such changes, which are encountered where a tangent meets a circular curve, or at points of compound curvature, can be avoided by the introduction of a general class of curves called spirals or "transition" curves. A spiral also provides the logical location for the introduction of superelevation so that it matches the local curvature of the alignment at every point.

In response to the needs of many roadway designers, AutoCAD Land Development Desktop includes a complete set of spiral design and computational tools.

A spiral is a curve comprised of short segments that have differing rates of curvature or radius. You must use the AutoCAD Land Development Desktop commands to create spirals. All AutoCAD Land Development Desktop commands expect spirals to meet certain design criteria. If the spirals do not meet these criteria, then the commands do not process the spirals properly. Even though a spiral returns polyline information when listed using the LIST command, you cannot create them with the PLINE command. If the horizontal alignment includes spirals, you must define the alignment using the Define from Objects command. Using the PEDIT command to join a spiral with other objects causes the spiral definition to be lost.

The spiral commands are divided into two categories: Fit and Attach. The Fit commands create spirals between two objects; the Attach commands extend a spiral from the end of a selected object.

When drawing spirals, do the following:

■ The spiral commands prompt for either a length or spiral A parameter. The A parameter describes the flatness of the spiral, and is a commonly used metric parameter that equals the square root of the product of the length and the radius. To use the A value, type A at the First spiral length (or A) and/or Second length (or A) prompt, and then enter the “A” value.
■ When attaching spirals or curves to an object, entering a positive radius draws the spiral or curve to the right (clockwise), and entering a negative radius draws the spiral or curve to the left (counter-clockwise).
■ All the options in the Attach Spiral command prompt you for a radius or degree of curvature. The degree of curvature is not generally used as spiral parameter, but if you attach a spiral in or out of a curve and know the degree of curvature but not the radius, then the options calculate the radius of the spiral from the degree of curvature.
Selecting the Current Spiral Type

You can choose the current spiral type: clothoidal, sinusoidal, cosinusoidal, or quadratic. Any command that creates a spiral uses the equations for the current spiral type. Changing the type of spiral does not affect the definition of existing spirals. All existing spirals retain their original definitions if you change the spiral type in the middle of a project. The default spiral type is clothoidal. This spiral type meets the needs of most design cases. For more information about spirals, see “Drawing Spirals” in this chapter.

To select the spiral type

1. Do one of the following to display the Alignment Values dialog box:
   - From the Lines/Curves menu, choose Create Spirals ➤ Spiral Type.
   - From the Projects menu, choose Drawing Settings to display the Drawing Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Spiral Type and then click the Edit Settings button.

2. Select a spiral type:
   - **Clothoid**: For more information, see “Clothoid Spirals” in this chapter.
   - **Sinusoid**: For more information, see “Quadratic, Cosinusoidal, and Sinusoidal Spirals” in this chapter.
   - **Cosinusoid**: For more information, see “Quadratic, Cosinusoidal, and Sinusoidal Spirals” in this chapter.
   - **Quadratic**: For more information, see “Quadratic, Cosinusoidal, and Sinusoidal Spirals” in this chapter.

3. Click OK.
Drawing Spirals Between Two Lines

You can draw spirals between two lines, either with or without an intermediate curve.

Drawing Two Spirals and an Intermediate Curve Between Two Tangents

You can create two spirals and the associated circular curve between two tangents. The spirals can be either symmetrical or asymmetrical.

To draw two spirals and an intermediate curve between two tangents

1. From the Lines/Curves menu, choose Create Spirals ➤ Fit Tangent-Tangent. The Fit Spirals - Tangent to Tangent icon menu is displayed.

2. From the Description list box, click Spiral-Curve-Spiral.

3. Click OK.

4. Select the tangents into and out of the curve.

   The following prompt is displayed:

   Enter radius (or Degree):

5. Do one of the following:

   ▪ Enter the radius. If you enter a negative radius value, then the command draws a clover leaf.

   ▪ Type Degree and enter the degree of curve.

   The following prompt is displayed:

   Spiral Length in (or A):

6. To define the spiral length or A value, do one of the following:

   ▪ Enter the spiral length.

   ▪ Type A, and then type the A value.

7. Repeat step 6 for the second spiral.
NOTE You can press F2 to view the text window, where the spiral data is listed.

The following illustration shows two spirals and the associated circular curve between two tangents:

![Two spirals and an intermediate curve](image)

**Drawing Two Spirals Between Two Tangents Without an Intermediate Curve**

You can draw two spirals between two tangents without a circular curve between them. The spirals can be either symmetrical or asymmetrical.

**To draw two spirals between two tangents**

1. From the Lines/Curves menu, choose Create Spirals ➤ Fit Tangent-Tangent to display the Fit Spirals - Tangent to Tangent icon menu.
2. From the Description list box, click Spiral-Spiral.
3. Click OK.
4. Select the tangents to be joined with the spirals.

The following prompt is displayed:

*Lengths/Radius <Radius>:*
Do one of the following:

- Type Lengths and then enter the spiral length in and length out.
- Type Radius and then enter the radius of the spirals where they intersect.
- Type Radius and then type Degree and enter a degree value.

**NOTE** You can press F2 to view the spiral data in the text window.

The following illustration shows two spirals between two tangents without a circular curve between them:

Two spirals without an intermediate curve

**Drawing Spirals Between Tangents and Curves**

To draw spirals between tangents and curves, you can either fit a spiral between a tangent and a curve, or fit a spiral, curve, compound spiral, and reverse spiral between a tangent and a curve.

**Drawing a Spiral Between a Tangent and a Curve**

You can draw a spiral between a tangent and circular curve.
To draw a spiral between a tangent and a curve

1. From the Lines/Curves menu, choose Create Spirals ➤ Fit Tangent-Curve to display the Fit Spirals - Tangent to Curve icon menu.

2. From the Description list box, click Spiral.
3. Click OK.
4. Select the tangent nearest to the end that is to be trimmed.
5. Select the curve (this curve must be close to the tangent but not cross it).

The required spiral length is unique and calculated by the command. The command draws the spiral and then displays information about it.

**NOTE** You can press F2 to view the spiral data in the text window.

The following illustration shows a spiral between a tangent and circular curve:
Drawing a Spiral, Curve, Compound Spiral, and a Reverse Spiral Between a Tangent and a Circular Curve

You can fit a spiral, curve, compound spiral, and reverse spiral between a tangent and a circular curve. The tangent and curve are trimmed to fit the new objects.

1. From the Lines/Curves menu, choose Create Spirals ➤ Fit Tangent-Curve to display the Fit Spirals - Tangent to Curve icon menu.
2. From the Description list box, click Spi-Crv-Spi-Rev-Spi.
3. Click OK.
4. Select the tangent nearest to the end of the new spiral.
5. Select the curve (this curve can be crossing the tangent).

The following prompt is displayed:

Tangent Spiral Length (or A):

6. Do one of the following:
   - Enter both the spiral length in and length out (for the spiral starting at the tangent).
   - Type A, and then type the spiral A value.

The following prompt is displayed:

Enter floating curve radius (or degree):

7. Do one of the following:
   - Enter the radius for the floating curve (the floating curve radius is the radius of the new circular curve between the two spirals).
   - Type Degree, and then enter the degree value of the floating curve.

The following prompt is displayed:

Reverse Spiral Length (or A):

8. Do one of the following:
   - Enter both the spiral length in and length out (for the reverse spiral).
   - Type A, and then type the spiral A value.

The compound spiral length is calculated based on the other parameters.

NOTE: You can press F2 to view the spiral data in the text window.
The following illustration shows a spiral, curve, compound spiral, and reverse spiral between a tangent and a circular curve:

Drawing Spirals Between Two Curves

You can draw spirals between two curves several ways. You can fit spirals either in various combinations between two curves or between a curve and a reverse curve.

Drawing a Tangent and Two Spirals Between Two Curves, Using the Spiral Lengths as the Control Factors

You can fit a tangent and two spirals between two curves.
To fit a tangent and two spirals between two curves

1. From the Lines/Curves menu, choose Create Spirals ➤ Fit Curve-Curve to display the Fit Spirals - Curve to Curve icon menu.

2. From the Description list box, click Spi-Tan-Spi (s).
   The (s) in the command name means that the spiral lengths (or A values) are the controlling factor.

3. Click OK.

4. Select the first curve nearest the end to which the spiral is fit.

5. Select the second curve. It does not matter which end of the second curve you select.
   The following prompt is displayed:
   First spiral length (or A):

6. Do one of the following:
   ■ Enter the length of the first spiral.
   ■ Type A, and then type an A value.

7. Repeat step 5 for the second spiral length.
   The command calculates the length and orientation of the tangent to fit between the spiral sections.

   NOTE: You can press F2 to view the spiral data in the text window.
The following illustration features a tangent and two spirals drawn between two curves:

**Drawing a Tangent and Two Spirals Between Two Curves, Using the Tangent Length as the Control Factor**

You can fit a tangent and two spirals between two curves.

To fit a tangent and two spirals between two curves

1. From the Lines/Curves menu, choose Create Spirals ➤ Fit Curve-Curve to display the Fit Spirals - Curve to Curve icon menu.
2. From the Description list box, click Spi-Tan-Spi (t).
   - The (t) in the command name means that the tangent length is the controlling factor.
3. Click OK.
4. Select the first curve nearest the end to which the spiral is fit.
5. Select the second curve. It does not matter which end of the second curve you select.
   - The following prompt is displayed:
     
     **Tangent length:**

6. Enter the length of the tangent. You can define the tangent length by either entering a length or selecting two locations on screen.
   - This option calculates the length and orientation of the spiral sections on either side of the tangent.
You can press F2 to view the spiral data in the text window.

The following illustration shows spirals when tangent length is greater than zero:

![Spirals when tangent length is greater than zero]

The following illustration shows resulting spirals when tangent length is zero:

![Spirals when tangent length is zero]
Drawing Spirals Between Two Curves

Drawing a Tangent and Two Spirals Between a Curve and a Reverse Curve, Using the Spiral Lengths as the Control Factors

You can fit a tangent and two spiral segments between a curve and a reverse curve.

To fit a tangent and two spirals between a curve and a reverse curve

1. From the Lines/Curves menu, choose Create Spirals ➤ Fit Curve-Curve to display the Fit Spirals - Curve to Curve icon menu.
2. From the Description list box, click Rev Spi-Tan-Spi (s).
   The (s) in the command name means that the spiral lengths are the controlling factors.
3. Click OK.
4. Select the first curve nearest the end to which the spiral is fit.
5. Select the second curve. It does not matter which end of the second curve you select.
   The following prompt is displayed:
   **First spiral length (or A):**
6. Do one of the following:
   - Enter the length of the first spiral.
   - Type A, and then type an A value.
7. Repeat step 6 for the second spiral length.
   The option calculates the length and orientation of the tangent to fit between the spiral sections.

**NOTE** You can press F2 to view the spiral data in the text window.
The following illustration features spirals and a tangent created with the Rev Spi-Tan-Spi(s) option:

Spirals and tangent created with the Rev Spi-Tan-Spi(s) option

Drawing a Tangent and Two Spirals Between a Curve and a Reverse Curve, Using the Tangent Length as the Control Factor

You can fit a tangent and two spiral segments between a curve and a reverse curve.

To fit a tangent and two spirals between a curve and a reverse curve

1. From the Lines/Curves menu, choose Create Spirals ➤ Fit Curve-Curve to display the Fit Spirals - Curve to Curve icon menu.

2. From the Description list box, click Rev Spi-Tan-Spi (t).
   The (t) in the command name means that the tangent length is the controlling factor.

3. Click OK.

4. Select the first curve nearest the end to which the spiral is fit.

5. Select the second curve. It does not matter which end of the second curve you select.
   The following prompt is displayed:
   
   **Tangent length:**

6. Enter the length of the tangent. You can define the tangent length by either entering a length or selecting two reference points from the graphics screen.
   The command calculates the length and orientation of the spiral sections on either side of the tangent.

**NOTE** You can press F2 to view the spiral data in the text window.
The following illustration shows spirals and a tangent whose length is greater than zero:

![Resulting spirals and tangent when the tangent length is greater than zero]

The following illustration features spirals and a tangent whose length is zero:

![Resulting spirals and tangent when the tangent length is zero]

**Drawing a Compound Spiral Between Two Curves**

You can draw a compound spiral between two curves. The path of the smaller curve must be reasonably close to, and completely within, the larger curve. If the paths of the curves intersect, then the spiral has no solution.

**NOTE** Compound spirals are only supported when using a clothoid spiral type. No matter what spiral type is set, the command always uses the clothoid spiral type.
To draw a compound spiral between two curves

1. From the Lines/Curves menu, choose Create Spirals ➤ Fit Curve-Curve to display the Fit Spirals - Curve to Curve icon menu.
2. From the Description list box, click Compound Spiral.
3. Click OK.
4. Select the first curve (the outer curve).
5. Select the second curve (the inner curve).

The following prompt is displayed:

Compound spiral direction (Left/Right) <Right>:

6. Type Right or Left:
   - Type Right if the compound spiral starts from the larger of the two curves and curve right (clockwise).
   - Type Left if the compound spiral starts from the larger of the two curves and curve left (counterclockwise).

The option draws the compound spiral and then displays information about it.

NOTE You can press F2 to view the spiral data in the text window.

A spiral cannot have a deflection angle greater than 180 degrees. If the deflection angle of the full spiral (the compound spiral projected out to the tangent) is greater than 180 degrees, then a message displays stating that the spiral angle is greater than 180 degrees.

The following illustration shows a compound spiral:
Drawing a Curve and Two Compound Spirals Between Two Curves

You can fit a circular curve and two compound spiral segments between two curves. Compound spirals are supported only when using a clothoid spiral type. No matter what spiral type is set, the command always uses the clothoid spiral type.

To draw a curve and two compound spirals
1. From the Lines/Curves menu, choose Create Spirals ➤ Fit Curve-Curve to display the Fit Spirals - Curve to Curve icon menu.
2. From the Description list box, click Comp Spi-Crv-Spi.
3. Click OK.
4. Select the first curve.
5. Select the second curve.

The following prompt is displayed:
First curve's spiral length (or A):

6. Do one of the following:
   ■ Enter the length of the first spiral.
   ■ Type A, and then type an A value.

7. Repeat step 5 for the second spiral.

The following prompt is displayed:
Enter floating curve radius (or degree):

8. Do one of the following:
   ■ Enter the radius of the floating curve between the spiral segments.
   ■ Type Degree and the degree of curvature.

NOTE You can press F2 to view the spiral data in the text window.
The following illustration features a curve and two compound spirals:

Curve and two compound spirals

**Drawing a Curve and Two Reverse Spirals Between Two Curves**

You can fit a circular curve and two sets of reverse spirals between two curves.

**To draw a curve and two reverse spirals**

1. From the Lines/Curves menu, choose Create Spirals ➤ Fit Curve-Curve to display the Fit Spirals - Curve to Curve icon menu.
2. From the Description list box, click Quad Spiral.
3. Click OK.
4. Select the first curve.
5. Select the second curve.
   The following prompt is displayed:
   
   First curve’s spiral Length (or A):

6. Do one of the following:
   - Enter the length of the first spiral.
   - Type A, and then type an A value.

7. Repeat step 5 for the second spiral.
   The following prompt is displayed:
   
   Enter floating curve radius (or Degree):
8 Do one of the following:
   - Enter the radius of the floating curve between the spiral segments.
   - Type Degree and the degree of curvature.

NOTE You can press F2 to view the spiral data in the text window.

The following illustration features reverse spirals and an intermediate curve:

Reverse spirals and the intermediate curve
Attaching Spirals to Objects

Several options are available for attaching spirals off the ends of objects.

Drawing a Spiral off the End of a Tangent

You can attach a spiral to the nearest end of a selected tangent starting with the point of intersection between the spiral and tangent (TS) and ending with the point of intersection between the spiral and curve (SC).

NOTE Although you can use the method described as follows to attach the spiral to any tangent, curve, or spiral, the command is intended to be used to attach the spiral to the end of a tangent, with the spiral leading into a curve.

To draw a spiral off the end of a tangent

1. From the Lines/Curves menu, choose Create Spirals ➤ Attach Spiral to display the Attach Spirals icon menu.

2. From the Description list box, click Spiral In.

3. Click OK.

4. Select the tangent.

   The following prompt is displayed:

   Enter length (or A):

5. Do one of the following:

   ■ Enter the length of the first spiral.
   ■ Type A, and then type an A value.

   The following prompt is displayed:

   Enter radius (or degree):
6. Do one of the following:

- Enter the radius (at the end of the spiral where it connects to a curve).
- Type Degree and the degree of curvature.

**NOTE** You can press F2 to view the spiral data in the text window.

The following illustration shows a spiral drawn from the end of a tangent:

![Spiral drawn off the end of a tangent](image)

### Drawing a Spiral off the End of a Curve

You can attach a spiral to the nearest end of a selected curve starting with the point of intersection between the curve and spiral (CS) and ending with the point of intersection between the spiral and tangent (ST).

Although you can use the method described as follows to attach the spiral to any tangent, curve, or spiral, the command is intended to be used to attach the spiral to the end of a curve or spiral, with the spiral leading out of a curve into a tangent.

**To draw a spiral off the end of a curve**

1. From the Lines/Curves menu, choose Create Spirals ➤ Attach Spiral to display the Attach Spirals icon menu.
2. From the Description list box, click Spiral Out.
3. Click OK.
4. Select the curve.

The following prompt is displayed:

Enter Radius <default radius> (or degree):

5. Do one of the following:

- Press ENTER to accept the default radius, which is the radius of the selected curve.
- Type a new radius.
- Type Degree and the degree of curvature.

The following prompt is displayed:

Enter length (or A):
Do one of the following:

- Enter the length of the spiral.
- Type A, and then type an A value.

The following illustration features a spiral drawn from the end of a curve:

![Spiral drawn off the end of a curve]

**Drawing a Spiral Between a Tangent and a Point**

You can draw a spiral to a selected point. You can start the spiral at the point of intersection between the tangent and spiral (TS), and end the spiral at the point of intersection between the spiral and curve (SC). Although you can use the method described as follows to attach the spiral to any tangent, curve, or spiral, the command is intended to be used to attach the spiral to the end of a tangent, with the spiral leading out of a tangent to a point.

**To draw a spiral between a tangent and a point**

1. From the Lines/Curves menu, choose Create Spirals ➤ Attach Spiral to display the Attach Spirals icon menu.
2. From the Description list box, click Spiral to Point.
3. Click OK.
4. Select the tangent (or other object).
5. Select the point to which the spiral is drawn. For more information, see “Selecting Points and Locations” in Chapter 11, “Creating Points.”

The point you select can be the end of a curve, a COGO point, or a random location in your drawing. The command calculates the unique spiral length required.

The following illustration shows a spiral drawn from a tangent to a point:

![Spiral drawn from a tangent to a point]
Drawing a Compound Spiral off the End of a Curve

You can attach a compound spiral to the end of a selected object. Although you can use any object, this command is intended to attach a compound spiral to a curve and, in turn, have another curve attached to it.

To draw a compound spiral off the end of a curve

1. From the Lines/Curves menu, choose Create Spirals ➤ Attach Spiral to display the Attach Spirals icon menu.
2. From the Description list box, click Compound Spiral.
3. Click OK.
4. Select the curve.

The following prompt is displayed:

```
Enter radius at object selected <-289.3932> (or Degree):
```

5. Do one of the following:
   ■ Press ENTER to accept the default radius, which is the radius of the selected curve.
   ■ Type a new radius.
   ■ Type Degree and type the degree of curvature.

The following prompt is displayed:

```
Enter length (or A):
```

6. Do one of the following:
   ■ Enter the length of the compound spiral.
   ■ Type A, and then type an A value.

The following prompt is displayed:

```
Enter ending radius (or degree):
```

7. Enter the ending radius or degree of curve to finish the definition of the compound spiral.
Chapter 18  Drawing Spirals

The following illustration features a compound spiral off the end of a curve:

Creating Spirals Using Speed Tables

Speed tables are common references found in various publications on highway design. A speed table for a horizontal alignment includes a design speed with a list of the following: degree of curve, radius, superelevation rate ($e$), spiral length or a factor for 2-lane designs, and spiral length or A factor for 4-lane designs.

AutoCAD Land Development Desktop provides several speed tables with common superelevation rates. These speed tables include the American Association of State Highway and Transportation Officials (AASHTO), Canadian RTAC, and Malaysian standards. You can modify these speed tables and also create new tables if needed.

You can use these speed tables to automatically calculate superelevation values for a spiral curve as you draw it. You can use this superelevation information when using Autodesk Civil Design.

Speed tables are stored in a folder in the following:

```
c:\Program Files\Land Desktop R2\data\speed tables
```

All commands that use speed tables reference this folder. If you want to share speed tables on a network, or if you move the speed table files, then you must update the path to this folder by changing the speed table path.

Changing the Speed Table Storage Path

The speed table path is set to the location that contains the default speed tables that are included with AutoCAD Land Development Desktop. By default this path is set to `c:\Program Files\Land Desktop R2\data\speed tables`. You must change this path if you move the speed table databases. You can also change this path if you work on a network and want to share the speed tables with multiple people. All speed tables have the extension .sup.
We recommend that you maintain the speed table path as a project-based setting. All drawings associated with a project should have the same path because they should use the same speed tables.

**To change the speed table path**

1. From the Lines/Curves menu, choose Speed Tables ➤ Set Table Path to display the Speed Table Path dialog box.

   ![Image](https://via.placeholder.com/150)

   The Root path lists the path that is currently set for the speed tables. By default, the User Preferences Speed Tables root path check box is selected and the Path box is empty. When the User Preferences Speed Tables root path is selected, the Root path is derived from a program settings file, the sdsk.dfm file. The default path, c:\Program Files\Land Desktop R2\data\speed tables, is stored in this file.

2. Do one of the following:

   - Clear the User Preferences Speed Tables root path check box if you do not want to use the default root path.
   - Select the User Preferences Speed Tables root path check box to use the default root path.
   - If you work on a network, see “Using Advanced Speed Table Path Settings” in this chapter for information about the User Preferences Speed Tables root path check box.

3. In the Path box, enter the path where the speed tables are located.

   - If you cleared the User Preferences Speed Tables root path check box, then enter the entire path in the Path box. For example, c:\Speed Tables.
   - If you selected the User Preferences Speed Tables root path check box, then type the path you want to append to the root path. For example, subdivision project.

   The updated Table path displays at the bottom of the dialog box, listing the entire path derived from either the Path box or a combination of the Root path and the Path boxes. In the second previous example, the Table path box would list c:\Program Files\Land Desktop R2\data\speed tables\subdivision project.

4. Click OK.
Default Speed Tables

AutoCAD Land Development Desktop includes the following speed tables. For example, AASHTO 4 is the AASHTO speed table for the maximum superelevation rate of 0.04.

- AASHTO 4 \( \text{emax} = 0.04 \)
- AASHTO 6 \( \text{emax} = 0.06 \)
- AASHTO 8 \( \text{emax} = 0.08 \)
- AASHTO 10 \( \text{emax} = 0.010 \)
- AASHTO 12 \( \text{emax} = 0.012 \)
- RTAC Canada Table B.3.1.4a \( \text{emax} = 0.04 \)
- RTAC Canada Table B.3.1.4b \( \text{emax} = 0.06 \)
- RTAC Canada Table B.3.1.4c \( \text{emax} = 0.08 \)
- Malaysia Table 4–4C: \( \text{emax} = 0.060 \)
- Malaysia Table 4–4C: \( \text{emax} = 0.010 \)
- Malaysia Table 4–4A: (Rural)
- Malaysia Table 4–4B: (Urban)

Using Advanced Speed Table Path Settings

Sometimes a fixed speed table path does not work for everyone. For example, if you plan to store the speed table files on a network, then each person has to map to the drive on which the tables are stored, using the same drive letter.

To have more flexibility you can use the User Preferences Speed Tables root path option and then edit the default path that is located in the sdsk.dfm file.

For example, if one person mounts the drive as j: \ and another person mounts it as k: \, then a fixed table path works for one, but not the other. By storing the path in the sdsk.dfm file, each person has a unique path pointing to the same table folder. The first person can set the User Preferences key to j: \ and the second person can set it to k: \. They can then set the path in the Path edit box to the portion of the path common to all. By entering tables \ in the path field, the first person can find the tables in j: \tables and the second person would find the same tables with the path k: \tables.

**NOTE** Although the User Preferences option was added to support multi-user environments, you can also use it for single-user systems.

**To use the User Preferences Speed Tables root path**

1. From the Lines/Curves menu, choose Speed Tables ➤ Set Table Path.
2. Select the User Preferences Speed Tables root path check box.

**NOTE** If you entered a path in the Path box, then that path is combined with the User Preferences Speed Table root path to create the entire table path. If the Path box is empty, then the entire table path is retrieved from the root user preferences path.

3. Click OK to exit the dialog box.
4 From the Projects menu, choose User Preferences to display the User Preferences dialog box:

5 Under File Locations, select Speed Tables from the Type pull-down menu.

6 Click the Browse button and locate where the speed tables are stored.

For instance, in the example described previously, the first person set the value to \speed tables and the second person set it to k:\speed tables.

7 Click OK to return to the User Preferences dialog box.

8 Click OK.
Editing a Speed Table

You can edit a speed table if you need to add information to it.

To edit a speed table

1. From the Lines/Curves menu, choose Speed Tables ➤ Edit Speed Tables. The Select Speed Table dialog box is displayed.

   ![](image1)

   **NOTE** If you receive an error message stating that no speed table was found, then you may need to change the speed table path. For more information, see “Changing the Speed Table Storage Path” in this chapter.

2. Select the table you want to use and click OK. The Horizontal Speed Table dialog box is displayed.

   ![](image2)

3. From the Design speed box, choose the design speed that is characteristic of the superelevated region.
Creating Spirals Using Speed Tables

4 Click the row in the speed table you want to edit.
5 Click Edit to edit an existing row, or click Add to add a new row.
The New/Edit Speed Table Item dialog box is displayed:

6 Edit the values in any or all of the five edit boxes.

   ■ **Degree of Curve**: When you enter the degree of curve, you must include degrees, minutes, and seconds. The recommended method of entry matches the display in the dialog box, where a ^ is used as the degree symbol, a ' for minutes and a " for seconds.
   ■ **Radius**: The spiral radius at the SC or CS.
   ■ **Superelevation Rate**: The superelevation rate or e value. This value is typically represented by a decimal number representing the percent grade of full superelevation. Other representations supported are nc for no crown and rc for remove crown. The rc value in the speed tables is always set to a 2 percent grade. You can change this value when you edit the superelevation parameters in Autodesk Civil Design.
   ■ **2 Lane Spiral Length**: Spiral lengths in and out for two-lane roads.
   ■ **4 Lane Spiral Length**: Spiral lengths in and out for four-lane roads.
7 Click OK to save your edits and return to the Horizontal Speed Table dialog box.
8 Select another row to edit, or click OK to end the command.

Creating Spiral Curves by Using a Speed Table to Calculate Superelevation

You can create a spiral-curve-spiral between two specified tangents by referencing speed tables. When you create the spiral, the spiral length in, spiral length out, and the radius values are retrieved from a speed table.

When you use this command, the superelevation information is stored with the spiral objects. After you define the alignment, this superelevation information is automatically added to the superelevation file of the alignment. You can use Autodesk Civil Design to edit the superelevation information if needed.

To create spiral curves by referencing speed tables
1 From the Lines/Curves menu, choose Speed Tables ➤ Create Curves.
2 Select the two tangents going in and out of the curve.
The Horizontal Speed Table dialog box is displayed:

3 Click Select to select the speed table you want to use.

The Select Speed Table dialog box is displayed:

4 Select the table you want to use.

5 Click OK to return to the Horizontal Speed Table dialog box.

6 From the Design speed box, choose the design speed that is characteristic of the superelevated region.

7 Click the row in the speed table you want to use.

8 Click OK to display the Select dialog box.

9 Click one of the following:
   - Two Lanes: If you are designing superelevation for a two-lane road.
   - Four Lanes: If you are designing superelevation for a four-lane road.
The command draws either a spiral-curve-spiral transition or a curve transition between the two tangents. The superelevation information is stored with the spiral and curve objects.

**Spiral Types**

Different types of spirals are classified by their curvature function (the equation that defines degree of curve as a function of station). Integration of this function gives an equation for the local azimuth (theta) at any given point on the spiral; subsequent integration of the cosine and sine of theta provide functions for the tangent and offset (X & Y) of that point. These equations allow the location of any point on a spiral.

**Clothoid Spirals**

AutoCAD Land Development Desktop currently supports four spiral types. However, in most cases, you use the clothoid (or linear) spiral. The clothoid spiral is used almost exclusively in the U.S. for both highway and track design, and is the most widely used type of spiral in most other countries as well.

First investigated by the Swiss mathematician Leonard Euler, the curvature function of the clothoid is a linear function chosen such that the degree of curve is zero (0) where the spiral meets the tangent. The function then increases linearly until it equals the degree of the adjacent curve at the point where the spiral and curve meet.

Such an alignment provides for continuity of the position function and its first derivative (local azimuth), just as a tangent and curve do at a Point of Curvature (PC). However, unlike the simple curve, it also maintains continuity of the second derivative (local curvature) which becomes increasingly important at higher speeds. A number of approximations of the clothoid have been introduced including the A.R.E.A. spiral, the cubic parabola, and the Searles spiral, but none of these provide the exact match between alignment and vehicle dynamics that the clothoid does. These alternative spirals were developed to simplify the computation process in the pre-computer era.

**Quadratic, Cosinusoidal, and Sinusoidal Spirals**

At extremely high speeds, such as those experienced on the high speed rail systems of Europe and Japan, the third derivative of the alignment function, which is discontinuous for the clothoid, becomes important. For this purpose, a number of “higher” spiral types have been introduced. Among these, the spirals with quadratic and sinusoidal curvature functions are widely used in Europe, while the cosine spiral is popular in Japan.

These three spiral types produce geometries that provide similar vehicle dynamics. Regional preferences play a significant role in decisions regarding what type of spiral a particular project should use.
The following illustration features the three spiral types:

Quadratic, cosinusoidal, and sinusoidal spirals

The following illustration shows how the three spiral types compared to the clothoid spiral:

Four spiral types
The following illustration depicts the spiral calculation parameters:

\[
D = f(L)
\]
\[
\theta = \int_0^L f(L) \, dL
\]
\[
x = \int_0^L \cos \theta \, dL
\]
\[
y = \int_0^L \sin \theta \, dL
\]

Spiral calculation parameters

The following illustration features the clothoid degree of curve function:

![Clothoid degree of curve function](image)

Clothoid degree of curve function

**Compound Spirals**

In the same way that a simple spiral provides a transition between a tangent and a circular curve, a compound spiral provides a transition between two circular curves with different radii. As with the simple spiral, this allows for continuity of the curvature function and provides a way to introduce a transition in superelevation. Currently, AutoCAD Land Development Desktop supports only clothoid type compound spirals.

The spiral resulting from the integration of this function is identical to a portion of a simple spiral with the longer radius curve attached at the point on the spiral where the local curvature is the same as for that curve. The shorter radius curve attaches to the usual location on the spiral.

Compound spirals are best used in either difficult terrain where the radius of a curve must change to avoid excessive earthwork or entrance/exit ramps where vehicle speed changes significantly. Occasionally, the demands of a complex alignment in an urban setting is best met by using compound spirals.
The following illustration depicts the design parameters of a compound spiral:

The following illustration features a compound spiral:

**Offset Spirals**

When a circular curve or tangent is offset, the resulting object is a new curve or tangent, and is therefore easy to deal with computationally. For a spiral, however, this is not the case. A spiral does not retain its curvature function when offset, and you cannot deal with this parallel spiral using the same geometry as the base spiral. However, you can describe such offset objects mathematically, and compute stations along them. AutoCAD Land Development Desktop includes the capabilities to handle such computations and lets you include parallel clothoid spirals in alignments. You might use this type of alignment for edge of pavement figures or for special cases of parallel transit alignments.
Although you can offset any type of spiral with AutoCAD Land Development Desktop commands, only the clothoid (simple or compound) currently maintains any mathematical integrity when offset. Do not include other types of offset spirals in alignments.

**Parallel Spiraled Alignments**

In alignment design it is often desirable to construct two or more alignments that are parallel through a curve. For circular curves, this is a simple matter; however, when spirals are introduced, the complications in Offset Spirals come into play. Following are two approaches to this problem.

The first method dictates that the alignments be everywhere at a uniform distance from each other. In this case, the first alignment is created and the spirals are added using any of the Spiral commands. The second alignment is created such that it has no mathematical description of its own, except that it is at a uniform offset from the first. You can use the Offset Alignments command or the Offset command to create the second alignment. Stationing and all computations regarding either alignment are generally done with respect to the first alignment.

The following illustration shows parallel alignments with offset spirals:

![Parallel alignments with offset spirals](image)

The second method uses nearly parallel, true spirals to create the second alignment and has the added advantage of allowing for widening of track centers in the main body of the curve. This can be useful in mass transit design where car overhang in tight curves requires increased lateral clearance between adjacent tracks. As with the first method, create the first alignment with the usual commands, then offset the tangents and circular portions with the Offset command. Finally, use the appropriate Create Spiral command to create the true spirals that connect the tangent(s) and curve(s).

These spirals have the length the program computes as necessary to join the selected objects, and are displaced (along the alignment) with respect to the spirals on the first alignment.

Because the spirals are not perfectly parallel, use the Divide Alignment commands to check clearances within the spirals.
The following illustration shows parallel alignments with true spirals:

**Basic Graphic Model of a Spiral**

AutoCAD Land Development Desktop represents a spiral using a polyline constructed so as to follow the spiral closely, but also to preserve its underlying mathematics precisely. This polyline has 10 segments with calculated bulge factors at each vertex. The bulge factors along the polyline are adjusted so that its local curvature best approximates the spiral and maintains tangency with adjacent objects in an alignment. This feature lets spirals be offset, while still retaining the proper relationship to adjacent offset objects.

The following illustration shows the Autodesk 10 segment spiral:

**NOTE**

Do not try to draw spiral segments using anything but the Create Spirals commands. Spirals drawn free-hand using the PLINE command may not have used the proper calculations, and do not always have the necessary information associated with them.
**Spiral Terminology**

Following is a list of terms used in discussing spirals.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>TS</td>
<td>Point of change from tangent to spiral</td>
</tr>
<tr>
<td>SC</td>
<td>Point of change from spiral to circular curve</td>
</tr>
<tr>
<td>CS</td>
<td>Point of change from circular curve to spiral</td>
</tr>
<tr>
<td>ST</td>
<td>Point of change from spiral to tangent</td>
</tr>
<tr>
<td>i1</td>
<td>Central Q angle of spiral curve L1, called &quot;spiral angle&quot;</td>
</tr>
<tr>
<td>i2</td>
<td>Central Q angle of spiral curve L2, called &quot;spiral angle&quot;</td>
</tr>
<tr>
<td>L1</td>
<td>Total length of spiral from TS to SC</td>
</tr>
<tr>
<td>L2</td>
<td>Total length of spiral from CS to ST</td>
</tr>
<tr>
<td>T1</td>
<td>Total tangent distance from PI to TS</td>
</tr>
<tr>
<td>T2</td>
<td>Total tangent distance from PI to ST</td>
</tr>
<tr>
<td>X1</td>
<td>Tangent distance at SC from TS</td>
</tr>
<tr>
<td>X2</td>
<td>Tangent distance at CS from ST</td>
</tr>
<tr>
<td>Y1</td>
<td>Offset distance at SC from TS</td>
</tr>
<tr>
<td>Y2</td>
<td>Offset distance at CS from ST</td>
</tr>
<tr>
<td>P1</td>
<td>Offset of the initial tangent into the PC of the shifted curve</td>
</tr>
<tr>
<td>P2</td>
<td>Offset of the initial tangent out to the PT of the shifted curve</td>
</tr>
<tr>
<td>K1</td>
<td>Abscissa of the shifted PC referred to the TS</td>
</tr>
<tr>
<td>K2</td>
<td>Abscissa of the shifted PT referred to the ST</td>
</tr>
<tr>
<td>LT1</td>
<td>Long tangent of spiral 1</td>
</tr>
<tr>
<td>LT2</td>
<td>Long tangent of spiral 2</td>
</tr>
<tr>
<td>ST1</td>
<td>Short tangent of spiral 1</td>
</tr>
<tr>
<td>ST2</td>
<td>Short tangent of spiral 2</td>
</tr>
</tbody>
</table>
Attaching Multiple Curves, Lines, and Spirals to Objects

To attach multiple lines, curves, or spirals from the end of any previously drawn object, use the Attach Multiple command on the Lines and Curves menu. The elements of this command have been included as separate commands in the Lines, Curves, and Spirals menus. In other words, if you only need to draw a curve, then use one of the commands in the Curves menu and similarly for lines and spirals.

Attaching a Line to an Object

To attach a line to an object
1. Select an object in the drawing.
2. From the Lines and Curves menu, choose Attach Multiple.
3. At the command prompt, type T to attach a tangent.
4. Enter the length of the new line section.
5. Press ENTER to exit the command.

Attaching a Curve to an Object

To attach a curve to an object
1. Select an object in the drawing.
2. From the Lines and Curves menu, choose Attach Multiple.
3. Select the object nearest the end to which the new object(s) are to be attached.
4. At the command prompt, type A to attach an arc.
5. Specify one of the following types of entries to use:
   - **Point**: draws the curve through a selected point. Select a point and enter the chord length.
   - **Radius**: draws the curve based on the radius or degree of curve. Enter the radius at the prompt, or type D and enter a degree of curve. When drawing a curve, specifying a positive radius or degree of curve draws the curve clockwise or to the right of the starting angle, whereas a negative radius or degree of curve draws the type curve counterclockwise or to the left.

   After you enter the radius, the following prompt is displayed:

   Select entry (Tan/Chord/Delta/Length/External/Mid) <Length>:

6. Do one of the following:
   - Type **Tan**, then type the tangent length.
   - Type **Chord**, then type the chord length.
   - Type **Delta**, then type the delta angle.
   - Type **Length**, then type the curve length.
   - Type **External**, then type the external secant.
   - Type **Mid**, then type the Middle Ordinate Distance.
All choices prompt for the value of the variable specified. After you define a curve with either the Point or Radius option, the curve data is displayed and the curve is drawn.

**Attaching a Spiral to an Object**

To attach a spiral to an object

1. Select an object in the drawing.
2. From the Lines and Curves menu, choose Attach Multiple.
3. Select the object nearest the end to which the new object(s) are to be attached.
4. At the command prompt, type `S` to attach a spiral.
5. Select one of the following spiral types. The command uses the spiral type that you set with the Spiral Type command, but it also uses an additional spiral type to link the spiral to the line segment.
   - **Compound**: To draw the spiral from one curve to another.
   - **Incurve**: To draw the spiral from a tangent to a curve.
   - **Outcurve**: To draw the spiral from a curve to a tangent.
   - **Point**: To draw the spiral from a tangent to a specified point.
6. At the prompt, type the length and radius of the spiral or the degree of curve.

The command displays the spiral data and draws the spiral.

The starting angle of the curve is specified by the closing angle of the line or curve you are attaching it to. If you attach a spiral to a curve or if you attach a curve to a curve or a spiral, the default value for the radius is the radius of the existing curve or spiral.
Drawing Special Lines and Curves

The Special Lines commands place special lines into a drawing. You can use these options to draw lines with regularly spaced text or symbols. Symbols include: barbed wire, stockade and chain-link fences, stone and retaining walls, tree, shore, and ledge lines, guardrails, and railroad tracks.
Special Lines and Curves

You can draw lines and curves that represent features on the terrain. You can draw tree lines, railroad tracks, and various fence and wall types. You can also draw lines and curves with any annotation or symbol you want.

Drawing a Stone Wall

You can draw a line that uses a series of ellipses to represent a stone wall.

To draw a stone wall

1. From the Lines/Curves menu, choose Special to display the Special Lines icon menu:

2. From the Description list box, click Stone Wall.
3. Click OK to close the dialog box.
4. Select the start point for the stone wall.
   The following prompt is displayed:
   Next point (curve/size):
5. To select the next point, draw a curve, or change the size of the wall symbol, do one of the following:
   - Continue to select points to draw the line.
   - Type C to draw a curve, and select a point on both the curve and the end of the curve.
   - Type S and enter a new size for the stone wall symbol.
6. After you finish drawing the line, press ENTER.

   NOTE   The size of the stone wall ellipse is initially based on the current horizontal scale in the drawing.
The following illustration features a stone wall linetype:

![Stone wall](image)

**Drawing a Tree Line**

You can draw a line that uses a series of curves to represent a tree line.

**To draw a tree line**

1. From the Lines/Curves menu, choose Special Lines to display the Special Lines icon menu.
2. In the Description list box, click Tree Line.
3. Click OK to close the dialog box.
4. Select the start point for the tree line.
   The following prompt is displayed:
   
   Next point (curve/size):

5. To select the next point, draw a curve, or change the size of the tree line symbol, do one of the following:
   - Continue to select points to draw the line.
   - Type C to draw a curve, and select a point on both the curve and the end of the curve.
   - Type S and enter a new size for the stone wall symbol.
6. After you finish drawing the line, press ENTER.

The command draws the tree line using a series of curves to the right of the first selected point, relative to the direction you draw the line. The size of the curves is initially based on the current horizontal scale.

The following illustration features the curve parameters for the tree line symbol:

![Curve parameters for tree line symbol](image)
The following illustration depicts a treeline:

![Treeline](image)

**Drawing a Shore Line**

**To draw a shore line**
1. Draw a line or polyline that represents the water’s edge.
2. From the Lines/Curves menu, choose Special Lines to display the Special Lines icon menu.
3. From the Description list box, click Shore Line.
4. Click OK.
5. Select the line representing the water’s edge.
   The following prompt is displayed:
   
   **Point in the river/pond:**

6. Click in the area of your drawing that represents the body of water.

**Drawing a Ledge**

You can draw a set of hatch lines that represents a ledge.

**To draw a ledge**
1. Draw a line or polyline that represents the ledge.
2. From the Lines/Curves menu, choose Special Lines to display the Special Lines icon menu.
3. From the Description list box, click Ledge.
4. Click OK.
5. Click a point on the line you drew in step 1.
6. Click a point in the area of your drawing where the ledge should appear. This must be a point inside the ledge area.
The following illustration features a ledge:

![Ledge Diagram]

**Drawing a Guard Rail**

You can draw a line that represents a guard rail.

**To draw a guard rail**

1. From the Lines/Curves menu, choose Special Lines to display the Special Lines icon menu.
2. From the Description list box, click Guard Rail.
3. Click OK.
4. Select the start point for the guard rail.
   
The following prompt is displayed:
   
   Next point (curve/size):
   
5. To select the next point, draw a curve, or change the size of the guardrail symbol, do one of the following:
   
   - Continue to select points to draw the line.
   - Type C to draw a curve, and select a point on both the curve and the end of the curve.
   - Type S and enter a new size for the guard rail symbol.
6. After you finish drawing the line, press ENTER.

The following illustration depicts a guard rail:

![Guard Rail Diagram]
Drawing a Railroad Track

You can draw a line that represents railroad tracks.

To draw a railroad track

1. From the Lines/Curves menu, choose Special Lines to display the Special Lines icon menu.
2. From the Description list box, click Railroad.
3. Click OK.
4. Select the start point for the railroad.
The following prompt is displayed:

   Next point (curve/size):

5. To select the next point, draw a curve, or change the size of the railroad symbol, do one of the following:
   - Continue to select points to draw the line.
   - Type C to draw a curve, and select a point on both the curve and the end of the curve.
   - Type S and enter a new size for the railroad symbol.

6. After you finish drawing the line, press ENTER.
The following illustration depicts a railroad track:

![Railroad track diagram]

Drawing a Retaining Wall

You can draw a line that represents a retaining wall.

To draw a retaining wall

1. From the Lines/Curves menu, choose Special Lines to display the Special Lines icon menu.
2. From the Description list box, click Retaining Wall.
3. Click OK.
4. Select the start point for the retaining wall.
The following prompt is displayed:

   Next point (curve/size):
To select the next point, draw a curve, or change the size of the retaining wall symbol, do one of the following:

- Continue to select points to draw the line.
- Type C to draw a curve, and select a point on both the curve and the end of the curve.
- Type S and enter a new size for the retaining wall symbol.

**NOTE**

The line increment is how much space is inserted between each symbol. The space increment is how much space is inserted around the symbol itself. A space increment of zero draws the line through the symbol.

After you finish drawing the line, press ENTER.

The following illustration features a retaining wall:

![Retaining wall illustration](image)

**Drawing a Line With Text on It**

You can insert text onto a line.

**NOTE**

This command uses the current text style and size.

**To draw a line with text**

1. From the Lines/Curves menu, choose Special Lines to display the Special Lines icon menu.
2. From the Description list box, click Line With Text.
3. Click OK.
4. Type the text you want to insert.
5. Select the start point for the line.

The following prompt is displayed:

*Next point (curve/size):*

6. To select the next point, draw a curve, or change the text or spacing, do one of the following:

- Continue to select points to draw the line.
- Type C to draw a curve, and select a point on the curve and the end of the curve.
- Type T to change the text
- Type S to change the line and/or space increments.
NOTE  The line increment is how much space is inserted between each text string.
The space increment is how much space is inserted around the text string itself. A space increment of zero draws the line through all the text.

7  After you finish drawing the line, press ENTER.
The following illustration shows text inserted onto a line:

![Line with text](image)

**Drawing a Line With a Symbol**

You can insert any symbol onto a line.

**To draw a line with a symbol**

1  From the Lines/Curves menu, choose Special Lines to display the Special Lines icon menu.
2  From the Description list box, click Line With Symbol.
3  Click OK.
4  Type the name of the symbol you want to use. This symbol (block) must exist in the `c:\Program Files\Land Desktop R2\data\Symbol Manager` folder for the command to function properly.

NOTE  Symbols used with the Line with Symbol command cannot contain attribute definitions.

5  Select the start point of the line.
The following prompt is displayed:

`Next point (curve/size):`

6  To select the next point, draw a curve, or change the symbol type, do one of the following:

- Continue to select points to draw the line.
- Type `C` to draw a curve, and select a point on the curve and the end of the curve.
- Type `T` to change the text.
- Type `S` to change the line and/or space increments.

NOTE  The line increment controls how much space is inserted between each symbol. The space increment controls how wide the line break is around the symbol itself.

7  After you finish drawing the line, press ENTER.
The following illustration features a symbol inserted onto a line:

**Drawing a Barbed Wire Fence**

You can draw a line that represents a barbed wire fence.

To draw a barbed wire fence

1. From the Lines/Curves menu, choose Special Lines to display the Special Lines icon menu.
2. From the Description list box, click Barbed Wire Fence.
3. Click OK.
4. Select the start point for the fence.
   
   The following prompt is displayed:

   Next point (curve/size):

5. To select the next point, draw a curve, or change the size or spacing of the fence symbol, do one of the following:
   - Continue to select points.
   - Type C to draw a curve, and select a point on the curve and the end of the curve.
   - Type S to change the symbol size or the line and space increments.

**NOTE**  
The line increment controls how much space is inserted between each symbol. The space increment controls how wide the line break is around the symbol itself.

6. After you finish drawing the line, press ENTER.

The following illustration features a barbed wire fence line:
Drawing a Stockade Fence

You can draw a line that represents a stockade fence.

To draw a stockade fence
1. From the Lines/Curves menu, choose Special Lines to display the Special Lines icon menu.
2. From the Description list box, select Stockade Fence.
3. Click OK.
4. Select the start point of the line.
   The following prompt is displayed:
   Next point (curve/size):
5. To select the next point, draw a curve, or change the size or spacing of the fence symbol, do one of the following:
   - Continue to select points.
   - Type C to draw a curve, and select a point on the curve and the end of the curve.
   - Type S to change the symbol size or the line and space increments.

   **NOTE** The line increment controls how much space is inserted between each symbol. The space increment controls how wide the line break is around the symbol itself.

6. After you finish drawing the line, press ENTER.
   The following illustration depicts a stockade fence line:

   ![Stockade fence diagram]

Drawing a Chain Link Fence

You can use this linetype to draw a line that represents a chain link fence.

To draw a chain link fence
1. From the Lines/Curves menu, choose Special Lines to display the Special Lines icon menu.
2. From the Description list box, select Chain Link Fence.
3. Click OK.
4. Select the start point for the fence. For more information, see “Selecting Lines, Curves, and Spirals by Selecting Points” in Chapter 11, “ Creating Points.”
The following prompt is displayed:

Next point (curve/size):

5 To select the next point, draw a curve, or change the size or spacing of the fence symbol, do one of the following:

- Continue to select points.
- Type C to draw a curve, and select a point on the curve and the end of the curve.
- Type S to change the symbol size or the line and space increments.

**NOTE** The line increment controls how much space is inserted between each symbol. The space increment controls how wide the line break is around the symbol itself.

6 After you finish drawing the line, press ENTER.

The following illustration shows a chain link fence line:
After you have drawn alignment geometry, you can use the Alignments commands to define and edit alignments. You can create offsets for alignments and import, delete, and merge alignments. You can also apply station equations to alignments and create station labels.

In this chapter

- Horizontal Alignments
- Drawing an Alignment
- Making an Alignment Current
- Defining an Alignment
- Creating Offsets for an Alignment
- Using Station Equations to Change the Stationing of an Alignment
- Editing Horizontal Alignments
- Reporting Data About a Horizontal Alignment
- Displaying Which Alignment is Current
- Listing the Alignments Defined in the Current Project
- Importing and Deleting Alignments
- Changing the Properties of Alignments
- Merging Alignments from Different Projects
- Stationing Alignments
- Labeling and Reporting Station and Offset Values
- Staking Out an Alignment
Horizontal Alignments

One of the first steps in roadway or railroad design is to create and define the horizontal alignment. You first draw the alignment geometry and then define the named alignment from that geometry. Defining an alignment creates an external database so that the alignment definition can be accessed from all drawings associated with the project. The external database for horizontal alignments contains all the information on each horizontal alignment defined in the project.

The alignment database is accessible by multiple people working on the project at the same time in different drawings. Each person can create and/or edit different alignments at the same time. In AutoCAD Land Development Desktop Release 2, locking is now done on a per-alignment basis.

The only limitation is when two people try to set the same alignment current at the same time. The first person to access an alignment by making it current opens that alignment with read-write capabilities. A lock file is created for that alignment and if another person selects that same alignment to set it current, they can open it with read-only access but they do not have write access, therefore they can't make any edits. They are also locked out of accessing the profiles and cross sections for that alignment (which can be created with Autodesk Civil Design).

For more information about the alignment database, see “The Horizontal Alignment Database” in this chapter.

You can edit the alignment data by using the Horizontal Alignment Editor. The Horizontal Alignment Editor is linked to the alignment, so any changes you make in the editor are automatically updated in the drawing. However, if you make changes to the graphical representation of the alignment in the drawing, you must then re-define the alignment to update the database with the changes.

The Horizontal Alignment Database

When you define a horizontal alignment from graphical objects in the drawing, the information is stored in the horizontal alignment database, an external file. All commands that work with alignments refer to the information in this database.

The alignment database is named alignment.mdb, and it is stored in the project’s \align folder.

For example, c:\Land Projects R2\<project name>\align\alignment.mdb.

Each drawing in a project has access to the alignment database. For example, if you create a new drawing in a project that already contains alignment definitions, you can import the graphical representation of the alignments from the alignment database into the new drawing. If you don’t need to see the horizontal alignment, then you don’t have to import it into the drawing to be able to work with it. The AutoCAD Land Development Desktop commands always access the alignment data directly from the database.
All horizontal alignment data for a project is stored in the \align project folder. If you create profile or cross section data for an alignment then a unique sub-folder in the project’s \align folder is created using the alignment name. This folder stores all profile and cross section data for the alignment. For example, if you sample a profile or cross sections for an alignment named Road1, then a \align\Road1 folder is created to store the data.

Whenever you define or edit an alignment, the data is saved to the alignment database. For example, when you define an alignment, the definition is automatically saved to the alignment database.

**NOTE**
Although the Release 2 alignment database is saved in a format that Microsoft Access can open, the alignment database is not intended to be edited or viewed in this manner. Use the Horizontal Alignment Editor to edit the alignment data and generate reports, or edit the alignment objects and redefine the alignment. For more information about the Horizontal Alignment Editor, see “Editing Horizontal Alignments” in this chapter.

**Sharing Access to Alignments Over a Network**
Because all of the alignment data is stored in an external database, you can share alignment data with other people working on the same project in a networked environment.

New in AutoCAD Land Development Desktop Release 2, alignment locking is handled on a per-alignment basis. The first person to access an alignment (by setting it current) obtains read-write access to that alignment. The next person who tries to access the same alignment obtains read-only access to the alignment, however, he or she could obtain read-write access to a different, unlocked, alignment.

If you set a locked alignment as current, a message displays at the command line to let you know that you have read-only access. If you have read-only access to the alignment, then you can import the alignment into a drawing and use alignment definition commands such as creating points along the alignment, stationing the alignment or listing station/offset. You can use the alignment editor to review the alignment data and print reports, but you cannot save any changes you make in the editor.

You can use Autodesk Civil Design to create profiles and cross sections for an alignment. However, when you have an alignment open with read-only access, the profile and cross section commands cannot be used for that alignment. You must have read/write access to the alignment in order to use the profile and cross section commands.

**NOTE**
In AutoCAD Land Development Desktop Release 1, the first person to access the alignment database locked all of the alignments. Now in Release 2, locking is handled on a per-alignment basis.
Alignment File Locking

Three different types of locks are created for the alignment database:

- **hrz alignment**: This lock is created when the alignment database is accessed in a Release 1 or Release 2 project. If this lock is instantiated by a Release 1 user accessing the project.adb alignment database, then the lock prevents someone using Release 2 from accessing the alignment.mdb database. If this lock is instantiated by a Release 2 user accessing the alignment.mdb database, then the lock prevents someone using Release 1 from accessing the project.adb alignment database.

- **#UserCount#**: This lock is created and updated when people access the alignment database. This lock keeps track of the number of people accessing the alignment database. The count is 1 when one person accesses the alignment database. The number is incremented by 1 for each additional person who accesses the alignment database.

- **<alignment name>**: This lock is created for each individual alignment that is accessed from the alignment database. It contains the Windows login name of the user who has the alignment locked. The user name is appended with the machine name and application ID. The machine name is used to avoid conflicts with two users in a network environment logging in with the same name. The application ID is used to avoid conflicts from a person running two sessions of AutoCAD Land Development Desktop at the same time.

You can see which lock files have been created in a project at any time by using the File Locks button in the Project Manager. You can also use the File Locks feature to remove locks that are left behind if a session is improperly terminated. All project lock files have the file extension .lk#.
The `<alignment name>` lock file (in the previous illustration, it is for lot55-44) is created when you make an alignment current. This file prevents other people (or other sessions of AutoCAD Land Development Desktop that you are running) from obtaining write access to that alignment. The lock for that alignment is deleted when you select a different current alignment, when you select the Close Database command, or when you end the drawing session.

The following is an example of the type of lock file that is created in the Project Manager when an alignment is set current:

```
File: c:\Land Projects R2\<project name>\align\align.lk#
Label: <alignment name> Type: s
Owner: leightk:PC56413:000003dc
Date/Time: Thu July 22 15:55:14 1999
```

- The File row shows the lock file name and where the lock file is located.
- The Label row shows the alignment name, and whether the alignment is shared (s) or read-only (r). Shared means that the owner has read-write access to the alignment, but another person could obtain read access to the alignment. Read-only means that you can access the alignment data, but you cannot make changes to it.
- The Owner row contains the AutoCAD login name, the computer name, and the application ID.
- The Date/Time row shows the date and time the lock file was created.

The type of lock file described previously is created for the current alignment only. For example, if you have an alignment set as current and then you make a different alignment current, then the lock on the first alignment is released and a lock is created for the second (current) alignment.

When you define an alignment, the alignment that you define is made current, and a lock file is created for it. To release the lock on the current alignment without setting another alignment current or ending the drawing session, you can use the Close Database command.

If an alignment is locked by another user, you can obtain read-only access to it by selecting it as the current alignment. When you select an alignment that is locked by another user, a lock file is created that contains an “r” (for read-only) on the Label row instead of a “s.”

In the event of a power failure or unexpected shut-down, you can use the file locking management options in the Project Manager to release the locks on selected alignments.

**WARNING!** You should never delete a lock for someone who is currently accessing the alignment file. This can lead to data loss or corruption of the database.

One command, Merge Database, cannot be used if there are locks on the alignment database. Everyone other than the person performing the merge must close the database before merging the database.
Alignment Locking when Working in More than One Session of AutoCAD Land Development Desktop

When you run more than one session of AutoCAD Land Development Desktop on the same computer, the alignment locking is handled the same way it is when you are working over a network.

If you make an alignment current in one session of AutoCAD Land Development Desktop, then that alignment is locked in the other session. You can only obtain read-only access to that alignment in the other session of AutoCAD Land Development Desktop, but you can set a different alignment as the current alignment in the second session with read/write access.

Access to Profile and Cross Section Data

When you create profiles and cross sections in Autodesk Civil Design, vertical alignment files (such as <alignment name>.vrt) are created for the alignment in the \align\alignment name\ folder of the current project.

When you select a current alignment and obtain read-write access to the alignment database, you also obtain read-write access to that alignment's profiles and cross sections (if Autodesk Civil Design is installed). When you select a current alignment that is already locked by another person, you get read-only access to the horizontal alignment but you are locked out of using any of the profile or cross section commands for that alignment. If you try to edit profile or cross section data for an alignment that is locked by another user, a warning message is displayed. You cannot edit the profile or cross section data for an alignment that is locked by another person.

Backwards Compatibility of Alignment Data

In previous releases of AutoCAD Land Development Desktop and Softdesk, the alignment database is named project.adb. The project.adb database format does not allow for alignment locking on a per-alignment basis. The first person to access an .adb alignment database obtains read-write access for the entire database, so no one else can work on another alignment at the same time.

The older format .adb databases are automatically converted to the .mdb format and are renamed alignment.mdb when you open a Release 1 or Softdesk 8 project in Release 2. However, the older .adb files are not deleted from your project folder. If no .adb file is detected in the project you open, then no conversion occurs. Additionally, if an alignment.mdb file is detected in the \align folder for the project, indicating that the alignment database already exists in the new format, no additional conversion takes place.

You can save the new alignment.mdb format database as an .adb database if you require backwards compatibility with previous releases. When converting to an .adb file, a file called longfilenamensystem.mdb is created if the names of your alignments are longer than 7 characters. This file was used in Release 1 of AutoCAD Land Development Desktop to allow the use of up to 40 characters for
alignment names. The new .mdb format allows the long file names to be written directly to the alignment.mdb file, so the longfilename.mdb file is no longer created, unless you save the database as .adb.

**NOTE** Softdesk 8 supports up to eight-character alignment names only, and cannot use the longsystemfilename.mdb file. Any profile and cross section files that are longer than eight characters are not readable by 8.

If you are sharing a Release 2 project with other people using Release 1 of AutoCAD Land Development Desktop, save the alignment database as an .adb file before you give them the project. When you receive the project back from them, use the Merge Database command to update the alignment.mdb file.

**Drawing an Alignment**

You can define an alignment either from a polyline or from line, curve, and spiral objects.

- Use the PLINE command to draw a continuous polyline with line and curve segments and define it as an alignment. When you define an alignment from a polyline using the Define from Polyline command, the alignment is defined in the direction in which you drew the polyline.
- Use the commands in the Lines/Curves menu to draw individual line, curve, and spiral objects that are joined at vertices and then define the entire group of objects as an alignment. The objects that comprise the alignment must meet exactly end-to-end. The Define from Objects command ends the alignment at any point it fails to find a connecting object.

**Making an Alignment Current**

To work on an alignment, you must select it as the current alignment. Only one alignment can be current at a time, even though a project may have several alignments. The current alignment is the alignment that is referenced in all subsequent alignment commands. You can choose a different current alignment at any time. Each time you open a drawing, you must choose which alignment you want to work on.

**TIP** If you’re not sure which alignment is set as current in your drawing, you can use the Display Current command. For more information, see “Displaying Which Alignment is Current” in this chapter.

When you make an alignment current, a lock file is created for that alignment. This lock file prevents other people working on a network (or yourself, if you are running more than one session of AutoCAD Land Development Desktop) from editing the alignment that you have set as current.

**NOTE** When you define an alignment, it automatically becomes the current working alignment.
To make an alignment current

1. From the Alignments menu, choose Set Current Alignment.

   You can make an alignment current by clicking on the alignment, by selecting the alignment from the Alignment Librarian dialog box, or by entering the alignment number.

2. Do one of the following:

   - Click the alignment in your drawing to make it current and to end the command. If you used the selected object in more than one alignment definition, then the following prompt is displayed:

     Number: {#}    Name: {name}    Desc: {description}
     Multiple Alignments - Is this the Alignment (Yes/No) <No>:

     The prompt displays the number, name, and description for each alignment name that has been assigned to these objects.

   - Specify No until the correct alignment name is displayed.

   - Specify Yes when the correct alignment name is displayed.

   If you want to select the alignment by specifying its name or number, then use one of the following methods to select it:

   - Press ENTER to select the alignment by name from the Alignment Librarian dialog box. From the scroll box in the Alignment Librarian dialog box, select the alignment you want to set as current, and click OK.

   - Press ENTER to display the Alignment Librarian dialog box, and then click Cancel or press ESC to close the dialog box, and then type the number of the alignment you want to select.
Defining Alignments

After drawing an alignment, you must define it, which creates a link between the objects and the alignment database. The alignment database, alignment.mdb, is created when the first alignment is defined in the project.

You can define an alignment in two ways: you can define a combination of line, curve, and spiral objects as an alignment, or define a polyline as an alignment. Any spirals that you want to use in an alignment must be created using the Spiral commands on the Lines/Curves menu. In addition, when you create offsets for an alignment, you have the option of defining these offsets as alignments.

When you define an alignment, that alignment is set as the current alignment in your drawing, and a lock file is created for it. When you create offsets, the centerline alignment (that you are offsetting) remains the current alignment after the offsets are defined.

For more information about the alignment database, see “The Horizontal Alignment Database” in this chapter.

You establish the station range for the alignment when you define it. If you must change the stationing of an alignment with station equations, you can use the Station Equations command.

Defining an Alignment from Objects

You can define an alignment from a combination of line, curve, and spiral objects in your drawing. The objects that you draw must meet end-to-end, with no gaps in between, or the complete alignment cannot be defined. Use Object Snaps when drawing the alignment to ensure that the objects connect.

NOTE You cannot use this command to define an alignment from a polyline; use the Define from Polyline command instead.

To define an alignment from line, curve, and spiral objects

1. From the Alignments menu, choose Define from Objects.
2. Select the first object nearest its point of beginning (POB).

   The command snaps to the nearest endpoint of the object. An X automatically appears at the nearest end of the line, curve, or spiral to indicate the start point of the alignment. If the X appears at the wrong end of the object, then cancel the command and try again by selecting closer to the other end of the first object.
3. Select the remainder of the objects that you want to define as an alignment. The following illustration shows how to select several objects:

   ![Select objects to define as an alignment](image)

   Select objects to define as an alignment
NOTE  If you use a window or crossing to select the objects, then the command filters out any objects that are not connected to the alignment (for example, points or blocks).

4 After you finish selecting the objects, press ENTER.
5 Press ENTER to accept the default stationing reference point or select a new reference point for defining the stationing. The alignment stationing is calculated by applying the starting station value that is entered in the Define Alignment dialog box to this reference point. The default is the start point of the alignment, but you can select any point on the alignment.

The Define Alignment dialog box is displayed.

6 In the Alignment Name box, type the alignment name. The alignment name can be up to 40 characters and can include any alphanumeric symbol. If you use a name that you have used previously, then you are prompted whether you want to overwrite the existing alignment after you click OK to exit the dialog box.
7 In the Description box, type the alignment description. The alignment description can be up to 80 characters in length and can include any alphanumeric symbol.
8 In the Starting Station box, review the starting station and change it if necessary. The starting station listed is the reference point you selected in step 5. This station can have a negative value. When entering the starting station value, do not include the plus sign (+). Enter station 10+00 as 1000.
9 Click OK.

The command records the new alignment in the alignment database file and the alignment is set as current. The Define from Objects command lists the starting and ending station and the length of the alignment defined, as well as the name, number, and description.

NOTE  The alignment number is automatically generated and cannot be changed.
The following is an example of defined alignment data:

```
--------------------------------- ALIGNMENT DATA --------------------------------
Description: Route 202 Bypass
Name: 202CL             Number: 1          Length: 14931.42
Starting station: 10+000.00        Ending station: 24+931.42
Superelevation data created.
```

When you define an alignment that contains one or more spirals, then the message “Superelevation data created” is displayed on the command line.

For any spirals that were created with the Create Curves command from the Lines/Curves ➤ Speed Tables menu, the superelevation information from the speed table is written to the superelevation parameters. For spirals that were created with any command other than the Create Curves command, then the default Civil Design Superelevation Control drawing settings are used for max e, runoff, runout, and so on.

## Defining an Alignment from a Polyline

You can define a single polyline as an alignment. When you define an alignment from a polyline, it is defined in the direction in which you drew the polyline. The polyline you select can be a 2D, lightweight, or 3D polyline. If you use a 3D polyline, the elevational data is not used in the alignment definition.

### Note

You cannot use this command to define an alignment from lines, curves, and spirals; use the Define from Objects command instead.

### To define an alignment from a polyline

1. From the Alignments menu, choose Define from Polyline.
2. Select a polyline.
   
   An X appears at the start point of the polyline (the first point that was drawn when the polyline was created). The command then connects the polyline vertices.
3. Press ENTER to accept the default stationing reference point, or select a new reference point for defining the stationing. The alignment stationing is calculated by applying the starting station value that is entered in the Define Alignment dialog box to this reference point. The default is the start point of the alignment, but you can select any point on the alignment.
   
   The Define Alignment dialog box is displayed.
4. In the Alignment box, type the alignment name. The alignment name can be up to 40 characters and can include any alphanumeric symbol. If you use a name that you have used previously, then you are prompted whether you want to overwrite the existing alignment after you click OK to exit the dialog box.
5. In the Description box, type the alignment description. The alignment description can be up to 80 characters in length and can include any alphanumeric symbol.
6 In the Starting Station box, review the starting station and change it if necessary. The starting station listed is the reference point you selected in step 3. This station can have a negative value. When entering the starting station value, do not include the plus sign (+). Enter station 10+00 as 1000.

7 Click OK. The command lists information about the alignment including the name, number, description, length, and starting and ending stations, and the new alignment is set as current.

**NOTE**  The alignment number is automatically generated and cannot be edited.

The following is an example of defined alignment data:

```
------------------- ALIGNMENT DATA ----------------------
Description: Route 202 Bypass  
Name: 202CL            Number: 1          Length: 1492.42
Starting station: 10+00.00          Ending station: 24+92.42
```

### Creating Offsets for an Alignment

After you define the centerline alignment, you can add alignment offsets. The following illustration shows an example of alignment offsets:

![Alignment offsets](image)

You can create up to eight offsets (four per side) at one time. If you need more than eight offsets for an alignment, then run the Create Offsets command again using new distances, layer names, and alignment names. When you create offsets, you have the option of defining the offsets as alignments.

**NOTE**  You should select the current alignment before using this command. If no alignment is set as current, then you are prompted to select the current alignment when you run the Create Offsets command.
To create alignment offsets

1 From the Alignments menu, choose Create Offsets to display the Alignment Offset Settings dialog box.

   ![Alignment Offset Settings dialog box]

   **NOTE** This dialog box is also available from the Projects ➤ Drawing Settings command so you can configure the offset defaults and save them to a prototype.

2 Select the Define offset alignments check box to define the offsets to the alignment database when they are created. If you do not want the offsets to be added to the alignment database, then clear this check box.

   When Define offset alignments is selected, the offset alignments are still listed as offsets rather than alignments when you use the List Defined command, but you can select and use them in the same manner as any alignment.

3 If you selected the Define offset alignments check box, the Name prefix box becomes active. In the Name prefix box, type the (offset) alignment name prefix. This prefix is added to the alignment offset names to become the full name of the alignments that are created from the offsets.

   Use the following guidelines for naming offsets:
   - The name prefix can be no longer than 20 characters.
   - The left and right offset names can be no longer than 40 characters.
   - The total alignment name length can be no longer than 40 characters.

   Therefore, if you are prefixing the alignment names with 20 characters, you should limit the left and right alignment name length to 20 characters or they will be truncated when the offsets are created.
NOTE You can type an asterisk (*) in the Name prefix box to use the centerline alignment name as the prefix for the offset alignments. The asterisk is counted as one character. You may also want to follow this asterisk with a dash ( - ) to separate the name.

4 Choose which offsets to create by selecting the Outer offset, Second offset, Third offset, or Inner offset check boxes.

5 In the Left offset and Right offset boxes, type the offset distances. Normally you would type in a positive value, but you can enter a negative number to draw the offset on the opposite side of the alignment. If an offset is not needed, enter zero (0). The command determines the left and right sides of an alignment based on station progression.

Offset widths do not need to be symmetrical; the left and right widths of the alignment can vary. The following illustration shows of symmetrical and asymmetrical offsets:

6 In the Left name and Right name boxes, type the offset names if you have selected the option to define new alignments from the offsets. The length of the names you type in the Left name and Right name boxes are limited to 40 characters which is also the limit for an alignment name. These names are combined with the name prefix you set to become the full alignment offset names. If the combination of the name and the name prefix exceeds 40 characters the name will be truncated.

7 In the Layer boxes, type the layer name for each offset. Both right and left offsets are placed on the same layer. If the layers do not exist, then the Create Offsets command creates them. When you create offsets, the layers specified in the dialog box are thawed and turned on if they exist.

8 Click OK to exit the dialog box and create the offsets for the current alignment. If no alignment is set as current, then you are prompted to select the current alignment for which you want to create the offsets.
Using Station Equations to Change the Stationing of an Alignment

Use station equations to change a station value. Station equations are used for creating station labels, and for creating, listing, and labeling profiles and cross sections.

If you create station equations or make changes to existing equations, then you must re-label the alignment with the Create Stations command.

The following illustration shows the selection point on an alignment for placing station equations:

![Selection point on alignment for station equation]

**NOTE**

In some instances when adjusting stationing with station equations, duplicate station numbers are created for an alignment.

If so, then several commands that require station numbers, such as the Create Stations command, will display the Duplicate Station Selection dialog box before proceeding.

This dialog box displays the duplicate stations in a scrolling list. To help you choose the correct station, each station lists the station back associated with it. The station back is the original station on the alignment before the equation was applied.

To create station equations

1. From the Alignments menu, choose Station Equations.

The Equations command displays the current alignment information and any station equations defined for it. Following is an example of station equation information:

<table>
<thead>
<tr>
<th>EQUATION</th>
<th>STATION-BACK</th>
<th>STATION-AHEAD</th>
<th>ORDER</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1675.00</td>
<td>2000.00</td>
<td>INCREASING</td>
</tr>
<tr>
<td>2</td>
<td>3261.00</td>
<td>3400.00</td>
<td>INCREASING</td>
</tr>
</tbody>
</table>

The following prompt is displayed:

Select operation (Clear/Add/eXit/Modify/Delete) <eXit>:
2 Type one of the following:
   ■ **Clear**: To clear the station equations. For more information, see “Clearing Station Equations” in this chapter.
   ■ **Add**: To add station equations. For more information, see “Adding Station Equations” in this chapter.
   ■ **X**: To exit the command. For more information, see “Exiting the Equations Command” in this chapter.
   ■ **Modify**: To change existing station equations. For more information, see “Modifying Station Equations” in this chapter.
   ■ **Delete**: To delete existing station equations. For more information, see “Deleting Station Equations” in this chapter.

**Clearing Station Equations**

When you type **Clear** to remove all defined station equations for the current alignment, a confirmation prompt is displayed.

■ Type **Yes** to remove all station equations, or type **No** to exit the option without removing any equations.

**Adding Station Equations**

After you type **Add** to add station equations, do the following:

1 Select the location for the equation. The station equation takes effect from this point, and is called the station back. You can use Object Snaps to select the point if needed.
   The station of the point you selected is displayed at the command line.
2 Press ENTER to accept the station of the point you selected, or type a new station value for the station back.
3 Type the station ahead. This is the station assigned to the next point on the alignment.
   The following prompt is displayed:
   
   Select stationing order (Increase/Decrease) <Increase>:

4 Do one of the following to specify the station order:
   ■ Type **Increase** to continue stationing the alignment in increasing station value increments.
   ■ Type **Decrease** to continue stationing the alignment in decreasing station value increments.

Information about the station equation is then displayed in the text window. Make a note of the equation number(s); you must supply an equation number if you need to modify the station equation in the future.

<table>
<thead>
<tr>
<th>EQUATION</th>
<th>STATION-BACK</th>
<th>STATION-AHEAD</th>
<th>ORDER</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>930.45</td>
<td>1000.00</td>
<td>INCREASING</td>
</tr>
</tbody>
</table>

In some instances, duplicate stationing occurs when you apply station equations to an alignment.
Modifying Station Equations

After you type `Modify` to modify station equations, do the following:

1. Type the equation number you want to modify.

   **NOTE** This number is generated when you create a station equation and is displayed in the text window. For more information, see “Adding Station Equations” in this chapter.

<table>
<thead>
<tr>
<th>EQUATION</th>
<th>STATION-BACK</th>
<th>STATION-AHEAD</th>
<th>ORDER</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>930.45</td>
<td>1000.00</td>
<td>INCREASING</td>
</tr>
</tbody>
</table>

2. Type the new value for the station back.
3. Type the reference station (which is the new station ahead).
4. Do one of the following to specify the station order:
   - Type `Increase` to continue stationing the alignment in increasing station value increments.
   - Type `Decrease` to continue stationing the alignment in decreasing station value increments.

   The station equation is modified and an updated list of defined equations is displayed in the text window.

Deleting Station Equations

- If only one station equation is defined when you type `Delete` to delete station equations, then that equation is deleted.
- If several equations are defined, then type the equation number to delete.

   **NOTE** This number is generated when you create a station equation and is displayed in the text window. For more information, see “Adding Station Equations” in this chapter.

   The station equation is then removed and an updated list of defined equations is displayed in the text window.

Exiting the Equations Command

When you type `X` to exit the Equations command, all equation information is saved and applied to the horizontal and vertical alignments.

If you previously created a profile or stationed the alignment, then you must do these tasks again in order to incorporate the changes made to the station equations.
Editing Horizontal Alignments

To edit an alignment after defining it, you can:

- Edit the individual objects or polyline and then redefine the alignment.
- Use a tabular editor called the Horizontal Alignment Editor.

This topic describes how to use the Horizontal Alignment Editor. When you make and save any changes in the Horizontal Alignment Editor, the changes are automatically updated in the drawing, and the changes are saved to the alignment database.

The Horizontal Alignment Editor lists each Point of Intersection (PI) in an alignment where a new object starts. It also lists the start and end points of an alignment. For example, if you define an alignment that is composed of a straight line segment, a curve segment, and another line segment, then you see five stations listed in the Horizontal Alignment Editor:

- The first PI is the start point of the alignment.
- The second PI is the Point of Curvature (PC) where the tangent meets the curve.
- The third PI is the Point of Intersection for the curve.
- The fourth PI is the Point of Tangency (PT) where the curve meets the tangent.
- The fifth PI is the end point of the alignment.

You can insert and delete Points of Intersection in the Horizontal Alignment Editor. The Horizontal Alignment Editor shows each PI station in the alignment. Each of these PIs is listed in the Station column, along with the Northing and Easting coordinates for each station.

- The Distance column shows the distance between the PIs.
- The type of angle displayed in the Direction column is the angle type that you chose when setting up the drawing. This is the reference angle of the object that exists between the two PIs.
- The station of a curve is equal to the PC station, plus the curve tangent length.

You can edit a curve PI by placing your cursor in the row that lists the PI of the curve and clicking Edit Curve. The following illustration shows a curve PI:

![Curve point of intersection](image)
You can edit a spiral PI by placing your cursor in the row that lists the PI of the spiral and clicking Edit Spiral. The following illustration shows a spiral PI:

![Spiral point of intersection](image)

**Navigation Buttons**

Within the Horizontal Alignment Editor, you can locate the PI you want to edit by using the following navigation buttons:

- **Home**: Moves the display to the first PI.
- **Page Up**: Moves up one page.
- **Up**: Moves up one row.
- **Down**: Moves down one row.
- **Page Down**: Moves down one page.
- **End**: Moves to the last PI.

**Inserting, Deleting, or Editing an Alignment Point of Intersection**

You can insert, delete, and edit points of intersection in an alignment. A point of intersection is where two tangents meet. In the Horizontal Alignment Editor, the start and end points of an alignment are also considered PIs.

In AutoCAD Land Development Desktop, curves and spirals are drawn tangent to the object they are drawn from. For curves and spirals, the PI is the virtual location where the two tangents would meet.
To insert, delete, or edit a Point of Intersection (PI)

1. From the Alignments menu, choose Edit to display the Horizontal Alignment Editor.

2. You can do any of the following:
   - Insert a Point of Intersection by placing your cursor in the row of the station above which you want to insert the point of intersection, and then click Insert PI.
   - Delete a Point of Intersection by placing your cursor in the row of the station that you want to delete, and then click Delete PI.
   - Edit a Point of Intersection by placing your cursor in the row of the PI that you want to edit, and then edit the Northing and Easting coordinate values to change the location of a point of intersection. After you change the northing and easting values, the station, distance between the PIs, and direction values for the PI are automatically recalculated to reflect the new point of intersection coordinates.

   **NOTE** If you edit a point of intersection with the Horizontal Alignment Editor, then the associated curve or spiral information is recalculated. The circular curve radius and the spiral lengths are maintained.
Editing a Horizontal Alignment Curve

Use the Horizontal Alignment Editor to edit alignment curve parameters. The following illustration shows the curve parameters that you can either view or edit using the Horizontal Alignment Editor:

To edit an alignment curve

1. From the Alignments menu, choose Edit to display the Horizontal Alignment Editor.
2. Place your cursor in the row that lists the Point of Intersection (PI) for the curve that you want to edit. Use the navigation buttons if necessary.
3. Click Edit Curve to display the Curve Detail Window dialog box.
Under Curve Stations, the station, northing, and easting information is displayed for the following items:

- **PC**: Point of Curvature
- **PI**: Point of Intersection
- **PT**: Point of Tangency
- **RP**: Radius Point

You cannot edit this data. If the current PI has no curve, then only the PI station, northing and easting, and overall PI central angle are displayed.

You can edit the following information for the curve:

- **R**: Radius
- **L**: Length of curve
- **Tc**: Tangent length of the circular curve
- **LC**: Length of long chord
- **D**: Degree of curve
- **Mc**: Middle ordinate of the circular curve
- **Ec**: External secant of the circular curve

After you make a change, press ENTER to accept the change and move to the next edit box. If you change any of the parameters, then the curve is recalculated based on the altered parameter.

You can view, but not edit, the following information:

- **Ic**: Central angle of the circular curve
- **I**: Total central angle of the overall PI (curves and spirals) when a spiral exists

To move between the next or previous curves in the alignment, click the Next or Previous buttons.

To edit a spiral, you can click the Spiral button to display the Spiral Detail Window. For more information, see “Editing a Horizontal Alignment Spiral” in this chapter.

Click OK to return to the Horizontal Alignment Editor dialog box, or click Cancel.

**NOTE**: Clicking OK in the Curve Detail Window does not save the changes you made. You must click Save on the Horizontal Alignment Editor dialog box to save the edits you made to the curve(s).

### Editing a Horizontal Alignment Spiral

Use the Horizontal Alignment Editor to edit both the radius of an alignment spiral curve and the spiral lengths.

**To edit an alignment spiral**

1. From the Alignments menu, choose Edit to display the Horizontal Alignment Editor.
2. Place your cursor in the row that lists the Point of Intersection (PI) information for the spiral that you want to edit. Use the navigation buttons if necessary.
Click Edit Spiral to display the Spiral Detail Window.

Under Spiral Stations, the station, northing, and easting information is displayed for the following items:

- **TS**: Point of change from tangent to spiral
- **SC**: Point of change from spiral to circular curve
- **CS**: Point of change from circular curve to spiral
- **ST**: Point of change from spiral to tangent

You can edit the following three spiral parameters:

- **Radius**, which is the spiral radius at the SC or CS. Changing the radius for a spiral also changes the radius of the adjacent curve.
- **L1**, which is the total length of spiral from TS to SC.
- **L2**, which is the total length of spiral from CS to ST.

If you change the spiral lengths, then the command recalculates the circular curve for that PI and maintains the radius. If the spiral lengths exceed the limits of geometric possibility, then the error message Spirals are too large for the delta angle of the PI is displayed.

After you make an edit, press ENTER to accept the edit and move to the next edit box.
5 You can view, but not edit, the following spiral parameters:

<table>
<thead>
<tr>
<th>i1</th>
<th>i2</th>
<th>T1</th>
<th>T2</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1</td>
<td>X2</td>
<td>Y1</td>
<td>Y2</td>
</tr>
<tr>
<td>P1</td>
<td>P2</td>
<td>K1</td>
<td>K2</td>
</tr>
<tr>
<td>LT1</td>
<td>LT2</td>
<td>ST1</td>
<td>ST2</td>
</tr>
<tr>
<td>A1</td>
<td>A2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For an explanation of these parameters, see “Spiral Parameters” in this chapter.

6 To move between the next or previous spirals in the alignment, click the Next or Previous buttons.

7 To edit a curve, click the Curve button to display the Curve Detail Window. For more information, see “Editing a Horizontal Alignment Curve” in this chapter.

8 Click OK to return to the Horizontal Alignment Editor dialog box, or click Cancel.

**NOTE** Clicking OK in the Spiral Detail Window does not save the changes you made. You must click Save on the Horizontal Alignment Editor dialog box to save the edits you made to the spiral(s).

**Spiral Parameters**
The following illustration shows some of the spiral parameters you can view, and some parameters that you can edit:
<table>
<thead>
<tr>
<th>Spiral parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>The Central Q angle of spiral curve L1, which is the spiral angle.</td>
</tr>
<tr>
<td>L2</td>
<td>The Central Q angle of spiral curve L2, which is the spiral angle.</td>
</tr>
<tr>
<td>T1</td>
<td>The total tangent distance from PI to TS.</td>
</tr>
<tr>
<td>T2</td>
<td>The total tangent distance from PI to ST.</td>
</tr>
<tr>
<td>X1</td>
<td>The tangent distance at SC from TS.</td>
</tr>
<tr>
<td>X2</td>
<td>The tangent distance at CS from ST.</td>
</tr>
<tr>
<td>Y1</td>
<td>The tangent distance at SC from TS.</td>
</tr>
<tr>
<td>Y2</td>
<td>The offset distance at CS from ST.</td>
</tr>
<tr>
<td>P1</td>
<td>The offset of the initial tangent into the PC of the shifted curve.</td>
</tr>
<tr>
<td>P2</td>
<td>The offset of the initial tangent out to the PT of the shifted curve.</td>
</tr>
<tr>
<td>K1</td>
<td>The abscissa of the shifted PC referred to the TS.</td>
</tr>
<tr>
<td>K2</td>
<td>The abscissa of the shifted PT referred to the ST.</td>
</tr>
<tr>
<td>LT1</td>
<td>The long tangent of spiral in.</td>
</tr>
<tr>
<td>LT2</td>
<td>The long tangent of spiral out.</td>
</tr>
<tr>
<td>ST1</td>
<td>The short tangent of spiral in.</td>
</tr>
<tr>
<td>ST2</td>
<td>The short tangent of spiral out.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Other spiral parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>Flatness of spiral in. The A value equals the square root of the spiral</td>
</tr>
<tr>
<td></td>
<td>length multiplied by the radius. A measure of the flatness of a spiral.</td>
</tr>
<tr>
<td>A2</td>
<td>Flatness of spiral out. The A value equals the square root of the spiral</td>
</tr>
<tr>
<td></td>
<td>length multiplied by the radius. A measure of the flatness of a spiral.</td>
</tr>
</tbody>
</table>
Reporting Data About a Horizontal Alignment

You can generate reports about the horizontal alignments in a project that are based on the stations of an alignment, the curves in an alignment, and the station information based on increments.

To report horizontal alignment data

1. From the Alignments menu, choose Edit to display the Horizontal Alignment Editor.
2. Click Settings to change the Output Settings. For more information about Output Settings, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”

   Each time you create a report, be sure to change the default output file name so you do not overwrite the previous report.
   - To keep a running record of all horizontal alignment data, clear the Overwrite file check box.
   - The Page breaks check box applies only to the screen display. The alignment reports are not displayed to the screen because the information is already available for viewing in the Horizontal Alignment Editor.
3. Click OK to return to the Horizontal Alignment Editor.
4. To generate a report, click one of the following buttons in the dialog box:
   - **Station**: For more information, see “Reporting Alignment Data by Station” in this chapter.
   - **Curve**: For more information, see “Reporting Alignment Data by Curve” in this chapter.
   - **Station and Curve**: For more information, see “Reporting Alignment Data by Station and Curve” in this chapter.
   - **By Increment**: For more information, see “Reporting Alignment Data By Increments” in this chapter.
Reporting Alignment Data by Station
The Station option reports all the horizontal tangent information for a range of stations to a file. The content and format of this file is similar to the one used to display information in the Horizontal Alignment Editor. No horizontal curve information is written using this selection.

1. Type the beginning station in the range of stations you want to report.
2. Type the ending station of the range.
3. Accept the default output file name by pressing ENTER, or type a new file name.

Reporting Alignment Data by Curve
The Curve option writes all the horizontal curve information for the current alignment to a file. The content and format of this file is similar to the one used in the Curve Detail dialog box.

1. Type the beginning station in the range of stations you want to report.
2. Type the ending station of the range.
3. Accept the default output file name by pressing ENTER, or type a new file name.

Reporting Alignment Data by Station and Curve
The Station and Curve option writes all the horizontal alignment information for the current alignment to a file. This option outputs the tangent information interspersed with horizontal curve information at the appropriate PVI stations.

1. Type the beginning station in the range of stations you want to report.
2. Type the ending station of the range.
3. Accept the default output file name by pressing ENTER, or type a new file name.

Reporting Alignment Data By Increments
The By Increment option writes horizontal alignment information to a file. This information displays according to an entered increment.

1. Type the beginning station in the range of stations you want to report.
2. Type the ending station of the range.
3. Type the increment by which you want to report the data.
4. Accept the default output file name by pressing ENTER, or type a new file name.
   The command outputs the station, northing and easting, and tangential direction at the specified increment.
Displaying Which Alignment is Current

You can display which alignment is the current alignment by using the Display Current command.

To display which alignment is current
1. From the Alignments menu, choose Display Current.
   The text window displays information about the current alignment. This information includes the alignment name, number, description, and starting and ending stations.
2. Click OK.

Listing the Alignments Defined in the Current Project

If you want to see information about all of the alignments that exist in the project, then use the List Defined command.

To list which alignments exist in the current project
1. From the Alignments menu, choose List Defined.
   The text window displays information on all alignments defined in the project. This information includes the alignment number, type, name, and description.
2. Press any key to return to the graphics screen.

Importing and Deleting Alignments

You may need to import a horizontal alignment into a drawing if you:
- Delete an alignment from the drawing (but do not delete it from the horizontal alignment database) and you want add the alignment back into the drawing.
- Define an alignment in a different drawing and need to bring it into the current drawing in the same project.

NOTE Use the Merge Database command to bring an alignment from a different project into the current project.

NOTE If you import an alignment that already exists in the drawing, then either delete the existing alignment to prevent outdated alignments from remaining in the drawing, or move it to a different layer.
You can delete an alignment from the drawing, the database, or both. When deleting alignments, you can also choose to delete the Autodesk Civil Design profile and cross section files at the same time. If you delete an alignment from the drawing, then you can always use the Import command to re-insert it. If you delete the alignment from the alignment database, then you can recreate the definition from the graphical objects. If you delete the alignment from both the screen and the database, then you cannot restore the alignment unless you redraw it.

**Importing a Horizontal Alignment**

You can import one horizontal alignment at a time into the drawing from the horizontal alignment database by using the Import command.

**NOTE**

To import more than one alignment at the same time, use the Multiple Selections command. For more information, see "Importing Multiple Horizontal Alignments" in this chapter.

**NOTE**

To bring alignments from another project into the drawing, you must first merge the other project’s alignment database with the alignment database of the current project. Then use the Import command to bring the merged alignments into the drawing.

**To import an alignment**

1. From the Alignments menu, choose Import to display the Alignment Librarian dialog box.
2. Do one of the following to select the alignment to import:
   - Select the name of the alignment you want to import.
   - Click Cancel, and then type the number of the alignment you want to import.

The alignment is imported onto the current layer.

**NOTE**

Alignments that were defined from a polyline are not imported as polylines; they are imported as individual objects, such as lines and curves.

**Deleting a Horizontal Alignment**

You can delete an alignment from the horizontal alignment database file and/or from the drawing. You can also delete all related vertical data (profile and cross section data) for the alignment simultaneously.
When you delete an alignment from the drawing, you can still access the data and you can also import the alignment back into the drawing later if needed.

**NOTE** You cannot delete an alignment or its profile or cross section files from the project if the alignment is locked by another person, but you can delete the alignment from the drawing.

**WARNING!** You cannot restore an alignment after you delete it from both the database and the drawing unless you redraw then redefine it manually.

### To delete an alignment

1. From the Alignments menu, choose Delete.
   
The following prompt is displayed:
   \[
   \text{Delete from (File/Screen/Both) <Both>:}
   \]

2. Do one of the following to specify what to delete:
   - Type **Both** to delete the alignment from both the database and the drawing.
   - Type **File** to delete the alignment from the database.
   - Type **Screen** to delete the alignment from the drawing.

3. Select the alignment you want to delete. You can click on the alignment if it was defined from lines, arcs, and/or spirals, or you can press ENTER to display the Alignment Librarian dialog box and select the alignment name. For more information, see “Making an Alignment Current” in this chapter.

   The following prompt is displayed:
   \[
   \text{Also delete the profile and cross section files for this alignment? (Yes/No) <Yes>:}
   \]

4. Type **Yes** if you want to delete the profile and cross section files, or type **No** to save the profile and cross section files.

**NOTE** To delete more than one alignment at a time, use the Multiple Selections command. For more information, see “Deleting Multiple Horizontal Alignments” in this chapter.

### Importing Multiple Horizontal Alignments

You can import multiple horizontal alignments into the drawing from the horizontal alignment database by using the Multiple Selections command.
To import multiple alignments

1. From the Alignments menu, choose Alignment Commands ➤ Multiple Selections to display the Multiple Alignments Librarian dialog box.

2. Under Selection, click each alignment you want to import. Selected alignments are marked by asterisks (*). You can click an alignment again to clear the selection.

3. Click Import to insert the alignments into the drawing on the current layer.

   TIP After you import the alignments, you can select an alignment from the Selection list and then click Select to set that alignment current and close the dialog box.

4. Click OK.

Deleting Multiple Horizontal Alignments

You can delete more than one alignment at a time by using the Multiple Selections command. You can delete multiple alignments from the horizontal alignment database file and/or from the drawing. You can also delete all related vertical data (profile and cross section data) for the alignments simultaneously.

When you delete alignments from the drawing, you can still access the data and import the alignments back into the drawing later if needed.

NOTE You cannot delete an alignment or its profile or cross section files from the project if the alignment is locked by another person, but you can delete the alignment from the drawing.
WARNING! You cannot restore alignments after you delete them from both the database and the drawing.

To delete multiple alignments

1. From the Alignments menu, choose Alignment Commands ➤ Multiple Selections to display the Multiple Alignments Librarian dialog box.
2. Under Selection, click each alignment you want to delete. Selected alignments are marked by asterisks (*). You can click an alignment again to clear the selection.
3. Under Delete Options, select one or more of the Delete options:
   - **Delete from screen**: Deletes the alignments from the drawing.
   - **Delete from database**: Deletes the alignments from the horizontal alignment database.
   - **Delete vertical files**: Deletes the alignments' profile and cross section files.
4. Click Delete to delete the selected alignments.
   A confirmation dialog box is displayed.

   ![Confirmation dialog box](image)

5. Click Yes to delete the alignments, or click No to cancel the command.

   **TIP** After you delete the alignments, you can select an alignment from the Selection list and then click Select to set that alignment current and close the dialog box.

6. Click OK.

Changing the Properties of Alignments

You can change the description, color, linetype, or layer of the current alignment by using the Modify Properties command. The color, linetype, and layer modifications change the objects that comprise the alignment in the current drawing. Alignment description changes are made to the alignment database, and are reflected in the commands that display the alignment information such as the Import and Edit commands.

**NOTE** The Modify Properties command Color, Layer, and Linetype options work only on alignments that have been defined from lines, curves, or spirals. If you want to modify the properties of an alignment that was defined from a polyline, delete the alignment from the drawing (not from the database) and then import the alignment back into the drawing. When you import polyline alignments back into a drawing they are imported as lines and arcs.
Moving an Alignment to a Different Layer

When you move an alignment to a different layer, the objects that comprise the alignment, such as the polyline, lines, curves, or spirals, are moved to the new layer. The objects take on the properties of the new layer, such as the layer color and linetype.

To move an alignment to a different layer

1. From the Alignments menu, choose Alignment Commands ➤ Modify Properties.
2. Select the current alignment. For more information, see “Making an Alignment Current” in this chapter.
3. The following prompt is displayed:
   Modify what (Layer/Color/LType/Description)?
4. Type Layer to change the layer.
5. Type the name of the layer on which you want to place the alignment objects.

   NOTE Layer names can be up to 255 characters.

Changing the Color of an Alignment

You can change the color of the objects that comprise an alignment without modifying the alignment’s layer properties.

To change the color of an alignment

1. From the Alignments menu, choose Alignment Commands ➤ Modify Properties.
2. Select the current alignment. For more information, see “Making an Alignment Current” in this chapter.
3. The following prompt is displayed:
   Modify what (Layer/Color/LType/Description)?
4. Type Color to change the color.
5. The following prompt is displayed:
   Color (Red/Yellow/Green/Cyan/Blue/Magenta/White/Number) <Number>: 
Do one of the following to define the color:
- Type the first character of the color name. For example, type R for red.
- Type Number, press ENTER, and then type a Windows color number.

<table>
<thead>
<tr>
<th>Color number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Red</td>
</tr>
<tr>
<td>2</td>
<td>Yellow</td>
</tr>
<tr>
<td>3</td>
<td>Green</td>
</tr>
<tr>
<td>4</td>
<td>Cyan</td>
</tr>
<tr>
<td>5</td>
<td>Dark blue</td>
</tr>
<tr>
<td>6</td>
<td>Magenta</td>
</tr>
<tr>
<td>7</td>
<td>White or black, depending on background color of AutoCAD</td>
</tr>
</tbody>
</table>

In addition, you can use any other color number from 0–255.

**Changing the Linetype of an Alignment**

You can change the linetype of the objects that comprise the current alignment without modifying the alignment’s layer properties.

**To modify the linetype of the current alignment**

1. From the Alignments menu, choose Alignment Commands ➤ Modify Properties.
2. Select the current alignment. For more information, see “Making an Alignment Current” in this chapter.
3. The following prompt is displayed:
   Modify what (Layer/Color/LType/Description)?
4. Type LType to change the linetype.
5. Type the linetype name. This linetype must exist in the drawing.

**Changing the Description of an Alignment**

You can change the description of an alignment after you define it. Alignment description changes are saved to the alignment database, and are reflected in the commands that display the alignment information such as the alignment Import and Edit commands.
To change the description of an alignment

1. From the Alignments menu, choose Alignment Commands ➤ Modify Properties.
2. Select the current alignment. For more information, see “Making an Alignment Current” in this chapter.

The following prompt is displayed:

Modify what (Layer/Color/LType/Description)?

3. Type Description to change the description.
4. Type the new description.

The description can be up to 255 alphanumeric characters in length.

Merging Alignments from Different Projects

If you want to access alignments in another project, then you can merge alignments to copy them from that project into the current project. You can merge all of the alignments from the selected project file, or just a few selected alignments. You also have the option to include profile and cross section files in the merge.

When you merge databases, the alignments from the selected project are copied into the current project's alignment.mdb file. To insert the merged alignments into a drawing, use the Import or the Multiple Selections command. When you merge the profile and cross section files, those files are copied into the c:\Land Projects R2\<project name>\align\<alignment name> folder.

You can merge both alignment.mdb files (Release 2 files) and project.adb files from Release 1 of AutoCAD Land Development Desktop or Softdesk 8.

**NOTE**

Alignments from the source project can be merged even if they are locked. For example, if someone is working on an alignment in Project 1, and you want to merge that alignment into Project 2, the person working on Project 1 does not have to release the lock on the alignment. The merge command has no effect on the source project. However, if someone other than you is working in the current “destination” project and has an alignment lock, then you cannot merge databases. To close the alignment database, use the Close Database command. For more information about the alignment database, see “The Horizontal Alignment Database” in this chapter.
To merge alignments

1. From the Alignments menu, choose Alignment Commands ➤ Merge Database. The Select Source Alignment Database dialog box is displayed. By default, the Files of type list displays MDB Files (*.mdb). These files are the AutoCAD Land Development Desktop Release 2 alignment database files. If you want to merge an alignment from a project you completed in Release 1 of AutoCAD Land Development Desktop or Softdesk 8, then select ADB Files (*.adb) from the Files of type list.

2. Select the file you want to merge from the c:\Land Projects R2\<project name>\align folder of the project from which you want to merge the alignment.

   **NOTE**  
   You cannot select the alignment database for the current project.

3. Click Open.

   The Alignment Selection for Merge Database dialog box is displayed. This dialog box displays the alignment names from the selected project's alignment database.

   **NOTE**  
   To allow the use of long alignment file names for Release 1 of AutoCAD Land Development Desktop, a file named longfilenamesystem.mdb was created. If that file no longer exists in your project folder when you attempt to merge an .adb file into the current project, then short file names are shown in the Alignment Selection for Merge Database dialog box, and the merged alignments will have short file names.
To select the names of the alignment(s) you want to merge, do one of the following:

- Select the name(s) of the alignment(s) that you want to merge by clicking on their names. Use SHIFT and CTRL to select a sequential list or a non-sequential list of alignments. When an alignment is selected, its name is highlighted. Click on a highlighted alignment name to clear it from the selection.
- Click Select All to select all the alignments.
- Click Clear All to clear the selection set and then make a new selection.

To merge the profile and cross section files, select the Include profile and cross section files check box. The files that are merged include *.tcd, *.tcp, *.tdf, *.vrt, *.xsd, *.xsp, and *.err. These files are placed in the c:\Land Projects R2\<project name>\align\<alignment name> folder of the current project.

Click OK to merge the alignments.

If the alignment name already exists in the current project, then the Alignment Database Merge Warning dialog box is displayed.

You can use the options in this dialog box to determine how to handle duplicate incoming alignments.

**TIP** Before you select to rename, skip, or overwrite an alignment name, decide whether you want to apply your choice to all other duplicate alignments, or just the alignment name that is shown in the Alignment Database Merge Warning dialog box. If you want to rename all duplicate alignments, for example, then select the Apply this choice to all subsequent existing alignments for this merge check box before you click Rename. If you do not select this check box, then the Alignment Database Merge Warning dialog box will be displayed for each duplicate incoming alignment.

Do one of the following to determine how to handle duplicate alignments:

- Click Rename to display the Rename Incoming Alignment dialog box, where you can assign a new name to the incoming alignment.
- Click Overwrite to overwrite the alignment in the current project with the incoming alignment.
- Click Skip to cancel the merging of this particular alignment.
- Click Cancel to cancel the command.
Saving the Alignment Database as an .adb File

If you want to share a project that contains alignments with someone using Release 1 of AutoCAD Land Development Desktop or Softdesk 8, then save the alignment database as an .adb file, the previous format of the alignment database.

In AutoCAD Land Development Desktop Release 2, the alignment database is saved to a Microsoft Access .mdb file named alignment.mdb. The .mdb format allows alignment locking on a per-alignment basis. In previous releases, the database was saved to the project.adb file, which allowed read-write access to only the first person who accessed the database.

**NOTE** When you open a Release 1 or Softdesk 8 project with Release 2 of AutoCAD Land Development Desktop, the alignment database is automatically converted from an .adb file to the alignment.mdb file.

If you give an .adb file to someone to work on, and later you want to incorporate their changes into your Release 2 project, then use the Merge Database command.

**To save the alignment database to an .adb file**

1. From the Alignments menu, choose Alignment Commands ➤ Save as .adb.

**NOTE** The Alignment database does not have to be closed when saving it as an .adb file.

If a project.adb file already exists in the project, then a warning dialog box is displayed, informing you that you will overwrite the existing .adb file if you continue.

2. Click Yes if you want to continue, or click No to end the command.

The alignment database is saved to a project.adb file to the current project’s \align folder. If the alignment names contain more than 8 characters, then a longfilenamesystem.mdb file is also written out. This file allows the use of up to 40 characters for alignment names in AutoCAD Land Development Desktop Release 1.

**NOTE** Softdesk 8 does not support long file names for alignments. If alignment names contain more than 8 characters, then the names are truncated. For example, “alignmentname” would appear as “alignm~1”. If you plan on sharing a project with someone using Softdesk 8, then it is recommended that you limit the alignment names to 8 characters or fewer. You can add detail to the alignment definition by using the Description box when defining the alignment.
NOTE

When you open a project that contains an .adb file, the .adb file is automatically converted to an alignment.mdb file. However, if an alignment.mdb file already exists in the project, then no conversion occurs.

Closing the Horizontal Alignment Database

To release the lock on the current alignment without selecting another current alignment, you can close the alignment database or close the drawing.

To close the alignment database

- From the Alignments menu, choose Alignment Commands ➤ Close Database.

By closing the database, you release the lock file on the current the alignment.

Changing the Station Display Format

To control how stations appear in AutoCAD Land Development Desktop, use the Station Display Format command. This command controls how stations appear for many AutoCAD Land Development Desktop and Civil Design commands, and it also affects how station labels are created.

The Station Display Format command controls the numeric format for the appearance of station labels, as well as precision, decimal character, and the station ‘+’ character.

To change the station display format

1 Do one of the following to display the Edit Station Format dialog box:
- From the Alignments menu, choose Station Display Format.
- From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Station Format and click the Edit Settings button.
Under the Preview section, a preview is shown that displays the edits that you make to the numeric format. You can change the number in the Preview Value edit box to change the preview value if needed.

Use the Numeric Format Options check boxes to control the way the numbers are displayed:

- **Show leading zeros**: Select this check box to display leading zeros. For more information, see the description in step 4 of “Minimum display width.”
- **Use ( ) for negative values**: Select this check box to display negative values in brackets. If you clear this check box, negative values are displayed with a minus (-) sign.
- **Drop decimal for even values**: Select this check box to drop the decimal precision for even numbers. Clear this check box to use the specified precision for even numbers.

Control the decimal display with the following edit boxes:

- **Minimum display width**: Use this option to specify the total number of characters that will be displayed when the “Show leading zeros” option is on. For example, if you enter a value of 6 in the minimum display width edit box, and set the decimal precision at 2, and enter a value of 50.02 in the preview value, then the value 050.02 will display in the preview. This option includes the decimal point in the total number of characters: 050.02 has a width of 6. If the width you specified is less than the width of the number, then the number will still display in total, it just won’t have any leading zeros. For example, if you specify a width of 2 but the number is 50.02, then the number 50.02 will display in the preview.
- **Decimal precision**: Use this option to control how many characters to the right of the decimal point are displayed.
- **Decimal character**: Use this option to control what the decimal character will be.

In the Station/Chainage Numeric Format section, set the options for stationing:

- **Use Station Format**: Select this check box to display the station values with the station character and base value. Clear this check box to display the station values as decimal numbers.
- **Station ‘+’ character**: Type a character in this box that will be used as the ‘+’ sign for the station label.
- **Station base value**: Use this control to determine how the station numeric format is displayed. For example, if the base value is 10, the station + character will be moved one position to the left of the decimal place.

Click OK.

### Changing the Alignment Label Settings

You can use the Alignment Labels command to specify the label text that is used to described points of change on alignments, such as “PC” beginning of curve. These Alignment Labels settings are used where ever these labels are displayed, including when you station the alignment in the drawing, create points on alignments with the At PC, PT, SC, etc. command, use the alignment editor, or when you use commands that output alignment data to text files.
To create station point labels when you use the Create Station Labels command, the Station point labels check box in the Alignment Station Label Settings dialog box must be selected. Station point labels include beginning of curve labels, curve/tangent intersection labels, and so on. For more information about changing the Alignment Station Label Settings, see “Changing the Alignment Station Label Settings” in this chapter.

To change the alignment label settings

1. Do one of the following to display the Alignment Labels Settings dialog box:
   - From the Alignments menu, choose Alignment Labels.
   - From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Alignment Labels and click the Edit Settings button.

2. In the Layer prefix box, type a layer prefix if you want to add a prefix to the layer on which the label is created. This option is used when creating station labels. Type an asterisk (*) to use the alignment name as the prefix.

3. Edit the label text for each type of alignment point of intersection:
   - **Station equation ahead**: Labels the stations ahead of the station equation.
   - **Station equation back**: Labels the stations behind the station equation.
   - **Tangent/Tangent intersect**: Labels the stations of the point of intersection between two tangents.
   - **Beginning of curve**: Labels the stations at the beginning of the point of curvature. You can replace the PC with BC, if desired.
   - **Curve/Tangent intersect**: Labels the stations of the point of tangency where a curve and tangent intersect.
   - **Radius point of curve**: Labels the stations at the radius of the point of curvature.
- **Tangent/Spiral intersect**: Labels the stations of the intersections between tangents and spirals.
- **Spiral/Curve intersect**: Labels the stations of the intersections between spirals and curves.
- **Curve/Spiral intersect**: Labels the stations of the intersections between curves and spirals.
- **Spiral/Tangent intersect**: Labels the stations of the intersections between spirals and tangents.
- **Spiral/Spiral intersect**: Labels the stations of the intersections between spirals.
- **Compound Curve/Curve intersect**: Labels the stations of the intersections between compound curves and curves.
- **Reverse Curve/Curve intersect**: Labels the stations of the intersections between reverse curves and curves.
- **Curve point of intersect**: Labels the stations of the intersections of two curves.
- **Spiral point of intersect**: Labels the stations of the intersections of two spirals.

4. Click OK.

---

### Stationing Alignments

To create stations for the current alignment, use the Create Stations command. Labels inserted with this command use the current text style, and are placed on the layer specified in the Station Label Settings command.

Before using the Create Stations command, you should set up the Station Display Format, establish the alignment station label settings, and set up the Alignment Label settings.

**NOTE** You can set the current text style for station labels by using the Set Text Style command on the Utilities menu.

### Changing the Alignment Station Label Settings

You can determine which types of station labels are created when you station an alignment, such as station labels, station point labels, and station equation labels, by changing the Alignment Station Label Settings. These settings also control how the station labels are oriented, the stationing increments, the stationing options, and the offset distances for labeling.
To change the alignment station label settings

1. Do one of the following to display the Alignment Station Label Settings dialog box:
   - From the Alignments menu, choose Station Label Settings.
   - From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Station Labels and click the Edit Settings button.

2. Select one or more of the following labeling options to determine which labels are created:
   - Station Labels: To create station labels.
   - Station Point Labels: To create station point labels.

   **NOTE**
   You can choose how the station point labels are named by using the Alignments ➤ Alignment Labels command.

   - Station Equations Labels: To insert station equation labels when you create stations. To specify the equations for the current alignment, you must use the Equations command.

3. If needed, change the layer names for each station label type in the adjacent Layer boxes.
4. Select one or more of the following labeling options to determine how the station labels are oriented:
   - Perpendicular Labels: To insert labels into the drawing in a perpendicular orientation. If you clear this check box, then the station labels are inserted parallel to the alignment.
   - Stations Read Along Road: To rotate the labels to be read along the alignment. If you clear this check box, then the labels are inserted in relation to a fixed vertical.
   - Plus Sign Location: To insert the station labels directly on the alignment, with the plus sign (+) in the label marking the station.
The following illustration shows the stationing parameters:

5 In the Station label increment box, type the distance between station labels. This value cannot be a negative value.

6 In the Station tick increment box, type the distance between tick marks. The station tick increment must be evenly divisible into the stationing label increment. For example, if the label increment equals 1000, then the tick increment might be 100, 200, 250, or 500. This value cannot be a negative value.

7 In the Station label offset edit box, type the offset distance. This is the distance from the alignment to the insertion point of the station label, and is in drawing units (feet or meters). Do not define a label offset if you selected the Plus sign location check box.

8 Click OK.

**NOTE** Other settings that affect station labels include the station display format settings, which control how the station labels appear, and the alignment label settings, which control the layer prefix for the layers and how station labels are named. For more information, see “Changing the Alignment Label Settings” and “Changing the Station Display Format” in this chapter.

**Creating Station Labels on an Alignment**

You can create labels on the stations along an alignment by using the Create Station Labels command. Before using the Create Station Labels commands, you can establish station display format, alignment label, and alignment stationing settings.

The current linear precision from the Drawing Setup command is used when labeling the stations of the Point of Curvature (PC), Point of Tangency (PT), and intersections between spirals and tangents or spirals and curves (TS, SC, CS, and ST).

To create station labels

1 Change the station display format. For more information, see “Changing the Station Display Format” in this chapter.

2 Change the alignment label settings. For more information, see “Changing the Alignment Label Settings” in this chapter.
3 Change the alignment station label settings. For more information, see “Changing the Alignment Station Label Settings” in this chapter.

4 Select the current text style for the drawing by using the Set Text Style command on the Utilities menu.

5 Select the current alignment. For more information, see “Making an Alignment Current” in this chapter.

6 From the Alignments menu, choose Create Station Labels.

7 Type the station at which you want the station labels to begin. The default value is based on the starting station of the current alignment.

8 Type the station at which you want the station labels to end. The default value is based on the ending station of the current alignment.

The command stations the current alignment.

The following illustration shows a stationed alignment:

![Stationed alignment](image)

**Labeling and Reporting the Station and Offset Values of Points in Relation to the Current Alignment**

By using the Station/Offset commands, you can list or label the station and offset of any location in relation to the current alignment.

**Labeling the Station and Offset of a Location in Relation to the Current Alignment**

You can label the station and offset of a location in relation to the current alignment.
To label the station and offset of a location

1. From the Alignments menu, choose Station/Offset ➤ Label.
2. Select the location to be labeled.
   The command starts a dimensioning leader arrow from the selected location, and the following prompt is displayed:
   Second leader point:
3. Select the second leader point.
   The following prompt is displayed:
   Next point:
4. Select one or more leader points, if needed.
5. After you have selected all the leader points, press ENTER.
   The label is inserted at the last leader point you selected. The label uses the current text size and is placed on the current layer.

   **NOTE** If the selected location is not perpendicular or radial to the alignment, then the following message displays:
   Point is not adjacent to alignment.

The following illustration shows an illustration of a station and offset label:

*Station and offset label*

**Reporting the Station and Offset of COGO Points in Relation to the Current Alignment**

You can report the station and offset of COGO points in relation to the current alignment by using the Display Points command.

   **NOTE** The steps in this command vary depending on the current Output Settings. You can access the Output Settings command from the Alignments menu by choosing Stakeout Alignment ➤ Output Settings. For more information about Output Settings see “Changing the Output Settings for Stakeout Reports” in this chapter.
To report the station and offset of COGO points to the current alignment

1. From the Alignments menu, choose Station/Offset ➤ Display Points.
   If you selected File as the output option in the Output Settings, then the following prompt is displayed:
   
   Output file name <output>:

2. Accept the default file name established in the Output Settings, or type a new file name. You can also specify a directory path for the file at this prompt. If you do not specify a directory path, then the file is created in the root of the project folder, c:\Land Projects R2\<project name>.
   
   The following prompt is displayed:
   
   Sort the points by Station (Yes/No) <Yes>:

3. Type Yes to sort the points by station, or type No to sort the points by point number.
   
   The following prompt is displayed:
   
   List points by (Selection/Number) <Selection>:

4. Do one of the following to specify how to select the points:
   
   - Type Selection if you want to select the points graphically. You can use a window or crossing window to select the points.
   - Type Number if you want to select the points by number. Separate the point numbers with commas (,) or hyphens (-). Point numbers separated by a hyphen indicate a range of point numbers.

5. Select the points or type a numerical range, depending on the selection option you specified.

6. After the selection set is complete, press ENTER.
   
   If you specified Screen as the Output Option in the Output Settings, then the text window displays the point number, station, offset, elevation, and description. Points are sorted by either station values or point numbers. The following is an example of a point list:

   **Point list example:**

<table>
<thead>
<tr>
<th>Point</th>
<th>Station</th>
<th>Offset</th>
<th>Elevation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>1124.75</td>
<td>-12.68</td>
<td>214.12</td>
<td>setpoint</td>
</tr>
<tr>
<td>15</td>
<td>1174.32</td>
<td>12.52</td>
<td>216.35</td>
<td>setpoint</td>
</tr>
</tbody>
</table>
If a selected point is not perpendicular or radial to the alignment, then the following message is displayed:

Point is not adjacent to alignment.

**Staking Out an Alignment**

You can create stakeout reports of alignments for surveyors. You can report the information using either turned or deflected angles.

**Changing the Alignment Stakeout Settings**

You can set stakeout settings that are used for all Stakeout commands. These settings control which angle type is used for the stakeout reports.

**To change the stakeout settings**

1. From the Alignments menu, choose Stakeout Alignment ➤ Settings. The Stakeout Settings dialog box is displayed.

2. Select the stakeout angle type to use.
   - For a turned angle right, select Turned +
   - For a turned angle left, select Turned -
   - For a deflection angle right, select Deflect +
   - For a deflection angle left, select Deflect -
   - For an angle that uses azimuths or bearings, select Direction
The following illustration shows the different stakeout angle types:

3. Click OK.

**Changing the Output Settings for Stakeout Reports**

Use the Output Settings command to specify how an alignment stakeout report is output. You can determine the format of the report, as well as the file name and destination. An Overwrite option is provided so that you can overwrite reports that may exist with the same name in the same location. If you choose not to overwrite existing files, then the new data is appended to the existing file.

To change the output settings for alignment stakeout reports

1. From the Alignments menu, choose Stakeout Alignment ➤ Output Settings to display the Output Settings dialog box.
For more information about changing the Output Settings, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”

**Creating an Alignment Stakeout Report**

You can write out alignment stakeout information for a surveyor that lists information for each occupied point, backsight point, starting station, ending station, and station interval.

Information is reported for each of the following stakeout points:

- Station
- Direction or angle
- Distance
- Northing/easting coordinates

The points listed in a stakeout report are the coordinates of the locations of each station point in relation to the occupied point.

**To create a stakeout report for an alignment**

1. Change the Stakeout Settings. For more information, see “Changing the Alignment Stakeout Settings” in this chapter.
2. Change the Output Settings. You can either display the report on the screen or save it to a file. For more information, see “Changing the Output Settings for Stakeout Reports” in this chapter.
3. From the Alignments menu, choose Stakeout Alignment ➤ Create File.
4. Type the point number of the occupied point. The occupied point does not need to exist on the alignment; it can be located anywhere in the project.
   
   **NOTE** You cannot select the occupied point by picking a point with your pointing device. You must type the point number.

5. Type the point number of the backsight point in the stakeout.
   
   **NOTE** If you chose the Direction type of angular entry in the Stakeout Settings, then you are not prompted for a backsight point.

6. Type the station on the alignment at which you want to start the stakeout report.
7. Type the station on the alignment at which you want to end the stakeout report.
8. Type the offset distance. The offset is the constant offset from the alignment used to determine the stakeout points.
9. Type the station interval. The default is the value set for the Station tick increment set in the Alignment Stationing Settings dialog box.
10. If you selected the option in the Output Settings to output the report to a file, then type the output file name.

The Create File command then writes the stakeout information.
Overview of Outputting Horizontal Alignment Data to ASCII Files

To use the alignment data in other programs that can read alignment data, you can create an ASCII file of alignment data.

Changing the Settings for Outputting ASCII Files

Use the Output Settings command to specify how alignment ASCII files are output. You can determine the format of the report, as well as the file name and destination. An Overwrite option is provided so that you can overwrite reports that may exist with the same name in the same location. If you choose not to overwrite existing files, then the new data is appended to the existing file.

To change the ASCII file output settings

1. From the Alignments menu, choose ASCII File Output ➤ Output Settings.
   The Output Settings dialog box is displayed.

For more information about changing the Output Settings, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
Outputting Horizontal Alignment Data to an ASCII File

You can output alignment data as an ASCII text file if you want to use the data in another program that has been created to read alignment data.

**NOTE** The files created by this command are output in ASCII format only. These are data files and not intended to be a report.

A multitude of different output formats exist worldwide. Some countries have standardized formats for profiles and cross sections, while in other countries the formats can vary greatly from region to region or even between corporations.

**To output alignment data to an ASCII file**

1. Select the current alignment.
2. From the Alignments menu, choose ASCII File Output ➤ Alignment.
   
   At the command line, the current alignment name, number, description, and starting and ending stations are displayed, and the following prompt is displayed:

   Directory to output to \c:\Land Projects 82\<project name>\align\:

3. Do one of the following to specify the output location:
   - Press ENTER to accept the default directory.
   - Type a new directory path.

4. Type the file name you want to create.
   
   When entering the file name, be sure to include the extension. If the file already exists, then a prompt is displayed asking whether or not to overwrite the file.

5. Type Yes to overwrite the existing file, or type No and then type a new file name.

The following table lists the alignment object types and the codes used in the ASCII text file:

<table>
<thead>
<tr>
<th>Description</th>
<th>Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output types</td>
<td>0: Line Object</td>
</tr>
<tr>
<td></td>
<td>1: Curve object</td>
</tr>
<tr>
<td></td>
<td>2: Spiral object</td>
</tr>
<tr>
<td></td>
<td>3: Station equation</td>
</tr>
<tr>
<td>Spiral types</td>
<td>0: Clothoid spiral object</td>
</tr>
<tr>
<td></td>
<td>1: Sinusoid spiral object</td>
</tr>
<tr>
<td></td>
<td>2: Cosinusoid spiral object</td>
</tr>
<tr>
<td></td>
<td>3: Quadratic spiral object</td>
</tr>
</tbody>
</table>
Alignment object types and codes used in the ASCII file (continued)

<table>
<thead>
<tr>
<th>Description</th>
<th>Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defined direction types for spirals</td>
<td>0: Defined from TS end</td>
</tr>
<tr>
<td></td>
<td>1: Defined from SC end</td>
</tr>
<tr>
<td>Station equation types</td>
<td>0: Increasing</td>
</tr>
<tr>
<td></td>
<td>1: Decreasing</td>
</tr>
</tbody>
</table>

The following text shows the format for the alignment ASCII text file:

Alignment name, number, starting station (internal), length description
0,internal sta, external sta, N, E, 1, N, 2, E, Dist., Dir.
1,internal sta, external sta, BC, N, BC, E, CC, N, CC, E, BC
2,Length, Radius, Delta
3,internal sta, external sta, RS, N, RS, E, SPI, N, SPI, E, RS, N, ES
4,Length, Theta, Radius, A, Offset, External, spiral type, direction defined
5,length along alignment (including starting station), external sta, type

The internal station is the original station value as the alignment was defined, before station equations are used. The external station is the current station value. If you have not used station equations, then the internal and external values are the same.

Any line beginning with either a number character (#) or semicolon (;) is a comment line. Following is an example of the alignment output in the ASCII text file.

# Alignment Output 1.0A
r1,1,1642.800000,1073.639873
Roadway one
3,1642.800000,3000.000000,0
0,1642.800000,3000.000000,4990.292780,4526.310407,4976.765050,4660.016800
3,134.388987,6.182354
1,1777.188987,3134.388987,4976.765050,4660.016803,4777.780893,4639.88460
3,4950.288333,4741.083335,85.940364,200.000000,0.429702
0,1863.129351,3220.329351,4950.288333,4741.083335,4900.570240,4825.83480
0,98.258331,5.752652
1,1961.387682,3318.587682,4900.570240,4825.834800,5116.204539,4952.33321
5,4866.721638,4968.404369,148.715643,-250.000000,0.594863
0,2110.103325,3467.303325,4866.721638,4968.404369,4868.362666,4993.87910
8,25.527540,0.064329
1,2135.630865,3492.830865,4868.362666,4993.879108,5117.845568,4977.80795
4,5041.455780,5215.851228,298.985535,-250.000000,1.195942
0,2434.616300,3791.816300,5041.455780,5215.851228,5309.800604,5301.95600
0,281.823573,1.26027
21

Working with Parcels

The commands on the Parcels menu define, resize, report, and label parcel areas. Parcel definitions are stored in the parcel database file. Use the Parcel Manager to create reports on parcel area, traverse, and map check information, as well as to import, delete, and rename parcels.

Most of the Parcels commands require that existing parcel lines be present in the drawing. Parcels can be defined from points, lines, curves, and polylines.
Using the Parcels Commands

Use the Parcels commands to define, size, and manage parcels. When you define a parcel, its definition is stored in the parcel database file. Because parcel data is stored externally, multiple people working on a network can access it. You can also delete the parcel geometry from the drawing, and import it back to the drawing later.

Drawing Parcels

To draw parcels, use the line and curve commands in the Lines/Curves menu. You can also use either the PLINE command, or any AutoCAD line or curve command.

NOTE
Do not use spiral curves in the parcel geometry, or incorrect parcel areas are calculated. If you want to create a parcel from a spiral, then use the BPOLY command to convert the spiral into a polyline before defining the parcel.

After you draw the parcel geometry, you must define the parcels to the parcel database. For more information, see “Defining Parcels” in this chapter.

NOTE
Be sure to draw the parcels as closed regions. If any of the joining lines has a break, then you cannot define the parcels.

Selecting a Curved Parcel Line

Several of the Parcels commands have the following prompt as part of their sequence:

Next point (or Curve):

This prompt allows you to select points or a curve as part of the parcel definition. The curve that you select must already exist in the drawing.

To select a curved parcel line

1 At the Next point (or Curve) prompt, type C.

NOTE
This option automatically sets the OSNAP mode to Center. Do not override this setting.

2 Select a point on the curve and the end of the curve.

The command then prompts for the position of the chord relative to the parcel:

Outside or inside:

Position of chord to parcel Outside/<Inside>:

3 Do one of the following:

- Type O if the chord is outside the parcel.
- Type I if the chord is inside the parcel area.
If the chord is on the inside of the parcel, then the area of the curve is added to the area of the parcel. If the chord is on the outside of the parcel, then the area of the curve is subtracted from the area of the parcel.

**NOTE**  Curves are assumed to have an included angle of less than 180 degrees. A curve with more than 180 degrees must be treated as two curves with included angles that are less than 180 degrees.

**Changing the Parcel Settings**

The Parcel Settings command controls the following factors:

- Whether parcels are defined to the database when you use the Parcel Sizing commands
- Whether parcel numbering is sequential (automatic) or manual
- How parcels are labeled
- Which layers the parcel commands use

**To change the parcel settings**

1. Do one of the following to display the Parcel Settings dialog box:
   - From the Parcels menu, choose Parcel Settings.
   - From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Parcel Settings and click the Edit Settings button.
2 To automatically save parcel definitions to the database when using the Parcel Sizing commands, select the Define parcels as sized check box. Clear this check box if you do not want to define the parcels as you experiment with the Parcel Sizing commands.

3 To label the parcels as you define them, select the Label parcels as defined check box.

4 Use the Map check across chord check box to determine how the Map Check report option calculates curve data. If this box is selected, then the traverse is checked based on the chord information of the curve. If the check box is cleared, then the traverse is calculated based on the curve length.

5 To automatically place the label at the center of the parcel, select the Automatic Label Placement check box. If you clear the Automatic Label Placement check box, you are prompted for the insertion point when you import a parcel; or when you define a parcel with the Label parcels as defined check box.

6 To truncate area labels, select the Truncate area labels check box. The area values are truncated based on the precision settings that are set in the Square Feet/Meters Labeling and Acres/Hectares Labeling areas of the dialog box. If this check box is cleared, then the areas are rounded off based on the precision settings.

   For example, if the exact parcel area equals 2.80857460 hectares, then the area is truncated or rounded as follows:
   - Truncated area with Square Feet/Meters precision set to 2 = 122,341.50 sq.m.
     Rounded area with Square Feet/Meters precision set to 2 = 122,341.51 sq.m.
   - Truncated area with Acres/Hectares precision set to 4 = 2.8085 hectares
     Rounded area with Acres/Hectares precision set to 4 = 2.8086 hectares

   Rounding may produce a label that states an area greater than the actual lot size.

   **NOTE** A typical suffix used in conjunction with the Truncate area labels option is "Acres/Hectares %%P." This suffix produces the plus/minus symbol typically used when labeling acres/hectares.

7 To include the parcel lines when you import parcels from the Parcel Manager, select the Include Parcel Lines on the Import check box.

8 To label parcels with their number, select the Labels on check box in the Parcel Numbering section.

9 To number parcels sequentially, select the Sequential on check box. When this check box is selected, the current parcel number is used as the parcels are defined. If you clear this check box, then you are prompted for parcel numbers as you define the parcels.

10 To use a prefix with the parcel numbers, type the prefix in the Prefix box in the Parcel Numbering section. For example, if you type Parcel as the prefix, then the parcels are labeled Parcel1, Parcel2, Parcel3, and so on.

11 To change the current parcel number, adjust the value in the Number box in the Parcel Numbering section. The parcel number is used as the value the next time the parcel is defined with Sequential on.
12 To set the text style for the parcel number labels, click the Select button and then choose a text style from the Text Style Selection dialog box, and then click OK to return to the Parcel Settings dialog box.

13 Set the Square Feet/Meters Labeling settings. This group of options determines how the square unit (feet or meters) value is labeled:
   - To include square unit labels, select the Labels on check box.
   - Set the labeling precision with the Precision box or slider bar.
   - Set the text style by clicking the Select button, and then selecting the style from the Text Style Selection dialog box.
   - In the Area suffix edit box, set the area suffix, such as sq.m or sq.ft.

14 Set the Acres/Hectares Labeling settings. This group of options determines how the area unit (acres or hectares) value is labeled. There are options for the text style, label precision, and suffix for the area, such as acres and hectares. For instructions, see Step 13.

15 Using the Parcel layer and Label layer boxes, set the layer names for the parcels, lines, and labels.

16 Click OK.

**Managing Parcels**

Use the Parcel Manager to import, delete, and rename parcels, as well as to report parcel data.
**Reporting Parcel Area, Inverse, or Map Check Data**

You can create reports of parcel area, inverse, and map check information. Before you can report parcel information, you must first define the parcel to the database. For more information, see “Defining Parcels” in this chapter.

**To report parcel data**

1. From the Parcels menu, choose Parcel Manager to display the Parcel Manager dialog box.
2. From the Select parcel list box, select the parcels. You can either select each individual parcel or use the Select All button to select all of the parcels in the list. An asterisk (*) indicates each parcel you select. To deselect all the parcels, click the Clear All button.
3. To change the parcel settings, click the Parcel Settings button. For more information, see “Changing the Parcel Settings” in this chapter.
4. To modify the output settings for the report options, click the Output Settings button. If you select the option to output to a file, then the parcel area, inverse, and map check information is written to a text file automatically.

5. Click OK to return to the Parcel Manager.

For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
6 Select one of the report buttons:

- To report the parcel area, select the Area button. The Parcel Area dialog box displays the area and perimeter for all selected parcels.

```
Parcel Area

Parcel name: 3
Perimeter: 1105.95  Area: 74,624 sq.ft.  1.71 acres
```

- To report the parcel traverse information, select the Inverse button. The Parcel Inverse dialog box displays the parcel traverse information, area, and perimeter for all selected parcels.

```
Parcel Inverse

Parcel name: 3

North: 667.9252  East: 286.9000
Line Course: S 90°00'00" E Length: 286.74
North: 667.9252  East: 592.6000
Line Course: S 00°00'00" W Length: 235.15
North: 332.7778  East: 593.0900
Line Course: N 90°00'00" W Length: 237.06
North: 332.7778  East: 265.6793
Line Course: N 05°09'24" E Length: 236.18
North: 667.9252  East: 286.9000
Perimeter: 1105.95  Area: 74,624 sq.ft.  1.71 acres
```

- To report the map check information, click the Map Check button.
Chapter 21  Working with Parcels

The Parcel Map Check dialog box displays the parcel closure calculation based on the traverse information, rounded off to the current drawing precisions as set in the Drawing Setup command. Set the drawing precisions to the same values used when labeling the parcel lines. The report also includes the parcel traverse information, area, and perimeter.

NOTE
The coordinates reported by the Map Check option are calculated from the directions and distances at the current drawing precisions. If you change the angular and linear precisions, then the coordinates of the parcel corners change accordingly. The coordinates reported by the Inverse option are calculated using the maximum precision allowed by AutoCAD. You can report these coordinates only to the coordinate precision set in the Drawing Setup, but the only changes in the reported parcel inverse coordinates are due to rounding.

Each report option displays the parcel information in a dialog box, with options to print to either a file or printer.

Importing Parcel Lines and Labels
If you delete parcels from the drawing, or want to add the parcels to a new drawing, you can import the parcels. When you import parcels, you can import any combination of parcel lines, parcel numbers, and parcel area labels.

NOTE
To use this command, at least one parcel must exist in the parcel database and one import option must be selected in Parcel Settings.
To import the parcel lines and labels of the selected parcels to the drawing
1. From the Parcels menu, choose Parcel Settings to display the Parcels Settings dialog box.
2. Under Options, you must select one of the following options:
   ■ Automatic Label Placement
   ■ Include Parcel Lines on Import
3. Click OK.
4. From the Parcels menu, choose Parcel Manager.
   The Parcel Manager dialog box is displayed.
5. From the Select parcel list, select the parcels you want to import. You can either select each individual parcel or click the Select All button to select all the parcels in the list. An asterisk (*) indicates each parcel you select. To deselect all the parcels, click the Clear All button.
6. Click Import to import the parcel definitions to the drawing.
7. If you choose to import labels and Automatic Label Placement is not selected in the Parcel Settings, then choose both an insertion point and a rotation angle for each parcel label.
   As each parcel is being inserted, the parcel number displays at the command prompt. The imported parcels are brought into the drawing as polylines.
8. Click OK to exit the dialog box.

Deleting Parcels

NOTE   Parcel definitions are stored to the parcel database; therefore, to permanently remove the parcels from the project, you must delete them from the database. To erase parcel lines from the drawing, use the ERASE command. Erasing parcel lines does not remove parcel definitions from the database.

To delete parcels from the parcel database
1. From the Parcels menu, choose Parcel Manager.
   The Parcel Manager dialog box is displayed.
2. From the Select parcel list, select the parcels you want to delete. You can either select each individual parcel or click the Select All button to select all the parcels in the list. An asterisk (*) indicates each parcel you select. To deselect all the parcels, select the Clear All button.
3. Click the Delete button.
   A warning box is displayed with the following prompt:

   WARNING
   About to permanently remove parcel definitions. Proceed?
   [ ] No [ ] Yes
4 Click Yes or No:
   ■ Click Yes to delete the parcels.
   ■ Click No to end the command.

Renaming Parcels

To rename parcels
1 From the Parcels menu, choose Parcel Manager to display the Parcel Manager dialog box.
2 In the Select parcel list, select the parcel to rename.
3 Click Rename to display the Rename Parcel dialog box.

4 In the Name text box, type the new parcel name. Parcel names can be up to 30 characters long, including spaces. They can include any valid file name characters, numbers, and letters.
5 Click OK to exit the dialog box.

The new parcel name is now in the project database and anyone accessing the project will see this new name.

Merging Parcel Data into the Current Project from Other Projects

To merge parcel databases from other projects with the parcel database of the current project, use the Merge Parcels command.

To merge parcels from other projects
1 From the Parcels menu, choose Merge Parcels.
The Parcel File to Import dialog box is displayed. The parcel database data is held in the `<project name>.gcf` file, which resides in the `\lots` subfolder of the project folder.

2. Select the `<project name>.gcf` file that you want to merge with the current project parcel database.

   **NOTE** You cannot merge the parcel database from the current project with itself. If you select the current project parcel database, then the following message is displayed:

   Cannot import the current parcel file.

3. Click OK.

   The Merge Design Parcels dialog box is displayed:

4. Select the parcels to be merged. You can either select each parcel individually, or click the Select All button to select all the parcels in the list.

5. Click OK to merge the parcels into the current project.
If the merge selection has duplicate parcel names, then the following prompt is displayed:

<Parcel#> exists. (Overwrite/Rename) <Overwrite>:

6 Type one of the following:

- **Overwrite**: To overwrite the existing parcel in the current project.
- **Rename**: To rename the duplicate parcel in the current project.

The following prompt is displayed:

Repeat this operation for all subsequent parcels. (Yes/No) <Yes>:

7 Type **Yes** or **No**:

- Type **Yes** to use the option you selected in Step 6 for all subsequent duplicate parcels.
- Type **No** to be prompted to overwrite or rename duplicate parcels each time a duplicate parcel is found.

## Defining Parcels

After drawing the parcel geometry, you must define the parcels to the parcel database if you want to import, delete, or rename the parcel, or to report area, mapcheck, or inverse data.

### Defining a Parcel from Lines and Curves

**To define a parcel from lines and curves**

1 From the Parcels menu, choose Define from Lines/Curves.
2 Select the first object nearest the point of beginning (POB).
3 Using a window or crossing, select the remaining objects. Select all the objects in the enclosed area. The parcel lines cannot extend past the parcel intersection points along the perimeter.

The following illustration shows parcel line selection guidelines:
If the parcel does not close, then a closure error prompt displays and an X is placed at the invalid closure point. If it is at the start point of the parcel, then you can accept the default (Yes) to close from that point back to the POB; or you can type N (for No) to end the command and then correct the closure error.

4 If the Sequential on check box is cleared in the Parcel Settings dialog box, then type the parcel number. If the parcel number has already been used, then a prompt displays to overwrite or rename the parcel. If the Label parcels as defined check box is selected, the parcel label is added to the drawing. If the Automatic Label Placement check box is cleared, select the label insertion point and define the rotation angle. The label insertion point corresponds to the center of the first line of inserted text.

5 Select additional objects to define as a parcel.

**Defining a Parcel from a Polyline**

**NOTE** Selecting a polyline that has been spline-fitted causes erroneous areas to be reported.

To define a parcel from a polyline
1 From the Parcels menu, choose Define from Polylines.
2 Select the polyline. If the polyline does not close, then a closure error prompt displays and an X is placed at the end of the polyline. You can accept the default (Yes) to close back to the point of beginning (POB). If not, then type No to end the command and correct the closure error.
3 If the Sequential on check box is cleared in the Parcel Settings, then type the parcel number. If the parcel number has already been used, then a prompt displays to overwrite or rename the parcel. If the Label parcels as defined check box is selected, the parcel label is added to the drawing. If the Automatic Label Placement check box is cleared, select the label insertion point and define the rotation angle. The label insertion point corresponds to the center of the first line of inserted text.
4 Specify the label insertion point and rotation angle.
   The label is inserted and the command prompts for another polyline.
5 Select another polyline to define as a parcel, or press ENTER to exit the command.

**Defining a Parcel from Points**

To define a parcel from points
1 From the Parcels menu, choose Define from Points.
2 Select the first point location. When using this command, set the AutoCAD OSNAP mode to endpoint.
3 Select the points to define the area perimeter in either a clockwise or counterclockwise direction. At a curve in the perimeter, type C to define the curve. For more information, see “Selecting a Curved Parcel Line” in this chapter.
4 If sequential numbering is turned off, type the parcel number. If the parcel number has already been used, then a prompt displays to overwrite or rename the parcel.

5 Select the insertion point for the label and the rotation angle.

The label is inserted.

6 Select points to define another parcel, or press ENTER to exit the command.

The following illustration features point selection guidelines to define a parcel:

![Selecting points to define a parcel]

Sizing Parcels So They Are Specific Areas

To calculate the size of a parcel you can use several different methods. The following methods require that three sides of the parcel already exist in the drawing as lines or curves. You can then use the parcel sizing commands to specify a specific area where you want the parcel to be.

**Sizing a Parcel Using a Sliding Bearing Line**

Use the Slide Bearing method to size a parcel size by sliding a line of fixed direction between two direction lines. This command defines the direction for the new parcel line by points, a bearing, or an azimuth. Original parcel lines must be present in the drawing in order to use this command.

NOTE To define the parcel to the database when you size it, select the Define parcels as sized check box in the Parcel Settings dialog box.

To size a parcel by using a sliding line

1 From the Parcels menu, choose Slide Bearing.
2 Select the first point to define the boundary around the parcel. Use the AutoCAD OSNAPs when selecting points, or the area will not be exact.
3 Select the next point on the parcel.
NOTE If the defined perimeter of the parcel has a curve, then type C at the prompt and select the curve.

4 After you finish selecting points, press ENTER.
   The command then draws a rubberband from the first parcel point selected and prompts you for the direction.
5 Select two direction points. The direction points define the direction in which each line slides.
   The following prompt is displayed:
   Choose new parcel line direction.
   Quadrant (1-4) (Azimuth/Points):
6 Do one of the following to define the direction of the sliding line:
   Select two points to define the direction.
   NOTE If the new parcel line is to be parallel to another, then select points to specify the direction and use AutoCAD OSNAPs to snap to the endpoints of the line.
   ▪ Type a quadrant number and then type the bearing.
   ▪ Type A and then type the azimuth.
   The command displays the minimum area that can be defined by the new parcel line placed from the first point to the last point of the known parcel. Adjustments of the minimum area number may occur.
7 Type the area. The units are based on either English or Metric units. The English standard of measure uses square feet; metric uses square meters.
   The command draws a line between the first and second direction lines selected with the new parcel line direction specified, and places it on the current layer.
8 Type the parcel number, unless you selected sequential parcel numbering in the Parcel Settings dialog box.
9 Select another parcel to size, or press ENTER to exit the command.
The following illustration shows the points to pick when defining parcel size by a sliding line:

Sizing a parcel using a sliding line

**Sizing a Parcel Using a Radial Line**

Use the Radial method to size a parcel by using a line that is radial to an existing curve. Original parcel lines must be present in the drawing in order to use this command. You can use this method to create parcels that are radial to a curve when you draw cul-de-sacs.

**NOTE**
To define the parcel to the database when you size it, select the Define parcels as sized check box in the Parcel Settings dialog box.

**To size a parcel by using a radial line**

1. From the Parcels menu, choose Radial.
2. Select the first parcel point.

**NOTE**
To ensure proper calculation of the area, select all endpoints using the AutoCAD OSNAP END override. This command sets the AutoCAD OSNAP to CENTER for the selection of any curves. If you override this setting, then the area is miscalculated.

3. Select the next parcel points. Select the points starting at the backline and continuing up to the beginning of the radial curve.

**NOTE**
If the defined perimeter of the parcel has a curve, then type C at the prompt and select the curve. For more information, see “Selecting a Curved Parcel Line” in this chapter.

4. After you have finished selecting points, press ENTER.
5. Select a point both on the curve and the end of the curve. If the parcel line is extended, then it passes through the center point of the curve.
6 Select the direction point. This point and the parcel first point define the direction of the line that the new parcel line is drawn to. After you select the direction line, the command draws a temporary line from the beginning of the curve to the point on the curve to draw the radial from. The position of this line (relative to the parcel) determines whether the command adds or subtracts the area of the curve.

**NOTE** If the position of the temporary line is inside the parcel (i.e., the curve is convex to the parcel), then the Radial command works only if the direction line passes between the radius point of the curve and the curve itself.

The command displays the minimum area that can be defined by the new parcel line placed from the first point to the last point of the known parcel. Adjustments of the minimum area number may occur.

7 Enter the direction of the backline.

8 Type the area. The units are based on either English or Metric units. The English standard of measure uses square feet; the metric uses square meters. The command then draws a line radially from the curve to the selected direction line and places it on the current layer.

The command displays the computed area.

9 Select another parcel to size, or press ENTER to exit the command.

The following illustration shows the points to pick when defining parcel size with a radial line:

![Sizing a parcel with a radial line](image-url)
**Sizing a Parcel by Swinging a Bearing to a Line**

Use the Swing on Line command to size a parcel by swinging a bearing line from a known point along a line. Original parcel lines must be present in the drawing in order to use this command.

**NOTE**
To define the parcel to the database when you size it, select the Define parcels as sized check box in the Parcel Settings dialog box.

**To size a parcel by swinging a bearing to a line**

1. From the Parcels menu, choose Swing on Line.
2. Select the point to swing from.

**NOTE**
To ensure proper calculation of this area, select all endpoints using the AutoCAD OSNAP END override.

3. Select the points to define the parcel.

**NOTE**
If there is a curve within the defined perimeter of the parcel, then type C at the prompt and select the curve. For more information, see “Selecting a Curved Parcel Line” in this chapter.

4. Press ENTER when you have finished selecting points.
5. Select the direction point. This is a point along the line that the new line will swing to.
6. Type the desired area. The units are based on either English or Metric units. The English standard of measure uses square feet; the metric uses square meters.

The command draws a line from the swing point to the direction line and places it on the current layer. The computed area is the minimum area that can be defined by the new parcel line placed from the first point to the last point of the known parcel.

7. Select another parcel to size, or press ENTER to end the command.

The following illustration shows how to select points from which to swing a bearing to a line:

[Diagram showing the process of selecting points to size a parcel by swinging a bearing to a line]

Selecting points from which to swing a bearing to a line
Sizing a Parcel by Swinging a Bearing to a Curve

Use the Swing on Curve command to size a parcel by swinging a bearing line from a known point to a curve. Original parcel lines must be present in the drawing in order to use this command.

NOTE To define the parcel to the database when you size it, select the Define parcels as sized check box in the Parcel Settings dialog box.

To size a parcel by swinging a bearing to a curve
1 From the Parcels menu, choose Swing on Curve.
2 Select the point to swing from.
3 Continue selecting points to define the parcel.

NOTE If the defined perimeter of the parcel has a curve, then type C at the prompt and select the curve. For more information, see "Selecting a Curved Parcel Line" in this chapter.

4 Press ENTER when you have finished selecting points.
5 Select a point on the curve to which the line swings.
6 Select the end of the curve to which the line swings.
7 Type the desired area. The units are based on either English or Metric units. The English standard of measure uses square feet; the metric uses square meters.

The command draws a line from the swing point to the curve and displays the computed area. If it is not mathematically possible to create a parcel with the given parameters, then the command displays the following error message:

No solution found in maximum number of iterations.

8 Select another parcel to size, or press ENTER to exit the command.

The following illustration shows how to select points when sizing a parcel by swinging a bearing to a curve:

Sizing a parcel by swinging a bearing to a curve
Breaking Parcel Lines and Curves

The geometry that you draw to represent parcels must be discrete for each parcel. Parcel lines cannot cross each other. The only instance in which two parcels can share a line and curve is if the line or curve is a shared boundary between the two parcels. If you used lines or curves to draw the parcels, then you can break crossing lines by using the Break Lines/Curves command.

To break parcel lines and curves

1. From the Parcels menu, choose Break Lines/Curves.
2. Select the object to break.
3. Select the cutting object.

The command breaks the object at the point where it intersects with the cutting object.

The following illustration shows how to select objects to break:

Selecting objects to break
Getting Started with Labels

Before you create labels for lines, curves, spirals, and points, establish the label settings. The label settings control how labels and label styles are updated, the current label styles, label alignment and rotation, current tag number, and the label style files path.
Using the Labels Commands

Use the Labels commands to label the lines, polylines, curves, spirals, and points in your drawing. You can create four different label types:

- **Dynamic**: Can automatically update whenever an object is moved or edited, or if the label style is edited. To prevent dynamic labels from being updated, you can disable the global label update settings, you can disable the dynamic updating property for individual labels (effectively making the label “static”), or you can disassociate the labels. You can use the Update All Labels or Update Selected Labels command to update labels when the global label update settings are disabled, but not when the dynamic updating property is disabled.

- **Static**: Do not update if the label style or object changes. They always preserve their values and locations when an object or a style is edited. Static labels do not update when you use the Update All Labels or Update Selected Labels command. If you later want static labels to update dynamically, you can enable the dynamic updating property for individual labels.

- **Tag**: Can label the objects with tags. You can insert tables that contain the object information.

- **Geodetic**: Can label the latitude, longitude, grid northing, and grid easting of points, or label geodetic distances on lines based on the current zone for the drawing. Geodetic labels do not use label styles.

Each dynamic, static, and tag label is based on a label style. A label style controls both the appearance of the label and the data that is labeled.

**NOTE**

AutoCAD Land Development Desktop displays a message dialog box if you open a drawing that was created in Autodesk S8 Civil/Survey or Softdesk 7.6 and the drawing contains dynamic labels. This dialog box prompts you to select among three conversion options. You can choose to convert the labels, to convert the labels to static labels, or to leave the labels as is (no conversion).

Creating a Selection Set for Labeling

You can use two methods to select the objects that you want to label.

If the PICKFIRST variable is set to one (<1>), then you can select the objects to label or edit before selecting a command from either the shortcut menu or the Labels menu. You can select an object by clicking on it or by selecting two points to draw a window or crossing around it. To clear the selection set, press ESC.

If the PICKFIRST variable is set to zero (<0>), then you must select the objects to label after selecting a command from the Labels menu. To select the objects, you can use any selection method, such as fence, window, crossing, and so on. For more information about the pickfirst variable, see “Selecting an Object in PICKFIRST Mode” in the *AutoCAD 2000 User’s Guide*.

The selection set that you create can contain any type of object. You can create a selection set that contains both lines and curves, for example, and label them all simultaneously.
Changing the Label Settings

You can change the settings for line, curve, spiral, and point labels. The label settings control the following:

- The label styles path
- The global updating settings for the labels
- Which label styles and tag label styles are current
- Whether labels are aligned on the object

Specifying Which Folder Contains the Label Styles

Label styles are stored in a folder specified by the label style path. If you move the label styles, or create label styles in a different location than the default (c:\Program Files\Land Desktop R2\data\labels), then you must change the label style path.

Label Style File Extensions

- Line styles: .lns
- Curve styles: .crs
- Spiral styles: .sps
- Point styles: .pts
- Line tag styles: .ltt
- Curve tag styles: .ctt
- Spiral tag styles: stt

To specify the path for label styles

1. Display the Label Settings dialog box by doing one of the following:
   - From the Labels menu, choose Settings.
   - From the Labels menu, choose Show Dialog Bar and then click .

Changing the Label Settings
From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Label Settings and click the Edit Settings button.

2. Click the General tab.
3. Do one of the following to specify the folder where you want to save the styles:
   - In the Style Files Path box, type a different path.
   - Click Browse and select a folder for the label styles.

4. Click OK.

   **NOTE** Changing the path does not move the existing styles. To use the existing styles, they must be present in the Style Files Path.
Specifying How Labels are Updated

Dynamic labels can automatically update whenever you edit either the label style or the labeled object. The ability of labels to update depends on the global and individual label update settings you specify before and after creating labels.

There are two different ways to specify how labels are updated:

- You can use the Label Settings command to establish the global update settings for the drawing. This setting affects all new dynamic labels that are created, as well as the dynamic labels that already exist in the drawing (unless the individual label dynamic update property has been disabled). These global update settings do not affect static labels.
- You can use the Edit Label Properties command to establish the update setting for each individual label. For example, you can enable the dynamic updating settings for the drawing (in the Label Settings), but for selected labels, you can disable dynamic updating so those selected labels do not update. Static labels are created with the dynamic updating property disabled. By enabling this option, the static labels become dynamic.

NOTE: If you create dynamic labels and then disable the automatic updating options in the Label Settings dialog box, you still have the ability to update dynamic labels if the drawing information or label style changes. Just use the Update All Labels or Update Selected Labels command to update the labels. Static labels cannot be updated with the label update commands, but they can be updated by turning on the dynamic updating option in the Label Properties.

To specify the global label updating options

1. From the Labels menu, choose Settings to display the Labels Settings dialog box.
2. Click the General tab.
3 Under Label Options, select or clear the following check boxes:

- **Update Labels When Style Changes**: Select this check box to update dynamic labels when you edit a label style. Clear this check box if you do not want the labels to update when you edit a label style. If you create dynamic labels when this option is disabled, the dynamic labels do not update unless you re-enable this option. Use the Update All Labels or Update Selected Labels command, or use the Label Properties command.

- **Update Labels When Objects Change**: Select this check box to update dynamic labels when you edit labeled objects. This option updates the position and contents of the labels in your drawing when the objects are edited. If you have moved labels, and then you edit the object with this option enabled, then the labels are returned to their original insertion point relative to the object. If you create dynamic labels when this option is disabled, the dynamic labels do not update unless you re-enable the option. Use the Update All Labels or Update Selected Labels command, or use the Label Properties command.

4 Click OK.

**NOTE** These global update settings have no effect on static labels. Static labels are always created with the dynamic updating property disabled (this property is controlled on a per-label basis). However, you can edit the label’s properties at a later time to update the static label.

### Updating Labels Manually

The following example explains how to use the Update Selected Labels command on a dynamic label when the global label update settings are turned off.

**NOTE** If you have disabled the Dynamically Update Label Text property for a label in the Label Properties dialog box, then you cannot update the label manually.

**To update labels manually**

1 Label a line with a dynamic label.
2 Select the line, and then from the Labels menu, select Settings to display the Label Settings dialog box.
3 Click the General tab if it is not active.
4 Clear the Update Labels When Objects Change check box.
5 Click OK to exit the dialog box.
6 Select the line label and move it away from the line.
7 Edit the line to make it shorter or longer. Notice that the label does not update.
8 To update the label, from the Labels menu, select Update Selected Labels.
9 Select the line and press ENTER.

The label is moved back to its original position on the line and the label text is updated.
Changing the Settings for Labeling Lines

You can set up default settings for labeling the lines in your drawing. These settings include the default label style, the label alignment and rotation, and the tag style to use when you create tag labels.

NOTE These are global settings. You can edit the properties of individual labels by using the Edit Label Properties command.

To change the line label settings

1. From the Labels menu, choose Settings to display the Labels Settings dialog box.
2. Click the Line Labels tab.
3. From the Current Label Style list, select the line label style that you want to use.
4. Do one of the following to specify the label alignment. For more information, see “The Effects of Label Alignment” in this chapter.
   - Select the Align Label On Object check box to align the label text with the line. The label is rotated to match the angle of the line.
   - Clear the Align Label On Object check box if you do not want the label to match the line’s rotation angle. When this check box is cleared, the labels use the rotation angle specified in the Non-Aligned Label Rotation Angle box.

Changing the Settings for Labeling Lines 441
Whenever you edit the line, the label is not moved or rotated; it stays in the same location.

5 In the Non-Aligned Label Rotation Angle box, type the rotation angle for labels that are not aligned. Type this value in decimal degrees.

6 From the Force Bearings list, select one of the following options for labeling bearings:
   ■ Mixed: Labels lines using either north or south bearings. The lines are labeled using the direction in which they are drawn.
   ■ North: Labels lines using north bearings. For example, N45°45'58" E.
   ■ South: Labels lines using south bearings. For example, S45°45'58" W.

7 Under Tag Labels, select the Current Label Style for tags.

8 Under Tag Labels, specify the current tag number in the Current Tag Number box. The next tag that is created uses this number if it has not been used already.

9 Click OK.

The Effects of Label Alignment

When a dynamic label is aligned to an object, the following occurs:

■ If you move the line, the label maintains its location relative to the object.
■ If you move the label away from the line (using grip editing), the label is realigned with the object if you edit either the object or the label style.

When a label is not aligned to an object, the following occurs:

■ If you move the object, the label does not maintain its location relative to the object. It remains in its original location.
■ If you edit the label style, the label remains in its original location.
Changing the Settings for Labeling Curves

You can set up default settings for labeling the curves in your drawing. These settings include the default label style, the label alignment and rotation, and the tag style to use when you create tag labels.

NOTE These are global settings. You can edit the properties of individual labels by using the Edit Label Properties command.

To change the curve label settings

1. From the Labels menu, choose Settings to display the Labels Settings dialog box.
2. Click the Curve Labels tab.
3. From the Current Label Style list, select the curve label style that you want to use.
4. Do one of the following to specify the label alignment:
   - Select the Align Label On Object check box to align the label text with the curve. The label matches the curvature of the curve.
   - Clear the Align Label On Object check box to have the label match the curvature of the curve. When this check box is cleared, the labels use the rotation angle specified in the Non-Aligned Label Rotation Angle box. Whenever you edit the curve, the label is not moved or rotated; it stays in the same location.

See the Label alignment illustration in “Changing the Settings for Labeling Lines” in this chapter.
5. In the Non-Aligned Label Rotation Angle box, type the rotation angle for labels that are not aligned. Type this value in decimal degrees.
6. Under Tag Labels, select the Current Label Style for tags.
7. Under Tag Labels, specify the current tag number in the Current Tag Number box. The next tag that is created uses this number if it has not been used already.
8. Click OK.
Changing the Settings for Labeling Spirals

You can set up default settings for labeling the spirals in your drawing. These settings include the default label style, the label alignment and rotation, and the tag style to use when you create tag labels.

**NOTE**
These are global settings. You can edit the properties of individual labels by using the Edit Label Properties command.

**To change the spiral label settings**

1. From the Labels menu, choose Settings to display the Labels Settings dialog box.
2. Click the Spiral Labels tab.
3. From the Current Label Style list, select the spiral label style that you want to use.
4. Do one of the following to specify the label alignment:
   - Select the Align Label On Object check box to align the label text with the spiral.
   - Clear the Align Label On Object check box to have the labels use the rotation angle specified in the Non-Aligned Label Rotation Angle box. Whenever you edit the spiral, the label is not moved or rotated; it stays in the same location.

   See the Label Alignment illustration in “Changing the Settings for Lines” in this chapter.
5. In the Non-Aligned Label Rotation Angle box, type the rotation angle for labels that are not aligned. Type this value in decimal degrees.
6. Under Tag Labels, select the Current Label Style for tags.
7. Under Tag Labels, specify the current tag number in the Current Tag Number box. The next tag that is created uses this number if it has not been used already.
8. Click OK.
Changing the Settings for Labeling Points

You can set up default settings for labeling the points in your drawing. These settings include the default label style and the label rotation.

**NOTE** These are global settings. You can edit the properties of individual labels by using the Edit Label Properties command.

**NOTE** In order to label points, the Use the Current Point Label Style When Inserting Points check box must be selected in the Point Settings dialog box.

To change the point label settings

1. From the Labels menu, choose Settings to display the Labels Settings dialog box.
2. Click the Point Labels tab.

![Labels Settings dialog box]

3. From the Current Label Style list, select the point label style that you want to use.
4. In the Label Rotation Angle box, type the rotation angle for the point labels. Type this value in decimal degrees.
5. Click OK.
Label Styles

Label styles control how line, curve, spiral, and point labels appear and function. Styles control what is labeled, such as length, chord, or direction. They also control label position and text appearance, justification, and units. Point label styles can be set up to label points with information from an External Data Reference (XDRef) and to override point marker text. Point label styles also control the use of description key substitution.
Label Styles

Each label is based on a label style. A label style determines how a label appears, and what information it contains. For example, a label style can be set up to label distance above the line and direction below the line.

Styles make it easier to maintain consistency in your drawing documentation:

- Label appearance is controlled by the label style text properties, such as text style, layer, and justification. The label appearance is also affected by the precision values you select for the labels and formulas, and whether you choose to add crow’s feet, tick marks, or arrows to the label style.
- Label content is controlled by choosing data elements. Data elements are items such as Direction, Distance, Length, Latitude, and so on. These are the pieces of information that the label contains. You can apply formulas to data elements.

AutoCAD Land Development Desktop includes several default label styles. Each of the four supported object types (lines, curves, spirals, and points) have different label styles.

**NOTE** For future upgrading purposes, it is recommended that you do not edit the default label styles. Instead, create new label styles for your custom requirements. Or, after editing a default label styles, save it to a new name.

Selecting the Current Label Style

All new labels are created with the current label styles. There are always seven current label styles, two each for lines, curves, spirals (for regular labels and tag labels), and one for points. For example, you can select a current line label style that is used when you create new line labels, and a current point label style that is used when you create new point labels.

**NOTE** Points use the current label style unless the points are inserted by a group that has a label override applied to it.
Point Block Only Label Style

The Point Block Only point label style mimics the Autodesk S8 Civil/Survey point block appearance. This style has no text, no description key symbol, and the common block is the Autodesk S8 POINT block. The POINT block has block attributes for elevation, point number, and description. When points are inserted into the drawing using this style, the attribute values are filled in. However, there is still a point object that is inserted into the drawing, and AutoCAD Land Development Desktop functionality that depends on point objects operates correctly.

This style was implemented to provide a method whereby third-party and user routines and programs that depend upon the presence of POINT blocks can still be used.

Making a Selected Label Style the Current Label Style

You can make select any label in the drawing and make its style the current label style.

To make a selected label style the current label style

1. Click on the label in your drawing that is the style you want to make current.

   IMPORTANT You must select the label itself, not the object that is labeled.

2. Right-click to display the shortcut menu.

3. Select Set Label Style Current.

Selecting the Current Label Style from the Style Properties Dialog Bar

A quick method of changing the current label styles is to use the Style Properties dialog bar. From the Style Properties dialog bar, you can select the current label styles for lines, curves, spirals, and points. You can also select the current tag label styles for lines, curves, and spirals.

To select the current label style from the Style Properties dialog bar

1. From the Labels menu, choose Show Dialog Bar.

2. Click one of the four tabs: Line, Curve, Spiral, or Point.

3. From the Current Label list, select the current label style.
TIP To select regular label styles, be sure that the icon is displayed.

To select tag label styles, be sure that the icon is displayed. You can switch the icons by clicking on the icon that is currently visible.

Selecting the Current Label Style from the Labels Settings Dialog Box

When you are specifying label settings you can select the current label and tag styles to use.

To select the current label style from the Labels Settings dialog box

1. From the Labels menu, choose Settings to display the Labels Settings dialog box.

   ![Labels Settings dialog box]

2. Click on the appropriate tab. For example, to select a different current line label style, click on the Line Labels tab.

3. From the Current Label Style lists, select a current label style and a current tag label style.

   NOTE Points do not use tag labels.

4. Click OK.

Style Properties Dialog Bar

Use the Style Properties dialog bar to select the current label styles for lines, curves, spirals, and points; to access the Edit Label Styles and Labels Settings dialog boxes; and to change the label alignment setting.

To display the Style Properties dialog bar

- From the Labels menu, choose Show Dialog Bar.
Changing the Label Alignment Setting from the Style Properties Dialog Bar

You can change the alignment setting for labels from the Style Properties dialog bar. The alignment setting controls whether the labels are aligned to the object’s rotation angle or not.

See the Label Alignment illustration “Changing the Settings for Labeling Lines” in Chapter 22, “Getting Started with Labels.”

To change the label alignment setting
1. From the Labels menu, choose Show Dialog Bar.
2. Do one of the following:
   - Select the Align on Object check box to align the labels with the object’s rotation.
   - Clear the Align on Object check box if you do not want to align the labels with the object’s rotation. When you clear this check box, the labels are created using the non-aligned label rotation angle in the Label Settings dialog box.

Accessing the Edit Label Styles Dialog Box from the Style Properties Dialog Bar

To access the Edit Label Styles dialog box from the Style Properties dialog bar
1. From the Labels menu, choose Show Dialog Bar.
2. Click .

Accessing the Label Settings Dialog Box from the Style Properties Dialog Bar

To access the label settings dialog box from the label dialog bar
1. From the Labels menu, choose Show Dialog Bar.
2. Click .

Switching Between Label Styles and Tag Label Styles in the Style Properties Dialog Bar

You can use the Style Properties dialog bar to select the current label styles for regular labels and tag labels. The dialog bar shows either the regular label styles or the tag label styles, depending on the mode of the dialog box. You can switch modes to access both sets of styles.
To switch between label styles and tag label styles
1. From the Labels menu, choose Show Dialog Bar.
2. Do one of the following:
   - If the label icon is displayed, then click it to display the tag icon.
   - If the tag icon is displayed, then click it to display the label icon.

Editing Line Label Styles
Each line label style has properties that define what type of data the label style contains, what text style it uses, and what units it uses. Each label style has a unique name. To change any of these aspects, you can edit a label style.

**NOTE**
The Save and Delete buttons in the Edit Label Styles dialog box commit the changes that you have made. Clicking Cancel after clicking Save or Delete does not undo your changes.

To edit a line label style
1. Display the Edit Label Styles dialog box by doing one of the following:
   - From the Labels menu, choose Edit Label Styles.
   - From the Labels menu, choose Show Dialog Bar, verify that the label icon is visible, and then click.
   - Select a label, right-click, and then select Edit Label Style.
   - From the Projects menu, choose Edit Data Files to display the Edit Data Files dialog box. From the Program list, select Land Development Desktop. From the Data Files list, select Label Styles and click Edit Data.

**NOTE** Be sure that you select the label text; do not select the object that is labeled.
2 Click the Line Label Styles tab.

3 Do one of the following:
   - From the Name list, select the name of the label style that you want to edit.
   - To create a new label style, type a new name in the Name list. Be sure to click Save to save the new style. Label style names are limited to 255 characters, including path and file extension. Invalid characters include "/:*?". For future upgrading purposes, it is recommended that you do not edit the default label styles. Instead, create new label styles for your custom requirements. Or, after editing a default label style, save it to a new name.

   **NOTE**
   For future upgrading purposes, it is recommended that you do not edit the default label styles. Instead, create new label styles for your custom requirements. Or, after editing a default label style, save it to a new name.

When you select a style, the Text Above and Text Below sections of the dialog box display the selected data elements. The box on the right shows you a preview of what this label looks like.

4 You can specify the following label style items:
   - **Text Properties**: Controls the text style, offset, layer, and justification. For more information, see “Text Properties for Line Label Styles” in this chapter.
   - **Data Elements**: Controls which items the label style will label, such as distance or direction, text breaks, delta symbols, and the plus/minus symbol. For more information, see “Data Elements for Line Label Styles” in this chapter.
   - **Text Above and Text Below**: Controls where the label is placed, either above or below the object. Controls the label prefix and text and formulas added to labels. For more information, see “Data Elements for Line Label Styles” in this chapter.
■ **Units**: The linear and angular units. For more information, see “Units for Line Label Styles” in this chapter.

■ **Arrow, Tick, Crows Feet**: Controls whether symbols are placed on the object along with the label. For more information, see “Arrows, Ticks, and Crow’s Feet for Line Label Styles” in this chapter.

**Text Properties for Line Label Styles**

1. Complete the steps in “Editing Line Label Styles” in this chapter.
2. Under Text Properties, select a text Style for the label. If you select *Current*, then any time that you label an object using this style, the label is created using the current text style.

   **NOTE** If you subsequently change the current text style for the drawing (STYLE command), then the labels that were created using the *Current* option are updated to the new current style, even if the labels are static or disassociated.

3. If you selected a zero-height style, then specify a height in the Height box.

   **NOTE** If the selected text style has a fixed height, then the value in the Height box has no effect on the height.

4. You can specify an Offset for the label. This value is not a distance; it is a factor. The offset value that you specify is a factor that is multiplied by the text height to compute the actual offset distance.

   Offset value

   \[
   \text{Offset value} = \text{TEXT HEIGHT} \times \text{OFFSET VALUE}
   \]

5. Select a Layer for the label. If you select *Current*, then any time you label an object using this style, the label is placed on the current layer.

   **NOTE** If you subsequently change the current layer for the drawing, then the labels that were created using the *Current* option remain on their original layer.

6. Select one of the following justification methods for the text:

   ■ **Left**: Left-justifies the label on the object.
   ■ **Right**: Right-justifies the label on the object.
   ■ **Center**: Centers the label on the object.

**Data Elements for Line Label Styles**

You can change what a label style will label by selecting different data elements.
1 Complete the steps in “Editing Line Label Styles” in this chapter.
2 From the Data list, select the data element you want to include in the label. When you define line label styles, you can specify what items you want to label on each line. These items are called data elements. Select a data element, and then click the Text Above or Text Below button to add that element to the label style.

<table>
<thead>
<tr>
<th>Data element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Labels the length of the line.</td>
</tr>
<tr>
<td>Direction</td>
<td>Labels the direction of the line.</td>
</tr>
<tr>
<td>Start Northing</td>
<td>Labels the northing coordinate of the start point of the line.</td>
</tr>
<tr>
<td>Start Easting</td>
<td>Labels the easting coordinate of the start point of the line.</td>
</tr>
<tr>
<td>End Northing</td>
<td>Labels the northing coordinate of the end point of the line.</td>
</tr>
<tr>
<td>End Easting</td>
<td>Labels the easting coordinate of the end point of the line.</td>
</tr>
<tr>
<td>Text Break</td>
<td>Creates multiple text objects. A text break can be used to separate the labels on an object. When you insert this data element, it shows up as “100” in the preview box.</td>
</tr>
</tbody>
</table>

Text break

Plus/Minus Symbol

Inserts a plus/minus (±) symbol into the label.

**NOTE**

The Plus/Minus symbol only appears in the labels if the text style being used for the label supports the Plus/Minus symbol. Many true type fonts do not support this character.
3 Do one of the following:
   ■ Click the Text Above button to place the data element in the Text Above box.

   ![Text Above box]

   When you label an object with this style, any data element in the Text Above box appears in the label above the object.

   ■ Click the Text Below button to place the data element in the Text Below box.
   Any data element in the Text Below box appears in the label below the object.

   **NOTE** The 100.00 preview values next to the Text Above and Text Below boxes are numeric place holders and do not necessarily represent actual values.

   The following illustration shows the effects of selecting Text Above and Text Below:

   ![Illustration of Text Above and Text Below]

   **Text Above and Text Below for Line Label Styles**
   This information follows the steps in “Editing Line Label Styles” in this chapter.
   The Text Above and Text Below boxes contain the data elements for a label style. The box on the right shows a preview of what the label looks like.

   **NOTE** The 100.00 preview values next to the Text Above and Text Below boxes are numeric place holders and do not necessarily represent actual values.

   You can type text into these boxes. This text appears in the label. For example, you can type **meters** into one of these boxes to create metric labels with the word “meters” appended to the end of the label.

   You can make any of the following changes to the data elements for a label style:

   ■ In the Text Above or Text Below box, you can type, select, delete, copy, and paste text.

   ■ You can add prefixes or suffixes to labels. For example, you can type **meters** to append the word “meters” to the end of a label.

   ■ You can add formulas to labels by inserting them into the Text Above or the Text Below boxes. For more information, see “Using a Formula Within a Label Style to Convert Values” in this chapter.
Units for Line Label Styles
You can change the precision values for linear and angular units.

1 Complete the steps in “Editing Line Label Styles” in this chapter.
2 Under Units, select Linear to display the Linear Units dialog box.

3 Enter the precision values for the following units:
   ■ Linear: For labeling lengths.
   ■ Formula: For labeling the results of formula calculations.
   ■ Coordinate: For labeling northing and easting coordinates.

   NOTE: You can either type a value in the boxes, or use the up and down arrows
   to select a value.

4 Click OK to return to the Edit Label Styles dialog box.
5 Under Units, select Angular to display the Angular Units dialog box.

6 Select the Allow Text Spaces check box to place spaces in angular labels. When this
   check box is selected, an angle is labeled in the format (N 52°14′39″E). If you do
   not select this check box, then an angle is labeled without spaces (N 52°14′39″E).
7 In the Angular box, enter the precision for displaying angles. This precision value
   is used to label a line’s direction.
8 In the Formula box, enter the precision for displaying the results of
   formula calculations. This precision value is used if you apply a formula
   to the line’s direction.
9 Click OK to return to the Edit Label Styles dialog box.
Arrows, Ticks, and Crows Feet for Line Label Styles

To add arrows, ticks, or crows feet to the objects that you label.

1. Complete the steps in “Editing Line Label Styles” in this chapter.
2. Under Text Above and/or Text Below, do the following:
   - Select the Arrow check box to insert arrows on the objects you label to indicate their direction.
   - Select either Tick or Crows Feet to insert either tick marks or crows feet on the objects you label.

Editing Curve Label Styles

Each curve label style has properties that define what type of data the label style contains, what text style the label style uses, and what units the label style uses. Each label style has a unique name. You can edit a label style to change any of these aspects.

**NOTE**

The Save and Delete buttons in the Edit Label Styles dialog box commit the changes that you have made. Clicking Cancel after clicking Save or Delete does not undo your changes.

To edit a curve label style

1. From the Labels menu, choose Edit Label Styles to display the Edit Label Styles dialog box.
2. Click the Curve Label Styles tab.
3 Do one of the following:

- From the Name list, select the name of the label style that you want to edit.
- Type a new name in the Name list to create a new label style. Be sure to click Save to save the new style. Label style names are limited to 255 characters, including path and file extension. Invalid characters include `/ : * ? " < > |.

**NOTE**  
For future upgrading purposes, it is recommended that you do not edit the default label styles. Instead, create new label styles for your custom requirements. Or, after editing a default label style, save it to a new name.

When you select a style, the Text Above and Text Below sections of the dialog box display the selected data elements. The box on the right shows you a preview of what this label would look like.

4 You can edit any of the following label style items:

- **Text Properties**: Controls the text style, offset, layer, and justification. For more information, see “Text Properties for Curve Label Styles” in this chapter.
- **Data Elements**: Controls which items the label style will label, such as distance or direction, text breaks, delta symbols, and the plus/minus symbol. For more information, see “Data Elements for Curve Label Styles” in this chapter.
- **Text Above and Text Below**: Controls where the label is placed, either above or below the object. Controls the label prefix and text and formulas added to labels. For more information, see “Data Elements for Curve Label Styles” in this chapter.
- **Units**: The linear and angular units. For more information, see “Units for Curve Label Styles” in this chapter.
- **Arrow, Tick, Crow’s Feet**: Controls whether symbols are placed on the object along with the label. For more information, see “Arrows, Ticks, and Crow’s Feet for Curve Label Styles” in this chapter.

**Text Properties for Curve Label Styles**

1 Complete the steps in “Editing Curve Label Styles” in this chapter.

2 Under Text Properties, select a text Style for the label. If you select “Current”, then any time that you label an object using this style, the label is created using the current text style.

**NOTE**  
If you subsequently change the current text style for the drawing (STYLE command), then the labels that were created using the “Current” option are updated to the new current style, even if the labels are static or disassociated.

3 If you selected a zero-height style, then specify a height in the Height box.

**NOTE**  
If the selected text style has a fixed height, then the value in the Height box has no effect on the height.

4 You can specify an Offset for the label. This value is not a distance; it is a factor. The offset value that you specify is a factor that is multiplied by the text height to compute the actual offset distance.
5 Select a Layer for the label. If you select *Current*, then any time you label an object using this style, the label is placed on the current layer.

**NOTE** If you subsequently change the current layer for the drawing, then the labels that were created using the *Current* option remain on their original layer.

6 Select one of the following justification methods for the text:

- **Left**: Left-justifies the label on the object.
- **Right**: Right-justifies the label on the object.
- **Center**: Centers the label on the object.

**Data Elements for Curve Label Styles**

You can change what a label style will label by selecting different data elements.

1 Complete the steps in “Editing Curve Label Styles” in this chapter.

2 From the Data list, select the data element that you want to include in the label.

When you define curve label styles, you can specify what items you want to label on each curve. These items are called data elements. Select a data element, and then click the Text Above or Text Below button to add that element to the label style.

<table>
<thead>
<tr>
<th>Data element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radius</td>
<td>Labels the radius of the curve.</td>
</tr>
<tr>
<td>Length</td>
<td>Labels the length of the curve.</td>
</tr>
<tr>
<td>Delta Angle</td>
<td>Labels the central angle of the curve.</td>
</tr>
<tr>
<td>Tangent</td>
<td>Labels the tangent length of the curve.</td>
</tr>
<tr>
<td>Chord Direction</td>
<td>Labels the direction of the chord.</td>
</tr>
<tr>
<td>Chord</td>
<td>Labels the length of the chord.</td>
</tr>
<tr>
<td>Text Break</td>
<td>Creates multiple text objects. A text break can be used to separate the labels on an object. When you insert this data element, it shows up as “100” in the preview box.</td>
</tr>
<tr>
<td>Plus/Minus Symbol</td>
<td>Inserts a plus/minus (±) symbol into the label.</td>
</tr>
<tr>
<td>Delta Symbol</td>
<td>Inserts a delta symbol (Δ) into the label.</td>
</tr>
</tbody>
</table>

**NOTE** The Plus/Minus symbol only appears in the labels if the text style being used for the label supports the Plus/Minus symbol. Many true type fonts do not support this character.
3 Do one of the following:
  ■ Click the Text Above button to place the data element in the Text Above box.
    When you label an object with this style, any data element in the Text Above box appears in the label above the object.
  ■ Click the Text Below button to place the data element in the Text Below box.
    Any data element in the Text Below box appears in the label below the object.

  **NOTE**  The 100.00 preview values next to the Text Above and Text Below boxes are numeric place holders and do not necessarily represent actual values.

**Text Above and Text Below for Curve Label Styles**
This information follows the steps in “Editing Curve Label Styles” in this chapter.
The Text Above and Text Below boxes contain the data elements for a label style.
The box on the right shows a preview of what the label looks like.

  **NOTE**  The 100.00 preview values next to the Text Above and Text Below boxes are numeric place holders and do not necessarily represent actual values.

You can type text into these boxes. This text appears in the label. For example, you can type meters into one of these boxes to create metric labels with the word "meters" appended to the end of the label.

You can make any of the following changes to the data elements for a label style:
  ■ First complete the steps in “Editing Curve Label Styles” in this chapter.
  ■ In the Text Above or Text Below box, you can type, select, delete, copy, and paste text.
  ■ You can add prefixes or suffixes to labels. For example, you can type meters to append the word “meters” to the end of a label.
  ■ You can add formulas to labels by inserting them into the Text Above or the Text Below boxes. For more information, see “Using a Formula Within a Label Style to Convert Values” in this chapter.

**Units for Curve Label Styles**
You can change the precision values for linear and angular units.

1 Complete the steps in “Editing Curve Label Styles” in this chapter.
2 Under Units, select Linear to display the Linear Units dialog box.
3 Enter the precision values for the following units:
  ■ **Linear**: For labeling lengths. The precision value is used to label the delta angle.
  ■ **Formula**: For labeling the results of formula calculations.
  ■ **Coordinate**: For labeling northings and eastings.

  **NOTE**  You can either type a value in the boxes, or use the up and down arrows to select a value.
4. Click OK to return to the Edit Label Styles dialog box.
5. Under Units, select Angular to display the Angular Units dialog box.
6. Select the Allow Text Spaces check box to place spaces in angular labels. This setting is typically used only for line labels.
7. In the Angular box, enter the precision for displaying angles. This precision value is used to label chord direction only.
8. In the Formula box, enter the precision for displaying the results of formula calculations. This precision value is used to label formulas that are applied to chord direction.
9. Click OK to return to the Edit Label Styles dialog box.

**Arrows, Ticks, and Crows Feet for Curve Label Styles**

To add arrows, ticks, or crows feet to the objects that you label.

1. Complete the steps in “Editing Curve Label Styles” in this chapter.
2. Under Text Above and/or Text Below, do the following:
   - Select the Arrow check box to insert arrows on the objects you label to indicate their direction.
   - Select either Tick or Crows Feet to insert either tick marks or crows feet on the objects you label.

**Editing Spiral Label Styles**

Each spiral label style has properties that define what type of data the label style contains, what text style it uses, and what units it uses. Each label style has a unique name. To change any of these aspects, you can edit a label style.

**NOTE** The Save and Delete buttons in the Edit Label Styles dialog box commit the changes that you have made. Clicking Cancel after clicking Save or Delete does not undo your changes.

To edit a spiral label style

1. From the Labels menu, choose Edit Label Styles to display the Edit Label Styles dialog box.
Click the Spiral Label Styles tab.

Do one of the following:

- From the Name list, select the name of the label style that you want to edit.
- To create a new label style, type a new name in the Name list. Be sure to click Save to save the new style. Label style names are limited to 255 characters, including path and file extension. Invalid characters include \ / : * ? " < > |.

NOTE
For future upgrading purposes, it is recommended that you do not edit the default label styles. Instead, create new label styles for your custom requirements. Or, after editing a default label style, save it to a new name.

When you select a style, the Text Above and Text Below sections of the dialog box display the selected data elements. The box on the right shows you a preview of what this label looks like.

You can specify the following label style items:

- **Text Properties**: Controls the text style, offset, layer, and justification. For more information, see “Text Properties for Spiral Label Styles” in this chapter.
- **Data Elements**: Controls which items the label style will label, such as distance or direction, text breaks, delta symbols, and the plus/minus symbol. For more information, see “Data Elements for Spiral Label Styles” in this chapter.
Text Above and Text Below: Controls where the label is placed, either above or below the object. Controls the label prefix and text and formulas added to labels. For more information, see “Data Elements for Spiral Label Styles” in this chapter.

■ Units: Controls the linear units. For more information, see “Units for Spiral Label Styles” in this chapter.

■ Arrow, Tick, Crows Feet: Controls whether symbols are placed on the object along with the label. For more information, see “Arrows, Ticks, and Crow’s Feet for Spiral Label Styles” in this chapter.

Text Properties for Spiral Label Styles

1. Complete the steps in “Editing Spiral Label Styles” in this chapter.

2. Under Text Properties, select a text Style for the label. If you select *Current*, then any time that you label an object using this style, the label is created using the current text style.

   NOTE
   If you subsequently change the current text style for the drawing (STYLE command), then the labels that were created using the *Current* option are updated to the new current style, even if the labels are static or disassociated.

3. If you selected a zero-height style, then specify a height in the Height box.

   NOTE
   If the selected text style has a fixed height, then the value in the Height box has no effect on the height.

4. You can specify an Offset for the label. This value is not a distance; it is a factor. The offset value that you specify is a factor that is multiplied by the text height to compute the actual offset distance.

5. Select a Layer for the label. If you select *Current*, then any time you label an object using this style, the label is placed on the current layer.

   NOTE
   If you subsequently change the current layer for the drawing, then the labels that were created using the *Current* option remain on their original layer.

6. Select one of the following justification methods for the text:

   ■ Left: Left-justifies the label on the object.
   ■ Right: Right-justifies the label on the object.
   ■ Center: Centers the label on the object.

Data Elements for Spiral Label Styles

You can change what a label style will label by selecting different data elements.

1. Complete the steps in “Editing Spiral Label Styles” in this chapter.

2. From the Data list, select the data element that you want to include in the label.

   When you define spiral label styles, you can specify what items you want to label on each spiral. These items are called data elements. Select a data element, and then click the Text Above or Text Below button to add that element to the label style.
Data elements for editing spiral label styles

<table>
<thead>
<tr>
<th>Data element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radius</td>
<td>Labels the radius of the spiral at the point of transition from spiral to curve (SC), or curve to spiral (CS).</td>
</tr>
<tr>
<td>Length</td>
<td>Labels the length of the spiral.</td>
</tr>
<tr>
<td>Theta</td>
<td>Labels the theta angle of the spiral.</td>
</tr>
<tr>
<td>X</td>
<td>Labels the tangent length between TS and SC, or CS and ST.</td>
</tr>
<tr>
<td>Y</td>
<td>Labels the offset distance at SC from TS, or at CS from ST.</td>
</tr>
<tr>
<td>Short Tangent</td>
<td>Labels the length of the short tangent.</td>
</tr>
<tr>
<td>Long Tangent</td>
<td>Labels the length of the long tangent.</td>
</tr>
<tr>
<td>P</td>
<td>Labels the offset of the initial tangent in to the PC of the shifted curve, or the offset of the initial tangent out to the PT of the shifted curve.</td>
</tr>
<tr>
<td>K</td>
<td>Labels the abscissa of the shifted PC referred to the TS, or the abscissa of the shifted PT referred to the ST.</td>
</tr>
<tr>
<td>A</td>
<td>Labels the spiral A parameter, which is the square root of the product of the length and radius.</td>
</tr>
<tr>
<td>Text Break</td>
<td>Creates multiple text objects. A text break can be used to separate the labels on an object. When you insert this data element, it shows up as “100” in the preview box.</td>
</tr>
<tr>
<td>Plus/Minus Symbol</td>
<td>Inserts a plus/minus (±) symbol into the label.</td>
</tr>
</tbody>
</table>

**NOTE** The Plus/Minus symbol only appears in the labels if the text style being used for the label supports the Plus/Minus symbol. Many true type fonts do not support this character.

3 Do one of the following:

- Click the Text Above button to place the data element in the Text Above box. When you label an object with this style, any data element in the Text Above box appears in the label above the object.
- Click the Text Below button to place the data element in the Text Below box. Any data element in the Text Below box appears in the label below the object.

**NOTE** The 100.00 preview values next to the Text Above and Text Below boxes are numeric place holders and do not necessarily represent actual values.
Text Above and Text Below for Spiral Label Styles

This information follows the steps in “Editing Spiral Label Styles” in this chapter. The Text Above and Text Below boxes contain the data elements for a label style. The box on the right shows a preview of what the label looks like.

NOTE
The 100.00 preview values next to the Text Above and Text Below boxes are numeric place holders and do not necessarily represent actual values.

You can type text into these boxes. This text appears in the label. For example, you can type meters into one of these boxes to create metric labels with the word “meters” appended to the end of the label.

- First complete the steps in “Editing Spiral Label Styles” in this chapter.
- In the Text Above or Text Below box, you can type, select, delete, copy, and paste text.
- You can add prefixes or suffixes to labels. For example, you can type meters to append the word “meters” to the end of a label.
- You can add formulas to labels by inserting them into the Text Above or the Text Below boxes.

Units for Spiral Label Styles

You can change the precision values for linear units.

NOTE
Spiral labels do not use the angular precision values.

1. Complete the steps in “Editing Spiral Label Styles” in this chapter.
2. Under Units, select Linear to display the Linear Units dialog box.
3. Enter the precision values for the following units:
   - Linear: For labeling lengths.
   - Formula: For labeling the results of formula calculations.
   - Coordinate: For labeling northing and easting coordinates.

NOTE
You can either type a value in the boxes, or use the up and down arrows to select a value.

4. Click OK to return to the Edit Label Styles dialog box.

Arrows, Ticks, and Crows Feet for Spiral Label Styles

To add arrows, ticks, or crows feet to the objects that you label.

1. Complete the steps in “Editing Spiral Label Styles” in this chapter.
2. Under Text Above and/or Text Below, do the following:
   - Select the Arrow check box to insert arrows on the objects you label to indicate their direction.
   - Select either Tick or Crows Feet to insert either tick marks or crows feet on the objects you label.
Editing Point Label Styles

Each point label style has properties that define what type of data the label style contains, what text style it uses, and what units it uses. Each label style has a unique name. To change any of these aspects, you can edit a label style.

Point label styles control the use of description keys and the insertion of common symbol blocks at point nodes. In order to achieve the full effects of description key substitution, you must use a point label style that is set up to label description keys.

In addition, you can label points with information that is not in the project point database. If you have a custom Microsoft Access database that contains point information that you want to label points with, then you can define XDRefs (External Data References) and then use the XDRefs as part of label styles.

Both point markers and point labels can be visible in the drawing at the same time. You can format the label style so that it automatically turns off the point markers when you label the points. For more information, see “Differences Between Point Markers and Point Labels” in Chapter 6, “Getting Started with Points.”

**NOTE**

In order to label points that already exist in the drawing, the Use the Current Point Label Style When Inserting Points check box must be selected in the Point Settings dialog box. If this check box is selected when you are creating or inserting points, then the current point label style is automatically applied to the points—you do not have to label the points after they are inserted or created.

**NOTE**

The Save and Delete buttons in the Edit Label Styles dialog box commit the changes that you have made. Clicking Cancel after clicking Save or Delete does not undo your changes.

**To edit a point label style**

1. From the Labels menu, choose Edit Label Styles to display the Edit Label Styles dialog box.
2. Click the Point Label Styles tab.

3. Do one of the following:
   - From the Name list, select the name of the label style that you want to edit.
   - To create a new label style, type a new name in the Name list. Be sure to click Save to save the new style. Label style names are limited to 255 characters, including path and file extension. Invalid characters include \/: * ? " < > |.

   **NOTE** For future upgrading purposes, it is recommended that you do not edit the default label styles. Instead, create new label styles for your custom requirements. Or, after editing a default label style, save it to a new name.

When you select a style, the Text Above and Text Below sections of the dialog box display the selected data elements. The box on the right shows you a preview of what this label looks like.

4. You can specify the following label style items:
   - **Text Properties**: Controls the text style, offset, layer, and justification. For more information, see “Text Properties for Point Labels” in this chapter.
   - **Data Elements**: Controls the items that the label style will label, such as description or elevation, text breaks, and the plus/minus symbol. For more information, see “Data Elements for Point Labels” in this chapter.
   - **XDRef Elements**: Controls whether points are labeled with point data from custom databases. For more information, see “XDRef Elements for Point Labels” in this chapter.
• **Turn Off Marker Text**: Controls whether point markers are turned off when labels are created. For more information, see “Turn Off Marker Text for Point Labels” in this chapter.

• **Text**: Controls the point label prefix and text and formulas added to labels. For more information, see “Text for Point Labels” in this chapter.

• **Units**: Controls the linear and angular units. For more information, see Units for Point Labels” in this chapter.

• **Common Symbol**: Controls the symbol block inserted at the point node. For more information, see “Common Symbol for Point Labels” in this chapter.

• **Description Keys**: Controls description keys for symbols, descriptions, and layer control. For more information, see “Description Keys for Point Labels” in this chapter.

**Text Properties for Point Labels**

1. Complete the steps in “Editing Point Label Styles” in this chapter.
2. Under Text Properties, select a text Style for the label. If you select *Current*, then any time that you label an object using this style, the label is created using the current text style.

   **NOTE** If you subsequently change the current text style for the drawing (STYLE command), then the labels that were created using the *Current* option are updated to the new current style, even if the labels are static or disassociated.

3. If you selected a zero-height style, then specify a height in the Height box.

   **NOTE** If the selected text style has a fixed height, then the value in the Height box has no effect on the height.

4. You can specify an Offset for the label. This value is not a distance; it is a factor. The offset value that you specify is a factor that is multiplied by the text height to compute the actual offset distance.

5. Select a Layer for the label. If you select *Current*, then any time you label an object using this style, the label is placed on the current layer.

   **NOTE** If you subsequently change the current layer for the drawing, then the labels that were created using the *Current* option remain on their original layer.

6. Under Justification, select one of the justification methods for the point label. The option you select represents the location of the point node. The “X” in the center represents the location of the point label.

   **NOTE** The On Elevation justification method uses the elevation’s decimal point as the point node.

**Data Elements for Point Labels**

You can change what a label style will label by selecting different data elements.

1. Complete the steps in “Editing Point Label Styles” in this chapter.

2. From the Data list, select the data element that you want to include in the label.
When you define point label styles, you can specify what items you want to label on each point. These items are called data elements. Select a data element, and then click the Text button to add that element to the label style.

### Data elements for edit point label styles

<table>
<thead>
<tr>
<th>Data element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point Number</td>
<td>Labels the point number.</td>
</tr>
<tr>
<td>Elevation</td>
<td>Labels the point elevation.</td>
</tr>
<tr>
<td>Description</td>
<td>Labels the point description.</td>
</tr>
<tr>
<td>Northing</td>
<td>Labels the northing.</td>
</tr>
<tr>
<td>Easting</td>
<td>Labels the easting.</td>
</tr>
<tr>
<td>Point Name</td>
<td>Labels the point name.</td>
</tr>
<tr>
<td>Point Name or Number</td>
<td>Labels the point name or number. If the point is named, then the name is labeled. If the point is unnamed, then the point number is labeled.</td>
</tr>
<tr>
<td>Latitude</td>
<td>Labels the latitude.</td>
</tr>
<tr>
<td>Longitude</td>
<td>Labels the longitude.</td>
</tr>
<tr>
<td>Grid North</td>
<td>Labels the grid northing of the point, based on the current zone for the drawing.</td>
</tr>
<tr>
<td>Grid East</td>
<td>Labels the grid easting of the point, based on the current zone for the drawing.</td>
</tr>
<tr>
<td>Group Name</td>
<td>Labels the point with the name of the (most recent) group it was inserted from.</td>
</tr>
<tr>
<td>Text Break</td>
<td>Creates multiple text objects. When you insert this data element, it shows up as &quot;100&quot; in the preview box.</td>
</tr>
<tr>
<td>Plus/Minus Symbol</td>
<td>Inserts a plus/minus (±) symbol into the label.</td>
</tr>
</tbody>
</table>

**NOTE** The Plus/Minus symbol only appears in the labels if the text style being used for the label supports the Plus/Minus symbol. Many true type fonts do not support this character.

3. Click the Text button to add the data element to the label style.
**XDRef Elements for Point Labels**

You can label points with point data from custom Microsoft Access database files by specifying an External Data Reference (XDRef). XDRefs must be present before you can format a label style using an XDRef. For more information on formatting labels to use XDRefs, see “Example: Creating a Point Label Style that Labels Points with XDRef Information” in Chapter 9, “External Data References (XDRefs).”

1. Complete the steps in “Editing Point Label Styles” in this chapter.
2. From the XDRef list, select the external reference file that you want to obtain data from.
3. Click Text to insert the external reference into the label style.

When you label points using this style, the information from the custom database is inserted into the label text.

**NOTE** When floating point values are used as XDRefs and are displayed in the point label text, rounding is controlled by the Linear precision setting of the point label style.

**Turning Off Marker Text for Point Labels**

You can control whether point marker text is turned off when you label points.

Complete the steps in “Editing Point Label Styles” in this chapter. Then, do one of the following:

- Select the Turn Off Marker Text check box to turn off marker text when point labels are created using this label style.
- Clear the Turn Off Marker Text check box to keep marker text in the drawing when you label points.

**Text for Point Labels**

This information follows the steps in “Editing Point Label Styles” in this chapter.

The Text box contains the data elements for a label style. You can type text into these boxes. This text appears in the label. For example, you can type `meters` into one box to create metric labels with the word “meters” appended to the end of the label (for example, for an elevation label).

- In the Text box, you can type, select, delete, copy, and paste text.
- You can add prefixes or suffixes to labels.
- You can add formulas to labels by inserting them into the Text box.

**NOTE** The 100.00 preview value next to the Text box is a numeric place holder and does not necessarily represent an actual value.

**Units for Point Labels**

You can change the precision values for linear and angular units. For point labels, the linear units apply to the point elevation labels. The angular units apply to latitude and longitude labels.

1. Complete the steps in “Editing Point Label Styles” in this chapter.
Under Units, select Linear to display the Linear Units dialog box.

Enter the precision values for the following units:
- **Elevation**: For labeling elevations.
- **Formula**: For labeling the results of formula calculations.
- **Coordinate**: For labeling northing and easting coordinates.

**NOTE** You can either type a value in the boxes, or use the up and down arrows to select a value.

4 Click OK to return to the Edit Label Styles dialog box.
5 Under Units, select Angular to display the Angular Units dialog box.
6 Select the Allow Text Spaces check box to place spaces in angular labels. This setting is typically used only for line labels.
7 In the Angular box, enter the precision for displaying latitudes and longitudes.
8 In the Formula box, enter the precision for displaying the results of formula calculations applied to latitudes and longitudes.
9 Click OK to return to the Edit Label Styles dialog box.

**Common Symbols for Point Labels**
You can use a symbol block to represent the point node.

1 Complete the steps in “Editing Point Label Styles” in this chapter.
2 Under Common Symbol, select the Insert Common Symbol check box.
3 From the Block list, select the symbol block that you want to use.

**NOTE** If the symbol you want to use is not in the list, then verify that it is located in the symbol path, or change the symbol path.

4 Select a layer for the symbol. You can select a layer from the Layer list, or type a new name in the Layer list.

**NOTE** You can use the WBLOCK command to create custom symbol blocks.

**Description Keys for Point Labels**
Point label styles control description key substitution. You can use description keys to insert symbols and full descriptions for points, and to place point nodes and symbols on specified layers.

For more information about formatting a label style to use description keys, see “Example: Formatting a Point Label Style to Use Description Key Substitution” in Chapter 8, “Description Keys.”

1 Complete the steps in “Editing Point Label Styles” in this chapter.
2 Under Description, select the Description Key Matching check box.
3 From the DescKey File list, select the description key file that contains the description keys you want to use.
4 You can select one or both of the following options to control the description key matching:

- **Substitute DescKey Description**: Uses the description located in the description key file. If you clear this check box, then the raw description that you defined when the point was created is used.
- **Insert DescKey Symbol**: Inserts the symbol associated with the description key. If you clear this check box, then the symbol is not used.

**NOTE** If you do not select either of these check boxes, then the points are created on the layer specified by the description key, but no symbol insertion or description substitution occurs.

The following illustration shows point labels that use description keys:

![Illustration of point labels with description keys](image)

**Using a Formula Within a Label Style to Convert Values**

You can insert formulas into any label style or table by typing the formula within the {} (curly brackets) in either the Text Above or Text Below boxes (line, curve, and spiral label styles) or the Text box (point label styles). The preview box located to the right of the text boxes displays how the formula appears when it is calculated.

![Preview of formula in a label](image)

**NOTE** All internal angle calculations are done in radians.
**Formula Function Symbols**

Use the following functions to perform calculations on label values. These functions extend the capability of label styles.

<table>
<thead>
<tr>
<th>Function</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>addition</td>
</tr>
<tr>
<td>-</td>
<td>subtraction</td>
</tr>
<tr>
<td>*</td>
<td>multiplication</td>
</tr>
<tr>
<td>/</td>
<td>division</td>
</tr>
<tr>
<td>^</td>
<td>exponent</td>
</tr>
<tr>
<td>(</td>
<td>open parenthesis</td>
</tr>
<tr>
<td>)</td>
<td>closed parenthesis</td>
</tr>
<tr>
<td>ABS</td>
<td>absolute value of a number</td>
</tr>
<tr>
<td>ACOS</td>
<td>arccosine of a number</td>
</tr>
<tr>
<td>ASIN</td>
<td>arcsine of a number</td>
</tr>
<tr>
<td>ATAN</td>
<td>arctangent of a number</td>
</tr>
<tr>
<td>COS</td>
<td>cosine of a number</td>
</tr>
<tr>
<td>COSH</td>
<td>hyperbolic cosine of a number</td>
</tr>
<tr>
<td>EXP</td>
<td>e raised to the power of a number</td>
</tr>
<tr>
<td>LOG</td>
<td>logarithm of a number to a specified base</td>
</tr>
<tr>
<td>LOG10</td>
<td>base-10 logarithm of a number</td>
</tr>
<tr>
<td>POW10</td>
<td>number raised to a power of 10</td>
</tr>
<tr>
<td>ROUND</td>
<td>rounds to the closest integer</td>
</tr>
<tr>
<td>SIN</td>
<td>sine of a number</td>
</tr>
<tr>
<td>SINH</td>
<td>hyperbolic sine of a number</td>
</tr>
<tr>
<td>SQRT</td>
<td>square root of a number</td>
</tr>
</tbody>
</table>
### Formula function symbols (continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQR</td>
<td>square of a number</td>
</tr>
<tr>
<td>TAN</td>
<td>tangent of a number</td>
</tr>
<tr>
<td>TANH</td>
<td>hyperbolic tangent of a number</td>
</tr>
<tr>
<td>TRUNC</td>
<td>number truncated to an integer</td>
</tr>
</tbody>
</table>

**NOTE** Use parentheses ( ) with formulas as required by standard mathematical notation.

---

**Example: Converting Feet to Meters**

You can use a formula to label a line with both feet and meters.

**To set up a label style that labels both feet and meters**

1. From the Labels menu, choose Edit Label Styles to display the Edit Label Styles dialog box.
2. Click the Line Label Styles tab.
3. From the Name box, select direction above, distance below. In the Text Below box, \{Length\}' is displayed. This labels the line with its length, followed by a ‘ (foot) symbol.

   You can now use a formula to label the distance in both feet and meters.
4. From the Data list, select Length.
5. Click Text Below.

   You now have two Length entries in the Text Below box. One labels the length in feet. You can edit the second entry so that it labels the length in meters.

6. In the Text Below box, place your cursor after the second Length entry (but inside the closing curly bracket).
7. Press SPACEBAR and then type * .3048, the conversion factor for feet to meters. The asterisk, *, is the formula symbol for multiplication.
8. Type m for meters after the closing curly bracket, and place straight brackets [ ] around the metric length entry so that the Text Below box appears as follows:

   \{Length\}' [[Length * .3048]m]

9. Click Units to display the Linear Units dialog box.
10. In the Linear box, type 2. This labels the line length in feet with a precision of 2.
11. In the Formula box, type 3. This labels the line length in meters with a precision of 3.
12. Click Save to save the style.
13. Click OK to exit the dialog box.
Example: Labeling the Magnetic Direction

All internal angle calculations are done in radians. Take this into account when you apply a formula to an angle, such as when you label a line with both a true direction and a magnetic direction.

For example, to subtract a 15d 30' 15" magnetic declination from an astronomic direction to derive the magnetic direction, and then label the magnetic direction, you can use the following formula:

**Known:**
PI = 3.141592654
360 degrees = 2(PI)
1 radian = 57.29577951 degrees

**Given:**
15d 30' 15" = 15.50417 degrees

**Formula Syntax:**
\[ \text{Direction} - (15.50417 \times \left(\frac{2 \times 3.141592654}{360}\right)) \] or,
\[ \text{Direction} - (15.50417/57.29577951) \]

For more information about applying a formula within a label style, see the previous topic “Example: Converting Feet to Meters.”

Example: Using the TRUNC Function

This formula:

\[ [\text{TRUNC(Length)}]' - \left(\text{(Length)} - \text{TRUNC(Length)}\right) \times 12]" \]

Produces a label that looks like this:
149' - 10"
when you set the precision for the formula to zero.
Labeling Objects

You can label lines, curves, spirals, points, and polylines with static or dynamic labels. Static labels never update if you edit the object or change the label style. Dynamic labels can automatically update if the object or style is edited.

In addition, you can label points and lines with geodetic information such as grid northing and easting, latitude and longitude, scale factor, and convergence angle.
Dynamic Labels

To update the labels in a drawing when you edit the label style or the labeled object, label the objects in your drawing with dynamic labels. By default, dynamic labels are automatically updated whenever you edit either a label style or the object itself.

Any label style can be dynamic—the dynamic or static nature of a label is not defined within the label style. Whether a label is dynamic or static depends on the command you use to create the label and the current label updating property.

You can swap the text of dynamic labels so that the label above the object and the label below the object are exchanged. This is useful, for example, when you want to label an enclosed area with direction labels on the outside, and distance labels on the inside. You can also flip direction labels so that a label that says N79°47'58"E is changed to S79°47'58"W.

If you create dynamic labels and later you do not want them to update, you can:

- Disable the global update settings in the Label Settings dialog box. This prevents all dynamic labels in the drawing from changing. However, you can still use the Update All Labels, Update Selected Labels, and Edit Label Properties commands to update the labels.
- Disable the Dynamically Update Label Text option in the Label Properties dialog box. By disabling this option, the label becomes static, and you cannot use the Update All Labels or Update Selected Labels commands to update the labels. You must enable the dynamic property to update the labels. The global update setting does not affect the labels when the Dynamically Update Label Text option is disabled.
- Disassociate labels. After you disassociate labels, they can never be dynamic again, and can never update, regardless of the global setting.

Creating Dynamic Labels

To create labels that update automatically if you change the label style or edit the object that is labeled, use the Add Dynamic Labels command.

Using this command, you can select any group of objects to label. For example, the selection set can contain lines, arcs, spirals, and points, or any combination of the different object types. The current label styles are used for each different type of object. If you select an object that cannot be labeled with the Add Dynamic Labels command, such as a contour object, then the command ignores it. For more information, see “Selecting the Current Label Style” in Chapter 23, “Label Styles.”

NOTE: In order to label points, the Use the Current Point Label Style When Inserting Points check box must be selected in the Point Settings dialog box.

NOTE: The global update settings in the Label Settings dialog box affect how dynamic labels behave after they have been created. The global update settings must be enabled for the dynamic labels to update when the objects or styles change.
To label objects with dynamic labels
1 Select the current label styles.
2 From the Labels menu, choose Add Dynamic Labels.
3 Select the object(s) that you want to label.
4 Press ENTER.

or
1 Select the current label styles.
2 Select the object(s) that you want to label.
3 Right-click to display the shortcut menu.
4 Select Add Dynamic Labels.

Updating Selected Dynamic Labels
If you disabled the global updating options in the Label Settings dialog box, and you want to update selected dynamic labels, then you can use the Update Selected Labels command. This command updates the label style, label position, and label content.

NOTE This command does not work with static labels (labels that have the Dynamically Update Label Text property disabled) or disassociated labels.

To update selected labels
1 From the Labels menu, choose Update Selected Labels.
2 Select the objects that have the labels you want to update.
3 Press ENTER.

or
1 Select the objects that have the labels you want to update.
2 Right-click to display the shortcut menu.
3 Click Update Labels.

Updating All Dynamic Labels in the Drawing
If you disabled the global updating options in the Label Settings dialog box, and you want to update all of the dynamic labels in your drawing, then you can use the Update All Labels command. This command updates the label style, label position, and label content.

NOTE This command does not work with static labels (labels that have the Dynamically Update Label Text property disabled) or disassociated labels.
To update all the labels in a drawing

■ From the Labels menu, choose Update All Labels.

NOTE An alternative to using this command would be to re-enable the global updating options in the Label Settings dialog box.

Swapping Label Text
You can switch which labels are above and below a line by using the Swap Label Text command. This command is useful if you label a parcel or boundary and want all the labels on the outside of the boundary to label one feature of the line (for example, distance), and all the labels inside the boundary to label another feature of the line (for example, direction).

NOTE This command does not work with static labels (labels that have the Dynamically Update Label Text property disabled) or disassociated labels.

To swap label text
1 From the Labels menu, choose Swap Label Text.
2 Select the objects that have the labels you want to swap.
3 Press ENTER.

Changing the Angular Direction of a Label
You can switch the bearing or azimuth of a line label by using the Flip Direction command. For example, if a line is labeled N74°53'51"E and you flip the label's direction, the label changes to S74°53'51"W.

NOTE This command does not work with dynamic labels on polylines, static labels (labels that have the Dynamically Update Label Text property disabled) or disassociated labels. However, you can flip the label direction for individual objects (like polylines) by using the Edit Label Properties command to force the bearing to use a specific direction, like North.

To change the angular direction of a line label
1 From the Labels menu, choose Flip Direction.
2 Select the lines that contain the labels you want to flip.

or
1 Select the lines that contain the labels you want to flip.
2 Right-click to display the shortcut menu.
3 Click Flip Direction.

Deleting Labels

To delete labels from your drawing, use the Delete Labels command. If you select an object that does not contain dynamic or static labels, such as a contour object, then the command ignores it.

**NOTE** This command does not work with disassociated labels.

To delete labels
1 From the Labels menu, choose Delete Labels.
2 Select the objects that have the labels you want to delete.
3 Press ENTER.

or

1 Select the objects that have the dynamic labels you want to delete.
2 Right-click to display the shortcut menu.
3 Select Delete Labels.

Disassociating Labels to Prevent Auto-Updating

You can turn dynamic labels into labels that never update by disassociating the label from the object.

**WARNING!** You cannot use the Update Selected Labels, Update All Labels, Flip Direction, or Swap Label Text commands on disassociated labels. Nor can you change the labels back to dynamic labels after you use the Disassociate Labels command. If you think you may need to update the labels at some time, instead of disassociating the labels, you can disable the dynamic updating property for the selected labels and then enable it when you must update the labels.
To disassociate labels
1 From the Labels menu, choose Disassociate Labels.
2 Select the objects that have the labels you want to disassociate.
3 Press ENTER.
   or
1 Select the objects that have the labels you want to disassociate.
2 Right-click to display the shortcut menu.
3 Select Disassociate Labels.

Grip Editing Label Text
Each label that you place on an object has grips. Use these grips to move the text along the object, or to rotate the text.

To grip edit label text
1 Verify that grips are enabled. For more information, see “Editing with Grips” in the AutoCAD 2000 User's Guide or online Help.
2 Click on the label text that you want to move or rotate.
3 Click on a grip to activate it.
4 Move the grip to the new location, or press SPACEBAR to cycle to another grip editing option.

   NOTE   The ROTATE option does not work on arcs.

If you are moving the label text on a curve, the label text flips automatically as you move it to maintain its legibility in plan view.

Changing the Properties of Labels
After you label an object in your drawing with a dynamic or static label, you can modify the label properties. The label properties include dynamic updating, label alignment, label swapping, and what type of bearing labels are being used.

You can turn a static label into a dynamic label, and vice versa, by changing the Dynamically Update Label Text property.

To change the properties of a label
1 Select the label(s) that you want to edit.

   IMPORTANT   You must select the label itself, not the object that is labeled.
2 Right-click to display the shortcut menu, and then select Edit Label Properties.

3 Select or clear the following check boxes to change the behavior of the selected labels:

- **Dynamically Update Label Text**: This check box switches the state of labels between static and dynamic. When this check box is selected, the label is dynamic and updates if the style or the object changes (however, this updating behavior is dependent on the global update settings in the Label Settings dialog box). When this check box is cleared, the label is static and does not update if the style or object changes.

  **NOTE**: For point labels, Dynamically Update Label Text is the only label property that is editable in the Label Properties dialog box.

- **Swap Label Text**: This check box switches the label (including arrow and crows feet) above the object with the label below the object.

- **Align Label Text on Object**: This check box changes the label’s alignment property. To align the text on the object, select the Align label text on object check box. If you clear this check box, then the label is reoriented so it matches the non-aligned label rotation angle in the Label Settings. In addition, the label is not repositioned if the object is edited.

- **Force Bearings**: This check box specifies how bearing labels for lines are formatted. To force all bearing labels and arrows to point in one direction, you can select North or South from the Force Bearings list. To mix (North or South) the bearing arrows, select Mixed. This setting only applies to line labels.

- **Tag Number**: This option specifies the current tag number for tag labels only. You can select a different, unused tag number for the tag label if needed. If you select more than one tag label from the drawing and then use the Edit Label Properties command, this option is unavailable.

4 Click OK.

**NOTE**: When you use the Label Line By Points or Label Curve by Points command to create tag labels, the editable label properties are limited to tag number only. This is because the labels are not associated with objects. Even if you change the tag number in the properties, the tag in the drawing is not updated. You must edit the tag in the drawing with the DDEDIT command to change it.
Static Labels

If you do not want the labels you create to be updated when you edit a label style or a labeled object, then label the objects with static labels.

Static labels:

- Never update when you edit the object or label style.
- Never update when you use the Update Selected Labels or Update All Labels commands.
- Are not affected by the automatic updating settings in the Label Settings dialog box.
- Cannot be swapped from one position on an object to the other (above/below the object).
- Cannot have their directions flipped.

You can use any label style to create static labels—the dynamic or static nature of a label is not defined within the label style. Whether a label is dynamic or static depends on the command you use to create the label.

If you create static labels and later want them to update, you can enable the Dynamically Update Label Text option in the Label Properties dialog box. Doing this makes the label dynamic. If you never want anyone to have the ability to update the labels, then you can disassociate the static labels so no one can ever enable their updating properties.

NOTE Curve labels always move with the curve if you edit the curve’s position, even when the label is static. However, the label text itself does not change values when the label is static.

Creating Static Labels

To create labels that do not automatically update if you change the label style or edit the object that is labeled, use the Add Static Labels command.

Using this command, you can select any group of objects to label. For example, the selection set can contain lines, arcs, spirals, and points, or any combination of these different objects. If you select an object that cannot be labeled with the Add Static Labels command, such as a contour object, then the command ignores it.

NOTE In order to label points, the Use the Current Point Label Style When Inserting Points check box must be selected in the Point Settings dialog box.

NOTE The global update settings in the Label Settings dialog box have no effect on static labels.
To label objects with static labels

1. Select the current label styles. For more information, see “Selecting the Current Label Style” in Chapter 23, “Label Styles.”
2. From the Labels menu, choose Add Static Labels.
3. Select the objects that you want to label.
4. Press ENTER.

or

1. Select the current label styles.
2. Select the object(s) that you want to label.
3. Right-click to display the shortcut menu.
4. Select Add Static Labels.

Labeling Line and Curve Segments

To label line and curve segments instead of entire lines and curves, you can use the Label Lines By Points and Label Curves By Points commands. These commands give you the flexibility of labeling lines and curves that are shared and may require more than one label, such as the lines in a parcel map. By using the label by points commands, you can create the labels you need without having to break shared objects, or draw duplicate objects.

Using the label by points commands, you can create full text labels, or you can create tag labels. After you create the tag labels, you can create tag tables. The labels created with the label by points commands are not associated with any object or object segment. Therefore, they cannot update dynamically if the objects or label styles change.

When you use the label by points commands to create tag labels, the only property of the tag labels you can change later (by using the Edit Label Properties command) is the current tag number. All the other options in the Label Properties dialog box are grayed out. If you change the tag number in the Label Properties dialog box, the tag in the drawing does not automatically update. You must edit the tag label text using the DDEDIT command to match the text in the drawing with the assigned tag number. An object table you create always uses the tag displayed in the drawing, regardless of a tag label’s assigned tag number.

NOTE You cannot change any property of regular, full-text labels created with the label by points commands.
Labeling Line Segments By Selecting Points to Define the Line Segments

You can use the Label Line By Points command to label a selected line segment with a static label by selecting points to define the line segment or by selecting the line itself.

By being able to select a line segment to label, instead of the entire line, you have added flexibility when labeling lines that are shared, such as the lines in a parcel map. You do not have to break those shared lines, or draw duplicate lines, to label the segments you want.

Using the Label Line By Points command, you can label line segments with full text labels, or you can label the line segments with tag labels. After you create the tag labels, you can use the Line Table command to create a tag table.

The labels created with the Label Line By Points command are not associated with the line or line segment. Therefore, they cannot update dynamically if the line segment or style change. Unlike static labels you create with the Add Static Labels command, labels created with the Label Line By Points command can never be turned into dynamic labels.

To label a line segment by selecting points

1. Select the current label styles.
   The Label Line by Points command uses the current line label style (or current tag style) to label the lines. For more information, see “Selecting the Current Label Style” in Chapter 23, “Label Styles.”

2. From the Labels menu, choose Label Line By Points.
   The following prompt is displayed:
   Create Tag Labels? <Yes/No> <No>:

3. Do one of the following:
   - Type No to label the line segments with full text labels.
   - Type Yes to label the line segments with tag labels.

   **NOTE** When you use this command to create tag labels, the only property of the tag label you can change later (by using the Edit Label Properties command) is the current tag number. However, if you change the tag number in the label properties, the tag in the drawing does not automatically update. You must edit the tag label text using the DDEDIT command to match the text in the drawing with the assigned tag number. A line table you create always uses the tag displayed in the drawing, regardless of a tag label’s assigned tag number.

The following prompt is displayed:
Select Points (or line):
4 Do one of the following to select the line that you want to label:

- **Points**: Select the end points of the line. If the line segment you want to select connects COGO points, then you can use the .G, .P, and .N point selection filters to select these points. You can also use Osnaps to accurately select the points. If the POints option is not active, then type PO and press ENTER before selecting the points.

- **Line**: Type Line and then select the line using any standard AutoCAD selection method. This selection method selects the entire line.

**TIP** You can tell whether or not a label in your drawing was created with the Label Line By Points command by looking at the Label Properties. Select the label, right-click, and select Edit Label Properties. The Label Properties dialog box appears but everything is grayed out (except for the tag number setting if the label is a tag label). The dialog box is grayed out because labels created by the Label Line By Points command are not associated with any line object. Therefore, they cannot be dynamically updated and are not affected by changing the Label Properties.

5 Continue to select lines to label, or press ENTER to end the command.

**Labeling Curve Segments by Selecting Points to Define the Curve Segments**

You can use the Label Curve By Points command to label a curve segment by selecting points to define the curve segment, or by selecting the curve itself.

By being able to select a curve segment to label, instead of the entire curve, you have added flexibility when labeling curves that are shared, such as the curves in a parcel map. You do not have to break those shared curves, or draw duplicate curves, to label the segments you want.

Using the Label Curve By Points command, you can label curve segments with full text labels, or you can label the curve segments with tag labels. After you create the tag labels, you can use the Curve Table command to create a tag table.

The labels created with the Label Curve By Points command are not associated with the curve or curve segment. Therefore, they cannot update dynamically if the curve segment or label style changes. Unlike static labels you create with the Add Static Labels command, labels created with the Label Curve By Points command can never be turned into dynamic labels.

**To label a curve segment by selecting points**

1 Select the current curve label styles. The Label Curve By Points command uses the current curve label style (or current tag style) to label the curves. For more information, see “Selecting the Current Label Style” in Chapter 23, “Label Styles.”

2 From the Labels menu, choose Label Curve By Points.

The following prompt is displayed:

Create Tag Labels? <Yes/No> <No>:
3  Do one of the following:
   ■ Type No to label the curve segments with full text labels.
   ■ Type Yes to label the curve segments with tag labels.

   **NOTE**  When you use this command to create tag labels, the only property of the
tag label you can change later (by using the Edit Label Properties command) is the current tag number. However, if you change the tag
number in the label properties, the tag in the drawing does not
automatically update. You must edit the tag label text using the DDEDIT
command to match the text in the drawing with the assigned tag
number. A curve table you create always uses the tag displayed in the
drawing, regardless of a tag label’s assigned tag number.

The following prompt is displayed:
Select Points (or Curves):

4  Do one of the following to select the curve segment that you want to label:
   ■ Points: Select the point of curvature, a point on the curve, and the point of
tangency. If the curve segment you want to select connects COGO points,
then you can use the .G, .P, and .N point selection filters to select these points.
If not, you can use Osnaps to accurately select the points. If the POints option
is not active, then type PO and press ENTER before selecting the points.
   ■ Curve: Type Curve and then select the curve using any standard AutoCAD
selection method. This selection method selects the entire curve.

5  Continue to select curve segments to label, or press ENTER to end the command.

   **TIP**  You can tell whether or not a label in your drawing was created with the
Label Curve By Points command by looking at the Label Properties. Select
the label, right-click, and select Edit Label Properties. The Label Properties
dialog box appears but everything is grayed out (except for the tag
number setting if the label is a tag label). The dialog box is grayed out
because labels created by the Label Curve By Points command are not
associated with any curve object. Therefore, they cannot be dynamically
updated and are not affected by changing the Label Properties.

---

**Labeling Polylines**

You can label polylines with the current line and curve label styles. Straight polyline
segments are labeled with the current line label style. Curved polyline segments are
labeled with the current curve label style. Each polyline segment can have more
than one label.

   **NOTE**  Only lightweight polylines can be labeled.
To label polylines
1 Select the current label styles for lines and curves. For more information, see “Selecting the Current Label Style,” in Chapter 23, “Label Styles.”
2 Select the polyline(s) you want to label.
3 Right-click to display the shortcut menu.
4 Select Add Dynamic Labels or Add Static Labels.

**NOTE** If you use the TRIM command to edit the polylines after they are labeled with dynamic labels, then the polyline labels disappears if the resulting segment type is different than the original segment type.

---

**Labeling Points with Northing and Easting Coordinates**

You can create northing/easting labels for points in your drawing. These labels are not dynamic and they are not based on the current point label style. Instead, they use the current text style for the labels.

**To label points with northing and easting coordinates**
1 From the Labels menu, choose Label North/East.
2 Select the point that you want to label. You can use point filters to select exact points.
3 Select a location in the drawing where you want to insert the label.
4 Do one of the following to define the rotation angle of the label:
   - Type a rotation angle at the command line in the format indicated.
   - Pick a point in the drawing to define the rotation angle. The angle used is the angle between the insertion point of the label and the rotation angle point you select.
5 Select an additional point to label, or press ENTER to end the command.

---

**Labeling Points with Geodetic Information**

You can label points and lines in your drawing with specific geodetic features. You choose which features you want to label by adjusting the geodetic point label and line label settings. These features include latitude and longitude, grid northing and grid easting, scale factor, convergence, and local northing and local easting, grid angle, grid distance, local angle, local distance, and geodetic distance.

**NOTE** These labels do not use the current point and line label styles. Instead, they use the current text style. They are placed on the layers specified in the Geodetic Annotation Settings dialog box.
Chapter 24  Labeling Objects

Changing the Geodetic Point Label Settings

To specify how points are labeled with geodetic features

1. Set the Current Zone and the Transformation Settings. For more information, see “Changing the Current Zone for a Drawing” in Chapter 4, “Setting Up Drawings” and “Changing the Geodetic Zone Transformation Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”

2. Display the Geodetic Annotation Settings dialog box by doing one of the following:
   - From the Labels menu, choose Geodetic Labels ➤ Geodetic Label Settings.
   - From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Geodetic Labels and click the Edit Settings button.

You can label each point with up to six different pieces of information. These six features are represented by fields. The field number is displayed on the far left of the dialog box.

3. Under Point Annotation, set the Type for each field number. You can select one of the following options for each field:
   - None
   - Grid northing
   - Grid easting
   - Latitude
   - Longitude
   - Convergence
   - Scale Factor
   - Local northing
   - Local easting

Chapter 24  Labeling Objects

490
For example, to label a point with only Grid northing and Grid easting, set field #1 to Grid northing, and field #2 to Grid easting, and all the other fields to None.

4 To use any kind of prefix or suffix for the labels, type the text in the Prefix and Suffix boxes.
   For example, the default prefix for Grid northing, Grid N, places Grid N in front of the value.

5 In the Precision edit boxes, type the precision for each point label field.

6 To use a bracket to set off the labels when they are placed in the drawing, select the Leader Bracket check box.

7 In the Layer edit box, type the name of the layer for the point labels.

8 Set the Label Line Settings for labeling lines with geodetic features, or click OK to exit the dialog box. For more information, see the following topic “Changing the Geodetic Line Label Settings.”

**Changing the Geodetic Line Label Settings**

**To specify how lines are labeled with geodetic features**

1 Set the Current Zone and the Transformation Settings. For more information, see “Changing the Current Zone for a Drawing” in Chapter 4, “Setting Up Drawings” and “Changing the Geodetic Zone Transformation Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”

2 Display the Geodetic Annotation Settings dialog box by doing one of the following:
   ■ From the Labels menu, choose Geodetic Labels ➤ Geodetic Label Settings.
   ■ From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Geodetic Labels and click the Edit Settings button.

3 Under Line Annotation, do one of the following to determine whether the directions of the lines are labeled with azimuths or bearings:
   ■ Select the Azimuths check box to label the direction with an azimuth.
   ■ Clear the Azimuths check box to label the direction with a bearing. When you clear the Azimuths check box, the Az label changes to Brg.

4 In the Precision box, type the line label precision.

5 In the Layer edit box, type the name of the layer for the line labels.

6 Select one or more of the following options to determine how you want to label lines:
   ■ Select the Grid check box to label lines with the grid data. Select the Az/Brg check box to label the grid angle of the lines. Select the Grid Dist check box to label the grid distance of the lines. The Grid northing and easting is based on the current zone.
   ■ Select the Ground check box to label lines with the direction and distance calculated with the local northing and easting coordinates. Select the Ground Az/Brg check box to label the local angle of the lines. Select the Ground Dist check box to label the local distance of the lines.
   ■ Select the Geodetic Dist check box to label lines with the geodetic distance, which is a distance in which the Earth’s curvature is taken into account.
7 Using the Placement lists, select the label placement. You can place the labels Above or Below the lines. The labels are placed at the same angle as the line.
8 To use a prefix or suffix for the labels, type the text in the Prefix and Suffix edit boxes.
9 Using the Distance Unit scroll box, select either Feet or Meters as the unit of measurement for the distances.
10 In the Distance Precision edit box, type the precision for labeling distances.
11 Click OK to exit the dialog box.

**Labeling a Point with Geodetic Data**

You can label a location or a COGO point with geodetic features.

**To label a point with geodetic features**
1 Change the Geodetic Label Settings. For more information, see “Changing the Geodetic Point Label Settings” in this chapter.
2 From the Labels menu, choose Geodetic Labels ➤ Label Location. The current zone is listed at the command line.
   The following prompt is displayed:
   Enter label point:
3 Select the point you want to label. You can use point filters to select the point.
4 You can select a point to define a leader.
   If you draw the leader to the left of the point, then the label text is right-justified.
   If you draw the leader to the right of the point, the label text is left-justified.
5 You can continue to select leader points.
6 Press ENTER to place the label in the drawing.

**Labeling a Line with Geodetic Data**

You can label lines in your drawing with geodetic features.

**To label a line with geodetic features**
1 Set the Geodetic Annotation Settings. For more information, see “Changing the Geodetic Line Label Settings” in this chapter.
2 From the Labels menu, choose Geodetic Labels ➤ Label Line.
   The current zone is listed at the command line.
3 To select the line, do one of the following:
   - Click the line.
   - Type PO and then select points to select the object.
4 Continue selecting lines to label, or press ENTER to end the command.
Creating a Building Offset Label

You can label the perpendicular offset distance between a building corner and a property line by using the Building Offset command. An object representing a building corner and another representing a property line must exist in the drawing to use this command.

NOTE This command is affected by the current AutoCAD dimension variables.

To label the perpendicular offset distance

2. Select the building corner. The AutoCAD OSNAP mode is automatically set to ENDPOINT for this selection, but you can override it.
3. Select a point on the property line. The AutoCAD OSNAP mode is automatically set to PERPENDICULAR at this prompt. Do not override this setting.

After you select the points, the perpendicular distance is labeled on the current layer.

The following illustration shows an offset label placed between a building and a property line:

![Building offset label](image-url)
25

Creating Object Tables

You can label the lines, curves, spirals, and polylines in your drawing with tag labels, and then create object tables that list the detailed information about each object.
Tag Labels and Object Tables

If the objects in your drawing are too short for regular labels, or if you want to present all the information about the objects in a table, then you can label the objects with tag labels. You can then create an object table that lists the detailed information about each object.

Tag labels have their own label styles. Default styles are included with AutoCAD Land Development Desktop, which you can use as-is or customize. Tag label styles do not determine which information is displayed in the tables. To control what pieces of information are created for an object, you must set up the table columns. You can then save this setup to a file which you can use in the future.

Tag Label Styles

Each tag label is based on a tag label style. A tag label style determines how a label appears. However, it does not determine what information is displayed in the object table.

- Tag label appearance is controlled by the tag label style text properties, such as the text style used for the label, the layer for the label, and the justification of the label text.
- The content of the object table is controlled by setting up table columns with the Line Table, Curve Table, and Spiral Table commands.

Three default tag label styles are included in AutoCAD Land Development Desktop, one each for lines, curves, and spirals. You can edit these styles and create new ones, depending on your requirements.

Editing Line Tag Label Styles

To edit a line tag label style

1 Display the Edit Tag Label Styles dialog box by doing one of the following:
   - From the Labels menu, choose Edit Tag Label Styles.
   - From the Labels menu, choose Show Dialog Bar, verify that is visible, and then click .
   - Select a tag label, right-click, and select Edit Label Style.

**NOTE** Be sure that you select the label text; do not select the object that is labeled.
From the Projects menu, choose Edit Data Files to display the Edit Data Files dialog box. From the Program list, select Land Development Desktop. From the Data Files list, select Tag Styles and click Edit Data.

2 Click the Line Label Styles tab.

3 Do one of the following:
   ■ From the Name list, select the name of the label style that you want to edit.
   ■ To create a new label style, type a new name in the Name list. Be sure to click Save to save the new style.

When you select a style, the Text Above and Text Below sections of the dialog box display the selected data elements. The box on the right shows you a preview of what this label looks like.

4 You can specify any of the following label style items:
   ■ **Text Properties**: Controls the text style, offset, layer, and justification. For more information, see “Text Properties for Tag Labels” in this chapter.
   ■ **Data Elements**: Controls the items that the label style will label. For tag label styles, there is only one data element, Tag Number. For more information, see “Data Elements for Tag Labels” in this chapter.
   ■ **Text Above and Text Below**: Controls where the tag label is placed, either above or below the object. For more information, see “Text Above and Text Below for Tag Labels” in this chapter.
   ■ **Arrow, Tick, Crows Feet**: Controls whether symbols are placed on the object along with the label. For more information, see “Arrows, Ticks, and Crows Feet for Tag Labels” in this chapter.
   ■ **Units**: Unit settings are not applicable to tag label styles.
**Text Properties for Tag Labels**

1. Complete the steps in “Editing Line Tag Label Styles” in this chapter.
2. Under Text Properties, select a text Style for the label. If you select “Current”, then any time that you label an object using this style, the label is created using the current text style.
3. If you selected a zero-height style, then specify a height in the Height box.

**NOTE** If the selected text style has a fixed height, then the value in the Height box has no effect on the height.

4. You can specify an Offset for the label. This value is not a distance; it is a factor. The offset value that you specify is a factor that is multiplied by the text height to compute the actual offset distance.
5. Select a Layer for the label. If you select “Current”, then any time you label an object using this style, the label is placed on the current layer.
6. Select one of the following justification methods for the text:
   - **Left**: Left-justifies the label on the object.
   - **Right**: Right-justifies the label on the object.
   - **Center**: Centers the label on the object.

**Data Elements for Tag Labels**

Tag labels have only one data element, Tag Number. You can control whether the tag number is displayed above or below the object.

1. Complete the steps in “Editing Line Tag Label Styles” in this chapter.
2. From the Data list, select Tag Number.
3. Do one of the following:
   - Click the Text Above button to place the Tag Number in the Text Above box. This places the tag above the object when you label an object with this style.
   - Click the Text Below button to place the Tag Number in the Text Below box. This places the tag below the object when you label an object with this style.

**Text Above and Text Below for Tag Labels**

This information follows the steps in “Editing Line Tag Label Styles” in this chapter.

The Text Above and Text Below boxes contain the data elements for label styles. For tag label styles, the only data element you can use is Tag Number. The box on the right shows a preview of what the label looks like. In the following example, L precedes the tag number because this is the line tag label style.

You can type text into these boxes. This text appears in the label. For example, you can type Line instead of L.

In the Text Above or Text Below box, you can type, select, delete, copy, and paste text.
Arrows, Ticks, and Crows Feet for Tag Labels

To add arrows, ticks, or crows feet to the objects that you label.
1. Complete the steps in “Editing Line Tag Label Styles” in this chapter.
2. Under Text Above and/or Text Below, do the following:
   - Select the Arrow check box to insert arrows on the objects you label to indicate their direction.
   - Select either Tick or Crows Feet to insert either tick marks or crows feet on the objects you label.

Editing Curve Tag Label Styles

To edit a curve tag label style
1. From the Labels menu, choose Edit Tag Label Styles.
2. Click the Curve Label Styles tab.
3. Do one of the following:
   - From the Name list, select the name of the label style that you want to edit.
   - To create a new label style, type a new name in the Name list. Be sure to click Save to save the new style.

When you select a style, the Text Above and Text Below sections of the dialog box display the selected data elements. The box on the right shows you a preview of what this label looks like.
4. You can specify any of the following label style items:
   - Text Properties: Controls the text style, offset, layer, and justification. For more information, see “Text Properties for Curve Tag Labels” in this chapter.
   - Data Elements: Controls the items that the label style will label. For tag label styles, there is only one data element, Tag Number. For more information, see “Data Elements for Curve Tag Labels” in this chapter.
   - Text Above and Text Below: Controls where the tag label is placed, either above or below the object. For more information, see “Text Above and Text Below for Curve Tag Labels” in this chapter.
   - Arrow, Tick, Crows Feet: Controls whether symbols are placed on the object along with the label. For more information, see “Arrows, Ticks, and Crows Feet for Curve Tag Labels” in this chapter.
   - Units: Unit settings are not applicable to tag label styles.

Text Properties for Curve Tag Labels

1. Complete the steps in “Editing Curve Tag Label Styles” in this chapter.
2. Under Text Properties, select a text Style for the label. If you select “Current”, then any time that you label an object using this style, the label is created using the current text style.
3. If you selected a zero-height style, then specify a height in the Height box.

NOTE: If the selected text style has a fixed height, then the value in the Height box has no effect on the height.
4 You can specify an Offset for the label. This value is not a distance; it is a factor. The offset value that you specify is a factor that is multiplied by the text height to compute the actual offset distance.

5 Select a Layer for the label. If you select *Current*, then any time you label an object using this style, the label is placed on the current layer.

6 Select one of the following justification methods for the text:
   - **Left**: Left-justifies the label on the object.
   - **Right**: Right-justifies the label on the object.
   - **Center**: Centers the label on the object.

**Data Elements for Curve Tag Labels**

There is only one data element for tag labels, Tag Number. You can control whether the tag number is displayed above or below the object.

1 Complete the steps in “Editing Curve Tag Label Styles” in this chapter.

2 From the Data list, select Tag Number.

3 Do one of the following:
   - Click the Text Above button to place the Tag Number in the Text Above box. This places the tag above the object when you label an object with this style.
   - Click the Text Below button to place the Tag Number in the Text Below box. This places the tag below the object when you label an object with this style.

**Text Above and Text Below for Curve Tag Labels**

This information follows the steps in “Editing Curve Tag Label Styles” in this chapter.

The Text Above and Text Below boxes contain the data elements for label styles. For tag label styles, the only data element you can use is Tag Number. The box on the right shows a preview of what the label looks like. In the following example, C precedes the tag number because this is the curve tag label style.

You can type text into these boxes. This text appears in the label. For example, you could type Curve instead of C.

In the Text Above or Text Below box, you can type, select, delete, copy, and paste text.

**Arrows, Ticks, and Crows Feet for Curve Tag Labels**

To add arrows, ticks, or crows feet to the objects that you label.

1 Complete the steps in “Editing Curve Tag Label Styles” in this chapter.

2 Under Text Above and/or Text Below, do the following:
   - Select the Arrow check box to insert arrows on the objects you label to indicate their direction.
   - Select either Tick or Crows Feet to insert either tick marks or crows feet on the objects you label.
Editing Spiral Tag Label Styles

To edit a spiral tag label style

1. From the Labels menu, choose Edit Tag Label Styles.
2. Click the Spiral Label Styles tab.
3. Do one of the following:
   ■ From the Name list, select the name of the label style that you want to edit.
   ■ To create a new label style, type a new name in the Name list. Be sure to click Save to save the new style.

When you select a style, the Text Above and Text Below sections of the dialog box display the selected data elements. The box on the right shows you a preview of what this label looks like.

4. You can specify the following label style items:
   ■ Text Properties: Controls the text style, offset, layer, and justification. For more information, see “Text Properties for Spiral Tag Labels” in this chapter.
   ■ Data Elements: Controls the items that the label style will label. For tag label styles, there is only one data element, Tag Number. For more information, see “Data Elements for Spiral Tag Labels” in this chapter.
   ■ Text Above and Text Below: Controls where the tag label is placed, either above or below the object. For more information, see “Text Above and Text Below for Spiral Tag Labels” in this chapter.
   ■ Arrow, Tick, Crows Feet: Controls whether symbols are placed on the object along with the label. For more information, see “Arrows, Ticks, and Crows Feet for Spiral Tag Labels” in this chapter.
   ■ Units: Unit settings are not applicable to tag label styles.

Text Properties for Spiral Tag Labels

1. Complete the steps in “Editing Spiral Tag Label Styles” in this chapter.
2. Under Text Properties, select a text Style for the label. If you select *Current*, then any time that you label an object using this style, the label is created using the current text style.
3. If you selected a zero-height style, then specify a height in the Height box.

   NOTE: If the selected text style has a fixed height, then the value in the Height box has no effect on the height.

4. You can specify an Offset for the label. This value is not a distance; it is a factor. The offset value that you specify is a factor that is multiplied by the text height to compute the actual offset distance.
5. Select a Layer for the label. If you select *Current*, then any time you label an object using this style, the label is placed on the current layer.
6. Select one of the following justification methods for the text:
   ■ Left: Left-justifies the label on the object.
   ■ Right: Right-justifies the label on the object.
   ■ Center: Centers the label on the object.
Data Elements for Spiral Tag Labels
Tag labels have only one data element, Tag Number. You can control whether the tag number is displayed above or below the object.

1. Complete the steps in “Editing Spiral Tag Label Styles” in this chapter.
2. From the Data list, select Tag Number.
3. Do one of the following:
   - Click the Text Above button to place the Tag Number in the Text Above box. This places the tag above the object when you label an object with this style.
   - Click the Text Below button to place the Tag Number in the Text Below box. This places the tag below the object when you label an object with this style.

Text Above and Text Below for Spiral Tag Labels
This information follows the steps in “Editing Curve Tag Label Styles” in this chapter.

The Text Above and Text Below boxes contain the data elements for label styles. For tag label styles, the only data element you can use is Tag Number. The box on the right shows a preview of what the label looks like. In the following example, SP precedes the tag number because this is the spiral tag label style.

You can type text into these boxes. This text appears in the label. For example, you can type Spiral instead of SP.

In the Text Above or Text Below box, you can type, select, delete, copy, and paste text.

Arrows, Ticks, and Crows Feet for Spiral Tag Labels
To add arrows, ticks, or crows feet to the objects that you label.

1. Complete the steps in “Editing Spiral Tag Label Styles” in this chapter.
2. Under Text Above and/or Text Below, do the following:
   - Select the Arrow check box to insert arrows on the objects you label to indicate their direction.
   - Select either Tick or Crows Feet to insert either tick marks or crows feet on the objects you label.
Creating Tag Labels

To label objects with tag labels
1. Select the current label styles for lines and curves. For more information, see “Selecting the Current Label Style” in Chapter 23, “Label Styles.”
2. From the Labels menu, choose Add Tag Labels.
3. Select the objects that you want to label.
4. Press ENTER.

or

1. Select the current tag label styles.
2. Select the object(s) that you want to label.
3. Right-click to display the shortcut menu.
4. Select Add Tag Label.

Creating Object Tables

After you tag the objects in your drawing with tag labels, you can create object tables that display detailed information about each object you tagged. You can insert multiple tables in a drawing. You can also specify a row limit for a table, and when that limit is reached, the table is split into pages.

To control what information is displayed about the objects, you must set up table columns when you are using the Add Tables commands. After you set up the table columns the way you want, you can save this setup to a file. The next time you want to create a table, you can load this file to use the same settings that you did previously.

Tables do not update automatically. To update tables with changes you’ve made to objects or tag styles, you can select a text object in the table, right-click, and select Re-Draw Table.

Creating a Line Table

After you label your lines with tag labels, you can draw a line table. Tables display detailed information about the objects that you labeled with tags.
To create a line table

1. From the Labels menu, choose Add Tables ➤ Line Table to display the Line Table Definition dialog box.

2. In the Text box, type a title for the table. By default the title is Line Table.

3. In the Layer box, select or type a layer for the table title. By default the layer is Line Table Header.

4. Select a Text Style for the table title. If you select a zero-height text style, then type a height in the Text Height box.

5. You can control any of the following line table items:

   **Line Table Sorting**
   Select the Sort table check box to have the table entries appear in the table in alpha-numeric order. If you clear this check box, then the tags are placed in the table in the order that the objects appear in the drawing database.

   **Line Table Border**
   Select the Draw border check box to draw both a border and column and row lines on your table. If you select the Draw border check box, then select a layer for the border from the Border Layer list.

**NOTE** If you already formatted a line table and saved the setup to a file, then you can skip the following steps by loading the table setup file. For more information, see “Loading an Existing Table Setup File” in this chapter.
Splitting a Line Table
To limit the rows in a table, type a limit in the Maximum Rows Per Page box. For example, if you have 20 lines and you limit the rows per table to 10, then the first table ends at L10 and the next table page begins at L11. Setting this value to 0 creates one continuous table.

6 To control what pieces of information are displayed in the table, set up the column definitions. For more information, see “Changing the Column Definitions of a Line Table” in this chapter.

NOTE By default, the first column in a table contains the Entity Description data element, which places the tag number in the first column. Be sure to not remove Entity Description from this column or the tag number will not be included in the table.

7 To save the settings to a file that you can use the future, choose Save As and save the file.

By default, this file is named linetabledef.ltd and is stored in the c:\Program Files\Land Desktop R2\data\labels folder.

8 Click OK.

9 Select the insertion point for the table.
This point corresponds to the upper-left corner of the table.

Changing the Column Definitions of a Line Table
You can customize each column of a line table to display the information that is relevant to your project.

To format a line table

1 Complete steps 1–5 in “Creating a Line Table” in this chapter.
2 Under Column Definition, place your cursor in the column that you want to edit and then click Edit. You can also double-click in the column that you want to edit.

NOTE To insert a new column, click Insert. To delete an existing column, click Delete.
The Column Definition dialog box is displayed.

To change the appearance of the column, make modifications in the Column Header Information section of the dialog box.

3 In the Header box, type the column heading.

4 In the Width box, type the width of the column. This value is in text characters, and is based on the text style that you specify for the header.

NOTE The text in a column does not wrap if it exceeds the column width. Be sure that you specify a column width that is large enough to accommodate all the text that appears in the column.

5 Select a text Style for the header. If you select a zero-height style, then also specify a text Height.

6 Under Justify, specify whether you want the header text to be right-justified, left-justified, or centered.

7 From the Layer box, choose a layer for the column header.

8 Under Display Value Information, choose the information that you want to appear in the column, and then click the Add Value button to add it to the Text box.

The Text box shows you the Display Value Information that you selected. You can choose to have more than one Display Value in a column. The box on the right of the Text list shows you a preview of how the column information appears.

To remove a category from the Text box, select the text in the Text box and delete it. You can type text in the Text box, such as m for meters.

You can also add formulas to tables.
9 Use the Text Properties section to format the column text style, layer, and justification. For more information, see steps 5–7.

10 Click Linear to select the linear precision values for table entries. For more information, see the following topic “Changing the Precision of the Display of Linear Units in Tag Tables.”

11 Click Angle to select the angular precision values for table entries. For more information, see “Changing the Precision of the Display of Angular Units in Tag Tables” in this chapter.

12 Click OK to return to the Line Table Definition dialog box.

<table>
<thead>
<tr>
<th>Display value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Lists the length of the line.</td>
</tr>
<tr>
<td>Direction</td>
<td>Lists the direction of the line.</td>
</tr>
<tr>
<td>Start Northing</td>
<td>Lists the northing coordinate of the start point of the line.</td>
</tr>
<tr>
<td>Start Easting</td>
<td>Lists the easting coordinate of the start point of the line.</td>
</tr>
<tr>
<td>End Northing</td>
<td>Lists the northing coordinate of the end point of the line.</td>
</tr>
<tr>
<td>End Easting</td>
<td>Lists the easting coordinate of the end point of the line.</td>
</tr>
<tr>
<td>Text Break</td>
<td>Inserts a text break into the label. A text break can be used to separate the labels on an object. When you insert this data element, it shows up as “100” in the preview box.</td>
</tr>
<tr>
<td>Plus/Minus Symbol</td>
<td>Inserts a plus/minus (±) symbol into the label.</td>
</tr>
<tr>
<td>Entity Description</td>
<td>Displays the tag number in the column. The first column of a table is automatically configured to display the Entity Description. To display the tag number in the column, make sure you do not remove the Entity Description category.</td>
</tr>
</tbody>
</table>

**Changing the Precision of the Display of Linear Units in Tag Tables**

You can change the precision values for displaying linear units in tag tables.

To change the linear precision for tag tables

1 Change the column definitions of the line table. For more information, see “Changing the Column Definitions of a Line Table” in this chapter.

2 In the Linear box, enter the precision for displaying lengths in tag table columns.

**NOTE** You can either type a value in the boxes, or use the up and down arrows to select a value.
3 In the Formula box, enter the precision for displaying the results of formula calculations.
4 In the Coordinate box, enter the precision for displaying northing and easting coordinates.
5 Click OK to return to the Column Definition dialog box.

**Changing the Precision of the Display of Angular Units in Tag Tables**

You can change the label precision for displaying angular values in tag tables.

**To change the angular precision for tag tables**

1 Change the column definitions of the line table. For more information, see “Changing the Column Definitions of a Line Table” in this chapter.
2 Select the Allow Text Spaces check box to place spaces in the display of angular units in the tag table columns. When this check box is selected, an angle is labeled in the format (N 52°14'39" N). If you do not select this check box, then an angle is labeled without spaces (N52°14'39"N).
3 In the Angular box, enter the precision for displaying angles in tag table columns.

**NOTE** You can either type a value in the boxes, or use the up and down arrows to select a value.

4 In the Formula box, enter the precision for displaying the results of formula calculations.
5 Click OK to return to the Column Definition dialog box.

**Loading an Existing Line Table Setup File**

If you have already defined and saved a table setup file, then you can load it whenever you want to create a table.

1 Create a line table and save the definition to a file. For more information, see “Creating a Line Table” in this chapter.
2 From the Labels menu, choose Add Tables ➤ Line Table to display the Line Table Definition dialog box.
3 Click the Load button.

4 Select the line table definition file that you want to use.
5 Click Open.

**Creating a Curve Table**

After you label your curves with tag labels, you can draw a curve table. Tables display detailed information about the objects that you labeled with tags.

**To create a curve table**

1 From the Labels menu, choose Add Tables ➤ Curve Table to display the Curve Table Definition dialog box.
NOTE If you already formatted a curve table and saved the setup to a file, then you can skip the following steps by loading the table setup file.

2 In the Text box, type a title for the table. By default the title is Curve Table.
3 In the Layer box, select or type a layer for the table title. By default the layer is Curve Table Header.
4 Select a Text Style for the table title. If you select a zero-height text style, then type a height in the Text Height box.
5 You can control any of the following curve table items:

   **Curve Table Sorting**
   Select the Sort table check box to have the table entries appear in the table in alpha-numeric order. If you clear this check box, then the tags are placed in the table in the order that the objects appear in the drawing database.

   **Curve Table Border**
   Select the Draw border check box to draw both a border and column and row lines on your table. If you select the Draw border check box, then select a layer for the border from the Border Layer list.

   **Splitting a Curve Table**
   To limit the rows in a table, type a limit in the Maximum Rows Per Page box. For example, if you have 20 lines and you limit the rows per table to 10, then the first table ends at C10 and the next table page begins at C11. Setting this value to 0 creates one continuous table.

6 To control what pieces of information are displayed in the table, set up the column definitions. For more information, see “Changing the Column Definitions of a Curve Table” in this chapter.

NOTE By default, the first column in a table contains the Entity Description data element, which places the tag number in the first column. Be sure to not remove Entity Description from this column or the tag number will not be included in the table.

7 To save the settings to a file that you can use the future, click Save As and save the file. By default, this file is named curvetabledef.ctd and is stored in the c:\Program Files\Land Desktop R2\data\labels folder.
8 Click OK.
9 Select the insertion point for the table.
   This point corresponds to the upper-left corner of the table.

**Changing the Column Definitions of a Curve Table**
You can customize each column of a curve table to display the information that is relevant to your project.
To format a curve table

1. Complete steps 1–5 in “Creating a Curve Table” in this chapter.
2. Under Column Definition, place your cursor in the column that you want to edit and then click Edit. You can also double-click in the column that you want to edit.

The Column #1 Definition dialog box is displayed.

**NOTE**

To insert a new column, click Insert. To delete an existing column, click Delete.

To change the appearance of the column, make modifications in the Column Header Information section of the dialog box.

3. In the Header box, type the column heading.
4. In the Width box, type the width of the column. This value is in text characters, and is based on the text style that you specify for the header.

**NOTE**

The text in a column does not wrap if it exceeds the column width. Be sure that you specify a column width that is large enough to accommodate all the text that appears in the column.

5. Select a text Style for the header. If you select a zero-height style, then also specify a text Height.
6. Under Justify, specify whether you want the header text to be right-justified, left-justified, or centered.
7. From the Layer box, choose a layer for the column header.
8. Under Display Value Information, choose the information that you want to appear in the column, and then click the Add Value button to add it to the Text box.

The Text box shows you the Display Value Information that you selected. You can choose to have more than one Display Value in a column. The box on the right of the Text list shows you a preview of how the column information appears.

To remove a category from the Text box, select the text in the Text box and delete it. You can type text in the Text box, such as m for meters.

You can also add formulas to tables.

9. Use the Text Properties section to format the column text style, layer, and justification. For more information, see steps 5–7.
10. Click Linear to select the linear precision values for table entries. For more information, see “Changing the Precision of the Display of Linear Units in Tag Tables” in this chapter.
11. Click Angle to select the angular precision values for table entries. For more information, see “Changing the Precision of the Display of Angular Units in Tag Tables” in this chapter.
12. Click OK to return to the Curve Table Definition dialog box.
<table>
<thead>
<tr>
<th>Display value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radius</td>
<td>Lists the radius of the curve.</td>
</tr>
<tr>
<td>Length</td>
<td>Lists the length of the curve.</td>
</tr>
<tr>
<td>Delta Angle</td>
<td>Lists the central angle of the curve.</td>
</tr>
<tr>
<td>Tangent</td>
<td>Lists the tangent length of the curve.</td>
</tr>
<tr>
<td>Chord Direction</td>
<td>Lists the direction of the chord.</td>
</tr>
<tr>
<td>Chord</td>
<td>Lists the length of the chord.</td>
</tr>
<tr>
<td>Text Break</td>
<td>Inserts a text break into the label. A text break can be used to separate the labels on an object. When you insert this data element, it shows up as “100” in the preview box.</td>
</tr>
<tr>
<td>Plus/Minus Symbol</td>
<td>Inserts a plus/minus (±) symbol into the label.</td>
</tr>
<tr>
<td>Delta Symbol</td>
<td>Inserts a delta symbol (Δ) into the label.</td>
</tr>
<tr>
<td>Entity Description</td>
<td>Displays the tag number in the column. The first column of a table is automatically configured to display the Entity Description. To display the tag number in the column, make sure you do not remove the Entity Description category.</td>
</tr>
</tbody>
</table>

**Loading an Existing Curve Table Setup File**

If you have already defined and saved a table setup file, then you can load it whenever you want to create a table.

1. Create a curve table and save the definition to a file. For more information, see “Creating a Curve Table” in this chapter.
2. From the Labels menu, choose Add Tables ➤ Curve Table to display the Curve Table Definition dialog box.
3. Click the Load button.
4. Select the curve table definition file that you want to use.
5. Click Open.
Creating a Spiral Table

After you label your spirals with tag labels, you can draw a spiral table. Tables display detailed information about the objects that you labeled with tags.

To create a spiral table

1. From the Labels menu, choose Add Tables ➤ Spiral Table to display the Spiral Table Definition dialog box.

![Spiral Table Definition dialog box]

2. In the Text box, type a title for the table. By default the title is Spiral Table.

3. In the Layer box, select or type a layer for the table title. By default the layer is Spiral Table Header.

4. Select a Text Style for the table title. If you select a zero-height text style, then type a height in the Text Height box.

5. You can control any of the following spiral table items:

   **Spiral Table Sorting**
   Select the Sort table check box to have the table entries appear in the table in alpha-numeric order. If you clear this check box, then the tags are placed in the table in the order that the objects appear in the drawing database.

   **Spiral Table Border**
   Select the Draw border check box to draw both a border and column and row lines on your table. If you select the Draw border check box, then select a layer for the border from the Border Layer list.

---

**NOTE** If you already formatted a spiral table and saved the setup to a file, then you can skip the following steps by loading the table setup file.
Splitting Spiral Table

To limit the rows in a table, type a limit in the Maximum Rows Per Page box. For example, if you have 20 lines and you limit the rows per table to 10, then the first table ends at C10 and the next table page begins at C11. Setting this value to 0 creates one continuous table.

To control what pieces of information are displayed in the table, set up the column definitions. For more information, see “Changing the Column Definitions of a Spiral Table” in this chapter.

NOTE

By default, the first column in a table contains the Entity Description data element, which places the tag number in the first column. Be sure to not remove Entity Description from this column or the tag number will not be included in the table.

7 To save the settings to a file that you can use the future, click Save As and save the file. By default, this file is named spiraltabledef.std and is stored in the c:\Program Files\Land Desktop R2\data\labels folder.

8 Click OK.

9 Select the insertion point for the table. This point corresponds to the upper-left corner of the table.

Changing the Column Definitions of a Spiral Table

You can customize each column of a spiral table to display the information that is relevant to your project.

To format a spiral table

1 Complete steps 1–5 in “Creating a Spiral Table” in this chapter.

2 Under Column Definition, place your cursor in the column that you want to edit and then click Edit. You can also double-click in the column that you want to edit.

The Column Definition dialog box is displayed.

NOTE

To insert a new column, click Insert. To delete an existing column, click Delete.

To change the appearance of the column, make modifications in the Column Header Information section of the dialog box.

3 In the Header box, type the column heading.

4 In the Width box, type the width of the column. This value is in text characters, and is based on the text style that you specify for the header.

NOTE

The text in a column does not wrap if it exceeds the column width. Be sure that you specify a column width that is large enough to accommodate all the text that appears in the column.

5 Select a text Style for the header. If you select a zero-height style, then also specify a text Height.

6 Under Justify, specify whether you want the header text to be right-justified, left-justified, or centered.
Creating Object Tables

7 From the Layer box, choose a layer for the column header.

8 Under Display Value Information, choose the information that you want to appear in the column, and then click the Add Value button to add it to the Text box.

The Text box shows you the Display Value Information that you selected. You can choose to have more than one Display Value in a column. The box on the right of the Text list shows you a preview of how the column information appears.

To remove a category from the Text box, select the text in the Text box and delete it. You can type text in the Text box, such as m for meters.

You can also add formulas to tables.

9 Use the Text Properties section to format the column text style, layer, and justification. For more information, see steps 5–7.

10 Click Linear to select the linear precision values for table entries. For more information, see “Changing the Precision of the Display of Linear Units in Tag Tables” in this chapter.

11 Click Angle to select the angular precision values for table entries. For more information, see “Changing the Precision of the Display of Angular Units in Tag Tables” in this chapter.

12 Click OK to return to the Spiral Table Definition dialog box.

<table>
<thead>
<tr>
<th>Information for spiral table columns</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display value</strong></td>
</tr>
<tr>
<td>Radius</td>
</tr>
<tr>
<td>Length</td>
</tr>
<tr>
<td>Theta</td>
</tr>
<tr>
<td>X</td>
</tr>
<tr>
<td>Y</td>
</tr>
<tr>
<td>Short Tangent</td>
</tr>
<tr>
<td>Long Tangent</td>
</tr>
<tr>
<td>P</td>
</tr>
<tr>
<td>K</td>
</tr>
<tr>
<td>A</td>
</tr>
</tbody>
</table>
Information for spiral table columns (continued)

<table>
<thead>
<tr>
<th>Display value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Break</td>
<td>Inserts a text break into the label. A text break can be used to separate the labels on an object. When you insert this data element, it shows up as “100” in the preview box.</td>
</tr>
<tr>
<td>Plus/Minus Symbol</td>
<td>Inserts a plus/minus (±) symbol into the label.</td>
</tr>
<tr>
<td>Entity Description</td>
<td>Displays the tag number in the column. The first column of a table is automatically configured to display the Entity Description. To display the tag number in the column, make sure you do not remove the Entity Description category.</td>
</tr>
</tbody>
</table>

Loading an Existing Spiral Table Setup File

If you have already defined and saved a table setup file, then you can load it whenever you want to create a table.

1. Create a spiral table. For more information, see “Creating a Spiral Table” in this chapter.
2. Click the Load button.
3. Select the spiral table definition file that you want to use.
4. Click Open.

Editing Object Tables

You can change the column definitions or the appearance of an existing object table.

To edit an object table

1. From the Labels menu, choose Edit Table.
2. Select the table you want to edit by selecting either the table text or the lines that separate the rows/columns.
Press ENTER to display the Line Table Definition dialog box.

Modify the options as necessary. For more information, see “Creating a Line Table” in this chapter.

Click OK to exit the Table Definition dialog box.

Use the Re-Draw Table command to update the table. For more information, see “Updating Object Tables” in this chapter.

or

1. Click on the table in your drawing that you want to edit.
2. Right-click to display the shortcut menu.
3. Select Edit Table Layout to display the Table Definition dialog box.
4. Modify the options as necessary.
5. Click OK to exit the Table Definition dialog box.
6. Use the Re-Draw Table command to update the table.

**Updating Object Tables**

Object tables do not update automatically. You must use the Re-Draw Table command to update the tables when you do any of the following:

- Edit an object that is tagged
- Delete an object that is tagged
- Delete a tag label
- Change the tag label style
- Change the table layout and edit column definitions
To update object tables
1 Select a text object in the table, such as the table title, or a table line.
2 Right-click to display the shortcut menu.
3 Select Re-Draw Table.

or
1 From the Labels menu, choose Edit Tables ➤ Re-Draw Table.
   The following prompt is displayed:
   Select Table Lines or Text:
2 Select a text object in the table you want to re-draw, such as the table title, or
   select a table line.
3 Press ENTER to re-draw the table.

NOTE Tag labels created by the Label Line by Points command and the Label Curve by Points command are not dynamic and therefore are not updated in a table if the object changes and you use the Re-Draw Table command. However, if you manually edit the tag label text using the DDEDIT command, this change is updated in the table when you use the Re-Draw Table command.

Deleting Object Tables

To delete an object table
1 Select a text object in the table, such as the table title.
2 Right-click to display the shortcut menu.
3 Select Delete Table.

or
1 From the Labels menu, choose Edit Tables ➤ Delete Table.
   The following prompt is displayed:
   Select Table Lines or Text:
2 Select a text object in the table you want to re-draw, such as the table title, or
   select a table line.
3 Press ENTER to re-draw the table.
Creating Surface Models

Use the Terrain Model Explorer to create and build surface models. You can add point, contour, breakline, and boundary data to the surface folders in the Terrain Model Explorer, and then you can build the surface based on that data.
Using the Terrain Commands

The Terrain menu contains all the surface creation, editing, and output commands. All of the surface creation commands are consolidated into an explorer-style dialog box called the Terrain Model Explorer. Using the right-click shortcut menus, you can create surfaces, choose which surface data to include in surfaces, and build surfaces. The Terrain Model Explorer makes it easy to see which data is included in a surface. You can also create data for the surface from within the Terrain Model Explorer, such as breaklines and boundaries.

After you have built a surface, you can use the surface editing commands to add or delete surface TIN (Triangulated Irregular Network) lines, add or delete points, and so on. For visualization purposes, you can draw waterdrop paths across the surface, draw slope arrows, or create 2D or 3D graphical representations of the surface slopes and elevations.

When you are ready to output data, you can generate contours, cross sections, and volumes. Two types of volume creation methods create surfaces which you can manage from within the Terrain Model Explorer.

Creating Surfaces

You can create surface models from point, breakline, boundary, and contour data. The following illustration shows a TIN surface created from point data:

Surface triangulation created from point data
The following illustration shows a TIN surface created from contour data:

In most surveying and civil engineering operations, you gather elevational information to generate surface contours that represent a model of the ground surface. When you gather data for the model, you must be thorough so the model you create is an accurate representation of the surface. Points or contours are usually a primary part of the original surface information and are supplemented with breaklines and boundaries. Breaklines are constraint lines such as retaining walls, stream banks and beds, ridge lines, curbs, and other abrupt changes in the surface. Boundaries control where surface triangulation occurs on a surface.
All the surface data definition and creation commands are located in the Terrain Model Explorer dialog box.

The process of surface generation includes:
- Creating a new surface
- Creating surface data
- Choosing which data you want to build the surface from
- Building the surface

### The Terrain Model Explorer

The Terrain Model Explorer contains every surface creation command. It is a modeless dialog box that stays open while you do other work.

The Terrain Model Explorer is divided into two sections: Terrain surfaces and Volume surfaces. The Terrain folder is where all of your regular surfaces, such as existing ground or finished ground, are stored. The Volume folder is where surfaces created by the volume commands are stored.

Each surface has its own folder in the Terrain Model Explorer. These surface folders contain subfolders that contain the data to be used in the surface generation. You can create and add data to the folders right from the Terrain Model Explorer.

When you click on a folder in the Terrain Model Explorer, relevant statistical information displays in the right-hand pane. For example, when you click a surface name, the surface statistics are displayed.

You can right-click on each item in the Terrain Model Explorer to use shortcut menus.
Creating a New Surface

The first step in surface generation is to create a surface folder in the Terrain Model Explorer. To do this, use the Create New Surface command.

This command creates a new folder for surface data in the Terrain Model Explorer that you can use to add data to the surface. The command also creates a surface subfolder in your project folder for data storage and creates a file named <surface name>.dat that contains the basic information for the surface. For example, if you create a surface named exist, then the data file is stored in the c:\Land Projects R2\<project name>\dtm\exist folder.

To create a new surface

1. From the Terrain menu, choose Terrain Model Explorer.
2. Right-click on Terrain to display the shortcut menu.
3. Click Create New Surface.

A folder for the surface is created in the Terrain Model Explorer:

- Terrain
  - Surface1

**NOTE** To name the surface, you can click on its default name and type a new name, or you can use the Rename command. Surface names are limited to 40 characters. For more information, see “Renaming a Surface” in this chapter.

You can open a surface folder to see the subfolders where the surface data is stored. Each subfolder has a shortcut menu that you can use to access commands to add surface data to the folders. For more information, see “Creating Surface Data and Adding It to the Surface Folders” in this chapter.
Building a Surface

You can build a surface from any combination of point, breakline, boundary, and contour data that you add to the surface folders in the Terrain Model Explorer.

NOTE: If you have previously built a surface and subsequently edited the surface, then the surface edits are saved to the surface’s Edit History folder. You can reapply the Edit History to the surface when you build it. This means that the Build Surface command processes the surface data first, and then reapplies all of the surface edits.

To build a surface

1. Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
2. Add surface data to the surface folders if you haven’t already. For more information, see “Creating Surface Data and Adding It to the Surface Folders” in this chapter.
3. From the Terrain menu, choose Terrain Model Explorer.
4. Right-click on the surface folder, for example Surface1, to display the shortcut menu.
5. Click Build to display the Build Surface dialog box.

6. Click the Surface tab if it is not already active.
7. In the Description box, you can type a description for the surface. The surface description can be up to 255 characters.
Select one or more of the following options to control how the surface is built:

**Log Errors to file**: Select this check box to create a `<surface name>.err` file in the `c:\Land Projects R2\<project name>\dtm\<surface name>` folder. This log file records the time it takes to build the surface, and records each step that the Build Surface command performs, such as adding point files or point groups to the surface.

**Build Watershed**: Select this check box to build a watershed at the same time the surface is built. If you select this option, then be sure to click the Watershed tab and set up the watershed options.

**Compute Extended Statistics**: Select this check box to generate extended surface statistics. These statistics are displayed when you click the surface name, for example in the Terrain Model Explorer.

Select any of the following surface data options to control how surface data is processed:

**Use point file data**: Select this check box to build the surface using the data in the surface's `Point Files` folder. If you clear this check box, then the surface is built without the point file data.

**Use point group data**: Select this check box to build the surface using the data in the surface's `Point Groups` folder. If you clear this check box, then the surface is built without the point group data.

**Use breakline data**: Select this check box to build the surface using the data in the surface's `Breaklines` folder. If you clear this check box, then the surface is built without the breakline data.

**Convert proximity breaklines to standard**: Select this check box to convert proximity breaklines to standard breaklines when the surface is built. Proximity breaklines obtain their exact point location and elevation by snapping to the nearest point on the surface. If you convert proximity breaklines to standard breaklines when building the surface, the breaklines are saved with fixed locations and elevations. Therefore, if any of the surface point data that the proximity breaklines were snapping to is subsequently changed, the breaklines are not updated with these changes.

When a proximity breakline is converted to a standard breakline, one or more standard breaklines are added to the breakline file in the Terrain Model Explorer, each with the description “From Proximity Breakline <breakline number>.”

Clear this check box if you want to preserve proximity breaklines when building the surface.

**Use contour data**: Select this check box to build the surface using the data in the surface's `Contours` folder. If you clear this check box, then the surface is built without the contour data.

**Minimize flat triangles resulting from contour data**: When building a surface, select this check box to check each contour in the surface for any triangles that have three points either on the same contour or at the same elevation. Any triangle that fits this criteria is eliminated. For more information, see “Minimize Flat Triangles Resulting from Contour Data” in this chapter.
Apply boundaries: Select this check box to build the surface using the data in the surface's Boundaries folder. If you clear this check box, then the surface is built without the boundary data.

Apply Edit History: Select this check box to apply the Edit History to the surface after it is built. The Edit History records all the surface editing that you have performed. For example, if you built a surface and edited it, but need to build it again, you do not have to make all the edits that you made previously. Just select the Apply Edit History check box and the edits repeat automatically.

Don’t add data with elevation less than: Select this check box to exclude any surface data that has an elevation less than the elevation you type in the box.

Don’t add data with elevation greater than: Select this check box to exclude any surface data that has an elevation greater than the elevation you type in the box.

10 If you selected the Build Watershed check box, then click the Watershed tab.

11 In the Minimum Depression Depth box, type the minimum depth at which a depression in the surface is to be considered a watershed. This setting prevents minor depression depths from being defined as watershed subareas.

12 In the Minimum Depression Area box, type the minimum area at which a depression in the surface is to be considered a watershed. This setting prevents minor depression areas from being defined as watershed subareas.

13 Select or clear the Must Exceed Both Minimum Area And Minimum Depth check box:
   ■ Select this check box to create watershed subareas of only those depressions that exceed both the minimum area and the minimum depth.
   ■ Clear this check box to create watershed subareas of those depressions that exceed either the minimum area or the minimum depth.

14 Click OK to build the surface.

A message dialog box is displayed, informing you that the program has finished building the surface.

15 Click OK.

16 If you want to view and edit the surface triangulation, then Import 3D Lines into the drawing. For more information, see “Importing the Surface as 3D Lines” in Chapter 30, “Editing Surfaces.”
Minimizing Flat Triangles Resulting from Contour Data

When building a surface, select the Minimize Flat Triangles Resulting From Contour Data check box to check each contour in the surface for any triangles that have three points either on the same contour or at the same elevation. Any triangle that fits this criteria is eliminated.

For example, during the first pass at creating the surface model from contours, you might find that the surface model interpolates between three points on the same contour. A typical example would be a site that includes finger-like contours such as those along a stream. If you clear the Minimize Flat Triangles Resulting From Contour Data check box, then the surface model may triangulate between a point on a contour on one side of the stream and a point on the same contour on the other side of the stream. The Minimize Flat Triangles Resulting From Contour Data Option searches those situations and resolves the problem by triangulating to another contour.

TIP
You can view these flat triangles graphically by using the 2D Solids slope shading command. If you run this command for just one range with a slope of 0.00 percent, you will see the flat areas along the contour data. For more information, see “Creating 2D Solids that Show the Slopes of a Surface” in Chapter 31, “Displaying Surfaces.”

NOTE
If you generate contours from a surface that you created using only contour information, you might need to place spot elevations or breaklines in areas where the contour lines change direction drastically. Areas where this is likely to happen include: a crowned roadway, a swale, or a ridge. In these places, contours might tend to triangulate onto themselves. In most instances, the Minimize flat triangles resulting from contour data option resolves the problem. In more drastic situations, you might need to use the Proximity Breakline commands or add additional point data. For more information, see “Proximity Breaklines” in this chapter.

Creating Surface Data and Adding It to the Surface Folders

Each surface can be made up of a combination of points, breaklines, boundaries, and contours. To create or add data to the surface, use the surface folder shortcut menus.
For example, to add contour data, right-click on the Contours folder and select Add Contour Data.

When you add data to the surface folders, surface data files are created in the c:\Land Projects R2\<project name>\dtm\<surface name> folder.

- For points, a <surface name>pnt.txt file is created.
- For breaklines, a <surface name>flt.bin file is created.
- For contours, a <surface name>brk.bin file is created.
- For boundaries, a <surface name>bnd.bin file is created.

Deleting Data from the Terrain Model Explorer Folders

To control which data in the surface folders is used when you build a surface, you can change the surface’s properties to exclude any data type, such as contours. However, you can also delete point files, point groups, or boundaries from the Terrain Model Explorer if you no longer want to use them for the surface.

**To delete data from the surface’s data folders in the Terrain Model Explorer**

1. Right-click on the Point Files, Point Groups, or Boundaries surface data folder that contains the data you want to delete.
2. Select Remove or press the DELETE key on your keyboard.

For more information about removing contour data from the Terrain Model Explorer, see “Deleting Contour Data from a Surface Folder” in this chapter.

Adding Point Groups to the Surface Folder to Use in Surface Generation

If you want to use points that exist in the project point database as surface data, then you must create point groups and add them to the surface folder. You can create point groups that contain specific points, like all existing ground points, making it easier to manage the surface points.

**To add a point group to the surface folder**

1. From the Terrain menu, choose Terrain Model Explorer.
2. Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
3. Open the surface folder in the Terrain Model Explorer to display the subfolders.
4. Right-click on Point Groups to display the shortcut menu.
5. Click Add Point Group to display the Add Point Group dialog box.

   **NOTE** If no point groups are defined, then a message dialog box is displayed, asking if you want to run the Point Group Manager to create a point group. Click Yes to create a point group. For more information, see “Creating a Point Group” in Chapter 7, “Point Groups and Lists.”
Adding Point Files to the Surface Folder to Use in Surface Generation

If you have ASCII text files that contain point data—point files that you created either manually or when downloading a data collector—you can use them as surface data. You can also create point data to use in surfaces from AutoCAD objects, such as point nodes, lines, blocks, text, polyfaces, and 3D faces.

If you have an ASCII text file or a Microsoft Access® .mdb file that you want to use as surface data, then you can add the point file to the Point File folder in the Terrain Model Explorer. An import/export format is required when you use Point Files so AutoCAD Land Development Desktop can interpret the format of the point file. For more information, see “Creating a Point Import/Export Format” in Chapter 12, “Importing and Exporting Points.”

You can manually create ASCII text files that contain point data; they can also be a result of downloading a data collector. For more information, see “Creating a Surface Point File Manually” in this chapter.

To create .mdb files, you must use Microsoft Access®.

To add a point file to the surface folder
1. From the Terrain menu, choose Terrain Model Explorer.
2. Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
3. Open the surface folder in the Terrain Model Explorer to display the subfolders.
4. Right-click on to display the shortcut menu.
5. Click Add Point File.
6. From the Format list, select the import format. You must set up this format to match the contents of the point file. For example, if you have a comma delimited ASCII text file that contains point number, northing, easting, and elevation data, then use a comma delimited PNEZ format that recognizes the data.
TIP
To create a new format, click to create the format. For more information, see “Creating a Point Import/Export Format” in Chapter 12, “Importing and Exporting Points.”

7 Click to display the Select Source File dialog box.

8 Locate the file you want to use.
9 Click Open to return to the Format Manager - Read Points dialog box.
10 Click OK.

The point file statistics are then updated in the right-hand pane of the Terrain Model Explorer.

Creating a Surface Point File Manually
You can create a text file with point information for creating a surface, and use point data created in any software program to produce a surface.

To create a point file manually
1 Open a text editor such as Notepad.
2 Type the point number, easting, northing, and elevation (for example). Separate each value by one or more spaces or with a comma.
3 Type the information for each point on a separate line. For best results, do not include extra spaces at the end of a line or blank lines at the end of the file. The file should consist entirely of point data, however, you can add a comment line by typing a # sign at the beginning of a line.
4 Save the file as a text file to the following folder:
c:\Land Projects R2\<project name>\dtm\<surface name>

NOTE
If you have used the Terrain Model Explorer to add AutoCAD objects to the surface point file, then a <surface name>.pnt.txt file already exists in that folder. Use a different name to avoid overwriting this file.

4 Add the file to the surface folder. For more information, see “Adding Point Files to the Surface Folder to Use in Surface Generation” in this chapter.

Chapter 26  Creating Surface Models
530
Creating Surface Point Data from Objects

If there are objects in your drawing that you want to use as surface data, such as 3D lines, then you can add them to the surface Point File folder. AutoCAD Land Development Desktop interprets the objects that you select as point data. Specific point data is created for each object type that you add to the surface folder. This data is saved to a <surface name>pnt.txt file that is saved in the c:\Land Projects R2\<project name>\dtm\<surface name> folder. The first time that you add objects to this file, you are not prompted to append or overwrite the file. However, for each subsequent addition, you are prompted to either append or overwrite the file with the new point data.

Appending or Overwriting the Surface Point File

If a point file already exists in the surface folder, then the following prompt is displayed:

Point file already exists for surface <surface name> (Append/Overwrite) <Append>: 

Type Append or Overwrite:

- Append: adds the object points to the surface data file.
- Overwrite: overwrites the surface data file and creates a new file from the object points.

Adding to the Surface Point File by Selecting AutoCAD Point Nodes

If you have AutoCAD point nodes with elevations in the drawing file, then you can add them to the surface data file.

To add point node data to the surface point file
1. From the Terrain menu, choose Terrain Model Explorer.
2. Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
3. Open the surface folder in the Terrain Model Explorer to display the subfolders.
4. Right-click on Point Files to display the shortcut menu.
5  Click Add Points from AutoCAD Objects ➤ Points.

The Terrain Model Explorer closes so you can view the drawing, and the following prompt is displayed:

Select objects by (Entity/Layer) <Layer>: 

**NOTE**  If you already defined point data from objects in the drawing, then an append or overwrite prompt is displayed. For more information, see “Appending or Overwriting the Surface Point File” in this chapter.

6  Do one of the following to select the points:

- Type `Entity` to select the points from the drawing, and then use any standard selection method to select the points.
- Type `Layer` to select the objects by layer, and then select one object on the layer that you want to select. All valid 3D points on that layer are added to the surface data file.
- Type `Layer`, press ENTER, and then type the layer name. All valid 3D points on the layer are added to the surface data file.

The point file statistics are then updated in the right-hand pane of the Terrain Model Explorer.

**Adding to the Surface Point File by Selecting Lines**

If your drawing file has 3D lines, then you can add the endpoints of these lines to the surface data file.

**To add line data to the surface point file**

1  From the Terrain menu, choose Terrain Model Explorer.
2  Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
3  Open the surface folder in the Terrain Model Explorer to display the subfolders.
4  Right-click on `Point Files` to display the shortcut menu.
5  Click Add Points from AutoCAD Objects ➤ Lines.

The Terrain Model Explorer closes so you can view the drawing and the following prompt is displayed:

Select objects by (Entity/Layer) <Layer>: 

**NOTE**  If you already defined point data from objects in the drawing, then an append or overwrite prompt is displayed. For more information, see “Appending or Overwriting the Surface Point File” in this chapter.
6 Do one of the following to select the lines:
   ■ Type Entity to select the lines from the drawing, and then use any standard selection method to select the lines.
   ■ Type Layer to select the lines by layer, and then select one line on the layer that you want to select. All valid 3D lines on that layer are added to the surface data file.
   ■ Type Layer, press ENTER, and then type the layer name. All valid 3D lines on the layer are selected and their end points are added to the surface data file.

The point file statistics are then updated in the right-hand pane of the Terrain Model Explorer.

Adding to the Surface Point File by Selecting Blocks

If you have blocks that are inserted at an elevation in the drawing, then you can add the insertion points of the blocks to the surface data file.

To add block data to the surface point file

1 From the Terrain menu, choose Terrain Model Explorer.
2 Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
3 Open the surface folder in the Terrain Model Explorer to display the subfolders.
4 Right-click on Point Files to display the shortcut menu.
5 Click Add Points from AutoCAD Objects ▶ Blocks.

The Terrain Model Explorer closes so you can view the drawing and the following prompt is displayed:

Select objects by (Entity/Layer) <Layer>:

NOTE If you already defined point data from objects in the drawing, then an append or overwrite prompt is displayed. For more information, see “Appending or Overwriting the Surface Point File” in this chapter.

6 Do one of the following to select the lines:
   ■ Type Entity to select the blocks from the drawing, and then use any standard selection method to select the blocks.
   ■ Type Layer to select the blocks by layer, and then select one block on the layer that you want to select. All valid blocks on that layer are selected and their insertion points are added to the surface data file.
   ■ Type Layer, press ENTER, and then type the layer name. All valid blocks on the layer are selected and their insertion points are added to the surface data file.

The point file statistics are then updated in the right-hand pane of the Terrain Model Explorer.
Adding to the Surface Point File by Selecting Text

If you have AutoCAD text that is inserted at an elevation in the drawing, then you can add the insertion points of the text to the surface data file.

To add text data to the surface point file

1. From the Terrain menu, choose Terrain Model Explorer.
2. Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
3. Open the surface folder in the Terrain Model Explorer to display the subfolders.
4. Right-click on [Point File] to display the shortcut menu.
5. Click Add Points from AutoCAD Objects ➤ Text.

   The Terrain Model Explorer closes so you can view the drawing and the following prompt is displayed:

   Select objects by (Entity/Layer) <Layer>:

   NOTE
   If you already defined point data from objects in the drawing, then an append or overwrite prompt is displayed. For more information, see “Appending or Overwriting the Surface Point File” in this chapter.

6. Do one of the following to select the text:

   ■ Type Entity to select the text from the drawing, and then use any standard selection method to select the text.
   ■ Type Layer to select the text by layer, and then select one piece of text on the layer that you want to select. All valid text blocks on that layer are selected and their insertion points are added to the surface data file.
   ■ Type Layer, press ENTER, and then type the layer name. All valid text blocks on that layer are selected and their insertion points are added to the surface data file.

   The point file statistics are then updated in the right-hand pane of the Terrain Model Explorer.

Adding to the Surface Point File by Selecting 3D Faces

You can add points to the surface data file by selecting existing AutoCAD 3D faces in the drawing. The corners of the selected faces become points in the surface point file.

To add 3D face data to the surface point file

1. From the Terrain menu, choose Terrain Model Explorer.
2. Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
3. Open the surface folder in the Terrain Model Explorer to display the subfolders.
4 Right-click on Point Files to display the shortcut menu.

5 Click Add Points from AutoCAD Objects ➤ 3D Faces.

   The Terrain Model Explorer closes so you can view the drawing and the following prompt is displayed:

   Select objects by (Entity/Layer) <Layer>:

   **NOTE**

   If you already defined point data from objects in the drawing, then an append or overwrite prompt is displayed. For more information, see “Appending or Overwriting the Surface Point File” in this chapter.

6 Do one of the following to select the 3D faces:

   ■ Type Entity to select the 3D faces from the drawing, and then use any standard selection method to select the 3D faces.

   ■ Type Layer to select the 3D faces by layer, and then select one 3D face on the layer that you want to select. All valid 3D faces on that layer are selected and the corner points of the selected faces are added to the surface data file.

   ■ Type Layer, press ENTER, and then type the layer name. All valid 3D faces on that layer are selected and the corner points of the selected faces are added to the surface data file.

   The point file statistics are then updated in the right-hand pane of the Terrain Model Explorer.

**Adding to the Surface Point File by Selecting Polyfaces**

You can add points to the surface data file by selecting existing AutoCAD polyfaces in the drawing.

**To add polyface data to the surface point file**

1 From the Terrain menu, choose Terrain Model Explorer.

2 Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.

3 Open the surface folder in the Terrain Model Explorer to display the subfolders.

4 Right-click on Point Files to display the shortcut menu.

5 Click Add Points from AutoCAD Objects ➤ Polyface.

   The Terrain Model Explorer closes so you can view the drawing and the following prompt is displayed:

   Select objects by (Entity/Layer) <Layer>:

   **NOTE**

   If you already defined point data from objects in the drawing, then an append or overwrite prompt is displayed. For more information, see “Appending or Overwriting the Surface Point File” in this chapter.
Do one of the following to select the polyfaces:

- Type `Entity` to select the polyfaces from the drawing, and then use any standard selection method to select the polyfaces.
- Type `Layer` to select the polyfaces by layer, and then select one polyface on the layer that you want to select. All valid polyfaces on that layer are selected and the vertices are added to the surface data file.
- Type `Layer`, press ENTER, and then type the layer name. All valid polyfaces on that layer are selected and the vertices are added to the surface data file.

The point file statistics are then updated in the right-hand pane of the Terrain Model Explorer.

### Creating Contour Data to Use in Surface Generation

To build a surface from contour data, you must add the contour data to the Contours folder in the Terrain Model Explorer. When you add contour data, AutoCAD Land Development Desktop reviews, organizes, and stores the contour data. The contour data is stored in the following folder:

c:\Land Projects R2\<project name>\dtm\<surface name>.

The Create as contour data check box in the Contour Weeding dialog box controls whether the contour data is written out as contour data or as point data.

- Select this check box to have the data written out as contour data to the `<surface name>brk.bin` file and have the contours treated as breaklines. No surface triangulation occurs across the contour lines.
- Clear this check box to have the contour data written out as point data to the `<surface name>pnt.txt` file and treated as point data. Using this method, surface triangulation could occur across the contour lines.

You can create contour data from contour objects that you created with the Create Contours, Digitize Contours, or Convert Polylines command. You can also create contour data from polylines drawn at an elevation or that were assigned elevations.
**Creating Contour Data to Use in Surface Generation**

To create contour data:

1. From the Terrain menu, choose Terrain Model Explorer.
2. Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
3. Open the surface folder in the Terrain Model Explorer to display the subfolders.
4. Right-click on Contours to display the shortcut menu.
5. Click Add Contour Data.

   The Terrain Model Explorer closes and the Contour Weeding dialog box is displayed.
6. Select or clear the Create as contour data check box:
   - Select this check box to write out the vertices as contour data, which has the same behavior as breaklines. When this box is selected, the program saves the data to the `<surface name>brk.bin` file.
   - Clear this check box to create random point data using the contour vertices and save the data to the `<surface name>pnt.txt` file.
7. Type the Weeding Distance and Angle factor values. Use the weeding factors to reduce the number of points generated along the contours. The weeding factors ignore vertices that are closer together than the distance factor and vertices that deflect less than the angle factor. A larger distance and deflection angle weeds a greater number of points. The distance factor is measured in linear units and the angle factor is measured in angular units. The weeding factors must be less than the supplementing factors.

   A point on the contour is weeded by calculating its location in relation to the vertices before and after it. If the length between these three points is less than the weeding length value, and the deflection angle is less than the weeding angle value, then the middle point is not added to the contour data file.

   The following illustration shows the weeding factor parameters:

   ![Weeding factor parameters](image-url)
8 Type the Supplementing Distance and Bulge factor values. Use the supplementing factors supplement or add vertices along contours. The supplementing distance is the maximum distance between vertices. If the distance between vertices on a contour is greater than the supplementing factor, then points are added along the contour at the specified distance. The smaller the distance, the greater the number of supplemented points.

The following illustration shows the supplementing factor parameters:

![Supplementing factor parameters](image)

For contours that contain curves, the bulge value is a minimum mid-ordinate distance along a polyline curve. The bulge factor adds vertices to a polyline curve, creating an approximation of the curve using straight line segments. The length of these segments varies depending on the bulge factor and the degree of curvature.

The following illustration shows the bulge factor parameters:

![Bulge factor parameters](image)

9 Click OK.

The following prompt is displayed:

Select objects by (Entity/Layer) <Layer>:

10 Do one of the following to select the contours or polylines:

- Type Entity to select the contours from the drawing, and then use any standard selection method to select the contours.
- Type Layer to select the contours by layer, and then select one contour on the layer that you want to select. All valid contours or polylines on that layer are selected.
■ Type Layer, press ENTER, and then type the layer name. All valid contours or polylines on that layer are selected.

The Terrain Model Explorer is redisplayed and the contour statistics are updated in the right-hand pane.

**Deleting Contour Data from a Surface Folder**

After you add contour data to a surface folder, you can delete it if you no longer want to use it as part of the surface definition.

**To delete contour data from a surface folder**

1. From the Terrain menu, choose Terrain Model Explorer.
2. Open the surface folder in the Terrain Model Explorer to display the subfolders.
3. Right-click on **Contours** to display the shortcut menu.
4. Select Remove All Contour Data.

A message box is displayed, informing you that all contour data will be deleted from the surface.

Click Yes to proceed, or click Cancel to end the command without deleting the contour data.

**Contour Data and Surface Triangulation**

Information obtained from a contour map differs greatly from data taken randomly in the field. Because contour map data is interpolated, the information may be less accurate than direct field data. The accuracy of the final surface model depends on the quality of your contour map and the contour interval.

If you bring contour data back into the drawing as points, then the points would not be very random. In steep areas, points would be close together. In flat areas, there is a greater distance between points on different contours. In both cases, the points along the contours are generally close together. Therefore, information taken from contours does not make effective random point data. Random data points generate the best triangulation with a minimal amount of work.

**Missing Contour Information**

When you create a model from contours and then generate contours from this model, a few circumstances exist where the Create Contours command may fail to generate contours. In the most common situation, a contour is missing in a low or high area. The missing contours might be located near the top of a hill, at the bottom of a valley, or on the edge of the site.

To correct both problems, place spot elevations or another contour line near the place where the contour is missing. For example, if a contour line is missing along the top of a hill with an elevation of 100, place a new contour, breakline, or spot elevations just above the 100 foot elevation (i.e. at 100.01). We suggest that you place any interpolated data, points, or contours on a separate layer.
NOTE
If you generate contours from a surface that you created using only contour information, you might need to place breaklines or spot elevations in areas where the contour line changes direction drastically. Areas where this is likely to happen include: a crowned roadway, a swale, or a ridge. In these places, contours might tend to triangulate onto themselves. In most instances, the Minimize Flat Faces command resolves this problem. In more drastic situations, you might need to use the Proximity Breaklines commands or add additional point data along the stream centerline.

Creating Breakline Data to Use in Surface Generation

You can create surface data from any combination of point, breakline, boundary, and contour data. You can use breaklines to define retaining walls, curbs, tops of ridges, and streams. Breaklines force surface triangulation along the breakline and prevent triangulation across the breakline.

Breaklines are typically critical to creating an accurate surface model, because it is the interpolation of the data, not just the data itself, that determines the shape of the model.

Breakline data is stored in the <surfacename>flt.bin file, located in the following folder:

c:\Land Projects R2\<project name>\dtm\<surface name>\n
All breaklines are created and managed in the Terrain Model Explorer dialog box.

NOTE
The breaklines are automatically drawn on the SRF-FLT layer by default, but you can change this layer. For more information, see "Changing the Surface Display Settings" in Chapter 31, "Displaying Surfaces."
Creating Breakline Data to Use in Surface Generation

The following illustration shows the effects of breaklines:

The Terrain Model Explorer closes so you can see the graphics window.

5. Select Define By Point.

The Terrain Model Explorer closes so you can see the graphics window.

6. Select the first point of the breakline.

**TIP** You can use Point Filters to snap exactly to the points. For more information, see “Selecting Points and Locations” in Chapter 11, “Creating Points.”

7. Continue selecting points to add to the line.

Creating Breaklines from Points

You can define a breakline by selecting COGO points from one end of the breakline to the other. You can pick any part of the COGO point to select the point.

**To create a breakline by selecting points**

1. From the Terrain menu, choose Terrain Model Explorer.
2. Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
3. Open the surface folder in the Terrain Model Explorer to display the subfolders.
4. Right-click on Breaklines to display the shortcut menu.
5. Select Define By Point.
6. Select the first point of the breakline.
7. Continue selecting points to add to the line.
At the select point prompt, press ENTER to complete the breakline.

Type a description for the breakline.

A dialog box is displayed that asks if you want to Delete existing objects.

Click Yes or No:

- Click Yes to erase the original breakline and create a new object with links to the breakline file. The program places the new object on the breakline layer.
- Click No to keep the existing breakline and to create a new object with links to the breakline file. The program places the new object on the breakline layer.

Breakline as you select successive points

Creating Breaklines from Point Numbers

You can define a breakline by entering point numbers from one end of the breakline to the other. You can use individual numbers and/or groups of numbers separated by dashes.

To create a breakline from point numbers

1. From the Terrain menu, choose Terrain Model Explorer.
2. Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
3. Open the surface folder in the Terrain Model Explorer to display the subfolders.
4. Right-click on Breaklines to display the shortcut menu.
5. Select Define By Point Number.

The Terrain Model Explorer closes so you can see the graphics window.

6. Type the point numbers of the breakline. You can type individual points separated by commas, and ranges of points separated by dashes (1,2,3,10-100).
7. Press ENTER to complete the breakline.
8. Type a description for the breakline.
The following illustration shows three breaklines defined by point numbers:

Two breaklines are the right and left edges of pavement, and the third is the roadway centerline. Because breaklines have been defined, no triangulation lines will be drawn from the left edge of pavement to the right edge of pavement.

**Creating Breaklines from 2D or 3D Polylines or Lines**

You can use 2D or 3D polylines as breaklines to create a surface. The X, Y, and Z coordinates of each vertex on the polyline that you select are written to the breakline file. If you select a 2D polyline with a zero elevation, then it is saved in the breakline file with that elevation.

**To create a breakline from a polyline**

1. From the Terrain menu, choose Terrain Model Explorer.
2. Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
3. Open the surface folder in the Terrain Model Explorer to display the subfolders.
4. Right-click on Breaklines to display the shortcut menu.
5. Select Define By Polyline.
   - The Terrain Model Explorer closes so you can see the graphics window.
6. Type a description for the breakline.
7. Select the polyline(s) to use as a breakline.
8. Press ENTER to complete the selection set.

A dialog box is displayed that asks if you want to Delete existing objects.
9 Click Yes or No:

- Click Yes to erase the original polyline and create a new object with links to the breakline file. The program places the new object on the breakline layer.
- Click No to keep the existing polyline and to create a new object with links to the breakline file. The program places the new object on the breakline layer.

If you selected a polyline that is already defined as a breakline, then a warning message is displayed with the following options:

- **Ignore**: Keeps the existing breakline, and ignores the newly selected polyline.
- **Modify**: Changes the breakline definition to include any changes to the graphic polyline selected.
- **Overwrite**: Deletes the original breakline definition and defines a new breakline from the polyline that you selected.

Each option has a second choice: Ignore All, Modify All, Overwrite All. If you select any All option, then the program suppresses this message and repeats the option selected on any other breaklines selected until the command is ended.

The following illustration shows polyline breaklines:

![Polyline breaklines](image)

**Creating Breaklines from 3D Lines**

You can use 3D lines as breaklines to create a surface. Each line that you select is defined as a two-point breakline.

**NOTE**  
This is a good way to recreate a surface if you lost all the project files associated with the line drawings.
To create breaklines from 3D lines

1. From the Terrain menu, choose Terrain Model Explorer.
2. Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
3. Open the surface folder in the Terrain Model Explorer to display the subfolders.
4. Right-click on 3D Lines to display the shortcut menu.
5. Select Define by 3D Lines.
   The Terrain Model Explorer closes so you can see the graphics window.
6. Type the description for the 3D line breaklines.
   The following prompt is displayed:
   Select objects by (Entity/Layer) <Layer>:
7. Do one of the following:
   - Type Entity and then use any standard selection method to select the lines.
   - Type Layer to select the text by layer, and then select one 3D line on the layer that has the 3D lines you want to select. All valid 3D lines on that layer are selected and their endpoints are added to the breakline file.
   - Type Layer and then press ENTER and then type the layer name. All valid 3D lines on that layer are selected and their end points are added to the breakline file.

Importing Breakline Definitions from a Text File

You can create a breakline file with a text editor. You can then import this text file into the drawing to use as breakline data for building the surface.

To import a breakline file

1. Create a breakline file. For more information, see “Creating a Breakline File Manually” in this chapter.
2. From the Terrain menu, choose Terrain Model Explorer.
3. Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
4. Open the surface folder in the Terrain Model Explorer to display the subfolders.
5. Right-click on 3D Lines to display the shortcut menu.
Select Define Breaklines From File to display the Read ASCII Breakline File dialog box.

Select the file to import. The files all have an .flt file extension. For more information, see the next section, “Creating a Breakline File Manually.”

Click OK.

Creating a Breakline File Manually

You can create your own breakline file by performing the following steps. If the coordinate information is supplied to you in a similar format, then you can easily create this import file.

To create a breakline file manually

1. Open an ASCII text editor such as Notepad or Wordpad.
2. Type the file using the following structure:
   ■ Use the (#) symbol as the first character in a comment line.
   ■ Use the letters P, S, L, and R describe the breakline type. These letters stand for Proximity, Standard, Wall Left, and Wall Right. Identify a breakline type for each new breakline.
   ■ Type the X, Y, and Z coordinates separated by a space.
   ■ A description for the breakline can follow the first coordinate of the line.
   ■ By entering in the breakline type letter at the beginning of a line, a new breakline is created. For instance, in the example below an S is placed at the beginning of the 8\textsuperscript{th} line of the file. All the points from this point until the next breakline letter modifier are in one breakline. This breakline is called EOP.
Save the file with an .flt file extension.

The following is an example of a breakline file:

```
# Autodesk User Defined Breakline File
P1542.258750 179.318779 0.000000 Flow Line
1190.721102 350.527660 0.000000
860.816542 446.044194 0.000000
588.600214 619.055276 0.000000
608.430540 743.406990 0.000000
565.164367 925.429066 0.000000
81529.639450 179.318779 0.000000 EOP
1188.918348 357.736453 0.000000
1021.998725 330.653391 0.000000
594.008485 610.044279 0.000000
761.574952 744.929530 0.000000
610.233298 754.220180 0.000000
570.572642 923.626865 0.000000
P1542.258750 179.318779 0.000000 Flow Line
1190.721102 350.527660 0.000000
860.816542 446.044194 0.000000
588.600214 619.055276 0.000000
608.430540 743.406990 0.000000
565.164367 925.429066 0.000000
```

Proximity Breaklines

Proximity breaklines reference sampled points (any breakline point, contour point, or COGO point used to create a TIN) that are in proximity to the points or polylines that you select as the breakline. You can define proximity breaklines quickly because you don’t have to exactly snap to the sampled points that you want to use for the breakline. You can just pick locations that are near to the sampled points that you want to use. The breakline vertices automatically snap to the nearest sampled point when the surface is built the first time.

You can define proximity breaklines by selecting locations in the drawing or from a polyline. The polyline method is similar to the point method. You don’t have to draw the polyline exactly between sampled points. The breakline definition automatically snaps to the sampled point that is nearest each polyline vertex when the surface is built the first time.

Proximity breaklines are 2D polylines with elevations of 0. When you run the Build command to build the surface, the northing, easting, and elevation are calculated for each vertex according to the closest sampled surface point. By default proximity breaklines are converted to standard breaklines. The conversion of proximity breaklines to standard breaklines can be turned off in the Build dialog box.

**NOTE** Proximity breaklines do not support curves. If a 2D polyline with a curve is selected the resulting breakline will only have the chord of the curve.
Defining Proximity Breaklines by Selecting Points

You can define proximity breaklines by selecting locations close to sampled points (any breakline point, contour point, or COGO point used to create a TIN). A breakline is added into the database based on the northings and eastings of the selected locations.

When you build the surface model, the proximity breakline points snap to match the nearest sampled points. After the model is created, you can import the proximity breakline to see what points were used in the breakline definition.

To define breaklines by proximity

1. From the Terrain menu, choose Terrain Model Explorer.
2. Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
3. Open the surface folder in the Terrain Model Explorer to display the subfolders.
4. Right-click on Breakline to display the shortcut menu.
5. Select Draw Proximity Breakline.
   The Terrain Model Explorer closes so you can see the graphics window.
6. Using your mouse, select the first point of the breakline. You do not have to snap to the point.
7. Using your mouse, select the next point. Continue selecting points until all points are selected.
8. Press ENTER to end the point selection.
9. Type the description for the breakline.
   A dialog box is displayed that asks if you want to Delete existing objects.
10. Click Yes or No:
    - Click Yes to erase the original breakline and create a new object with links to the breakline file. The program places the new object on the breakline layer.
    - Click No to keep the existing breakline and to create a new object with links to the breakline file. The program places the new object on the breakline layer.

Defining Proximity Breaklines by Selecting Polylines

You can define proximity breaklines from polylines that are not drawn exactly from sampled point to sampled point, but are in the proximity of the points. Each vertex point in the polyline can be in the proximity of a sampled point. When the surface model is calculated, each vertex point of that breakline snaps to the nearest sampled point. Because you don’t have to draw the polylines from exact points, the proximity breakline command makes it quicker and easier to define a breakline.
This command adds a breakline into the database based on polyline vertex northing and easting coordinates. The elevational value at each vertex point of the breakline is 0. When you build the surface model, the proximity breakline points snap to match the nearest sampled points. After the model is created, you can import the proximity breakline to see what points were used in the breakline definition.

To define a proximity breakline by using a polyline near points
1. From the Terrain menu, choose Terrain Model Explorer.
2. Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
3. Open the surface folder in the Terrain Model Explorer to display the subfolders.
4. Right-click on Breakline to display the shortcut menu.
5. Select Proximity By Polylines.
   The Terrain Model Explorer closes so you can see the graphics window.
6. Type the description for the breaklines.
7. Select the polylines to create breaklines from.
8. Press ENTER to end the polyline selection.
   A dialog box is displayed that asks if you want to Delete existing objects.
9. Click Yes or No:
   - Click Yes to erase the original polyline and create a new object with links to the breakline file. The program places the new object on the breakline layer.
   - Click No to keep the existing polyline and to create a new object with links to the breakline file. The program places the new object on the breakline layer.

The following illustration shows the relationship between the proximity points and the polyline selection point:
Defining Walls or Curbs as Breaklines

You can define retaining walls or curbs as breaklines to be used as surface data. By creating wall breaklines, you prevent surface triangulation from occurring from one side of the wall to the other. For example, for a retaining wall, you can define the differences in elevation between the material on both sides of the wall so that TIN lines on one side of the wall stop at the bottom of the wall, and the TIN lines on the other side of the wall stop at the top of the wall.

You can define wall breaklines by selecting an existing polyline. The Define Wall Breaklines command extends this polyline by creating new polyline segments and vertices parallel to the original polyline, but offset at an incremented distance to represent the differences in elevation between the material on either side of the wall.

The command continues through each polyline vertex in sequence until all control and offset elevation values are entered, defining the top and bottom configuration of the wall breakline.

After you defined the wall breakline, you can create a new surface that recognizes this breakline, with the polyline vertices becoming new surface points.

![Polyline vertices as new surface points](image)

**NOTE** When you define wall breaklines, we recommend that you define no more then five walls at one time. When running, the command uses much of your system’s resources. Resources are cleared when you end the command.

To create a wall breakline

1. From the Terrain menu, choose Terrain Model Explorer.
2. Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
3. Open the surface folder in the Terrain Model Explorer to display the subfolders.
4. Right-click on **Breaklines** to display the shortcut menu.
5. Select Define Wall Breaklines.
   
   The Terrain Model Explorer closes so you can see the graphics window.
6. Type the description for the wall breakline.
Select the polyline to define the wall breakline.

After you select the existing polyline, you need to specify the offset side for the wall breakline. The existing polyline side of the wall is the control side.

Select the offset side. This is the side for the new offset line that represents the elevation of material on the other side of the wall.

A temporary arrow originating from each vertex shows the direction of the offset point, and then you define the elevation as the command proceeds.

Type the elevation for the wall.

The command prompts you for the elevation of the first control point (original polyline vertex), then the associated offset point (new polyline vertex) immediately below or above it.
The prompts provide two ways to define elevations for each offset point: as an elevation or as the elevational difference between the control point and the offset point. Elevational differences may be either positive or negative values.

Elevational differences

10 Type the elevation, or difference in elevation, for the offset.
11 Repeat steps 9 and 10 until all points receive elevations.
12 If you want to create another wall, then type the wall description and repeat steps 7 through 11.
13 Press ENTER to end the command.

If the polyline selected for this command is already a defined breakline, a warning message is displayed. If you want to save the work you just did, then select Yes to save the data.

**Identifying Breaklines in a Drawing**

You can list a breakline’s number, description, and type by selecting it from the drawing.

To identify a breakline
1 From the Terrain menu, choose Terrain Model Explorer.
2 Open the surface folder in the Terrain Model Explorer to display the subfolders.
3 Right-click on the Breakline to display the shortcut menu.
4 Select Id Breakline.

The Terrain Model Explorer closes so you can see the graphics window.
Select a breakline.
The breakline number, description and type are displayed at the command line.
Types include Standard, Proximity, and Wall.

At the Select Polyline prompt, press ENTER to end the command.

**Listing the Breaklines in the Project**

You can display information about breaklines that exist in the project. The breaklines do not need to exist in the drawing in order to view the information.

**To list breakline data**
1. From the Terrain menu, choose Terrain Model Explorer.
2. Open the surface folder in the Terrain Model Explorer to display the subfolders.
3. Right-click on `Breaklines` to display the shortcut menu.
4. Select List Breaklines to display the List Breaklines dialog box.

This dialog shows each breakline number and description.

Select a breakline.
6 Click List to see the detailed information for that breakline. The following information is displayed:

<table>
<thead>
<tr>
<th>Vertex</th>
<th>Northing</th>
<th>Easting</th>
<th>Elevation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 4029125.0000</td>
<td>21541.63</td>
<td>29404.9400</td>
<td>0.0000</td>
</tr>
<tr>
<td>2 4029125.78</td>
<td>21541.63</td>
<td>29404.9400</td>
<td>0.0000</td>
</tr>
<tr>
<td>3 4029125.2393</td>
<td>21541.63</td>
<td>29404.9400</td>
<td>0.0000</td>
</tr>
</tbody>
</table>

- **Vertex**: The number of the vertex in the breakline. (This is not the number of the point that was selected if the breakline was generated from point data.)
- **Northing**: The northing value of a specific vertex in the breakline.
- **Easting**: The easting value of a specific vertex in the breakline.
- **Elevation**: The elevation of a specific vertex in the breakline.

7 Click OK to return to the List Breakline dialog box.
8 Click Cancel to return to the drawing.

**Importing Breaklines into a Drawing**

You can import any or all of the breaklines from the breakline file into a drawing. This is useful if you start another drawing in the current project, or erased the breaklines from the drawing and you want to edit them. The file that contains the breakline data is `<surface name>flt.bin`, a file located in the project directory.

**To import a breakline into a drawing**

1 From the Terrain menu, choose Terrain Model Explorer.
2 Open the surface folder in the Terrain Model Explorer to display the subfolders.
3 Right-click on **Breakline** to display the shortcut menu.
Select Import Breaklines to display the Import Breaklines dialog box.

5 Select the breakline to import by clicking on its name, or, use any of the following selection methods:
- **Select All**: Selects all the breaklines in the list.
- **Clear All**: Clears the selection of all the breaklines in the list.

Each breakline you select is marked with an asterisk (*).

6 Click OK to insert the breaklines you selected.

When this command imports the breaklines, it creates them as 3D polylines in the drawing.

**Editing Breaklines**

You can edit any breakline that you have defined by selecting it from the screen. You can insert, move, and delete vertices, as well as redefine the elevation at a selected vertex.

**NOTE** To edit the location of a breakline, use AutoCAD editing commands, and then you can redefine the breakline to the database. For more information, see “Updating Edited Breaklines” in this chapter.

**To edit a breakline**

1 From the Terrain menu, choose Terrain Model Explorer.
2 Open the surface folder in the Terrain Model Explorer to display the subfolders.
3 Right-click on the Breaklines to display the shortcut menu.
4 Select Edit Breakline.

The Terrain Model Explorer closes so you can see the graphics window.

5 Select the breakline to edit. A graphic X displays at the beginning of the breakline you select.

The following prompt is displayed:

Next/Previous/exit/Move/Elevation/Insert/Delete/<Next>:
Do one of the following:

■ Press ENTER or Next to move to the next vertex in the breakline. A temporary cross on the screen indicates the current vertex.
■ Type Previous to move to the previous vertex in the breakline.
■ Type Move to move the current vertex of a polyline to a new location, and then select a new location for the vertex at the New location prompt.
■ Type Edit to edit the elevation of the selected vertex, and then type the new elevation.

**NOTE** If the selected breakline is a wall, then the command prompts you for two elevations.

■ Type Insert to insert another vertex in the polyline at the selected location, and then select the new vertex location and type an elevation.
■ Type Delete to delete the current vertex.
■ Type Exit to stop editing the breakline and exit the command.

**NOTE** Changes are made to the graphic polyline representation of the breakline only. Use the Update Breaklines command to incorporate these changes into the breakline database.

### Changing the Description of a Breakline

You can change the description of any breakline by selecting it.

**To edit a breakline’s description**
1. From the Terrain menu, choose Terrain Model Explorer.
2. Open the surface folder in the Terrain Model Explorer to display the subfolders.
3. Right-click on a breakline to display the shortcut menu.
4. Select Edit Description.
   The Terrain Model Explorer closes so you can see the graphics window.
5. Select the breakline whose description you want to change.
   The breakline’s number, description, and type are displayed at the command line.
6. Type the new description for the breakline.

### Updating Edited Breaklines

You can use AutoCAD commands like MOVE to modify the position of a breakline. However, if you make changes to a breakline, you must run the Update Breaklines command to update the breaklines in the breakline file. If you do not run the routine, then the breakline in the file (not the breakline in the drawing) is used in surface creation.

**To update a breakline**
1. From the Terrain menu, choose Terrain Model Explorer.
2. Open the surface folder in the Terrain Model Explorer to display the subfolders.
3. Right-click on a breakline to display the shortcut menu.
4 Select Update Breaklines.  
The Terrain Model Explorer closes so you can see the graphics window.  
5 Select the breakline(s) that you have edited.  
6 Press ENTER to complete the selection set.  
Any edits that you made to the selected breaklines are saved to the breakline file.

**Deleting Breaklines**

You can remove a breakline definition from the breakline file.

**To delete a breakline**

1 From the Terrain menu, choose Terrain Model Explorer.  
2 Open the surface folder in the Terrain Model Explorer to display the subfolders.  
3 Right-click on Breaklines to display the shortcut menu.  
4 Select Delete Breaklines to display the Delete Breaklines dialog box.  

```
Delete Breaklines

Select breaklines to delete

[File] [Drawing] [Both]

Remote Storage

OK Cancel Help
```

5 Select the breakline to delete by clicking its name, or, use any of the following selection methods:

- **Select All**: Selects all the breaklines in the list.  
- **Clear All**: Clears the selection of all the breaklines in the list.  
- **Select**: Closes the dialog box and lets you select the breakline to be deleted from the drawing.

Selected breaklines are marked by an asterisk (*).
6 Under Delete From, select where the breakline will be deleted from:
   ■ File: Deletes the selected breakline from the breakline file only.
   ■ Drawing: Deletes the selected breakline from the drawing only.
   ■ Both: Deletes the selected breakline from both the breakline file and the drawing.
7 Click OK.

   NOTE If all the breaklines are deleted, then the whole breakline file is deleted.

Exporting Breakline Data to a Text File
You can export selected breakline information to an ASCII text file.

To export breakline data to a file
1 From the Terrain menu, choose Terrain Model Explorer.
2 Open the surface folder in the Terrain Model Explorer to display the subfolders.
3 Right-click on to display the shortcut menu.
4 Select Export to File to display the Write ASCII Breakline File dialog box.

5 Type the name of the file to create.
6 Click OK to exit the dialog box.
   The Select Breakline dialog box is displayed.
7 Select the breaklines to write to the file by clicking their names, or use the following selection methods:
   ■ Select All: Selects all the breaklines in the list.
   ■ Clear All: Clears the selection of all the breaklines in the list.
8 Click OK to write the file and return to the drawing.
Creating Boundary Data to Use in Surface Generation

By defining boundaries, you can control where surface triangulation occurs. You can define two different types of boundaries: outer and interior.

There can be only one outer boundary. The outer boundary defines the outer limits of the surface. An outer boundary is always a Show boundary, meaning that the TIN lines inside the boundary are visible, and the TIN lines outside the outer boundary are not visible. For example, the outer boundary prevents surface triangulation from occurring outside of the bounds of the survey.

You can define multiple interior boundaries for a surface. Interior boundaries can be either Hide or Show boundaries. A Hide boundary hides the surface TIN inside the boundary. A Show boundary shows the surface TIN inside the boundary. For example, an inner boundary could prevent surface triangulation from occurring within an area, such as a building.

When you want to work with the entire surface again, you can remove the boundaries.

Before you define the boundary, you must draw a closed polyline that surrounds the area you want to show or hide. This polyline is used to define the boundary. If you want to create a boundary at the limits of the surface, then you can create a surface border using either the 2D or 3D polyline border commands, and then select it as a boundary. For more information, see “Creating Surface Borders” in Chapter 30, “Editing Surfaces.”

You can define boundaries in one of two ways:

- Before building the surface, you can create boundaries from within the Terrain Model Explorer.
- After building the surface, you can edit the surface by creating (or deleting) boundaries. When you create (or delete) boundaries after building a surface, the surface is modified and the change is added to the Edit History of the surface.

NOTE: Hide boundaries mask the surface, but the surface is not deleted. The full surface remains intact. If there are surface TIN lines that you want to permanently remove from the surface, then use the Delete Line command. For more information, see “Deleting TIN Lines from a Surface” in Chapter 30, “Editing Surfaces.”

Adding a Boundary to the Surface Folder to Use in Surface Generation

When you add a boundary to the surface’s Boundaries folder in the Terrain Model Explorer, the boundary can be used for surface generation. You must build the surface after adding a boundary to the Boundaries folder to see the effect of the boundary.
NOTE There is a Surface Boundaries editing command that you can use to add or remove boundaries after you have built the surface. For more information, see “Defining Surface Boundaries After Building a Surface” in Chapter 30, “Editing Surfaces.”

To define a boundary and add it to the surface folder

1 Draw the boundary using one of the following methods:
   - Use the PLINE command.
   - Use the Surface Borders commands to draw a 2D or 3D polyline border around the surface. For more information, see “Creating Surface Borders” in Chapter 30, “Editing Surfaces.”

   NOTE The boundary must be a closed polyline.

2 From the Terrain menu, choose Terrain Model Explorer.
3 Create a new surface if needed. For more information, see “Creating a New Surface” in this chapter.
4 Open the surface folder in the Terrain Model Explorer to display the subfolders.
5 Right-click on to display the shortcut menu.
6 Click Add Boundary Definition.
   The Terrain Model Explorer closes and you are prompted to select a polyline.
7 Select the closed polyline that represents the outer boundary.
8 Type a name for the boundary.
   The following prompt is displayed:

   Boundary type (Show/Hide/Outer)? <Hide>:

9 Do one of the following:
   - Type Show to create an interior boundary that shows the TIN lines inside the selected polyline.
   - Type Hide to create an interior boundary that hides the TIN lines inside the selected polyline.
   - Type Outer to create an outer boundary for the surface. A surface can have only one outer boundary. An outer boundary is always a Show boundary.

   The following prompt is displayed:

   Make breaklines along edges? <Yes>:

10 Type Yes or No:
   - Type Yes to create non-destructive breaklines along the edges of the boundary.
     When you select this option, vertices are created where the triangulation lines cross the boundary, and the surface is retriangulated.
   - Type No to clip the triangles that cross the boundary line.
The following illustration shows the effects of non-destructive breakline boundaries:

Triangles broken exactly where they cross the boundary

The following illustration shows the effects of not creating non-destructive breaklines at the boundary:

Only full triangles inside boundary are preserved
If you define a boundary for a building pad, for example, and you choose to make non-destructive breaklines at the boundary, then the following effect occurs:

The triangles are broken exactly where the boundary crosses them. Vertices are created where the triangulation lines cross the boundary, and the surface is retriangulated.

**Importing a Surface Boundary**

If you delete the polyline that represents a surface boundary, then you can import the polyline back into the drawing to redisplay the boundary. The Import Boundaries command imports the boundaries as lightweight polylines.

**NOTE**

To see the effects of this command, at least one boundary must be defined in the surface's **Boundaries** folder, and you must have deleted from your drawing the polyline that represents the boundary.

**To import boundaries**

1. From the Terrain menu, choose Terrain Model Explorer.
2. Open the surface folder in the Terrain Model Explorer to display the subfolders.
3. Right-click on **Boundaries** to display the shortcut menu.
4. Click Import Boundaries.
Using Roadway Cross Sections as Surface Data

You can use roadway section data to create a surface model, using the following two methods:

**Method 1:**
- Import points from the cross section data.
- Create a point group from those points.
- Build a surface from that point group.

**Method 2:**
- Import a 3D Road Grid from the cross section data, which brings into the drawing a grid composed of 3D faces.
- Build a surface using point file data (AutoCAD objects) created from 3D faces.

To minimize surface editing, it is best to include data created by the sections only. Points close to but not on a section might cause triangles to be formed in an improper direction. If non-section points exist, then exclude them from the point group. If the surface requires non-section points, then define breaklines along the alignment to represent features such as EOP, Centerline, and so on. This helps to ensure that the triangulation is correct.

**NOTE**
If you want to create sections from an alignment where data in the field is taken on the same interval as the sections to be plotted, then the best method of determining the existing ground might be to create an ASCII file of station and offset information. You can then use the Civil Design Cross Sections menu and choose Existing Ground ➤ Sample From File to import the sections from the ASCII file.
Surface Statistics

The Terrain Model Explorer shows data for each item in the Terrain and Volume folders. Just click any folder to update the view in the right-hand pane with statistics on how many point groups, contours, breaklines, and so on are included in the built surface.

In this chapter

- Statistics for Terrain Surfaces
- Overall Statistics for a Surface
- Statistics for Surface Data Folders
- Volume Surface Statistics
Statistics for Terrain Surfaces

When you click on the Terrain folder in the Terrain Model Explorer, the following information is displayed in the right-hand pane:

**Surface Name**: Lists the terrain surfaces that are defined.

**Status**: Lists the status for surfaces:

- **No data**: The surface has been created but no data exists in the surface folders. The surface has not been built, and no surface .tin file exists.
- **Not built**: The surface has been created and data has been added to the surface folders, but the surface has not yet been built and no surface .tin file exists.
- **OK**: The surface has been built and none of the surface files has been modified since the surface was built. A surface .tin file exists that is newer than all of the data files. This implies that the surface has been built with all of the current data, and no surface properties have been changed since it was built.
- **Out of Date**: The surface has been built but some data has been updated or surface properties have changed since the surface was built. Re-build the surface to update the surface with changes to the data.

**# Points**: Lists the number of points from which the surface was built.

**Modified**: Lists when the surface was last built or saved.

**Size**: Lists the size of the surface in KB.

Overall Statistics for a Surface

When you click on a surface name in the Terrain Model Explorer, for example Surface1, the surface statistics appear in the right-hand pane. These statistics include the description of the surface as well as surface data, surface statistics, and extended surface statistics.

**Description of the Surface**

**Description**
The description of the surface. You assign the description when you build the surface.

**Locked By**
The AutoCAD login name of the person who has the surface open in a read-writable state. NOT LOCKED is displayed when the surface is closed.
**Surface Data**

**Point Groups**
The number of points in the surface that were added from point groups.

**Point Files**
The number of points in the surface that were added from point files, including <surface name>pnt.txt, the file that is created when you use the Add Points from AutoCAD Objects commands.

**Contours**
The number of points in the surface that were added from contours.

**Breaklines**
The number of points in the surface that were added from breaklines.

**Boundaries**
The number of points in the surface that were added from boundaries.

**Estimated Total**
The estimated total number of points the surface was created from. This number is an estimate because the actual number of points that is added to the surface may be less. There may be duplicate points between different data sources, some points may not have valid elevations, or some points referenced in point groups may have been deleted from the COGO point database.

**Surface Statistics**

**Revision #**
The first time a surface is built, the revision # is 1. Each time the surface is rebuilt or saved, the number is incremented.

**No. of Points**
The exact number of points used in the surface.

**Min Coordinates**
The lowest northing and easting coordinates of the surface.

**Max Coordinates**
The highest northing and easting coordinates of the surface.

**Minimum Elevation**
The minimum elevation of the surface.

**Maximum Elevation**
The maximum elevation of the surface.
Extended Surface Statistics

NOTE To generate extended statistics, select the Compute Extended Statistics check box in the Build dialog box when you build the surface. Or, right-click on the surface name in the Terrain Model Explorer and select Calculate Extended Statistics.

Number of Triangles
The number of triangles in the surface TIN.

2D Surface Area
The 2D surface area is the apparent surface area if you look at the surface from plan view. It is obtained by projecting the visible triangles onto the XY plane along the Z axis and summing the areas of the triangles.

If areas on the surface are hidden within boundaries, then these areas are not included in the surface area.

3D Surface Area
The 3D surface area is the true area of the surface and accounts for variations in the surface elevation. The 3D area is the sum of the areas of each of the visible triangles in the surface without projecting the triangles. The greater the variation in elevations, the more the 3D area differs from the 2D area.

An example of the difference between 2D and 3D areas is a building pad. The 2D area is the area that you can see from only the top and doesn't vary with the height of the building pad. The 3D surface area of the building pad is the sum of the areas of each face of the building pad, which would become larger the higher the building pad becomes.

Mean Elevation
The mean elevation of the surface.

Minimum Triangle Area
The area of the smallest triangle in the surface TIN.

Maximum Triangle Area
The area of the largest triangle in the surface TIN.

Statistics for Surface Data Folders

TIN Data Statistics
When you click on the TIN Data folder in the Terrain Model Explorer, the following information is displayed in the right-hand pane:

Point Groups
The number of points in the surface that were added from point groups.
Point Files
The number of points in the surface that were added from point files, including <surface name>pnt.txt, the file that is created when you use the Add Points from AutoCAD Objects commands.

Contours
The number of points in the surface that were added from contours.

Breaklines
The number of points in the surface that were added from breaklines.

Boundaries
The number of points in the surface that were added from boundaries.

Estimated Total
The estimated total number of points the surface was created from. This number is an estimate because the actual number of points that is added to the surface may be less. There may be duplicate points between different data sources, some points may not have valid elevations, or some points referenced in point groups may have been deleted from the COGO point database.

Edit History Information
When you edit a surface, your edits are recorded in an edit history. You can choose to apply these same edits to the surface the next time you build the surface by selecting the Apply Edit History option in the Build Surface dialog box. When the surface is rebuilt, the same edits are made in the order you made them.

When you click on the Edit History folder in the Terrain Model Explorer, each surface edit is displayed in the right-hand pane in the order that it was performed. You can delete an edit from the Edit History by selecting the name of the edit and pressing the DELETE key.

Watershed Information
If watershed data has been calculated, when you click on the Watershed folder in the Terrain Model Explorer, then the information about each watershed subarea is displayed in the right-hand pane:

- The watershed ID, which includes a number for each subarea and the subarea type.
- The watershed area.
- If the watershed is a flat area, multi-drain, multi drain notch, or depression, then the watersheds that it drains into are listed by ID.
- If the watershed is a depression, then the volume and depth when full are also displayed.

For more information about watershed types, see “Watershed Types” in Chapter 29, “Creating Watershed Models.”
Point Group Information

When you click on the Point Groups folder in the Terrain Model Explorer, the names of the point groups that you have added to the surface data are displayed in the right-hand pane.

![Terrain Model Explorer](image)

Point File Information

When you click on the Point File folder in the Terrain Model Explorer, the names of the .txt files, the date the files were last modified, and the size of the files in KB are displayed in the right-hand pane. The point file <surface name>pnt.txt is created when you use the Add Points from AutoCAD Objects commands.

Contour Information

When you click on the Contours folder in the Terrain Model Explorer, the following information is displayed in the right-hand pane:

- **Total # contour points**: The total number of points in the surface that were added from contours.
- **Total # of contours**: The total number of contours in the surface.
- **Elevation range**: The minimum and maximum elevations of the contour data.
- **Minimum coordinates**: The lowest northing and easting coordinates for a contour point in the surface.
- **Maximum coordinates**: The highest northing and easting coordinates for a contour point in the surface.
Breakline Information

When you click on the Breakline folder in the Terrain Model Explorer, the following information is displayed in the right-hand pane:

- **Total # breakline points**: The total number of points in the surface that were added from breaklines.
- **Total # of breaklines**: The total number of breaklines in the surface.
- **Elevation range**: The minimum and maximum elevations of the breakline data.
- **Minimum coordinates**: The lowest northing and easting coordinates for a breakline point in the surface.
- **Maximum coordinates**: The highest northing and easting coordinates for a breakline point in the surface.

Boundary Information

When you click on the Boundary folder in the Terrain Model Explorer the boundary name, type, and whether the TIN triangles are trimmed at the boundary is displayed. The boundary type can be Outer, Hide, or Show.

Volume Surface Statistics

Statistics for All Volume Surfaces

When you click on the Volume folder in the Terrain Model Explorer, the following information is displayed in the right-hand pane:

- **Volume name**: The name of the volume surface.
- **Cut**: The total cut volume for the surface, without cut factor applied.
- **Fill**: The total fill volume for the surface, without fill factor applied.
- **Net**: The difference between the cut and fill volumes.

**NOTE** Parcel volumes are not displayed in the Terrain Model Explorer.
Statistics for a Volume Surface

When you click on a volume surface folder in the Terrain Model Explorer, for example Grid volume results - Site 1 the following information about the volume surface is displayed in the right-hand pane:

- **Description**: The description of the volume surface.
- **Type**: The method used to calculate volumes, such as grid or composite.
- **Strata**: The stratum from which the site was defined.
- **Surface 1**: The first surface in the stratum.
- **Surface 2**: The second surface in the stratum.
- **Cut Volume**: The total cut volume for the site, without cut factor applied.
- **Fill Volume**: The total fill volume for the site, without fill factor applied.
- **Net**: The difference between the cut and fill volumes.
- **Revision #**: The first time a surface is built, the revision # is 1. Each time the surface is rebuilt or saved, the number is incremented.
- **No. of Points**: The exact number of points used in the surface.
- **Min Coordinates**: The lowest northing and easting coordinates of the surface.
- **Max Coordinates**: The highest northing and easting coordinates of the surface.
- **Minimum Elevation**: The minimum elevation of the surface.
- **Maximum Elevation**: The maximum elevation of the surface.
Managing Surfaces

Before you use any of the surface editing or display commands, set the current surface. You can set a current surface, open, close, delete, copy, and rename Terrain and Volume surfaces using the Terrain Model Explorer. You can also view and edit the Edit History of a surface. The Edit History stores a record of all the edits you make to a surface so they can be reapplied to the surface if you ever need to rebuild them.
Managing Surfaces

Use the Terrain Model Explorer to manage your surfaces. From the Terrain Model Explorer you can open, close, save, copy, rebuild, rename, and delete surfaces. You can also use commands on the Terrain menu to select and save the current surface.

Making a Surface Current

Many surfaces can be open simultaneously. However, all surface editing, viewing, volumes, sections, and contour commands work on the current surface only. There can be only one current surface.

To make a surface current

1. From the Terrain menu, choose Set Current Surface to display the Select Surface dialog box.

2. Select one of the following to filter the listed surfaces:
   - Terrain Surface: To show the terrain surfaces in the list.
   - Volume Surface: To show the volume surfaces in the list.

3. Select the surface that you want to make current.

4. Click OK.

NOTE: In the Terrain Model Explorer, you can set a surface current by using the Open (Set Current) command. The last surface that you open using this command is the current surface. For more information, see “Opening an Existing Surface and Making it Current” in this chapter.
In the Terrain Model Explorer, the following conventions are used to indicate different surface states:

- The current surface is indicated by the solid green surface icon: ![Surface1]
- Open surfaces are indicated by bold text: **Surface1**
- Closed surfaces are indicated by normal text: *Surface1*

### Opening an Existing Surface and Making It Current

You must open a surface to either edit it or access the elevational information you need for operations such as creating profiles. After you open the surface, you can edit, query, or display the model any way you like. You can have an unlimited number of surfaces open at any one time. The most recent surface that you open is the current surface.

**NOTE** You can have only one current surface at a time.

In the Terrain Model Explorer you can open a surface and set it current by using the Open (Set Current) command.

- The current surface is indicated by the solid green surface icon: ![Surface1]
- Open surfaces are indicated by bold text: **Surface1**
- Closed surfaces are indicated by normal text: *Surface1*

**To open an existing surface and make it current**

1. From the Terrain menu, choose Terrain Model Explorer.
2. Right-click on the surface folder of the surface that you want to open, for example ![Surface1] to display the shortcut menu.
3. Click Open (Set Current).

### Saving a Surface

When you edit a surface, you should save your changes before closing the surface. If you do not save the surface after you have modified it, then you are prompted to save it when either closing the surface or exiting the drawing.

**To save a surface**

1. From the Terrain menu, choose Terrain Model Explorer.
2. Right-click on the surface folder of the surface that you want to save, for example ![Surface1] to display the shortcut menu.
3. Click Save.
Saving a Surface with a Different Name

You can save a surface with a new name. When you save a surface with a new name, the program makes a copy of the surface and all of the contents of the surface folders.

To save a surface with a different name

1. From the Terrain menu, choose Terrain Model Explorer.
2. Right-click on the surface folder of the surface that you want to save, for example \Surface1 to display the shortcut menu.
3. Click Save As to display the New Surface dialog box.
4. Type the name for the new surface.
5. You can type a description for the new surface.
6. Click OK.

The new surface is displayed in the left-hand pane of the Terrain Model Explorer.

Saving the Current Surface

When you edit a surface, you should save your changes before closing the surface. If you do not save the surface after you have modified it, then you are prompted to save it when either closing the surface or exiting the drawing.

NOTE

In the Terrain Model Explorer, the current surface is indicated by the solid green surface icon: \Surface1.

To save the current surface

- From the Terrain menu, choose Save Current Surface.

Closing a Surface

If you are not working on a surface, then you can close it to free up memory or to allow someone else to edit it.

In the Terrain Model Explorer, the following conventions are used to indicate different surface states:

- The current surface is indicated by the solid green surface icon: \Surface1
- Open surfaces are indicated by bold text: \Surface1
- Closed surfaces are indicated by normal text: \Surface1

Chapter 28  Managing Surfaces  

576
To close a surface that is open
1. From the Terrain menu, choose Terrain Model Explorer.
2. Right-click on the folder of the open surface that you want to close, for example Surface1 to display the shortcut menu.
3. Click Close.

Copying a Surface
To copy a surface
1. From the Terrain menu, choose Terrain Model Explorer.
2. Right-click on the surface folder of the surface that you want to copy, for example Surface1 to display the shortcut menu.
3. Click Copy.
A copy of the surface is added to the Terrain Model Explorer named Copy of <surface name>. You can rename this surface. For more information, see “Renaming a Surface” in this chapter. All surface data that was in the original surface is copied.

Deleting a Surface
To delete a surface
1. From the Terrain menu, choose Terrain Model Explorer.
2. Right-click on the surface folder of the surface that you want to delete, for example Surface1 to display the shortcut menu.
3. Click Delete.
A warning dialog box is displayed, informing you that all files for the selected surface are about to be deleted.
4. Click Yes to delete the surface.
The surface folder is removed from the Terrain Model Explorer.

Renaming a Surface
To rename a surface
1. From the Terrain menu, choose Terrain Model Explorer.
2. Right-click on the surface folder of the surface that you want to rename, for example Surface1 to display the shortcut menu.
3 Click Rename to display the Rename Surface dialog box.

![Rename Surface Dialog Box]

4 Type the new surface name. Surface names are limited to 40 characters.
5 Click OK.

**Calculating Extended Statistics for a Surface**

To calculate extended statistics for a surface
1 From the Terrain menu, choose Terrain Model Explorer.
2 Right-click on the surface folder of the surface that you want to calculate extended statistics for, for example Surface1 to display the shortcut menu.
3 Click Calculate Extended Statistics.

The surface statistics are updated to show the extended statistics. For more information, see “Overall Statistics for a Surface” in Chapter 27, “Surface Statistics.”

**Surface Locking**

To support multi-user access to a surface in a network environment, surfaces have a locking mechanism so that only one person can save edits at a time. Anyone else who opens the surface has read-only access to it. When a surface is locked, you can view it, extract information, or even edit it, but you can’t save it.

In the Terrain Model Explorer statistics, you can see whether a surface is locked or unlocked. For more information, see “Overall Statistics for a Surface” in Chapter 27, “Surface Statistics.”

It is important to coordinate efforts when working with surfaces, or any other project data, in a multi-user network environment.

**Changing Surface Properties**

You can change the surface properties before, during, or after building a surface.
To change the surface properties before or after building a surface, you can use the Properties command.

The properties that you change are not applied until you build the surface.

To change the surface properties
1 From the Terrain menu, choose Terrain Model Explorer.
2 Right-click on the surface folder, for example Surface1 to display the shortcut menu.
3 Click Properties to display the Surface Properties dialog box.
4 Click the Surface tab if it is not already active.
In the Description box you can type a description for the surface. The surface description can be up to 255 characters.

Change the properties as needed. For more information, see “Building a Surface” in Chapter 26, “Creating Surface Models.”

Managing Volume Surfaces

When you calculate volumes using either the grid method or the composite method, a volume surface is created.

The elevational values of a volume surface are actually the differences between the two surfaces that make up the stratum. For example, at point 1000, 1000, the bottom surface has an elevation of 100, and the top surface has an elevation of 150. The elevation of point 1000, 1000 on the volume surface is the difference between the two surfaces, which is 50.

If a point on a volume surface is in a fill situation, then the elevation of that point is a positive number. If a point is in a cut condition, then the elevation of that point is a negative number.

Because surfaces are generated from the grid and composite volume calculations, you can create cut and fill contours from a volume surface to show the depths of cut and fill, and you can use any of the surface display commands to view the surface.

NOTE
You can access some surface display commands from the volume surface shortcut menu in the Terrain Model Explorer. For more information on changing the display of volume surfaces, see Chapter 31, “Displaying Surfaces.”

Opening a Volume Surface and Make it Current

To work with a volume surface, it must be open and it must be set current.

In the Terrain Model Explorer, the following conventions are used to indicate different volume surface states:

- Open volume surfaces are indicated by bold text: Volume 1
- Closed volume surfaces are indicated by normal text: Volume 1

To open a volume surface and make it current

1. Calculate volumes using either the grid method or the composite method. By calculating volumes using these methods, a volume surface is created. For more information, see the sections “Calculating Grid Volumes” and “Calculating Composite Volumes” in Chapter 35, “Calculating Volumes.”
2. From the Terrain menu, choose Terrain Model Explorer.
3. Right-click on the folder of the volume surface that you want to open, for example Volume 1 to display the shortcut menu.
4. Click Open (Set Current).
Closing a Volume Surface

If you are not working on a surface, then you can close it to free up memory or to allow someone else to edit it.

In the Terrain Model Explorer, the following conventions are used to indicate different volume surface states:

- Open volume surfaces are indicated by bold text: Volume 1
- Closed volume surfaces are indicated by normal text: Volume 1

To close a volume surface

1. Calculate volumes using either the grid method or the composite method. By calculating volumes using these methods, a volume surface is created. For more information, see the sections “Calculating Grid Volumes” and “Calculating Composite Volumes” in Chapter 35, “Calculating Volumes.”
2. From the Terrain menu, choose Terrain Model Explorer.
3. Right-click on the folder of the volume surface that you want to close, for example Volume 1 to display the shortcut menu.
4. Click Close.

Saving a Volume Surface

When you edit a surface, you should save your changes before closing the surface. If you do not save the surface after you have modified it, then you are prompted to save it when either closing the surface or exiting the drawing.

To save a volume surface

1. Calculate volumes using either the grid method or the composite method. By calculating volumes using these methods, a volume surface is created. For more information, see the sections “Calculating Grid Volumes” and “Calculating Composite Volumes” in Chapter 35, “Calculating Volumes.”
2. From the Terrain menu, choose Terrain Model Explorer.
3. Right-click on the folder of the volume surface that you want to save, for example Volume 1 to display the shortcut menu.
4. Click Save.

Renaming a Volume Surface

When you calculate volumes using the grid method or the composite method, a volume surface is created and given the name that you assigned to it when you were calculating volumes. You can rename this surface if needed.

To rename a volume surface

1. Calculate volumes using either the grid method or the composite method. For more information, see the sections “Calculating Grid Volumes” and “Calculating Composite Volumes” in Chapter 35, “Calculating Volumes.”
2. From the Terrain menu, choose Terrain Model Explorer.
3 Right-click on the folder of the volume surface that you want to rename, for example Volume1 to display the shortcut menu.
4 Click Rename to display the Rename Surface dialog box.
5 Type the new surface name. Surface names are limited to 40 characters.
6 Click OK.

**Copying a Volume Surface**

To copy a volume surface

1 Calculate volumes using either the grid method or the composite method. By calculating volumes using these methods, a volume surface is created. For more information, see the sections "Calculating Grid Volumes" and "Calculating Composite Volumes" in Chapter 35, "Calculating Volumes."
2 From the Terrain menu, choose Terrain Model Explorer.
3 Right-click on the folder of the volume surface that you want to copy, for example Volume1 to display the shortcut menu.
4 Click Copy.
   A copy of the surface is added to the Terrain Model Explorer, named Copy of <surface name>. You can rename the surface if needed. For more information, see "Renaming a Surface" in this chapter. All of the surface data that was in the original surface is copied.

**Deleting a Volume Surface**

To delete a volume surface

1 Calculate volumes using either the grid method or the composite method. For more information, see the sections "Calculating Grid Volumes" and "Calculating Composite Volumes" in Chapter 35, "Calculating Volumes."
2 From the Terrain menu, choose Terrain Model Explorer.
3 Right-click on the folder of the volume surface that you want to delete, for example Volume1 to display the shortcut menu.
4 Click Delete.
   A warning dialog box is displayed, informing you that all files for the selected surface are about to be deleted.
5 Click Yes to delete the surface.
   The volume surface folder is removed from the Terrain Model Explorer.


**Changing the Volume Surface Properties**

When you generate a volume surface, you can name the surface, but you cannot add a description to the surface. You can add a description of the surface by changing the volume surface properties in the Terrain Model Explorer.

**To change the volume surface properties**

1. Calculate volumes using either the grid method or the composite method. For more information, see the sections “Calculating Grid Volumes” and “Calculating Composite Volumes” in Chapter 35, “Calculating Volumes.”
2. From the Terrain menu, choose Terrain Model Explorer.
3. Right-click on the folder of the volume surface that you want to change the properties of, for example, to display the shortcut menu.
4. Select Properties to display the <surface name> Properties dialog box.

The volume calculation method used to create the surface is displayed on the tab in the dialog box: Grid or Composite.

5. In the Description box, type a description for the surface.
6. Click OK.
Creating Watershed Models

Use the Watershed commands to calculate watershed areas and import them as polylines or solid fills into your drawing. You can choose an option to calculate watersheds during the process of building a surface, or you can use a command to calculate watersheds after a surface has been built.
Creating Watershed Models

You can calculate watersheds either while you build a surface or afterward. AutoCAD Land Development Desktop uses the surface TIN lines to calculate the channels that water would flow along the surface. From these channels, the drain targets and watershed subareas are determined.

Different drain targets are calculated for watershed subareas. For example, some subareas include a boundary point as a drain target, which is the point where the channel of water would drain off the surface. Some subareas have depression areas where the water flows to, and some subareas are defined as boundary segments if the drain target includes the boundary of a surface. For more information about watershed types, see “Watershed Types” in this chapter.

If the Calculate Watershed command determines that water from one TIN surface triangle could flow into more than one watershed subarea, then it splits the TIN triangle to make two triangles. This ensures that each watershed consists of complete triangles, and that the boundary of each watershed consists solely of TIN edges.

After you build the watershed model, use the Water Drop command to draw polyline representations of the path that water would flow along the surface toward channels.

Building a watershed involves three steps: configuring the settings, selecting the Calculate Watershed command from the Terrain Model Explorer, and then selecting the Import Watershed Boundaries command to draw the watershed boundaries.

**TIP** You can use the watershed boundaries when you are using the hydrology commands in Civil Design to calculate watershed runoff.

Changing the Watershed Settings

The watershed settings control the default minimum and maximum watershed depths and areas, watershed layers for different watershed types, whether the watershed subareas are filled in with solids or outlined with polylines when the watershed boundaries are imported, whether the watersheds are numbered when imported, and whether the previous watershed boundaries are erased when boundaries are imported.
To change the watershed settings

1. From the Projects menu click Drawing Settings to display the Edit Settings dialog box.

2. Under Program, select Land Development Desktop.

3. In the Settings list, click Watershed Settings.

4. Click the Edit Settings button to display the Watershed Settings dialog box.

5. Under Depression Criteria, in the Minimum Depression Depth box, type the minimum depression depth that you want to be ignored. This depth is the difference in elevation between the lowest point(s) on the depression boundary and the bottom of the depression.

   This value is used to filter out any smaller depressions that may be in the larger watershed. Any depression that is not as deep as this minimum depth is considered part of the larger watershed that it empties into.

   For more information, see “Shallow Depressions” in this chapter.
6 In the Minimum Depression Area box, type the minimum depression area that you want to be ignored. This area is in the current (square) units that AutoCAD Land Development Desktop is set to, either feet or meters. This value is used to filter out any smaller depressions that may be in the larger watershed. Any depression that is smaller in area than this minimum area is considered part of the larger watershed that it empties into.

7 Select or clear the Must exceed both criteria check box:
   - Select this check box to build the model by only including areas that exceed both the minimum depression depth and the minimum depression area.
   - Clear this check box to use either criteria when evaluating what types of depression areas to include.

8 Under Options, select the Fill with solids check box to fill the watershed areas with solids instead of creating polyline boundaries (when you import the watershed boundaries). This option creates solid areas in the color of the subarea layer. Clear this check box to create polyline outlines.

9 Under Options, select the Display ID Numbers check box to insert watershed numbers in the watersheds.

   **NOTE** You should clear the Fill with solids check box when you select Display ID Numbers, because the numbers are not visible if the watersheds are filled with solids.

10 Under Options, select the Erase previous layers check box to erase the layers on which you have created previous watershed boundaries (when you import the watershed boundaries). Clear this check box if you do not want to erase the layers.

11 Under Layers, select the default layer names for each watershed type. For more information about each of these watershed types, see “Watershed Types” in this chapter.

   **TIP** Use the LAYER command to make these layers different colors so you can easily determine what type of watershed boundary is represented.

12 Click OK.

### Changing Watershed Properties

You can change the watershed properties before, during, or after building a surface. To change the surface properties before or after building a surface, you can use the Properties command.

The properties that you change are not applied until you build the surface.

**To change the watershed properties**

1 From the Terrain menu, choose Terrain Model Explorer.
2 Click on the **Watershed** folder of the surface to display the shortcut menu.
3 Select Properties to display the Watershed Properties dialog box.

![Watershed Properties dialog box]

4 In the Minimum Depression Depth box, type the minimum depression depth that you want to be ignored. This depth is the difference in elevation between the lowest point(s) on the depression boundary and the bottom of the depression. This value is used to filter out any smaller depressions that may be in the larger watershed. Any depression that is not as deep as this minimum depth is considered part of the larger watershed that it empties into.

For more information, see “Shallow Depressions” in this chapter.

5 In the Minimum Depression Area box, type the minimum depression area that you want to be ignored. This area is in the current (square) units that AutoCAD Land Development Desktop is set to, either feet or meters. This value is used to filter out any smaller depressions that may be in the larger watershed. Any depression that is smaller in area than this minimum area is considered part of the larger watershed that it empties into.

6 Select or clear the Must exceed both minimum area and minimum depth check box:
   - Select this check box to build the model by only including areas that exceed both the minimum depression depth and the minimum depression area.
   - Clear this check box to use either criteria when evaluating what types of depression areas to include.

7 Click OK.
Creating a Watershed Model When Building a Surface

You can create a watershed model of the current surface automatically when you build a surface.

After the watershed is calculated, you can create polyline boundaries or solid areas that delineate each subarea (also known as catchment) for the surface by using the Import Watershed Boundaries or Import Individual Watersheds command. Watershed data that is created is saved as <surface name>.hdm and is saved to the c:\Land Projects R2\<project name>\dtm\<surface name> folder. Two other files are also saved to this folder. Watershed boundary data is saved as <surface name>ws.bin and a text file that contains a list of the watersheds that are found is saved as <surface name>ws.txt.

To create a watershed model when building a surface

1. From the Terrain menu, choose Terrain Model Explorer.
2. Create a new surface if needed. For more information, see “Creating a New Surface” in Chapter 26, “Creating Surface Models.”
3. Add the necessary surface data to the surface folders if needed. For more information, see “Creating Surface Data and Adding It to the Surface Folders” in Chapter 26, “Creating Surface Models.”
4. Right-click on the surface folder, for example Surface1 to display the shortcut menu.
5. Click Build to display the Build dialog box.
6. Click the Surface tab if it is not already active.
7. Select the Build Watershed check box.
8. Select the Minimize Flat Triangles Resulting from Contour Data check box.

NOTE If surface data consists of contours, then it is highly recommended that you select the Minimize Flat Triangles Resulting From Contour Data check box if you are building a watershed. This minimizes the number of flat triangles on a surface.

You must also select any other options on the Surface tab required to build the surface. For more information, see “Building a Surface” in Chapter 26, “Creating Surface Models.”

9. Click the Watershed tab.
10. In the Minimum Depression Depth box, type the minimum depression depth that you want to be ignored. This depth is the difference in elevation between the lowest point(s) on the depression boundary and the bottom of the depression. This value is used to filter out any smaller depressions that may be in the larger watershed. Any depression that is not as deep as this minimum depth is considered part of the larger watershed that it empties into.

For more information, see “Shallow Depressions” in this chapter.
In the Minimum Depression Area box, type the minimum depression area that you want to be ignored. This area is in the current (square) units that AutoCAD Land Development Desktop is set to, either feet or meters. This value is used to filter out any smaller depressions that may be in the larger watershed. Any depression that is smaller in area than this minimum area is considered part of the larger watershed that it empties into.

Select or clear the Must exceed both minimum area and minimum depth check box:
- Select this check box to build the model by only including areas that exceed both the minimum depression depth and the minimum depression area.
- Clear this check box to use either criteria when evaluating what types of depression areas to include.

Click OK to build the surface and the watershed model.

You can import the watershed boundaries into the drawing. For more information, see “Importing the Watershed Boundaries into the Drawing” in this chapter.

Creating a Watershed Model After Building the Surface

You can create a watershed model of the current surface after you build a surface. After the watershed is calculated, you can create polyline boundaries that delineate each different type of subarea (also known as catchment) for the surface by using the Import Watershed Boundaries command.

Watershed data that is created is saved as <surface name>.hdm and is saved to the c:\Land Projects R2\<project name>\dtm\<surface name> folder. Two other files are also saved to this folder. Watershed boundary data is saved as <surface name>ws.bin and a text file that contains a list of the watersheds that were found is saved as <surface name>ws.txt.

To create a watershed model after building a surface

1. From the Terrain menu, choose Terrain Model Explorer.
2. Right-click on the surface’s Watershed folder.
3. Select Calculate Watershed to display the Watershed Properties dialog box. For more information, see “Changing Watershed Properties” in this chapter.
4. Click OK.

The watershed is calculated and the watershed statistics are displayed on the right-hand pane of the Terrain Model Explorer.

5. You can import the watershed boundaries into the drawing. For more information, see “Importing the Watershed Boundaries into the Drawing” in this chapter.
Importing the Watershed Boundaries into the Drawing

After you calculate the watersheds for a surface, you can import all of the watershed boundaries into the drawing as polylines or as solid fill areas. You can also number the watershed areas if you import polyline boundaries.

**NOTE** To import individual watershed boundaries, use the Import Individual Watersheds command.

To import the watershed boundaries to the surface

1. From the Terrain menu, choose Terrain Model Explorer.
2. Right-click on the surface’s Watershed folder.
3. Select Import Watershed Boundaries to display the Watershed Display Settings dialog box.

![Watershed Display Settings dialog box](image)

4. Select or clear the Fill With Solids check box:
   - Select this check box to fill the watershed areas with solids instead of creating polyline boundaries. This option creates solid areas using the color of the subarea layer.
   - Clear this check box if you want to create polyline boundaries that outline the watershed subareas.

5. To number the watersheds in the drawing, select the Display ID Numbers check box. This option numbers the watershed in the TIN triangle closest to the watershed’s centroid.

**NOTE** If you select Fill With Solids check box, then you cannot see the watershed numbers. Clear the Fill With Solids check box if you want to view the watershed numbers.
To erase the layers on which you have created previous watershed boundaries, select the Erase Previous Layers check box. Clear this check box if you do not want to erase the layers.

Under Layers, select the default layer names for each watershed type. Each type of watershed is placed on a different layer, based on watershed types:

- **Boundary Point**: The layer for any watershed subarea that is categorized as a boundary point watershed. This region drains to a specific point on the boundary of the surface.
- **Boundary Segment**: The layer for any watershed subarea categorized as a boundary segment watershed. This region drains to an edge of the surface boundary along two or more consecutive points.
- **Depression**: The layer for any watershed subarea categorized as a depression area watershed. This region does not drain off the surface.
- **Flat Area**: The layer for any watershed subarea categorized as a flat area watershed.
- **Multi Drain**: The layer for any watershed subarea categorized as a multi-drain watershed. This region drains to two or more different regions.
- **Multi-Drain Notch**: The layer for any watershed subarea categorized as a multi-drain notch watershed. This region drains to two or more different regions from a flat notch in the surface.

**TIP**
Use the LAYER command to make these layers different colors so you can easily determine what type of watershed boundary is represented.

For more information about each of these watershed types, see “Watershed Types” in this chapter.

Click OK to import the watershed boundaries.

**Importing Individual Watershed Boundaries Into a Drawing**

You can use the Import Individual Watersheds command to import watershed boundaries one-by-one.

**NOTE**
To import all of the watershed boundaries at once, use the Import Watershed Boundaries command.

To import individual watershed boundaries

1. From the Terrain menu, choose Terrain Model Explorer.
2. Right-click on the surface’s Watershed folder.
3. Select Import Individual Watersheds to display the Watershed Display Settings dialog box.
4 Select or clear the Fill With Solids check box:
- Select this check box to fill the watershed areas with solids instead of creating polyline boundaries. This option creates solid areas using the color of the subarea layer.
- Clear this check box to create polyline boundaries that outline the watershed subareas.

5 To number the watersheds in the drawing, select the Display ID Numbers check box. This option numbers the watershed in the TIN triangle closest to the watershed's centroid.

NOTE If you select Fill With Solids check box, then you cannot see the watershed numbers. Clear the Fill With Solids check box if you want to view the watershed numbers.

6 To erase the layers on which you have created previous watershed boundaries, select the Erase Previous Layers check box. Clear this check box if you do not want to erase the layers.

7 Under Layers, select the default layer names for each watershed type. Each type of watershed is placed on a different layer, based on watershed types:
- **Boundary Point**: The layer for any watershed subarea that is categorized as a boundary point watershed. This region drains to a specific point on the boundary of the surface.
- **Boundary Segment**: The layer for any watershed subarea categorized as a boundary segment watershed. This region drains to an edge of the surface boundary along two or more consecutive points.
- **Depression**: The layer for any watershed subarea categorized as a depression area watershed. This region does not drain off the surface.
- **Flat Area**: The layer for any watershed subarea categorized as a flat area watershed.
- **Multi Drain**: The layer for any watershed subarea categorized as a multi-drain watershed. This region drains to two or more different regions.
- **Multi-Drain Notch**: The layer for any watershed subarea categorized as a multi-drain notch watershed. This region drains to two or more different regions from a flat notch in the surface.

TIP Use the LAYER command to make these layers different colors so you can easily determine what type of watershed boundary is represented.

8 Click OK.

The following prompt is displayed:

You can specify a watershed by clicking on a POINT in it or by typing its NUMBER Point/Number <Point>:

9 Do one of the following to specify a watershed:
- Press ENTER and then click on a point on the surface to draw the watershed.
- Type Number and then type the number of the watershed you want to import.

10 Continue to specify watersheds by clicking on points or by typing numbers, and then press ENTER to end the command.
Watershed Types

When you use the Import Watershed Boundaries command, polylines (or solid fill areas) are drawn around the watersheds. The watershed types, and the layers they are placed on, are based on what type of drain target the watershed has.

A drain target is the location where water flow stops. Water that flows along a channel or across a surface triangle eventually either flows off the surface or it reaches a point from which there is no downhill direction.

For each drain target of a surface, the Calculate Watershed command determines the region of the surface that drains to that target. This region is called the watershed for that drain target.

Each watershed subarea that you delineate is categorized as one of the following types, based on drain target. For each type of subarea, AutoCAD Land Development Desktop reports information about the subarea in the Terrain Model Explorer.

**Boundary Point**

If the downhill end of a channel edge is on the surface boundary, then water flowing through that channel continues off the surface. The boundary point is the lowest end of the channel. In the following illustration, point p5 is a boundary point, the drain target of the channel p7-p6-p5.

If a watershed has this type of drain target, then it is called a boundary point watershed.
**Boundary Segment**

If an edge on the surface boundary belongs to a triangle that slopes down toward that edge, then water flows off the surface all along that edge. A boundary segment is a connected sequence of such edges.

In the following illustration, the edges p1-p2, p2-p3, and p3-p4 form a boundary segment. If a watershed has this type of drain target, then it is called a boundary segment watershed.

![Boundary segment watershed](image)

**Depression**

If a point is at a lower elevation than all its neighboring TIN points, then when water flows to it, it has no downhill place to go. Similarly, a connected set of points that are at the same elevation and all of whose neighbors are at higher elevation, is a single drain target. A depression is any such set of points.
In the following illustration, points p8 and p9 form a depression. If a watershed has this type of drain target, then it is called a depression watershed.

**Ambiguous Depression Watershed**

A depression watershed can be ambiguous. This occurs when the depression watershed depth is less than the threshold given to the Calculate Watershed command, but there are multiple neighboring watersheds at points of minimum elevation on the boundary.

When such a watershed fills to overflowing, water flows to all those neighboring watersheds, so the Calculate Watershed command cannot merge it into any single one. Instead, the Calculate Watershed command keeps it as a separate watershed and lists the neighboring watersheds into which it will drain. In this case, it won’t draw a boundary for this region.

**Shallow Depressions**

If a point is at a lower elevation than all its neighboring TIN points, then water that flows to it has no downhill place to go. Similarly, a connected set of points that are at the same elevation, and all of whose neighbors are at higher elevation, is a single drain target. A depression is any such set of points.

The minimum depression depth is the difference between the points around a depression and the depression itself. The smaller this difference, the more quickly the depression fills and begins draining into neighboring watersheds.

If the depth of a depression watershed (defined as the difference in elevation between the lowest point on the boundary and the depression point) is less than this value, and if there is only one neighboring watershed at the point(s) of minimum elevation on the boundary, then the Calculate Watershed command considers the triangles draining to the depression point to be part of the neighboring watershed.
Flat Area Watershed

A Flat Area Watershed is a watershed that has flat areas within it. There are three different types of flat area watersheds.

If for every edge on the boundary of a flat area, the opposing, non-flat triangle slopes up from the edge, then the flat area is the bottom of a depression watershed as shown in the following illustration:

![Flat area at bottom of depression watershed](image)

If some of the opposing, non-flat triangles slope down from the flat area boundary but all these flow to the same drain target, then the flat area is part of the watershed for that drain target, as shown in the following illustration for drain target A:

![Flat area drains to target A](image)
In the following illustration, the flat area, plus whatever part of the surface flows
down to it, becomes a flat area watershed. This watershed is ambiguous because
water flowing through it can flow to more than one drain target.

Flat area drains to targets A and B

**Multi-Drain Watershed**

One type of ambiguous watershed is called a Multi-Drain or Split
Channel watershed.

In the following illustration, the channel edges e2 and e3 flow to different
drain targets:

Multi-drain or split-channel watershed

Then water flowing down edge e1 could eventually reach either of these drain
targets. In a case like this, the Calculate Watershed command determines the
region that flows to edge e1 and defines this region to be a split channel watershed.
The Calculate Watershed command also, in this situation, keeps track of the watersheds into which water from the multi-drain watershed might drain.

**Multi-Drain Notch Watershed**

A multi-drain notch watershed occurs where there is a notch in the surface, illustrated by the flat edge created between P1 and P2 in the following illustration. This type of watershed is called a “multi-drain” notch because water flowing into the notch could drain to drain target A or drain target B.
30

Editing Surfaces

With the Edit Surface commands, you can edit the surface after it is created. You have the option of importing the current Triangulated Irregular Network (TIN) surface into a drawing as 3D lines. You can also add and delete lines or points, change the elevations of surface points, minimize flat faces on a surface, and define or remove surface boundaries.

Using the Surface Border commands, you can create 2D or 3D line and 2D or 3D polyline surface borders.
Chapter 30  Editing Surfaces

Editing Surfaces

After building a surface, you should review it for accuracy. If the triangulation is incorrect, then you can add or delete Triangular Irregular Network (TIN) lines or flip triangle faces so the TIN lines follow ridges or depressions. You can add, delete, or edit points; add non-destructive breaklines; and change the elevation of the entire surface.

To control triangulation, you can define surface boundaries and minimize the number of flat faces that are triangulated from contour data. If you have two or more surfaces that you want to join together, then you can paste one into the other.

All surface edits that you make to a surface are stored in the surface’s Edit History folder in the Terrain Model Explorer. Whenever you need to rebuild a surface after you edit it, you can apply the Edit History to the new surface so you don’t have to repeat the surface edits.

Surface editing commands work with the current surface. For more information, see “Making a Surface Current” in Chapter 28, “Managing Surfaces.” You should set the current surface before selecting an editing command. To perform any of the line, face, or point edit commands on a surface you must import the surface as 3D lines.

After you edit a surface, you must save it to update the surface data file. For more information, see “Saving a Surface” in Chapter 28, “Managing Surfaces.” If you exit the drawing without saving a modified surface, then you are prompted to save the surface.

Importing the Surface as 3D Lines

To edit a surface TIN, you must import the surface as 3D lines into the drawing.

To import the surface as 3D lines

1. From the Terrain menu, choose Edit Surface ➤ Import 3D Lines.
2. The following prompt is displayed:
   
   **Erase old surface view (Yes/No) <Yes>:**

3. Type Yes or No:
   - Type Yes to erase the old surface view.
   - Type No to keep previous surface lines in the drawing.

The Edit History of Surfaces

When you use any surface editing command on a surface, the history of those commands is stored in the Edit History folder for the surface. You can delete items from the Edit History and you can reapply the edits to a surface when you rebuild the surface.
Deleting Edits from a Surface’s Edit History

You can delete an edit from the Edit History by selecting the name of the edit and pressing the DELETE key. When you delete an edit from the Edit History, it does not get reapplied to the surface the next time you build the surface.

**NOTE**

When you build a surface, the Apply Edit History check box on the Build dialog box must be selected in order to reapply the Edit History to the surface.

**To delete edits from a surface’s edit history**

1. From the Terrain menu, choose Terrain Model Explorer.
2. Open the surface’s Edit History folder.
   - If you have made edits to a surface by using the Terrain ➤ Edit Surface commands, then the Edit History folder contains a list of these edits.
3. Select an edit to delete.
4. Press the DELETE key on your keyboard.
   - The next time you build the surface and select the option to Apply Edit History, the edit that you deleted is not applied to the surface.

Adding TIN Lines to a Surface

You can add new lines to an existing surface by selecting the endpoints of the new line. By adding a new TIN line, you can modify the way the surface is triangulated. The endpoints of the new line must be located at the endpoints of other surface lines. The new line passes through one or more existing surface lines. This forces the surface to re-triangulate in this area.

**To add TIN lines to a surface**

1. Import the surface as 3D lines. For more information, see “Importing the Surface as 3D Lines” in this chapter.
2. From the Terrain menu, choose Edit Surface ➤ Add Line.
3. Select the first point of the new line. This must be an existing point in the surface TIN.
4. Select the second point of the new line.
5. Press ENTER to end the command.

**NOTE**

Use the Save command to update the surface data file with any edits you make.
Deleting TIN Lines from a Surface

You can delete TIN lines from a surface. For example, if the model has lines on the perimeter that are long and narrow, then they might not be accurate for the surface and you should delete them. You can also delete surface lines within a pond or building foundation to create a void area, for example. By removing these lines, you can prevent contours from being drawn through the pond area.

To delete TIN lines from a surface
1 Import the surface as 3D lines. For more information, see “Importing the Surface as 3D Lines” in this chapter.
2 From the Terrain menu, choose Edit Surface ➤ Delete Line.
3 Select the line to delete.
4 Press ENTER to end the command.

This command automatically removes lines from the model and changes the surface.

Flipping TIN Faces on a Surface

You can change the direction of two triangle faces in the surface model so that the triangle edges match ridges or swales.

To flip faces
1 Import the surface as 3D lines. For more information, see “Importing the Surface as 3D Lines” in this chapter.
2 From the Terrain menu, choose Edit Surface ➤ Flip Face.
3 Select a triangle edge to flip.
4 Press ENTER to end the command.

The following illustration shows the effects of the Flip Face command:
Adding Points to a Surface

You can add points directly to the surface model with the Add Point command.

**WARNING!** These points are not added to the Surface Point Data file. However, the edits are saved to the surface’s Edit History folder.

To add a point to a surface

1. Import the surface as 3D lines. For more information, see “Importing the Surface as 3D Lines” in this chapter.
2. From the Terrain menu, choose Edit Surface ➤ Add Point.
3. Select the location of the point.

**NOTE** You can insert points outside the surface border.

4. Type an elevation for the new point, then press ENTER.
5. Press ENTER to end the command.

After you select the point, the surface triangulation is automatically updated.

Deleting Points from a Surface

You can delete a point from a surface to remove inaccurate or unnecessary data.

To delete a point from a surface

1. Import the surface as 3D lines. For more information, see “Importing the Surface as 3D Lines” in this chapter.
2. From the Terrain menu, choose Edit Surface ➤ Delete Point.
3. Select the point to delete. If you select a point from the screen, then the command automatically searches for an endpoint of a line.
4. Press ENTER to end the command.

After you select the point, the surface triangulation is automatically updated.

Changing the Elevations of Surface Points

You can change the elevations of single or multiple surface points. To change the elevations of multiple points, draw a polyline border around the points you want to edit.

To edit the elevations of single surface points

1. From the Terrain menu, choose Edit Surface ➤ Edit Point.
   The following prompt is displayed:
   
   Edit surface elevations {Single/Multiple} <Single>:
   
2. Press ENTER to accept Single as the default.
3. Select the point to edit.
The command automatically searches for an endpoint of a line.

4 Type the new elevation for the point.
5 Select another point to edit or press ENTER to end the command.

To edit the elevations of multiple surface points

1 From the Terrain menu, choose Edit Surface ➤ Edit Point.
   The following prompt is displayed:
   Edit surface elevations (Single/Multiple) <Single>:

2 Type *Multiple* to edit multiple surface elevations.
3 Select the polyline border that surrounds the points to edit.
   The following prompt is displayed:
   Change Elevations (Relative or Absolute) <Relative>:

4 Type one of the following to define how to change the elevations:
   - *Relative*, and then type a relative change in elevation. For example, you can use this option to add 2 ft. to all elevations within the polyline.
   - *Absolute*, and then type an absolute elevation. For example, you can use this option to make all the surface within the polyline into a flat pad at elevation 100 ft.

5 Press ENTER to end the command.

---

**Adding Non-Destructive Breaklines to a Surface**

You can create a non-destructive breakline from an open or closed polyline. When you define a polyline as a non-destructive breakline, the program creates surface points at each vertex of the polyline and at each intersection of a surface triangle and the polyline. The new points create additional surface triangles. Non-destructive breaklines are often needed when deleting surface regions where a clean TIN edge does not exist.

The program extracts the elevation of each new triangle from the original surface triangle, thus maintaining the integrity of the original surface.

**To add a non-destructive breakline**

1 Import the surface as 3D lines. For more information, see “Importing the Surface as 3D Lines” in this chapter.
2 Draw the polyline that you want to define as a non-destructive breakline.
3 From the Terrain menu, choose Edit Surface ➤ Nondestructive Breaklines.
   The following prompt is displayed:
   Select objects by (Entity/Layer) <Layer>: 
4 Type one of the following options:
   ■ Type Entity, and then use any standard selection method to select polyline(s).
   ■ Type Layer to select the objects by layer, and then select one polyline on the layer that has the polylines you want to select.
   ■ Type Layer, and then press ENTER and type the layer name.

The following prompt is displayed:
View/Review surface (Yes/No) <Yes>: 

5 Type Yes or No:
   ■ Type Yes to draw temporary lines that show the changes made to the surface triangulation. You can type REDRAW to remove these temporary lines from the screen.
   ■ Type No if you do not want to view the re-triangulation.

The following illustration shows the effects of non-destructive breaklines:

![Non-destructive breaklines](image-url)
Minimizing Flat Faces on a Surface That is Generated from Contours

The Minimize Flat Faces command on the Terrain menu checks each contour in the surface for any triangles that have either three points on the same contour, or three points at the same elevation. The command eliminates any face found that fits this criteria. This command eliminates as many suspect faces as possible, but some ambiguous cases may need manual intervention.

To minimize flat faces
1. From the Terrain menu, choose Edit Surface ➤ Minimize Flat Faces.
2. If a surface already exists in your drawing, a prompt sequence similar to the following is displayed:
   - Optimize contour data (Yes/No) <Yes>:
   - Optimize contour data (Iterative/Single) <Single>:
   - Minimum acceptable number of face changes: 1
   - Processing contour 52
   - Number of faces changed: 796
   - Processing contour 52
   - Number of faces changed: 12
   - Processing contour 52
   - Number of faces changed: 2
   - View/Review surface (Yes/No) <Yes>:

3. Type Yes to view the surface as temporary lines, or type No if you do not want to review the surface.
4. Press ENTER to exit the command.

Changing the Elevations of the Current Surface or Copying a Surface with a Relative Elevational Change

The Raise/Lower Surface command changes surface elevations by adding or subtracting an amount from the existing elevation. A positive value increases the elevation; a negative value lowers elevation.

To raise or lower surface elevations
1. From the Terrain menu, choose Edit Surface ➤ Raise/Lower Surface.
   - The following prompt is displayed:
     - Save modified surface as New surface (Yes/No) <Yes>:

2. Type Yes or No:
   - Type Yes to save the edits to a new surface.
   - Type No to apply the elevational changes to the existing surface.
When you type Yes in step 2, the New Surface dialog box is displayed:

3 In the New Surface box, type a name for the surface.
4 In the Description box, type an optional description for the surface.
5 Click OK.

The following prompt is displayed:

Add to each elevation:

6 Type the elevational value to add to, or subtract from, the surface:
   ■ Type a positive value to increase the elevations.
   ■ Type a negative value to decrease the elevations.

**Pasting Two Surfaces Together**

You can paste a surface into the current surface. For example, if you have a building pad model that you want to paste into a full site model, then you can set the full-site model current and then paste the building pad model into it. The building pad replaces that portion of the site model that it covers.

**NOTE** Surfaces with void regions (areas where TIN lines have been deleted, like building footprints) cannot be pasted.

**To paste two surfaces together**

1 Open the two surfaces you want to paste together. For more information, see “Opening an Existing Surface and Making it Current” in Chapter 28, “Managing Surfaces.”
2 Set the current surface (the surface that you want to paste another surface into). In the previous example, this would be the full site model. For more information, see “Making a Surface Current” in Chapter 28, “Managing Surfaces.”
3 From the Terrain menu, choose Edit Surface ➤ Paste Surface to display the Select Surface dialog box. This displays all open surfaces, other than the current surface.
4 Select the surface to paste into the current surface.
5 Click OK.

The surface you selected to paste is not modified and should be fully visible when the pasting is complete. The surface you pasted into is modified, and lines are edited to maintain the integrity of the surface you have pasted.
Editing a Surface to Define or Remove Surface Boundaries

By defining boundaries, you can control where surface triangulation occurs. You can define two different types of boundaries: outer and interior.

There can be only one outer boundary, which you define in the Terrain Model Explorer. The outer boundary defines the outer limits of the surface. An outer boundary is always a Show boundary, meaning that the TIN lines inside the boundary are visible, and the TIN lines outside the outer boundary are not visible. For example, the outer boundary prevents surface triangulation from occurring outside the bounds of the survey.

You can define multiple interior boundaries for a surface. Interior boundaries can be either Hide or Show boundaries. A Hide boundary hides the surface TIN inside the boundary. A Show boundary shows the surface TIN inside the boundary. For example, an inner boundary could prevent surface triangulation from occurring within an area, such as a building.

When you want to work with the entire surface again, you can remove the boundaries.

Before you define the boundary, you must draw a closed polyline that surrounds the area you want to show or hide. This polyline is used to define the boundary. To create a boundary at the limits of the surface, you can create a surface border using either the 2D or 3D polyline border commands, and then select it as a boundary. For more information, see “Creating Surface Borders” in this chapter.

You can define boundaries in one of two ways:

■ Before building the surface, you can create boundaries from within the Terrain Model Explorer.
■ After building the surface, you can edit the surface by creating (or deleting) boundaries. When you create (or delete) boundaries after building a surface, the surface is modified and the change is added to the Edit History of the surface.

NOTE

Hide boundaries mask the surface, but the surface is not deleted. The full surface remains intact. If there are surface TIN lines that you want to permanently remove from the surface, then use the Delete Line command. For more information, see “Deleting TIN Lines from a Surface” in this chapter.
Defining Surface Boundaries After Building a Surface

You can use boundaries to define the active area(s) of a surface. This lets you view only the surface area that is within the bounds of the survey, or hide surface areas, such as ponds. After you select the polyline, the Surface Boundaries command prompts for Show or Hide.

- **Show**: Displays any face inside the polygon.
- **Hide**: Masks any face inside the polygon.

**To add a boundary to a surface**

1. Draw the boundary as a closed polyline.
2. From the Terrain menu, choose Edit Surface ➤ Surface Boundaries.
3. Select the closed polyline.
   
   The following prompt is displayed:
   
   Remove All or Add? <Add>:

4. Type **Add** to add a new boundary to the surface definition.
   
   The following prompt is displayed:
   
   Remove all existing boundary definitions (Yes/No) <No>:

5. Type **Yes** or **No**:
   
   - **Type Yes** to remove all existing boundary definitions and display all the faces that were visible after the surface was built without a boundary.
   - **Type No** if you do not want to delete existing boundary definitions.

   The following prompt is displayed:
   
   Select polyline for boundary:

6. Select a closed polyline.
   
   The following prompt is displayed:
   
   Boundary definition (Show/Hide) <Show>:

7. Type **Show** or **Hide**:
   
   - **Type Show** to create the active surface area within the interior of the polyline, hiding the TIN lines that are outside the polyline.
   - **Type Hide** to create the active surface area outside the polyline, hiding the TIN lines inside the polyline.

   The following prompt is displayed:
   
   Make breaklines along edges: <Yes/No>:

8. Type **Yes** or **No**:
   
   - **Type Yes** to create non-destructive breaklines along the edges of the boundary. This clips the triangle edges exactly where they cross the boundary.
   - **Type No** if you do not want to make non-destructive breaklines along the boundary. This only affects those triangles that are completely within or outside of the boundary.
Removing Surface Boundaries After Building a Surface

When you want to work with the entire surface again, you can remove all surface boundaries. The Remove All option of the Surface Boundaries command removes all surface boundaries, including the outer boundary.

To remove all boundary definitions for a surface

1. From the Terrain menu, choose Edit Surface ➤ Surface Boundaries.

The following prompt is displayed:

Remove All or Add? <Add>:

2. Type Remove All to remove all existing boundary definitions.

The following prompt is displayed:

View/Review surface (Yes/No) <Yes>:

3. Type Yes or No:

- Type Yes to create temporary vectors that show the surface triangulation after the boundary is removed.
- Type No if you do not want to create temporary vectors.

Creating Surface Borders

The Surface Border commands on the Terrain menu insert a border around the existing surface. Each command creates the border as specified by their names, including: 2D Lines, 3D Lines, 2D Polyline, and 3D Polyline.

Borders are created by default on layer SRF-BDR. For more information about changing this setting, see “Changing the Surface Display Settings” in Chapter 31, “Displaying Surfaces.”
Creating a 2D Line Surface Border
You can create a border that consists of 2D lines around an existing surface.

To create a 2D line surface border
1 From the Terrain menu, choose Surface Border ➤ 2D Lines.
   The following prompt is displayed:
   Erase old BORDER/SKIRT view (Yes/No) <Yes>:
2 Type Yes or No:
   ■ Type Yes to save the previous border.
   ■ Type No to erase the previous border.

Creating a 3D Line Surface Border
You can create a border that consists of 3D lines around an existing surface.

To create a 3D line surface border
1 From the Terrain menu, choose Surface Border ➤ 3D Lines.
   The following prompt is displayed:
   Erase old BORDER/SKIRT view (Yes/No) <Yes>:
2 Type Yes or No:
   ■ Type Yes to save the previous border.
   ■ Type No to erase the previous border.

Creating a 2D Polyline Surface Border
You can create a border that consists of a 2D polyline.

To create a 2D polyline surface border
1 From the Terrain menu, choose Surface Border ➤ 2D Polyline.
   The following prompt is displayed:
   Erase old BORDER/SKIRT view (Yes/No) <Yes>:
2 Type Yes or No:
   ■ Type Yes to save the previous border.
   ■ Type No to erase the previous border.
Creating a 3D Polyline Surface Border

You can create a border that consists of a 3D polyline.

To create a 3D polyline surface border

1. From the Terrain menu, choose Surface Border ➤ 3D Polyline.
   The following prompt is displayed:
   
   *Erase old BORDER/SKIRT view (Yes/No) <Yes>:

2. Type Yes or No:
   - Type Yes to save the previous border.
   - Type No to erase the previous border.
Displaying Surfaces

The Surface Display submenu provides commands that display the surface in different ways. You can view the surface TIN lines as temporary vectors, as 3D faces, or as a polyface mesh. Using either the Average or the Banding method, you can create 2D solids, 3D faces, or polyfaces that show the elevations or slopes of a surface.

With the Surface Utilities commands, you can draw water drop paths on the current surface, or project lines.
Using the Surface Display Commands

So that you can better visualize the results of surface triangulation, AutoCAD Land Development Desktop provides several Surface Display commands you can use. For example, you can create 2D or 3D bands on a surface that show elevation ranges in different colors, making it easy to visually determine the surface's elevations.

You can access the Surface Display commands from the Terrain menu and also from the Terrain Model Explorer. From the Terrain Model Explorer, right-click on a surface folder and select a command from the Surface Display menu.

Changing the Surface Display Settings

By changing the Surface Display settings, you can control the layer on which surface faces, borders, and breaklines are created, whether or not skirts are created, and what the base elevation is. You can also define a vertical factor that exaggerates 3D faces and define a layer prefix.

To change the surface view settings

1. Do one of the following to display the Surface Display Settings dialog box:
   - From the Terrain menu, choose Surface Display ➤ Settings.
   - From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Surface Display and click the Edit Settings button.

2. In the Layer prefix box, type a surface layer prefix. This prefix applies to all the layers that may be created when using the Surface Display commands.

   **NOTE**
   Type an asterisk in this box to set the prefix for all of the layers to the current surface name. For example, if you have a surface called EG, objects created for this surface are placed on layers that start with EG. You can also type a value other than the surface name.
3 Type the surface layer name for the surface faces. By default this layer is SRF-VIEW.

**NOTE** The layer name should not exceed 255 characters. If the combined layer name exceeds 255 characters, the program truncates the prefix so that it fits 255 characters.

4 Type the layer name for the surface border. By default this layer is SRF-BDR.

5 Type the layer name for the breaklines. By default this layer is SRF-FLT.

6 Select the Create skirts check box to create vertical 3D faces from the border of the surface to the base elevation.

7 Type a base elevation. This must be a real number. The vertical base serves as a reference plane for the 3D skirts and the vertical factor. For 3D skirts, the base elevation is used to determine the elevation of the bottom of the 3D skirts. When the vertical factor is applied, the surface is scaled vertically from the base elevation.

8 Type a vertical factor. This must be a real number. You can exaggerate the relief of a site by applying a vertical scale factor other than 1.0. The program finds the elevations of the 3D faces by applying the vertical scale factor to the difference between the real elevation and the base elevation, then adds the result to the base elevation.

9 Click OK.

**Viewing the Surface TIN Lines as Temporary Vectors**

To view the surface TIN lines, you can create temporary vectors that are erased when you use the REDRAW command, or a command that causes a REDRAW or REGEN to occur.

**To view the surface TIN lines as temporary vectors**

1 Do one of the following:
   - From the Terrain menu, choose Surface Display ➤ Quick View.
   - Right-click on a surface folder in the Terrain Model Explorer and select Surface Display ➤ Quick View.

**Viewing the Surface TIN Lines as 3D Faces**

To view the surface TIN lines in 3D view, you can create 3D faces. If you select the Create skirts option in the Surface Display Settings dialog box, then skirts are also created.

**To view the surface as 3D faces**

1 Do one of the following:
   - From the Terrain menu, choose Surface Display ➤ 3D Faces.
   - Right-click on a surface folder in the Terrain Model Explorer and select Surface Display ➤ 3D Faces.
The Surface Display Settings dialog box is displayed. For more information on changing these settings, see “Changing the Surface Display Settings” in this chapter.

2 Click OK.

The following prompt is displayed if the Create Skirts option is selected in the Surface Display Settings:

Erase old BORDER/SKIRT view (Yes/No) <Yes>:

3 Type Yes or No:
   - Type Yes to erase any existing surface skirts.
   - Type No to keep any existing surface skirts.

The following prompt is displayed:

Erase old surface view (Yes/No) <Yes>:

4 Type Yes or No:
   - Type Yes to erase any existing 3D faces.
   - Type No to keep any existing 3D faces.

TIP Use the Object Viewer command on the Utilities menu to view the surface in 3D.

Viewing the Surface TIN Lines as a Polyface Mesh

You can create a polyface mesh that represents the surface TIN faces. A polyface is comprised of many 3D face objects but acts as one object when inserted into the drawing, so selecting one line highlights the entire mesh.

NOTE Skirts are not created for polyfaces.

To view the surface as a polyface

1 Do one of the following:
   - From the Terrain menu, choose Surface Display ➤ Polyface Mesh.
   - Right-click on a surface folder in the Terrain Model Explorer and select Surface Display ➤ Polyface Mesh.

The Surface Display Settings dialog box is displayed. For more information on changing these settings, see “Changing the Surface Display Settings” in this chapter.

2 Click OK.

The following prompt is displayed if the Create Skirts option is selected in the Surface Display Settings:

Erase old BORDER/SKIRT view (Yes/No) <Yes>: 
3 Type Yes or No:
   ■ Type Yes to erase any existing surface skirts.
   ■ Type No to keep any existing surface skirts.

The following prompt is displayed:
Erase old surface view (Yes/No) <Yes>:

4 Type Yes or No:
   ■ Type Yes to erase any existing polyface.
   ■ Type No to keep any existing polyfaces.

TIP Use the Object Viewer to view the surface in 3D.

Changing the Surface Display Based on Elevation Ranges

To quickly determine the elevation ranges of a surface, you can create different types of surface views.

■ You can create 2D or 3D average views that use a centroid-averaging calculation to determine which surface triangles belong in which elevation range. These options create sawtooth-looking ranges.
■ You can create 2D or 3D banding views that split surface triangles based on elevation ranges to create smooth bands.
■ You can create a polyface mesh that shows the surface elevation ranges in 2D mesh view. This method uses the centroid-averaging calculation to determine which surface triangles belong in which elevation range.

The 2D options create solid colors that show the elevation ranges. The 3D options and the polyface option create wire frames that you must shade or render to view the elevation ranges as solid colors.

As you view the results of these commands, you see bands or triangles drawn in different colors. This can be useful in identifying flood plains, mountain peaks, or low valleys.

TIP To see the full effect of the Surface Display commands, you must select a different color for each elevation range. You can do this when you define the elevation range settings or by controlling the layer color for each range that is created.

Changing the Surface Elevation Shading Settings

You can specify which elevation ranges you want displayed when you use one of the Average or Banding commands to create 2D solids, 3D faces, or polyfaces.
To change the surface elevation shading settings

1. Do one of the following to display the Surface Elevation Shading Settings dialog box:
   - From the Terrain menu, choose Surface Display ➤ Elevation Settings.
   - From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Surface Elevation Shading and click the Edit Settings button.

2. In the Layer prefix box, type a surface layer prefix. This prefix applies to all the layers that may be created when using the Surface Display commands.
   
   **NOTE.** Type an asterisk in this box to set the prefix for all the layers created to the current surface name. You can also type a value other than the surface name. The surface layer name should not exceed 255 characters. If the combined layer name exceeds 255 characters, the program truncates the prefix so that it fits 255 characters.

3. Select the Create skirts check box to create vertical 3D faces from the border of the surface to the base elevation.

4. Type a base elevation. This must be a real number. The vertical base serves as a reference plane for the 3D skirts and the vertical factor. For 3D skirts, the base elevation is used to determine the elevation of the bottom of the 3D skirts. When the vertical factor is applied, the surface is scaled vertically from the base elevation.

5. Type a vertical factor. This must be a real number. You can exaggerate the relief of a site by applying a vertical scale factor other than 1.0. The program finds the elevations of the 3D faces by applying the vertical scale factor to the difference between the real elevation and the base elevation, then adds the result to the base elevation.

6. Type the number of ranges, or use the slider bar to specify the number of elevation ranges to create. This option designates how many ranges the Auto-Range and User-Range options use.
7 Click one of the following to define the elevation ranges:
- **Auto-Range**: For more information, see the following section, “Defining the Auto-Range Elevation.”
- **User-Range**: For more information, see “Defining the User-Range Elevation” later in this chapter.

### Defining the Auto-Range Elevation

1 Complete steps 1–7 in the previous section, “Changing the Surface Elevation Shading Settings.”
2 Click Auto-Range to display the Terrain Range Views dialog box.

![Terrain Range Views dialog box](image)

3 In the Minimum box, type the minimum elevation you want to include in the range view. For example, if you want to create ranges that show the elevations between 100 and 200 feet, then type 100.

4 In the Maximum box, type the maximum elevation you want to include in the range view. For example, if you want to create ranges that show the elevations between 100 and 200 feet, then type 200.

5 Click OK.

The Surface Range Definitions dialog box is displayed. You can use this dialog box to control the beginning and ending elevations of the ranges, the range layers, and the range colors. The first column lists the range number. You can define up to 16 ranges each time you use this command.

![Surface Range Definitions dialog box](image)
6 In the Begin column, type the beginning value for the range. You can assign the beginning elevation for the respective range number. We suggest that the starting value of a range equal the ending value of the previous range.

7 In the End column, type the ending value for the range. You can assign the ending elevation for the respective range number. We suggest that the ending value of a range equal the starting value of the following range.

8 In the Layer column, type the layer name for the range.

9 In the Color column, select a color for the range. You can either type the number of the color, or choose the color from the Select Color dialog box by clicking the box to the right of the number. If you set the colors to 0, then the ranges are created using the colors that are defined for each layer.

10 Click Next if you are defining more than five ranges.

11 Click OK.

**Defining the User-Range Elevation**

1 Complete steps 1–7 in the previous section, “Changing the Surface Elevation Shading Settings.”

2 Click User-Range to display the Surface Range Definitions dialog box.

The Surface Range Definitions dialog box controls the beginning and ending elevations of the ranges, the range layers, and the range colors. The first column lists the range number. You can define up to 16 ranges each time you use this command.

In the Surface Range Definitions dialog box, the first column displays the range number. You can define up to 16 ranges each time you use this command.

3 In the Begin column, type the beginning value for the range. You can assign the beginning elevation for the respective range number. We suggest that the starting value of a range equal the ending value of the previous range.

4 In the End column, type the ending value for the range. You can assign the ending elevations for the respective range number. We suggest that the ending value of a range equal the starting value of the following range.
In the Layer column, type the layer name for the range.

In the Color column, select a color for the range. You can either type the number of the color, or choose the color from the Select Color dialog box by clicking the box to the right of the number. If you set the colors to 0, then the ranges are created using the colors that are defined for each layer.

Click Next if you are defining more than eight ranges.

Click OK.

**Creating 2D Solids Using the Average Method that Show the Elevations of a Surface**

You can generate 2D solids that show elevations, using the Average Method. The color and layer that are assigned are determined by the elevation range that the triangle falls in. The average elevation for each triangle is calculated and then drafted on the layer you define.

**To create 2D solids that show elevations using the Average Method**

1. From the Terrain menu, choose Surface Display ➤ Average – 2D Solids to display the Surface Elevation Shading Settings dialog box.

   For more information about changing these settings, see “Changing the Surface Elevation Shading Settings” in this chapter.

2. Click OK.

   The following prompt is displayed if the Create skirts option is selected in the Surface Elevation Shading Settings:

   Erase old BORDER/SKIRT view (Yes/No) <Yes>:

3. Type Yes or No:
   - Type Yes to erase any existing skirts.
   - Type No to keep any existing skirts.

   The following prompt is displayed:

   Erase old range view (Yes/No) <Yes>:

4. Type Yes or No:
   - Type Yes to clear the Range View layers of any existing objects.
   - Type No to keep any existing objects on the Range View layers.

   The program creates and plots 2D solids, and then displays the Range Statistics dialog box. You can review the data in this dialog box and either create a legend or output the information to a text file.

5. Click one of the following options:
   - **To File**: To output the data. The Output Settings dialog box is displayed. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
   - **Legend**: The Surface Legend dialog box is displayed. For more information, see the next section, “Creating Legends that Explain Surface Views.”

6. Click OK to return to the drawing.
Creating Legends that Explain Surface Views

The final option when creating an elevation or slope range map is to insert a legend that shows how the ranges were defined, such as which color each range uses. You can plot the legend on the drawing for future reference.

To create a legend that explains the surface view

1. Display the Surface Legend dialog box. This dialog box is displayed when you use the Average – 2D Solids command, for example.

2. Type a Legend Title.

3. Organize the data in columns 1 through 6 as you want to plot it:
   - **Color**: Places the range’s color in the selected column.
   - **Layer**: Places the range’s layer name in the selected column.
   - **Begin**: Places the range’s beginning elevation (or slope) in the selected column.
   - **End**: Places the range’s ending elevation (or slope) in the selected column.
   - **%**: Places the range’s percent of the total surface model in the selected column. The percentage is based on all the faces that are in the defined range. This might not be the entire site. For example, you might have a site that ranges from 100’ to 200’. When generating the range view, you might choose to include only the data between 150’ and 170’. In this case, the percentage value relates to all surface area that falls into the 150’ to 170’ range.
   - **Area**: Places the range’s actual area in the selected column.
   - **None**: Ends the legend at that column.

4. Click OK.

5. Select an insertion point for the legend.

   **NOTE** The insertion point of the legend is the midpoint of the legend’s title. Text in the legend is drawn on the current layer.
Changing the Surface Display Based on Elevation Ranges

The following illustration shows a completed legend:

<table>
<thead>
<tr>
<th>LEGEND TITLE</th>
<th>INSERTION POINT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>LEGEND</td>
</tr>
<tr>
<td>Color</td>
<td>Layer</td>
</tr>
<tr>
<td>TIN-RNG1</td>
<td>800.00</td>
</tr>
<tr>
<td>TIN-RNG2</td>
<td>811.00</td>
</tr>
<tr>
<td>TIN-RNG3</td>
<td>822.00</td>
</tr>
<tr>
<td>TIN-RNG4</td>
<td>833.00</td>
</tr>
<tr>
<td>TIN-RNG5</td>
<td>844.00</td>
</tr>
<tr>
<td>TIN-RNG6</td>
<td>856.00</td>
</tr>
<tr>
<td>TIN-RNG7</td>
<td>867.00</td>
</tr>
<tr>
<td>TIN-RNG8</td>
<td>878.00</td>
</tr>
</tbody>
</table>

Completed legend

Creating 3D Faces Using the Average Method that Show the Elevations of a Surface

You can generate 3D faces that show elevation ranges, using the Average Method. The color and layer that are assigned are determined by the elevation range that the triangle falls in. The average elevation for each triangle is calculated and then drafted on the layer you define.

To create 3D faces that show elevations using the Average Method

1. From the Terrain menu, choose Surface Display ➤ Average – 3D Faces.

   The Surface Elevation Shading Settings dialog box is displayed. For more information, see “Changing the Surface Elevation Shading Settings” in this chapter.

2. Click OK.

   The following prompt is displayed if the Create skirts option is selected in the Surface Elevation Shading Settings:

   Erase old BORDER/SKIRT view (Yes/No) <Yes>:

3. Type Yes or No:
   - Type Yes to erase any existing skirts.
   - Type No to keep any existing skirts.

   The following prompt is displayed:

   Erase old range view (Yes/No) <Yes>:

4. Type Yes or No:
   - Type Yes to clear the Range View layers of any existing objects.
   - Type No to keep any existing objects on the Range View layers.

   The program creates and plots 3D faces on the correct layers, and then displays the Range Statistics dialog box. You can review the data in this dialog box and either create a legend or output the information to a text file.
5  Click one of the following options:
   ■  To File: To output the data. The Output Settings dialog box is displayed. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
   ■  Legend: The Surface Legend dialog box is displayed. For more information, see “Creating Legends that Explain Surface Views” in this chapter.

6  Click OK to return to the drawing.

The following illustration shows an example of the Average Method. Shades of gray have been substituted for colors:

![3D faces]

**Creating a Polyface Using the Average Method that Shows Surface Elevations**

You can create a polyface mesh from the existing surface, using the Average Method. The complete surface becomes one polyface mesh object.

**To create a polyface mesh that shows elevations by using the Average Method**

1  From the Terrain menu, choose Surface Display ➤ Average – Polyface.
   The Surface Elevation Shading Settings dialog box is displayed. For more information, see “Changing the Surface Elevation Shading Settings” in this chapter.

2  Click OK.

   The following prompt is displayed if the Create skirts option is selected in the Surface Elevation Shading Settings:

   Erase old BORDER/SKIRT view (Yes/No) <Yes>:

3  Type Yes or No:
   ■  Type Yes to erase any existing skirts.
   ■  Type No to keep any existing skirts.
The following prompt is displayed:

Erase old range view (Yes/No) <Yes>:

4 Type Yes or No:
- Type Yes to clear the Range View layers of any existing objects.
- Type No to keep any existing objects on the Range View layers.

The program creates and plots a polyface mesh on the correct layer, and then displays the Range Statistics dialog box. You can review the data in this dialog box and you can create a legend or output the information to a text file.

5 Click one of the following options:
- To File: To output the data. The Output Settings dialog box is displayed. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
- Legend: The Surface Legend dialog box is displayed. For more information, see “Creating Legends that Explain Surface Views” in this chapter.

6 Click OK to return to the drawing.

Creating 2D Solids Using the Banding Method that Show the Elevations of a Surface

You can create 2D solids that show the elevations of a surface by using the Banding Method. When a triangle spans an elevation range, the triangle is split along the range border.

The color and layer assigned to each solid is based on the elevation range.

To create 2D solids that show elevations using the Banding Method

1 From the Terrain menu, choose Surface Display ➤ Banding – 2D Solids.
   The Surface Elevation Shading Settings dialog box is displayed. For more information, see “Changing the Surface Elevation Shading Settings” in this chapter.

2 Click OK.

   The following prompt is displayed if the Create skirts option is selected in the Surface Elevation Shading Settings:

   Erase old BORDER/SKIRT view (Yes/No) <Yes>:

3 Type Yes or No:
- Type Yes to erase any existing skirts.
- Type No to keep any existing skirts.

   The following prompt is displayed:

   Erase old range view (Yes/No) <Yes>:

4 Type Yes or No:
- Type Yes to clear the Range View layers of any existing objects.
- Type No to keep any existing objects on the Range View layers.
The program creates and plots 2D solids on the correct layers, and then displays the Range Statistics dialog box. You can review the data in this dialog box and either create a legend or output the information to a text file.

5 Click one of the following options:
- To File: To output the data. The Output Settings dialog box is displayed. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
- Legend: The Surface Legend dialog box is displayed. For more information, see “Creating Legends that Explain Surface Views” in this chapter.

6 Click OK to return to the drawing.

**Creating 3D Faces Using the Banding Method that Show the Elevations of a Surface**

You can create 3D faces that show the elevations of a surface by using the Banding Method. When a triangle spans an elevation range, the triangle is split along the range border.

The color and layer assigned to each 3D face is based on the elevation range.

**To create 3D faces that show elevations using the Banding Method**

1 From the Terrain menu, choose Surface Display ➤ Banding – 3D Faces.

   The Surface Elevation Shading Settings dialog box is displayed. For more information, see “Changing the Surface Elevation Shading Settings” earlier in this chapter.

2 Click OK.

   The following prompt is displayed if the Create skirts option is selected in the Surface Elevation Shading Settings:

   Erase old BORDER/SKIRT view (Yes/No) <Yes>:

3 Type **Yes** or **No**:

   - Type **Yes** to erase any existing skirts.
   - Type **No** to keep any existing skirts.

   The following prompt is displayed:

   Erase old range view (Yes/No) <Yes>:

4 Type **Yes** or **No**:

   - Type **Yes** to clear the Range View layers of any existing objects.
   - Type **No** to keep any existing objects on the Range View layers.

   The program creates and plots 3D faces on the correct layers, and then displays the Range Statistics dialog box. You can review the data in this dialog box and either create a legend or output the information to a text file.
5 Click one of the following options:

- **To File**: To output the data. The Output Settings dialog box is displayed. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”

- **Legend**: The Surface Legend dialog box is displayed. For more information, see “Creating Legends that Explain Surface Views” in this chapter.

6 Click OK to return to the drawing.

---

**Changing the Surface Display Based on Slope Settings**

To quickly determine the slope ranges of a surface, you can create 2D solids, 3D faces, or a polyface mesh. Each option creates color-coded triangles that represent the different slope ranges. The 2D solid option creates solid colors that show the slope ranges. The 3D face and polyface options create wireframes that you must shade or render to view the slope ranges as solid colors.

You can also create arrows that indicate the slope of each triangle if you need to visualize the slope descent.

**TIP** To see the full effect of the Surface Display commands, you must select a different color for each slope range. You can do this when you define the slope range settings. As you view the results of these commands, you see groups of slope triangles drawn in different colors. This can be useful in identifying flat land masses, steep mountain faces, or smooth flowing terrain.

---

**Changing the Surface Slope Shading Settings**

You can specify which slope ranges that you want displayed when you use one of the slope shading commands to create 2D solids, 3D faces, or polyfaces.

**To change the surface slope shading settings**

1 To display the Surface Slope Shading Settings dialog box use one of the following methods:

- From the Terrain menu, choose Surface Display ➤ Slope Settings.
From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Surface Slope Shading and click the Edit Settings button.

2 In the Layer Prefix box, type a surface layer prefix. This prefix applies to all the layers that may be created when using the Surface Display commands.

   **NOTE** Type an asterisk in this box to set the prefix for all the layers created to the current surface name. You can also type a value other than the surface name.

3 Select the Create skirts check box to create vertical 3D faces from the border of the surface to the base slope.

4 Type a base elevation. This must be a real number. The vertical base serves as a reference plane for the 3D skirts and the vertical factor. For 3D skirts, the base elevation is used to determine the elevation of the bottom of the 3D skirts. When the vertical factor is applied, the surface is scaled vertically from the base elevation.

5 Type a vertical factor. This must be a real number. You can exaggerate the relief of a site by applying a vertical scale factor other than 1.0. The program finds the elevations of the 3D faces by applying the vertical scale factor to the difference between the real elevation and the base elevation, then adds the result to the base elevation.

6 Type the number of ranges, or use the slider bar to specify the number of slope ranges to create. This option designates how many ranges the Auto-Range and User-Range options use.

7 Click one of the following to define the slope ranges:

   ■ **Auto-Range**. For more information, see “Defining the Auto-Range Slope” in this chapter.

   ■ **User-Range**. For more information, see “Defining the User-Range Slope” in this chapter.
Defining the Auto-Range Slope

To define the auto-range slope

1 Complete steps 1–7 in the previous section, “Changing the Surface Slope Shading Settings.”
   When you click Auto-Range, the Terrain Range Views dialog box is displayed:

   ![](image)

   2 Type the minimum and maximum slopes you want to include in the slope ranges.
   3 Click OK.
      The Surface Range Definitions dialog box is displayed. You can use this dialog box to control the beginning and ending slopes of the ranges, the range layers, and the range colors. The first column lists the range number. You can define up to 16 ranges each time you use this command.
   4 In the Begin column, type the beginning value for the range. You can assign the beginning slope for the respective range number. We suggest that the starting value of a range equal the ending value of the previous range.
   5 In the End column, type the ending value for the range. You can assign the ending slopes for the respective range number. We suggest that the ending value of a range equal the starting value of the following range.
   6 In the Layer column, type the layer name for the range.
   7 In the Color column, select a color for the range. You can either type the number of the color, or choose the color from the Select Color dialog box by clicking the box to the right of the number. If you set the colors to 0, then the ranges are created using the colors that are defined for each layer.
   8 Click Next if you are defining more than eight ranges.
   9 Click OK.

Defining the User-Range Slope

To define the user-range slope

1 Complete steps 1–7 in the previous section, “Changing the Surface Slope Shading Settings.”
   When you click User-Range, the Surface Range Definitions dialog box is displayed. You can use this dialog box to control the beginning and ending slopes of the ranges, the range layers, and the range colors. The first column lists the range number. You can define up to 16 ranges each time you use this command.
In the Begin column, type the beginning value for the range. You can assign the beginning slope for the respective range number. We suggest that the starting value of a range equal the ending value of the previous range.

In the End column, type the ending value for the range. You can assign the ending slopes for the respective range number. We suggest that the ending value of a range equal the starting value of the following range.

In the Layer column, type the layer name for the range.

In the Color column, select a color for the range. You can either type the number of the color, or choose the color from the Select Color dialog box by clicking the box to the right of the number. If you set the colors to 0, then the ranges are created using the colors that are defined for each layer.

Click Next if you are defining more than eight ranges.

Click OK.

Creating 2D Solids that Show the Slopes of a Surface

You can generate 2D solids that show the slopes of a surface. The color and layer assigned to each solid is determined by the slope range each surface triangle falls in.

To create 2D solids that show the slopes of a surface

From the Terrain menu, choose Surface Display ➤ 2D Solids.

The Surface Slope Shading Settings dialog box is displayed. For more information, see “Changing the Surface Slope Shading Settings” in this chapter.

Click OK.

The following prompt is displayed if the Create skirts option is selected in the Surface Slope Shading settings:

Erase old BORDER/SKIRT view (Yes/No) <Yes>: 

Type Yes or No:

■ Type Yes to erase any existing skirts.
■ Type No to keep any existing skirts.

The following prompt is displayed:

Erase old range view (Yes/No) <Yes>: 

Type Yes or No:

■ Type Yes to clear the Range View layers of any existing objects.
■ Type No to keep any existing objects on the Range View layers.

The program creates and plots 2D solids on the correct layers, and then displays the Range Statistics dialog box. You can review the data in this dialog box and either create a legend or output the information to a text file.
5 Click one of the following options:

- **To File**: To output the data. The Output Settings dialog box is displayed. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”

- **Legend**: The Surface Legend dialog box is displayed. For more information, see “Creating Legends that Explain Surface Views” in this chapter.

**NOTE** One field in the legend includes the percentage of the overall range views that a specific range covers. This is useful in determining the percentage of a site that is suitable for development.

6 Click OK to return to the drawing.

**Creating 3D Faces that Show the Slopes of a Surface**

You can generate 3D faces that show the slopes of a surface. The color and layer assigned to each 3D face is determined by the slope range each surface triangle falls in.

**To create 3D faces that show slopes of a surface**

1 From the Terrain menu, choose Surface Display ➤ 3D Faces.

   The Surface Slope Shading Settings dialog box is displayed. For more information, see “Changing the Surface Slope Shading Settings” in this chapter.

2 Click OK.

   The following prompt is displayed if the Create skirts option is selected in the Surface Slope Shading settings:

   `Erase old BORDER/SKIRT view (Yes/No) <Yes>:`

3 Type **Yes** or **No**:

   - **Type Yes** to erase any existing skirts.
   - **Type No** to keep any existing skirts.

   The following prompt is displayed:

   `Erase old range view (Yes/No) <Yes>:`

4 Type **Yes** or **No**:

   - **Type Yes** to clear the Range View layers of any existing objects.
   - **Type No** to keep any existing objects on the Range View layers.

   The program creates and plots 3D faces on the correct layers, and then displays the Range Statistics dialog box. You can review the data in this dialog box and either create a legend or output the information to a text file.
Click one of the following options:

- **To File:** To output the data. The Output Settings dialog box is displayed. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”

- **Legend:** The Surface Legend dialog box is displayed. For more information, see “Creating Legends that Explain Surface Views” in this chapter.

**NOTE**

One field in the legend includes the percentage of the overall range views that a specific range covers. This is useful in determining the percentage of a site that is suitable for development.

Click OK to return to the drawing.

**Creating a Polyface Mesh that Shows the Slopes of a Surface**

You can create a polyface mesh that shows the slopes of a surface. The color of each mesh triangle is determined by the slope range each triangle falls in.

**To create a polyface that shows the slopes of a surface**

1. From the Terrain menu, choose Surface Display ➤ Polyface.
   The Surface Slope Shading Settings dialog box is displayed. For more information, see “Changing the Surface Slope Shading Settings” in this chapter.
2. Click OK.
   The following prompt is displayed if the Create skirts option is selected in the Surface Slope Shading settings:
   
   Erase old BORDER/SKIRT view (Yes/No) <Yes>:

3. Type Yes or No:
   - Type Yes to erase any existing skirts.
   - Type No to keep any existing skirts.

   The following prompt is displayed:
   
   Erase old range view (Yes/No) <Yes>:

4. Type Yes or No:
   - Type Yes to clear the Range View layers of any existing objects.
   - Type No to keep any existing objects on the Range View layers.

   The program creates and plots a polyface mesh, and then displays the Range Statistics dialog box. You can review the data in this dialog box and either create a legend or output the information to a text file.
Changing the Surface Display Based on Slope Settings

5 Click one of the following options:

■ To File: To output the data. The Output Settings dialog box is displayed. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”

■ Legend: The Surface Legend dialog box is displayed. For more information, see “Creating Legends that Explain Surface Views” in this chapter.

**NOTE**
One field in the legend includes the percentage of the overall range views that a specific range covers. This is useful in determining the percentage of a site that is suitable for development.

6 Click OK to return to the drawing.

**Drawing Arrows on a Surface that Show Surface Slopes**

You can show the slope of a surface by inserting arrows that point down the slope of each surface triangle. These arrows point in the downhill direction.

**NOTE**
Arrows that converge denote channels; arrows that diverge denote ridges.

**To draw arrows that show surface slopes**

1 From the Terrain menu, choose Surface Display ➤ Slope Arrows.

The Surface Slope Shading Settings dialog box is displayed. For more information, see “Changing the Surface Slope Shading Settings” in this chapter.

2 Click OK.

The following prompt is displayed:

```
Erase old BORDER/SKIRT view (Yes/No) <Yes>:
```

3 Type Yes or No:

■ Type Yes to erase any existing skirts.
■ Type No to keep any existing skirts.

The following prompt is displayed:

```
Erase old range view (Yes/No) <Yes>:
```

4 Type Yes or No:

■ Type Yes to clear the Range View layers of any existing objects.
■ Type No to keep any existing objects on the Range View layers.

5 Type the scale factor for the arrow symbol.

The Range Statistics dialog box is displayed.

6 Click OK.

The program places arrows on each triangle, and bases the color of each arrow on the slope ranges. The block that is inserted is named DTMARROW. You can modify this block.
The following illustration shows arrows pointing down the slope of a surface:

Creating a Surface Grid of 3D Faces

You can create a 3D face grid of the current surface at a grid spacing that you specify.

To create a grid of 3D faces

1. From the Terrain menu, choose Surface Display ➤ Grid of 3D Faces.
2. Specify the grid rotation angle by either picking two points or by typing an angle.
3. Select the base point for the grid by either picking a location or by entering X and Y coordinates.
4. Type the grid M spacing (the grid cell spacing in the M direction). The M direction corresponds to the X direction of a Cartesian plane. If a rotation exists in the plane, then the X axis is called the M axis.
5. Type the grid N spacing (the grid cell spacing in the N direction). The N direction corresponds to the Y direction of a Cartesian plane. If a rotation exists in the plane, then the Y axis is called the N axis.
The following illustration shows the 3D grid parameters:

6 Select the upper-right limit of the grid. The snap is set to the size of the grid square for the selection of the upper-right corner.

One grid square and the extents of the grid are drawn so you can see the size of the grid.

The following prompt is displayed:
Change the size or rotation of the grid/grid squares (Yes/No) <No>: 

7 Type Yes or No:
■ Type Yes to repeat steps 2 through 6 and change the size of the grid.
■ Type No to display the Surface 3D Grid Generator dialog box, where you can change the settings. For more information, see “Changing the Surface 3D Grid Generator Settings” in this chapter.

8 After you finish changing the settings, click OK.

The following prompt is displayed:
Erase old Grid Layer (Yes/No) <Yes>: 

9 Type Yes or No:
■ Type Yes to clear the grid layer of any existing objects.
■ Type No to keep any existing objects on the grid layer.

The following prompt is displayed:
Erase old Skirt Layer (Yes/No) <Yes>: 

10 Type Yes or No:
■ Type Yes to clear the skirt layer of any existing objects.
■ Type No to keep any existing objects on the skirt layer.

To view the grid in 3D, change the User Coordinate System (UCS) of the drawing by using either the VPOINT command or the Object Viewer.
The following illustration shows a 3D view of the surface grid:

![3D view of a surface grid](image)

**Changing the Surface 3D Grid Generator Settings**

The Surface 3D Grid settings control how grids are created when you use the Grid of 3D Faces command on the Terrain ➤ Surface Display menu.
The following illustration shows some of the 3D grid parameters:

To change the surface 3D grid generator settings

1. Do one of the following to display the Surface 3D Grid Generator dialog box:
   - From the Terrain menu, choose Surface Display ➤ Surface 3D Grid.
   - Right-click on a surface folder in the Terrain Model Explorer and select Surface Display ➤ Surface 3D Grid.
   - From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. In the Settings list, select Surface 3D Grid. Click the Edit Settings button.

2. Select the Hold upper point check box if you want to pin the upper-right corner of the grid and adjust the cell size so that an even number of cells fit in each direction.
3 Select 3D skirts if you want to show vertical faces on a surface that was created using the object type of 3D faces. Turn this option off to suppress the creation of vertical faces around the exterior of the 3D grid. The following illustration shows skirts turned off and on:

![Skirts turned off and on](image)

4 In the Base elevation text box, the default is zero, but you can type a value to raise or lower the grid of polylines. This must be a real number.

5 In the Vertical factor text box, type a value to exaggerate the surface vertically when using 3D lines or 3D faces as the object type. The exaggerated elevations are determined by subtracting the base elevation (minimum elevation if the base elevation is zero) from the elevation of the point and then applying the vertical scale factor (multiplying).

6 Under M (x) Direction, do one of the following:
   - Select Size and type a value in the Value box. The number you type for Value is interpreted as the spacing in the M direction.
   - Select Number and type a value in the Value box. The number you type for Value is interpreted as the number of cells in the M direction.

The value in the Value box determines the cell size in decimal units in the M direction. This must be a real number. If the rotation angle on the grid is 0.0, M corresponds to the X direction. If the cell type is set to size, this number represents the spacing in the M direction. If the cell type is set to number, this number represents the number of cells in the M direction.

7 Under N (y) Direction, do one of the following:
   - Select Size and type a value in the Value box. The number you type for Value is interpreted as the spacing in the N direction.
   - Select Number and type a value in the Value box. The number you type for Value is interpreted as the number of cells in the N direction.

The value in the Value box determines the cell size in decimal units in the N direction. This must be a real number. If the rotation angle on the grid is 0.0, N corresponds to the Y direction. If the cell type is set to size, this number represents the spacing in the N direction. If the cell type is set to number, this number represents the number of cells in the N direction.

8 Under Number of facets per face, select either 1, 2, or 4 facets per 3D face.
The following illustration shows the different facet options:

![Facet options for surface grid]

9. In the Grid layer field, type the layer on which you want the 3D grid placed.
10. Click OK.

**Creating a Surface Grid of 3D Polylines**

You can create a 3D polyline grid of the current surface at a grid spacing that you specify.

**To construct a grid of 3D polylines**

1. From the Terrain menu, choose Surface Display ➤ Grid of 3D Polylines.
2. Specify the grid rotation angle by either picking two points or typing an angle.
3. Select the base point for the grid by either picking a location or entering X and Y coordinates.
4. Type the grid M spacing (the grid cell spacing in the M direction). The M direction corresponds to the X direction of a Cartesian plane. If a rotation exists in the plane, then the X axis is called the M axis.
5. Type the grid N spacing (the grid cell spacing in the N direction). The N direction corresponds to the Y direction of a Cartesian plane. If a rotation exists in the plane, then the Y axis is called the N axis.
6. Select the upper-right limit of the grid. The snap is set to the size of the grid square for the selection of the upper-right corner.

One grid square and the extents of the grid are drawn so you can see the size of the grid.

The following prompt is displayed:

`Change the size or rotation of the grid/grid squares (Yes/No) <No>:`
7 Type Yes or No:
- Type Yes to repeat steps 2 through 6 and change the size of the grid.
- Type No to display the Surface 3D Polyline Grid Settings dialog box, where you can change the settings. For more information, see “Changing the Surface 3D Polyline Grid Settings” in this chapter.

8 After you finish changing the settings, click OK.

The following prompt is displayed:
Erase old Grid Layer (Yes/No) <Yes>:

9 Type Yes or No:
- Type Yes to clear the grid layer of any existing objects.
- Type No to keep any existing objects on the grid layer.

The following prompt is displayed:
Erase old Skirt Layer (Yes/No) <Yes>:

10 Type Yes or No:
- Type Yes to clear the skirt layer of any existing objects.
- Type No to keep any existing objects on the skirt layer.

To view the grid in 3D, change the User Coordinate System (UCS) of the drawing by using either the VPOINT command or the Object Viewer.

For an illustration of a 3D grid, see “Creating a Surface Grid of 3D Faces” in this chapter.
Changing the Surface 3D Polyline Grid Settings

To change the surface 3D polyline grid settings:

1. From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box.

2. Under Program, select Land Development Desktop.

3. In the Settings list, select Surface 3D Polyline.

4. Click the Edit Settings button to display the Surface 3D Polyline Grid Settings dialog box.

5. Select the Hold upper point check box if you want to pin the upper-right corner of the grid and adjust the cell size, so an even number of cells fit in each direction.

6. Under M (x) Direction, select the Draw in M (x) direction check box to generate cross sections in the M direction.
If you select the Draw in M (x) direction check box, then select either the Size or Number option:

- If you select Size, the number you type in the Value box is interpreted as the spacing in the M direction.
- If you select Number, the number you type in the Value box is interpreted as the number of cells in the M direction.

Type a value in the Value box to determine the cell size in decimal units in the M direction. This must be a real number. If the rotation angle on the grid is 0.0, M corresponds to the X direction.

Under N (y) Direction, select the Draw in N (y) direction check box to generate cross sections in the N direction.

If you select the Draw in N (y) direction check box, then select either the Size or Number option:

- If you select Size, the number you type in the Value box is interpreted as the spacing in the N direction.
- If you select Number, the number you type in the Value box is interpreted as the number of cells in the N direction.

Type a value in the Value box to determine the cell size in decimal units in the N direction. This must be a real number. If the rotation angle on the grid is 0.0, N corresponds to the Y direction.

In the M (x) direction layer text box, type the layer you want the polyline drawn in the M direction.

In the N (x) direction layer text box, type the layer you want the polyline drawn in the N direction.

In the Base elevation text box, the default is zero, but you can type a value to raise or lower the grid of polylines. This must be a real number.

In the Vertical factor text box, type a value to exaggerate the surface vertically when using 3D lines or 3D faces as the object type. The exaggerated elevations are determined by subtracting the base elevation (minimum elevation if the base elevation is zero) from the elevation of the point and then applying the vertical scale factor (multiplying).

Click OK.

For an illustration of 3D grid parameters, such as M and N, see “Creating a Surface Grid of 3D Faces” in this chapter.
Using Surface Utilities

You can use the Surface Utilities commands to visualize waterdrop paths, to project objects onto a 3D grid, and to view the surface along a polyline path or from a specified point. You can also label elevations of selected surface points.

Drawing Water Drop Paths on the Current Surface

You can trace the path that water would take across a surface by using the Water Drop command. This command draws a polyline that represents the water as it flows downhill. If the channel splits, then new polylines are drawn to follow each water drop path.

To draw a water drop path

1 Build the watershed model of the surface. For more information, see “Creating Watershed Models When Building a Surface” in Chapter 29, “Creating Watershed Models.”

   NOTE This step is not required but it can make the waterdrop trails more accurate.

2 From the Terrain menu, choose Surface Utilities ➤ Water Drop to display the Water Drop dialog box.

   ![Water Drop dialog box]

   NOTE If the current surface is not selected, then the Select Surface dialog box is displayed. Select the surface and click OK.

3 In the Water drop layer box, type the name of the layer for the water drop path, and then click OK to continue.

4 Determine how you want to handle water drop paths by typing Yes or No:
   
   ■ Type Yes to erase old water drop paths.
   ■ Type No to preserve existing water drop paths.

5 Determine how you want to handle tick marks by typing Yes or No:
   
   ■ Type Yes to place tick marks at the beginning of each path.
   ■ Type No to draw the polyline without tick marks.

6 Pick a point on a surface that represents the origin of the water drop path. This is the point where the water drop strikes the surface.

   The Water Drop command draws the path the water would take across the surface.

7 Pick the next water drop point, or press ENTER to end the command.
Projecting Lines, Curves, or Polylines onto a 3D Grid Surface

You can drape lines, curves, or polylines onto an existing 3D grid surface. This command creates 3D line segments from the objects that you select, and places them in the defined projection layer on the surface.

To project objects onto a 3D grid

1. Construct a grid of 3D faces. For more information, see “Creating a Surface Grid of 3D Faces” in this chapter.
2. From the Terrain menu, choose Surface Utilities ➤ Object Projection.
3. Select the objects to project.

The Object Projection dialog box is displayed.

4. Type the Projection Layer name. This layer contains the new 3D objects.
5. Click OK.

The following prompt is displayed:

Erase old projection layer (Yes/No) <Yes>: 

6. Type Yes or No:
   - Type Yes to delete all objects on the projection layer.
   - Type No to preserve all objects on the projection layer.

**TIP** Change the color of the projection layer to a color other than the grid of 3D faces so you can see the projected objects.
Labeling the Elevation of a Surface Point

You can label different locations in a drawing with finished ground labels.

NOTE These labels are drawn on the FGLBL layer.

To label the elevation of a surface point

1. From the Terrain menu, select Surface Utilities ➤ Label Spot Elevation.

The following prompt is displayed:

Point (or Surface):
2 Do one of the following:
   ■ Select a point in your drawing.
   ■ Type Surface to display the Select Surface to Label dialog box. Select the surface and click OK. Then select the location you want to label. Surface statistics such as minimum and maximum elevations, and the amount of surface points that make up the surface, are displayed in the Statistics area of the dialog box. The surface status—whether or not the surface is locked by another user—is also displayed.

3 Type the finished ground elevation.

   **NOTE** If you chose a surface in step 2, then the elevation of the surface at the chosen location displays as a default.

4 Select a point for the end of the leader that points to the spot elevation label.

5 Select additional leader points, if needed, and then press ENTER.

   The following prompt is displayed:
   
   Label rotation <0d0’0”>:

6 Type the label rotation angle.

### Viewing the Surface from a Specified Point

You can establish a line of sight between a fixed position and a target and then place the drawing in a selected dynamic view or view point. The elevations of the current surface are used, and the current base elevation and vertical exaggeration are applied.

You will be prompted for an initial position (camera point), a height at that position, a target, and a height at that target. The heights you enter are relative to the current surface.

**To view the surface from a specified point**

1 From the Terrain menu, choose Surface Utilities ➤ Line of Sight.
2 Select a point on the surface for the camera.
3 Type the height of the camera. This is the height of the camera above the surface in real units.

   **NOTE** The Line of Sight command uses the current vertical exaggeration after you enter the camera and target heights.

4 Select a target point.
5 Type the height of the target. This is the height of the target above the surface in real units.
The Surface Line of Sight dialog box is displayed.

This dialog box shows the Line of Site Statistics. Here you can view information about the selected camera, target, and surface. The camera and target's X and Y coordinates, and elevation are reported as well as the distance between the two.

- The critical point defines the closest surface point to the line of sight between the camera and target. The critical point indicates whether there is an obstruction between the camera point and the target point.
- The distance is the distance to the obstruction (or to the target if there is no obstruction).
- The clearance is the vertical clearance or distance above the point or the depth of the obstruction. If the clearance is a negative number, then the camera cannot see the target as it is set up.

You can adjust the position and height of the camera and target by doing the following:

- If you want to adjust the position and height of the camera, then click the Camera button, and then select a new position for the camera and define a new camera height. After you make changes, the dialog box displays the new information calculated.
- If you want to adjust the position and height of the target, then click the Target button, and then select a new position for the target and define a new target height. After you make changes, the dialog box displays the new information calculated.

Select one of the following options to see the model in 3D space:

- **Vpoint**: changes the view to the viewpoint shown in the Horizon Statistics dialog box. This activates the VPOINT command.
- **Dview**: changes the view as selected by the camera and target by using the DVIEW command.

**NOTE** If you use the Vpoint or Dview options, you can return your drawing view to plan view by typing PLAN, and then typing current.
The following illustration shows the line of sight parameters:

![Line of Sight Parameters](image)

**Viewing the Surface Along a Polyline Path**

You can view the surface along a polyline path by using the Fly By command. A polyline must exist in the drawing to use this command. This polyline defines the viewing path.

To view the surface along a polyline path

1. From the Terrain menu, choose Surface Utilities ➤ Fly By.
2. Select the polyline that you want to view the surface along.

The Surface Fly By dialog box is displayed.
3 Select one of the following Fly by types:

- Select Follow path to place the camera and target at each successive vertex on the polyline path, creating a slide for each position. The following illustration shows a follow path fly by:

- Select Fixed target to move the camera along the polyline path while keeping the target at a selected point. The following illustration shows a fixed target fly by:

- Select Fixed camera to move the target along the polyline path while maintaining the camera at a fixed location. The following illustration shows a fixed camera fly by:
Select one of the following Viewpoint Types:
- Select Vpoint if you want the Fly By command to use the AutoCAD VPOINT command when creating the slides or named views.
- Select Dview if you want the Fly By command to use the AutoCAD DVIEW command when creating the slides or named views.

Select one of the following View Types:
- Select Shade if you want the Fly By command to shade the surface model when creating the slides or views, using the AutoCAD SHADE command.
- Select Hide if you want the Fly By command to hide the surface model lines when creating the slides or views, using the AutoCAD HIDE command.
- Select None if you want the Fly By command to capture the slides or views of the surface model as it currently exists.

Type a Camera height. This height is above the surface elevation at the selected camera point and is vertically exaggerated after the height is selected.

Type a Target height. This height is above the surface elevation at the selected target point and is vertically exaggerated after the height is selected.

Type the Output prefix for the slides. When the slides are created, they are named using the output prefix and numbered sequentially.

Select one of the following Output Types:
- Select Slide to create a slide for every stop along the polyline. You can view the slides using the AutoCAD VSLIDE command.
- Select View to create an AutoCAD view for every stop along the polyline, which can be displayed to the screen using the Restore option of the AutoCAD VIEW command.

Click OK to proceed.
- If you selected Follow path as the Fly by type, then the slides or views are created.
- If you selected Fixed target as the Fly by type, then choose the target point.
- If you selected Fixed camera as the Fly by type, then choose the camera point.

The command creates slides or named views, depending on the Output type you selected. You can restore the named views by using the Restore option of the AutoCAD VIEW command. You can view the slides using the AutoCAD VSLIDE command.
Creating and Managing Contours

The Contour commands create, edit, and label contours. Using these commands, you can create contours from a surface, digitize contours, assign elevations to contours, and weed contours to remove and add points.
Creating and Managing Contours

You can use contours during different phases of the design process:

- Contours can be used as data for building surfaces.
- Contours can be generated from a surface.

Contours can consist of polylines or contour objects. To create contours to use as surface data, you can convert polylines to contours, digitize contours, and assign elevations to existing polylines. You can also copy and offset existing contours.

To create contours from a surface, you can define contour styles and generate major and minor contours that mark the elevational changes of the surface at specified intervals. Contour and contour label appearance is controlled by Contour Styles. Styles control smoothing, label display, label position, and other options.

Advantages of Using the Contour Object

AutoCAD Land Development Desktop creates contours that are AutoCAD objects rather than polylines. This has several advantages:

- Smaller drawing size. The contour object definition is much more compact than the polyline representation of a contour.
- Improved speed for contour creation, redraw, and regeneration.
- Context-sensitive shortcut menu that you can open by clicking the right mouse button.
- Better listing capabilities. You see only the information that is relevant to each AEC contour, such as elevation and layer, not a listing for every contour vertex.
- Dynamic labeling capabilities. You can edit the contour and the label is automatically updated.
- Better display control. When adjusting the view orientation of the drawing using DVIEW twist, the contour label still appears to be upright as opposed to being upside down.
- More intuitive editing. If you delete a label, the gap in the contour is eliminated.

To create contour objects from existing polylines in your drawing, use the Convert Polylines command. For more information, see "Converting Polylines to Contours" in this chapter.

To share your drawing with someone who is not using AutoCAD Land Development Desktop, you can use the EXPLODE command to convert the AEC contours to lightweight polylines.
Using the Contour Style Manager

You can use the Contour Style Manager to change contour style settings and to create, edit, and manage contour styles and to change contour properties.

When you select the Contour Style Manager command from the Terrain menu, you can set up styles based on the contour settings. Contour Styles control how contours and contour labels appear on screen. For example, you can use the Contour Style Manager to apply smoothing to contours and to turn off the display of contour labels.

You can also access the Contour Style Manager by selecting a contour, right-clicking to display the shortcut menu, and then selecting Contour Properties. When you access the Contour Style Manager using this method, the changes you make are applied directly to the contour(s) you selected. For example, you can use the Contour Properties command to turn off or show contour labels and grips on existing contours, or to smooth existing contours.

NOTE A contour’s color and linetype are controlled by the layer on which the contour is drawn.

Changing the Contour Appearance Settings

To change the contour appearance settings

1. Do one of the following to display the Contour Style Manager dialog box:
   - From the Terrain menu, choose Contour Style Manager.
   - Select a contour, right-click and select Contour Properties.
   - From the Projects menu, choose Data Files to display the Edit Data Files dialog box. Under Program, select Land Development Desktop. From the Data Files list, select Contour Style Manager, and click the Edit Settings button.

2. Click the Contour Appearance tab.
The name of the current contour style is listed at the top of the property sheet.

**TIP**
To create a new style, click the Manage Styles tab and type a name for the new style in the Contour Styles in Drawing box, and then click Add.

3 Under Contour Display, select one of the following options:
- **Contours and Grips**: To display contours with a grip at each vertex that you can use to edit the contours.
- **Contours Only**: To display contours without a grip at each vertex.

**NOTE**
It is easier to edit contour labels if contour grips are turned off. Also, in complex drawings, selecting Contours Only improves selection speed.

4 In the Line Width box, type the line width to use for the contours. You may want to make the line width greater than 0 if you intend to plot the contours. This makes all contours use the defined width. To control minor and major contours, you can control the plotted contours by defining specific layer colors and correlating the plotting pen width.

**NOTE**
This option affects only non-smoothed contours and contours smoothed with Add Vertices smoothing. It does not affect spline-smoothed contours.

5 Under Label Display, select one of the following options:
- **Labels and Grips**: To create labels with grips that you can use to edit the labels. By using the grips, you can slide the labels to different locations along the contour.
- **Labels Only**: To create labels without grips.
- **Labels Off**: To suppress the display of labels for the contour style.

**NOTE**
If you create contours using a contour style that uses the Labels Off option, then you cannot see any contour labels if you label the contours. You can edit the style to turn labels on.

6 Under Smoothing Options, select one of the following options:
- **No Smoothing**: If you do not want to smooth the contours.
- **Add Vertices**: To add vertices along the contours. This option supplements points on the contours when smoothing them to give them a more noticeably curved appearance, while still maintaining the highest level of integrity relative to the surface.
- **Spline Curve**: To pass a spline curve through the contour points. This gives the smoothest contour representation.

7 If you selected Add Vertices, then use the slider to increase the smoothing (or decrease existing smoothing).

**NOTE**
You cannot adjust the level of smoothing when you select the Spline Curve option.

8 Click OK.
The following illustration features smoothed contours:

![Smoothed contours](image)

**Changing the Contour Text Style Settings**

To change the contour text style settings

1. From the Terrain menu, choose Contour Style Manager.
2. Click the Text Style tab.

3. From the Style list, select a text style to use for contour labels.

   **TIP** You can choose Current to always create labels using the current text style.

4. Click the Color box to display the Select Color dialog box.
5. Select a color for the labels.

   **NOTE** Contours are drawn on a user-defined layer. You can control the contour color and linetype by using the AutoCAD layer functions. The contour label is part of the contour and therefore is on the same layer. The label color option allows you to independently control the color of the labels for display and plotting purposes.
6 Click OK to return to the Text Style property sheet.
7 From the Prefix list, you can select a label prefix. Defaults include EL and ELEV=.
   You can also type a different prefix in the Prefix box.
8 From the Suffix box, you can select a label suffix. Defaults include ', FT, ft, and m.
9 If you select a zero-height text style, then type a text height in the Height box.
10 In the Precision box, select a precision for the contour labels.
11 Click OK.

**NOTE** Remember that these changes affect all contours that are drawn with the same contour style.

**Changing the Contour Label Position Settings**

Using the Contour Style Manager dialog box, you can change the contour label position settings. The Label Position tab in the Contour Style Manager includes entries for the orientation, readability, and border of the contour labels in the drawing.

To change the contour label settings

1 From the Terrain menu, choose Contour Style Manager.

2 Click the Label Position tab.
3 Under Orientation, select one of the following label positions:
   - **Above Contour**: Calculates the actual offset by multiplying the label's text height by the offset value. You can specify the offset of the label by typing a value in the Offset box.
   - **Below Contour**: Calculates the actual offset by multiplying the label’s text height by the offset value. You can specify the offset of the label by typing a value in the Offset box.
   - **On Contour**: Breaks the contour lines where the label is located. You may want to select the Break Contour For Label check box. The contour is still one object if you select this option.
4 Under Readability, select one of the following options:
- **Make Plan Readable**: To orient the label text so that it is legible in plan view.
- **Label Positive Slope**: To orient the label text so that the top of the text is always positioned in the uphill direction. By using this option, the label text indicates the slope of the surface.

5 Under Border Around Label, select one of the following options:
- **Rectangular**: To insert a rectangular border around contour labels.
- **Round Corners**: To insert rectangles with rounded corners around contour labels.
- **None**: To insert no label borders.

6 Click OK.

The following illustration features the different contour label borders:

![Contour label borders](image)

**Managing Contour Styles**

You can use the Contour Style Management options to create new contour styles, delete contour styles, and to save styles to the Contour Style folder so that the styles can be used in other drawings and projects. Because settings are adjusted and saved only in the current drawing, you must save the contour styles to the External Contour Style folder in order to use them in other drawings. To use contour styles in the Contour Style folder, you must load them into your drawing.

**NOTE** After you create the contour style files using Release 2 of AutoCAD Land Development Desktop, the contour style files may not be used with any prior version of AutoCAD Land Development Desktop.
Creating a New Contour Style

To create a new contour style

1. From the Terrain menu, choose Contour Style Manager.

2. Use the tabs on the dialog box to set up the style you want to save.

3. Click the Manage Styles tab.

4. In the Contour Styles in Drawing box, type the name of the style you want to save. This name cannot have any spaces in it.

5. Click Add.

6. Click OK.

Selecting the Current Contour Style

When you use the Contour Style Manager to edit contour styles, be aware that the edits you make are to the current contour style only. The current contour style is displayed at the top of the Contour Appearance, Text Style, and Label Position tab in the Contour Style Manager.

When you edit a contour style, the contours in the drawing that were created with that contour style are updated automatically. No other contours are affected.

To select the current contour style

1. From the Terrain menu, choose Contour Style Manager to display the Contour Style Manager dialog box.

2. Click the Manage Styles tab.

3. From the Contour Styles in Drawing list, select the style you want to make current.
Deleting a Contour Style from the Current Drawing

To delete a contour style
1. From the Terrain menu, choose Contour Style Manager.
2. Click the Manage Styles tab.
3. In the Contour Styles in Drawing list, select the style you want to delete.
4. Click Remove.
5. Click OK.

NOTE If you attempt to delete a contour style that is being used by any contours in the drawing, then you are not allowed to remove the style.

Saving Contour Styles to the Contour Style Folder

To use a contour style with another drawing, you must save the contour style to the contour style folder.

To save contour styles to the contour style folder
1. From the Terrain menu, choose Contour Style Manager.
2. Click the Manage Styles tab.
3. In the Contour Styles in Drawing list, select the contour style you want to save to the contour style folder.
4. Click Save to add the style to the Contour Style Directory list.
5. Click OK.

Deleting Contour Styles from the Contour Style Folder

You can delete any contour styles that you have saved to the contour style folder. If you delete a style from this folder, then it is unavailable to use in other drawings.

To delete contour styles from the contour style folder
1. From the Terrain menu, choose Contour Style Manager.
2. Click the Manage Styles tab.
3. In the Contour Style Directory list, select the contour style you want to delete from the folder.
4. Click Delete.
5. Click OK.

NOTE This command does not delete the style that exists in the drawing.
Renaming Contour Styles in the Contour Style Directory

You can rename any contour style that is saved to the contour style folder. This does not affect the name of the style in the current drawing.

To rename contour styles in the contour style folder
1. From the Terrain menu, choose Contour Style Manager.
2. Click the Manage Styles tab.
3. In the Contour Style Directory list, select the contour style that you want to rename.
4. Click the Rename button to display the Rename a Contour Style dialog box.
5. In the File name box, change the style’s name.
6. Click Save.
7. Click OK.

Loading Contour Styles into a Drawing

To use any of the contour styles that are located in the contour style folder but are not in the current drawing, you must load the contour styles into the drawing.

To load contour styles into a drawing
1. From the Terrain menu, choose Contour Style Manager.
2. Click the Manage Styles tab.
3. In the Contour Styles Directory list, select the contour style you want to load into the current drawing. Only one style can be loaded at a time.
4. Click the Load button.
   The contour style displays in the Contour Styles in Drawing list.
5. Click OK.
Changing the Contour Styles Path

By changing the contour styles path, you can choose which folder to which to save contour styles and from which to load contour styles.

To change the contour styles path
1. From the Terrain menu, choose Contour Style Manager.
2. Click the Manage Styles tab.
3. Click Browse to display the Browse for Folder dialog box.
4. Select the folder for the contour styles.
5. Click OK to return to the Contour Style Manager dialog box.

Creating Contours From a Built Surface

You can create contours from either a terrain or volume surface that you have built. When you create contours from a surface, you can specify the elevation range for the contours, the vertical exaggeration, the contour intervals, and the contour style to use.

You can quickly edit the contours you create by using grips and by using the Contour Properties shortcut command, and you can create labels for the contours at their ends or at selected locations.

Creating Contours From a Surface

You can create contour objects in a drawing that represent the contours across your site. The Create Contours command uses a specified contour style to determine contour appearance.
To create contours from a surface

1. Build a surface. For more information, see “Building a Surface” in Chapter 26, “Creating Surface Models.”

2. From the Terrain menu, choose Create Contours to display the Create Contours dialog box.

3. From the Surface list, select the surface that you want to create contours for. If the surface name is not displayed in the list, then click Browse to search for it. Surfaces have the file extension .tin.

4. Under Elevation Range, define the range of the surface’s elevation for which you want to create contours by entering values in the From and To boxes. The low and high elevations of the surface are displayed as defaults.

   **Tip** If you change the Elevation Range, then you can return to the default range by clicking the Reset Elevations button.

5. To exaggerate the elevational changes of the contours when you look at them in 3D, enter a value other than 1 in the Vertical Scale box.

   **Note** If you exaggerate the vertical scale, the contours are drawn at an exaggerated elevation and are therefore incorrect when labeling or as a basis for future TIN creation.

6. Under Intervals, select one of the following options:
   - Both Minor and Major
   - Minor Only
   - Major Only

7. Define the contour intervals by entering values in the Minor Interval and Major Interval boxes. For example, if you enter a minor interval of 2, and your drawing units are meters, then a minor contour is created every place there is a 2-meter change in elevation.
8 Specify the layers for the major and minor contours. By placing the minor and major contours on different layers, you can easily control the contour colors and linetypes. You can select a layer or type in a new layer name.

9 Under Properties, select one of the following options:
   - **Contour Objects**: To create contour objects. For more information, see “Advantages of Using the Contour Object” in this chapter.
   - **Polylines**: To create polyline contours.

   **NOTE** If you select the Polylines option, then you cannot select a contour style to use.

10 From the Contour Style list, select the contour style to use for the contours.

   **TIP** Click the Preview button to see a preview of the contour style.

11 If you need to load a contour style, edit a style, or create a new style, then click the Style Manager button to display the Contour Style Manager dialog box. For more information, see “Managing Contour Styles” in this chapter.

12 Click OK to generate the contours.

   The following prompt is displayed:
   
   Erase old contours (Yes/No) <Yes>:

13 Type Yes or No:
   - Type Yes to erase any existing contours that may be present on the contour layers.
   - Type No to preserve existing contours.
WARNING! If you type Yes to erase the old contours, then existing contours on both the major and minor contour layers are erased. When you develop grading plans, pay attention to the layers that the Create Contours command uses so that your existing ground contours are not erased.

The following illustration shows contours over a surface:

![Contours created over a surface](image)

### Changing Contour Properties
You can smooth selected contours, and show label grips and contour grips, by modifying the contour properties.

To change contour properties
1. Select one or more contours in the drawing.
2. Right-click to display the shortcut menu.
3. Select Contour Properties to display the Contour Style Manager dialog box. For more information, see “Using the Contour Style Manager” in this chapter.

### Showing or Hiding Contour Grips
You can show or hide the grips on a contour. When you click a contour to select it, grips are displayed at each contour vertex, and the contour is highlighted. You can select a grip to edit the contour.

**NOTE** Sometimes the contour grips can interfere with the label grips when you edit a label. Turn them off when you grip edit contour labels. For more information, see “Editing Contour Labels Using Grips” in this chapter.

To show or hide contour grips
1. From the Terrain menu, choose Contour Style Manager.
Select the current contour style.

2 Click the Contour Appearance tab.

3 Under Contour Display, select one of the following options:
   - **Contours Only**: To hide contour grips.
   - **Contours and Grips**: To show contour grips.

4 Click OK.

**Editing Contours Using Grips**

You can edit a contour object using grips.

**To edit a contour using grips**

1 Create contours using the Create Contours command, the Digitize Contours command, or the Convert from Polylines command.

   For more information on the Create Contours command, see “Creating Contours from a Surface” in this chapter. For more information on the Digitize Contours command, see “Digitizing Contours” in this chapter. For more information on the Convert from Polylines command, see “Converting Polylines to Contours” in this chapter.

2 Click the contour in your drawing that you want to edit to display the grips along the contour.

   **NOTE** Make sure contour grips are turned on. For more information, see “Showing or Hiding Contour Grips” in this chapter.

3 Click a grip to select it, and then move the grip to the new location.

---

**Labeling Contours**

Use the contour labeling commands to label any contour you created using the Create Contours or the Convert Polylines command. You can also use the contour labeling commands to label 2D polylines or contours. However, the contour labels function differently if you label polylines or contour objects.

For example:

- You can slide a label along a contour object using grips.
- You can turn off the display of contour object labels.
- If you change label properties after labeling contour objects, the labels are automatically updated. To update polyline labels, you must label the polylines again.
- When you label a polyline on the line and choose to break the line, then the label command breaks the polyline and inserts the text. If you label a contour object on the line, then the contour appears to be broken, but it actually is not. You can slide the label along the contour, and the break is moved with the label.
Labeling the End of a Contour

You can label a contour with its elevation at the end of the contour line. Contour objects, or contours consisting of 2D or lightweight polylines with elevations, must exist in the drawing for this command to work properly.

To label contours at the end of the line

1. Change the contour label settings. For more information, see “Using the Contour Style Manager” in this chapter.
2. From the Terrain menu, choose Contour Labels ➤ End.
3. Select the contour to label.
4. Select the insertion point for the label. The insertion point corresponds to the lower left-hand corner of the inserted text label.
5. Enter the rotation angle of the text by either picking two points or typing a value.
6. Repeat steps 3 through 5 for each contour you want to label.
7. At the Select contour to label prompt, press ENTER to end the command.

**NOTE** This command draws labels on the same layer as the contour and the label appearance is based on the contour style.

The following illustration shows a contour labeled at its end:

![Contour labeled at end](image)

Labeling the Ends of Multiple Contours

You can label a group of contours at the end of the contour lines with their elevation. Contour objects, or contours consisting of 2D or lightweight polylines with elevations, must exist in the drawing for this command to work properly.

To label a group of contours at the end of the lines

1. Change the contour label settings. For more information, see “Using the Contour Style Manager” in this chapter.
2. From the Terrain menu, choose Contour Labels ➤ Group End.
The Contour Labels — Increments dialog box is displayed:

![Contour Labels - Increments dialog box](image)

3. In the Elevation Increment box, type the increment for the labels. For example, to label every fifth contour, type 5.

The other options in this dialog box are not available for Group End labels.

4. Click OK.

5. Enter the rotation angle of the text by either picking two points or typing a value.

6. Select the contours to label by picking two points to drag a line across them.

   The Group End command labels only the contours that intersect this line. The command places the contour label on the end of the contour closest to the dragged line.

   **NOTE** When labeling a dashed contour line, the intersection location for labels may inadvertently be missed (for example, the crossing line passes through a gap in the dashed line). In some cases, it is advisable to use a continuous linetype for contours when adding labels. After labels are drawn, then you can reset the layer to a dashed linetype.

   **NOTE** This command draws labels on the same layer as the contour and the label appearance is based on the contour style.

The following illustration features a group of contours labeled at the ends:

![Multiple contours labeled at the ends](image)
Labeling a Contour at a Selected Location

You can label a contour with its elevation at a selected location. Contour objects, or contours consisting of 2D or lightweight polylines with elevations, must exist in the drawing for this command to work properly.

To label a contour at a selected location

1. Change the contour label settings. For more information, see “Using the Contour Style Manager” in this chapter.
2. From the Terrain menu, choose Contour Labels ➤ Interior.
3. Select the contour line to label.
4. Select a point on the contour for the middle point of the label.
5. At the Select contour to label prompt, select another contour to label, or press ENTER to end the command.

NOTE: This command draws labels on the same layer as the contour and the label appearance is based on the contour style.

The following illustration shows interior contour labeling:

![Interior contour labeling](image)

Labeling Multiple Contours at a Selected Location

You can label a series of contours with their elevations at selected locations. The Group Interior command draws labels on the same layer as the contour and the label appearance is based on the contour style. Contour objects, or contours consisting of 2D or lightweight polylines with elevations, must exist in the drawing for this command to work properly.

To label a group of contours at selected locations

1. Change the contour label settings. For more information, see “Using the Contour Style Manager” in this chapter.
2. From the Terrain menu, choose Contour Labels ➤ Group Interior.
The Contour Labels—Increments dialog box is displayed:

3 In the Elevation Increment box, type the increment for the labels. For example, to label every fifth contour, type 5.

4 Select the Add multiple interior labels along each contour check box to add several interior labels along each contour, instead of just one label per contour. If you select this option, then the spacing distance between labels can be edited. Otherwise, the Spacing option is inaccessible.

5 If you select the Add multiple interior labels along each contour check box then type a value in the Spacing box. This is the distance between labels on the contours, and is measured in drawing units.

6 Click OK.

7 Select the contours to label by picking two points to drag a line across them.

The Group Interior command draws labels on the same layer as the contour and labels only the contours that intersect this line. The command places the label at the intersection of the contour and the line (and at intervals specified by the Spacing box). If the selection line does not intersect a contour at the specified interval, then the program does not insert a label.

**NOTE** When labeling a dashed contour line, the intersection location for labels may inadvertently be missed (for example, the crossing line passes through a gap in the dashed line). In some cases, it is advisable to use a continuous linetype for contours when adding labels. After labels are drawn, then you can reset the layer to a dashed linetype.

**NOTE** If the message At least one break point must be valid is displayed, then the text size for the label may be set too large for the location of the text.
The following illustration features a group of contours labeled on the line:

![Multiple contours labeled at a selected location]

**Deleting Contour Labels**

If you don’t want to plot labels, you can either hide the contour labels or delete the contour labels. For more information about hiding contour labels, see “Showing or Hiding Contour Labels” in this chapter.

**To delete a contour label**

1. From the Terrain menu, choose Contour Labels ➤ Delete Labels.
2. Select the contour from which you want to remove the label.
3. Select a location near the contour label you want to remove.
4. To remove additional labels on the contour, continue to select points.
5. To select another contour line from which to delete labels, press ENTER and select the contour.

**Deleting All Contour Labels from Selected Contours**

If each contour is labeled more than once and you want to delete those labels, then you can use the Delete All Labels command.

**To delete all contour labels from selected contours**

1. From the Terrain menu, choose Contour Labels ➤ Delete All Labels.
2. Select the contours from which you want to delete labels. You can use any standard AutoCAD selection method, such as a crossing or fence, to select the contours.
3. Press ENTER to complete the selection set and delete all the labels from the selected contours.
Showing or Hiding Contour Labels

You can turn on or off the display of contour labels in your drawing.

**NOTE**  
This option works only with labels that are on contour objects. It does not work with polyline contour labels.

To show or hide contour labels

1. From the Terrain menu, choose Contour Style Manager to display the Contour Style Manager dialog box.
2. Select the current contour style. For more information, see “Selecting the Current Contour Style” in this chapter.
3. Click the Contour Appearance tab.
4. Select one of the following options:
   - **Labels Off**: To hide the labels.
   - **Either Labels Only or Labels and Grips**: To show the labels.
5. Click OK.

Showing or Hiding Contour Label Grips

You can show or hide the label grips on a contour. When you click a label to select it, a grip is displayed. You can move the label along the contour by selecting the grip and sliding it.

To show or hide contour label grips

1. From the Terrain menu, choose Contour Style Manager to display the Contour Style Manager dialog box.
2. Select the current contour style. For more information, see “Selecting the Current Contour Style” in this chapter.
3. Click the Contour Appearance tab.
4. Under Label Display, select one of the following options:
   - **Labels Only**: To hide contour label grips.
   - **Labels and Grips**: To show contour label grips.
5. Click OK.

Editing Contour Labels Using Grips

You can edit a contour object label using grips.

To edit a contour label using grips

1. Create contours using the Create Contours command, the Digitize Contours command, or the Convert from Polylines command.
   For more information on the Create Contours command, see “Creating Contours from a Surface” in this chapter. For more information on the Digitize Contours command, see “Digitizing Contours” in this chapter. For more information on the Convert from Polylines command, see “Converting Polylines to Contours” in this chapter.
2 Label the contours using one of the contour labeling commands. For more information, see “Labeling Contours” in this chapter.
3 Click the label you want to edit to display the grip.

**NOTE** Make sure contour label grips are turned on. For more information, see “Showing or Hiding Contour Label Grips” earlier in this chapter.

4 Click the label grip to select it, and then move the grip to the new location along the contour.

### Using Contour Utilities to Create and Edit Contours

You can use the Contour Utilities to create contours by doing any of the following tasks:

- Converting polylines to contours
- Digitizing contours
- Copying and offsetting contours

In addition, you can use the Contour Utilities to edit contour elevations and weed contour vertices (adding or removing points on the contours).

#### Converting Polylines to Contours

You can convert polylines to contour objects. Converting polylines to contours reduces your drawing size. It also lets you take advantage of the contour shortcut menu commands and dynamic labeling features.

**To convert polylines to contour objects**

1 From the Terrain menu, choose Contour Utilities ➤ Convert Polylines.
2 Select the polylines you want to convert.
3 Press ENTER.

#### Exploding Contours to Polylines

To share your drawing with someone who is not using AutoCAD Land Development Desktop (but using AutoCAD), you can explode the contour objects to polylines so that the other person can view and edit the contours.

**To explode contour objects to polylines**

1 At the command line, type EXPLODE.
2 Select the contour objects that you want to convert to lightweight polylines.
3 Press ENTER to convert the contours.

If needed, you can convert the polylines back to contour objects using the Convert Polylines command. For more information, see “Converting Polylines to Contours” in this chapter.
Digitizing Contours

If you have paper copies of plans with contours, or if you have a raster image of contours, then you can digitize (or trace) those contours. Digitizing contours creates contour objects that you can use to build a surface model.

Using your pointing device, you can digitize a scanned raster image of contours that is inserted into your drawing. If you have a tablet, then you can trace a paper copy of a drawing.

If you are using a tablet, then you need to use the CALIBRATE command to configure your tablet so the coordinates of the hard copy drawing match your AutoCAD drawing.

For more information about digitizing contours, see “Digitized Contours” in this chapter.

To digitize contour lines

1. From the Terrain menu, choose Contour Utilities ➤ Digitize Contours to display the Digitize Contours dialog box.

2. In the Starting Elevation box, enter the elevation of the first contour to digitize. For each subsequent contour that you digitize, this value is increased or decreased by the minor interval value.

   For example, if the starting elevation is 200', and the minor interval is 5', then the first contour you digitize is given an elevation of 200'. For the second contour, you can increase or decrease this elevation by the minor interval amount, so you could create a contour with an elevation of 195' or 205'.

3. Under Intervals, select one of the following options:
   - Both Minor and Major
   - Minor Only
   - Major Only

4. Define the contour intervals by entering values in the Minor Interval and Major Interval boxes.
Specify the layers for the minor and major contours. You can select an existing layer or type in a new layer name. By placing the minor and major contours on different layers, you can easily control the contour colors and linetypes.

Under Properties, select one of the following options:
- **Contour Objects**: To create contour objects. For more information, see “Advantages of Using the Contour Object” in this chapter.
- **Polylines**: To create polyline contours.

**NOTE** If you select the Polyline option, then you cannot select a contour style to use.

From the Contour Style list, select the contour style to use for the contours.

**TIP** Click the Preview button to see a preview of the contour style.

If you need to load a contour style, edit a style, or create a new style, then click the Style Manager button to display the Contour Style Manager dialog box. For more information, see “Managing Contour Styles” in this chapter.

Click OK to start digitizing.

Pick points to trace the contour lines.

After you have completed tracing a contour, press ENTER.

The following prompt is displayed:

Next contour relative to <0.00> (+/-/=/Change) <+>:

Type one of the following to define the calculation method for the next contour:
- **A minus sign** (-): To create a contour at the next lower contour interval.
- **An equals sign** (=): To create a contour at the same elevation as the last contour.
- **Change**, and then type a value for the next elevation.
- **A plus sign** (+): To create a contour at the next higher contour interval.

After you finish digitizing contours, press ENTER to end the command.

**Digitized Contours**

The methods you use to digitize the contours can greatly enhance the performance of the surface generator. Remember that the contours ultimately become point data, so you should place just enough vertices to define the contour line adequately. If the contour line is fairly straight, then you do not need many points along it.
If you digitize contours from an existing map, then consider that when contours are used to generate a surface, they are not sorted. You can speed up the triangulation process by digitizing the contours in sections, which minimizes disk access. Divide the site by drawing vertical and horizontal lines. You might do this by dividing the site in half both vertically and horizontally. Then draw a line both horizontally and vertically halfway through each section. Continue to do this until the size of the sections allows for easy digitizing. This method of digitizing speeds up the search process and, therefore, the surface generation.

NOTE
The Weed Contour Vertices command allows you to append or weed vertices in cases where too few or too many polylines or contour segments have been digitized. For more information, see “Weeding Contours to Remove and Add Points” in this chapter.

Changing Contour Elevations

You can change the elevations of selected contours or polylines by using commands on the Contour Utilities menu.

NOTE
You can also use the Object Property Manager to change the elevations of contours.

Changing the Elevations of Selected Contours

You can change the elevation of any contour or polyline in the drawing.

NOTE
Use the Edit Elevation command to change the elevation of a contour object. Do not use the AutoCAD MOVE or CHANGE command.

To change the elevations of selected contours

1. From the Terrain menu, choose Contour Utilities ➤ Edit Elevation.
2. Select the contour line or polyline to edit.
   The elevation value is displayed at the command line. If the contour does not have an elevation, then its elevation is listed as zero.
3. Type the new elevation.
4. Press ENTER to end the command.

NOTE
All contour labels are automatically updated (on contour objects only, not on polylines) to the new elevation.
Changing the Elevation of Each Contour on a Layer

You can change the elevation of each contour on a specific layer. The specified layer must contain contours consisting of 2D polylines or contour objects.

To change the elevation of each contour on a layer

1. From the Terrain menu, choose Contour Utilities ➤ Edit Elevations by Layer.
   The following prompt is displayed:
   
   Select objects by (Entity/Layer) <Layer>:

2. Type one of the following to select the contours:
   - Type Entity and then use any standard selection method to select the contours.
   - Type Layer and then select one contour on the layer that you want to select.
   - Type Layer, press ENTER, and then type the layer name.

   **NOTE** When you use one of the Layer options, all valid contours on that layer are selected.

   A new elevation is prompted for each contour line on the designated layer:
   
   New elevation <{Elevation}>:
   New elevation <{Elevation}>:
   New elevation <{Elevation}>:

3. Type the change in elevation. A positive value increases the elevations; a negative value decreases the elevations.
4. Press ENTER to end the command.

Changing Contour Elevation Datum by Adding or Subtracting a Value

You can change the elevations of a group of contours by adding or subtracting an amount from the existing elevation. Contour objects, or contours consisting of 2D or lightweight polylines with elevations, must exist in the drawing for this command to work properly.

To change contour elevations by addition or subtraction

1. From the Terrain menu, choose Contour Utilities ➤ Edit Datum Elevation.
   The following prompt is displayed:
   
   Select objects by (Entity/Layer) <Layer>:
2 Type one of the following options:
   ■ Type Entity and then use any standard selection method to select the contours.
   ■ Type Layer and then select one contour on the layer that you want to select.
   ■ Type Layer, press ENTER, and then type the layer name.

NOTE When you use one of the Layer options, all valid contours on that layer are selected.

3 Type the change in elevation. A positive value increases the elevations; a negative value decreases the elevations.

Assigning Elevations to Contours or Polylines

You can quickly enter the elevations for a group of contours. You begin by assigning an elevation to the first contour, and then you define an increment for the next. As you select contour lines, you define increasing or decreasing elevations. The command automatically calculates all subsequent contour elevations.

TIP This is a good command to use if you want to assign Z values to polylines.

To assign new elevations to contours
1 From the Terrain menu, choose Contour Utilities ➤ Assign Elevation.
2 Select the first contour or polyline.
3 Enter the first contour elevation.
4 Enter the contour increment.
5 Select the next contour.
   The following prompt is displayed:
   Elevation (Increasing/Decreasing) <I>:

6 Type one of the following one of the following options:
   ■ Increasing: To assign a higher elevation to the next contour.
   ■ Decreasing: To assign a lower elevation to the next contour.
   The current and new elevations are displayed.
7 Press ENTER to accept the new elevation.
8 Repeat steps 5–7.
9 Press ENTER to enter a new first contour, or press ENTER twice to exit the command.
Finding and Changing Contours with Zero Elevations

When you work with contours, it is important that you review the contours to see if any have elevations of zero. If a contour is not intended to have an elevation of zero, then you can change the elevation.

To change contours with zero elevations

1. From the Terrain menu, choose Contour Utilities ➤ Check for 0 Elevation. The following prompt is displayed:
   
   Select objects by (Entity/Layer) <Layer>:

2. Type one of the following options:
   - Type Entity and then use any standard selection method to select the contours.
   - Type Layer and then select one contour on the layer that you want to select.
   - Type Layer, press ENTER, and then type the layer name.

   **NOTE** When you use one of the Layer options, all valid contours on that layer are selected.

   After the program finds a contour with a zero elevation, it highlights the contour and prompts you for the new elevation.

3. Type a new elevation.

4. Repeat steps for every contour found in the selection set that has an elevation of zero.

Weeding Contours to Remove and Add Points

You can add and subtract points on contours by using weeding and supplementing factors. The Weed Contours command adds or removes vertices on the contours in the selection set. This is helpful to control the drawing file size and contour appearance, or to remove redundant information.

To weed or add vertices on a contour

1. From the Terrain menu, choose Contour Utilities ➤ Weed Contour Vertices to display the Contour Weeding dialog box.
NOTE The Create as contour data check box is not used when weeding the contours in the drawing. This option is used only when writing the contour data for use in a surface model.

2 Type the Weeding Distance and Angle factor values.
3 Type the Supplementing Distance and Bulge factor values.

NOTE For more information about weeding and supplementing factors, see “Creating Contour Data to Use in Surface Generation” in Chapter 26, “Creating Surface Models.”

4 Click OK.

The following prompt is displayed:

Select objects by (Entity/Layer) <Layer>:

5 Type one of the following options:
   ▪ Type Entity and then use any standard selection method to select the contours.
   ▪ Type Layer and then select one contour on the layer that you want to select.
   ▪ Type Layer, press ENTER, and then type the layer name.

NOTE When you use one of the Layer options, all valid contours on that layer are selected.

When the operation is complete, the number of contour vertices added or deleted is displayed at the command line.

Creating Contours by Copying and Offsetting

You can create finished ground contours by copying and offsetting existing contours by using grade or slope offsets. These contours provide the information necessary for creating or representing the finished surface.

Copying Finished Ground Contours to Another Layer

You can use the Copy Finished Ground command to copy a group of contours to another layer. Contours must exist in the current drawing to use this command.

To copy finished ground contours
1 From the Terrain menu, choose Contour Utilities ➤ Copy Finished Ground.

The following prompt is displayed:

New layer name:

Creating Contours by Copying and Offsetting
2 Type the name of the new layer to which to copy the contours and press ENTER. 
   The following prompt is displayed:
   Select the old contours:
   Select objects:
3 Select the contours to copy.
4 When you have finished selecting contours to copy, press ENTER to end the
   command. The contours are copied to the new layer. 
   You can now modify the copied contours to show the proposed grading or an
   existing subsurface. The original contours remain unchanged. The Copy Finished
   Ground command ensures that the original and secondary surfaces match
   everywhere except where you modify the site.

**Copying and Offseting the Contours Using a**
**Slope and an Elevation Increment**

With the Copy by Slope command, you can create new contours at a specified
slope and specified elevation increment.

**To copy and offset contours using a slope and an elevation increment**

1 From the Terrain menu, choose Contour Utilities ➤ Copy by Slope. 
   The following prompt is displayed:
   Contour increment:
2 Type the contour increment and press ENTER.
   This is the vertical distance between successive contour lines.
   The following prompt is displayed:
   Run:
3 Type a value or select the slope by entering the two points of the run.
   The run is always a positive horizontal distance. Do not use a plus sign (+) to
   enter a positive rise. For example, to specify a -3:1 (3 to 1) slope, enter a run of 3
   and a rise of -1.
   The following prompt is displayed:
   Rise:
4 Type a value or select the slope by entering the two points of the rise.
   The rise is the vertical distance, positive or negative, for the slope. Do not use a
   plus sign (+) to enter a positive rise. For example, to specify a -3:1 (3 to 1) slope,
   enter a run of 3 and a rise of -1.
   The following prompt is displayed:
   Contour line to offset:
5 Select the contour line to offset in your drawing.
   The following prompt is displayed:
   Side to offset:
Specify the side for the new contour line relative to the selected contour line.

Select another contour to offset, or press ENTER to end the command.

The command uses the elevation and slope of the contour line selected and calculates the necessary horizontal offset distance for the new contour line. The new contour is placed on the same layer as the original contour.

In the following illustration, the new contour is placed six feet from the contour being copied. The elevation of the contour is two feet less than the contour selected for copying.

**Copying and Offsetting Contours by Using a Grade and an Elevation Increment**

You can create new contours at a specified grade and specified elevation increment using the Copy by Grade command.

To copy and offset contours by using a grade and an elevation increment

1. From the Terrain menu, choose Contour Utilities ➤ Copy by Grade.
   The following prompt is displayed:
   Contour increment:

2. At the command prompt, type the contour increment and press ENTER.
   This is the vertical distance between successive contour lines.
   The following prompt is displayed:
   Grade:

3. Specify the grade by entering a percentage change in elevation.
   Enter a minus sign (-) for a negative grade for decreasing elevation, but not a plus sign (+) when specifying a positive grade for increasing elevation.
   The following prompt is displayed:
   Contour line to offset:

4. Select the contour line to offset.
   The following prompt is displayed:
   Side to offset:
5 Specify the side for the new contour line relative to the selected contour line.
The following prompt is displayed:
Contour line to offset:

6 Select another contour to offset, or press ENTER to end the command.
The command uses the elevation of the contour line selected and the grade
given, and calculates the necessary horizontal offset distance for the contour line.
The new contour is placed on the same layer as the original contour.
The following illustration shows contour lines copied at a grade:

![Contour Lines Copied at a Grade](image)

Copying and offsetting contours by specifying a grade

**Creating Multiple Offsets of a Contour Within a Specified Distance**

With the Offset by Distance command, you can create multiple offsets of a
contour at a specified elevation increment and grade until they meet the distance
you specify. A contour must exist in the current drawing to use this command.

To create multiple offsets of a contour within a specified distance

1 From the Terrain menu, choose Contour Utilities ➤ Offset by Distance.
The following prompt is displayed:
Contour line to offset:

2 Select the contour line to offset in your drawing.
The following prompt is displayed:
Select total distance to offset
(or RETURN for value):

3 Define the distance for the offset contours using one of the following methods:
   - Select a second point by clicking a point in your drawing to define the
distance. The new contour will be created on the side of the drawing
you selected.
   - Press ENTER, and then type a distance value, then select the side of the
drawing to create the new contours.
The following prompt is displayed:
Contour interval:
4 Type the contour interval.
The following prompt is displayed:

Grade:

5 Specify the grade using one of the following methods:

■ Select two points in your drawing.
■ At the command prompt, type a percentage change in elevation and press ENTER.

Enter a minus sign (-) for a negative grade for decreasing elevation, but not a plus sign (+) when specifying a positive grade for increasing elevation.

The following prompt is displayed:

Highlight interval:

6 Do one of the following:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>Then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>include highlighted contours</td>
<td>type the highlight interval and press ENTER.</td>
</tr>
<tr>
<td>exclude highlighted contours</td>
<td>press ENTER.</td>
</tr>
</tbody>
</table>

The command creates contours between the selected contour line and the distance specified. If the selected contour line is not on an even interval, then the command adjusts the offset distance to obtain an even contour elevation.

The following prompt is redisplayed:

Contour line to offset:

7 Continue to select a contour line to offset, or press ENTER to exit the command.

**Creating Multiple Offsets of a Contour Until the Elevation you Specify is Obtained**

Using the Offset by Elevation command, you can create multiple offsets of a contour at a specified interval and grade until the elevation you specify is obtained. A polyline or contour must exist in the current drawing.

**To create multiple offsets of a contour until the elevation you specify is obtained**

1 From the Terrain menu, choose Contour Utilities ➤ Offset by Elevation.
The following prompt is displayed:

Contour line to offset:

2 Select the contour line to offset.
The following prompt is displayed:

Select side to offset:
3 Select the side to offset.
   The following prompt is displayed:
   Enter maximum/minimum elevation:

4 Enter the minimum/maximum elevation.
   For a positive grade, this value must be greater than the selected contour line. For
   a negative grade, it must be less than the selected contour line.
   The following prompt is displayed:
   Contour interval:

5 Type the contour interval and press ENTER.
   The following prompt is displayed:
   Grade:

6 Specify the grade by entering a percentage change in elevation.
   Enter a minus sign (-) for a negative grade for decreasing elevation, but not a plus
   sign (+) for a positive grade for increasing elevation.
   The following prompt is displayed:
   Highlight interval:

7 Do one of the following:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>Then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>include highlighted contours</td>
<td>type the highlight interval and press ENTER.</td>
</tr>
<tr>
<td></td>
<td>Then, type the name of the layer on which you want to include highlighted contours and press ENTER.</td>
</tr>
<tr>
<td>exclude highlighted contours</td>
<td>press ENTER.</td>
</tr>
</tbody>
</table>

The program creates offsets starting with the selected contour line until the elevation you entered is reached. If the selected contour line is not on an even interval, the command adjusts the offset distance to obtain even contour elevations.

The following prompt is redisplayed:
Contour line to offset:

8 Continue to select a contour line to offset, or press ENTER to exit the command.
33

Working with 3D Polylines

You can use 3D polylines to create additional data to include in surfaces. You can convert 2D polylines to 3D polylines and vice versa. You can add vertices or remove vertices, and you can join 3D polylines together.

In this chapter

- Creating 3D Polylines
- Creating 3D Polylines by Referencing Elevation of Points
- Creating 3D Polylines by Referencing Points and Slopes
- Creating a Curb
- Creating a Step
- Converting 3D Polylines to 2D Polylines
- Converting 2D Polylines to 3D Polylines
- Editing 3D Polylines
- Filleting 3D Polyline Vertices
- Displaying 3D Polyline Grade Breaks
- Adding Vertices to a Polyline
- Joining 3D Polylines
- Weeding 3D Polylines
Creating 3D Polylines

3D polylines are perhaps the most powerful and simple tool to create an accurate 3D representation of a design surface. The 3D polyline tools allow the designer to do the following tasks:

■ Create and edit 3D polylines by specifying elevations, slopes, grades, and distances.
■ Offset 3D polylines to represent curbs, steps, or walls.
■ Accurately represent 3D curves, which are not a valid part of an AutoCAD 3D polyline, by creating a series of 3D segments that lie on the geometric definition of an arc.
■ Fillet 3D polyline vertices, which is not possible in AutoCAD alone, by creating a series of 3D segments that lie on the geometric definition of a filleted arc.
■ Add and remove polyline vertices.
■ Join 3D polylines.

Creating 3D Polylines by Referencing the Elevations of Points

With the Create by Elevation command, you can create a 3D polyline by elevation by specifying an object or points for the polyline vertices. You can use a surface to calculate the vertex elevations, extract elevations from points, or type elevations at the command prompt.

To create 3D polylines by referencing the elevations of points

1. From the Terrain menu, choose 3D Polylines ➤ Create by Elevation.
   The following prompt is displayed:
   From point (or Entity):

2. Select the point or entity for the polyline vertices by doing one of the following:
   ■ Select points to define the vertices.
   ■ Type E and select an existing entity in your drawing.

   If you use the .G point selection filter to select point objects, the elevation for the point is reported in step 3.

   ■ Define the elevation for the points or the entity vertices as you select them. For more information, see “Define the Elevations for Points or Entity Vertices” in this chapter.

   The following prompt is displayed:
   To point (eXit/Dtm/Curve/Undo/Entity/Transition):

3. At the prompt, select the next point of the polyline. For more information, see “3D Polylines – Options for Defining the Polyline” in this chapter.
5 Select the next point for the polyline.
After you draw two polyline segments, you can continue to use the options listed in step 3 to draw segments. You also have the following options:

- Type R for Redraw to redraw the temporary lines. Until you end the command, all the segments are temporary lines. If you use a transparent command like a ZOOM or PAN, the temporary lines disappear. Type R to redraw those lines.
- Type CL for Close to close the polyline.

6 After you finish drawing the polyline, type X to create the polyline in the drawing.

Define the Elevations for Points or Entity Vertices

- For points: Type an elevation for the first point. If you selected points using the .G filter, the elevation is reported at the command line. Press ENTER to accept this value, or type a new value. You can also type D to extract elevations from a surface, and select the surface from which to read the elevation. You can accept the elevation obtained from the surface model, or type a new elevation.
- For a line or curve entity: Type an elevation for the first vertex, or type D to select the surface from which to read the elevation. You can then either accept the elevation obtained from the surface, or type a new elevation.
- For a contour: If you select a contour with multiple vertices, the following prompt is displayed:

```
Additional curve vertices by (eXit/Number/Mid/Distance) <Distance>:
```

At this prompt, define the contour by typing one of the following options:

- Type N and then the number of vertices to use.
- Type M and then the mid-ordinate length.
- Type D and then the distance.
- Type X to exit the command.

3D Polylines – Options for Defining the Polyline

Use the following options to define the polyline:

- Point: Select the next point, and define its elevation.
- eXit: Type X to exit the command.
- DTM: Type D to either turn on or off the surface option before selecting the next point.
- Undo: Type U to undo the last point you selected.
- Transition: Type T to create a more continuous slope between polyline vertices.

By defining the beginning and ending elevation, the command calculates all intermediate vertices on the slope of this line.

When you select the Transition option, the following prompts are displayed:

```
To point (eXit/Dtm/Curve/Undo/Entity/Transition): T
To Point (or Curve):
To Point (End/Curve/Undo):
```

After selecting the transition points, type E to end the transition.
A total length of transition segments displays and you are prompted for the ending elevation. The calculated slope and grade appear for the transition segments, and you return to the previous polyline prompts.

- **Entity**: Type E and select an entity nearest the vertex you want to use.
- **Curve**: Type C, and draw a curve at an elevation by selecting the point on the curve and the endpoint of the curve, and defining the ending elevation for the curve. Then, after you draw the arc, you are prompted to specify how many vertices you want the curve to have. This is because you cannot actually draw a 3D curve in AutoCAD; you must draw line segments to create the representation of the arc.

The following prompt is displayed:

```
Additional curve vertices by (exit/number/mid/distance) <distance>:
```

At this prompt, you can type one of the following options:

- Type N and then the number of vertices to add.
- Type M and then the mid-ordinate distance.
- Type D and then the distance between each vertex.
- Type X to exit the command.

### Creating 3D Polylines by Referencing Points and Slopes

With the Create by Slope command, you can create a 3D polyline by specifying an entity or points for the polyline vertices, and then give the polyline an elevation by specifying a slope.

**To create 3D polylines by referencing points and slopes**

1. From the Terrain menu, choose 3D Polylines ➤ Create by Slope.
   The following prompt is displayed:

   ```
   From point (or Entity):
   ```

2. At the command prompt, select the start point, or type E and select an existing entity in your drawing.

   **NOTE** If you use the .G point selection filter to select point objects, the elevation for the point is reported in step 3.

3. Define the elevation for the point or first entity vertex. For more information, see “Defining the Elevation for the Point or the First Entity Vertex” in this chapter.
   The following prompt is displayed:

   ```
   Slope (or Grade) <Infinite>:
   ```
Define the slope or grade from the first point to the second point using one of the following methods:

- Type a slope in the following format: 3:1.
- Type G and a grade.

**NOTE**
An Infinite slope is a horizontal line. An Infinite grade is a vertical line.

The command reports the resulting elevation for the second point.

The following prompt is displayed:

To point (eXit/Redraw/Curve/Close/Undo/Entity):

At the command prompt, type one of the options to continue. For more information, see “Creating 3D Polylines by Referencing the Points and Slopes - Define the Polyline” in this chapter.

After you finish drawing the polyline, type X for eXit to create the polyline.

### Defining the Elevation for the Point or the First Entity Vertex

**For points:** Type an elevation for the first point. If you selected points using the .G filter, the elevation is reported at the command line. Press ENTER to accept this value, or type a new value. You can also type D to extract elevations from a surface, and then select the surface from which to read the elevation. You can then accept the elevation obtained from the surface, or type a new elevation.

The following prompt is displayed:

To point (eXit/Curve/Undo/Entity):

Use these options to select the second point, to draw a curve, to undo the last point, or to select a point on an entity.

**For a line or curve entity:** Type an elevation for the first vertex, or type D to select the surface from which to read the elevation. You can then either accept the elevation obtained from the surface, or type a new elevation.

**For a contour:** If you select a contour with multiple vertices, the following prompt is displayed:

Additional curve vertices by (eXit/Number/Mid/Distance) <Distance>:

At this prompt, type one of the following options:

- Type N and then the number of vertices to use.
- Type M and then the mid-ordinate length.
- Type D and then the distance.
- Type X to exit the command.

### Creating 3D Polylines by Referencing the Points and Slopes - Define the Polyline

You can use the following options to define the polyline:

- **Point:** Select the next point, and then define the next slope.
- **eXit:** Type X to exit the command.
- **Redraw:** Type R to redraw the temporary lines.
■ Close: Type CL to close the polyline back to the start point.
■ Undo: Type U to undo the last point you selected.
■ Entity: Type E and select an entity nearest to the vertex you want to use.
■ Curve: Type C, and draw a curve: select the point on the curve and the endpoint of the curve, and then define the curve's ending slope. After you draw the curve, you are prompted to specify how many vertices you want it to have. This is because you cannot actually draw a 3D curve in AutoCAD; you must draw polyline segments and then fillet each vertex to create the representation of the arc.

The following prompt is displayed:
Additional curve vertices by (eXit/Number/Mid/Distance) <Distance>:

At this prompt, type one of the following options:
■ Type N and then the number of vertices to add.
■ Type M and then the mid-ordinate distance.
■ Type D and then the distance between each vertex.

Creating a Curb by Offsetting a 3D Polyline and Applying a Single Elevational Change

With the Create Curb command, you can offset an existing polyline in your drawing and apply an elevational change to the entire polyline. This command is useful in creating any feature that has a constant depth, such as curbs or walks.

To create a curb by offsetting a 3D polyline and applying a single elevational change

1. From the Terrain menu, choose 3D Polylines ➤ Create Curb.
   The following prompt is displayed:
   Select polyline:

2. Select the polyline.

   **NOTE** This command uses a midpoint Object Snap, and in order for the program to recognize the polyline, the midpoint of the polyline must be visible on the screen. Use the ZOOM command to make the midpoint of the polyline visible on the graphics screen.

   **NOTE** If you select a 2D polyline that includes curves, the following prompt is displayed:

   Additional curve vertices by (eXit/Number/Mid/Distance) <Distance>: 
3 At this prompt, type one of the following options:
- Type N and then the number of vertices to use.
- Type M and then the mid-ordinate length.
- Type D and then the distance.
- Type X to exit the command.

**NOTE** To draw a 3D polyline arc, you must specify how many vertices you want the curve to have. This is because you cannot actually draw a 3D curve in AutoCAD; you must draw polyline to create the representation of the arc.

The following prompt is displayed:

Select offset side:

4 Select a side for the new polyline.

The following prompt is displayed:

Offset <0.00>:

5 At this prompt, specify an offset distance for the polyline using one of the following methods:
- Type an offset value.
- Select two points to define the offset distance.

**NOTE** The offset distance of the new polyline must not exceed a value that creates a polyline with fewer vertices than the existing polyline.

The following prompt is displayed:

Elevation (exit/Difference) <0.00>:

6 At this prompt, specify the elevation for the new polyline by typing one of the following options:
- Type a value that is a uniform elevation for the entire polyline.
- Type D and the elevational difference between the original polyline and the new polyline, calculated at each vertex. Use the Difference option to add or subtract the difference value from each original elevation.

**NOTE** The new polyline is created with the same number of vertices as the original.

The following illustration shows a 3D polyline that was offset to create a curb:
Creating a Step by Offsetting a 3D Polyline and Applying the Elevational Changes to Each Vertex

With the Create Step command, you can offset an existing polyline and apply an elevational change to each vertex on the polyline. This command is useful in modeling a vertical face when the top and bottom have different elevations, such as a retaining or wing wall.

To create a step by offsetting a 3D polyline and applying the elevational changes to each vertex

1. From the Terrain menu, choose 3D Polylines ➤ Create Step.
   The following prompt is displayed:
   Select polyline:

2. Select the polyline.

   NOTE This command uses a midpoint Object Snap, and in order for the program to recognize the polyline, the midpoint of the polyline must be visible on the screen. Use the ZOOM command to make the midpoint of the polyline visible on the graphics screen.

3. At this prompt, type one of the following options:
   ■ Type X to exit the command.
   ■ Type N and then the number of vertices to use.
   ■ Type M and then the mid-ordinate length.
   ■ Type D and then the distance.

   NOTE To draw a 3D polyline arc, you must specify how many vertices you want the curve to have. This is because you cannot actually draw a 3D curve in AutoCAD; you must draw polyline segments and then fillet each vertex to create the representation of the arc.

   The following prompt is displayed:
   Select offset side:

4. Select a side for the new polyline.
   The following prompt is displayed:
   Offset <0.00>: 
Converting 3D Polylines to 2D Polylines

Using the Convert to 2D Polyline command, you can convert 3D polylines to 2D polylines.

By definition, a 2D polyline is co-planar, which means that all of its vertices have the same elevation. A 2D polyline may contain arcs. Comparatively, a 3D polyline may have different vertex elevations, but cannot contain any arcs. However, a 3D polyline may have all of its vertices at equal elevation. When a 3D polyline is converted to a 2D polyline, all of its vertices are changed to the same elevation as the first vertex on the 3D polyline from which it was created.
To convert 3D polylines to 2D polylines

1. From the Terrain menu, choose 3D Polylines ➤ Convert to 2D Polyline.

The following prompt is displayed:

Select by Layer (Selection/Layer):

2. Do one of the following to convert 3D polylines to 2D:

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>Then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>select the objects in your drawing</td>
<td>type $ for Selection at the command prompt and press ENTER.</td>
</tr>
<tr>
<td>select the object on a specific layer</td>
<td>type L for Layer at the command prompt and press ENTER.</td>
</tr>
<tr>
<td>type the layer name on which the 3D polylines that you want to convert to 2D are located</td>
<td>type L and press ENTER.</td>
</tr>
</tbody>
</table>

The program performs the conversion.

Converting 2D Polylines to 3D Polylines

You can convert 2D polylines to 3D polylines using the Convert from 2D Polyline command.

By definition, a 2D polyline is co-planar, which means that all of its vertices have the same elevation. A 2D polyline may contain arcs. Comparatively, a 3D polyline may have different vertex elevations, but cannot contain any arcs. However, a 3D polyline may have all of its vertices at the same elevation. When a 2D polyline is converted to a 3D polyline, all of its vertices have the same elevation as the original 2D polyline.

To convert 2D polylines to 3D polylines

1. From the Terrain menu, choose 3D Polylines ➤ Convert from 2D Polyline.

The following prompt is displayed:

Select by Layer (Selection/Layer):
Do one of the following to convert 2D polylines to 3D.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>select the objects in your</td>
<td>type S for Selection at the command</td>
</tr>
<tr>
<td>drawing</td>
<td>prompt and press ENTER.</td>
</tr>
<tr>
<td>select the object on a</td>
<td>type L for Layer at the command prompt and</td>
</tr>
<tr>
<td>specific layer</td>
<td>press ENTER.</td>
</tr>
<tr>
<td>type the layer name on</td>
<td>type L and press ENTER.</td>
</tr>
<tr>
<td>which the 2D polylines</td>
<td></td>
</tr>
<tr>
<td>that you want to convert</td>
<td></td>
</tr>
<tr>
<td>to 3D are located</td>
<td></td>
</tr>
</tbody>
</table>

The program performs the conversion.

Editing a 3D Polyline

With the Edit 3D Polyline command, you can edit any 3D polyline by selecting a vertex and changing its elevation and/or location. A temporary X is located at the current vertex for reference.

To edit a 3D polyline

1. From the Terrain menu, choose 3D Polylines ➤ Edit 3D Polyline.
   The following prompt is displayed:
   Select polyline:

2. Select a polyline from your drawing.
   The following prompt is displayed:
   Previous/Close/Move/Redraw/Elevation/Slope/eXit/Next <Next>:

3. Select one of the following editing options:
   - **Next**: Type N to move to the next polyline vertex.
   - **Previous**: Type P to move to the previous polyline vertex.
   - **Close**: Type C to connect the last segment with the first. A polyline is considered open unless you close it using the Close option. After you use the Close option, the Open option is displayed.
   - **Open**: Type O to open a polyline that you closed.
   - **Move**: Type M to move the current vertex, and then select the new location.
   - **Redraw**: Type R to redraw the display.
   - **Elevation**: Change the elevation of the current vertex. Type E to display the following prompt:
     Elevation (eXit/Difference) <0>:

     Type a new elevation for the vertex, type D and a value to be added or subtracted to the current elevation, or type X to exit this option.
■ **Slope**: Change the slope of the current polyline segment. Type **S** to display the current slope of the segment and the following prompt:

```
Slope option (Next/Previous/eXit) <eXit>:
```

You can type a new slope for the current segment, move to the next or previous vertex, or type **X** to exit this option.

■ **eXit**: Exits the command.

---

## Filleting 3D Polylines Vertices

You can round the corners of 3D polylines at selected vertices. This is called filleting. The result is not actually an arc in the 3D polyline, but a series of user-specified straight line segments that approximate the arc geometry.

One situation where you would fillet the corners of a 3D polyline object is to create a radial corner when using the Civil Design Daylighting commands. Another is when you want to create a 3D representation of an arc within a 3D polyline.

When you draw a 3D polyline arc, you can specify how many vertices you want the curve to have. This is because you cannot actually draw a 3D polyline curve in AutoCAD; you must draw polyline segments and then use the Fillet 3D Polyline command to create the representation of the arc. The more vertices, the more realistic the representation of the curve.

**To fillet a 3D polyline vertex**

1. From the Terrain menu, choose 3D Polylines ➤ Fillet 3D Polyline.

   The following prompt is displayed:

   ```
   Fillet radius <10.00>:
   ```

2. Define the fillet radius.

   The fillet radius defines the new arc segment at the vertex. You can either type a radius or select two points. When you fillet a 3D polyline arc, the arc is broken down into line segments.

   The following prompt is displayed:

   ```
   Maximum distance to set additional curve vertices<0.50>:
   ```

3. Determine the length of these line segments by defining the distance between each vertex using one of the following methods:

   - Type a value at the command prompt.
   - Select two points to define the distance.

4. Select all the vertices you want to fillet, and then press ENTER to continue.

   Determine whether to erase the existing polyline or leave it in the drawing.
5 You can press ENTER to erase the old polyline, or type No to leave the old polyline.

NOTE After erasing the old polyline, use the AutoCAD Redraw command to redraw the screen.

Displaying 3D Polyline Grade Breaks

With the 3D Polyline Grade Breaks command, you can display 3D polyline grade breaks (changes in slope/grade) on an existing 3D polyline in your drawing. The grade breaks are marked with a temporary X.

To display 3D Polyline grade breaks
1 From the Terrain menu, choose 3D Polylines ➤ 3D Polyline Grade Breaks.
The following prompt is displayed:
Layer/Selection <Selection>:
2 At this prompt, do one of the following:
■ Press ENTER to accept the default, select the objects(s) in your drawing that you want to display grade breaks for, and then press ENTER.
■ Type L for Layer and select an object on the layer the polylines are on, or type L, press ENTER, and type the layer name.
Temporary Xs are placed on the polyline to indicate where the grade breaks occur. You can type Redraw to remove the markers.
3 Select additional objects, or press ENTER to end the command.

Adding Vertices to a Polyline

You can add vertices to any polyline. The polyline can have a constant elevation, or it can have varying elevations at its vertices. It can be an open or closed polyline.

To add vertices to an existing polyline
1 From the Terrain menu, choose 3D Polylines ➤ Add Vertices.
The following prompt is displayed:
Select entity (or Points):
2 At this prompt, select the polyline to which to add vertices using one of the following methods:
■ Select a polyline with your pointing device.
■ Type P and select points to define the polyline.
When you select the points to define the polyline, the following prompt is displayed:

Establish first point elevation
Elevation <0.00>: Establish second point elevation
Elevation (exit/difference/slope) <0.000>: 

3 At this prompt, type one of the following options:

- Type the elevation for the second point.
- Type D and the difference in elevation between the first and second points.
- Type S and a slope between the first and second points, or type G and a grade.

4 Specify the distance to set the additional polyline vertices.

This is the horizontal distance between the new vertices.

If you selected a 2D polyline that contains arcs, the following prompt is displayed:

Additional curve vertices by (exit/number/mid/distance) <distance>:

5 At the prompt, type one of the following options:

- Type C, and draw a curve at an elevation by selecting the point on the curve and the endpoint of the curve, and defining the ending elevation for the curve. After you draw the arc, you are prompted to specify the number of vertices you want the curve to have. The reason you must specify the number of vertices is because you cannot actually draw a 3D curve in AutoCAD; you must draw line segments to create the representation of the arc.
- Type X to exit the command.
- Type N and then the number of vertices to add.
- Type M and then the mid-ordinate distance.
- Type D and then the distance between each vertex.

The following prompt is displayed:

Erase old entity (Yes/No) <Yes>:

6 At this prompt, press ENTER to erase the old polyline. You can also type No to keep the old polyline.

NOTE If you do not erase the old polyline, then you may have trouble selecting the new polyline definition because there are now two objects in the same location.

The following illustration shows an example of adding vertices:
Joining 3D Polylines

The Join 3D Polyline command lets you select two 3D polylines (with varying elevations) and join them into one new 3D polyline.

To join 3D polylines

1. From the Terrain menu, choose 3D Polylines ➤ Join 3D Polylines.
2. Select the 3D polylines you want to join.
3. Press ENTER.

The 3D polylines you selected are combined into one polyline.

Weeding 3D Polyline Vertices

You can use the Weed Vertices command to remove extra vertices on 3D polylines. Using the Weed Vertices command you enter three criteria to determine if a vertex should be removed from the 3D polyline. For each of these criteria, the command looks at three consecutive vertices. If the three criteria for the three consecutive vertices are met, the middle vertex is removed, and the command continues to analyze and remove vertices until the end of the 3D polyline is reached.

To weed 3D polyline vertices

1. From the Terrain menu, choose 3D Polylines ➤ Weed Vertices.

The following prompt is displayed:

Select objects by [Entity/Layer] <Layer>:

2. Do one of the following to select the 3D polylines you want to weed:

   - Type Entity and then select the 3D polylines from the drawing.
   - Type Layer and then select a polyline on the layer you want to select, or press ENTER to specify a layer name to select.
The 3D Polyline Weeding dialog box is displayed and the number of valid 3D polylines that you selected is displayed in the Number of 3D Polylines Selected box.

3 Under Weeding Factors, specify the Maximum Horizontal Distance. For each of the criteria you specify for this command, the command looks at three consecutive vertices. The XY distance from the first and third vertices must be less than the Maximum Horizontal distance.

4 Specify the Maximum Horizontal Deflection Angle. The XY deflection angle between the two segments formed by the three vertices must be less than Maximum Horizontal deflection angle.

5 Select the Check for Grade Breaks check box if you want to use the Maximum Grade Change value as part of the criteria for weeding the polyline vertices.

6 If you selected the Check for Grade Breaks check box, then specify the Maximum Grade Change (Percent) value. The vertical grade change (Z) between the two segments formed by the three vertices must be less than the Maximum Grade Change percent.

7 Select the Erase Existing 3D Polylines check box to erase the polyline(s) that you selected. If you clear this check box, then the new, weeded, polylines are drawn on top of the existing polylines.

The program applies the weeding factors on the set of 3D polylines selected and highlights the removed vertices with a temporary red + or x. The command line displays the total number of original vertices, the total number of vertices removed, and the number of new vertices.
Creating and Managing Surface Sections

To help you determine a surface’s characteristics, you can create cross sections of the surface. AutoCAD Land Development Desktop has two different methods you can use to create sections. You can create quick sections that display in a window, or you can create cross sections that you can import into a drawing.
Creating Surface Sections

To better visualize the slopes of a surface, you can create cross sections of the surface. You can create two types of sections:

■ Sections you can import into the drawing and query.
■ Quick cross sections that are displayed in a separate window.

Creating Surface Sections that You Can Import and Query

You can create sections that you can import into the drawing, query, and use for final plotting. Creating the sections is a three-step process. First, you define where the sections will be cut. Next, you process the section data for those sections, and finally you can import the sections into the drawing. You can create sections that show section data for more than one surface which can give you an idea of cut and fill situations.

Turning Multiple Surfaces On or Off for Creating Surface Sections

You can turn on the use of multiple surfaces, and then create a multiple surface file for generating surface sections. For more information, see “Creating Surface Sections from Multiple Surfaces” in this chapter.

To turn multiple surfaces on or off

■ From the Terrain menu, choose Sections ➤ Multiple Surfaces On/Off.

If multiple surfaces are on, then all the surfaces you select with the Define Multiple Surfaces command are used to create sections. The elevations for the section are extracted from the surface associated with each surface name in the file. If multiple surfaces are off, then only the current surface is used.

Creating Surface Sections from Multiple Surfaces

You can choose which surfaces from which to create cross sections.

To create a multiple surface file for cross sections

1 Turn on the use of multiple surfaces. For more information, see “Turning Multiple Surfaces On or Off for Creating Surface Sections” in this chapter.
2 From the Terrain menu, choose Sections ➤ Define Multiple Surfaces to display the Multiple Surface Selection dialog box.

![Multiple Surface Selection dialog box](image)

3 Select which surfaces you want to use by clicking the surface names in the Select from list. As soon as you click a surface name in the Select from list, it is placed into the Current list.

You can press the SHIFT key to select more than one surface name at a time, or press the CTRL key to select non-sequential surface names.

4 Click OK to create the multiple surface file.

---

**Defining Surface Sections**

You can define which cross sections you want to view when you import them into a drawing. To do this, you name the cross section group that you want to create, and then pick points on the surface to define the start and end points of the cross section to create.

**To define the surface sections**

1 To create sections for more than one surface, choose which surfaces to use.
   For more information, see “Creating Surface Sections from Multiple Surfaces” in this chapter.

2 Import the surface as 3D lines. For more information, see “Importing the Surface as 3D Lines” in Chapter 30, “Editing Surfaces.”
   This is recommended so that you can see which points on the surface to select.

3 From the Terrain menu, choose Sections ➤ Define Sections.

4 Type a group label for the section. This label can have up to 8 characters.
   You can use this label to organize related sections together. For example, you can create a group of sections across a particular building pad that you can group together using the name of the building as the group label.

5 Type a section label for the section. This label can have up to 8 characters. You can use this label to add a more descriptive label to the section, like offset from a particular baseline.

6 Select the endpoints of the cross section by either picking points or typing coordinates of the endpoints.
The following illustration shows a section line drawn across a surface:

7 Repeat steps 5–6 to define more cross sections for the group.

To create a new group, press ENTER at the Section Label prompt. The Group Label prompt is displayed. You can type a new group label and create sections for the new group.

8 Press ENTER twice to end the command.

9 Process the cross section elevational information before you import the cross sections into your drawing. For more information, see “Processing Surface Sections” in this chapter.

**Processing Surface Sections**

After you define the sections that you want to view, you need to process the cross sections using the Process Sections command. This command extracts the elevations of the cross sections from the surface(s). For more information, see “Defining Surface Sections” in this chapter.

**To process the cross sections**

1 From the Terrain menu, choose Sections ➤ Process Sections.

If you defined more than one group of sections, then the groups that you defined are displayed at the command line.

2 Type the name of the group that you want to process.

The command processes the sections.

3 Type the name of another group to process, or press ENTER to end the command.

4 Import the sections into the drawing. For more information, see “Importing Surface Sections into the Drawing” in this chapter.

**NOTE** If you already processed cross sections, then you are prompted to append the new cross sections to the existing file. If you select Yes, then the newly processed sections are appended to the section file that you defined earlier. If you select No, then the existing section information is deleted and a new section file is created.
If a newly-defined group has the same name as an existing group, then the following prompt is displayed:

Group <{Group Name}> already exists. Do you want to rename the group?

If you type Yes, then the command prompts you to name the new group. If you type No, then the old group and sections within the group are deleted.

If multiple surfaces are turned on, then the surfaces as specified in the Define Multiple Surfaces command are accessed and elevations for each defined section are extracted. These elevations are included in the section file used by the Import Sections command.

For more information about multiple surfaces, see “Turning Multiple Surfaces On or Off” in this chapter. For more information on defining multiple surfaces, see “Creating Surface Sections from Multiple Surfaces” in this chapter. For more information on importing sections, see the following section, “Importing Surface Sections into the Drawing.”

**Importing Surface Sections into the Drawing**

After you process cross sections, you can import them into a drawing. For more information about processing cross sections, see “Processing Surface Sections” in this chapter.

**To import surface sections into the drawing**

1. From the Terrain menu, choose Sections ➤ Import Sections.
2. Type a layer name for the datum line and datum block, or press ENTER to accept the default.
   
   The datum block is the block to the left of the imported section. This block contains the datum label, group label, and section label.
   
   When multiple surfaces are turned on, the following prompt is displayed before the datum layer prompt:

   Layer name prefix for surface(s):

   You can specify a prefix for each surface at this prompt. This prefix is combined with the name of the surface to form the layer name. For example, if a surface is EG and the prefix entered is SURF, then the layer name for the surface line is SURFEG. If you do not want to define a prefix, press ENTER at this prompt.
3. Type the vertical scale factor for the cross section.
   
   To exaggerate the features of a cross section, make this number greater or less than 1.
4. Pick an insertion point for the first cross section. The command line displays the group name and section name of the cross section that you are inserting.
   
   The command displays the minimum and maximum elevation of the cross section, and suggests a default datum elevation based on these numbers.
5. Accept the default, or type a new value for the datum elevation.
6. Repeat steps 4–5 for each cross section that you want to import.
If the defined sections are completely outside the surface or sections are not defined, then the following error message is displayed:

No sections processed or imported into the drawing.

The following illustration shows a surface section imported into a drawing:

![Surface section imported into a drawing](image)

**Placing a Grid Over Surface Sections**

You can place a grid onto imported surface sections that shows elevation and spacing values, as shown in the following illustration:

![Grid on imported surface sections](image)

**To place a grid onto imported surface sections**

1. From the Terrain menu, choose Sections ➤ Grid For Sections.
2. Type a layer name for the grid, or press ENTER to accept the default.
3. Click any part of the datum block that contains the DATUM ELEV, GROUP name, and SECTION name. This block is located to the left of the section.
4. Type an elevation increment for the grid.
   - This is the vertical spacing of the grid. For example, if you want a grid line to mark the change in elevation for every 2 meters, then type 2.
   - **NOTE** This spacing is exaggerated based on the vertical exaggeration of the cross section.
5. Type an offset increment for the grid.
This is the horizontal spacing of the grid. For example, if you type 2, then a grid line is placed every 2 meters (or feet, depending on the units you use) along the cross section.

6 Select another datum block and repeat steps 4–5, or press ENTER to end the command.

**Listing the Elevation of a Point on a Surface Section**

You can list the elevation of a point on a surface section with respect to a selected section.

**To list the elevation of a surface section point**

1 Import the cross section into the drawing. For more information, see “Importing Surface Sections into the Drawing” in this chapter.
2 From the Terrain menu, choose Sections ➤ List Elevation.
3 Select the datum block of the section.
   The datum block of the section labels the DATUM ELEV, GROUP name, and SECTION name. This block is located to the left of the section.
4 Pick the point in the cross section that you want to display the elevation of.
   The selected point's elevation is displayed at the command line.
5 Continue to pick more points to list, or press ENTER to display the Select desired section DATUM block prompt. At this prompt, you can select the datum block of another section, or press ENTER to end the command.

**Listing the Elevational Difference Between Two Points on a Surface Section**

You can list the elevational difference (vertical distance) between two points with respect to a selected section and its datum and scale.

**To list the elevational difference between two points**

1 Import the cross section into the drawing. For more information, see “Importing Surface Sections into the Drawing” in this chapter.
2 From the Terrain menu, choose Sections ➤ List Depth.
3 Select the datum block of the section.
   The datum block of the section labels the DATUM ELEV, GROUP name, and SECTION name. This block is located to the left of the section.
4 Select two points that you want to list the elevational difference between.
   The elevational difference between the two points is listed with respect to the selected datum block. The vertical scale of the selected section is taken into account.
5 Choose another section at the Select desired section DATUM block prompt, or press ENTER to end the command.
Creating Quick Surface Sections

For quick visualization of surface slopes of the current surface, you can create quick section views. Quick sections appear in a separate window on the screen. As you move your pointing device over the section, the distance and elevation values are displayed on the section window title bar.

When you create quick cross sections, you draw a line across the surface to indicate where the section is to be cut. These lines are called section lines. You can access a shortcut menu by right-clicking a section line. You can use the shortcut menu options to close the section window, to redisplay the section in the section window, to view section statistics, and to change the color of a section line. Section lines are not saved with the drawing. However, to keep a line in the drawing to indicate where a section was cut, use the EXPLODE command to convert the section line into a polyline that is saved with the drawing.

NOTE These cross sections are intended for visualization purposes to help you edit the surface. To create final cross sections for plotting, use the Define Sections, Process Sections, and Import Sections commands. For more information on these commands, see “Defining Surface Sections,” “Processing Surface Sections,” or “Importing Surface Sections” in this chapter.

Creating Quick Surface Sections and Profiles

You can create a quick section view in a separate window by drawing a section line across the current surface. You can grip edit the section line to automatically update the cross section. If you edit the surface, then you can update the cross section using the Update Section Views command. For more information, see “Updating Quick Surface Sections and Profiles” in this chapter.

TIP If you use the Create Section View command to display more than one section view, then you can drag the second cross section window to a new location on your screen so you can view both sections simultaneously.

To view a quick cross section
1 Select the current surface. For more information, see “Making a Surface Current” in Chapter 28, “Managing Surfaces.”
2 From the Terrain menu, choose Sections ➤ Create Section View.
3 Pick two or more points on the surface to draw a line where you want to cut the cross section.
4 Press ENTER to draw the cross section.
Creating Quick Surface Sections

The cross section window is displayed on your screen, showing the cross section along with the elevation and offset values of the cross section.

![Cross Section Window](image)

After you draw a cross section line and display a cross section view, you can:

- Change the cross section properties, such as color, vertical scale factor, and tick increment. For more information, see “Changing the Properties of Quick Sections and Profiles” in this chapter.
- Close the window and redisplay it later. For more information, see “Closing the Section Window” and “Redisplaying Quick Sections in the Section Window” in this chapter.
- Save the cross section view as a Windows metafile. For more information, see “Saving Quick Surface Sections and Profiles as Windows Metafiles” in this chapter.
- Copy the cross section to the clipboard to paste into your drawing files. For more information, see “Copying Quick Sections to the Clipboard” in this chapter.
- Grip edit the section line to display a different cross section in the same window. For more information, see “Grip Editing Quick Section Lines” in this chapter.
- Edit the surface, and then run the Update Section View command, which refreshes the view(s) in the cross section window(s). For more information, see the following section, “Updating Quick Surface Sections and Profiles.”
- View the cross section statistics. For more information, see “Viewing the Statistics of Quick Sections and Profiles” in this chapter.
- Use the EXPLODE command to explode the section line to a 3D polyline that you can save with the drawing.

### Updating Quick Surface Sections and Profiles

You can update a quick cross section after editing the surface.

**To update a cross section**

- From the Terrain menu, choose Sections ➤ Update Section Views.

All quick sections are automatically updated with any edits that you made to the surface.

**NOTE** The section window need not be visible to update the section.
Saving Quick Surface Sections and Profiles as Windows Metafiles

You can save a cross section view as a Windows metafile. This is a common image format that you can insert into many different applications.

To save a cross section view as a Windows metafile
1. Use the Create Section View command to create a cross section. For more information, see “Creating Quick Surface Sections and Profiles” in this chapter.
2. From the Section menu in the cross section window, choose Save As to display the Save As dialog box.
3. Choose a location in which to save the file.
4. In the File Name box, type a name for the file.
5. Click Save to save the file.

Copying Quick Sections to the Clipboard

You can copy a cross section to the clipboard to paste into either an AutoCAD drawing or another application.

To copy a cross section to the clipboard
1. Use the Create Section View command to display a cross section.
2. From the Section menu in the cross section window, choose Edit.
3. Paste the cross section into AutoCAD or another application.

Closing the Section Window

To close a cross section window
1. Right-click on the title bar of the cross section window to display the shortcut menu.
2. Select Close to close the section window.

Redisplaying Quick Sections in the Section Window

If you close the section window, then you can redisplay the cross section window.

To redisplay a cross section
1. Click on the cross section line that you drew on the surface.
2. Right-click to display the shortcut menu.
3. Click View Section.
Changing the Properties of Quick Sections and Profiles

You can change both the grid settings and the color settings of the quick cross sections in your drawing.

To change the cross section properties

1. Create a quick cross section. For more information, see “Creating Quick Surface Sections and Profiles” in this chapter.
2. From the Section menu in the cross section window, choose View Properties to display the Quick Section Properties dialog box.
3. Click the Grid Settings tab.

You can modify the following settings:

- **Vertical Factor**: Changes the vertical exaggeration of the cross section. By default, the section displayed in this window uses the current ratio of horizontal to vertical scale for the drawing that you set in the Drawing Setup dialog box.
- **Number of Tick Marks**: Changes the number of tick marks displayed along the elevation axis of the cross section window.
- **Minimum Interval Increment**: Specifies what elevational change each tick mark along the elevation axis represents. For example, an interval increment of 10 causes each tick mark to represent an elevational change of 10 units. A value of 0 represents no minimum. Set the spacing based on both the elevation range of the section and number of tick marks set.
4 Click the Color Settings tab to change the colors of the line color, grid color, text color, or background color that are shown in the Section window.

To change the color of a cross section window component, click the color box next to a component to display the Select Color dialog box. Select a color and click OK.

**NOTE**
If elevation labels start to overlap on the section view, then they are removed. To see this behavior, slowly make the window smaller and watch the text.

**Viewing the Statistics of Quick Sections and Profiles**
You can view the statistics of a quick cross section.

**To view the cross section statistics**
1 Create a quick cross section.
2 From the surface, click the section line to display the grips.
3 Right-click to display the shortcut menu.
4 Click Properties to display the Section Properties dialog box.
Click the Statistics tab to view the cross section statistics.

**NOTE** You can change the color of the cross section line by clicking the Color tab.

Click OK.

### Changing the Color of Quick Section Lines

To change the color of the cross section line

1. Create a quick cross section. For more information, see “Creating Quick Surface Sections and Profiles” in this chapter.
2. From the surface, click the section line to display the grips.
3. Right-click to display the shortcut menu.
4. Select Properties to display the Section Properties dialog box.
5. Click the Color tab.

6. Click the Color box to display the Select Color dialog box.
7. Select a color.
8. Click OK to return to the Section Properties dialog box.
9. Click OK to end the command.
Grip Editing Quick Section Lines
To edit a quick cross section so that it displays a different surface view, you can edit the section line using grips.

To grip edit a cross section line
1. Click a cross section line to display the grips.
2. Select the grip you want to move.
3. Drag it to the new location.
   The cross section in the section window is updated automatically.

Exploding Quick Section Lines into Polylines
You can explode a cross section line into a 3D polyline that follows the elevations of the surface.

To explode a cross section line
1. Create a quick cross section. For more information, see “Creating Quick Surface Sections and Profiles” in this chapter.
2. Click on the cross section line.
3. Right-click to display the shortcut menu.
4. Select Explode.
   The cross section line is converted to a 3D polyline that is saved with the drawing.
Calculating Volumes

The Volumes menu provides commands to define the site for volume calculations and compute the volume between two surfaces using one of the three methods of calculation: grid, composite surface, and section methods. Before running most Volume commands, you must select a current stratum.

Using the Volume Reports command, you can report total volume data for a site, create an ASCII file of total site volume data, and create a parcel volume table.
Using Volume Calculation Methods

AutoCAD Land Development Desktop provides three volume calculation methods that you can use to calculate volumes between two surfaces: Grid, Composite, and Section. For more information about each type of volume calculation method, see “Volume Calculation Methods” in the following section.

All methods use a stratum to define which two surfaces to calculate volumes from. All methods also require a site. A site defines the area inclusive of the stratum to calculate volumes from. It also defines grid spacing for volume calculations.

After you calculate total site volumes using either the Grid or Composite methods, you can calculate parcel volumes. To calculate parcel volumes, valid parcels must be defined in the project.

Volume Calculation Methods

AutoCAD Land Development Desktop provides three methods for performing volume calculations: Grid, Composite Surface, and Section (which can be done with both the Average End and Prismoidal methods).

Both the Grid and Section methods are approximations controlled by the grid spacing. Therefore, varying results may occur if the surfaces are either not sampled often enough or are sparsely populated with data. We recommend that when you use grid-based and average-end area (section) volumes, you make sure the grid spacing is not too small as to sample too often, and not too large as to result in an imprecise volume estimate. In any case, use all three volume calculation types (including different scenarios for each volume type) as redundancy checks. Use your own judgment when deciding which result is appropriate for the site.

The Grid and Composite Volume methods create volume surfaces that represent the depth of cut and fill. Any command that generates information based on a surface can be used with the volume surface. You can, for example, create contours or points based on depth of cut and fill. Volume surfaces are displayed in the Terrain Model Explorer.

Using the Grid Method

The Grid method calculates volumes using a grid overlaid on the two surfaces that comprise the current stratum. This method calculates the volumes by using the prismatic volume of all grids and summarizing. This method is most accurate when the grid spacing is less than the average surface data spacing.
The Grid method breaks the site into a series of grid cells in rows and columns that are determined by the Define Site command. For more information, see “Defining a Site for Volume Calculations” in this chapter. The Grid method uses the M and N size that you specify when you define the site to determine the dimensions of the grid cells. The Grid method samples the elevations of the existing and proposed surfaces at the corners (or grid nodes) of each cell. It then breaks the resulting face into two triangular prisms. If any corner of the cell falls outside of the surfaces, then the entire cell area is discarded. The cells are then split into individual prismoidal objects.

The Grid method uses approximations controlled by the grid spacing. When you use grid-based volumes, make sure the grid spacing is not too large, which might result in imprecise volume estimates. In any case, you can use both the Grid and Composite Volume methods, and then decide which result is appropriate for the site.

**NOTE** You can import the cut and fill grid ticks to view the sampling locations for the grid volumes.

### Using the Composite Method

When you calculate the volumes using this method, instead of using a grid, the Composite Method re-triangulates a new surface based on points from both surfaces. It uses the points from both surfaces, as well as any location where the triangle edges between the two surfaces cross. The command then calculates the new composite surface elevations based on the difference between the elevations of the two surfaces.

This method is the most accurate, giving the exact volumes between the two surface definitions.
Using the Section Method

The Section method calculates cross sections from the two surfaces of the current stratum, and generates volumes using either of two methods: Prismsoidal or Average End Area. You can interpolate sections in either the M or N direction, with spacing based on the grid spacing of the defined site. You can then plot the sampled sections to verify the areas.

The following illustration shows the relationship of M and N to the AutoCAD X and Y axes in the Average End Area grid lines:

The command defines each section line in the direction sampled to be a station. For example, if the grid is designed to use a cell width of 20 units, then each station is 20 units apart. The first section is always station 0+00 (0+000 in metric units). The fourth section would be assigned a station value of 0+60 (0+060 in metric units).

As each section is sampled, the command calculates the offset and elevation for each triangle edge that the section crosses on the surfaces. The offsets are always positive, and calculated from left to right along the section line in the direction of station progression. Each station (section) usually has several offsets and elevations.
The following illustration shows this relationship:

After the sections are sampled, the command uses either the Average End Area or Prismoidal method to calculate the volumes for the site. The following illustration shows the Average End Area method:

The Prismoidal method is similar to the Grid method. However, the Prismoidal method used for section volumes calculates the prismoidal objects between sections rather than between surfaces.
Using a Stratum for Volume Calculations

Using the Select Current Stratum command on the Terrain menu, you can define, select, and delete a stratum in your drawing. A stratum consists of the two surfaces that are used for calculating volumes.

**Stratum**

A stratum contains two surfaces that exist in your project, usually the existing ground surface and a finished ground surface, and is used for calculating volumes. The following illustration shows a sample stratum:

You can also define multiple strata with various types of combinations. When you calculate volumes, you are prompted for the stratum to be used for those computations.
**Defining a Stratum**

You can define a stratum to use for calculating volumes.

**To define a stratum**

1. From the Terrain menu, choose Select Current Stratum.

If you haven’t defined a stratum, then the Define Stratum dialog box is displayed:

![Define Stratum Dialog Box]

If you have already defined a stratum, then the Select Current Stratum dialog box is displayed. Click the New button to display the Define Stratum dialog box.

2. In the Name box, type the name of the new stratum.
3. In the Description edit box, type the description.
4. Select the two surfaces that will make up the stratum. The order of these surfaces is important. For volume calculation purposes, Surface 1 is the existing ground surface and Surface 2 is the proposed surface. To select the two surfaces that will make up the stratum, you can:
   - Type the names of the surfaces in the Surface 1 and Surface 2 boxes.
   - Click the Select button to display the Select Surface dialog box, where you can select the surfaces to use.
5. Click OK to define the stratum.

**Selecting the Current Stratum**

You can select the current stratum to work with.

**To select a stratum to work with**

1. From the Terrain menu, choose Select Current Stratum to display the Select Current Stratum dialog box.
2. From the Selection list box, select the stratum to use.
3. Click OK.
Deleting a Stratum

You can delete a stratum from your project.

To delete a stratum
1. From the Terrain menu, choose Select Current Stratum to display the Select Current Stratum dialog box.
2. From the Selection list box, select the stratum to delete.
3. Click the Delete button.
   The following warning message is displayed:

   ![Warning dialog box]

   4. Click Yes or No:
      - Click Yes to delete the stratum.
      - Click No to save the stratum.

4. Click OK to exit the Select Current Stratum dialog box.

Using Sites for Volume Calculations

To calculate volumes, you must define a site. A site controls both the area on the stratum for which you want to calculate volumes, and the grid spacing which is used for both the Grid and Section methods.

Changing the Volume Site Settings

You can control both how sites are labeled with volume information, and how grid cells for volume calculations are defined.

To change the volume site settings
1. Do one of the following to display the Volume Site Settings dialog box:
   - From the Terrain menu, choose Site Definition ➤ Site Settings.
From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Volume Site Definitions and click the Edit Settings button.

The first two parts of the dialog box, the M Direction and N Direction sections, control the grid cell definition for creating sites. You must set these settings before defining a site.

2 Under the M (x) Direction, define the grid parameters for the M direction. If the rotation angle on the grid is 0.0, then M corresponds to the X direction. When you define a site for volume calculations, the values you set here for the M Direction are the defaults.

3 Determine how to size the grid by selecting either the Size or Number option. If you select Size, then the number you type in the Value box is the length of the cell in the M direction. If you select Number, then the number you type in the Value box is the number of cells in the M direction.

4 Under N (y) Direction, define the grid parameters for the N direction. If the rotation angle on the grid is 0.0, then N corresponds to the Y direction. When you define a site for volume calculations, the values you set here for the N Direction are the defaults.

For information about these options, see step 3.

**NOTE**

The Grid method for calculating volumes is an approximation controlled by the grid spacing. When you use grid-based volumes, make sure the grid spacing is not too large, which might result in an imprecise volume estimate.

The next sections of the dialog box control how the sites are labeled when you import them into the drawing with the Site Manager command. For more information, see “Managing Site Definitions” in this chapter.
5 Under Site Labeling, type a text style to use for the labels in the Text Style box. Or, click Select and select a text style to use, and click OK to return to the Site Settings dialog box.

NOTE If you use metric units, then only metric styles, plus Standard, Dimtext, and Ashade are displayed. If you use English units, then only English styles plus Standard and Dimtext are displayed.

6 Under Volume Labeling, set the precision, text style, and suffix for volume labels:
   ■ **Text style**: Type the text style used for volume labeling. Or, click Select and select a text style to use, and click OK to return to the Volume Site Settings dialog box.
   ■ **Suffix**: Type the suffix to use for volume labeling, such as yards or meters.
   ■ **Precision**: Type the precision for labeling volumes, or use the slider to adjust the value. This precision value affects only the display of the volume labels.

7 In the Site layer edit box, type the layer for the site lines and labels.

8 Select the Automatic Label Placement check box to place site labels automatically as they are imported.

9 Click OK.

### Defining a Site for Volume Calculations

To calculate volumes, you must define the area that will be used in the volume calculations. This area is called a site, which you can define using grid cells. The site definition is stored in the control file, `{project}.gcf`. This file also holds any parcel definitions for the project and all the volume calculations.

**To define a site**

1 Define a stratum. For more information, see “Defining a Stratum” in this chapter.

2 In the Volume Site Settings dialog box, set the M Direction and N Direction parameters. For more information, see “Changing the Volume Site Settings” in this chapter.

3 From the Terrain menu, choose Site Definition ➤ Define Site.

   The following prompt is displayed:
   
   **Rotation angle <0d0'0">:**

4 To define the rotation angle of the grid, do one of the following:
   ■ Press ENTER to place the grid cells at zero rotation.
   ■ Type another rotation angle in the format specified.
   ■ Select two points to define the angle.

   You can use a rotation angle for any site that is not positioned horizontally. For example, if a site has contours that run at approximately 30 degrees, you can rotate the grid accordingly.

5 Select the site base point. This is the lower-left corner of the grid.

6 Define the Grid M size and Grid N size, or the Grid M number and Grid N number if you want to use values other than the defaults you selected in the Site Settings dialog box.
If you define the grid by size, type the size of the cells in the M and N directions at the following prompts:

**Grid M size:**
**Grid N size:**

Generally, the Grid M and Grid N size can be related to the density of data on the surfaces. If surface points are, on average, 50 units apart, then the grid cells should be no larger than 50 units square, or an M size of 50 and a N size of 50, to generate accurate volumes.

If you define the grid cells by number, then type the number of cells in the M and N directions at the following prompts:

**Grid M number:**
**Grid N number:**

The grid cells are sized according to the number of rows and columns specified by the M and N numbers, and the size of the site.

The following illustration features grid cells as defined by number:

![Grid cells defined by number]

**NOTE**
A large grid cell size can adversely affect the grid or average end area section volumes.

7 Select the upper-right corner of the site. This corner must be in the rotated first quadrant with respect to the base point. If this corner is not selected in the correct location, then an error message is displayed and you have to repeat steps 4–7.

8 The command draws outlines to demonstrate both the extents of the site and the size of the grid cell. The following prompt is displayed:

`Change the size or rotation of the grid/grid squares (Yes/No) <No>:`

9 Do one of the following:

- Press ENTER to continue.
- Type Yes to change the rotation angle, base point, Grid M and Grid N values, and/or upper-right corner of the grid.

The following prompt is displayed:

`Erase old site outline (Yes/No) <Yes>:`
10 Type Yes or No:
- Type Yes to erase the old site outline.
- Type No to continue.

11 Type the name for the site. The site name can be up to 30 characters.

**NOTE** If an existing site has the same name, you are prompted either to change the name or overwrite the existing site. The command then defines the grid and either creates the control file or appends the new information to an existing file. If you delete the control file or remove the site definition, then you must recreate the site definitions and volumes.

The following illustration shows the site definition parameters:

![Site definition parameters](image)

The following illustration shows a grid with unequal M and N sizes:

![Grid with unequal M and N values](image)
Managing Site Definitions

Use the Site Manager to report data about sites, delete sites, and import sites that are defined in the project into the drawing.

Reporting Site Information

You can output the site definition details, such as the rotation angle, grid M and grid N values, and the lower-left and upper-right corners of the site.

To report site information

1. From the Terrain menu, choose Site Definition ➤ Site Manager to display the Site Manager dialog box.

2. Click the Output Settings button to display the Output Settings dialog box where you can select output options. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”

3. Click OK to return to the Site Manager dialog box.

4. From the Select site list, select the sites to report. When you select a site, an asterisk (*) appears next to it.

   **TIP** You can click the Select All button to select all sites in the list, or click the Clear All button to clear the selection set.

5. Click the Info button to create the report.
The report is created as follows:

**Importing Sites into the Drawing**

If you delete the rectangle from your drawing that represents the site, or if you create a new drawing and want to import the site rectangle, then you can import the site into a drawing.

**To import a site**

1. Change the Volume Site Settings. For more information, see “Changing the Volume Site Settings” in this chapter.
2. From the Terrain menu, choose Site Definition ➤ Site Manager to display the Site Manager dialog box.
3. From the Select Site list, select the sites to import. When you select a site, an asterisk (*) appears next to it.

   **TIP** You can click the Select All button to select all sites in the list, or click the Clear All button to clear the selection set.

4. Click the Import button.

   A message dialog box is displayed.

5. Click Yes or No:
   - Click Yes to create site labels for the imported sites.
   - Click No if you do not want to label the sites.

6. If you click Yes, and you did not select the Automatic Label Placement check box in the setting, then select an insertion point for the label.

   The following prompt is displayed:

   Rotation angle <0d0°0”>:  

   ![Site Information](image)
To define the label rotation angle, use one of the following methods:

- Press ENTER to place the label at zero rotation.
- Type another rotation angle in the format specified.
- Select two points to define the angle.

**Deleting Sites from the Project**

You can delete a site from the project if it is no longer needed.

**To delete a site**
1. From the Terrain menu, choose Site Definition ➤ Site Manager to display the Site Manager dialog box.
2. From the Select Site list, select the sites to import. When you select a site, an asterisk (*) appears next to it.
   
   **TIP** You can click the Select All button to select all sites in the list, or click the Clear All button to clear the selection set.
3. Click the Delete button.
   A warning dialog box is displayed.
4. Click Yes or No:
   - Click Yes to delete the sites.
   - Click No to keep the sites.

**Calculating Grid Volumes**

Use the Grid method to calculate volumes for a site and for parcels within the area of that site. The Grid method requires both a stratum and a site. For more information, see “Using the Grid Method” in this chapter.

**Changing the Grid Volume Settings**

To calculate the volume of a differential grid surface, you need to set the grid volumes settings.

**To change the grid volumes settings**
1. From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box.
2. Under Program, select Land Development Desktop.
4 Click Edit Settings to display the Grid Volume Settings dialog box.

![Grid Volume Settings dialog box]

5 Under Elevation Tolerance, type a value in the Minimum difference edit box. The elevation tolerance factor determines how large a difference in elevation between two surfaces must exist in order to be included in volume calculations. The volume commands compare the two surfaces at each grid node. If the difference in elevation between the two surfaces is less than the elevation tolerance at a grid point, then it is considered to be 0.

For example, if the elevation tolerance factor is 0.5 units, then the calculations ignore any elevational difference between the two surfaces that is less than 0.5 units. The calculations include any elevational difference that is 0.5 units or greater.

6 Type a Cut factor and a Fill factor for the Grid Volumes Corrections values. These values compensate for expansion and compaction of the surface material, and help to determine the actual volume of material that needs to be removed (the cut factor) or added (the fill factor) to the site.

- **Cut factor**: Compensates for the expansion factor of the material left after the cut.
- **Fill factor**: Compensates for the compaction factor of the fill material.

For example, for a material that expands 15 percent, type the value 1.15. However, for a material that compacts to 93 percent of its original value, type 0.93. A factor of 1.00 does not adjust the volumes.

7 Under Grid Volumes Output, determine the type of output file that the Volume commands generate by selecting one of the following options:

- Select None if you do not want an external file to be written when grid volumes are calculated. Grid volume calculations are still written to the control file even when this option is selected.
- Select SDF (Space Delimited File) to output the grid volumes to an ASCII file that is broken down into columns. This file uses the output settings set in the Output Settings dialog box.
Calculating Grid Volumes

The following text illustrates an SDF file output:

---

**Project: EWTEST**  
**Fri Sept 24 07:43:44 1999**

**Grid Volumes**

<table>
<thead>
<tr>
<th>Surface 1</th>
<th>Surface 2</th>
<th>Prism 1</th>
<th>Prism 2</th>
<th>Cell Net Vol</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXIST</td>
<td>FG6</td>
<td>-257.3604</td>
<td>-288.1221</td>
<td>-545.4825</td>
</tr>
<tr>
<td>1 1</td>
<td>-379.1143</td>
<td>-398.1256</td>
<td>-777.2399</td>
<td></td>
</tr>
<tr>
<td>1 3</td>
<td>-450.3528</td>
<td>-460.0470</td>
<td>-910.3997</td>
<td></td>
</tr>
<tr>
<td>1 4</td>
<td>-465.2367</td>
<td>-453.8010</td>
<td>-919.0377</td>
<td></td>
</tr>
</tbody>
</table>

---

CDF (Comma Delimited File): To output the grid volumes to an ASCII file that is separated by commas. This format has no headers. The following text illustrates a CDF file:

```
1,1,-257.360437,-288.122104,-545.482540
1,2,-379.114264,-398.125601,-777.239865
1,3,-450.352769,-460.046952,-910.399720
1,4,-465.236693,-453.801041,-919.037735
```

---

8 Click OK.

**Calculating Total Site Volumes Using the Grid Method**

You can calculate the total site volume using the Grid method.

1 Define a stratum. For more information, see “Defining a Stratum” in this chapter.
2 Define a site. For more information, see “Defining a Site for Volume Calculations” in this chapter.
3 From the Terrain menu, choose Grid Volumes ➤ Calculate Total Site Volume.

**NOTE** If you haven’t selected a current surface or stratum, the Select Current Stratum dialog box displays. Select the surface or stratum and click OK.

The Site Volume Librarian dialog box is displayed:
4 Select the site for which you want to calculate volumes.
5 Click OK.
   The command derives a volume by computing the prismoidal volume of each
   face on the grid surface, and displays the Grid Volume Settings dialog box.
6 You can change the Grid Volume Settings. For more information, see “Changing
   the Grid Volume Settings” in this chapter.
7 Click OK.
   The Volume Results Surface dialog box is displayed:

   ![Volume Results Surface dialog box]

8 In the New Surface box, type a name for the grid volume surface.
   
   **NOTE** If you have already built a grid volume surface for the current stratum
   and site, the program prompts you to use the name of the new surface
   and overwrite the existing surface. If you click NO, the program prompts
   you for a new surface name. If you give the name of another existing
   surface, you are prompted to overwrite that surface. If you click NO, the
   prompt for a new name is repeated until you specify a valid surface name
   that is either new, or existing that you want to overwrite.
9 Click OK.
   The volumes are calculated, and the volume surface is added to the Terrain
   Model Explorer.

**Calculating Parcel Volumes Using the Grid Method**

After you calculate the total site volumes, you can calculate the cut and fill
volumes of selected parcels.

**To calculate parcel volumes**

1 Calculate the total site volume using the Calculate Total Site Volume method. For
   more information, see “Calculating Total Site Volumes Using the Grid Method”
   in this chapter.
2 Define at least one parcel.
3 From the Terrain menu, choose Grid Volumes ➤ Calculate Parcel Volumes.
   If you haven’t selected the current stratum and surface, then you are prompted to
do so. The Site Volume Librarian dialog box is displayed.
4 Select the site for which you want to calculate parcel volumes.
5 Click OK to display the Parcel Volume Librarian dialog box.

![Parcel Volume Librarian dialog box]

6 Choose the parcel name(s) to calculate volumes for.

7 Click OK.

The command processes each parcel, performs the volume calculations, and displays the status for the net cut and fill volumes.

**Creating a Grid of Ticks That Shows Cut and Fill Areas on Volume Surfaces**

Based on the grid surface definition, you can insert labels and tick marks that show the elevations of grid volume surfaces, and whether each node is in a cut or fill situation.

The following illustration features a site with tick marks and labels:

![Tick marks and labels for a site]
To create a grid of ticks that shows cut and fill areas

1 Calculate site volumes using the Grid method. For more information, see “Calculating Total Site Volumes Using the Grid Method” in this chapter.
2 From the Terrain menu, choose Grid Volumes ➤ Grid Volume Ticks to display the Site Librarian dialog box.
3 Select the site on which to create the grid ticks.
4 Click OK to display the Grid Volume Ticks dialog box.

<table>
<thead>
<tr>
<th>Grid Volume Ticks</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Grid Volume Ticks dialog box" /></td>
</tr>
</tbody>
</table>

5 Select the Create Tick Marks check box to create tick marks over the site. The command inserts two different blocks as tick marks. Fill situations are shown with a plus sign (+), cut situations with a minus sign (-).

6 Type a tick interval value to control the frequency of the tick marks. For example, a 1 signifies that each grid point in the surface is marked with a tick mark, a 2 places a tick mark on every other point on the grid, and so on.

7 Type a tick size.

8 Type a Cut Tick Layer name. The cut tick block, a minus sign (-), is placed on this layer.

9 Type a Fill Tick Layer name. The fill tick block, a plus sign (+), is placed on this layer.

10 Select the Create Labels check box to create tick labels for the site.

11 Type a Label Interval value to control the frequency of the labels. For example, a 1 signifies that each grid point is marked with a label, a 2 places a label on every other point on the grid, and so on.

12 Type a Label Size.

13 Type a Label Precision or use the slider to set the precision.

14 Type a Cut Label Layer name.

15 Type a Fill Label Layer name.
16 Under Label Position, select one of the following options to control where the label is placed in relation to the tick mark:
- **Center**: Places the label centered on the tick mark.
- **Right**: Places the label to the right of the tick mark.
- **Left**: Places the label to the left of the tick mark.
- **Top**: Places the label above the tick mark.
- **Bottom**: Places the label below the tick mark.

17 Click OK to exit the dialog box.

The following prompt is displayed:

Erase old grid ticks (Yes/No) <Yes>:

18 Type **Yes** or **No**:
- Type **Yes** to erase any existing tick marks.
- Type **No** to keep any existing tick marks.

The command places tick marks and labels representing the difference in elevation between the two surfaces. A negative number represents a cut area, a positive number a fill area.

**TIP** You may want to assign the cut and fill tick marks and label layers different colors in order to more clearly show the specific areas of cut and fill.

---

**Calculating Composite Volumes**

Use the Composite method to calculate volumes both for a defined stratum and parcels within the area of that stratum. For more information about the composite method, see “Using the Composite Method” in this chapter.

**Changing the Composite Volume Settings**

To calculate the volume of a differential composite surface, you need to set the Composite Volumes settings.

**To change the Composite Volumes settings**

1 Do one of the following to display the Composite Volume Settings dialog box:
- From the Terrain menu, choose Composite Volumes ➤ Calculate Total Site Volume to display the Site Volume Librarian dialog box. From the list box, select a site and click OK.
From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Composite Volumes and click the Edit Settings button.

2. Under Elevation Tolerance, type a value in the Minimum difference box. The elevation tolerance factor determines how large a difference in elevation between two surfaces must exist in order to be included in volume calculations. For example, if the elevation tolerance is 0.5 units, then the calculations ignore any elevational difference between the two surfaces that is less than 0.5 units. The calculations include any elevational difference that is 0.5 units or greater.

3. Type a cut factor and a fill factor for the Composite Volumes Corrections values. These values compensate for expansion and compaction of the surface material, and help to determine the actual volume of material that needs to be removed (the cut factor) or added (the fill factor) to the site.

- **Cut factor**: Compensates for the expansion factor of the material left after the cut.
- **Fill factor**: Compensates for the compaction factor of the fill material.

For example, for a material that expands 15 percent, type the value 1.15. However, for a material that compacts to 93 percent of its original value, type 0.93. A factor of 1.00 does not adjust the volumes.

4. Click OK.

**Calculating Total Site Volumes Using the Composite Method**

You can calculate the total surface volume using the Composite method. For more information about the composite method, see “Using the Composite Method” in this chapter.

**To calculate the total surface volumes**

1. Define a site. For more information, see “Defining a Site for Volume Calculations” in this chapter.

2. Define a stratum. For more information, see “Defining a Stratum” in this chapter.

3. From the Terrain menu, choose Composite Volumes ➤ Calculate Total Site Volume.
NOTE If you haven’t selected a current surface or stratum, the command prompts you to do so.

4 Select the site for which you want to calculate volumes.
5 Click OK to display the Composite Volume Settings dialog box.
6 Change the Composite Volume Settings if needed. For more information, see “Changing the Composite Volume Settings” in this chapter.
7 Click OK to display the Volume Results Surface dialog box.

8 Type a new composite volume surface name.

NOTE If you have already built a composite volume surface for the current stratum and site, the program prompts you to use the name of the new surface and overwrite the existing surface. If you click NO, the program prompts you for a new surface name. If you give the name of another existing surface, you are prompted to overwrite that surface. If you click NO, the prompt for a new name is repeated until you specify a valid surface name that is either new, or existing that you want to overwrite.

9 Click OK.

The volumes are calculated and the volume surface is added to the Terrain Model Explorer.

**Calculating Parcel Volumes Using the Composite Method**

After you calculate the total site volumes, you can calculate the cut and fill volumes of selected parcels.

**To calculate parcel volumes**

1 Calculate the total site volume using the Calculate Total Site Volume command. For more information, see “Calculating Total Site Volumes Using the Composite Method” in this chapter.
2 Define at least one parcel.
3 From the Terrain menu, choose Composite Volumes ➤ Calculate Parcel Volumes.
If you haven’t selected the current stratum and surface, then you are prompted to do so.

The Site Volume Librarian dialog box is displayed:

4 Select the site for which you want to calculate parcel volumes.
5 Click OK to display the Parcel Volume Librarian dialog box.

6 Choose the parcel name(s) for which to calculate volumes.
7 Click OK.

The command processes each parcel, performs the volume calculations, and displays the status for the net cut and fill volumes.
Calculating Section Volumes

Use the Section method to calculate volumes for a site. The Section method requires both a stratum and a site. Calculating volumes using the Section method is a two-step process. First, you must sample the sections along the surfaces in the stratum. Then you must calculate the section volume total. You cannot calculate parcel volumes using the Section method. For more information about the Section method, see “Using the Section Method” in this chapter.

Changing the Section Volume Settings

You can change the settings for sampling section data for section volume calculations.

To change the section volume settings

1. Do one of the following to display the Section Volume Settings dialog box:
   - From the Terrain menu, choose Section Volumes ➤ Sample Sections to display the Site Volume Librarian dialog box. From the list box, select a site and click OK.
   - From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. Under Settings, select Section Volumes. Click the Edit Settings button to display the Section Volume Settings dialog box.

2. Select which type of volume calculation you want to perform: Average end area or Prismoidal. For more information, see “Using the Section Method” in this chapter.

3. Select the direction in which you want to sample the site for cross sectional volume calculations:
   - M (x): Sample sites along the M axis.
   - N (y): Sample sites along the N axis.

The Sample Sections command uses the site grid to determine the points to sample. If the grid is sampled in the M direction, then each section line in the M direction is considered a station.
4 Under Volume Corrections, specify the expansion and compaction factors that you want to apply to the volume calculations:

- **Cut factor**: Helps determine the actual volume of material that needs to be removed from the site. This value compensates for the expansion factor of the material left after the cut.
- **Fill factor**: Helps determine the actual volume of material that needs to be added to the site. This value compensates for the compaction factor of the fill material.

**NOTE**
For a material that expands 15 percent, enter the value 1.15. For a material that compacts to 93 percent of its original value, enter 0.93. A factor of 1.00 does not adjust the volumes.

5 Click OK.

**Using the Prismsoidal Volume Calculation Method**

The Prismsoidal method for calculating section volumes is also called the Grid method. When using this method, a regular grid is overlaid on the two surfaces. The elevations on both surfaces are calculated at each grid intersection. The resulting face is then broken into two triangular prisms.

The following formula is used when you select the Prismsoidal Volume Calculation method:

\[
V = \frac{L}{3} \left( A_1 + \sqrt{A_1 \cdot A_2} + A_2 \right)
\]

where:
- \( V \): Volume
- \( L \): Length (Distance between sections)
- \( A_1 \): First end area
- \( A_2 \): Second end area

**Using the Average End Area Volume Calculation Method**

The Average End Area method is the most common method of calculating volumes. The average of adjacent cross section areas is multiplied by the distance between them.
Calculating Section Volumes

The following formula is used when you select the Average End Area volume calculation method:

\[ V = \frac{L}{2} (A_1 + A_2) \]

where:

- \( V \): Volume
- \( L \): Length (Distance between sections)
- \( A_1 \): Area of section 1
- \( A_2 \): Area of section 2

**Sampling Section Data for Volume Calculations**

You can calculate volumes based on sampled cross sections, using average end or prismoidal methods of calculation. Use the Sample Sections command to sample and retrieve elevations from the triangulation data on the surface to calculate section volumes.

**To sample section data for volume calculations**

1. From the Terrain menu, choose Section Volumes ➤ Sample Sections.
   - If you haven’t selected a current stratum, then the Select Current Stratum dialog box is displayed. Select the stratum to use for volume calculations and click OK.
   - The Site Volume Librarian dialog box is displayed.
2. Select the site to use for volume calculations and click OK.
   - The Section Volume Settings dialog box is displayed.
3. Set the section settings. For more information, see “Changing the Section Volume Settings” in this chapter.
4. Click OK to sample the sections.

The command uses the site grid to determine the points to sample. If the grid is sampled in the M direction, then each section line in the M direction is considered a station. Station numbers refer to the section line sampled. Station numbers start at 0+00 (0+000 in metric units) and are assigned based on the grid cell width. For example, if the grid cells are 20 units in width, then the fourth grid sampled has a station value of 0+60 (0+060 in metric units).

The command then samples along each section, calculating elevations at each point where a TIN line crosses the section line. These points are considered offsets. The offsets are always positive, and calculated from left to right along the station line in the direction of station progression. You can view or edit the station and offset information for the sections using the Edit Sections command. For more information, see “Editing Sampled Section Data for Volume Calculations” in this chapter.
Editing Sampled Section Data for Volume Calculations

You can edit cross sections that you sampled for a site using the Sample Sections command. You can edit offset, elevation, and grade information for individual stations.

To edit sampled cross section information

1. From the Terrain menu, choose Section Volumes ➤ Edit Sections to display the Site Volume Librarian dialog box.
2. Select the site from which you calculated the section information.

   **NOTE** Unlike multiple grid/composite surfaces, each site can have only one set of section volume data.

3. Click OK.

   The Existing Ground Section Editor dialog box is displayed. The current surface and station are listed at the top.

4. To select a different surface to edit, click the Select Surface button and select another surface, and then click OK to return to the Existing Ground Section Editor dialog box.

---

Chapter 35  Calculating Volumes
742
To select a different station to edit, click any of the following buttons:

- **Previous**: Moves to the previous station on the surface.
- **Next**: Moves to the next station on the surface.
- **Select**: Displays a dialog box to select the station to move to.

**NOTE**
For more information on how stations are numbered, see “Sampling Section Data for Volume Calculations” in this chapter.

The offset, elevation, and grade of the selected station, as well as buttons to move through the information, are displayed in the dialog box. Click any of the following buttons to view more information about a station:

- **Home**: Moves the cursor to the first page of the current station’s information.
- **Page Up**: Moves up one page at a time.
- **Up**: Moves up one line at a time.
- **Down**: Moves down one line at a time.
- **Page Down**: Moves down one page at a time.
- **End**: Moves to the final page of the current station’s information.

You can insert and delete offsets, stations, and surfaces using the following buttons:

- **Insert Offset**: Inserts an offset where the cursor is positioned.
- **Delete Offset**: Deletes the offset where the cursor is positioned.
- **Insert Station**: Displays the Station Entity dialog box. Type the required station, and then click OK to return to the Existing Ground Section Editor dialog box.
- **Delete Station**: Deletes the current station.
- **Insert Surface**: Sets a new surface current in the Existing Ground Section Editor dialog box. This surface name is unique to the section volumes data file.
- **Delete Surface**: Permanently removes the current station’s surface data from the Existing Ground Section Editor dialog box.

Click OK.

**Calculating Total Site Volumes Using the Section Method**

You can calculate the total volume for a site using the Section method. You can use this command as an alternative to the Volume Report command for section volume processing, but it does not write information to a file.

**To calculate total site volumes**

1. Sample the site information. For more information, see “Sampling Section Data For Volume Calculations” in this chapter.
2. From the Terrain menu, choose Section Volumes ➤ Calculate Volume Total to display the Site Librarian dialog box.
3 Choose the site from which you calculated the section information.
4 Click OK.

The Section Volumes Settings dialog box is displayed:

5 Choose which type of volume calculation you want to perform: Average end area or Prismoidal.
6 Choose the direction in which you want to sample the site for cross sectional volume calculations:
   - M (x): Samples sites along the M axis.
   - N (y): Samples sites along the N axis.

The Sample Sections command uses the site grid to determine the points to sample. If the grid is sampled in the M direction, then each section line in the M direction is considered a station.

7 Specify the expansion and compaction factors that you want to apply to the volume calculations:
   - Cut factor: Helps determine the actual volume of material that needs to be removed from the site. This value compensates for the expansion factor of the material left after the cut.
   - Fill factor: Helps determine the actual volume of material that needs to be added to the site. This value compensates for the compaction factor of the fill material.

   **NOTE** For a material that expands 15 percent, enter the value 1.15. For a material that compacts to 93 percent of its original value, enter 0.93. A factor of 1.00 does not adjust the volumes.

8 Click OK.

The command processes the volumes and displays the total cut, fill, and net volumes for the processed site.
9 Press any key to continue.
Reporting Section Volume Data

You can write section volume data to an ASCII text file.

To write volume data to a text file
1 Sample the site information. For more information, see “Sampling Section Data for Volume Calculations” in this chapter.
2 From the Terrain menu, choose Section Volumes ➤ Volume Report to display the Site Librarian dialog box.
3 Select the site from which you calculated the cross section information.
4 Click OK.
   The Section Volumes Settings dialog box is displayed.
5 Set the volume calculation settings. For more information, see “Choosing Section Volume Settings” in this chapter.
6 Click OK.
7 Press any key to continue.
   The file lists the station cut and fill areas, station cut and fill volumes, station total volume, and the running mass ordinate.

Plotting Volume Sections

AutoCAD Land Development Desktop has commands that you can use to plot the sections from which the volumes were calculated. This lets you evaluate the surface data for any potential data errors.

You can plot sections by:
- Importing individual sections, in which the command prompts you for each station to plot.
- Importing all sections. The horizontal and vertical spacing of the page layout control how the sections appear on the screen.
- Importing sections page by page.

Changing the Section Volumes Plotting Settings

You can specify which elements of the volume sections to display, and the layers on which they are displayed when plotted.

NOTE The cross section output depends on the horizontal and vertical scale. These scales are set during the drawing setup.
To change the section volumes plotting settings

1. Do one of the following to display the Cross Section Plot Settings dialog box:
   - From the Terrain menu, choose Section Volumes ➤ Plot Settings.
   - From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Section Volume Plotting and click the Edit Settings button.

2. Select which elements you want to display on the plotted cross sections:
   - **Existing Ground**: Controls whether or not the existing ground surface is displayed.
   - **Grid**: Controls whether or not the cross section grid is displayed.
   - **Grid text**: Controls whether or not annotation text for the cross section is displayed.

3. You can accept the default layer names for each of plotted item, or type new layer names in the Layer boxes.

4. Set the Section Layout settings. For more information, see “Changing the Section Layout Settings for Plotting Section Volumes” in this chapter.

5. Set the Page Layout settings. For more information, see “Changing the Page Layout Settings for Plotting Section Volumes” in this chapter.

6. Click OK.

The following illustration features the parameters used in plotting section volumes:

![Parameters used in plotting section volumes](image)
Changing the Section Layout Settings for Plotting Section Volumes

You can control the factors that affect the plotting of individual site cross sections. These factors include grid and label increments.

To change the section layout settings for plotting section volumes

1. Do one of the following to display the Section Volume Plot Settings dialog box.
   - From the Terrain menu, choose Section Volumes ➤ Plot Settings.
   - From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Section Volume Plotting and click the Edit Settings button.

2. Click the Section Layout button to display the Section Layout dialog box.

3. Under Offset, change the following settings that affect the cross section grid that is overlaid on the cross section. Enter these increments in drawing units:
   - **Increment**: Determines the distance between the vertical lines on the grid.
   - **Label interval**: Determines which offset grid lines to label. If the label interval is one (1), then every grid line is labeled. If the label interval is two (2), then every other line is labeled.
   - **Label precision**: Determines the precision used to label the volume section offset grid lines.

4. Under Elevation, change the following settings:
   - **Increment**: Determines the distance between the horizontal lines on the grid.
   - **Label interval**: Determines which elevation grid lines to label. If the label interval is one (1), then every grid line is labeled. If the label interval is two (2), then every other line is labeled.
   - **Label precision**: Determines the precision used to label the volume section elevation grid lines.
The following illustration shows the offset and elevation increments:

<table>
<thead>
<tr>
<th>Offset and elevation increments for a section grid</th>
</tr>
</thead>
<tbody>
<tr>
<td>748.0</td>
</tr>
<tr>
<td>0</td>
</tr>
</tbody>
</table>

5. Under Section Height, specify how many extra grid cells are plotted with the cross section:
   - **Rows below datum**: Determines how many rows of grid cells to place below the datum.
   - **Rows above maximum**: Determines how many rows of grid cells to place above the highest point on the existing ground.

6. Click OK to return to the Cross Section Plotting Settings dialog box.

**Changing the Page Layout Settings for Plotting Section Volumes**

Use the Page Layout settings to determine the sheet size, margins, spacing, and number of vertical sheets that are used for the Plot Page and Plot All commands.

**To change the page layout settings for plotting section volumes**

1. Do one of the following to display the Section Volume Plot Settings dialog box:
   - From the Terrain menu, choose Section Volumes ➤ Plot Settings.
   - From the Projects menu, choose Drawing Settings to display the Edit Settings dialog box. Under Program, select Land Development Desktop. From the Settings list, select Section Volume Plotting and click the Edit Settings button.

2. Click the Page Layout button to display the Page Layout dialog box.
You can change the following settings:

- **Sheet height**: Determines the height of a page for cross sections in plotted units.
- **Sheet width**: Determines the width of a page for cross sections in plotted units.
- **Left margin**: Determines the distance between the left edge of the sheet and the border in plotted units.
- **Right margin**: Determines the distance between the right edge of the sheet and the border in plotted units. The right margin is a minimum. This value is keyed to the values entered for both the offset increment and elevation increment in the Section Layout settings.
- **Top margin**: Determines the distance between the top edge of the sheet and the border in plotted units. The top margin is a minimum. This value is keyed to the values entered for both the offset increment and elevation increment in the Section Layout settings.
- **Bottom margin**: Determines the distance between the bottom edge of the sheet and the border in plotted units.
- **Column spacing**: Determines the vertical spacing between sections. The column spacing is the number of cells placed horizontally between cross sections.
- **Row spacing**: Determines the horizontal spacing between sections. The row spacing is the number of cells placed vertically between the cross sections. The cell width depends on the offset increment. The cell height depends on the elevation increment. For example, if the offset increment is set to 10 and the column spacing to 4, then there are 40 units between columns of cross sections. The cell width is used to determine station numbering for section volume calculations.

Under Plotting of Multiple pages, change the following setting:

- **Maximum number of vertical pages**: Determines how many sheets are drawn in the vertical direction when the Multiple option of the Page command is used.

Click OK to return to the Cross Section Plot Settings dialog box.
Selecting the Text Size to Use for Plotted Volume Sections

You can select the text size to be used for the plotted section grid text.

To select the text size to use for plotted volume sections

1. From the Terrain menu, choose Section Volumes ➤ Set Text Style to display the Text Style dialog box.

   ![Text Style dialog box]

2. From the list boxes, select a text style and font to use. For more information about the Text Style dialog box, see “Creating and Modifying Text Styles” in the online Help.

3. Click OK.

Plotting a Single Volume Section

You can plot volume sections at specified stations into a drawing, one at a time.

To plot a single volume section

1. Change the section volumes plotting settings. For more information, see “Changing the Section Volumes Plotting Settings” in this chapter.

2. From the Terrain menu, choose Section Volumes ➤ Plot Single to display the Site Volume Librarian dialog box.

3. Choose the site from which you calculated the cross section information.

4. Click OK.

   The selected site is the only site processed. The command overwrites any existing section information for that site.

5. Type the station of the first section that you want to plot. The default is the first station in the sampled range. If the station entered in response to this prompt lies outside the range of sampled stations, then the command draws the cross section of the nearest station.
6 Select an insertion point for the section. This is the lower-left corner of the imported cross section. Both surfaces in the sampled stratum are shown.

7 You can plot additional sections, or press ENTER in response to the Station and Pick bottom insertion point prompts to end the command.

The following illustration features a single volume section:

---

**Plotting All Volume Sections for a Site**

You can plot all volume sections for a site. The command draws the cross sections in columns from bottom to top and left to right.

**To plot all sections for a site**

1 Change the section volume plotting settings. The Plot All command uses the sheet height from the plotting settings to determine the maximum height to plot the sections.

   For more information, see “Changing the Section Volume Plotting Settings” in this chapter.

2 From the Terrain menu, choose Section Volumes ➤ Plot All to display the Site Librarian dialog box.

3 Choose the site from which you calculated the cross section information.

4 Click OK.

   The selected site is the only site processed. The command overwrites any existing section information for that site.

5 Select the sheet origin point, or type X, Y coordinates.
The following illustration features volume sections imported with the Plot All command:

Imported volume sections

**Plotting a Page of Volume Sections**

You can process a range of volume sections related to a site, and then either plot them in the current drawing or export them to another drawing. The volume sections are drawn in columns from bottom to top and left to right.

**To plot a page of cross sections**

1. From the Terrain menu, choose Section Volume ➤ Plot Page to display the Site Librarian dialog box.
2. Choose the site from which you calculated the volume section information.
3. Click OK.
   
   The following prompt is displayed:

   `Page import type (Multiple/Single)<Single>:`

4. Type `Single` or `Multiple`:
   
   - Type `Single` to import a single page.
   - Type `Multiple` to import multiple pages.
   
   The following prompt is displayed:

   `Import sections into current drawing (Yes/No) <Yes>:`

5. Type `Yes` or `No`:
   
   - Type `Yes` to import the sections into the current drawing as objects. For more information, see “Importing Volume Sections into the Current Drawing” in this chapter.
   - Type `No` to import the sections into another drawing as objects. For more information, see “Importing Volume Sections into Another Drawing” in this chapter.
The following illustration features a single page of cross sections:

![Single page of volume sections](image)

The following illustration shows all the volume section pages imported:

![Imported volume section pages](image)

### Importing Volume Sections into the Current Drawing

**To import volume sections into the current drawing**

1. Complete steps 1–5 of “Plotting a Page of Volume Sections” in this chapter.
2. Type the station of the first section that you want to plot.
3. Select a sheet origin point (the lower-left corner of the sheet).
Importing Volume Sections into Another Drawing

To import volume sections into another drawing
1 Complete steps 1–5 of “Plotting a Page of Volume Sections” in this chapter.
2 Type a prefix for the drawing in which the volume sections will be plotted. The drawing prefix can have a maximum of five characters. The name of the drawing that is created is determined by the drawing prefix and the sheet number. For example, if the drawing prefix is Site1, and the first sheet number is 1, then the drawing containing the first sheet of volume sections is named Site1001.dwg.
3 Type the starting sheet number.
4 Type the station of the first section that you want to plot.
5 Select a sheet origin point (the lower-left corner of the sheet).
   An AutoCAD Map message box may display. This dialog box is displayed whenever an object is WBLOCKed from a drawing.
6 Click either button to continue.
   The drawing is saved to c:\Program Files\Land Desktop R2.

NOTE If there are any drawing objects within the sheet boundary, then they are also written out. The current view must encompass the entire sheet, or the option for plotting the sections to drawing files does not work.

Outputting Volume Data

After you calculate volumes using the Grid, Composite, or Section methods, you can either output the volume data to ASCII text files, or create volume tables to insert in the drawing.

Reporting Total Volume Data for a Site

You can display volume information for a site in a dialog box.

To report total volume data for a site
1 Change the Output Settings. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
2. From the Terrain menu, choose Volume Reports ➤ Site Report to display the Site Volume Corrections dialog box.

   ![Site Volume Corrections dialog box]

   This dialog box shows the corrections applied to the site volumes for the method used.

3. Type new correction factors if needed.
   - **Cut factor**: Helps determine the actual volume of material that needs to be removed from the site. This value compensates for the expansion factor of the material left after the cut.
   - **Fill factor**: Helps determine the actual volume of material that needs to be added to the site. This value compensates for the compaction factor of the fill material.

4. Click OK.

   If you selected the Screen check box in the Output Settings dialog box, then the command displays the Site Volumes dialog box. This dialog box displays the cut, fill, and total volumes.

---

**Creating a Total Volume Table for a Site**

You can create a table of volume data in the current drawing.

To create a total volume table for a site

1. From the Terrain menu, choose Volume Reports ➤ Site Table to display the Site Volume Corrections dialog box.

   This dialog box shows the corrections applied to the site volumes for the method used.
2 Type new correction factors if needed.

- **Cut factor**: Helps determine the actual volume of material that needs to be removed from the site. This value compensates for the expansion factor of the material left after the cut.
- **Fill factor**: Helps determine the actual volume of material that needs to be added to the site. This value compensates for the compaction factor of the fill material.

3 Click OK.

4 Select the insertion point for the table by either selecting a point or by specifying X, Y coordinates. This is the upper-left corner of the table.

5 Specify the rotation angle by typing a value or by either selecting two points to define the angle. The command then inserts a table on the current layer containing volume information. This information includes the site name, stratum name, surface names, total cut and fill volumes, net volume, units, and method used for each site.

The following illustration features a site volume table:

<table>
<thead>
<tr>
<th>Site</th>
<th>Stratum</th>
<th>Surf1</th>
<th>Surf2</th>
<th>Cut</th>
<th>Fill</th>
<th>Net</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>EW-99-1</td>
<td>PAV-1</td>
<td>FGD-1</td>
<td>3856.9</td>
<td>1083.5</td>
<td>2773.4</td>
<td>(C)</td>
<td>Grid</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3790.6</td>
<td>1107.0</td>
<td>2683.6</td>
<td>(C)</td>
<td>Sn Sub</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3639.2</td>
<td>1044.1</td>
<td>2795.1</td>
<td>(C)</td>
<td>End Area</td>
</tr>
<tr>
<td>EW-100-1</td>
<td>DRIVE-3</td>
<td>FGD-3</td>
<td>5532.8</td>
<td>6866.6</td>
<td>1336.8</td>
<td>(F)</td>
<td>Grid</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5400.5</td>
<td>7022.0</td>
<td>1620.5</td>
<td>(F)</td>
<td>Sn Sub</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5472.2</td>
<td>6972.9</td>
<td>1500.7</td>
<td>(F)</td>
<td>End Area</td>
</tr>
</tbody>
</table>

Site volume table
Creating an ASCII File of Total Volume Data for a Site

You can write site volume data to an ASCII text file.

To write site volume data to an ASCII text file

1. From the Terrain menu, choose Volume Reports ➤ Site ASCII File to display the Site Volume Corrections dialog box.

This dialog box shows the corrections applied to the site volumes for the method used.

2. Type new correction factors in the edit boxes if needed.

3. Click OK.

The Output Site Volumes File dialog box is displayed.

4. Specify the name of the file to which the site volume data should be written. The default file path is the current project folder.

The command then creates a comma (,) delimited ASCII file that includes the site name, stratum, top and bottom surface names, volume calculation method, cut and fill volumes, and net volume information.

Following is the basic format for the ASCII file:

site,stratum,surface1,surface2,method,cut volume,fill volume,net volume
**Reporting Parcel Volume Data**

You can report volume data for selected parcels in a dialog box.

**To report parcel volume data**

1. Change the Output Settings. For more information, see “Changing the Output Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
2. From the Terrain menu, choose Volume Reports ➤ Parcel Report to display the Parcel Librarian dialog box.
3. From the list box, select the parcel you want to report.
4. Click OK.
   
   The Parcel Volume Corrections dialog box is displayed. This dialog box shows the corrections applied to the parcel volumes for the method used.
5. Type new correction factors if needed.
6. Click OK.
   
   If you selected the Screen check box in the Output Settings dialog box, then the command displays the Parcel Volumes dialog box. This dialog box displays the cut, fill, and total volumes for the selected parcels.

**Creating a Parcel Volume Table**

You can create a table of parcel volume data in the current drawing.

**To create a parcel volume table**

1. From the Terrain menu, choose Volume Reports ➤ Parcel Table to display the Parcel Volume Librarian dialog box.
2. From the list box, select the parcels.
3. Click OK.
   
   The Parcel Volume Corrections dialog box is displayed. This dialog box shows the corrections applied to the parcel volumes for the method used.
4. Type new correction factors if needed.
5. Click OK.
6. Select the insertion point for the table by either selecting a point or by specifying X, Y coordinates. This is the upper-left corner of the table.
7. Specify the rotation angle by either typing a value or by selecting two points to define the angle.
   
   The command then inserts a table on the current layer containing volume information for the selected parcels. This information includes the parcel name, total cut and fill volumes, net volume, units, and the method used for each parcel.
Creating an ASCII File of Parcel Volume Data

You can write parcel volume data to an ASCII text file.

To write parcel volume data to an ASCII text file

1. From the Terrain menu, choose Volume Reports ➤ Parcel ASCII File to display the Parcel Volume Librarian dialog box.

2. From the list box, select the parcel(s) to which you want to write volume data to an ASCII text file.

3. Click OK.
   The Parcel Volume Corrections dialog box is displayed. This dialog box shows the corrections applied to the parcel volumes for the method used.

4. Type new correction factors if needed.

5. Click OK.
   The Output Parcel Volumes File dialog box is displayed.

6. Specify the name of the file to which the parcel volume information will be written. The default file path is the current project folder.

   The command creates a comma (,) delimited ASCII file including the parcel name, stratum, top and bottom surface names, volume calculation method, cut and fill volumes, and net volume information.

   Following is the basic format for the ASCII file:

   site,stratum,surface1,surface2,method,cut volume,fill volume,net volume
36

Managing Terrain Layers

The Terrain Layers commands help you manage layers in a drawing. Terrain layers include: surface, border, range, contour, 3D grid, polyline grid, 3D projection, water drop, site grid, and volume ticks.
Using the Layer Commands

AutoCAD Land Development Desktop has layer commands that you can use to quickly control terrain layers. The layer commands control layer visibility, such as whether the layer is on or off, or frozen or thawed. You can also use these commands to erase the contents of specified layer.

Managing the Surface Layer

You can turn the surface layer on or off, as well as freeze, thaw, or erase the layer.

To manage the surface layer

1. From the Terrain menu, select Terrain Layers ➤ Surface Layer.

The following prompt is displayed:

ON/OFF/Freeze/Thaw/Erase <Erase>:

2. Type one of the following options:
   - **ON**: To turn the surface layer on.
   - **OFF**: To turn the surface layer off.
   - **Freeze**: To freeze the surface layer.
   - **Thaw**: To thaw the surface layer.
   - **Erase**: To erase all objects from the surface layer.

3. Press ENTER.

Managing the Border Layer

You can turn the border layer on or off, as well as freeze, thaw, or erase the layer.

To manage the border layer

1. From the Terrain menu, choose Terrain Layers ➤ Border Layer.

The following prompt is displayed:

ON/OFF/Freeze/Thaw/Erase <Erase>:

2. Type one of the following options:
   - **ON**: To turn the border layer on.
   - **OFF**: To turn the border layer off.
   - **Freeze**: To freeze the border layer.
   - **Thaw**: To thaw the border layer.
   - **Erase**: To erase all objects from the border layer.

3. Press ENTER.
Managing the Range Layers
You can turn the range layers on or off, as well as freeze, thaw, or erase the layer.

To manage the range layers
1 From the Terrain menu, choose Terrain Layers ➤ Range Layers.
The following prompt is displayed:
ON/OFF/Freeze/Thaw/Erase <Erase>:
2 Type one of the following options:
   ■ ON: To turn the range layer on.
   ■ OFF: To turn the range layer off.
   ■ Freeze: To freeze the range layer.
   ■ Thaw: To thaw the range layer.
   ■ Erase: To erase all objects from the range layer.
3 Press ENTER.

Managing the Contour Layers
You can turn the contour layers on or off, as well as freeze, thaw, or erase the layer.

To manage the contour layers
1 From the Terrain menu, choose Terrain Layers ➤ Contour Layers.
The following prompt is displayed:
ON/OFF/Freeze/Thaw/Erase <Erase>:
2 Type one of the following options:
   ■ ON: To turn the contour layer on.
   ■ OFF: To turn the contour layer off.
   ■ Freeze: To freeze the contour layer.
   ■ Thaw: To thaw the contour layer.
   ■ Erase: To erase all objects from the contour layer.
3 Press ENTER.

Managing the 3D Grid Layer
You can turn the 3D grid layer on or off, as well as freeze, thaw, or erase the layer.

To manage the 3D grid layer
1 From the Terrain menu, choose Terrain Layers ➤ 3D Grid Layer.
The following prompt is displayed:
ON/OFF/Freeze/Thaw/Erase <Erase>:
2 Type one of the following options:
   ■ ON: To turn the 3D grid layer on.
   ■ OFF: To turn the 3D grid layer off.
- **Freeze**: To freeze the 3D grid layer.
- **Thaw**: To thaw the 3D grid layer.
- **Erase**: To erase all objects from the 3D grid layer.

3 Press ENTER.

### Managing the Polyline Grid Layer

You can turn the polyline grid layer on or off, as well as freeze, thaw, or erase the layer.

**To manage the polyline grid layer**

1 From the Terrain menu, choose Terrain Layers ➤ Polyline Grid Layer.

The following prompt is displayed:

- **ON/OFF/Freeze/Thaw/Erase <Erase>**:

2 Type one of the following options:

- **ON**: To turn the polyline grid layer on.
- **OFF**: To turn the polyline grid layer off.
- **Freeze**: To freeze the polyline grid layer.
- **Thaw**: To thaw the polyline grid layer.
- **Erase**: To erase all objects from the polyline grid layer.

3 Press ENTER.

### Managing the 3D Projection Layer

You can turn the 3D projection layer on or off, as well as freeze, thaw, or erase the layer.

**To manage the 3D projection layer**

1 From the Terrain menu, choose Terrain Layers ➤ 3D Projection Layer.

The following prompt is displayed:

- **ON/OFF/Freeze/Thaw/Erase <Erase>**:

2 Type one of the following options:

- **ON**: To turn the 3D projection grid layer on.
- **OFF**: To turn the 3D projection grid layer off.
- **Freeze**: To freeze the 3D projection grid layer.
- **Thaw**: To thaw the 3D projection grid layer.
- **Erase**: To erase all objects from the 3D projection grid layer.

3 Press ENTER.
Managing the Water Drop Layer

You can turn the water drop layer on or off, as well as freeze, thaw, or erase the layer.

To manage the water drop layer
1. From the Terrain menu, choose Terrain Layers ➤ Water Drop Layer.
   The following prompt is displayed:
   ON/OFF/Freeze/Thaw/Erase <Erase>:

2. Type one of the following options:
   ■ ON: To turn the water drop layer on.
   ■ OFF: To turn the water drop layer off.
   ■ Freeze: To freeze the water drop layer.
   ■ Thaw: To thaw the water drop layer.
   ■ Erase: To erase all objects from the water drop layer.

3. Press ENTER.

Managing the Site Grid Layer

You can turn the site grid layer on or off, as well as freeze, thaw, or erase the layer.

To manage the site grid layer
1. From the Terrain menu, choose Terrain Layers ➤ Site Grid Layer.
   The following prompt is displayed:
   ON/OFF/Freeze/Thaw/Erase <Erase>:

2. Type one of the following options:
   ■ ON: To turn the site grid layer on.
   ■ OFF: To turn the site grid layer off.
   ■ Freeze: To freeze the site grid layer.
   ■ Thaw: To thaw the site grid layer.
   ■ Erase: To erase all objects from the site grid layer.

3. Press ENTER.
Managing the Volume Ticks Layers

You can turn the volume ticks layers on or off, as well as freeze, thaw, or erase the layer.

To manage the volume ticks layers

1. From the Terrain menu, choose Terrain Layers ➤ Volume Ticks Layers. The following prompt is displayed:

   ON/OFF/Freeze/Thaw/Erase <Erase>:

2. Type one of the following options:
   - **ON**: To turn the volume ticks layer on.
   - **OFF**: To turn the volume ticks layer off.
   - **Freeze**: To freeze the volume ticks layer.
   - **Thaw**: To thaw the volume ticks layer.
   - **Erase**: To erase all objects from the volume ticks layer.

3. Press ENTER.
Performing Inquiries on Drawing Features

The Inquiry commands report specified information about drawing objects and spatial relationships between objects. You can select a location in the drawing and use the commands on the Inquiry menu to list the northing and easting coordinates, latitude and longitude, geodetic inverse, station and offset, and object geometry data.

Commands are also provided to list distances, areas, elevations, and to track northing and easting coordinates and elevations.
Using the Inquiry Commands

The commands on the Inquiry pull-down menu list statistics about your drawing and the objects drawn within.

Listing the Northing and Easting of a Location

You can display the X and Y coordinates, and the COGO northing and easting coordinates of a selected location in the drawing. The relationship between the X, Y coordinates and the northing/easting coordinates are based on the drawing's defined base point and north rotation angle. For more information, see “Changing the Base Point for a Drawing” or “Changing the North Rotation for a Drawing” in Chapter 4, “Setting Up Drawings.”

NOTE Use AutoCAD Object Snaps to accurately select the location.

To list the northing and easting of a location
1. From the Inquiry menu, choose North/East.
2. Select a point.
3. Select additional points, or press ENTER to end the command.

Listing the Latitude and Longitude of a Location

You can list the latitude and longitude a location based on the current zone. Once this information is supplied, AutoCAD Land Development Desktop computes the grid northing/easting coordinates.

NOTE Use AutoCAD Object Snaps to accurately select the location.

To list the latitude and longitude of a location
1. Set the current zone. For more information, see “Changing the Current Zone for a Drawing” in Chapter 4, “Setting Up Drawings.”
2. Set the Geodetic Transformation Settings. For more information, see “Changing the Geodetic Zone Transformation Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
3. From the Inquiry menu, choose Lat/Long.
4. Select a point.

The northing, easting, grid northing, grid easting, convergence, scale factor, latitude and longitude are listed at the command line. Press F2 to view the information in the text window.
5. Select another point, or press ENTER to end the command.
Listing the Geodesic Information of a Line

You can report the grid distance, geodesic distance, and the starting and ending geodetic azimuths of a line. This is referred to as a geodetic inverse.

**NOTE** Use AutoCAD Object Snaps to accurately select the location.

To perform a geodetic inverse

1. Set the current zone. For more information, see “Changing the Current Zone for a Drawing” in Chapter 4, “Setting Up Drawings.”
2. Set the Geodetic Transformation Settings. For more information, see “Changing the Geodetic Zone Transformation Settings” in Chapter 5, “Changing the AutoCAD Land Development Desktop Settings.”
3. From the Inquiry menu, choose Geodetic Inverse.
4. Select the first point of the line.

When you select the first point, the following type of information is displayed about that point:

- **Current zone:** NH83
- **Northing:** 5283.4318
- **Easting:** 5508.9269
- **Convergence:** $-7-21-42$
- **Scale factor:** 1.009822450434
- **Latitude:** 42-21-49
- **Longitude:** 81-01-11

5. Select the second point of the line.

When you select the second point, the information for that point is displayed, and the geodetic inverse information is displayed for the line, as in the following example:

- **Northing:** 4542.6078
- **Easting:** 4951.9931
- **Convergence:** $-7-21-52$
- **Scale factor:** 1.009834763073
- **Latitude:** 42-21-24
- **Longitude:** 81-01-31
- **Grid Distance:** 926.82
- **Grid Azimuth:** 216-34-25
- **Geodetic Azimuth of line (at start):** 209-34-25
- **Geodetic Azimuth of Line (at end):** 209-34-08
- **Geodetic Distance (geodesic):** 917.80

Listing the Station and Offset of a Location in Relation to an Object

You can list the station and offset of any point relative to an existing line, curve, or spiral object in your drawing.

To list the station and offset of a location in relation to an object

1. From the Inquiry menu, choose Station/Offset Object.
2. Select the object the point is offset from.

Using the Inquiry Commands 769
To list the station and offset of a point that is adjacent to a roadway centerline, you can select one of the objects that make up the alignment. You must specify a line, curve, or spiral object.

The command marks the nearest endpoint of the object with an X.

3 Type the starting station of the object. After you select the starting station, the command calculates the ending station of the object you chose.

4 Select the point for which you want to determine the station and offset. The station and offset of the point is displayed. A negative offset is to the left of the object you selected; a positive offset is to the right based on station progression.

5 Continue to select points, or press ENTER to end the command.

The following illustration shows how to select an object and specify the starting station:

![Selecting an object and specifying the starting station](image)

**Listing the Station and Offset of a Location in Relation to the Current Alignment**

You can list the station and offset of any location relative to the current alignment.

To list the station and offset of a location in relation to the current alignment

1 From the Inquiry menu, choose Station/Offset Alignment.

2 Select the point for which you want to determine the station and offset. This point must be adjacent to the current alignment.

The program displays the station and offset of the point. A negative offset is to the left of the alignment; a positive offset is to the right based on station progression.

3 Continue to select points, or press ENTER to end the command.
Identifying Object Geometry

By using the Inquiry commands, you can obtain information about selected lines, roadway and railway curves, spirals, and angles. Such information may include the length of lines and curves and the external distance.

Listing Line, Curve, or Spiral Data

You can list information about an object, including start points and endpoints, radius or intersection points, lengths, radii, and orientation. The object must be a line, curve, or spiral.

To list line, curve, or spiral data

1. From the Inquiry menu, choose Line/Curve/Spiral.
2. Select the object.
3. Press F2 to view the information in the text window.
4. Select another object, or press ENTER to exit the command.

Listing Roadway Curve Data

You can list data about any roadway curve. You describe roadway curve using the curve definition. The curve definition states that the degree of curve equals the angle between any two points on the curve, separated by 100 units measured along the curve.

To list roadway curve data

1. From the Inquiry menu, choose Roadway Curves.
2. Select the curve.
   The information is displayed in the text window. For example:

   ROADWAY CURVE LISTING
   ---------------------------
   Included angle = 65-29-41
   Radius = 205.250m
   Tangent length = 132.008m
   Arc length = 234.621m
   Chord length = 222.054m
   External secant = 38.786m
   Mid ordinate = 32.622m
   Degree of curve = 27-54-54

3. Press F2 to return to your drawing.

Listing Railway Curve Data

You can list data about any railway curve. You describe railway curve using the chord definition. The chord definition states that the degree of curve equals the angle between any two points on the curve, separated by 100 units measured along the chord.

To list a railway curve

1. From the Inquiry menu, choose Railway Curves.
2 Select the curve.

The information is displayed the text window. For example:

RAILWAY CURVE LISTING
----------------------------------------
Included angle = 65-29-41
Radius = 200.000m
Tangent length = 128.631m
Arc length = 226.195m
(True arc = 228.620m)
Chord length = 216.374m
External secant = 37.794m
Mid ordinate = 31.787m
Degree of curve = 28-57-18

3 Press F2 to return to your drawing.

Listing a Spiral Radius

You can use the Spiral Radius command to list the radius at a fixed location along a spiral. You must create the spiral object using a spiral creation command on the Lines/Curves menu. This radius is calculated based on the spiral type. Because spiral representations are not always graphically accurate, the radius is calculated from the equations that have been generated.

To list a spiral radius

1 From the Inquiry menu, choose Spiral Radius.

2 Select the beginning of the spiral. The distance is measured from the nearest end point on the spiral.

The following prompt is displayed:

Enter Length (or Point):

3 To select the location on the spiral at which to list the radius, do one of the following:

■ Type the length (this defines the distance along the spiral at which the radius is to be measured).
■ Type PO, and then select a point on the spiral at which the radius is to be measured.

The command displays the northing and easting of the selected point, the spiral radius at that point, and the direction of the spiral tangent at that point.

North:(Northing) East:(Easting)
Radius:(Radius) Tangent Direction:(Direction)

4 Continue to select points to list, or press ENTER to end the command.
Listing the Acute and Obtuse Angles Between Points or Intersecting Lines

You can list the acute and obtuse angles between points or intersecting lines in your drawing.

To list the acute and obtuse angles

1. From the Inquiry menu, choose Angles.
   The following prompt is displayed:
   Select First line (or Point):

2. Do one of the following:
   - Select the first and second intersecting lines.
   - Type PO, and then select three points to determine the angle. You can use either the following illustration for reference, or Point Filters (.P, .G, or .N) to select the three points to determine the angle.

The following illustration shows how to select lines or points for listing acute and obtuse angles:

3. Continue to select lines or points, or press ENTER to end the command.

Displaying Object Design Properties

You can view data in a dialog box about a line, curve, or spiral object in your drawing.

To display object design properties

1. Select the object by clicking on it or by picking two points to draw a window or crossing around it.
2. Right-click to display the shortcut menu.
3 Select Design Properties to display the Entity Data dialog box.

This dialog box displays the properties of the line, curve, or spiral that you selected.
This dialog box is a modeless dialog box, which means that you can leave it open while you perform other tasks, such as selecting another entity to display data about.

4 To close the dialog box, click the upper-left corner.

### Line tab data

<table>
<thead>
<tr>
<th>Line tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Displays the length of the line.</td>
</tr>
<tr>
<td>Direction</td>
<td>Displays the direction of the line.</td>
</tr>
<tr>
<td>Start Northing</td>
<td>Displays the northing coordinate of the start of the line.</td>
</tr>
<tr>
<td>Start Easting</td>
<td>Displays the easting coordinate of the start of the line.</td>
</tr>
<tr>
<td>End Northing</td>
<td>Displays the northing coordinate of the end of the line.</td>
</tr>
<tr>
<td>End Easting</td>
<td>Displays the easting coordinate of the end of the line.</td>
</tr>
</tbody>
</table>

### Curve tab data

<table>
<thead>
<tr>
<th>Curve tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radius</td>
<td>Displays the radius of the curve.</td>
</tr>
<tr>
<td>Length</td>
<td>Displays the length of the curve.</td>
</tr>
<tr>
<td>Delta</td>
<td>Displays the central angle of the curve. Also known as (\Delta).</td>
</tr>
<tr>
<td>Degree of Curve</td>
<td>Displays the degree of curve.</td>
</tr>
<tr>
<td>Tangent Length</td>
<td>Displays the tangent length of the curve.</td>
</tr>
<tr>
<td>Chord Length</td>
<td>Displays the length of the long chord.</td>
</tr>
<tr>
<td>Middle Ordinate</td>
<td>Displays the middle ordinate.</td>
</tr>
<tr>
<td>External Secant</td>
<td>Displays the external secant.</td>
</tr>
</tbody>
</table>
### Spiral tab data

<table>
<thead>
<tr>
<th>Spiral tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Displays whether the spiral is a clothoid, sinusoid, cosinusoid, or quadratic spiral.</td>
</tr>
<tr>
<td><strong>Length</strong></td>
<td>Displays the spiral length.</td>
</tr>
<tr>
<td><strong>Radius</strong></td>
<td>Displays the radius of the spiral at SC (point of change from spiral to curve) or CS (point of change from curve to spiral).</td>
</tr>
<tr>
<td><strong>Theta</strong></td>
<td>Displays the central angle of the spiral.</td>
</tr>
<tr>
<td><strong>Xs</strong></td>
<td>Displays the tangent distance from TS (point of change from tangent to spiral) to SC (point of change from spiral to curve) or CS (point of change from curve to spiral) to ST (point of change from spiral to tangent).</td>
</tr>
<tr>
<td><strong>Ys</strong></td>
<td>Displays the offset distance at SC from TS or at CS from ST.</td>
</tr>
<tr>
<td><strong>P</strong></td>
<td>Displays the offset of the initial tangent in to the PC of the shifted curve, or the offset of the initial tangent out to the PT of the shifted curve.</td>
</tr>
<tr>
<td><strong>LT</strong></td>
<td>Displays the length of the long tangent.</td>
</tr>
<tr>
<td><strong>ST</strong></td>
<td>Displays the length of the short tangent.</td>
</tr>
<tr>
<td><strong>K</strong></td>
<td>Displays the abscissa of the shifted PC referred to the TS, or the abscissa of the shifted PT referred to the ST.</td>
</tr>
<tr>
<td><strong>A</strong></td>
<td>Displays the spiral “A” value, or the “flatness” of the spiral. This value is equal to the square root of the product of the length times the radius.</td>
</tr>
</tbody>
</table>

### Listing Distances

You can use the Continuous Distance and Add Distances commands to list specified information about spatial relationships between objects in your drawing. These two commands are similar, except that the Add Distances command does not hold the start point of the subsequent distances.

### Listing the Distance of a Series of Points

The Continuous Distance command lists the distance between two points. This command continuously holds either the first or last selected point for distance selections.

**To list the distance of a series of points**

1. From the Inquiry menu, choose Continuous Distance.

The following prompt is displayed:

```
Base/Continuous <Continuous>:
```
2  Type **Base** or **Continuous**:
   - **Type Base** to hold the first point selected and use it as the first point for all distance calculations.
   - **Type Continuous** to hold the last point selected for all distance calculations. The last point held is updated each time a new point is selected.
3  Select the start point.
4  Select the next point.
   The distance is displayed at the command line.
5  When you are finished selecting points, press ENTER.
   The command displays the total distance in the current drawing units and the following prompt:
   
   ```plaintext
   Total distance: {Distance}
   Place distance on drawing <Yes>:
   ```
6  Do one of the following:
   - **Type Yes** to insert text showing the total distance calculated on the drawing. No dimension leaders are placed with this text.
   - **Type No** to end the command.
   
   If you type **Yes**, then the following prompt is displayed:
   
   ```plaintext
   Distance text point:
   ```
7  Select the point at which to insert the text.
   The text is drawn on the current layer, using the current text style. A rotation angle of zero (0) is used for the text.

**Listing the Total Distance of a Series of Points**

The **Add Distances** command calculates the total of several disjunct distances.

**To list the total distance of a series of points**

1  From the Inquiry menu, choose **Add Distances**.
   The following prompt is displayed:
   
   ```plaintext
   This program adds together multiple distances.
   First distance (or Select):
   ```
2  Do one of the following:
   - Enter the first distance.
   - Select two points in your drawing that show the first distance to be used.
   
   The command displays the last distance calculated and the running total:
   
   ```plaintext
   Last distance = {Distance}
   Total distance = {Distance}
   Next distance (or Select):
   ```
3 Enter or select the next distance at the previous prompt.
4 When all of the distances have been entered or selected, press ENTER in response to the Next distance (Select) prompt.
   The command then displays the following prompt:
   
   Distance text point:

5 Select the point at which to insert the text.
   The text is drawn on the current layer, using the current text style. A rotation angle of zero (0) is used for the text.

Listing Areas

You can calculate the area and perimeter of boundaries that are defined by a sequence of points, lines, curves, or polylines.

Listing an Area Bounded by Lines and Curves

You can list an area bounded by lines and curves. This command lists the area in square feet and acres (square meters and hectares if working in metric units).

To list an area that is bounded by lines and curves
1 From the Inquiry menu, choose Area by Lines/Curves.
2 Select the first object nearest the point of beginning (POB).
3 Use a window or crossing to select the rest of the objects, and then press ENTER to complete the selection set.
   The lines and curves cannot extend past the property line intersections. They must be separate objects meeting at endpoints.
   If the boundary has any breaks, then a closure error prompt is displayed and an × is placed at the invalid closure point. If it is at the starting point of the boundary, then you can accept the default (Yes) to close back to the POB. If not, then type N (for No) to end the command and correct the closure error.
   The command then reports the area.
4 Press ENTER to end the command, or select another boundary to list.
The following illustration shows object selection guidelines:

Selecting objects bounded by lines and curves

**Listing an Area Bounded by a Polyline**

You can list an area bounded by a single closed polyline.

- **NOTE** Selecting a polyline that has been spline fitted causes erroneous areas to be reported.

To list an area defined by a polyline

1. From the Inquiry menu, choose Area by Polylines.
2. Select the polyline.

The command calculates the area and lists it on screen.

- **NOTE** If the area does not close, then a closure error prompt is displayed and an X is placed at the invalid closure point. Type either Yes to accept the default and close back to the point of beginning (POB), or type No to end the command and correct the closure error.

**Listing an Area Bounded by Points**

You can list an area bounded by a series of selected points.

- **NOTE** Use AutoCAD Object Snaps to accurately select the location.

To list an area bounded by points

1. From the Inquiry menu, choose Area by Points.
2. Select the area first point.
3. Continue selecting points along the perimeter in either a clockwise or counterclockwise direction. You can also type C and define a curve. For more information, see “Defining a Curve by Points” in this chapter.
4. After you finish selecting points, press ENTER.
The following illustration shows point selection guidelines:

Selecting points to define an area

**Defining a Curve by Points**

**To define a curve by points**

1. Type `C` to define a curve.
   
The following prompt is displayed:
   
   Next point (or Curve):
   
   **NOTE** This option automatically sets the OSNAP mode to Center. Do not override this setting.

2. Select a point on both the curve and end of the curve.
   
The command then prompts for the position of the chord relative to the boundary:
   
   Position of Chord to lot Outside/<Inside>:
   
3. Type `O` or `I`:
   
   - Type `O` if the chord is outside the boundary.
   - Type `I` if the chord is inside the boundary.

   If the chord is on the inside of the boundary, then the area of the curve is added to the area of the boundary. If the chord is on the outside, then the area of the curve is subtracted from the area of the boundary.

   **NOTE** Curves are assumed to have an included angle less than 180 degrees. You must treat a curve with more than 180 degrees as two curves with included angles that are less than 180 degrees.
Listing Elevations

Topographic mapping, designing and laying out highways, and designing drainage systems all require determining differences in elevation. You can quickly list the elevations of contours or surfaces at selected locations.

Listing the Elevations of a Contour

You can list the elevation of any contour or polyline in the drawing.

To list contour elevations
1. From the Inquiry menu, choose Contour Elevation.
2. Select the contour line to list.
   The command calculates the contour elevation and lists it on screen. If the item has no elevation, then its elevation is zero.
3. Press ENTER to end the command.

Listing the Elevations of the Current Surface

You can list the elevations for points on the current surface.

NOTE
Use AutoCAD Object Snaps to accurately select the location.

To list surface elevations
1. From the Inquiry menu, choose Surface Elevation.
2. Select a location on the surface at which you want to list the elevation.
   The elevation value is displayed at the command line. If the selected location is not within the surface, the following message is displayed:
   Press ENTER to end the command.

Listing Slope Information Between Two Points

You can list slope information between two points in the drawing using the List Slope command.

To display slope information between two points in your drawing
1. From the Inquiry menu, choose List Slope.
   The following prompt is displayed:
   Select the first point:

2. Select the first point from your drawing by positioning the cursor and clicking.
   The following prompt is displayed:
   Select the second point:
3 Select the second point from your drawing by positioning the cursor and clicking.

The following information is displayed above the command prompt at the bottom of the AutoCAD screen:

- First elevation
- Second elevation
- Elevation difference
- Slope
- Grade
- Horizontal distance

4 Press ENTER to end the command.

**Listing the Elevation at a Slope**

To list the elevation at a slope given a known elevation and distance from that elevation

1 From the Inquiry menu, choose List Elevation ➤ Slope.

   The following prompt is displayed:

   ```
   Elevation slope - Select point:
   ```

2 Select a point from your drawing.

3 Do one of the following to define the grade or slope:
   - Type a slope value.
   - Select two points to define a slope.
   - Type **G** and a grade value, or select two points to define the grade.

   The following prompt is displayed:

   ```
   Distance <0>:
   ```

4 Enter a distance by typing a value or by selecting two points.

   The elevation is displayed above the command prompt at the bottom of the AutoCAD screen.

5 Press ENTER to end the command.
Tracking Coordinates and Elevations

You can retrieve coordinate and elevational information as you move your pointing device across the drawing.

Tracking Northing and Easting Coordinates

You can track northing and easting coordinates of the current pointer location. You can keep the Coordinate Tracking dialog open while using other commands.

To track northing and easting coordinates

- From the Inquiry menu, choose Track North/East.

Tracking Elevations

You can track elevational information of the current surface. The elevation is displayed in the AutoCAD status bar.

To track elevations

1. From the Inquiry menu, choose Track Elevation.
2. To stop the elevation tracking, press ENTER.
Utilities

Use the Utilities commands to view objects, track revisions, manage layers, and to insert symbols, leaders, and cameras into the drawing.

The Utilities documentation is included in the online Help.
Utilities Documentation

See the online Help for Utilities documentation.
Appendix A

File List

This appendix contains a list of files that AutoCAD Land Development Desktop creates and maintains.
## AutoCAD Land Development Desktop File List

<table>
<thead>
<tr>
<th>Feature</th>
<th>File</th>
<th>Location</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Projects</strong></td>
<td>project.dfm</td>
<td>&lt;project&gt;</td>
<td>Project specific settings</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>longfilenamesystem.mdb</td>
<td>&lt;project&gt;</td>
<td>Long file name correlation database</td>
<td>Microsoft Access database</td>
</tr>
<tr>
<td></td>
<td>&lt;project&gt;.lk#</td>
<td>&lt;project&gt;</td>
<td>Multi-user coordination lock file</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>&lt;drawing&gt;.dfm</td>
<td>&lt;project&gt;\Dwg</td>
<td>Drawing specific settings</td>
<td>ASCII text file</td>
</tr>
<tr>
<td><strong>Points</strong></td>
<td>points.mdb</td>
<td>&lt;project&gt;\Cogo</td>
<td>Point database</td>
<td>Microsoft Access database</td>
</tr>
<tr>
<td></td>
<td>groups.mdb</td>
<td>&lt;project&gt;\Cogo</td>
<td>Point group database</td>
<td>Microsoft Access database</td>
</tr>
<tr>
<td></td>
<td>xdrefs.mdb</td>
<td>&lt;project&gt;\Cogo</td>
<td>XRef definition database</td>
<td>Microsoft Access database</td>
</tr>
<tr>
<td></td>
<td>default.mdb</td>
<td>&lt;project&gt;\Cogo\DescKey</td>
<td>Default description key database</td>
<td>Microsoft Access database</td>
</tr>
<tr>
<td></td>
<td>&lt;name&gt;.mdb</td>
<td>&lt;project&gt;\Cogo\DescKey</td>
<td>User defined description key database</td>
<td>Microsoft Access database</td>
</tr>
<tr>
<td></td>
<td>&lt;name&gt;.mdb</td>
<td>&lt;project&gt;\Cogo\UserDB</td>
<td>User defined database for XDREF</td>
<td>Microsoft Access database</td>
</tr>
<tr>
<td></td>
<td>Default.cor</td>
<td>&lt;project&gt;\Cogo</td>
<td>Translate/Rotate points – history of changes made</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>&lt;drawing&gt;.cor</td>
<td>&lt;project&gt;\Cogo</td>
<td>Translate/Rotate points – update multiple dwgs</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>&lt;project&gt;.lk#</td>
<td>&lt;project&gt;</td>
<td>Multi-user coordination lock file</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>&lt;drawing&gt;.dfm</td>
<td>&lt;project&gt;\Dwg</td>
<td>Drawing specific settings</td>
<td>ASCII text file</td>
</tr>
<tr>
<td>Feature</td>
<td>File</td>
<td>Location</td>
<td>Description</td>
<td>Format</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>----------------</td>
<td>--------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td><strong>Alignments</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Alignment.mdb</td>
<td>&lt;project&gt;\Align</td>
<td>Alignment database</td>
<td>Microsoft Access database</td>
</tr>
<tr>
<td></td>
<td>project.adb</td>
<td>&lt;project&gt;\Align</td>
<td>Alignment database of AutoCAD Land Development Desktop R1.0x or previous versions</td>
<td>Binary data file</td>
</tr>
<tr>
<td></td>
<td>&lt;drawing&gt;.ahl</td>
<td>&lt;project&gt;\Align</td>
<td>Alignment objects handle file for AutoCAD Land Development Desktop R1.0x or previous versions</td>
<td>Binary data file</td>
</tr>
<tr>
<td></td>
<td>align.lk#</td>
<td>&lt;project&gt;\Align</td>
<td>Multi-user coordination lock file</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>&lt;drawing&gt;.dfm</td>
<td>&lt;project&gt;\Dwg</td>
<td>Drawing specific settings</td>
<td>ASCII text file</td>
</tr>
<tr>
<td><strong>Parcels</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;project&gt;.gcf</td>
<td>&lt;project&gt;\Lots</td>
<td>Parcel and Volume Sites database file</td>
<td>Binary data file</td>
</tr>
<tr>
<td></td>
<td>&lt;drawing&gt;.dfm</td>
<td>&lt;project&gt;\Dwg</td>
<td>Drawing specific settings</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>lots.lk#</td>
<td>&lt;project&gt;\Lots</td>
<td>Multi-user coordination lock file</td>
<td>ASCII text file</td>
</tr>
<tr>
<td><strong>Labels</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;drawing&gt;.cgx</td>
<td>&lt;project&gt;\Dwg</td>
<td>Label settings</td>
<td>ASCII text file</td>
</tr>
<tr>
<td><strong>Terrain</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;.sdf</td>
<td>&lt;project&gt;\Dtm&lt;surface&gt;</td>
<td>Surface settings file</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;pnt.txt</td>
<td>&lt;project&gt;\Dtm&lt;surface&gt;</td>
<td>Surface point data file</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;brk.bin</td>
<td>&lt;project&gt;\Dtm&lt;surface&gt;</td>
<td>Contour data file</td>
<td>Binary data file</td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;flt.bin</td>
<td>&lt;project&gt;\Dtm&lt;surface&gt;</td>
<td>Breakline data file</td>
<td>Binary data file</td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;pnt</td>
<td>&lt;project&gt;\Dtm&lt;surface&gt;</td>
<td>Surface model points</td>
<td>Binary data file</td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;lin</td>
<td>&lt;project&gt;\Dtm&lt;surface&gt;</td>
<td>Surface model definition</td>
<td>Binary data file</td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;bnd.bin</td>
<td>&lt;project&gt;\Dtm&lt;surface&gt;</td>
<td>Terrain Model Explorer boundaries definition</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;hdm</td>
<td>&lt;project&gt;\Dtm&lt;surface&gt;</td>
<td>Watershed model definition</td>
<td>Binary data file</td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;ws.bin</td>
<td>&lt;project&gt;\Dtm&lt;surface&gt;</td>
<td>Watershed boundary file</td>
<td>Binary data file</td>
</tr>
</tbody>
</table>
### Appendix A  File List

<table>
<thead>
<tr>
<th>Feature</th>
<th>File</th>
<th>Location</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terrain (continued)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;.ws.txt</td>
<td>&lt;project&gt;\Dtm&lt;surface&gt;</td>
<td>Watershed description file</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;.eds</td>
<td>&lt;project&gt;\Dtm&lt;surface&gt;</td>
<td>Edit history log</td>
<td>Binary data file</td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;.err</td>
<td>&lt;project&gt;\Dtm&lt;surface&gt;</td>
<td>Build surface log file</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;.xst</td>
<td>&lt;project&gt;\Dtm</td>
<td>New defined sections definition file</td>
<td>Binary data file</td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;.xsb</td>
<td>&lt;project&gt;\Dtm</td>
<td>Sections definition file</td>
<td>Binary data file</td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;.xsr</td>
<td>&lt;project&gt;\Dtm</td>
<td>Processed sections data file</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>surface.txt</td>
<td>&lt;project&gt;\Dtm</td>
<td>Multiple surface definition file</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>strata.txt</td>
<td>&lt;project&gt;\er</td>
<td>Defined strata list</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>strata.dfm</td>
<td>&lt;project&gt;\er</td>
<td>Strata/Volume surface list</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>&lt;site&gt;.xsd</td>
<td>&lt;project&gt;</td>
<td>Section volume data file</td>
<td>Binary data file</td>
</tr>
<tr>
<td></td>
<td>&lt;site&gt;.xsp</td>
<td>&lt;project&gt;</td>
<td>Section volumes pointer file</td>
<td>Binary data file</td>
</tr>
<tr>
<td></td>
<td>&lt;surface&gt;.lk#</td>
<td>&lt;project&gt;\Dtm&lt;surface&gt;</td>
<td>Multi-user coordination lock file</td>
<td>ASCII text file</td>
</tr>
<tr>
<td>Utilities</td>
<td>passwords.def</td>
<td>&lt;project&gt;\job</td>
<td>Revisions password list</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>&lt;drawing&gt;.dbf</td>
<td>&lt;project&gt;\job</td>
<td>Revision log database</td>
<td>dBase database</td>
</tr>
<tr>
<td></td>
<td>timeman.cdx</td>
<td>&lt;project&gt;\pp</td>
<td>Drawing revision database index file</td>
<td>Binary data file</td>
</tr>
<tr>
<td></td>
<td>timeman.dbf</td>
<td>&lt;project&gt;\pp</td>
<td>Drawing revision data file</td>
<td>dBase database</td>
</tr>
<tr>
<td></td>
<td>timeman.rep</td>
<td>&lt;project&gt;\pp</td>
<td>Time management report</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>cr.dfm</td>
<td>&lt;project&gt;\cr</td>
<td>Leader and discontinued settings</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>&lt;name&gt;.ssl</td>
<td>&lt;user path&gt;</td>
<td>Snapshot of layers</td>
<td>Binary data file</td>
</tr>
<tr>
<td></td>
<td>&lt;name&gt;.ars</td>
<td>&lt;user path&gt;</td>
<td>Attribute report specification file</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>&lt;name&gt;.txt</td>
<td>&lt;user path&gt;</td>
<td>Attribute extraction template file</td>
<td>ASCII text file</td>
</tr>
<tr>
<td>Feature</td>
<td>File</td>
<td>Location</td>
<td>Description</td>
<td>Format</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
<td>--------------</td>
<td>--------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Utilities</td>
<td>&lt;name&gt;.txt</td>
<td>&lt;user path&gt;</td>
<td>Extracted attributes</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>legend.dbf</td>
<td>&lt;project&gt;</td>
<td>Legend database</td>
<td>dBase database</td>
</tr>
<tr>
<td></td>
<td>zzsdesk.ly</td>
<td>&lt;project&gt;</td>
<td>Leader/Legend and discontinued layer settings</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>zzstyle.dat</td>
<td>&lt;project&gt;</td>
<td>Leader/Legend and discontinued text settings</td>
<td>ASCII text file</td>
</tr>
<tr>
<td></td>
<td>&lt;drawing&gt;.dfm</td>
<td>&lt;project&gt;\Dwg</td>
<td>Drawing specific settings</td>
<td>ASCII text file</td>
</tr>
</tbody>
</table>
Index

2D line
   surface border, 611
2D polyline
   converting
      from 3D polyline, 693
      to 3D polyline, 694
   surface border, 611
3D grid layer, 763
3D line
   surface border, 611
3D polyline
   converting
      from 2D polyline, 694
      to 2D polyline, 693
   displaying grade breaks, 697
   editing, 695
   filleting, 696
   joining, 699
   surface border, 612
3D polyline vertices
   adding, 697
   weeding, 699
3D polyline, creating, 686
   by referencing point elevations, 686
   by referencing points and slopes, 688
   curb, 690
   step, 692
3D polyline, grade breaks, 697
3D projection layer, 764
3D surface grid, 634, 639
acute and obtuse angles, listing, 773
alignment, 362
   creating
      defining, 369
      drawing, 367
      from objects, 369
      from polyline, 371
   creating offsets, 372
   deleting, 389
alignment (continued)
   deleting multiple, 391
   displaying current, 388
   editing, 378
   importing, 388, 389
   importing multiple, 390
   label settings, 400
   locking, 363, 364
   making current, 367
   merging, 395
   moving to different layer, 393
   output to ASCII file, 411, 412
   point of intersection, 379
   sharing data, 363
   stakeout, 408
   settings, 408, 409
alignment database, 362
   closing, 399
   locking, 364
   saving, 398
alignment properties, 392
   color, 393
   description, 394
   linetype, 394
alignment station equations, 375
   adding, 376
   changing, 375
   clearing, 376
   creating, 375
   deleting, 377
   exiting, 377
   modifying, 377
alignment station labels, 402
   creating, 404
   offset values, 405
   settings, 401, 402
alignment stations, 197, 402
   display format, 399
alignment, reporting data, 386
  by curve, 387
  by increments, 387
  by station, 387
  by station and curve, 387
  stakeout, 408, 410
  station and offset, 406
ASCII file output, 411, 412
AutoCAD Land Development Desktop.
  See Land Development Desktop
Auto-Range
  slope, 629
average end area, 719, 740
average method, elevation
  2D solids, 621
  3D faces, 623
  polyface, 624
banding method, elevation
  2D solids, 625
  3D faces, 626
barbed wire fence, drawing, 357
base point, 50
blocks, 533
border
  layer, 762
  line, 56
  scaled block, 57
  style, 55
  unscaled block, 57
border (surface)
  2D line, 611
  2D polyline, 611
  3D line, 611
  3D polyline, 612
boundary
  creating, 559
  importing, 562
  information, 571
  Terrain Model Explorer folder, 571
breakline
  changing description, 556
  defining
    curbs, 550
    walls, 550
  deleting, 557
  editing, 555
  exporting, 558
  folder, 571
  identifying, 552
breakline (continued)
  importing, 554
  importing definitions, 545
  information, 571
  listing, 553
  proximity, 547
  updating, 556
breakline data, surface generation, 540
breakline file, 546
  creating, 546
  importing, 545
breakline, creating, 540
  from 3D lines, 544
  from point numbers, 542
  from points, 541
  from polylines, 543
  manually, 546
building offset label, 493
chain link fence, drawing, 358
chord definition, railway curve, 771
clipboard, copying quick sections, 710
clothoid spiral, 339
COGO database import options, 223
COGO points, 78
column headings, 231
  thickness, 233
  user defined, 231
  XDRRef, 233
  Z-, 232
  Z+, 232
composite method, volume
  calculation, 736, 737
composite volume settings, 735
compound spiral, 341
contour
  data, 536
  digitize, 673, 674
  editing, 672
  exploding to polylines, 672
  folder, 570
  layer, 676, 763
  managing, 652
  properties, 664
  surface generation, 537
  surface triangulation, 539
  text style, 655
  utilities, 672
  weeding, 678
contour elevations
assigning, 677
changing, 675
by addition or subtraction, 676
each contour on a layer, 676
selected contours, 675
listing, 780
zero, 678
contour grips
hiding, 664
showing, 664
using, 665
contour information, 570
missing, 539
contour label, 665, 666, 668
deleting, 670
editing, 671
grips, 671
hiding, 671
position, 656
showing, 671
contour points
adding, 678
removing, 678
contour settings
appearance, 653
label position, 656
text style, 655
contour style, 653
creating, 658
deleting current, 659
deleting saved, 659
folder, 659
loading, 660
managing, 657
path, 661
renaming, 660
saving, 659
selecting current, 658
settings, 653, 655, 656
contour, copying and offsetting, 679
creating multiple offsets, 682, 683
using grade, 681
using slope, 680
contour, creating, 652, 672
by copying and offsetting, 679
from built surface, 661
from existing contour, 679
from surface, 661
converting points, 246
coordinate display settings, 88
copying points, 257
cross sections, quick. See quick
cross sections
curb breakline, 550
curb, creating, 690
current
drawing scale, 129
point number for a drawing, 82
point number for a user, 82
current alignment
displaying, 388
selecting, 367
current zone, 48
curve
attaching to object, 346
data, 771
drawing. See draw curve
label, 443
railway, 771
roadway, 771
selecting, 171
curve definition
by chord length, 300
by degree, 299
by external secant, 299
by length, 299
by middle ordinate distance, 300
by minimum distance, 300
by radius, 300
by tangent length, 299
curve label styles, editing, 458
arrows, 462
crows feet, 462
data elements, 460
precision values, 461
text above/below, 461
text properties, 459
ticks, 462
curve stakeout report, 267
curve table
border, 510
column definition, 510
creating, 509
loading, 512
sorting, 510
split, 510
cut and fill areas, 733
data files, editing, 65
database, alignment, 362

Index

793
description key, 122
  creating, 125
deleting, 131
description parameters, 133, 134
importing older description key files, 132
manager, 124
matching, 115
properties, 132
rotating, 134
scaling, 134
settings, 89
substitution, 141
symbol, 124
  rotating, 127, 128
scaling, 127, 128
wildcard characters, 136
description key file, 130, 142
deleting, 131
loading from a prototype, 143
saving to a prototype, 142
description parameters, 133
digitize contour, 673, 674
direction, lines and alignments, 192
draw curves, 298
  best fitting, 304, 307
  between two lines, 298
  compound, 304
defining. See curve definition
  fixed endpoints/variable radius, 285
  fixed radius/start point, 284
  from end of object, 303
  multiple curves, 302
  on two lines, 301
  radius, 303
  reverse, 304
  special curves, 350
  through a point, 301
  with two compound spirals, 325
  with two reverse spirals, 326
draw lines, 282
  best fit, 291
  by defining direction, 285
  by station and offset, 288
  by turned or deflection angle, 287
COGO points, 283
defining a direction, 285
deflection angle, 287
  from ends of objects, 290
  perpendicular to an object, 295
  point numbers, 283, 284
draw lines (continued)
  radial to an object, 295
  range of point numbers, 284
  selecting points, 282
  selecting start and end points, 282
  special lines, 350
  station and offset, 288
tangent, 294
using COGO points, 283
using point numbers/range of point numbers, 284
  with symbol, 356
  with text, 355
draw spirals, 310
  between curves, 317
  between tangents and curves, 314
  between two lines, 312
  with curve, 325, 326
drawing settings
  changing, 66
  loading, 67
  output settings, 73
  saving, 66
drawing setup, 40, 41, 64
  loading profiles, 41
  precision values, 45
  saving setup profile, 43
  scale, 46
  sheet size, 48
  units, 44
  using the wizard, 40
drawings
  base point, 50
  border style, 55
  creating new project, 8
  current zone, 48
  north rotation, 52
  opening existing, 11
  reassociate, 31
  sheet size, 48
  starting new, 6
  text style, 54
  units, 44
  using existing project, 7
  watershed boundaries, 590
duplicate point numbers, 165
dynamic label
  angular direction, 480
  deleting, 481
disassociating, 481
  grip edit, 482
dynamic label (continued)
- properties, 482
- swapping text, 480
- updating
  - all, 479
  - preventing, 481
  - selected, 479
- edit
  - alignment curve, 381
  - alignment spiral, 382
- edit history folder
  - deleting edit, 601
- edit label styles
  - curve label, 458
  - line label, 452
  - point label, 467
  - spiral label, 462
  - using a formula, 473
- elevation
  - changing, 606, 675
  - contour, 675
  - listing, 780
  - listing at slope, 781
  - surface points, 603
  - tracking, 782
  - zero elevation, 678
- erasing points, 258
- explode contours to polylines, 672
- export points, 222
  - import/export format, 225
  - point data, 241
- external data references. See XDRefs
- external database file, 153
- external point data references, 146
- external point database
  - creating, 147
- fence
  - barbed wire, 357
  - chain link, 358
  - stockade, 358
- file locking, alignment, 364
  - backwards compatibility, 366
  - multiple sessions, 366
  - profile and cross section data, 366
- filleting, 696
- filters
  - finding a project, 10, 23
- fixed scale factor, 129
- geodetic calculator, 278
- geodetic zone transformation settings, 68
- grid
  - 3D faces, 634
  - 3D polylines, 639
  - tolerance factor, 730
  - volume, 722
- grid method, 729, 731, 732
- grid volume ticks, 734
- guard rail, drawing, 353
- history folder, editing, 569
- horizontal alignment editor
  - editing curve, 381
  - editing spiral, 382
  - navigating, 379
- horizontal alignment. See alignment, 362
- import
  - 3D Lines, 600
  - alignments, 388
  - breakline, 554
  - breakline file, 545
  - multiple alignments, 390
  - parcel lines and labels, 422
  - sites, 728
  - surface sections, 705
  - volume sections, 753, 754
  - watershed boundaries, 591
- import points, 80, 222
- import/export format, 225
  - into COGO point database, 239
  - point data, 239
  - using description keys, 122
- import/export format
  - copying, 237
  - creating, 225
  - modifying, 238
  - removing, 238
  - viewing, 237
- inquiry, 768
  - areas, 777
  - distances, 775
  - elevations, 780
  - contour, 780
  - surface, 780
- geodetic inverse, 769
- latitude and longitude, 768
- northing/easting, 768
- object design properties, 773
inquiry (continued)
  object geometry, 771
  angles, 773
  curve, 771
  line, 771
  railway curve, 771
  roadway curve, 771
  spiral, 771
  spiral radius, 772
  slope information, 780
  station and offset, 769, 770
  current alignment, 770
  object, 769
inserting points, 166
interpolating points, 211
  along a line, 211
label
  alignment, 442, 451
  building offset, 493
  commands, 436
  contours, 665, 666, 668
  creating, 436
    dynamic, 478
    static, 484
  curve, 443
    by points, 487
deleting, 481
disassociating, 481
dynamic, 436, 439, 478
  creating, 478
  updating all, 479
  updating selected, 479
geodetic, 436
grip edit, 482
line, 441, 486
  by points, 486
polyline, 488
properties, 482
spiral, 444
static, 436, 484
  creating, 484
  curve segment, 485, 487
  line segment, 485, 486
  station and offset, 405
storing, 437
swapping text, 480
tag, 436
type, 436
  updating, 439
    dynamically, 439
    manually, 440
label point, 445
  geodetic information, 489
  northing and easting, 489
label settings, 437
  curve, 443
    line, 441
    point, 445
    spiral, 444
label style, 436, 448
  current, 448, 449
  curve, 458
  folder path, 437
  formula, 473
    line, 452
    point, 467
    point block only, 449
  spiral, 462
label style properties
  curve, 458
  line, 452
  point, 467
  spiral, 462
  using a formula, 473
Land Development Desktop, 2
AutoCAD options, 60
  editing data files, 65
  preferences, 61
  AutoCAD New command, 64
  AutoCAD Open command, 63
  set up new drawings, 64
program paths, 61
settings, 60
  changing, 66
  loading, 67
  saving, 66
Start Up dialog box, 63
starting, 4
unloading applications, 18
Civil Design, 18
Survey, 18
layer
  3D grid, 763
  3D projection, 764
  border, 762
  contour, 676, 763
  polyline grid, 764
  range, 763
  site grid, 765
  surface, 762
terrain, 762
  volume ticks, 766
  water drop, 765
least squares adjustment, 291
ledge, drawing, 352
line
attaching attaching to object, 346
defining
by azimuth, 286
by bearing, 286
by point selection, 287
direction, 285
drawing. See draw lines
extending, 290
label, 441
selecting, 171
shortening, 290
line border, 56
line label styles, editing, 452
arrows, 458
crows feet, 458
data elements, 454
precision values, 457
text above/below, 456
text properties, 454
ticks, 458
line table
border, 504
column definition, 505
creating, 503
loading, 508
precision
angular, 508
linear, 507
sorting, 504
split, 505
listing an area
lines and curves, 777
points, 778
polyline, 778
listing breaklines, 553
listing data
angles, 773
areas, 777
curve, 771
distances, 775
elevations, 780
line, 771
railway curve, 771
roadway curve, 771
slope, 780, 781
spiral, 771
spiral radius, 772
listing elevations
contour, 780
surface, 780
location
latitude and longitude, 768
northing and easting, 768
selecting, 170
station and offset, 769, 770
lock files, 28
managing, 29
projects, 28
lots, numbering, 417
manage projects, 21
margins, 748
menu palette
changing name or description, 16
creating, 15
deleting, 18
restoring original, 13
saving, 17
selecting, 13
using, 12
MENULOAD command, 13, 15
multiple surfaces, 702
New command, 6
north rotation, 52
numbering convention for points, 81
object geometry, 771
object table, 496
creating, 503
curve table, 509
line table, 503
spiral table, 513
deleting, 518
editing, 516
updating, 517
objects
attaching lines, curves, and spirals, 346
attaching spirals, 328
defining an alignment, 369
offset spiral, 342
Open command, 11
opening drawings, 11
OPTIONS command, 60
output settings, 73
palette. See menu palette
parallel spiraled alignments, 343
parameter (rotation), 129
parameter (scaling), 128
parcel, 416
  breaking crossing lines, 434
  changing settings, 417
  deleting, 423
  drawing, 416
  importing lines and labels, 422
  managing, 419
  merging, 424
  renaming, 424
  reporting data, 420
  selecting curved line, 416
  volume table, 758
parcel, defining, 426
  from lines and curves, 426
  from points, 427
  from polyline, 427
parcel, sizing, 428
  by swinging bearing line, 432
  by swinging bearing to curve, 433
  using radial line, 430
  using slide bearing line, 428
plotting
  all, 748
  page, 748
  settings, 745, 747, 748
  volume sections, 745, 750, 751, 752
point
  adding to drawing, 80
  checking, 163
  COGO, 78
  converting, 246
  coordinate display settings, 88
  creating. See point, creating
  current, 82
    drawing, 82
    user, 82
  description key settings, 89
  description settings, 83
  display properties, 250
  displaying information, 159
  duplicate numbers, 165
  editing. See point, editing
  elevation settings, 82
  exporting, 222, 241
  extents
    drawing, 275
    zooming, 275
  import/export format, 225
  importing, 222, 239
  inserting, 166
  insertion settings, 84
  interpolating, 211
point (continued)
  locations, 274
  locking and unlocking, 161
  names, 79
  preferences, 95
  prompts, 170
  properties
    display, 250
    removing from database, 274
  selecting, 156, 170, 171
  transferring, 222, 244
  update settings, 86
  utilities, 274
point blocks, 275
point database
  creating, 78
  merging, 222, 246
  packing, 277
  removing points, 274
  settings, 157
  updating, 163
point file folder, 570
point group, 98
  creating, 100
  deleting, 116
  manager, 99
  overrides, 109, 110, 114, 115
  properties, 116
  removing points, 114
  Terrain Model Explorer folder, 570
point label, 91, 123
  settings, 445
point label styles, 467
  data elements, 469
  description keys, 472
  marker text, 471
  precision values, 471
  symbols, 472
  text, 471
  text properties, 469
  XDRRef elements, 471
point list, 98
  creating, 102, 115, 117, 118
  filtering, 104
  options, 106, 107
  printing, 160
  viewing, 108
point marker, 91, 123
  symbol settings, 92
  text settings, 93
point names, 79
point numbers
  COGO points, 283
displaying, 274
drawing a line, 283
duplicates, 165
numbering convention, 81
renumbering, 256
zooming to, 274
point of intersection, alignment, 379
point settings, 170
  coordinate display, 88
  creating points, 80
description, 83
description key, 89
elevation, 82
insertion, 84
point marker, 92, 93
update, 86
point stakeout report, 264
  consecutive points, 270
curve, 267, 268
  direction, 267
offsets, 268
output settings, 265
radial, 266
spiral, 268, 269
  direction, 268
offsets, 269
point, creating, 170, 172
  at intersections, 183
  based on a surface, 204
  based on horizontal alignments, 197
  based on slopes, 206
settings, 80
point, editing, 156, 254
  changing coordinates, 259
  changing elevation, 255
  changing rotation, 261
  copying, 257
  erasing, 258
  listing points, 160
  moving, 256
  removing, 167
  renumbering, 256
  restoring, 259
  rotating, 257
polyface, 535
polyline
  converting to contour, 672
  defining an alignment, 371
  grid layer, 764
polyline label, 488
preferences
  AutoCAD New command, 64
  AutoCAD Open command, 63
  points, 95
  set up new drawings, 64
  start up dialog box, 63
prismoidal method, 719
prismoidal volume calculation method, 740
profile, drawing setup, 41
program paths, 61
project, 20
  associating, 32
  changing detail settings, 24
  copying, 25
  creating, 23, 31
  creating externally, 21
deleting, 26
displaying details, 23
finding, 23
locks, 28
managing, 21
renaming, 27
selecting, 22, 31
using filters to find, 10
project path
  adding, 21
  removing, 22
project point information, 165
prototype, 34
  changing settings, 37
  copying, 34
  deleting, 36
  managing, 34
  renaming, 36
proximity breakline, 547
  defining
    by points, 548
    by polylines, 548
quick cross sections
  color, 713
  copying, 710
  creating, 708
  exploding, 714
  grip editing, 714
  properties, 711
  redisplaying, 710
  saving, 710
  statistics, 712
  updating, 709
  viewing, 708
radial stakeout report, 266
railroad track, drawing, 354

Index
799
railway curve data, 771
range layer, 763
redisplaying quick sections, 710
remove
  import/export format, 238
  points from drawing, 167
  points from point database, 274
  points from point group, 114
  vertices, 678
rename
  project, 27
  prototype, 36
renumber points, 256
report
  data, 386, 754, 758
  point stakeout, 264
  site information, 727
  station and offset, 406
reporting data, 745
resection, 176
restore points, 259
retaining wall, drawing, 354
rotate
  coordinates, 261
  fixed, 130
  parameter, 129
  points, 257
save
  contour style, 659
  menu palette, 17
  profiles, 710
  quick cross sections, 710
  quick surface sections, 710
scale settings, 46
  determining, 47
scaled block border, 57
section
  plotting, 745
  settings, 739, 747
section method, 743
section volume
  importing, 753, 754
  plotting
    all, 751
    page, 752
    settings, 745, 747
    single, 750
    text size, 750
  settings, 739
section window
  closing, 710
  redisplaying, 710
settings
  drawing, 44, 46
  plotting, 745, 747, 748
  program paths, 61
  sheet size, 48, 748
  shore line, drawing, 352
site
  grid layer, 765
  reporting information, 727
  total volume table, 755
  volume calculations, 724
slope ranges, 627
spacing, 748
special lines and curves, 350
speed table, 332
  default, 334
  editing, 336
spiral
  attaching to object, 328, 346
  clothoid, 339
  compound, 341
  cosinusoidal, 339
  creating
    using speed tables, 332
  drawing. See draw spirals
  graphic model, 344
  label, 444
  offset, 342
  quadratic, 339
  selecting, 171
  selecting current type, 311
  sinusoidal, 339
  terminology, 345
  types, 339
spiral label styles
  editing, 462
  arrows, 466
  crows feet, 466
  data elements, 464
  precision values, 466
  text above/below, 466
  text properties, 464
  ticks, 466
spiral stakeout report, 268
spiral table
  border, 513
  column definition, 514
  creating, 513
  loading, 516
  sorting, 513
  split, 514
stakeout
angle type, 264
files, 265
report, 264
settings, 408, 409
start a drawing
existing project, 7
new, 6
new project, 8
start up dialog box, using, 4
derisplaying, 63
turning off display, 5
static label, 484
creating, 484
curve segments, 485
line segments, 485
station equations
adding, 376
clearing, 376
deleting, 377
exiting, 377
modifying, 377
statistics, 712
surface, 566
surface data folder, 568
terrain folder, 566
volume surface, 571
step, creating in polylines, 692
stockade fence, drawing, 358
stone wall, drawing, 350
stratum, 720
current, 721
defining, 721
deleting, 722
Style Properties dialog bar, 450
style, label, 448
point block only, 449
selecting, 448
selecting current style, 449
supplementing factors, 537
surface
adding non-destructive breaklines, 604
adding points, 603
building, 524
calculating extended statistics, 578
changing elevations, 606
changing properties, 578
closing, 576
copying, 577
defining boundaries, 608
deleting, 577
deleting points, 603
surface (continued)
deleting TIN lines, 602
edit history, 601
flat faces
minimizing, 606
flipping TIN faces, 602
import
watershed boundaries, 590
locking, 578
making current, 574
managing, 574
minimizing flat faces, 606
multiple, 702
non-destructive breaklines
adding, 604
opening existing, 575
pasting together, 607
removing boundaries, 608
renaming, 577
saving, 575
saving current, 576
saving with different name, 576
statistics, 566
TIN faces, flipping, 602
TIN lines
adding, 601
deleting, 602
utilities, 643
viewing
along polyline path, 648
from specified point, 646
water drop paths, 643
watershed models, 584
surface borders
2D line, creating, 611
2D polyline, creating, 611
3D line, creating, 611
3D polyline, creating, 612
surface boundaries
defining, 608
removing, 608
surface creation, 520
2D line borders, 611
2D polyline borders, 611
3D line border, 611
3D polyline borders, 612
new, 523
sections, 702
surface data
adding to surface folder, 527
creating, 527
deleting from surface folder, 528
Index

802

surface data (continued)
folder
statistics, 568
roadway cross sections, 563
surface display, 617, 627
elevation
shading, 617
User-Range, 620
legend, 622
settings, 614
slope
Auto-Range, 629
shading, 627
User-Range, 629
surface folder
adding contour data, 537
adding data, 527
adding point files, 529
adding point groups, 528
deleting contour data, 539
deleting data, 528
surface generation
creating a watershed model, 588
creating contour data, 537
from breakline data, 540
from contour data, 536
surface layer, 762
surface point
adding, 603
changing elevation, 603
deleting, 603
labeling elevation, 645
surface point data
creating from objects, 531
surface point file
adding to, 531, 532, 533, 534, 535
appending, 531
creating, 530
overwriting, 531
selecting 3D faces, 534
selecting AutoCAD point nodes, 531
selecting blocks, 533
selecting lines, 532
selecting polyfaces, 535
selecting text, 534
surface sections
creating, 702
defining, 703
grid, 706
importing, 705

surface sections (continued)
listing
elevational difference, 707
point elevation, 707
processing, 704
quick. See quick cross sections
surface settings
3D grid generator, 636
3D polyline grid, 641
elevation shading, 617
slope shading, 627
surface triangulation, 539
surface, editing, 600
adding and deleting point, 603
adding line, 601
deleting line, 602
editing point, 603
flipping face, 602
nondestructive breaklines, 604
surface boundaries, 609
tag label, 496
creating, 503
tag label styles, 451, 496
editing curve tag
arrows, 500
crows feet, 500
data element, 500
text above/below, 500
text properties, 499
ticks, 500
editing line tag, 496
arrows, 499
crows feet, 499
data element, 498
text above/below, 498
text properties, 498
ticks, 499
editing spiral tag, 501
arrows, 502
crows feet, 502
data element, 502
text above/below, 502
text properties, 501
ticks, 502
terrain folder statistics, 566
terrain layers, 762
Terrain Model Explorer, 520, 522
managing surfaces, 574
text, 534
size, 750
text style, drawing, 54

tick marks, 733

tilde (~) character in description keys, 138

TIN lines, 600
  adding, 601
  deleting, 602
  editing, 600
  viewing as 3D faces, 615
  viewing as polyface mesh, 616
  viewing as temporary vectors, 615

tracking, 782
  elevations, 782
  northing and easting, 782

transfer points, 222, 244

transformation reference point, defining
  from point coordinates, 71
  from point in drawing, 71
  from point number, 72

transformation rotation angle, defining
  from grid north rotation, 73
  from point coordinates, 73
  from point in drawing, 72
  from point number, 72

transformation settings, changing, 68

Triangular Irregular Network lines.
  See TIN lines

unerase points, 259

unit settings, 44

unscaled block border, 57

update
  labels, 439
  profiles, 709
  quick cross sections, 709
  quick surface sections, 709

User-Range
  elevation, 620
  slope, 629

Utilities commands, documentation, 784

utility pole, 139

view
  import/export format, 237
  point list, 108
  statistics of quick sections and
    profiles, 712
  surface TIN lines as 3D faces, 615
  surface TIN lines as polyface mesh, 616
  surface TIN lines as temporary
    vectors, 615

volume
  grid, 729
  report, 754, 758
  reporting, 745
  settings, 722
  stratum, 721
  defining, 721
  deleting, 722
  selecting current, 721
  table, 755
  ticks layer, 766
  total site, 731, 736, 743

volume calculation methods, 716
  average end area, 740
  composite, 717
  grid, 716
  prismatical, 740
  section, 718

volume composite, calculating, 735

volume folder, 571

volume ticks layer, 766

volume, outputting data, 754
  ASCII file, 757, 759
  parcel volume, 758
  parcel volume table, 758
  total volume of site, 754
  total volume table, 755

volume, parcel
  calculating, 732, 737
  settings, 729

volume, section
  calculating, 739, 743
  importing, 753, 754
  plotting, 745, 750, 751, 752
  reporting data, 745
  sampling data, 741
  settings, 739
  text size, 750

volume, site
  calculating, 736
  defining, 724
  deleting, 729
  importing, 728
  managing definitions, 727
  reporting, 727, 754
  settings, 722

volume, surface
  changing properties, 582
  closing, 580
  copying, 581
volume, surface *(continued)*
   deleting, 581
   managing, 579
   opening, 579
   renaming, 580
   saving, 580
water breakline, 550
water drop, 643
water drop layer, 765
watershed
   information, 569
   water drop path, 643
watershed boundaries, drawing, 590
watershed model
   changing properties, 586
   changing settings, 584
   creating, 584
   after building a surface, 589
   when building a surface, 588
watershed types, 593
   boundary point, 593
   boundary segment, 594
watershed types *(continued)*
   depression, 594
   ambiguous, 595
   shallow, 595
   flat area, 596
   multi-drain, 597
   split channel, 597
weeding factors, 537
wildcards, 136
wildcard characters, 108
wildcards, 108
Windows metafile
   saving cross-section views, 710
XDRef, 146, 233
   creating, 149
   deleting, 151
   properties, 150
   requirements, 146
zone transformation settings, 68